## Contents

### Getting Started
- Documentation for Corel WordPerfect ................................................. 11
- The Basics ..................................................................................... 12
- Getting Help .................................................................................. 16
- A Brief Lesson ............................................................................... 16

### Reference
- Advance ....................................................................................... 21
- Append ......................................................................................... 24
- Attributes ..................................................................................... 25
- Auto Code Placement .................................................................... 28
- Backup, Original .......................................................................... 30
- Backup, Timed ............................................................................... 32
- Bar Code ...................................................................................... 33
- Beep Options ............................................................................... 35
- Binding ......................................................................................... 36
- Block, Define ............................................................................... 38
- Block Protect ................................................................................ 40
- Cancel ......................................................................................... 42
- Capitalization ............................................................................. 43
- Cartridges/Fonts/Print Wheels ..................................................... 44
- Center Page ............................................................................... 49
- Center Text .................................................................................. 50
- Change Mode ............................................................................... 53
- Colors/Fonts/Attributes ............................................................... 54
- Columns, Display ........................................................................ 56
- Columns, Newspaper ................................................................... 57
- Columns, Parallel ........................................................................ 61
- Compose ....................................................................................... 65
- Conditional End of Page .............................................................. 67
- Convert Program ......................................................................... 69
- Corel® Versions® .......................................................................... 70
- Cross-Reference .......................................................................... 71
- Cursor Movement ........................................................................ 77
- Date .......................................................................................... 79
- Delete Codes ............................................................................... 82
- Delete Files .................................................................................. 83
- Delete Text .................................................................................. 84
- Directories ................................................................................... 85
- Display Pitch ............................................................................... 87
- Display Setup ............................................................................... 89
- Document Comments .................................................................. 90
- Document Compare ...................................................................... 92
- Document Conversion, Versions 4.2 and 5.0 to 8c ....................... 95
- Document Conversion, Versions 8c to 5.1 ................................ 96
- Document Format ........................................................................ 96
- Document Summary .................................................................... 97
- Edit-Screen Options .................................................................... 102
- Environment Setup ...................................................................... 104
- Equations .................................................................................... 107
- Equations, Commands, and Symbols ......................................... 116
Lists, Define ................................................ 265
Lists, Mark Text ............................................. 266
Location of Files ............................................. 267
Locked Documents ........................................... 270
Look ...................................................... 272
Macros .................................................... 275
Macros, Conversion Program ................................... 276
Macros, Define .............................................. 278
Macros, Execute ............................................. 283
Macros, International Interface .................................. 284
Macros, Macro Editor ......................................... 285
Macros, Message Display ...................................... 289
Make It Fit™ ............................................... 297
Margin Release .............................................. 298
Margins, Left and Right ....................................... 298
Margins, Top and Bottom...................................... 299
Master Documents ........................................... 300
Math ...................................................... 304
Math, Define Columns ........................................ 308
Math, Formulas ............................................. 311
Math—Row Titles, Numbers, and Functions ....................... 314
Menu Options .............................................. 316
Merge ..................................................... 318
Move ..................................................... 327
Move, Block................................................ 329
Other Format ............................................... 334
Outline, Create .............................................. 335
Outline, Define ............................................. 341
Outline, Style ............................................... 346
Overstrike .................................................. 350
Page, Soft and Hard .......................................... 352
Page Format ................................................ 353
Page Numbering ............................................. 355
Paper Size/Type .............................................. 358
Paragraph Numbering ......................................... 364
Port Control ................................................ 368
Print, Document on Disk ...................................... 370
Print, Document on Screen ..................................... 373
Print Color ................................................. 374
Print Job, Cancel ............................................. 375
Print Options ............................................... 377
Print Quality ............................................... 378
Printer, Edit ................................................ 380
Printer, Select ............................................... 382
Printer Commands ........................................ 385
Printer Functions ........................................... 386
Printer Program ............................................. 390
Printer Program, AutoFont .................................... 395
Printer Program, Customize Substitute Fonts..................... 398
Printer Program, Modify Automatic Font Changes ................... 400
Printing—General Information .................................. 403
<table>
<thead>
<tr>
<th>Feature</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Printing, Landscape</td>
<td>406</td>
</tr>
<tr>
<td>Printing, Stop</td>
<td>409</td>
</tr>
<tr>
<td>Printing to Disk</td>
<td>410</td>
</tr>
<tr>
<td>Pull-Down Menus</td>
<td>411</td>
</tr>
<tr>
<td>QuickCorrect™</td>
<td>413</td>
</tr>
<tr>
<td>Redline/Strikeout</td>
<td>414</td>
</tr>
<tr>
<td>Repeat Value</td>
<td>414</td>
</tr>
<tr>
<td>Replace</td>
<td>416</td>
</tr>
<tr>
<td>Retrieve</td>
<td>418</td>
</tr>
<tr>
<td>Return, Soft and Hard</td>
<td>420</td>
</tr>
<tr>
<td>Reveal Codes</td>
<td>423</td>
</tr>
<tr>
<td>Rewrite</td>
<td>425</td>
</tr>
<tr>
<td>Save</td>
<td>426</td>
</tr>
<tr>
<td>Screen</td>
<td>427</td>
</tr>
<tr>
<td>Search</td>
<td>428</td>
</tr>
<tr>
<td>Setup</td>
<td>430</td>
</tr>
<tr>
<td>Sheet Feeder</td>
<td>431</td>
</tr>
<tr>
<td>Sort</td>
<td>432</td>
</tr>
<tr>
<td>Sort, Keys</td>
<td>437</td>
</tr>
<tr>
<td>Sort, Select Records</td>
<td>439</td>
</tr>
<tr>
<td>Speller, Check Spelling</td>
<td>441</td>
</tr>
<tr>
<td>Speller, Dictionaries</td>
<td>446</td>
</tr>
<tr>
<td>Speller, Look Up Words</td>
<td>449</td>
</tr>
<tr>
<td>Speller, Word Count</td>
<td>450</td>
</tr>
<tr>
<td>Speller Utility</td>
<td>451</td>
</tr>
<tr>
<td>Spreadsheet, Import and Link</td>
<td>456</td>
</tr>
<tr>
<td>Spreadsheet, Link Options</td>
<td>462</td>
</tr>
<tr>
<td>Style</td>
<td>463</td>
</tr>
<tr>
<td>Style, Create</td>
<td>468</td>
</tr>
<tr>
<td>Suppress Page Format</td>
<td>472</td>
</tr>
<tr>
<td>Switch</td>
<td>474</td>
</tr>
<tr>
<td>Tab</td>
<td>476</td>
</tr>
<tr>
<td>Tab Align</td>
<td>478</td>
</tr>
<tr>
<td>Tab Set</td>
<td>479</td>
</tr>
<tr>
<td>Table, Create</td>
<td>484</td>
</tr>
<tr>
<td>Table, Edit Structure</td>
<td>491</td>
</tr>
<tr>
<td>Table, Format Columns and Cells</td>
<td>502</td>
</tr>
<tr>
<td>Table, Math</td>
<td>507</td>
</tr>
<tr>
<td>Table of Authorities</td>
<td>512</td>
</tr>
<tr>
<td>Table of Authorities, Define</td>
<td>513</td>
</tr>
<tr>
<td>Table of Authorities, Mark Text</td>
<td>515</td>
</tr>
<tr>
<td>Table of Contents</td>
<td>518</td>
</tr>
<tr>
<td>Table of Contents, Define</td>
<td>519</td>
</tr>
<tr>
<td>Table of Contents, Mark Text</td>
<td>520</td>
</tr>
<tr>
<td>Text In/Out</td>
<td>521</td>
</tr>
<tr>
<td>Text Screen Size</td>
<td>524</td>
</tr>
<tr>
<td>Thesaurus</td>
<td>525</td>
</tr>
<tr>
<td>Typeover</td>
<td>527</td>
</tr>
<tr>
<td>Undelete</td>
<td>529</td>
</tr>
<tr>
<td>Units of Measure</td>
<td>530</td>
</tr>
<tr>
<td>View Document</td>
<td>532</td>
</tr>
</tbody>
</table>
Getting Started
This manual is designed to assist you in using Corel WordPerfect 8 for character-based terminals. If you want help with Corel WordPerfect 8 for the X Window System, there are several resources available.

### Online Manual

The online *User's Guide* is available locally in Adobe Acrobat (.pdf) format, in ASCII text format for the SCO version of Corel WordPerfect, or from the Word Wide Web (in HTML format).

The Acrobat version of the Corel WordPerfect 8 for the X Window System *User's Guide* is available on the Corel WordPerfect for UNIX CD. See your system administrator if the `wp8gui.pdf` file has not been installed with the rest of the Corel WordPerfect files. If you are using the SCO version of Corel WordPerfect, the *User's Guide* is available in ASCII text format instead of Acrobat format. See your system administrator if the `wp8gui.txt` file has not been installed with the rest of the Corel WordPerfect files. You can view a copy of the manual in HTML format using your Internet browser for all versions of Corel WordPerfect 8 for the X Window System.

To open the local version of the manual,

1. Start Corel WordPerfect 8 for the X Window System.
2. Choose **Online Help** from the **Help** menu.
3. Choose **WP Online Manual**.

To view the HTML version of the manual,

1. Start Corel WordPerfect 8 for the X Window System.
2. Choose **Online Help** from the **Help** menu.
3. Choose **WP HTML Manual**.

You can access the manual directly from your Web browser using the following URL:

http://www.sdcorp.com/products/wp8/info

### Using the Online Manual

The online *User's Guide* includes *Getting Started*, *Lessons*, and *Reference* sections.

#### Getting Started

This section includes an overview of the manual and online Help, and a brief introduction to Corel WordPerfect 8.

#### Lessons

The lessons help you to create and format a variety of documents using Corel WordPerfect. These lessons are useful if you’re new to word processing or to Corel WordPerfect.

#### Reference

The alphabetically-arranged, task-oriented sections in the *Reference* can answer questions you have as you use Corel WordPerfect. The sections include general steps for using a feature, as well as additional information when needed.
### Online Help
Use Corel WordPerfect's online Help system to get immediate information about Corel WordPerfect 8 for the X Window System features and options.

### Help Menu
You can access the full range of Help topics using the following items from the Help menu:

<table>
<thead>
<tr>
<th>Choose Menu Item</th>
<th>To Get</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contents</td>
<td>List of Help contents and access to Search (Index), How Do I, Glossary, Menu Commands, Corel WordPerfect Bars, and Using Help</td>
</tr>
<tr>
<td>Search for Help on</td>
<td>List of Help topics in alphabetical order</td>
</tr>
<tr>
<td>How Do I</td>
<td>Instructions for performing common tasks; for example, you might ask, “How do I save a document?”</td>
</tr>
<tr>
<td>Macros</td>
<td>Online Macros Manual</td>
</tr>
<tr>
<td>Online Help</td>
<td>Access to Automated Support, the online manual in Adobe Acrobat format, and the online manual on the World Wide Web</td>
</tr>
<tr>
<td>About Corel WordPerfect</td>
<td>Information about your license number, your network username, your version of Corel WordPerfect, the network setup, system, printer, and environment</td>
</tr>
</tbody>
</table>

### README Files
README files contain information about changes to the program that were made after the manuals were printed. Be sure to retrieve README files into Corel WordPerfect and read through them.

### The Basics

#### Installation
Your system administrator should have already installed Corel WordPerfect 8 for character-based terminals. If it is not working, please contact your system administrator.

#### The Template
The template is an optional menu card that fits onto your keyboard and shows the locations of Corel WordPerfect function keys. If your template does not fit the keyboard you are using, contact your system administrator for a replacement.

#### Start Corel WordPerfect
Once Corel WordPerfect has been installed by your system administrator, you are ready to start the program.
First log on to your terminal, then follow the procedure below that matches your system setup.

- If you see the shell prompt after you log on, enter `wp` to start Corel WordPerfect.
- If you see a menu of applications to select from, choose the letter or number that corresponds to Corel WordPerfect.

---

**Clean Screen**

When you begin a new document, you are in the editing screen.

The cursor points to the current position on the screen. The status line displays the position of the cursor, messages, or warnings. When you save a document, the status line also displays the filename of the document on the editing screen.

Initial (default) formats, such as margins, tabs, and line spacing, are already set. You can, however, change them at any time in the document (see Appendix G: Initial Settings for a complete list of initial format settings).

---

**Keys to Know**

<table>
<thead>
<tr>
<th>Key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Backspace</td>
<td>Erases characters to the immediate left of the cursor as you type.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Backs you out of features that display a message on the status line, such as Block, Exit, or Retrieve. It also backs you out of any menu. Cancel can also be used to restore text that has been erased by the delete keys.</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes text at the cursor position.</td>
</tr>
<tr>
<td>Exit</td>
<td>Saves or exits a menu or a document, exits Corel WordPerfect without saving a document, or clears the screen.</td>
</tr>
<tr>
<td>Help</td>
<td>Displays on-screen information about any feature you are using. You can also use this feature to display the Corel WordPerfect template or a list of features that begin with a specific letter. Pressing Return or the Space Bar exits the help screen.</td>
</tr>
</tbody>
</table>
**Return**

Ends a short line of text, or sends a command to your terminal. For example, to save or retrieve a file, you must type a filename, then press Return. You can also use Return to accept a default prompt.

**Function Keys**

You use function keys to access the many features in the program. The function keys you press will vary depending on the keyboard you are using. The template shows the location of function keys.

You can change these assignments to suit your needs. For further information on keyboard assignments, see *Keyboard Layout*.

For more information about assigning Help to Cancel, Cancel to Escape, and Repeat Value to Help, see *Alternate Keyboard* under *Environment Setup*.

**Pull-Down Menus**

Use pull-down menus to select features.

Pull-down menu titles appear in a bar at the top of the screen. Hold down the Escape key and press the equal sign key (=). To select features in the pull-down menus, use the arrow keys and press **Return**. You can also select these features by typing the mnemonic letter that is highlighted in the feature name (S for Save).

If you prefer to use the pull-down menus, look for this symbol: ☐. Throughout the documentation, this symbol will be followed by the name of the pull-down menu where you can find the feature.

Example:

*Or ☐ Select Append from the Edit menu.*
Menu Options

Some features, such as Print, give you a menu of options, as in the example below.

<table>
<thead>
<tr>
<th>Print Options</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 - Full Document</td>
<td>S - Select Printer</td>
</tr>
<tr>
<td>2 - Page</td>
<td>HP LaserJet 1100</td>
</tr>
<tr>
<td>3 - Document on Disk</td>
<td>N - Number of Copies</td>
</tr>
<tr>
<td>4 - Control Printer</td>
<td>1</td>
</tr>
<tr>
<td>5 - Multiple Pages</td>
<td>W - Multiple Copies Generated by WordPerfect</td>
</tr>
<tr>
<td>6 - View Document</td>
<td>G - Graphics Quality</td>
</tr>
<tr>
<td>7 - Initialize Printer</td>
<td>High</td>
</tr>
<tr>
<td>8 - Control Form</td>
<td>I - Ink Quality</td>
</tr>
<tr>
<td>9</td>
<td>J - Job Type &quot;(all types)&quot;</td>
</tr>
<tr>
<td>10</td>
<td>B - Priority</td>
</tr>
<tr>
<td>11</td>
<td>S5</td>
</tr>
<tr>
<td>12</td>
<td>Selection:</td>
</tr>
</tbody>
</table>

When you are in one of these menus, there are two ways to select an option.

- Type the option number, such as (1) for Full Document. (Use the numbers at the top of the keyboard, not the numbers on the number pad.)
- Type the mnemonic letter that is highlighted in the option name (P for Page).

Codes

Codes are commands that tell Corel WordPerfect and your printer what to do. When you use a feature such as Block or Underline, the commands are inserted in your document. You can see the codes in Reveal Codes. See Appendix B: Codes for a list of all codes.

Exit Corel WordPerfect

When you finish using Corel WordPerfect, you must exit before turning off your terminal.

1. Press Exit.
   
   Or Select Exit from the File menu.

2. Press y to save the document, then enter a filename.
   
   or
   
   Press n to continue exiting without saving the document.

3. Press y to exit.

   There are several save options. For further information, see Save.
Getting Help

If you want help with Corel WordPerfect as you work, there are several sources available.

Help Feature
Press the Help key to display on-screen information about features.

Reference Manual
This manual describes how each feature works.

A Brief Lesson

Creating the Document
After you start Corel WordPerfect, you are ready to start typing. If you make any mistakes, you can use Backspace to erase them.

When a line fills with text, the cursor returns to the left margin on a new line. This automatic return is known as word wrapping.

1 Type the following note without pressing Return at the end of a line.

Remember the discussion we had about starting a study abroad program? I just returned from a study abroad conference in Illinois, and I have an outline I want you to read. Please stop by my office when you are at this end of campus, and we can talk about it.

Editing the Document
You just created your first document, but you see parts of the document you want to edit.

Moving the Cursor
Move the cursor by using the Up and Down Arrow keys, or the Left and Right Arrow keys on your keyboard.

Some keyboards have a separate number pad that is also used for cursor control. The Num Lock key (or its equivalent) operates as a toggle to turn Num Lock on and off. When Num Lock is turned off, the number pad can be used for cursor control. To find the alternate cursor toggle keystroke, press Help, Help, Right Arrow. An additional help screen labeled Miscellaneous Corel WordPerfect Functions appears. The function name is Keypad Numeric/Application-mode toggle.

1 Using the arrow keys, move the cursor to the uppercase R in Remember.

Insert vs. Typeover
By default, Insert is on. Text you type is inserted at the cursor, moving the existing text to the right. To type over existing text use Typeover. Press Help to access appropriate keystrokes.

2 Type Do you and press the Space Bar.

3 Press Insert. Notice that Typeover appears at the bottom left of the screen.

4 Type a lowercase r to replace the existing R.
5 Press **Insert** to end Typeover and return to Insert.

6 Move the cursor to the h in have in the second sentence.

7 Press **Delete** until the sentence (including the period) is erased. 

Many keyboard functions will repeat if you hold down the key. Holding down a key too long can insert unwanted codes and delete other necessary codes.

8 Type **think I’ve come up with an outline that will make us all very happy.**

9 Move the cursor to the v in very.

**Block and Underline**

Block defines portions of text for use with other features.

1 Press **Block**, then press **Right Arrow** until very is highlighted.

   Or **Select Block from the Edit menu, then press Right Arrow until very is highlighted.**

2 Press **Underline**.

Select Appearance from the Font menu, then select Underline.

You can block characters, words, sentences, or entire pages. If you had blocked the rest of the note from very forward, the entire block would have been underlined.

3 Move the cursor to the D in Do at the beginning of the note.

4 Press **Return** two times to add blank lines at the beginning of the note.

**Using the Home Key**

Use the Home key to move through the document quickly.

1 Press **Home** key twice, then **Up Arrow** to go to the top of the document.

2 Type **Mitch,**

3 Return to the D in Do at the beginning of the note.

4 Press **Tab.**

---

**Mitch,**

Do you remember the discussion we had about starting a study abroad program? I’ve just returned from a study abroad conference in Illinois, and I think I’ve come up with an outline that will make us all **very happy.** Why don’t you stop by my office the next time you’re at this end of campus, and we can talk about it.

---

*A Brief Lesson* 17
Saving the Document
You typed the note and now you want to save it. When you save a document, all
document initial settings are saved, including printer selection.

1. Press Save.
   
   \textit{Or} \[
   \text{Select Save from the File menu.}
   \]

A message appears on the status line at the bottom of the screen: “Document to
be Saved:”

2. Type \texttt{study} as the filename, then press \texttt{Return}.

The name of your document and the directory appear on the status line at the
bottom of the screen. This original document is now saved. Any changes you
make in the rest of the lesson are only temporary. The changes do not affect the
original document, unless you save them under the same filename.

Printing the Document
From the screen, you can print a document, page, or a block of text.

1. Press Print to display the Print menu.
   
   \textit{Or} \[
   \text{Select Print from the File menu.}
   \]

2. Select Full Document (1) from the Print menu to send the note to the
   printer.

If your printer does not print, make sure it is turned on, it is on-line, and the
printer cable is attached securely to your computer and printer. If you still
cannot print, contact your system administrator.

Saving the Document and Exiting
You already saved your original document. You can also save your document
and exit Corel WordPerfect at the same time.

1. Press Exit.
   
   \textit{Or} \[
   \text{Select Exit from the File menu.}
   \]

A message appears on the status line at the bottom of the screen asking you if
you want to “Save Document? Yes (No).”

2. Type \texttt{y}, then press \texttt{Return} to save it with the \texttt{study} filename.

   \textit{Pressing Return will automatically select the default option.}

Because there is already a document with the filename \texttt{study}, the message on the
status line asks if you want to replace the previously saved document. If you had
changed any text, the new version of the text would replace the old version.

3. Type \texttt{y}.

The message on the status line asks if you want to “Exit WP? No (Yes).”

4. Type \texttt{y} to exit.

For information on other saving and filing options, see \textit{Save and List Files}. 
Advance

Use Advance to position text at an exact location on a page. Advance can place text in graphics images. In the image below, Advance positions “Help!” inside the cartoon bubble.

Use Advance to fill in spaces in existing forms, such as positioning text to fit in a pre-printed form (see Filling in Forms below).

When you use different fonts and type sizes, use Advance to move to a specific position on a page without having to calculate the line height required to reach that position. You can also used Advance to manually kern characters (see Word and Letter Spacing).

To use advance,

1. Move the cursor to where you want the advance to begin.
2. Press Format, then select Other (4).
   Or Select Other from the Layout menu.
3. Select Advance (1), then select the advance option of your choice (see Advance Options below).
4. Enter a distance.
5. Press Exit to return to the document.
6. Type the text.
Notes

**Advance and Graphics Images**
If you use Advance to position text in a graphics image, make sure the Wrap Text Around Box option for the graphics box that contains the image is set to No. If it is set to yes, you cannot position text inside the box (see Graphics, Define a Box).

**Advance and Page Breaks**
Use Advance to move the cursor on the current page only. You cannot enter an Advance measurement which advances the cursor past a page break (see Page, Soft and Hard).

**Advance Options**
If you select Advance Up (1), Down (2), Left (4), or Right (5), the distance you enter is measured relative to the cursor position. For example, if you enter an Advance Left measurement of 1" and the cursor is at position 3.5", you will be advanced to position 2.5" on the same line.

If you select Advance to Line (3) or Position (6), the distance you enter is an absolute position on the page, regardless of where the cursor is located at that time.

Advance to Line is a vertical measurement, measured from the top edge of the page. For example, if you enter an Advance to Line measurement of 3", you will be advanced 3" down from the top edge of the page.

Advance to Position is a horizontal measurement, measured from the left edge of the page. For example, if you enter an Advance to Position measurement of 3", you will be advanced 3" in from the left edge of the page.

You cannot advance vertically and horizontally using one Advance code. To change the cursor position to a new vertical and horizontal position, you must enter two Advance codes.

**Cursor Position**
Advance inserts an Advance code into your document which indicates the type of advance you selected and the distance. This does not change the on-screen position of the cursor. However, any change in location is reflected in the “Ln” and “Pos” numbers on the status line.

If you do not know the position of specific text in your document, move the cursor to that text, using Reveal Codes. Make sure the cursor is placed after the Advance code, then check the position displayed on the status line. You can also use View Document to preview where the text will be printed on the page.

**Filling in Forms**
When you select Advance to Line (3) from the Advance options and enter a distance, text is printed immediately below the distance you enter. For example,
if you enter an Advance to Line measurement of 3", the full line of text is printed immediately below 3" from the top of the page.

<table>
<thead>
<tr>
<th>Advance measurement</th>
<th>3&quot;</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line of text</td>
<td></td>
</tr>
<tr>
<td>Baseline</td>
<td></td>
</tr>
</tbody>
</table>

When you place text in pre-printed forms, set the Baseline Placement for Typesetters option on the Format: Printer Functions menu to Yes. You may also want to enter a fixed line height and enter a fixed line measurement (see Line Height). Text is printed on top of the line instead of below the line. If you enter an Advance to Line measurement of 3", the bottom or baseline of your text is printed 3" down from the top of the page.

<table>
<thead>
<tr>
<th>Advance measurement</th>
<th>3&quot;</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line of text</td>
<td></td>
</tr>
<tr>
<td>Baseline</td>
<td></td>
</tr>
</tbody>
</table>

The baseline of your text will be 3 inches down.
Returning to the Original Position
To return the cursor to its original position after using Advance, insert an Advance to Line and an Advance to Position measurement. For example, if you were originally at the Position 1" Line 1" position, return the cursor to that position by entering an Advance to Line measurement of 1" and an Advance to Position measurement of 1".

Text Boxes
Advance code measurements inside text boxes are measured from the top left corner of the box.

Append

Append adds text on the screen to an existing file on disk. Text is added to the end of the file.

1 Move the cursor to the text you want to append.
2 Press Move.
   Or Choose Select from the Edit menu.
3 Select Sentence (1), Paragraph (2), or Page (3) to highlight the sentence, paragraph, or page on which the cursor is resting.
   You can also append a block of text (see Blocks of Text below).
4 Select Append (4).
5 Enter the name of the file to which you want to append the text (see Entering Filenames below). If the file does not exist, it will be created.

Notes
Append and Macros
If you use Append in macros, a new file is automatically created if the filename you enter does not exist.

Blocks of Text
You can append a block of text to a file on disk. Select Block to block the text, press Move, select Block (1), and follow steps 4 and 5 above.

Entering Filenames
If the file is in your default directory, enter only the filename. If the file is in another directory, you must enter the full pathname for the file.

Locked Files
To append to a locked file, use the above steps, then enter the correct password for the locked file.
Sentence, Paragraph, and Page Delimiters

Sentences, paragraphs, and pages are distinguished by delimiters such as periods, Hard Return codes [HRt], Soft Page codes [SPg], and Hard Page codes [HPg]. If you have trouble blocking a sentence, paragraph, or page, one or more of the necessary delimiters is missing.

For more information about sentence, paragraph, and page delimiters, see Move.

Tabular Columns and Rectangles

Use Block to block a tabular column or a rectangle. You cannot enter a filename to append a blocked tabular column or rectangle directly to a file. You can, however, move these items by appending them to a temporary buffer.

To move a blocked tabular column or rectangle,

1. Select Block to block a tabular column or a rectangle (see Move, Block).
2. Press Move, with the block on the screen.
3. Select Tabular Column (2) or Rectangle (3).
4. Select Append (4) to save the block to a temporary buffer.

The text will remain in that temporary buffer until you move new text to that buffer or exit Corel WordPerfect. To move the buffer to another file, switch to the new file and retrieve the buffer.

To retrieve the block,

1. Press Move.
2. Select Retrieve (4).
3. Select Tabular Column (2) or Rectangle (3).

You cannot use the Tabular Column or Rectangle option to block and append graphics boxes unless the graphics box is empty or contains only text. If you use the Tabular Column or Rectangle option to block and append a graphics box which contains a graphics image, you will get an error message.

Attributes

Attributes change the size or appearance of printed text. They can provide emphasis to a word or set text apart on a page.

Size attributes change the size of printed text, while appearance attributes enhance the printed text.
In the following example, size attributes create headlines of different sizes.

**Seeing Things Clearly**

**Proposal Summary**

As we suspected, aquarium operations in both production and marketing have a determinant effect on how well our marine and freshwater fish operations perform. A comparative study of the two financial histories shows that our revenues followed the same fiscal pattern as that of Clearly Aquariums: when aquarium sales are up, we prosper. But this symbiotic relationship also has a downside. Currently, there is little activity among aquarium manufacturers to stimulate their weak market—output is at a standstill.

These indicators lead us to believe that if aquarium sales continue to soften, our profits will begin to recede symptomatically. One way of breaking from the aquarium industry's downward spiral and increasing our potential for growth is to adopt a more aggressive posture in aquarium manufacturing.

This proposal suggests that we purchase the aquarium industry leader, Clearly Aquariums, to fortify our company and our sales for the future. Because our sales depend on aquarium output, acquiring Clearly would allow us to improve productivity, oversee marketing, and give us tighter control over our fish sales. Agreed, acquiring another business in these volatile times is risky, but the returns for us on an aquarium venture will essentially be guaranteed; everyone who buys our fish will have to have somewhere to put them, and everyone who buys an aquarium will want to fill it with fish.

To add an attribute as you type text,

1. Press Font to display the Font menu on the status line.
2. Select Size (1) or Appearance (2).

   Or ☐ Select specific size attributes from the Font menu. For appearance attributes, select Appearance from the Font menu.
3. Select the attribute of your choice.
4. Type the text.
5. To turn off the attribute, reselect the attribute (steps 1 through 3 above), or move the cursor past the attribute off code (see Codes below). You can also turn off all current active attributes at the same time (see Normal Text below).

### Notes

**Appearance Attributes**

Appearance attributes specify text style text. Select Bold (1), Underline (2), Double Underline (3), Italic (4), Outline (5), Shadow (6), Small Caps (7), Redline (8), or Strikeout (9).

**Base Font**

The attributes you select are variations of the current document's base font. You can use size attributes to temporarily change font size without changing the base font. If the attributes do not look the way you expect them to print, your printer does not have the necessary fonts to print them (see Colors/Fonts/Attributes and Font).

To preview appearance attributes, use View Document.
**Bold and Underline**

Bold and Underline are assigned to specific keystrokes. Select **Bold** or **Underline**, then press the keystroke again to turn off the attribute, or press **Right Arrow** to move past the attribute off code.

**Codes**

When you select an attribute, on and off codes are inserted, with the cursor resting before the off code. For example, the on code inserted for the Bold attribute is `[BOLD]` and the off code is `[bold]`. You can display these codes by pressing **Reveal Codes**. Any text between the codes takes on the attribute.

To turn off the attribute, press **Right Arrow** to move past the off code.

**Existing Text**

To add attributes to existing text, block the text using **Block**, then select the attribute using steps 1 through 3 above. When you use this method, the cursor is placed after the attribute off code.

**Normal Text**

When you have more than one attribute active at a time, you can turn off all current attributes. Press **Font**, then select **Normal (3)** to return the text to the base font. This inserts the necessary off codes or moves the cursor past existing off codes. Text which follows the off codes is printed in the current base font (see **Base Font** above).

**On-Screen Appearance**

The attribute currently selected appears in the text you type and in the numbers next to the "Pos" indicator at the status line. When attributes are displayed on the screen, they can be represented in several ways, depending on your terminal.

To learn more about the on-screen appearance of attributes, see **Colors/Fonts/Attributes**.

**Printing**

Since the printed appearance of text depends upon the capabilities of your printer, you may not be able to print certain attributes. For example, some printers print underlining as a solid line, while others can only produce a broken line. To learn more about how attributes are printed, see **Font**.

You can determine which attributes are available on your printer by retrieving and printing the printer.tst file (select your printer before printing). It includes several attributes and the most common attribute combinations.

*Important:* printer.tst is installed with the Corel WordPerfect Program files. It is originally copied to the wplrn directory.

**Removing Attributes**

You can remove attributes by deleting either one of the pair of attribute codes which surround the text. Corel WordPerfect then deletes the matching code. We suggest you turn on Reveal Codes to see the attribute codes you are deleting. Also, if you delete an attribute code in the normal editing screen, you are prompted to confirm the deletion. You can type `y` to confirm the deletion, or type any other key to skip the code without deleting it.
**Size Attributes**
The size attributes deal with the height and width of a character or character position in a line.

Select either Superscript (1), Subscript (2), Fine (3), Small (4), Large (5), Very Large (6), or Extra Large (7).

To alternate type sizes, use these size attributes instead of adjusting Base Font settings.

Using the size attributes, however, may not actually change the size of the text you print. It depends on what fonts your printer has available. For example, if your printer has only Courier 10 point, it will print only in that font regardless of the size attributes you select.

The actual sizes used for Fine, Small, Large, Very Large, and Extra Large are determined by your current base font and the printer fonts you select (see *Base Font* above, and *Font*).

You can also change the fonts being used for the attributes by editing the .prs file (see *Printer Program, Modify Automatic Font Changes*).

**Size Attribute Ratios**
A new feature, Size Attribute Ratios, helps you determine the size of the font attributes (see *Initial Settings*).

*See Also:* Colors/Fonts/Attributes; Font; Printer, Select; Redline/Strikeout

---

**Auto Code Placement**

Certain Corel WordPerfect codes are designed for insertion at the beginning of a paragraph or page, depending on the code. When inserting a code, Auto Code Placement moves the code to the top of the paragraph or page where the insertion point is located. Auto Code Placement removes duplicate codes by deleting the old code before inserting the new code.

The code then affects the paragraph or page, and all subsequent text, unless Corel WordPerfect encounters the same code later in the document.

*If you select text before you insert a code listed in the table below, the code affects the entire paragraphs or pages containing the selection.*

If you start Corel WordPerfect with a -A startup option, Auto Code Placement brackets are made visible around the Page or Paragraph code here ([Auto Placement]>>) [<<<Auto Placement]).

When you retrieve a Corel WordPerfect UNIX document into the DOS version of Corel WordPerfect, the Auto Code Placement codes will appear as [Unknown].
The table below lists the codes placed at the top of the page and at the beginning of each paragraph. Codes not listed in the table are character codes. Such codes are placed where the insertion point is located.

<table>
<thead>
<tr>
<th>Formatting Code</th>
<th>Code Placement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alignment Character</td>
<td>Paragraph</td>
</tr>
<tr>
<td>Baseline Line Height</td>
<td>Paragraph</td>
</tr>
<tr>
<td>Block Protect</td>
<td>Paragraph</td>
</tr>
<tr>
<td>Columns, Def</td>
<td>Paragraph</td>
</tr>
<tr>
<td>Columns, On</td>
<td>Paragraph</td>
</tr>
<tr>
<td>Endnote Print Here</td>
<td>Paragraph</td>
</tr>
<tr>
<td>Footer, A or B</td>
<td>Page</td>
</tr>
<tr>
<td>Force Odd/Even Page</td>
<td>Page</td>
</tr>
<tr>
<td>Header, A or B</td>
<td>Page</td>
</tr>
<tr>
<td>Hyphenation Zone</td>
<td>Paragraph</td>
</tr>
<tr>
<td>Justification, Center, Full, Left, or Right</td>
<td>Paragraph</td>
</tr>
<tr>
<td>Leading Adjustment</td>
<td>Paragraph</td>
</tr>
<tr>
<td>Line Height</td>
<td>Paragraph</td>
</tr>
<tr>
<td>Line Numbering</td>
<td>Paragraph</td>
</tr>
<tr>
<td>Line Spacing</td>
<td>Paragraph</td>
</tr>
<tr>
<td>Margins, Left or Right</td>
<td>Paragraph</td>
</tr>
<tr>
<td>Margins, Top or Bottom</td>
<td>Page</td>
</tr>
<tr>
<td>Math Columns, Define</td>
<td>Paragraph</td>
</tr>
<tr>
<td>Math Columns, On</td>
<td>Paragraph</td>
</tr>
<tr>
<td>Page, Center</td>
<td>Page</td>
</tr>
<tr>
<td>Page Number</td>
<td>Page</td>
</tr>
<tr>
<td>Page Number Position</td>
<td>Page</td>
</tr>
<tr>
<td>Page Number Style</td>
<td>Page</td>
</tr>
<tr>
<td>Paragraph Numbering</td>
<td>Paragraph</td>
</tr>
<tr>
<td>Suppress Page</td>
<td>Page</td>
</tr>
<tr>
<td>Tab Set</td>
<td>Paragraph</td>
</tr>
<tr>
<td>Widow/Orphan, On or Off</td>
<td>Page</td>
</tr>
<tr>
<td>Word/Letter Spacing</td>
<td>Paragraph</td>
</tr>
</tbody>
</table>

**Notes**

Placement

To reposition a code that has been automatically positioned at the beginning of a page or paragraph, block the desired code and use **Move** to move it to the new location.

For example, if you want Line Numbering to start in the middle of a paragraph, you must turn Line Numbering on. With Reveal Codes on, go to the beginning of the paragraph, block the line numbering code, then move the code to the line where you want Line Numbering to begin.

Placement Restrictions

Auto Code Placement restricts where regular text and character codes can be entered. If you enter text when the insertion point is between page or paragraph-type codes, the insertion point is moved past all page and paragraph functions before the text is inserted.
Normally, when you replace a document with one of the same name, the original is deleted. The Original Backup option lets you save the original and the replacement version of the document.

Original Backup is a safeguard against replacing previous versions of a document.

When you replace a file with Original Backup on, the original version of a file is renamed filenameBK! (where filename is the name of the original file). As you continue to replace the same file, the BK! file is replaced with the current original file. The BK! files are stored in the same directory as the replacement file.

For example, if you save the first draft of a document named letter, when you replace the first draft with the second draft, the first draft is renamed letterBK! and the second draft is named letter.
When you replace the second draft of letter with the third draft of letter, the first draft of letter is deleted, the second draft of letter is renamed letterBK!, and the third draft is named letter.

To use Original Backup,

1. Press Setup.
   
   Or Select Setup from the File menu.

2. Select Environment (2), then select Backup Options (1).


4. Type y to use the Original Backup option.

5. Press Exit to exit the Setup: Backup menu.

Copying Files
Because disks can become corrupted, resulting in lost data and unusable files (both original and backup), we recommend you make backup copies of your files.

Location of Backup Files
Original backup files are stored in the same directory as the files they back up.

Retrieving Original Backup Files
To retrieve an original backup file, use the Rename feature in List Files to rename the backup file, then retrieve it as you would a text file.

Turning off the Original Backup option deletes the original backup file the next time you save the document. Rename original backup files before you turn off Original Backup.
Timed Backup
Timed Backup is a safeguard against losing text during a power outage, machine failure, or other computer-related problem.

You can use original and timed backup at the same time.

See Also: Save

Backup, Timed

Timed Backup is a safeguard against the loss of work due to machine failure, power outage, or other computer-related problem.

Timed Backup backs up or makes a copy of your document at specified intervals. Every few minutes, a “Timed Backup” message is displayed on the status line, and the file is copied to the directory you specify in the Location of Files feature.

Timed Backup is a powerful option, but it is not a substitute for saving your files.

Timed backup files are deleted when you properly exit Corel WordPerfect.

To set Timed Backup,
1 Press Setup.
   Or Select Setup from the File menu.
2 Select Environment (2), then select Backup Options (1).
3 Select Timed Document Backup (1).
4 Type y to back up your documents at specified intervals.
5 Enter the time interval (in minutes).
6 Press Exit to exit the Setup: Backup menu.

Notes

Copying Files
Because disks can become corrupted, resulting in lost data and unusable files, we strongly recommend you make backup copies of your files.

Disks can become corrupted by static, power surges, magnets, or other computer-related problems.

Retrieving Timed Backup Files
Timed backup files are temporary files that are stored in the directory you specify in Location of Files. If you do not specify a location, they are stored in the tmp drive. When you exit Corel WordPerfect properly, timed backup files are deleted.

wp_bk1.<pid> (<pid> is the Process ID number) is the name of the timed backup file for the document on the Document 1 screen, while wp_bk2.<pid> is the name of the timed backup file for the document on the Document 2 screen.
After the first backup, a document is backed up again only if you have made changes.

To retrieve a timed backup file, go to List Files, then retrieve the file as you would a text file.

See Also: Backup, Original; Save

---

**Bar Code**

You can speed mail sorting, increase delivery accuracy, and reduce postage costs by including a POSTNET (Postal Numeric Encoding Technique) bar code with the mailing address on your envelopes.

You create POSTNET bar codes by entering a 5-, 9-, or 11-digit ZIP Code in the Bar Codes option of Other on the Layout menu. When you print the envelope or document, Corel WordPerfect converts the ZIP Code into a combination of tall and short lines called a POSTNET bar code.

You create POSTNET bar codes by entering a 5-, 9-, or 11-digit ZIP Code in the Bar Codes option of Other on the Layout menu. When you print the envelope or document, Corel WordPerfect converts the ZIP Code into a combination of tall and short lines called a POSTNET bar code.

POSTNET bar code specifications are regulated by the U.S. Postal Service. For the benefits of bar codes, contact the U.S. Postal Service Business Center, Account Representative, or Postmaster in your area.

---

**Creating a POSTNET Bar Code on an Envelope**

1. Press **Format**, then select **Page (2)**.
   
   Or **Select Page from the Layout menu**.

2. Select **Paper Size (7)**.

3. Select a paper size, then select **Envelope (5)**.

4. Press **Return** and select **Other (4)**.

5. Select **Bar Codes (9)**.

6. Enter a 5-, 9-, or 11-digit ZIP Code at the PostNet Bar Code prompt, then press **Return** three times.

POSTNET Bar Codes can be inserted above the addressee line or below the last address line.
Adding a POSTNET Bar Code to a Line of Text

You can add a POSTNET bar code anywhere in a document. This feature is a time-saver if you are using window envelopes to mail inserts (such as letters or cards).

1. Place the cursor where you want the bar code to appear in your document.
2. Press Format, then select Other (4).
   * Or Select Other from the Layout menu.
3. Select Bar Codes (9).
4 Enter a 5-, 9-, or 11-digit ZIP Code at the PostNet Bar Code prompt, then press Enter three times.

### Changing an Existing Bar Code in a Document

A bar code cannot be edited. Once it has been inserted in the document, it must be deleted and reinserted to make any changes.

1. Place the cursor immediately to the right of the bar code or bar code block.
2. Press Backspace to delete the bar code.

You can also delete a bar code by placing the cursor immediately to the left of the bar code and pressing Delete or by deleting [Bar Code] in the Reveal Codes window.

If you change your mind after deleting the bar code, choose Undelete from the Edit menu, then choose Restore.

3. Press Format, then select Other (4).
4. Select Bar Codes (9).
5. Enter a 5-, 9-, or 11-digit ZIP Code at the PostNet Bar Code prompt, then press Enter three times.

### Notes

**Typing Bar Code Numbers**

When you type a 9- or 11-digit ZIP code, you can include hyphens (for example, 84097-8602 or 84097-8602-81).

**Printing Envelopes with Bar Codes for Mass Mailings**

If you frequently do mass mailings, you can save time creating envelopes or address blocks with bar codes by using the Merge feature. See POSTNET Bar Codes under Merge.

**Printing Address Labels**

You can print address labels that contain a bar code much like printing envelopes for mass mailings. See Labels.

### Beep Options

Use the Beep Options feature if you want your computer to notify you with a beep when certain messages are displayed on the status line.

1. Press Setup.
   
   Or Select Setup from the File menu.

2. Select Environment (2), then select Beep Options (2).

3. Select an option (see the option headings under Notes below).
Press y to turn on the option.

or

Press n to turn off the option.

5 Repeat steps 3 and 4 above for any other options you want to change.

6 Press Exit to exit the Setup: Beep Options menu.

Notes

Beep on Error
This option determines whether the computer will beep when an “ERROR: ...” message appears on the status line.

Beep on Hyphenation
This option determines whether the computer will beep when Hyphenation is on and the “Position Hyphen; Press ESC ...” message appears on the status line.

Beep on Search Failure
This option determines whether the computer will beep when the “**Not Found**” message appears on the status line after a search.

See Also: Hyphenation; Search; Appendix E: Error Messages.

---

**Binding**

Use Binding to print two-sided documents, and to shift text to the right on odd-numbered pages and to the left on even-numbered pages.

This feature is especially helpful with printers that print in duplex (see Double-Sided Printing under Paper Size/Type).

1 Press Print.

   or  Select Print from the File menu.

2 Select Binding Offset (b), then enter the amount you want the text shifted.

3 Press Exit to exit the menu.
Changing the Default

To change the default binding offset for all new documents, use the Print Options feature on the Setup: Initial Settings menu (see Initial Settings).

Documents previously saved with a different binding offset must be retrieved, have the binding changed, then be saved again.

Codes

A code for binding is not inserted into your document, but it is saved with the document. This setting remains in effect for the document until you change it again. When you exit the current document, the Binding Offset setting on the Print menu returns to the default for the next document.

Margin Settings

The binding offset shifts text on a page. On odd pages, the left margin is increased by the amount entered for the binding offset and the right margin is decreased by the same amount. On even pages, the left margin is decreased by the amount entered for the binding offset and the right margin is increased by the same amount. For example, if your left and right margins are set to 1” and you want the text to start printing 1.5” from the left edge of the page, enter .5” as the binding offset. The right margin will then be only .5” wide.

Left margin

Binding offset

To change the default binding offset for all new documents, use the Print Options feature on the Setup: Initial Settings menu (see Initial Settings).

Documents previously saved with a different binding offset must be retrieved, have the binding changed, then be saved again.

Codes

A code for binding is not inserted into your document, but it is saved with the document. This setting remains in effect for the document until you change it again. When you exit the current document, the Binding Offset setting on the Print menu returns to the default for the next document.

Margin Settings

The binding offset shifts text on a page. On odd pages, the left margin is increased by the amount entered for the binding offset and the right margin is decreased by the same amount. On even pages, the left margin is decreased by the amount entered for the binding offset and the right margin is increased by the same amount. For example, if your left and right margins are set to 1” and you want the text to start printing 1.5” from the left edge of the page, enter .5” as the binding offset. The right margin will then be only .5” wide.

If you want the margins to be even (not including the binding offset) on both odd and even pages, there is a formula you can follow.

1. Decide what you want your binding offset to be.
2. Divide that number by 2, then enter that number as the binding offset in the step above.
3. Now you need to change the left and right margin settings.
4. Add the amount you entered for the binding offset to the left and right margin settings (see Margins, Left and Right).
These steps increase the bound edge of the page to a 1.5” margin (allowing .5” for binding) and decrease the other edge of the page to a 1” margin, regardless of whether the page is odd or even.

**One-Sided Documents**
If you create a one-sided document, increase the left margin instead of using the Binding feature.

**Resetting**
To change the binding offset back to zero, repeat steps 1 through 3 above, entering 0 as the binding offset.

**Top Binding**
You can also add the binding offset to the top of the page using the Binding Edge option (7) on the Format: Edit Paper Definition menu (see Paper Size/Type). If you select Top (1), the binding offset you enter in step 2 above moves the text up or down on the page.

**See Also:** Print, Document on Disk; Print, Document on Screen; Print Options; Printing—General Information

---

**Block, Define**

Block highlights any portion of the on-screen document file. You can use the block of text with many other features.

To define a block,

1. Move the cursor to one edge of the text you want to block.
2. Press **Block** to turn on the Block feature.
   
   Or □ Select **Block** from the **Edit** menu to turn on **Block**.
3. Move the cursor to the opposite edge of the text to highlight it.

4. Select the feature you want to use.
Notes

Associated Features
Once a block is defined, you can do a variety of things with it. For example, pressing **Bold** or **Underline** bolds or underlines the block of text. Pressing **Font** and selecting an attribute gives the block the attribute. Pressing **Save**, and entering a filename saves the block as a file.

The following features work with Block:

- Append
- Attributes
- Block Protect
- Bold
- Capitalization (Case Conversion)
- Center
- Comment
- Delete
- Flush Right
- Justification
- Mark Text
- Move
- Print
- Replace
- Save
- Search
- Shell (Append to Clipboard, Save to Clipboard)
- Sort
- Spell
- Styles
- Switch

When you press **Backspace** or **Delete** to delete a block, you are asked to confirm whether you want the block deleted. Type y to delete the block or n to cancel the command.

**Canceling Block**
Block turns off after you perform a function. To cancel a block without performing a function, press **Block** again or press **Cancel**.

**Codes**
Since codes can be included in a block, make sure you press **Reveal Codes** before defining a block. This lets you see the cursor’s location in relation to existing codes. When Block is on, a Block code [Block] in the codes portion of the screen pinpoints the location where the block begins.

**Cursor Movement**
When Block is on, typing any character moves the cursor forward to the next occurrence of that character. If the character is not found in approximately 2000 characters, the cursor remains in place and a beep sounds.

Press **Return** to block the text from the cursor to the end of that paragraph (the next Hard Return code [HRt]).
To block text in a forward or reverse direction, use the arrow keys. You can also use *Search or +Search to search for and highlight text to the end of the search string.

Once you block text, you can use all of the features you normally use with a block (see Associated Features above).

Once you block text and release the left arrow key, you can change the block size by pressing the arrow keys. You can also use *Search or +Search to search for and highlight text to the end of the next search string.

**On-Screen Display**
Blocked text usually appears on the screen in reverse video. You can change the appearance of the block using Colors/Fonts/Attributes.

**Redefining a Block**
You can perform more than one function on the same block of text. For example, to underline a block of text, and then bold the same block, press Block, then press Go To twice.

**Saving and Retrieving**
Once a block has been defined, press Save and enter a filename to save the block to a permanent file, or press Return to save the block in a temporary buffer.

If a block exists in the temporary buffer, pressing Retrieve then pressing Return retrieves the block at the cursor. This temporary buffer is deleted when you exit Corel WordPerfect, or when you save another block to the temporary buffer.

---

**Block Protect**

Block Protect prevents a block of text from being split between two pages.

When you work with a document in which the number of lines frequently increases or decreases, Block Protect keeps a block of text together. You can add and delete text from the block itself or from the document. As long as the block is less than a page in length, it will remain together on the same page.

To protect a block,

1. Use Block to block the text you want protected. It must be less than a page in length.

2. Press Format, then type y to confirm that you want to protect the block.

   Or Select Protect Block from the Edit menu.

The block is protected by codes (see Codes below). If part of the protected block must be moved to the next page, the entire block will be moved to the next page.
Block Protect and Hard Returns

Two consecutive protected blocks must be separated by at least one Soft Return code [SRt] or Hard Return code [HRt] (see Page, Soft and Hard). If they are not separated, the blocks are treated as one large block. To avoid these problems, you can define blocks from character to character and exclude all Hard Return codes when you protect blocks of text.

Block Protect vs. Conditional End of Page

Block Protect keeps a block of text together even though you may add or delete text from the block. Conditional End of Page keeps a specific number of lines together, such as a heading and the first two lines of a paragraph.

Codes

When you protect a block, it places a Block Protect On code [Block Pro:On] at the beginning of the block and a Block Protect Off code [Block Pro:Off] at the end.

Even if the Block Protect On code does not come at the beginning of the line, the entire line of text is protected.

You can cancel the block protection by deleting the codes. Deleting either code deletes the pair.
Cancel

Press Cancel to do any of the following:

• Back out of a menu or status line message without saving changes.
• Cancel a hyphenation request, forcing the word to wrap to the next line.
• Recover up to nine levels of deleted text.
• Turn off Block.
• Cancel a search or macro in operation.

Notes

Backing Out of Menus and Options
To back out of a menu, press Cancel. For some menus, you must press Cancel more than once.

To save any changes you have made, press Exit. Pressing any letter or number that is not listed as a menu option also backs you out of a menu and saves any changes you have made.

Help Menus
When you press Cancel in a Help menu, it displays the help screen for the Cancel feature. Cancel does not back you out of the Help menus. Press Return or the Space Bar to exit the Help menus.

Macros
Pressing Cancel cancels a macro in operation, but it does not cancel a macro definition. To end a macro definition, press Macro Define. When you press Cancel in a macro definition, it inserts the Cancel keystroke into the definition.

Recovering Text
When you press Cancel in the editing screen, a highlighted block appears in your document and a message appears on the status line asking if you want to restore that block.

The highlighted block contains the last text or codes you deleted from your document and appears at the cursor. If nothing appears in the block in the normal editing screen, you can press Cancel, press Reveal Codes, then press Cancel again to see the codes inserted into your document.

Select Restore (1) to restore the highlighted block, or select Previous Deletion (2). You can press Up Arrow or Down Arrow to display up to your last nine deletions. Corel WordPerfect stores the nine previous deletions in temporary files. These temporary files are erased when you exit Corel WordPerfect. You can also use the Undelete and Restore features to move text in a document.

Reveal Codes
Pressing Cancel in the Reveal Codes screen does not turn off Reveal Codes. You must press Reveal Codes.

See Also: Exit; Undelete
Capitalization

To capitalize individual characters, type the character while holding down the Shift key. You can also use the Caps Lock key to type a group of uppercase letters.

1. Press Caps Lock to begin typing uppercase letters.
2. Type the text.
3. Press Caps Lock again to end typing uppercase letters.

Notes

Converting Existing Text
To convert existing text to all uppercase or lowercase letters,

1. Block the text.
2. Press Switch.
   Or Select Convert Case from the Edit menu.
3. Select Uppercase (1) or Lowercase (2).

Corel WordPerfect is case sensitive. This means that words that start with “I” followed by an apostrophe and the first words of sentences remain capitalized when you select lowercase. When you block the text to be converted, include the punctuation from the end of the preceding sentence in the block to make sure that Corel WordPerfect recognizes the first letter of a sentence. If there is no preceding punctuation, Corel WordPerfect does not recognize the beginning of a sentence and will not leave a capital letter.

Shift and Caps Lock
Caps Lock affects only letters A through Z. To type the characters displayed above the numbers at the top of your keyboard, press Shift, then the number.

Small Caps
If your printer has a small caps font, you can select it using the Attributes feature. The text you type will then be printed in the small caps font with slightly larger letters for the letters you type in uppercase.

Status Line
When Caps Lock is on, “Pos” on the status line is displayed in all uppercase letters.

See Also: Attributes; Block; Switch
Cartridges/Fonts/Print Wheels

Many printers let you access additional fonts with interchangeable print cartridges, print wheels, or downloadable font files. Cartridges/Fonts/Print Wheels lets you mark the cartridges, soft fonts, and print wheels you plan to use with your printer.

If you have not purchased any soft fonts, cartridges, or additional print wheels for your printer, you do not need to go into the Cartridges/Fonts/Print Wheels menu.

1 Press Print.

Or Select Print from the File menu.

2 Choose Select Printer, then move the cursor to the desired printer.

You need to have already selected a printer for this feature to work.

3 Select Edit (3), then select Cartridges/Fonts/Print Wheels (4) to display a list of font categories (built-in, cartridges, soft fonts, or print wheels) your printer supports.

If you receive a “Printer files not found” message, Corel WordPerfect cannot find the .all file that was used to define your printer. If you have moved the .all files since the initial installation, you must specify the new directory where the .all files can be found. Or, if you deleted the .all files, you must reinstall the printers.

4 Move the cursor to the type of font you want to mark (see Font Category below), then choose Select (1) to display a list of all fonts of that type which Corel WordPerfect supports.

If you choose Select with the Soft Fonts category highlighted, a Font Groups screen is displayed. Move the cursor to the group which contains the font you want to mark and choose Select (1).

5 Move the cursor to the cartridge, font, or print wheel you want to use with your printer, then mark it as Present When Print Job Begins (*) and/or Can be Loaded/Unloaded During Job (+) (see Marking Cartridges/Fonts/Print Wheels below).

Important: Do not mark fonts you do not have. Corel WordPerfect does not create fonts or provide them for you. It accesses only the font capabilities of your printer.

6 Press Exit to save the markings and return to the list of font categories.

You may need to press Exit twice to return to the list of font categories, depending on whether or not a Font Groups screen was displayed.

You can select another font type and repeat steps 4 through 6 or press Exit to return to the Select Printer: Edit menu. Corel WordPerfect updates the fonts before it returns you to this screen if you have made changes in font selection.
Notes

Available
The Available column screen on the Select Printer: Cartridges/Fonts/Print Wheels shows you the quantity available for cartridges, fonts, or print wheels. This amount is decreased when you mark cartridges, soft fonts, or print wheels with an asterisk (*) (see Marking Cartridges/Fonts/Print Wheels below). This keeps you from selecting more cartridges, soft fonts, or print wheels than your printer can accommodate.

If you change the total quantity (see Quantity below), the Available quantity is also changed by the same amount.

Cartridges • The Available column for cartridges shows how many slots are still available. For example, if you have two slots for cartridges, but have not yet marked any cartridges, the Available column will show “2.” Each cartridge you mark with an asterisk (*) decreases this amount by 1.

Print Wheels • The Available column for print wheels gives the number of print wheels your printer still has available. Each print wheel you mark with an asterisk (*) decreases this amount by 1.

Soft Fonts • The Available column for soft fonts shows the amount of memory still available. This amount is decreased when you mark fonts with an asterisk (*).

Base Font
The fonts you mark using the above steps appear on all Base Font menus as long as they match the Font Type (which is set with the Paper Size/Type feature). In other words, if you have landscape fonts available, they will not appear on the Base Font menus until you select a landscape paper type (see Paper Size/Type). The printer’s built-in fonts also appear on the Base Font menus if they match the Font Type (see Font).

Built-In
Built-In is one of the font categories on the Select Printer: Cartridges/Fonts/Print Wheels screen for dot matrix and laser printers (not for daisy wheel printers); however, no amount is listed under the Quantity or Available headings. Corel WordPerfect marks all these fonts automatically to indicate they are currently in the printer. You can unmark these fonts (see Marking Cartridges/Fonts/Print Wheels below) if you do not want Corel WordPerfect to access them.

Corel WordPerfect makes the built-in fonts available (includes them on the Base Font menus) when you select a printer. Information about each printer’s built-in fonts is copied to the .prs file when you add a printer to the printer definition list (see Printer, Select).

Downloading Soft Fonts
Soft fonts are purchased as software (on diskettes or tape), and must be sent from your computer to your printer. This process is called “downloading” fonts. Corel WordPerfect can download fonts in two ways. If you mark a soft font with an asterisk (*) (see Marking Cartridges/Fonts/Print Wheels below), you will have to initialize your printer every time you turn it on. This sends all fonts
marked with an asterisk to the printer. These fonts remain in the printer (even if you exit Corel WordPerfect) until you turn off the printer (or until you unmark the font, then reinitialize the printer).

If you mark a font with a plus sign (+), it will be downloaded only when it is needed. Then it will be deleted from the printer’s memory.

After marking or unmarking fonts with asterisks and plus signs, reinitialize the printer to make sure the proper fonts are available. If you only mark fonts with a plus sign (no asterisks), you will not need to reinitialize your printer.

**Important:** Mark the fonts you have. Specify a path using the Path for Downloadable Fonts and Printer Command Files option on the Select Printer: Edit menu (see Printer, Edit).

**Font Category**

This heading on the Select Printer: Cartridges/Fonts/Print Wheels screen lists the different types of fonts available for your printer. The choices for this column might include: Built-In, Cartridges, Print Wheels, Slot Fonts, and Soft Fonts. If your printer only has its built-in fonts available, that is the only thing listed under this heading.

**Font Groups**

If you choose Select (1) with the Soft Fonts category highlighted in step 4 above, a Font Groups screen could be displayed (depending on your printer). You would then need to select the font group containing the fonts you want to mark. Once you mark fonts (see Marking Cartridges/Fonts/Print Wheels below), the font group containing the marked fonts is displayed with a bullet (*).

**Marking Cartridges/Fonts/Print Wheels**

After you choose Select (1) in step 4 above, a list of available cartridges, soft fonts, or print wheels (depending on which font category you select) is displayed. If you selected soft fonts, you may need to select a font group before the list is
displayed. The list includes each font, cartridge, or print wheel name and the quantity it represents.

<table>
<thead>
<tr>
<th>Font Name</th>
<th>Quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td>*ECD M110 CS</td>
<td>255</td>
</tr>
<tr>
<td>*ECD M110 CS Bold</td>
<td>0</td>
</tr>
<tr>
<td>*ECD M110 CS Italic</td>
<td>0</td>
</tr>
<tr>
<td>*ECD M110 CS Bold Italic</td>
<td>0</td>
</tr>
<tr>
<td>*ECD M110 CS Condensed</td>
<td>0</td>
</tr>
<tr>
<td>*ECD M110 CS Condensed Bold</td>
<td>0</td>
</tr>
<tr>
<td>*ECD M110 CS Condensed Italic</td>
<td>0</td>
</tr>
<tr>
<td>*ECD M110 CS Condensed Bold Italic</td>
<td>0</td>
</tr>
<tr>
<td>*ECD M110 CS Extra Bold</td>
<td>0</td>
</tr>
<tr>
<td>*ECD M110 CS Extra Bold Italic</td>
<td>0</td>
</tr>
<tr>
<td>*ECD M110 CS Extra Condensed</td>
<td>0</td>
</tr>
<tr>
<td>*ECD M110 CS Extra Condensed Bold</td>
<td>0</td>
</tr>
<tr>
<td>*ECD M110 CS Extra Condensed Italic</td>
<td>0</td>
</tr>
<tr>
<td>*ECD M110 CS Extra Condensed Bold Italic</td>
<td>0</td>
</tr>
<tr>
<td>*ECD M110 CS Blackletter</td>
<td>0</td>
</tr>
<tr>
<td>*ECD M110 CS Blackletter Italic</td>
<td>0</td>
</tr>
<tr>
<td>*ECD M110 CS Blackletter Bold</td>
<td>0</td>
</tr>
<tr>
<td>*ECD M110 CS Blackletter Bold Italic</td>
<td>0</td>
</tr>
</tbody>
</table>

In the upper-right corner of the screen, Corel WordPerfect displays the total quantity of that type of font that your printer can support, along with the quantity still available. In addition, if you are marking soft fonts, the number of fonts your printer lets you mark with an asterisk (*) at one time may be displayed.

For example, if you are marking soft fonts and your printer has 350K of memory, the Available Quantity and the Total Quantity start at 350. As you mark soft fonts with an asterisk (*), the Available Quantity is decreased by the amount of memory needed by those soft fonts, while the Available number of fonts is decreased by one for every font marked.

Depending on the printer, there may be a limit to the number of soft fonts you can mark with an asterisk, regardless of the memory available. (This limit is displayed in the Select Printer: Soft Fonts screen to let you know when you are approaching the limit.) For example, if your printer lets you mark 32 fonts (displayed under "* Fonts" in the upper right corner of the Select Printer: Soft Fonts screen) and you mark 32 fonts, you cannot mark another font with an asterisk (*) or a plus sign (+), even if you have memory available.

Mark the soft fonts or print wheels you have available for your printer with one or both of two possible settings: Present When Print Job Begins (*) or Can be Loaded/Unloaded During Job (+). Cartridges can only be marked with an asterisk.

You can mark soft fonts until the maximum quantity (in memory or number of fonts) is reached. Corel WordPerfect counts all fonts you mark with an asterisk (*) when calculating the available quantity.

**Can be Loaded/Unloaded During Print Job** • Mark a print wheel with a plus sign (+) to be prompted to change the print wheel. Mark a soft font this way if you want it to be loaded and unloaded during a print job. Fonts marked with a plus sign are downloaded only when needed. You cannot mark a font with a plus sign (+) if that font is larger than the remaining available quantity or if the "* Fonts" amount displays 0. For example, if you...
have 350K of memory and have marked 300K of fonts with an asterisk, you
cannot mark any single font that is larger than 50K with a plus sign. (You
cannot mark it because it could not be loaded that font during a print job.)

If you marked a print wheel with a plus sign and selected that font in your
document, the printer stops and your computer beeps to signal a print wheel
change. When this happens, display the Job Control screen, follow the
displayed instructions (shown next to “Action:”), then select Go (3) to
continue the print job.

If you have one print wheel you use more than any other, mark that print wheel with an
asterisk (*) (see Present When Print Job Begins below). Otherwise, you will be prompted to
insert it every time you print with that print wheel.

Some printers can load and unload soft fonts during a print job. Others can
only load fonts during a print job and unload them after the job is finished.
And still others will not let you load and unload fonts at all during a print
job. If the fonts can be loaded and unloaded, the “+ Can Be
Loaded/Unloaded During Job” message appears at the bottom of the screen.
If this message does not appear, Corel WordPerfect will not let you mark any
fonts with a plus sign. In this case, the fonts you intend to use during a print
job must be present when the print job begins (marked with an asterisk).

Marking with Both Settings • Fonts on some printers can be marked with
both an asterisk (*) and a plus sign (+). If a font is marked with both
settings, it is considered “swappable” and Corel WordPerfect will unload it if
the space is needed in the printer’s memory to swap in another font.
Swappable fonts (those marked with an asterisk and a plus sign) are reloaded
at the end of the print job if they were swapped out during the print job.

Any fonts marked with both settings remain marked as initially present each
time Corel WordPerfect is started.

Present When Print Job Begins • Mark a cartridge, soft font, or print
wheel with an asterisk (*) if the cartridge is in a slot, the soft font is in the
printer memory, or the print wheel is already installed when you start a print
job. Marking a cartridge, soft font, or print wheel with this option decreases
the available quantity.

You must select the Initialize Printer option on the Print menu every time
you turn on your printer to download soft fonts marked with this option (see
Downloading Soft Fonts above).

Quantity
Quantity refers to the number of slots available for cartridges, the amount of
printer memory available for soft fonts, or the number of print wheels available.
The quantity number is preset to original printer specifications. If you have
added more memory to your printer, you can change the quantity number by
selecting Change Quantity (2) from the Select Printer: Cartridges/Fonts/Print
menu, then entering the new quantity. The largest number you can enter for the
quantity is 65535.
**Important:** Increasing the quantity of memory available for soft fonts will work properly only if you have physically installed more memory in your printer. If you increase the quantity number and mark more fonts than can be downloaded to your printer’s memory, documents will not print properly when using the fonts that are not completely downloaded.

**Soft Font Programs**
Some third-party soft font programs have installation programs that can add names of fonts and information about those fonts to your printer files. If you have used such a program, the names of those fonts will appear on the Select Printer: Soft fonts screen when you are marking fonts.

**See Also:** Font; Printer, Edit; Printer, Select

---

**Center Page**

Center Page centers text vertically between the top and bottom margins on a page.

1. Press **Go To**, then press **Up Arrow** to move the cursor to the top of the page you want to center, before any codes (see **Codes** below).
2. Press **Format**, then select **Page (2)**.
   - **Or** Select Page from the Layout menu.
3. Select **Center Page (1)**, then type **y** to turn on this option.
4. Press **Exit** to exit the Page Format menu and to return to the document.
Center Text

Use Center to center text between the left and right margins or over a particular point in a line.
The page displayed below shows a title centered between the left and right margins, and several titles centered over columns of text.

When you type new text, you can center a line of text between the left and right margins.

1. Move the cursor to the left margin.
2. Press **Center** to move the cursor to the center of the line.
3. Type the text you want centered.
4. Press **Return** to end centering.

**Notes**

**Center Code**
Pressing **Center** inserts a Center code [Center]. Pressing **Return** inserts a Hard Return code [HRt] and ends the centering. A Center code affects only the line of text which it is on. If you insert a Center code at the beginning of a line and type text that extends beyond that line, only the first line of that text will be centered. The code will not affect subsequent lines of text.

A Center code takes precedence over other text. For example, if you are in the middle of a line of text when you press **Center**, or if the text you are typing runs into a Center code, on-screen text may seem to disappear. Use Reveal Codes to view and delete the unwanted text or code.

**Center vs. Justification**
Center is designed to center only one line of text at a time. When you want to center several lines of text at once, use Center Justification.

**Centering at a Specific Position**
You do not have to center text between margins. If the cursor is not at the left margin and is preceded by a Tab code, or at least two spaces, pressing **Center**, then typing text centers that text over the cursor position.
For example, to center text over a tab stop at position 5”, tab to that position, press Center, then type the text. You can center text more than once on a line if the text is preceded by a tab, or at least two spaces. However, when you center text at a line position, it may overlap any preceding text on-screen and when the document is printed.

Centering Existing Text
You can center an existing line of text by moving the cursor to the beginning of the line of text, pressing Center, then pressing Down Arrow.

This method will not work if the cursor is not at the beginning of the line when you press Center. When the cursor is not at the beginning of the line, or two spaces in from the beginning of a line, pressing Center centers the text to the right of the cursor at the cursor position. This can cause the text to overlap.

Dot Leader
When centering text between margins, you can insert a dot leader from the left margin to the beginning of the centered text by pressing Center twice.

To continue the dot leader to the right of centered text, press Flush Right twice.

You can also insert a dot leader using the Home keystrokes (see Hard Center Tab below).

Hard Center Tab
A Hard Tab is a tab that does not change its type, even if you change the type with the Tab Set feature. You can insert a Hard Center Tab over the next tab stop by pressing Home, Center. Corel WordPerfect inserts a [CNTR TAB] code in the document. To insert a Hard Center Tab with dot leaders, press Home, Home, Center.

Pages of Text
You can use Center Page to center an entire page of text vertically.

Removing Centering
To remove centering, delete the Center code [Center].

Text in Columns
If you are centering text in columns created with the Columns feature, move to the left margin of the column, then follow the steps given at the beginning of this section.

If you are centering text in columns created with tabs or indents, use the method for centering text at a specific line position described under Centering at a Specific Position above.

See Also: Block; Center Page; Justification
Change Mode

When you create a Corel WordPerfect file, you can give access privileges (read, write, and execute) to various users. As the creator of the document, you are called the file owner. Only the file owner or person with superuser privileges can change a file's access privileges. The combined access privileges assigned to a file are called the file's privileges mode.

To change the privileges mode of a file,

1. Press List.
2. Move to the desired file.
3. Press Change Mode (6).
4. To modify the code, type in the new privileges.
5. Press Return to accept the new code.
6. Press Exit to return to the normal editing screen.

Notes

The Privileges Mode

You can display and change a document’s privileges mode from the List Files screen. The sixth column of the List Files screen shows a ten-character code that describes the user privileges, as in the example below.

```
drwxrwxrwx
```

The first character in the code shows whether a listing is a directory file.

The first “rwx” sequence shows the read (r), write (w), and execute (x) privileges of the file owner.

The second “rwx” sequence shows the read, write, and execute privileges of the owner’s group. (The owner’s group is the subgroup of system users to which the file owner belongs.)

The third “rwx” sequence shows the user privileges assigned to other users on the owner’s system.

A hyphen (-) means that the privilege indicated by the character space is not presently assigned.
Colors/Fonts/Attributes

Colors/Fonts/Attributes specifies how text is displayed on the screen. Depending on the capabilities of your terminal, text can be displayed with and without attributes. For example, you may be able to highlight bolded characters on the screen or assign a color to underlined text. For information on printed text, see *Font*.

1. Press *Setup*.
   
   Or  Select *Setup* from the *File* menu.

2. Select *Display* (1), then select *Colors/Fonts/Attributes* (1).

   The screen varies according to terminals.

3. Assign a screen color or screen font to each attribute listed (see *Assigning Fonts and Colors* below).

4. Press *Exit* twice to return to the normal editing screen.

   These settings are in effect for the current editing screen only. For information about setting them for the other editing screen, see *Multiple Documents* below.

   All settings you select are stored in the .wp7c.set file if Corel WordPerfect is run as root. They are in effect each time you start the program.

Notes

Assigning Fonts and Colors

When you assign fonts and colors with Colors/Fonts/Attributes, you assign screen fonts and screen colors. Options vary according to terminals. The way text appears on the screen is independent of the way it is printed.

As you assign screen fonts and screen colors, the first column of the Setup: Fonts menu is a list of the size and appearance attributes found on the Font key. The last column is a sample column that shows you the result of your selections.

Between the first and last columns are columns you use to assign screen fonts or screen colors to the list of attributes. The number and types of these columns vary according to your terminal. The screen shown below is the Setup: Fonts menu for most monochrome displays.

---

<table>
<thead>
<tr>
<th>Attribute</th>
<th>BLINK</th>
<th>REVERSE</th>
<th>UNDERLINE</th>
<th>BOLD</th>
<th>ESC</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal</td>
<td>n</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Blocked</td>
<td>y</td>
<td>y</td>
<td></td>
<td></td>
<td>27</td>
</tr>
<tr>
<td>Underline</td>
<td>y</td>
<td></td>
<td></td>
<td></td>
<td>28</td>
</tr>
<tr>
<td>Strikethru</td>
<td>y</td>
<td></td>
<td></td>
<td></td>
<td>29</td>
</tr>
<tr>
<td>Bold</td>
<td>n</td>
<td>n</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Slanted</td>
<td>n</td>
<td>n</td>
<td>n</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Shadow</td>
<td>n</td>
<td>n</td>
<td>n</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Italics</td>
<td>n</td>
<td>n</td>
<td>n</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Small Caps</td>
<td>n</td>
<td>n</td>
<td>n</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Subscript</td>
<td>n</td>
<td>n</td>
<td>n</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Supercript</td>
<td>n</td>
<td>n</td>
<td>n</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fine Print</td>
<td>n</td>
<td>n</td>
<td>n</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Large Print</td>
<td>n</td>
<td>n</td>
<td>n</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Very Large</td>
<td>n</td>
<td>n</td>
<td>n</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bold # Umbrin</td>
<td>n</td>
<td>n</td>
<td>y</td>
<td>y</td>
<td>27</td>
</tr>
<tr>
<td>Other</td>
<td>n</td>
<td>n</td>
<td>n</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

   Switch documents: Move to copy settings  Del 1
Move your cursor to the row representing the attribute appearance you want to change, then change the settings by pressing a letter or number.

For example, to change the Redline attribute to blinking, bolded text in the screen above, use the Up or Down Arrows to move to the Redline line, then type y under the Blink column and y under the Bold column. The Left and Right Arrows move you from column to column.

To see how text with a particular attribute will appear on the screen, look at the sample column for that attribute.

**Attribute Combinations**

Text can have more than one attribute at a time. For example, text can be both bolded and italicized.

The Setup: Colors/Fonts/Attributes screen does not list all possible combinations. It does, however, list an Other Combinations heading. Most attribute combinations are displayed according to the Other Combinations setting.

**Multiple Documents**

When you set attributes, you are setting them for the current editing screen only. For example, if you are in the Document 6 screen, you are setting them for Document 6. If you are in the Document 9 screen, you are setting them only for Document 9.

Check the “Doc” heading on the status line to find out which editing screen you are in. To move to another document, press Home, followed by the number key of the document you want to switch to. For example, pressing Home-9 takes you to the Setup screen for document 9.

To copy settings from one editing screen to another, go to the Setup: Fonts screen by following the steps at the beginning of this reference section. Press Switch to switch setup screens, press Move, type y, then enter the document number to copy the setting from.

For example, to copy settings from the Document 2 screen to the Document 5 screen, go to the Setup: Fonts screen for Document 2 by following the steps at the beginning of this reference section. Press Switch while in the Document 2 setup screen to switch to the setup screen of Document 5. Press Move, type y, then type 2 followed by Return.
Columns, Display

When you display columns on the screen side-by-side, it can slow the speed with which Corel WordPerfect reformats text as you edit a document.

You can speed up display of columns by turning off Side-by-side Column Display. Columns are separated by page breaks, instead of appearing side-by-side, as in the following example.

1 Press Setup, then select Display (1).
   Or Select Setup from the File menu, then select Display.
2 Select Edit-Screen Options (6).
3 Select Side-by-side Column Display (7), then type \nt to turn off this option.
4 Press Exit to return to your document.

Notes

Automatic Reformatting
When Side-by-side Column Display is off, Corel WordPerfect reformats columnar text with the same speed it uses to reformat any text. You can also increase the speed of editing in columns by turning off Automatic Reformatting.

Text usually reformats each time certain keys are pressed. When this feature is turned off, the screen is only reformatted as you move the cursor through text. It does not reformat each time you press certain keys. To turn this option off, repeat steps 1 and 2 above, select Automatically Format and Rewrite (1), then type \n. Press Exit to return to your document.

Cursor Movement
If columns are not displayed side-by-side on the screen, you can use the same cursor movements to move the cursor through each column, and from column to column (see Moving from Column to Column under Columns, Parallel and Columns, Newspaper).

When columns are not displayed side-by-side on the screen, the Up Arrow and the Down Arrow keys move from column to column each time the cursor crosses a page break. They do not remain in the same column.
Printing
Newspaper and parallel columns are always printed side-by-side on a page, regardless of the type of on-screen display you select. You can see how they will appear in print by using View Document.

See Also: Columns, Newspaper; Columns, Parallel

Columns, Newspaper

Newspaper-style columns let text flow continuously from column to column on a page, and are often used to create newsletters, like the one shown below.

Column width and spacing is automatically calculated when you specify margins and the number of equal-sized columns on a page. You can also use Columns to put existing text into columns.

To define and create newspaper columns,

1. Move the cursor to where you want the columns to begin.

   Or Select Columns from the Layout menu.

2. Press Columns/Table, then select Columns (1).

3. Select Define (3).

4. Enter the number of columns and the margins you want (see Number and Margins below), then press Return or Exit to return to your document with the Columns menu displayed on the status line.

5. Select On (1) to turn on the Columns feature (see Turning Columns On and Off below).
6 Type the text you want in the columns, if necessary. Press Hard Page when you want to end a column and start a new one before reaching the bottom of a page (see Text Flow in Newspaper Columns below).

7 Press Columns/Table, select Columns (1), then select Off (2) to turn off the Columns feature.

Or Select Columns from the Layout menu, then select Off.

---

**Notes**

**Defining Columns**
If you want columns in a document, use the Columns/Definition feature to specify the number of columns and the margins you want. When you define columns, a Column Definition code [Col Def:column type; #columns; margins] is inserted in your document. Column type is the type of columns defined. #columns is the number of columns. Margins indicates the left and right margins for each column. The definition is in effect until another column definition is inserted.

You can turn on Columns only after they have been defined. When Columns are on, “Col #” is displayed before the document number at the status line. # is the number of the current column.

You can have multiple column definitions in a document, but Columns must be off before you can create a new definition.

**Distance Between Columns**
If you do not specify a distance between columns, the distance will be approximately one-half inch. To specify a different distance, select Distance Between Columns (3) from the text Column Definition menu, then enter a new measurement.

Changing the left and right margin settings of columns can also affect the distance between columns.

**Editing in Newspaper Columns**
The cursor keys that move up and down scroll all columns at the same time. These cursor keys include the Up Arrow, Down Arrow, Home, Up Arrow, Home, Down Arrow, Page Up, and Page Down.

The delete keys work inside a single column. For example, if you use Delete to End of Page, only the text from the cursor to the bottom of the current column is deleted.

Use Move within a single column to cut or copy a sentence. Use Block with Move to move an entire column of text. Block a column, press Move, select Block (1), then select a move option. When using move with Newspaper columns, do not select Tabular Column (2), because this option does not let you retrieve the moved text correctly.
Features
You can use columns with several other features such as graphics text boxes and headers. You cannot use columns in footnotes, endnotes, or tables.

To include a table in a column, create the table in a graphics box (see Table, Create).

Margins
Once you select the number of columns, equal columns are created according to your current margin setting. These settings are displayed in the Text Column Definition menu under Margins. If you do not want equal columns, or you need to change the displayed column sizes, select Margins (4) on the Text Column Definition menu. Enter a new measurement for each setting, or press Return to skip a displayed setting.

Changing column margins does not change the left and right margin settings of the document. Make sure the left margin of the first column corresponds to the current left margin setting for the page, and the right margin of the last column corresponds to the current right margin setting for the page. When you place graphic images in columns, problems can occur if these settings do not correspond.

Moving from Column to Column
To move the cursor from column to column,

- Press Go To, then press Right Arrow to move one column to the right, or press Left Arrow to move one column to the left.
- Press Go To, Home, Left or Right Arrow to move to the first or last column on a page.
- Press Go To, then press Up Arrow or Down Arrow to move the cursor to the top or bottom of the current column.

Newspaper vs. Parallel Columns
The default column style is newspaper-style. You can also create parallel columns in which blocks of text are held together side-by-side on a page. Text does not flow from column to column in parallel columns (see Columns, Parallel and Table, Format Columns and Cells).

Number
The default number of columns is two. To change the number on the Text Column Definition menu, select Number of Columns (2), then enter the number of columns you want across a page (up to 24 are possible). If you have already entered a column definition, you can change the number of newspaper columns by placing the cursor immediately after the previous Column Definition code [Col Def:column type,#columns;margins] and redefining the columns. The columns will adjust automatically. You can then delete the previous Column Definition code.

Removing Columns
If you create columns and then want to delete them, you can return your text to normal format by deleting the Column Definition code [Col Def:column type,#columns;margins]. This can be done in Reveal Codes or in the normal
editing screen. The Hard Page codes [HPg] remain and must be deleted manually. To delete one set of columns, delete the [Col On] or [Col Off] codes.

If a previous column definition exists in a document when you delete a column definition, the codes within the column definition remain. The existing columns are formatted according to the previous column definition.

If you have several sets of columns in your document and want to delete only one set, do not delete the Column Definition code. Delete the Column On [Col On] or Column Off [Col Off] code for that set.

**Text Flow in Newspaper Columns**

When the text in a newspaper column reaches the bottom of a page, a Soft Page code [SPg] is automatically inserted and the text moves to the top of the next column on the page. At the end of the last column on a page, a Soft Page break is inserted and the cursor moves to the beginning of the next page.

To end a column before the bottom of a page, press **Hard Page** to insert a Hard Page code [HPg]. This moves the cursor to the next column. In the last column on a page, press **Hard Page** to move the cursor to the first column on the next page.

To display columns side-by-side, use the current column display selection in Setup (see **Columns, Display**).

**Turning Columns On and Off**

Columns can be turned on before or after text has been entered. For example, you can turn on Columns anywhere after a Column Definition code, then turn off Columns where you want the columns to end. Hard page breaks between the [Col On] and [Col Off] codes end the current column of text and begin a new one.

**See Also:** Columns, Display; Columns, Parallel; Table, Create
Columns, Parallel

Use parallel columns for unequal blocks of text that do not flow to the next column. Do not use tabs, indents, or newspaper columns.

This same format can also be created using the Tables feature (see Table, Create).

To define and create parallel columns,

1. Move the cursor to where you want the columns to begin.
2. Press Columns/Table, then select Columns (1).
   
   Or Select Columns from the Layout menu.
3. Select Define (3).
4. Select Type (1) to display the choice of columns at the status line, then select the type of parallel columns you want (see Parallel vs. Parallel with Block Protect below).
5. Enter the number and margins of the columns you want (see Number and Margins below), then press Return or Exit to return to the document with the Columns menu displayed on your status line.
6. Select On (1) to turn on the Columns feature.
7. Type the text (see Entering Text in Parallel Columns below). Press Hard Page when you want to end a column and start a new one.
8. Press Columns/Table, select Columns (1), then select Off (2) to turn off the Columns feature.
   
   Or Select Columns from the Layout menu, then select Off.
**Defining Columns**

Use Columns to specify the number and size of columns.

When you define Parallel columns, a Column Definition code `[Col Def:column type;#columns;margin]` is inserted in your document. When you turn on columns, a Column On code `[Col On]` is inserted. After you enter the text you want in the columns, turn off columns. Text between the `[Col On]` and `[Col Off]` codes is in columnar format.

If you turn on Columns in existing text, the remaining text in the document from the cursor forward will be formatted in the current columns. It can, however, be confusing in parallel columns. For example, if your first parallel column is only one inch wide, all the remaining text in your document will be formatted with a one-inch width.

To insert a group of parallel columns into an existing document, turn on Columns, then turn off Columns. This inserts a Column On code `[Col on]` and a Column Off code `[Col off]`. The format of the subsequent text returns to normal. You can then move the cursor between the Column On and Column Off codes, and insert the new text you want in columns.

**Distance Between Columns**

The distance between columns is automatically calculated unless you enter a Distance Between Columns. To set your own distance, select **Distance Between Columns (3)** from the text Column Definition menu, then enter a new measurement.

Changing the left and right margin settings of columns can also affect the distance between columns.

**Editing in Parallel Columns**

With the exception of using Move, editing text in parallel columns works the same as it does in newspaper columns (see **Columns, Newspaper**).

To edit parallel columns, select Move to move the columns. When you want to move sets of parallel columns, edit the columns with Reveal Codes on.

Typing a set of parallel columns across a page inserts a Column On code `[Col On]` and a Column Off code `[Col Off]` at the beginning and end of the set. When you move a set of parallel columns to another place in the same file, you must block both the Column On and Column Off codes and move them with the text. Without the Column On and Column Off codes, the text in parallel columns is separated by a series of Hard Page codes `[HPg]`. It displays and prints as a series of separate pages.

When you use Block Protect, a Block Protect On code `[Block Pro:On]` and a Block Protect Off code `[Block Pro:Off]` are inserted at the beginning and at the end of each set, next to the Column On and Off codes. When you want to move sets of parallel columns that have been created with Block Protect on, you must also move the Block Protect codes.
Entering Text in Parallel Columns
When you first enter text in parallel columns, type the text you want in the first column, then press **Hard Page** to move to the next column. Press **Hard Page** to continue moving the cursor from column to column across the page. When you reach the last column on the page, pressing **Hard Page** starts a new set of columns, which places you in the first column of a new page in your document. It also inserts an extra Hard Return code [HRt] so that each separate set of columns will be separated by an extra space. If you want your sets of columns to be single-spaced on a page, you must delete the Hard Return code [HRt] between each set of columns.

Features
You can use columns with other features such as graphics text boxes, headers, and footers. You cannot include columns in footnotes, endnotes, or tables.

To include a table in a column, create the table in a graphics box (see Table, Create).

Margins
Once you select the number of columns, settings for equal columns are calculated automatically. These settings are displayed in the Text Column Definition menu under Margins. If you do not want equal columns, or you want to change the displayed column sizes, select **Margins (4)** on the Text Column Definition menu. Enter a new measurement for each setting, or press **Return** to skip over a displayed setting.

To change the column margins for parallel columns, enter a new parallel column definition directly after your existing one and delete the old code. The new column margins take effect, and the existing text is formatted in the new column margins. You can also change the number of columns, but it will reformat the existing text. For example, when two columns are combined into one column, the text in those columns is also combined.

Changing the margins for your columns does not change the left and right margin settings of your document. Make sure the left margin of the first column corresponds to the current left margin setting for the page, and the right margin of the last column corresponds to the current right margin setting for the page. When you place graphic images in columns, problems can occur if these settings do not correspond (see Graphics, Define a Box).

Moving from Column to Column
To move the cursor from column to column, once you have typed text,

- Press **Go To**, then press **Right Arrow** to move one column to the right, or **Left Arrow** to move one column to the left.
- Press **Go To, Home, Left** or **Right Arrow** to move to the first or last column on a page.
- Press **Go To**, then press **Up Arrow** or **Down Arrow** to move the cursor to the top or bottom of the current column.
Number
In the default setting, Corel WordPerfect creates two columns on each page within the existing margins in your document. To change the number of columns on the Text Column Definition menu, select Number of Columns (2), then enter the number of columns you want across a page.

The maximum number of columns you can create is 24. If you enter more columns than can fit within your margins, you will get an error message. If this happens, you can reduce the distance between columns (see Distance Between Columns above).

Parallel vs. Newspaper
In parallel columns, blocks of text are held together side-by-side on a page. You can also create newspaper-style columns, where text moves down the first column to the bottom of the page, then moves to the top of the next column (see Columns, Newspaper).

Parallel vs. Parallel with Block Protect
When you create parallel columns, you can select Parallel (2) or Parallel with Block Protect (3). Using Parallel, a single parallel column can be longer than one page.

In Parallel with Block Protect, each set of columns is held together on one page (unless the text in one of the columns is longer than a page). This is useful when typing such things as inventories where you want to keep sets of items together.

Removing Columns
If you create columns and then want to delete them, you can return your text to normal format by deleting the Column Definition code [Col Def:column type,#columns;margins] from Reveal Codes or in the normal editing screen.

When you delete a column definition, all the codes that go with the column definition are deleted. The Hard Page codes [HPg] remain and must be deleted manually. To delete one set of columns, delete the [Col On] or [Col Off] codes.

If a previous column definition exists in a document when you delete a column definition, the codes that go with the previous column definition remain and the existing columns are formatted according to the previous column definition.

If you have several sets of columns in a document but want to delete only one set, do not delete the Column Definition code. Delete the Column On [Col On] code and Column Off [Col Off] code for that set.

See Also: Columns, Display; Columns, Newspaper
Compose

Use Compose to access characters not found on your keyboard. A list of these characters is found in the Corel WordPerfect Character Sets (see Appendix P).

1  Press Compose.
   Or  Select Characters from the Font menu.

Pressing Ctrl-v displays a “Key =” prompt at the bottom of the screen; the keys you press in steps 2 through 4 below are displayed. Pressing Ctrl-2 displays no prompt and the keys you press do not appear on the screen. However, both keystrokes perform the same function in the normal editing screen.

2  Type the number of the character set containing the character you want to create.

3  Type a comma (,).
   or
   Press Return.

4  Enter the number of the character you want to create.

For example, to create ÅE (character number 36 in Corel WordPerfect Character Set 1), press Compose, then enter 1,36.

Notes

Characters on the Screen
Not all characters in the character sets can be displayed on the editing screen. Some are represented by a tilde or other default character. Use View Document to see how the characters will appear when printed.

Compose with Limited Characters
If you use Compose to enter a character from a Corel WordPerfect Character Set into a long document name, macro description, graphics caption, or other situation where the number of characters is limited, you may not be able to enter as many characters as if you did not use any Compose characters.

Do not use any Compose characters in a UNIX filename. Many of these characters are not valid.

Ctrl-v
Press Ctrl-v to access Compose from the normal editing window. However, if you press Ctrl-v in Window Edit structures such as comments and document summaries, or in Line Edit structures such as macro descriptions and other document summary fields, the “Key =” prompt will not be displayed.

In the Macro Editor press Ctrl-2 instead if Ctrl-v.

Digraphs, Symbols, and Diacritics
You can use Compose to access some of the common digraphs and diacritics from the Corel WordPerfect Character Sets without typing the character set or character numbers. After pressing Compose, type one character followed by another character. You do not need to type a comma between the two characters.
or press Return after typing the characters. You can type either character in the pair first.

**Diacritics** • Diacritics are marks used with characters to represent a certain phonetic value. Accessing diacritics is not as specific as accessing digraphs and symbols. Examples of some diacritics are listed below. Try the diacritics with the character of your choice, or use the Corel WordPerfect Character Set number.

<table>
<thead>
<tr>
<th>Mark</th>
<th>Example</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Acute</td>
<td>'i</td>
<td>í</td>
</tr>
<tr>
<td>Caron</td>
<td>vz</td>
<td>ž</td>
</tr>
<tr>
<td>Cedilla</td>
<td>.c</td>
<td>ç</td>
</tr>
<tr>
<td>Centered Dot</td>
<td>:l</td>
<td>l•</td>
</tr>
<tr>
<td>Circumflex</td>
<td>^a</td>
<td>â</td>
</tr>
<tr>
<td>Crossbar</td>
<td>-t</td>
<td>-t</td>
</tr>
<tr>
<td>Dot Above</td>
<td>.c</td>
<td>ć</td>
</tr>
<tr>
<td>Grave</td>
<td>'e</td>
<td>è</td>
</tr>
<tr>
<td>Macron</td>
<td>_u</td>
<td>ū</td>
</tr>
<tr>
<td>Ogonek</td>
<td>ã</td>
<td>à</td>
</tr>
<tr>
<td>Ring Above</td>
<td>@a</td>
<td>á</td>
</tr>
<tr>
<td>Slash</td>
<td>/o</td>
<td>ø</td>
</tr>
<tr>
<td>Stroke</td>
<td>\l</td>
<td>l</td>
</tr>
<tr>
<td>Tilde</td>
<td>&quot;n</td>
<td>ň</td>
</tr>
<tr>
<td>Umlaut</td>
<td>&quot;u</td>
<td>ü</td>
</tr>
</tbody>
</table>

**Digraphs and Symbols** • The following are some of the digraphs and symbols that can be created with Compose:

<table>
<thead>
<tr>
<th>Type</th>
<th>Character</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>AE</td>
<td>[1,36]</td>
<td>Æ</td>
</tr>
<tr>
<td>ae</td>
<td>[1,37]</td>
<td>æ</td>
</tr>
<tr>
<td>IJ</td>
<td>[1,138]</td>
<td>IJ</td>
</tr>
<tr>
<td>ij</td>
<td>[1,139]</td>
<td>ij</td>
</tr>
<tr>
<td>OE</td>
<td>[1,166]</td>
<td>Œ</td>
</tr>
<tr>
<td>oe</td>
<td>[1,167]</td>
<td>ø</td>
</tr>
<tr>
<td>ox</td>
<td>[4,24]</td>
<td>ø</td>
</tr>
<tr>
<td>ss</td>
<td>[1,23]</td>
<td>ß</td>
</tr>
<tr>
<td>L-</td>
<td>[4,11]</td>
<td>£</td>
</tr>
<tr>
<td>P'l</td>
<td>[4,5]</td>
<td>£</td>
</tr>
<tr>
<td>&lt;&lt;</td>
<td>[4,9]</td>
<td>«</td>
</tr>
<tr>
<td>&gt;&gt;</td>
<td>[4,10]</td>
<td>»</td>
</tr>
<tr>
<td>Y=</td>
<td>[4,12]</td>
<td>Ý</td>
</tr>
<tr>
<td>Pr</td>
<td>[4,13]</td>
<td>Pr</td>
</tr>
<tr>
<td>c/</td>
<td>[4,19]</td>
<td>c</td>
</tr>
<tr>
<td>+/-</td>
<td>[6,1]</td>
<td>±</td>
</tr>
<tr>
<td>&lt;=</td>
<td>[6,2]</td>
<td>&lt;=</td>
</tr>
<tr>
<td>&gt;=</td>
<td>[6,3]</td>
<td>&gt;=</td>
</tr>
<tr>
<td>==</td>
<td>[6,14]</td>
<td>==</td>
</tr>
</tbody>
</table>
Keyboard Mapping
You can “map” characters you frequently use to a specific key (or keys) on the keyboard. Use Compose with Keyboard Layout to map these characters.

Printable Characters
If your printer can print graphics, you can print every character in the Corel WordPerfect Character Sets (see Appendix P). If your printer does not have a specific character, the character is created with the .drs (driver resource) file and then printed as a graphic image. With diacritics, often only the diacritical mark must be created graphically.

If your printer cannot print graphics, some characters from the Character Sets will not print. See Printer Program, Customize Substitute Fonts to find out how you can increase the number of characters you can print as text.

See Also: Keyboard Layout; Printer Program, Customize Substitute Fonts; Appendix P

Conditional End of Page
Use Conditional End of Page to keep titles and subsequent paragraphs together. This protects a specified number of lines from being split between pages.
In the document below, the paragraph title is separated from the paragraph by a page break.

In the document below, Conditional End of Page keeps the title and paragraph on the same page.

Before you use Conditional End of Page, determine the number of lines you want to keep together.

1 Move the cursor to the line immediately above the lines you want kept together (even if there is text on that line).

2 Press Format, then select Other (4).

Or Select Other from the Layout menu.

3 Select Conditional End of Page (2).

4 Enter the number of lines to keep together.

5 Press Exit to return to the document.

**Notes**

**Codes**

Places a Conditional End of Page code Cndl EOP: # in your document, where # is the number of lines to be held together. A soft page break is inserted instead of splitting the protected lines. To separate protected lines, press Hard Page.
Conditional End of Page vs. Block Protect
Conditional End of Page protects a specific number of lines from a certain point forward. Block Protect protects a block of text.

Line Spacing
When entering the number of lines to be protected, consider any blank lines that will result from double- or triple-spaced text. For example, to keep a heading and the first line of a paragraph together in double-spaced text, enter 4 and not 2 as the number of lines to protect.

Convert Program
The Corel WordPerfect Convert Program (cvt) converts files from selected programs to Corel WordPerfect, and Corel WordPerfect files to other programs. To convert a file to ASCII format (with no word-processing codes), use Text In/Out.

Command Line Convert
Corel WordPerfect 8c for UNIX uses a command line format to convert files from the UNIX command line.

To use the Convert Utility,

1. Make sure the Convert Utility (cvt) is in your path (the Installation Program copies it to the shbin directory).

2. Enter `cvt [-ohi] input output type`

The table below gives examples of the conversion process, using the Convert Utility.

<table>
<thead>
<tr>
<th>Input Filename</th>
<th>Convert Command</th>
<th>Output Filename and File Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>doc.in</td>
<td>cvt doc.in doc.out</td>
<td>doc.out (Corel WordPerfect 8c file)</td>
</tr>
<tr>
<td></td>
<td>wp8c</td>
<td></td>
</tr>
<tr>
<td>doc2.in</td>
<td>cvt -i doc2.in</td>
<td>doc2.out (Navy DIF file)</td>
</tr>
<tr>
<td></td>
<td>doc2.out ndif</td>
<td></td>
</tr>
</tbody>
</table>

Notes
Three flags are available. The `-h` flag displays a help screen which describes the usage of cvt. This screen also appears if cvt is called without arguments.

The `-i` flag specifies the ISO Latin-1 character set. If `-i` is not specified, cvt uses the extended ASCII character set.

The `-o` flag overwrites existing output files. If `-o` is not specified, and the output file already exists, nothing will be converted or written to the output file.
Auto-Detection
The Convert Utility automatically detects the input file type. You only need to specify the output file type in the type argument.

If the Convert Utility detects a file it cannot convert, the output file will not be created, and cvt will return an error message to the UNIX shell. Because Corel WordPerfect 8c calls cvt for file conversions, cvt cannot generate error messages.

Output File Conversion Types
The type argument specifies the format of the output file. The table below shows the abbreviation of each output file type.

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Output File Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>asc</td>
<td>7-bit ASCII</td>
</tr>
<tr>
<td>asci</td>
<td>8-bit Extended ASCII</td>
</tr>
<tr>
<td>dw40</td>
<td>DisplayWrite® 4.0</td>
</tr>
<tr>
<td>mm37</td>
<td>Multimate® Advantage II</td>
</tr>
<tr>
<td>ndif</td>
<td>Navy DIF Standard</td>
</tr>
<tr>
<td>rft</td>
<td>IBM® DCA Revisable-Form-Text</td>
</tr>
<tr>
<td>fft</td>
<td>IBM® DCA Final-Form-Text</td>
</tr>
<tr>
<td>wd40</td>
<td>Microsoft® Word 4.0</td>
</tr>
<tr>
<td>wp42</td>
<td>WordPerfect® Corporation’s WordPerfect 4.2</td>
</tr>
<tr>
<td>wp50</td>
<td>WordPerfect® Corporation’s WordPerfect 5.0</td>
</tr>
<tr>
<td>wp51</td>
<td>Corel® WordPerfect 5.1</td>
</tr>
<tr>
<td>ws33</td>
<td>WordStar® 3.3</td>
</tr>
</tbody>
</table>

See Also: Document Conversion; Retrieve; Text In/Out

Corel® Versions®
Corel® Versions® is the solution to the problem of trying to control and track multiple copies of the same file. Instead of trying to keep track of all your updates to a file by saving new versions of it under different file names, Corel Versions lets you save the changes you have made to each successive version of your file. Each version is archived to its own directory, or the directory of your choice, on any read/write drive, including hard drives and disks.

Corel Versions lists all your archived files in a history list, allowing you to retrieve any archived file if you need a previous version. Corel Versions also lets you compare any two files to see the text differences between them.

With Corel Versions you can

- Archive previous versions of your files
- Retrieve any archived version of a file
- View any archived version of a file
- Compare archived files to see the differences between them
• Attach meaningful information to each archived version that can be viewed in the document history window
• Track multiple users of a common file
• Delete any archived file from the history list
• Specify how many versions to keep in the document history list (when the number is reached the oldest version is discarded), or keep all of them
• Protect a specific archived version from being discarded from the history list by using the permanent option

Corel Versions can also be used on a network when a group will work on the same files. Each saved version displays the name of the user who archived it.

For more information on how to use Corel Versions, see Corel WordPerfect’s online Help.

Cross-Reference

Cross-references are often used in legal documents, research papers, or other documents to refer the reader to a page number, table number, or footnote number.

<table>
<thead>
<tr>
<th>Cross-references</th>
</tr>
</thead>
<tbody>
<tr>
<td>Despite advice to the contrary, Metcalf has always maintained that employees should be given direction instead of management. To that end, he has worked to give employees a voice in both their job description and the goals of this company. Maximizing the Organization However, in all the attention to employees, the goal to provide quality merchandise at discount prices (see figure 4) continues to give purpose and direction to the company. As indicated in the Operating Expenses table (again, see page 2), that goal contributes to the recent venture into retail outlets. After the opening of several retail stores in 1990, sales increased by 50% in the last quarter. However, as demonstrated by the table figures, operating expenses were often more than twice those of the third quarter.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Operating Expenses</th>
</tr>
</thead>
<tbody>
<tr>
<td>Expense</td>
</tr>
<tr>
<td>1990</td>
</tr>
</tbody>
</table>

Use Cross-Reference to marks references and targets. After editing the document, generate to update the cross-references.
Cross-references consist of:

- Reference
- Target
- Target name

The reference is the location from which you are referring. It is where you create the text and numbers that send a reader to other parts of the document. The examples shown at the beginning of this section are references.

The target is the location to which you refer the reader. In the examples shown above, the targets are where you look after you read the information.

The target name is a unique identifier that ties references and targets together. When you generate or compile your cross-references, the target name matches references and targets.

*The target name is only used during generation. It is not printed, and is only displayed in Reveal Codes.*

To create a cross-reference,

- Mark the references and targets and include a target name.
- Generate the cross-references.

To mark the reference and target in one operation,

1. Move the cursor to where you want to create the reference.
2. Type any introductory text you want to include, then press the **Space Bar** to add a space between the introductory text and the location of the reference (see **Introductory Text** below).
3. Press **Mark Text**, then select **Cross-Ref** (1).
   
   Or  ![Select Cross-Reference from the Mark Menu.]
4. Select Mark Both Reference and Target (3) to begin marking the reference and target.
   
   Or  ![Select Both from the Cross-Reference submenu.]
5. Select the type of reference you want to use (see **Reference Types** below).
6. Move the cursor to a position immediately after the target, then press **Return**.

*Make sure the cursor is after the target by checking Reveal Codes.*

7. Enter a target name (see **Target Name** below).
8. If necessary, finish typing the introductory text for the reference.
9. Repeat the steps above, marking all references and targets in your document.
10. Press **Mark Text**, then select **Generate** (6).
    
    Or  ![Select Generate from the Mark menu.]

---

72  Cross-Reference
Select Generate Tables, Indexes, Cross-References, etc. (5), then type y to generate.

The last cross-references generated are the cross-references that are printed. You should generate the cross-references before you print the document to ensure that cross-references are correct. For a more detailed explanation of Generate, see Generate.

**Notes**

**Introductory Text**

Corel WordPerfect inserts a number, letter, or character at the spot of the reference when the cross-references are generated. If you want introductory text that explains the number or letter, you must type the text.

The only exceptions to this rule occur if you reference graphics box numbers or page numbers. For graphics box numbers, Corel WordPerfect inserts the Caption Number Style before the box number. If the Caption Number Style includes text, the text appears when the cross-reference is generated. For more information about Caption Number Styles, see *Graphics Options*.

For page numbers, Corel WordPerfect inserts the Page Number Style. If the Page Number Style includes text, the text appears when the cross-reference is generated. See *Page Numbering*.

**Mark Reference Only**

You can create the reference before the target is created.

To mark only the reference,

1. Move the cursor to the position where you want to create the reference.

2. Type any introductory text you want to include, then press the Space Bar to add a space between the introductory text and the location of the reference (see *Introductory Text* above).

3. Press Mark Text, then select Cross-Ref (1).

   Or  Select Cross-Reference from the Mark menu.

4. Select Mark Reference (1) to begin marking the reference.

   Or  Select Reference from the Cross-Reference submenu.

5. Select the type of reference you want to use (see *Reference Types* below).

6. Enter a target name.

7. If necessary, finish typing the introductory phrase for the reference.

Repeat the steps above for additional references you want to mark separately. When you mark a reference, [Ref(target name):type] can be seen in Reveal Codes.

A question mark (?) appears in place of the reference number. Once you mark targets and generate cross-references, the question mark is replaced by the correct information (see *Mark Target Only* below).
**Mark Target Only**

If you marked or plan to mark a reference separately and want to create a target, you can mark the target separately.

To mark only a target,

1. Move the cursor to a position immediately after the target.  
   *Use Reveal Codes to be sure of the cursor location.*

2. Press **Mark Text**, then select Cross-Ref (1).  
   *Or*  
   *Select Cross-Reference from the Mark menu.*

3. Select Mark Target (2) to mark the target.  
   *Or*  
   *Select Target from the Cross-Reference submenu.*

4. Enter a target name. The target name should be the same as the target name for the reference (see Target Name below).

Repeat the steps above for all targets you want to mark separately. When you mark a target, [Target (target name)] can be seen in Reveal Codes.

If you marked all your references and targets, you are ready to generate the cross-references.

To generate the cross-references,

1. Press **Mark Text**.

2. Select Generate (6).

3. Select Generate Tables ... (5), then type y.

**Master Documents**

If your document is extremely long, you can use Master Document to divide it into smaller files. You can still generate cross-references which include any references and targets marked in subdocuments.

**Multiple Cross-References**

You can create two types of multiple cross-references. The first type cross-references the same target with one or more reference types. The second type cross-references one or more targets with the same reference type.
To create the first type, mark a reference for each different reference type. You only need one target. For example, in the following cross-reference mark two references, a page number reference and a graphics box reference.

Cross-reference

The Next Fifty Years
While the recent upswing in the growth of HALVA International is a welcome indicator, there are also potential problems that need to be addressed.
However, if these needs are met, the company can look forward to a bright and exciting future through the decade of the 1990’s and beyond.

Expanding Markets
From oriental rugs to imported jewelry, HALVA International has always provided a variety of merchandise to its customers. However, the variety of products has often been limited to those items that are a known quantity.
Recent trends indicate, however, that there is profit to be made in areas such as oriental furniture and music boxes. In fact, our research indicates that music boxes may become a long-term, profitable investment (see page 4, figure 2).

Expanding Resources
You must mark the target once if both references use the same target name. The target can be marked in the same operation as one of the references, or separate from both of the references.

To create the second kind of cross-reference, you must mark the reference once, but mark each target separately. The targets should have the same target name. For example, in the following cross-reference you should mark one page number reference.

Cross-reference

In this report, the past, present, and future status of HALVA International are reviewed (see pages 4, 10, 12), with an emphasis on these characteristics as being vital to the continued survival of the company.

The European Connection
The year was 1939, and the rumors of war had become a nightmare of reality. With the transportation of goods between many countries blocked, and the lines of economic communication virtually severed, intercontinental business was at a standstill.

"Suddenly, the entire face of economics changed to a survival industry. Manufacturing resources were transformed overnight into a war machine. Sacrifice of conveniences became the test of civil loyalty."

"It was an awkward, if not impossible, time for the birth of an import/export business. But, then, Bryan Metcalf was no ordinary individual.

The Roots of Mail Order

Cross-Reference 75
You should mark a target on each page you refer to. You can mark one of the targets in the same operation as the reference, but you must mark at least two targets separately. When you generate, the cross-references will be separated by a comma and a space.

**Reference Types**

You can reference page numbers, paragraph/outline numbers, footnote numbers, endnote numbers, and graphics box numbers. If you cross-reference a graphics box number, you must also select the type of graphics box you want to cross-reference.

To mark a target for most of these items, move the cursor to the immediate right of the code that represents that item, then mark the target. For example, mark a paragraph number by moving the cursor to the immediate right of the paragraph number code you want to cross-reference, then mark the target.

You can mark the target with Reveal Codes on to make sure the cursor location is correct.

The following are exceptions:

- If you mark a page number, move to the text on the page that you want to cross-reference, then mark the target. Make sure you mark the target within the text. This ensures that the cross-reference will be correct even if the text is moved to a different page.

- To mark a page number for a footnote or endnote, display the footnote or endnote in its editing screen, Footnote (1) or Endnote (2), Edit (2), note number) before marking the target.

To mark a page number for an endnote, you must generate endnotes for the page number to appear correctly (see Generate).

- To mark a page number for a graphics box, place the target in the graphics box caption. If the box “bumps,” the correct page number is still referenced.

- If your reference is located in a graphics box caption, a header, or a footer, you cannot mark the reference and the target in the same operation. You must mark the reference and target separately (see Mark Reference Only and Mark Target Only above).

**Target Name**

The Target Name “ties” the reference and target together. When Corel WordPerfect generates cross-references, it looks for matching target names, then creates the cross-reference.

The target names must be an exact match. For example, if you type “Bird” at the reference and mistakenly type “Birds” at the target, the two will not match, and Corel WordPerfect cannot create the correct cross-reference.

Target names, however, are not case specific. “BIRD” and “bird” are considered the same.
Update Cross-References
The last cross-references generated are the cross-references that are printed. You should generate the cross-references before you print the document, so cross-references will be correct. For a more detailed explanation of Generate, see Generate.

See Also: Generate

Cursor Movement
The cursor is the on-screen box that indicates where you are in a document.

Use cursor movement keys to move a character, a word, a screen, or a page at a time. You can also move to either edge of the screen or to the top or bottom of your document.

Notes
Codes
As you move the cursor through text, it also moves through codes. If you press Left Arrow or Right Arrow and the cursor does not appear to move, it is probably moving through codes. Use Reveal Codes to display the codes on the screen as you move the cursor through the document.

Cursor Appearance
The cursor is usually displayed on the screen as a small blinking box, but may differ depending on your terminal.

Cursor Movement Keystrokes
The following table lists the keystrokes you can use to move the cursor through text in a document.

<table>
<thead>
<tr>
<th>Location</th>
<th>Cursor Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Left One Character</td>
<td>Left Arrow</td>
</tr>
<tr>
<td>Right One Character</td>
<td>Right Arrow</td>
</tr>
<tr>
<td>Left One Word</td>
<td>Word Left</td>
</tr>
<tr>
<td>Right One Word</td>
<td>Word Right</td>
</tr>
<tr>
<td>Left Side of Screen</td>
<td>Home,Left Arrow</td>
</tr>
<tr>
<td>Right Side of Screen</td>
<td>Home,Right Arrow</td>
</tr>
<tr>
<td>Far Left of Line (even when the line extends beyond the left edge of the screen)</td>
<td>Home,Home,Left Arrow</td>
</tr>
<tr>
<td>Far Right of Line (even when the line extends beyond the right edge of the screen)</td>
<td>Home,Home,Right Arrow or End</td>
</tr>
<tr>
<td>Up One Line</td>
<td>Up Arrow</td>
</tr>
<tr>
<td>Location</td>
<td>Cursor Keys</td>
</tr>
<tr>
<td>-------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Down One Line</td>
<td>Down Arrow</td>
</tr>
<tr>
<td>Top of Screen (then up one screen at a time)</td>
<td>Home, Up Arrow or Minus (−) on the number keypad</td>
</tr>
<tr>
<td>Bottom of Screen (then forward one screen at a time)</td>
<td>Home, Down Arrow or Plus (+) on the number keypad</td>
</tr>
<tr>
<td>First Line on the Previous Page</td>
<td>Page Up</td>
</tr>
<tr>
<td>Up One Paragraph</td>
<td>Ctrl-Up Arrow</td>
</tr>
<tr>
<td>Down One Paragraph</td>
<td>Ctrl-Down Arrow</td>
</tr>
<tr>
<td>First Line on the Next Page</td>
<td>Page Down</td>
</tr>
<tr>
<td>Beginning of a Document (after any formatting codes)</td>
<td>Home, Home, Up Arrow</td>
</tr>
<tr>
<td>Beginning of a Document (before any formatting codes)</td>
<td>Home, Home, Home, Up Arrow</td>
</tr>
<tr>
<td>End of a Document (after any formatting codes)</td>
<td>Home, Home, Home, Down Arrow</td>
</tr>
</tbody>
</table>

**Cursor Movement Pattern**

As you move the cursor up or down in a document, the cursor retains its current horizontal position. For example, if the cursor is at Position 4.5” on one line, it stays at Position 4.5” in all the lines it moves through. If they are shorter than 4.5” long, the cursor moves to the right edge of the line.

**Escape**

Use Escape to move the cursor a specific number of characters, lines, or pages. Press **Escape**, type a number, then select the cursor control key you want repeated.

**Go To**

Use Go To to move the cursor to a specific character or page, the top or bottom of the current page, a different column, or back to its original position.

**See Also:** Go To; Repeat Value; Reveal Codes
Date

Date inserts the current date as text or as a code that is replaced by the current date each time you retrieve or print that document. You can select one of the three formats.

To use Date,
1. Move the cursor to the place where you want the date inserted.
2. Press Date/Outline to display the Date/Outline menu on the status line.
3. Select an option to insert the current date or a Date code into your text (see Date Text or Date Code below).

Or Select a Date option from the Tools menu.

Notes

Date Code
Selecting Date Code (2) from the Date/Outline menu inserts a Date code at the cursor position. In the normal editing screen and when the document is printed, the Date code is replaced by the current date. Each time you retrieve the document at a later date, the Date code is updated to reflect the current date.
You can see the code in Reveal Codes. It is displayed as [Date:format] where format represents the format in which the date will be printed (see Date Format below).

**Date Format**

Normally, the date is inserted as *month day, year* (November 19, 1991). You can change the format to other formats. For example, November 19, 1991 can also be printed as: 19 November, 1991; Sun Nov 19, 1991; or 11/19/91 (Sunday). A date can also include the time, single words, or phrases.

To change the date format, select Date Format (3) from the Date/Outline menu.

### Numbers

<table>
<thead>
<tr>
<th>Number</th>
<th>Date Format</th>
<th>Display</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Day of the Month</td>
<td>March 15, 1990</td>
</tr>
<tr>
<td>2</td>
<td>Month (number)</td>
<td>March 15, 1990 — 10:55am</td>
</tr>
<tr>
<td>3</td>
<td>Day (in American)</td>
<td>DATE: 2/1/5 (6)</td>
</tr>
<tr>
<td>4</td>
<td>Hour (24-hour clock)</td>
<td>TIME: 8:90</td>
</tr>
<tr>
<td>5</td>
<td>Day of the Week (word)</td>
<td>DATE: 3/15/90 (Tuesday)</td>
</tr>
<tr>
<td>6</td>
<td>Year (2-digit)</td>
<td>TIME: 10:55am</td>
</tr>
</tbody>
</table>

Inserting the percent sign (%) before a format number adds a zero to any number that is less than ten or abbreviates the names of the months and days.

### Format

<table>
<thead>
<tr>
<th>Format</th>
<th>Display</th>
</tr>
</thead>
<tbody>
<tr>
<td>2/1/5</td>
<td>3/6/90</td>
</tr>
<tr>
<td>%2/%1/5</td>
<td>03/06/90</td>
</tr>
<tr>
<td>3 1, 4</td>
<td>November 21, 1990 (Monday)</td>
</tr>
<tr>
<td>%3 1, 4</td>
<td>Nov. 21, 1990 (Mon)</td>
</tr>
</tbody>
</table>

Inserting the dollar sign ($) before a format number adds a space to any number that is less than ten, and abbreviates the names of the months and days.

### Format

<table>
<thead>
<tr>
<th>Format</th>
<th>Display</th>
</tr>
</thead>
<tbody>
<tr>
<td>2/1/5</td>
<td>3/6/90</td>
</tr>
<tr>
<td>$2/$1/5</td>
<td>3/ 6/90</td>
</tr>
</tbody>
</table>
The month names, day names, and their abbreviations are determined by a language resource file (wp.lrs) provided with Corel WordPerfect. To change the month and day names or their abbreviations, edit the wp.lrs file (see Language Resource File).

Changing the date format affects only those date codes which are inserted after the format has been changed. This lets you insert different date formats in a document.

Any changes made to the date format are erased when you exit Corel WordPerfect.

To change the date format permanently,

1 Press Setup.
2 Select Initial Settings (3).
3 Select Date Format (2).
4 Enter a new format.
5 Press Exit to save your changes and return to the normal editing screen (see Initial Settings).

Date Text
Selecting Date Text (1) from the Date/Outline menu inserts the current date at the cursor as text (March 18, 1991). The way the date is written is determined by the current date format (see Date Format above).

Language
If a language code is in effect at the Date code, the text of the date and the date format corresponds with the language code. To change the language being used, change the language code (see Language).

You can also change the way the month and day names and their abbreviations are written in a specific language by editing the language resource file (see Language Resource File).

Merge Files
You can include a {DATE} command in a primary merge file. Corel WordPerfect inserts the current date when you perform the merge. Move the cursor to the place in the file where you want the code inserted, press Merge Codes, select More (6), type d to move to the {DATE} code, then press Return (see Merge).

Wrong Date and Time
Corel WordPerfect does not set the date and time. If your system clock is incorrect, contact your system administrator.

See Also: Initial Settings; Language; Language Resource File; Merge Codes
Delete Codes

Codes determine how your text looks on the screen and the printed document. However, these codes are not shown in the normal editing screen.

When you run into problems with on-screen text, you can move through the text in the Reveal Codes screen and delete any unwanted codes.

1. Press Reveal Codes
   Or Select Reveal Codes from the Edit menu.

The cursor is displayed in the normal editing screen. It is highlighted in the screen which displays text accompanied by codes (see Reveal Codes).

2. Move the cursor to a code using any of the cursor keys or Search (see Searching for Codes below).

3. Press Delete to delete the code at the cursor.

4. Press Reveal Codes again to return to the normal editing screen.
   Or Select Reveal Codes from the Edit menu.

Notes

Normal Editing Screen
You can delete codes while in the normal editing screen. When you use Delete or Backspace to delete text in the normal editing screen, you are usually asked to confirm the deletion of any codes.

Using any deletion method other than Delete and Backspace usually deletes any codes within the deleted text. For example, most codes are deleted when you use Delete Word, Delete to End of Line, or Delete to End of Page. Most codes are also deleted when you use Block to block text and delete it.

Corel WordPerfect, however, keeps the attributes of text the same unless you change them. If you block only one of the two codes in a paired code (bold, underline) and delete the block, Corel WordPerfect inserts the necessary code to keep the bolded text bolded, or the underlined text underlined (see Attributes).

If you delete codes by mistake, you can restore them using Undelete.

Searching for Codes
To delete multiple occurrences of unwanted codes from your text, press *Search or Search, press the keys used for a specific feature, then press *Search or Search again to begin the search. The cursor moves to the right of the first occurrence of the code. Press Backspace to delete it.

For example, to search for a left or right margin setting press *Search, press Format, select Line (1), then select Margins (6) to insert a Left/Right Margin code [L/R Mar] in the Search string. You cannot press *Search, then type [L/R Mar] to search for the Left/Right Margin code. You must use the necessary keystrokes to insert the code into the search string (see Search).

To search for the second code in a set of paired codes, insert both codes in the pair into the search string and delete the first code. For example, to search for
the Bold Off code [bold], press \textbf{Search}, press \textbf{Bold} twice to insert a pair of bold codes ([BOLD][bold]) into the search string, press \textbf{Left Arrow} to move to the immediate right of the Bold On code [BOLD], press \textbf{Backspace} to delete it, then press \textbf{Search} to begin the search.

Replace can also search for unwanted codes and delete them. If you do not enter a replacement string, the code you search for is deleted when you use Replace.

See Also: Replace; Reveal Codes; Search

Delete Files

Once you delete a file, Corel WordPerfect cannot restore that file.

To delete files,

1. Use \textbf{List} to display an on-screen listing of the files in a directory (see \textit{List Files}).

   \textit{Or} \textbf{Select List Files from the File menu.}

2. Use one of the Delete features as described in \textit{Notes} below.

Notes

\textbf{Deleting a Single File}

To delete a file on a displayed file list, use the cursor keys or Name Search to move to the file, select \textbf{Delete (2)}, then type \textit{y}.

\textbf{Deleting All the Files in a Directory}

Files are divided into groups called \textit{directories}. When a list of files is displayed on-screen, the name of the directory being listed is displayed at the top center of the screen. The names of any subdirectories within that directory appear alphabetically at the first of the list, with a <DIR> to the right of each directory name.

When a list of the files in a directory is displayed, you can delete all the files in that directory by pressing \textbf{Mark Text} or \textbf{Home,*} to mark all the files with an asterisk (*), selecting \textbf{Delete (2)}, then typing \textit{y} twice. Because the deleted files will be erased, you are asked twice to confirm whether you want to delete the marked files.

You cannot delete a directory until all the files in it have been deleted. Once a directory is empty, you can highlight the empty directory, select \textbf{Delete (2)}, and type \textit{y} to delete it (see \textit{Directories}).

\textbf{Deleting Several Files in a Directory}

To delete several files at the same time, move the cursor to each file you want to delete, type an asterisk (*) to mark each file, then select \textbf{Delete (2)}. Type \textit{y} twice, and the marked files are deleted.

After pressing \textbf{Delete} or selecting \textbf{Delete (2)} to delete the marked files, if you answer \textit{No} by typing \textit{n}, you are asked if you want to delete the file on which the
cursor is resting even if it is not marked. You can delete that file by typing y or skip over it by pressing any other key.

You can unmark a marked file by moving the cursor to the filename and typing an asterisk (*) again. Before selecting Delete (2), you can mark or unmark any file on the list. Even after selecting Delete, you can press Cancel at any time before completing the deletion process.

**Restoring Lost Files**
If you delete an important file, you can try to restore it using a file recovery program. See your computer dealer for more information.

**Short Cuts**
You can display a specific group of files in a directory and then use Mark Text to mark and delete the files as described in *Deleting All the Files in a Directory* above.

When you press List, the name of the current directory is displayed, followed by *. This character causes all the files in that directory to be displayed (usr/work/*).

For example, if a directory contains several files with the .ltr extension, changing the * to *.ltr (usr/work/*.ltr), then pressing Return will display only the .ltr files. You can then press Mark Text to mark all the .ltr files, select Delete (2), then type y twice to delete them.

See Also: Directories; List Files

---

**Delete Text**

There are many ways you can delete part of a document.

**Notes**

**Codes**
When you use Delete and Backspace to delete text in the normal editing screen, you can delete both text and codes (see *Appendix B: Codes* for a list of codes).

When you use any other deletion keystroke, any unseen codes within the text are automatically deleted (see *Deletion Keystrokes* below).

**Deleting Using Block**
Block makes it easy to delete large portions of text in a document. You can use Move or Block and the cursor keys to block several paragraphs or pages of text, and then delete the blocked text by pressing Backspace or Delete and typing y.

When you delete a block of text, any codes within that text are also deleted. Press Reveal Codes before you block the text you are going to delete to avoid deleting any important codes.
Deletion Keystrokes
The following table lists keystrokes to delete text.

<table>
<thead>
<tr>
<th>Deletion</th>
<th>Keystrokes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Character to the left of the cursor</td>
<td>Backspace</td>
</tr>
<tr>
<td>Character at the cursor</td>
<td>Delete</td>
</tr>
<tr>
<td>Word at the cursor</td>
<td>Delete Word</td>
</tr>
<tr>
<td>From the cursor to the end of the line</td>
<td>Delete to End of Line</td>
</tr>
<tr>
<td>From the cursor to the end of the page</td>
<td>Delete to End of Page, y</td>
</tr>
<tr>
<td>Blocked text</td>
<td>Backspace, y or Delete, y</td>
</tr>
<tr>
<td>Delete from cursor to beginning of word</td>
<td>Home,Backspace</td>
</tr>
<tr>
<td>Delete from cursor to end of word</td>
<td>Home,Delete</td>
</tr>
</tbody>
</table>

Restoring Deletions
If you delete text by mistake, it is not immediately lost. Corel WordPerfect stores your last nine deletions. Pressing Cancel displays your last deletion on the screen and highlights it. You can select Restore (1) to insert the currently displayed deletion into your text at the cursor, select Previous Deletion (2), or press Up Arrow or Down Arrow to continue displaying up to your last nine deletions (see Undelete).

Directories
A directory is a special file that stores the names of a group of files, groups the files, and keeps them organized. (You can organize your directories with List Files.)

To create a new directory while in Corel WordPerfect,

1. Press List.
   
   Or  Select List Files from the File menu.

2. Type an equal sign (=).
   
   or  Press Return, then select Other Directory (7) from the List Files menu.

3. Enter the name of a new directory (see Pathnames below).

4. Type y to create the directory.

Notes
Default Directory
Each time you start Corel WordPerfect, a directory is selected to save and retrieve document files. This directory is called the default directory. When you save or retrieve a document file, enter a filename to save the file to, or retrieve the file from the default directory.

You can find out which directory is the default by pressing List. The directory displayed at the bottom left of the screen is the default directory.
If you specify a documents directory using Location of Files in Setup, that directory is used as the default directory. If you do not specify a documents directory, the default directory is the working directory from which you entered Corel WordPerfect.

Changing the Default • To change the default directory, follow the steps above for creating a directory, but enter the name of a directory that already exists instead of the name of a new directory. This changes the default while you are in Corel WordPerfect.

However, if you exit and restart Corel WordPerfect, the default returns to the working directory from which you entered Corel WordPerfect.

Deleting a Directory
You can delete a directory from the List Files screen, but the directory must be empty before you can delete it.

1 Move the cursor to an empty directory (<DIR> appears in the Size column to indicate directories) in the List Files screen.

2 Select Delete (2).
   or
   Press Delete.

3 Type y to delete the directory.

If the directory contains any files, you will receive an error message indicating the directory is not empty. Look in the directory (see List Files), to delete or move all files in the directory, then repeat steps 1 through 3 above.

List Files
List Files lets you display all or some of the files in a directory. (A directory has <DIR> in the Size column of the List Files screen.)

The file size, date, and time it was created (or last revised) are displayed with each filename, and kept in the directory.

Pathnames
A full pathname includes subdirectory names. Each name is separated by a slash (/). For example, “/usr/home” refers to the home directory in /usr. “/usr/home/test” refers to the test subdirectory (or file) in the home directory in /usr.

To specify a document filename that is not found in the default directory, enter the full pathname, including the filename. For example, to retrieve a document named letter from your home directory, enter /usr/home/letter at the “Document to be Retrieved:” prompt.

See Also: List Files
When you change the base font, text can wrap differently on the screen, depending on the size of the font. The width of the on-screen characters does not change, but the number of characters that fit on one line varies.

In the screen below, notice where the text wraps.

Here is the same text. Now notice where the text wraps.

The only difference between the two screens is that the first screen represents text that will be printed in 10pt text, while the second screen represents text that will be printed in 18pt text. Since 18pt text is taller and wider than 10pt text, fewer 18pt characters can fit on one line.

Corel WordPerfect does not change the size of the characters on the screen, but it accurately represents the number of characters that will fit on one line of the page when the text is printed. It calculates the printed width of characters and spaces (taken from information in the printer files) to determine how many characters will fit on the line of text.

Corel WordPerfect may run across certain codes (Indents, Tabs, Table Margins, or Column Margins) that require an absolute measurement, a code that is represented by a specific distance (1.5"), not a specific number of characters. When Corel WordPerfect encounters these codes, it cannot use character
information from the printer files to determine the correct on-screen representation of the code. Instead, it uses the display pitch.

Display pitch determines the amount of space (in width) one on-screen character or space represents. It helps Corel WordPerfect display codes that require an absolute measurement. For example, if the display pitch is set to .1˝, a 1˝ indent occupies the same space as 10 characters or spaces (10 x .1 = 1).

When the display pitch measurement is decreased, the document on the screen expands horizontally. If you use the 1˝ indent from the example above and change the display pitch to .05˝, the indent occupies the same space on the screen as 20 characters or spaces (20 x .05 = 1).

Corel WordPerfect is initially set to adjust the display pitch automatically. You can, however, enter your own display pitch setting. Since Corel WordPerfect uses the display pitch for only the few codes mentioned above, change the display pitch when you want to change the space allotted on the screen to these codes.

Display Pitch only affects the way text is displayed on the screen. It does not affect the way text is printed. To see how a document will appear when it prints, use View Document.

To set the display pitch,

1 Press **Format**, then select **Document** (3).
   
   *Or* Select **Document** from the **Layout** menu.

2 Select **Display Pitch** (1).

3 Press **y** to set the display pitch automatically.
   
   *Or* Press **n** to enter a display pitch.

4 Enter a display pitch width. The initial (default) setting is .1˝.
   
   *If Corel WordPerfect is setting the display pitch automatically, the display pitch you enter has no effect.*

5 Press **Exit** to return to the document.

The setting made with this option is in effect for the entire document. When you save the document, the display pitch is saved with it. When you exit the document, the display pitch setting is returned to Automatic.

### Notes

**Codes**

Unlike most other features, a display pitch change does not insert a code into your document. The setting can be changed anywhere in your document and is in effect for the entire document.
Columns
Display Pitch makes columns more readable on the screen. For example, if text in columns overlaps, you can decrease the display pitch to increase the amount of space between columns.

Rewrite
If there are no absolute measurement codes in the portion of the document on the screen, selecting Rewrite resets Display Pitch and adjusts the text.

Tables
Display Pitch can increase or decrease the amount of on-screen space allotted to table cells. The setting only affects the width of the cells and does not affect the amount of text that can be entered in a cell.

See Also: Display Setup

Display Setup

Display Setup lets you change the way text and menus are displayed on-screen. This can help you simplify document creation and editing. Each option is described in its own section (Colors/Fonts/Attributes; Edit-Screen Options; Graphics Screen Type; Menu Options; View Document, Options).

The options in Display Setup do not affect printed text.

1 Press Setup.

Or Select Setup from the File menu.

2 Select Display (1).

3 Select an option from the Setup: Display menu, then make the necessary changes.

4 Press Exit to return to the normal editing screen.

Selections made with any of the Setup: Display menu options are stored in the .wp8c.set file and remain in effect each time you start Corel WordPerfect.

Notes

Options
Options are described in Colors/Fonts/Attributes; Edit-Screen Options; Graphics Screen Type; Menu Options; and View Document, Options in Reference.
Document Comments

Document Comments lets you add comments or reminders to your text that do not print as part of the document. These comments appear in a box when your document is displayed on the screen.

Comments have several purposes. For example, you can use comments to remind you of changes you need to make to a document (information that needs to be added when it becomes available). You can include suggested test questions on a class-study paper as comments. Also, people who are reading the same file can list their suggested changes as comments so the original text of the document remains intact.

To create a comment,

1. Press **Text In/Out**, then select **Comment (4)**.
2. Select **Create (1)**.

An empty comments box is displayed.

3. Type the text of your comment (see *Entering and Editing Text* below).
4. Press **Exit** to save the comment and return to your document.

The comment is inserted at the cursor.
Notes

Creating a comment inserts a Comment code [Comment] in your text.

When comments are hidden (see Hiding Comments below), you can find them by using •Search and •Search to search for the Comment code (see Search).

A comment may artificially separate a line of text when it does not appear at the beginning of the line, as in the following example.

One line of text

A comment is considered a single code. When you use the arrow keys to move through text, you can pass over the comment with a single keystroke. The comment does not affect the line of printed text.

Columns and Comments
When you include a comment in text that is formatted in parallel or newspaper columns, the comment does not appear on-screen. If you format existing text into newspaper columns, any comments within the text will not appear. The comments will reappear when you remove the Column codes (see Turning Columns On and Off under Columns, Newspaper).

Editing an Existing Comment
To edit an existing comment, move the cursor after the comment, press Text/In Out, select Comment (4), then select Edit (2).

Corel WordPerfect initially searches backward for a comment. If it cannot find a comment, it searches forward. Corel WordPerfect then displays the first comment it finds on the screen in the comments box. You can edit the comment and press Exit to save your changes.

Entering and Editing Text
You can use the standard cursor movement and deletion keys to edit the text of a comment. You can also use Bold and Underline to emphasize text, or add other characters with Compose.

You cannot use the Speller, Thesaurus, or Search in the Comments screen.
Hiding Comments
You can edit a document without having on-screen space taken up by comments. You can keep comments from being displayed on the screen by turning off Comments Display in Setup (see Edit-Screen Options).

Printing Comments
The Comment code and the comment itself do not effect printed text. If you want to print the comment, you must change it into text. With the cursor after the comment, press Text/In Out, select Comment (4), then select Convert to Text (3).

Corel WordPerfect searches backward from the cursor. If it does not find a comment, it searches forward. Corel WordPerfect then changes the first comment it finds to text. Since the characters in the comment are inserted immediately at the comment code, you may need to add spacing and punctuation before and after the comment to blend it correctly into the existing text.

See Also: Edit-Screen Options

Document Compare
Document Compare compares two different versions of the same document and notes the differences between the documents.

Differences are marked phrase-by-phrase, not word-by-word (see Phrases below). When you compare two documents, keep a copy of both documents stored on disk before making the comparison. You can then exit the new compared document without saving it and retrieve either original.

To compare a document on the screen with another document on disk,

1 Press Mark Text, then select Generate (6).
   Or Select Generate from the Mark menu.

2 Select Compare Screen and Disk Documents and Add Redline and Strikeout (2).

You are asked to enter the name of a document on disk you want to compare with the on-screen document. If the on-screen document has been saved, its filename is displayed as the default choice.

3 If you made changes to the document on screen and you want to compare it with the original which is still on disk, press Return.
   or
   Enter the name of a document on disk.

While the two documents are being compared, a counter appears at the left end of the status line.
When the comparison is finished, the differences are marked and the cursor is placed at the beginning of the on-screen document (see Difference Indicators below).

**Notes**

Document Compare uses several indicators to mark differences.

<table>
<thead>
<tr>
<th>Difference</th>
<th>Indicators</th>
</tr>
</thead>
<tbody>
<tr>
<td>Added Phrases</td>
<td>A pair of Redline codes [REDLN][redln] are placed around the phrase that was added.</td>
</tr>
<tr>
<td>Deleted Phrases</td>
<td>A pair of Strikeout codes [STKOUT][stkout] are placed around the phrase that was deleted.</td>
</tr>
<tr>
<td>Moved Phrases</td>
<td>Inserts THE FOLLOWING TEXT WAS MOVED before and THE PRECEDING TEXT WAS MOVED after the phrase that was moved.</td>
</tr>
</tbody>
</table>

Redline and Strikeout codes do not appear in the normal editing screen. They can be seen in Reveal Codes.

Normally, Strikeout puts a dash through text (see Redline/Strikeout). You have three options as to how redlined text appears in print (see Redline Method under Document Format).

The appearance of Redline and Strikeout text in the normal editing screen depends on your monitor and display card capabilities. If Redline and Strikeout markings are not displayed in your normal editing screen, you can modify your settings for the Redline and Strikeout attributes under Colors/Fonts/Attributes in Setup so that you can clearly identify these passages (see Colors/Fonts/Attributes).

You can also display the marked passages by printing the document, or by previewing the printed text in View Document, as in the following example.

---

*invite your friends to take a look at Malvio Corporation.*

*The public is welcome.*

*The tour includes a brief overview of company history.*
Phrases

The phrases used as a basis of comparison are, as much as possible, the sentences in your document (not the words).

A phrase is defined as the text found between two phrase markers. The phrase markers Corel WordPerfect uses are those items which normally punctuate sentences, including punctuation marks (period, comma, exclamation point, question mark, colon, semicolon), Hard Return codes [HRt], Hard Page codes [HPg], Footnote codes [Footnote:#[Note Num] text], Endnote codes [Endnote:#[Note Num] text], and the end of the document.

Corel WordPerfect starts from the first word in your document and compares the text in the two documents until it reaches a phrase marker. If any change has been made, Corel WordPerfect marks the phrase, noting the change (see Difference Indicators above). Corel WordPerfect then starts the comparison again from that point. It continues to the end of the document, marking from phrase marker to phrase marker.

The comparison includes any text found within the footnotes, endnotes, or tables in your document. If a change has been made to the text included in these features, it is marked.

The comparison does not include changes made to text found within graphics boxes, headers, or footers.

Because punctuation can vary, the phrases that Corel WordPerfect marks may not always correspond to the grammatical sentences in your document. For example, to cut down on the length of the phrases being used for comparison, Corel WordPerfect considers any group of words that end with commas as a phrase. Grammatically, such a group is an incomplete sentence.

Undoing the Comparison

After making a comparison, you can restore the document on the screen to its original format before the comparison was made. To have Corel WordPerfect remove the markings, press Mark Text, select Generate (6), select Remove Redline Markings and Strikeout Text from Document (1), then type y.

This deletes Redline codes, Strikeout codes (and the text found between them), and the notations around the moved phrases (see Difference Indicators above). This also deletes any Redline codes and Strikeout codes (and the text found in between them) that were already a part of your document before you made the comparison. It leaves the cursor at the end of the document.

If many differences have been marked, restoring a compared document to its original state can become complicated. When you compare two documents you want to keep, have a copy of both documents stored on disk before making the comparison. You can then exit the new compared document without saving it and retrieve either original.

See Also: Redline/Strikeout
To convert a document created in WordPerfect Corporation’s WordPerfect 4.2, retrieve the 4.2 document. The “Document Conversion in Progress” message will be displayed. All text and most codes will be converted to 8c. If the document displays correctly, save it in 8c and your document conversion will be complete.

To convert a 5.0 or 5.1 document, retrieve the document, then save it. All codes should convert.

To convert a 8c document to 5.1 or 5.0, see Text In/Out.

**Changing Fonts**

When you retrieve a 4.2 document, 4.2 fonts are automatically converted to a 8c equivalent.

Fonts converted from 4.2 to 5.0 used a now-obsolele standard.crs file. If your 5.0 document used any of these fonts, play the font macro to convert them to 8c.

1. Turn on Reveal Codes to locate any fonts that need to be changed.
2. Press Macro.
3. At the macro prompt, type the full path to the wplib directory (where font.wpm is located), followed by font (for example, /usr/.wprc/wplib/font).
4. Press Return.
5. From the Base Font menu, cursor up or down to highlight the font you want to replace.
6. Press Return.

The macro cannot distinguish between different point sizes of a scalable font. For example, a CG Times 12-point font and a CG Times 14-point font are treated as the same font. The macro will replace both. After the message, you are asked whether you want to continue with replacement of the font.

7. Select Y to return to the Base Font Menu. Cursor up or down to highlight the replacement font, and press Return. Enter the point size and press Return.
   or
   Press N to stop the macro and return to the normal editing screen.

The macro replaces the fonts in your document, and will show how many fonts were replaced.

**See Also:** Convert Program; Document Conversion, Versions 8c to 5.1; Text In/Out
Document Conversion, Versions 8c to 5.1

The easiest way to convert a Corel WordPerfect 8c document to WordPerfect Corporation’s WordPerfect 5.1 is to use the Save as option on the Text In/Out key. If the document displays correctly as it is, you do not need to do anything.

See Also: Convert Program; Document Conversion, Versions 4.2 and 5.1 to 8c; Text In/Out

Document Format

Use Document Format options to change the format of the current document. For example, use Document Format to change the initial base font or create a document summary.

1 Press Format, then select Document (3).

Or Select Document from the Layout menu.

2 Select an option, then make any necessary changes in your document (see Notes below).

3 Press Exit to return to the normal editing screen.

Notes

Display Pitch
To change the space on the screen allotted to tabs, indents, or column “gutters,” change the display pitch.

Changing the display pitch does not insert a code in your text, but it does affect the on-screen appearance of the text.

Initial Base Font
When you select a printer, an initial base font is assigned with that printer (see Printer, Select). The Initial Base Font lets you override the setting for a document. The font you select using this option becomes the base font for that document, unless you change it using Base Font (see Font).

Initial Codes
The Initial Codes option lets you display the codes you inserted in the Initial Codes option on the Setup: Initial Settings menu. You can then edit these settings or insert new codes for a document. Any changes you make using this option override the settings made on the Setup: Initial Settings menu. The method for entering the codes is the same for both features (see Initial Codes).

The codes you enter using this option do not appear in the document, but they take effect from the beginning of the document, and remain in effect until you enter new codes in the document to change them.
Redline Method
This feature determines how Redline marking is displayed on the printed page for a specific document (see Redline/Strikeout).

Select Printer Dependent (1), Left (2), or Alternating (3).

Printer Dependent marks the redlined text according to the redline string in the .prs file, as displayed when you print printer.tst (see Font). Left marks redlined text with a vertical bar (|) in the left margin. Alternating marks redlined text with a vertical bar in the left margin for even-numbered pages and in the right margin for odd-numbered pages.

When you select Left or Alternating, you are asked for a redline character that will be placed in the margins. The default is the vertical bar (|). You can enter the redline character by typing the character or by using Compose to enter any character in the Corel WordPerfect character sets.

Summary
Select Summary (5) to create or edit a document summary for the document you are creating.

See Also: Display Pitch; Document Summary; Font; Initial Settings; Redline/Strikeout

Document Summary

Document Summary helps you organize and quickly locate your documents.

If you create a document summary for a file, that summary is the first thing which is displayed when you look at the contents of the file in List Files. When you look through a directory that contains many large files, you do not have to scroll through the text of each file to determine the file’s contents.

Instead, you are presented with a brief on-screen summary of each document which shows the author, the typist, and a short description of the file’s contents.
If you use Long Document Name, the summary lists the UNIX name and the long name for each document (see Name and Type below).

The document summary also displays the date the summary was created and the latest revision date of the document. If you make different revisions of the same file, you can edit the document summary for each revision, indicating the differences. You can quickly display a summary of the changes made in that revision and the revision date.

Document summaries also let you search when you use Find in List Files (see the information on keywords under Document Summary Menu below).

You can create or edit a document summary anywhere in your document.

1. Press **Format**, then select **Document** (3).
   
   * Or **[ ]** Select Document from the Layout menu.

2. Select **Summary** (5).

3. Select the options and enter the information you want in the document summary (see Document Summary Menu below).

4. Press **Exit** to return to the document and save your changes.

The cursor returns to its original place in the document.

With the Document Summary menu on-screen, press **Cancel** to return to the previous menu, ignoring any changes you made.

---

**Notes**

**Create Summary**

You can set Create Summary on Save/Exit in Setup to Yes to be prompted to create document summaries. When Create Summary is set to Yes, Corel WordPerfect displays the Document Summary menu each time you save or exit a document (see Document Management/Summary under Environment Setup).

**Delete**

Creating a document summary does not insert any codes in a document. When you create a summary for a document, the only way you can delete it is by pressing **Delete**, then typing y while the cursor is on the status line in the Document Summary menu. This deletes the document summary and returns you to the normal editing screen.

If you delete a document summary, you cannot restore it. You must create a new summary for that document.
**Document Summary Menu**

When you display the document summary menu using steps 1 and 2 at the beginning of this section, it shows the information contained in the current summary.

<table>
<thead>
<tr>
<th>Selection:</th>
<th>2</th>
<th>(Retrieve to capture: Not to remove summary)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Document Summary</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Revision Date</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td>1 - Creation Date 10-03-91 04:50p</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2 - Document Name</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Document Type</td>
<td></td>
</tr>
<tr>
<td></td>
<td>3 - Author</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Typist</td>
<td></td>
</tr>
<tr>
<td></td>
<td>4 - Subject</td>
<td></td>
</tr>
<tr>
<td></td>
<td>5 - Account</td>
<td></td>
</tr>
<tr>
<td></td>
<td>6 - Keywords</td>
<td></td>
</tr>
<tr>
<td></td>
<td>7 - Abstract</td>
<td></td>
</tr>
</tbody>
</table>

The Creation Date is still displayed on the Document Summary menu if no summary exists for a document. If the document has a Revision Date, Long Document Name, or Long Document Type, these entries are also displayed.

The Revision Date is the latest date the document was revised. A revision date cannot be edited or changed. When you edit and save a document, Corel WordPerfect updates the date according to your computer's date and time.

To change an entry on the document summary menu, select the entry, then enter the information you want. You can use the standard cursor movement and delete keys to edit text. You can also use Bold, Underline, and Compose. However, you cannot use other editing features such as the Speller, Thesaurus, or Search.

**Abstract** • The Abstract entry (7) can contain 780 characters, which excludes any space required for extended characters created using Compose. An abstract is usually a brief summary of a document's contents. You can type an abstract in this entry, or you can press **Retrieve** when the cursor is on the Document Summary menu and type y. This retrieves the first 400 characters of the document as its abstract (see **Retrieve** below).

**Author and Typist** • The Author and Typist entries (3) can contain 60 characters, which excludes any extra space required for extended characters. You can type names in these entries, or you can press **Retrieve** and type y when the cursor is on the Document Summary menu. This retrieves the latest Author and Typist entries which you saved to a document summary during that editing session (see **Retrieve** below).

**Creation Date** • The Creation Date (1) is the date the document summary was created. It remains the same unless you change it.

Once you select this entry, you can edit the existing date and time, or enter a new one. For the date, enter the month, day, and year, separated by slashes. For the time, enter the complete time.
Information Entries • Entries 4 through 6 on the Document Summary menu can contain 160 characters, which excludes any extra space required for extended characters.

Select Subject (4) to enter any information that will help you identify a document. You can type a subject or you can move to the status line in the Document Summary menu, press Retrieve, then type y to retrieve the first 160 characters of the Subject entry from the document (see Subject Entries below).

Select Account (5) to enter any information which will help you identify the document.

Select Keywords (6) to enter keywords that label a document. When you use Find in List Files, you can search for the Keyword entries from the document summaries.

Name and Type • The Document Name entry (2) applies to the Long Document Name. A long document name can contain 68 characters. A long document type can contain 20 characters.

Corel WordPerfect does not recognize pathnames in long document names, and treats them as part of the long document name.

If a document already has a long name and type, they are displayed in this entry. You can enter or edit the long name and the type in Document Summary. If you change them, the new name and type appear when you exit or save the document.

If you set Long Document Names in Setup to No, a long document name and type you place in the Document Summary will be included with the document when you save it. The long document name is displayed on-screen when you use Long Display in List Files.

Retrieve
When the cursor is on the status line in the Document Summary menu, you can press Retrieve and type y to retrieve all of the following entries into the Document Summary menu:

• The latest author and typist entries saved with a document summary during that editing session.
• The first 160 characters of a subject entry in the document as the Document Summary Subject entry (see Subject Entries below).
• The first 400 characters of the document as the Document Summary Abstract entry.

These entries are retrieved at the same time.

Saving and Printing Summaries
To save a document summary to a file while the Document Summary menu is on-screen, press Save, then enter a filename. If the filename you enter already exists, you are asked if you want to replace the file or add to it. Select Replace...
(1) to replace the contents of the file with the summary text or Append (2) to add the summary text at the end of the existing file. When it appends a document summary to a file, a Hard Return code is inserted immediately before the document summary.

When a document summary is displayed on-screen, you can print it by pressing Print. When you print selected pages of a document, you can type s to print the document summary. The printed appearance of the prompts on the document summary menu is determined by the wp.lrs file, which is provided with Corel WordPerfect. You can change the appearance of these prompts in print by editing the wp.lrs file (see Language Resource File).

**Subject Entries**

Normally, RE: is the standard heading for the subject entry in official documents. When you retrieve a subject from your document by pressing Retrieve and typing y while the cursor is on the status line, Corel WordPerfect searches the document for an RE: notation. It copies the text immediately following the RE: (up to 160 characters or the next Hard Return code [HRt]) into the Subject entry.

You can search for any subject heading you select by changing the Subject Search Text in Setup. Press Setup, select Environment (3), select Document Management/Summary (4), select Subject Search Text (2), then enter the subject heading. The heading you enter becomes the notation Corel WordPerfect looks for in the future.

When entering the subject search text, you can enter 39 standard characters, which excludes the extra space used by any extended characters you add using Compose.

**System Filename and System Filetype**

When you print a document summary, Corel WordPerfect includes entries that do not appear on the Document Summary menu, and adds the necessary information. These entries are System Filename and System Filetype. The system filename is the complete UNIX pathname for the document. The System Filetype is the version of Corel WordPerfect used to create that document.

**See Also:** List Files
Edit-Screen Options

Change the appearance of the normal editing screen with the Edit-Screen options. These options do not affect printed text.

1 Press Setup.
   
   Or Select Setup from the File menu.

2 Select Display (1), then select Edit-Screen Options (6).

3 Select the option you want, then make the necessary changes to your document (see the option headings under Notes below).

4 Press Exit to return to the normal editing screen.

Settings are stored in the .wp8c.set file.

Notes

Automatically Format and Rewrite
Use this option to format text on the screen after an editing change. If the option is set to No, text is formatted as you scroll through the document. If the setting is Yes, it is formatted after each change.

Select No for faster editing.

To manually rewrite the screen press Screen, then select Rewrite (3).

Comments Display
This option specifies whether document comments are displayed on the screen. See also Document Comments.

Filename on Status Line
This option specifies whether the document filename is displayed on the status line. If you set this option to Yes, and you edit a document that has been previously saved, the filename appears on the left end of the status line.

The filename can be replaced with messages even if you set this option to Yes.

Hard Return Display Character
Normally, when you press Return to end a paragraph or short line of text, the cursor moves to the next line without displaying any type of character. To display a character at each hard return, select this option, then type the character.

You can enter a character from the Corel WordPerfect character sets with Compose.

If you insert a character and want to delete it, go back to the Hard Return Display option, then press the Space Bar.

The Hard Return Display Character will not print or display in View Document.

Merge Codes Display
This option determines whether merge codes are displayed on the screen. For more information about Merge, see Merge.
Reveal Codes Window Size
This option lets you enter the number of lines you want to allot to the Reveal Codes screen. For example, you can allot 10 lines.

Or, you can allot three lines.

If you choose to allot one line, only the character or code where the cursor is located is displayed in the Reveal Codes screen.

Side-by-side Columns Display
This option determines whether columns created using Columns are displayed on the screen side-by-side or on separate pages. Columns always print side-by-side, but you can edit a document more quickly if they are displayed on separate pages.

Update Status Line Every
This option determines whether the status line is updated every character, line, or space. If you set this option to line or space, it speeds up the editing process.

See Also: Colors/Fonts/Attributes; Display Setup; Menu Options
Environment Setup

The options on the Environment Setup menu let you:

- Set backup options to safeguard against losing documents.
- Instruct the computer to sound a “beep” when certain status line messages are displayed.
- Speed up the document saving process.
- Make default settings for Hyphenation.
- Determine the units of measure for the status line features that require a measurement.
- Set the default format for saving or retrieving text files.

To set the options on the Environment Setup menu,

1. Press **Setup**.
   Or  Select Setup from the File menu.

2. Select Environment (2).

3. Select an option, then make the necessary adjustments to your document.
   General information on each of the options is found under Notes below.
   More information can be found under specific headings in Reference.

4. Press **Exit** to return to the normal editing screen.

The settings are stored in the .wp8c.set file.

---

**Notes**

**Alternate Keyboard**
You may be able to assign Help to the Cancel key, Cancel to Escape, and Repeat Value to Help, depending on the terminal you are using. Contact your system administrator for information. If you set this option to Yes, you can still select a keyboard layout (see Keyboard Layout).

**Backup Options**
There are two backup options, Timed and Original. These options act as safeguards against losing documents.

Timed backup makes a copy of the current document every few minutes. This prevents large amounts of work from being lost because of machine failure, power outage, or other computer-related problems. Original backup lets you save the original and replacement versions of the same document. This prevents the loss of a document that was replaced by mistake.

For more information see Backup, Timed and Backup, Original.
**Beep Options**
The Beep Option notifies you with a “beep” when it displays an error message, prompts you for hyphenation, or cannot find search text. For more information see Beep Options.

**Document Management/Summary**
This option lets you make selections for Document Summary and Long Document Names.

Create Summary on Save/Exit (1) specifies whether you want Corel WordPerfect to create a document summary for you when you save a document. This option is only in effect if you have not already created a document summary.

Subject Search Text (2) specifies what Corel WordPerfect searches for when it inserts information under the Subject heading in a Document Summary.

Default Document Type (4) specifies what is inserted under the Document Type heading when you create a Document Summary.

These options are in effect for all document summaries, but you can override the Subject Search Text and Document Type entries for individual document summaries with Document Summary. Once a summary is created, it can be edited only with Document Summary.

Long Document Names (3) specifies whether you want to name a document with a long document name when you save the document. It also lets you give a more descriptive name to your documents.

*You can enter up to 68 characters or spaces for a long document name. The first 30 of those characters can be displayed on the List Files Long Display screen. Characters entered with Compose may take up more space than regular keyboard characters. If you decide to enter characters with Compose, you may not be able to use all 68 characters or spaces for the document name. Also, do not enter a pathname. Corel WordPerfect does not recognize pathnames in long document names and treats them as part of the long document name.*

When you save a document with Long Document Names set to Yes, Corel WordPerfect prompts you to enter the long document name, the document type, and the UNIX filename. If you have not previously entered a UNIX filename, one will be provided for you from the characters in the long document name, and the characters in the document type.

If you set the Long Document Names option to Yes, the Long Display screen is displayed when you use List Files. In List Files you can change to the Short Display screen.

**Fast Save (unformatted)**
By default, this option is Yes, which saves your document more quickly than No. If you print from disk, however, a document saved with Fast Save usually takes longer to print than a document saved without Fast Save, because it must be formatted before it can print (see Fast Save).
Hyphenation
This option specifies which dictionary is used to hyphenate words when
Hyphenation is on. External Dictionary/Rules and Internal Rules are the types
of hyphenation.

External Dictionary/Rules (1) specifies the hyphenation program and dictionary
contained in the wplex.us file. Internal Rules (2) specifies a Corel WordPerfect
hyphenation dictionary. The external dictionary is more powerful and accurate
than internal hyphenation, but it occupies more disk space.

The Prompt for Hyphenation option discussed below specifies when you are
prompted for hyphenation.

Prompt for Hyphenation
This option determines when you are prompted for hyphenation assistance when
Hyphenation is on. Normally, you will be prompted only when the hyphenation
dictionary cannot determine how to hyphenate a word. This is what is meant by
the When Required (2) setting.

Never (1) means you will never be prompted for assistance. If the word is not
found in the hyphenation dictionary, it will wrap to the next line.

Always (3) means you will always be prompted for assistance when the program
comes to a word that needs to be hyphenated.

Text In/Out Format
Text In/Out lets you import and export text into usable formats.

When you retrieve a file that is not in Corel WordPerfect format, the Conversion
feature transfers the file into Corel WordPerfect format.

ISO Latin-1 (1) is a standard text file format that lets you use converted ISO files
in other Corel WordPerfect applications. Fonts and formatting options (such as
indents, styles, tables, and font attributes such as bold and underline) are
preserved. When you convert a Corel WordPerfect document to ISO, the Corel
WordPerfect-specific codes are replaced by the standard ISO codes.

PC Extended ASCII (2) deletes formatting codes, while preserving the text of a
document. A PC ASCII text file contains only text, spaces, and carriage returns.
Some output devices require a PC ASCII text file.

When you save a Corel WordPerfect document as a PC ASCII text file, Date,
Soft Hyphens, and Paragraph Numbering codes are converted to ASCII text,
while codes such as -Indent, -Indent-, Center, Tab Align, and Flush Right are
converted to spaces. Columns, footnotes, endnotes, headers, footers, and so on,
are deleted.

7-Bit ASCII (3) is useful when transferring documents over a modem or line that
transfers only seven bits. Corel WordPerfect codes use the eighth bit, so the
codes are usually stripped during a 7-bit transfer. With the 7-bit conversion
choice, however, files are rearranged into a 7-bit format, preserving all codes.
Units of Measure
This option determines the units of measure Corel WordPerfect uses for the
status line and for features that require a measurement. Inches, centimeters,
points, Corel WordPerfect units (lines, columns), and 1/1200ths of an inch are
supported.

For more information on this feature, see Units of Measure.

See Also: Backup, Original; Backup, Timed; Beep Options; Cursor Speed;
Document Summary; Fast Save; Hyphenation; Text In/Out; Units of Measure

Equations

The Equation Editor helps you create mathematical or scientific equations and
include them in documents such as reports, tests, or research papers.

For example, the following equations can be created in the Equation Editor.

\[
\frac{\frac{1}{n}}{n} = \frac{1}{x} \left( \frac{1}{n} \right)^{-1}
\]

\[
f'(x) = \lim_{h \to 0} \frac{f(x+h)-f(x)}{h}
\]

\[
dU = A \left( \frac{1}{2} c_0 E + c B \right) dx
\]

Important: The Equation Editor helps you create, align, and print (typeset)
mathematical equations. It does not, however, calculate equations for you.

To format an equation, first define a graphics box that will contain the equation,
then create the equation itself. Use the Graphics feature to define the box, then
use the Equation Editor to create the equation.

Graphics, Edit and Graphics, Define a Box discuss editing and renumbering equation boxes.

1 Press Graphics, then select Equation (6).
2 Select Create (1).
Select Edit (9) to display the Equation Editor.

The Equation Editor is displayed any time you select Edit for a box whose contents are listed as Equation. Once the Equation Editor is displayed, you can create your equation. The Equation Editor has three windows: the Editing window, the Equation Palette, and the Display window.

By selecting commands and symbols from the Equation Palette in the Equation Editor and by typing characters from the keyboard, you can create the equation in the Editing window. After creating the equation, you can display it in the Display window to see how it will look when it is printed. Because there are many commands and symbols included in the Equation Palette, your equations can be simple or complex.

Create your equation (see Editing Window below).

For example, typing \texttt{a times b} in the Equation Editor creates this equation:

\[ a \times b \]

Typing \texttt{a times b over c} in the Equation Editor, creates this equation:

\[ \frac{a \times b}{c} \]
And typing \( x = \frac{-b \pm \sqrt{b^2 - 4ac}}{2a} \) in the Equation Editor creates this equation:

\[
x = \frac{-b \pm \sqrt{b^2 - 4ac}}{2a}
\]

5 Press Screen to view your equation (see Display Window below).

6 Repeat steps 4 and 5 above until you are satisfied with the appearance of the equation.

7 Press Exit to return to the normal editing screen.

Once you are in the normal editing screen, you can view your equation as it will appear in the document by selecting View Document.

**Editing Window**

The Editing window is where you create the equation.

You can enter numbers, letters, and certain keyboard characters (+ – / = < > ! ? , ! @ ; :) in the Editing window by pressing the appropriate keys. The keyboard characters ’ " { } ( ) and pairs of keyboard characters shown above (-> <= >=) can also be entered but have special meaning to the Equation Editor. See Equations, Commands and Symbols for a description of these characters.

You can enter one of the numerous equation commands and symbols by pressing List to move to the Equation Palette, moving the cursor to the command or symbol you want to include, then pressing Return (see Equation Palette below).

Hard returns move the cursor to the next line of the Editing window, but do not insert Hard Return codes in the equation. To create multiple-line equations in one equation box such as the one shown below, you should use the pound sign (#) STACK, or STACKALIGN command (see Equations, Commands and Symbols).

\[
a + b = c \\
x + y = z
\]

Pressing the Space Bar inserts a space in the Editing window, but does not add a space between characters in an equation. To add a space, type a tilde (˜) for a normal space or a backward accent (‘) for a thin space. A thin space is equivalent to one-fourth of a normal space.

Equations are formatted according to established mathematical typesetting guidelines which include specific size, attribute, and placement requirements for characters and symbols. You can include approximately 2000 characters in the Editing window. Pressing Ctrl-Page Down in the Editing window deletes text from the cursor forward and resets all display parameters in the Display window to Automatic.
Equation Palette
The Equation Palette displays the commands and symbols you can use in an equation. It is shown in the screen that accompanies the numbered steps at the beginning of this section.

You must be in the Equation Editor to move the cursor from the Editing window to the Equation Palette. List places you in the Equation Palette. You can use the Up or Down Arrow keys to move the cursor to the desired command or symbol in the displayed menu, or press Page Up or Page Down to display the next menu on the Palette. If the menu extends beyond the screen, you can scroll to the bottom of the menu to display more commands or symbols.

When the cursor is resting on the command or symbol you want, press Return to insert the command or symbol into the Editing window. Some symbols can be represented by text (keywords) and a character. For these symbols, pressing Return inserts the keyword, while pressing Control-Return inserts the character.

When you are in the Equation Palette, the command or symbol your cursor is on is highlighted in reverse video. The name of each menu in the Palette appears at the top of the Palette.

To leave the Equation Palette without entering a command, press Exit or Cancel. For more information on commands and symbols, see Equations, Commands and Symbols and Equations, Commands Syntax. Some of the commands require a special syntax such as a space between a command and the number or variable you want the command to affect. Equations, Commands Syntax contains information on the proper syntax.

You can enter a command without going to the Equation Palette by typing the command in the Editing window.

Display Window
After you create or edit an equation in the Editing window, you can view it in the Display window. The Display window is shown in the screen that accompanies the numbered steps of this reference section.

To display an equation in the Display window, press Screen. Redisplay an equation after you make editing changes by pressing Screen again.

If you have a syntax error in the equation, the equation will not display in the Display window. Instead, you will receive the “Incorrect Format” error message, and the cursor will return to the point in the equation where the error occurs. This error message can be displayed for several reasons, depending on the command you are using. Check the information pertaining to the command you are using in Equations, Commands Syntax.

The size of the equation in the Display window is not the exact size of the equation as it appears in the document. The percentage measurement at the lower right of the screen tells you the viewing magnification. For example, if the percentage shows 500%, the equation on the screen is 5 times its printed size.

Press Switch to display an equation in the Display window and move to the Display window. Doing so lets you use the Display window options to move...
and resize the equation. When you are in the Display window, you cannot use the cursor in the Editing window.

When you are in the Display window, a double line appears at the right of the Display window. When you are not, a double line appears at the right of the Editing window.

The Display window options let you use the arrow keys to reposition the equation and the Page Up and Page Down keys to enlarge or reduce the view of the equation. Go To resets any changes you made with the arrow, Page Up, or Page Down keys.

Moving or resizing the equation in the Display window with the arrow, Page Up, or Page Down keys helps you view the equation. It does not affect the way the equation prints. The Aligning Equations, Fonts, Graphical Font Size, and Print as Graphics headings below give you more information on the way the equation will print.

Press Switch again or Exit to move to the Editing window and display the Editing window options.

Notes

Aligning Equations
Several options let you choose the way equations will be aligned in the equations box.

Alignment options for the box itself are discussed in Graphics, Define a Box.

Initial or default alignment settings for an equation are located on the Setup: Initial Settings menu. Unless you change alignment options for an equation in the Equation Editor, the equation conforms to the settings on the Setup: Initial Settings menu. The alignment option centers the equation vertically and horizontally in a box.

Once an equation is created, it retains the alignment settings it was created under. The only way you can change those settings is to edit them in the Equation Editor.

To change the default alignment settings, you must be in the normal editing screen.

1 Press Setup.
2 Select Initial Settings (3).
3 Select Equations (3).
4 Select Horizontal Alignment (3) or Vertical Alignment (4).
5 Select the alignment option of your choice, then press Exit to return to the normal editing screen.

To change the alignment settings for a single equation, make sure you are in the Editing window of the Equation Editor. Press Setup, then select Horizontal Alignment (3) or Vertical Alignment (4). Next, select the alignment option of your choice, then press Exit to return to the Equation Editor.
Deleting in the Equation Editor
If you are in the Editing window of the Equation Editor, you can delete single letters or symbols with the Delete and Backspace keys. To delete text and symbols from the cursor forward to the end of the equation in the Equation Editor, make sure the cursor is located in the Editing window. Pressing **Delete to End of Page** in the Editing window resets all display parameters to Automatic.

To delete text and symbols from the cursor forward to the end of the line in the Equation Editor, make sure the cursor is located in the Editing window, then press **Delete to End of Line**.

To delete the entire equation (including the box), delete the Graphics Box code in the editing screen.

Equation Keyboard
Using Keyboard Layout, you can reassign or remap features or characters to different keys on your keyboard. For example, you can remap Quick Macro a to be the Greek Alpha character or Quick Macro i to be the integral symbol.

Using an option on the Setup: Initial Settings menu, you can assign a specific keyboard layout to the Equation Editor. When you are in the Equation Editor, that keyboard will be in effect.

To assign a keyboard, you must be in the normal editing screen.
1. Press **Setup**.
2. Select **Initial Settings** (3).
3. Select **Equations** (3).
4. Select **Keyboard for Editing** (5).
5. Move the cursor to the keyboard you want to select, then choose **Select** (1).
6. Press **Exit** to return to the normal editing screen.

An equations keyboard has been provided with Corel WordPerfect. Select a keyboard to use it. See also **Appendix H: Keyboards**. For information about creating a customized keyboard, see **Keyboard Layout**.

Equation Setup
In the Equation Editor you can press **Setup** to display a menu of options that change equation alignment and determine the printing options for the equation you are working on. See **Aligning Equations** above and **Graphical Font Size** and **Print as Graphics** below.

Fonts
Symbols from the initial base font are used to print equation symbols unless there is an Equation Box Options code preceding the equation in the document.

If there is an Equation Box Options code, all subsequent equations are printed in the font that is the current base font at the Equation Box Options code. This may be the same font as the initial base font for the document, depending on whether you made any base font changes in your document.
To change the size of an equation, change the size of your initial base font or change the base font prior to an Equation Box Options code (see Font).

More information on Equation Box Options codes can be found under Graphics Options.

If the Print as Graphics option is set to Yes (see Print as Graphics below), Corel WordPerfect can instruct your printer to emulate three fonts: WP Helv, WP Roman, and WP Courier. The font closest in appearance to the base font preceding the Equation Box Options code (or the initial base font for the document if there is no Equation Box Options code) will be selected. Use the Graphical Font Size option to change the size (see Graphical Font Size below).

Equations are formatted according to established mathematical equation typesetting guidelines. Variables, which are any sequence of alphabetical characters you type (other than equation commands), are printed in italics if you print equation symbols as graphics characters (see Print as Graphics below). If not, variables are printed in the italics font which corresponds to your base font (see Font).

Second-level characters such as subscripts, superscripts, small fractions, binomials, and limits are printed in the superscript font. If the characters are third-level, they are printed in the superscript font for the superscript font. Characters at subsequent levels are printed in the same font as third-level characters (see Font).

If the second-level characters are printed as graphics characters (see Print as Graphics below), the superscript font is two-thirds the size of the graphical font size and the superscript font for the superscript font is one-half the size of the graphical font size (see Graphical Font Size below).

**Graphical Font Size**

If you print equation symbols as graphics characters (see Print as Graphics below), you can set a specific size yourself, or you can have Corel WordPerfect determine the size.

To change the graphical font size setting for an equation, go to the Setup: Initial Settings menu. The equation conforms to the default setting on the Setup: Initial Settings menu, unless you change the printing setting for an equation in the Equation Editor. The graphical font size setting is set to Default Font.

Once an equation is created, it retains the graphical font size setting it was created under. The only way you can change the setting is to edit it in the Equation Editor.

To change the initial graphical font size setting, you must be in the normal editing screen.

1. Press Setup.
2. Select Initial Settings (3).
3. Select Equations (3).
4 Select Graphical Font Size (2) and the graphical font size option of your choice.

5 Press Exit to return to the normal editing screen.

To change the graphical font size setting for a single equation, make sure you are in the Editing window of the Equation Editor. Press Setup, then select Graphical Font Size (2). Select the graphical font size option you want, then press Exit to return to the Equation Editor.

There are two graphical font size options: Default Font (1) and Set Point Size (2). If you select Default Font, the font size will be the same as the size for the base font prior to the Equation Box Options code for the equation (or the initial base font for the document if there is no Equation Box Options code).

If you select Set Point Size, you can enter the point size yourself.

**Positioning Equations**

If you plan to create equations, we suggest you become familiar with graphics boxes. These boxes are used to position your equations on the page.

One box type is “Equation,” but you do not have to create an equation in an Equation type box. You can create an equation in any type of graphics box by selecting Equation for the box contents. The Equation type graphics box, however, has an initial appearance (no box lines, positioned from margin to margin) that is common for many equations. This is why we suggest you use it in the steps of this section.

For more information on Graphics, see *Graphics, Create.*

**Print as Graphics**

Corel WordPerfect is initially set to print all equation symbols as graphics characters. You can change this setting to have Corel WordPerfect print an equation symbol as a graphics character only if you do not have the symbol in one of the printer fonts.

Unless you change the printing setting on the Setup: Initial Settings menu, the equation conforms to the default setting. Once an equation is created, it retains the printing setting it was created under, and the only way you can change this setting is to edit it in the Equation Editor.

To change the default printing setting, you must be in the normal editing screen. When you are,

1 Press Setup

2 Select Initial Settings (3)

3 Select Equations (3)

4 Select Print as Graphics (1). Type y to print all equation characters as graphics or type n to print equation characters as graphics only when necessary.

5 Press Exit to return to your normal editing screen.
To change the printing setting for a single equation, make sure you are in the Editing window of the Equation Editor. Press **Setup**, then select **Print as Graphics**. Type `y` to print all equation characters as graphics characters or type `n` to print equation characters as graphics only when necessary. Press **Exit** to return to your normal editing screen.

If you have a printer that does not print graphics, you should set **Print as Graphics** to **No**.

If you set the **Print as Graphics** setting to **No**, Corel WordPerfect searches your automatic font changes and substitute fonts for the symbol it is looking for (see Printer Program, Customize Substitute Fonts and Printer Program, Modify Automatic Font Changes). If it cannot find the symbol, it will print the symbol as a graphics character.

If your printer does not have a font that contains the symbol Corel WordPerfect is looking for and cannot print graphics, it cannot print the symbol, and will leave a blank space.

If you do not want to print an equation symbol (or any other character) as a graphics character, set the **Graphics Quality** option on the Print menu to **Do Not Print** (see **Print Quality**).

For a more detailed description of the Corel WordPerfect printing process, see **Printing—General Information**.

If you are printing equation characters as graphics, you can improve the print quality with **Print Quality**. If the **Text Quality** option on the Print menu is set to **High**, graphics equation characters are printed in high quality. If the **Text Quality** option is set to a quality less than **High** but greater than **Do Not Print**, Corel WordPerfect uses the **Graphics Quality** setting to print graphical equations.

**Retrieving an Equation**

To retrieve an existing equation press **Retrieve** in the Equation Editor, then enter the filename of the equation. Corel WordPerfect looks for the equation in the document directory, then in the default directory (see **Location of Files**).

After pressing **Retrieve**, you can press **List**, then enter a directory name to display the files in a directory. If you select **Retrieve** while you are in that directory, Corel WordPerfect will retrieve the highlighted file to the Equation Editor.

You can also enter the equation filename under the **Filename** heading on the **Definition: Equation** menu to retrieve the equation.

If you retrieve a Corel WordPerfect (non-equation) file to the Equation Editor, all codes will be removed except hard returns (\[HRt\]) and Corel WordPerfect characters. Soft returns will be changed to hard returns. The file will be formatted according to mathematical equation typesetting guidelines, so spaces and hard returns will not separate text in the printed equation (see **Editing Window** above).

If there are equation syntax errors in the text, the “Incorrect Format” message appears when you try to display the equation. For more information on this message, see **Display Window** above.
Saving an Equation

To save the equation you have created to a separate file, press **Save** while in the Equation Editor.

If you have entered a pathname for a documents directory in Location of Files, Corel WordPerfect prompts you to save it in this directory (see **Location of Files**).

If you are saving an equation that you retrieved to the Equation Editor, the pathname to the documents directory and equation filename are displayed. To save the equation in the documents directory under the same filename, press **Return**, then type **y** if you are asked to replace. You can make changes to the path or filename, then press **Return**.

If you save an equation you did not retrieve to the Equation Editor, the pathname to the documents directory is displayed. To save the equation to the documents directory, press **End**, then enter the filename. If you enter a filename without moving to the end of the displayed pathname, the equation will be saved to the default directory.

If you have not entered a pathname for a documents directory and are saving an equation, Corel WordPerfect displays the filename of the equation (if the equation was retrieved to the Equation Editor) or leaves it blank. You can press **Return**, then type **y** to save the equation under the same filename, or you can enter a filename of your own. Unless you enter a complete pathname, your equation will be saved to the default directory.

A saved equation can be retrieved into the Equation Editor for other equations (see **Retrieving an Equation** above). When you save an equation as a separate file, the alignment or printing options are not saved for the equation.

Saving an equation is *not* the same thing as saving the entire document. In order to save the document, you must be in the normal editing screen.

**See Also:** Equations, Commands and Symbols; Equations, Commands Syntax; Graphics, Define a Box; Appendix D

---

Equations, Commands and Symbols

This section assumes that you are familiar with entering and exiting the Equation Editor. If you are not, refer to *Equations*.

When you enter the Equation Editor, the cursor is in the Editing window. You can now build your equation with commands, symbols, and text.

There are two different methods for entering equation commands and symbols:

- You can enter math commands, letters found on the keyboard, and extended characters, directly from the keyboard.

  or
• You can choose commands and symbols from the Equation Palette. The menus on the Palette are discussed below.

Write your equation on paper as you create it. The Equation Editor closely follows the normal conventions for verbalizing mathematical equations. For example, to produce the following equation, you might say “$y$ equals 1 over the square root of $x$.”

$$y = \frac{1}{\sqrt{x}}$$

This is similar to how you would produce the formula in the Equation Editor.

$$y = 1 \text{ OVER SQRT } x$$

You could also type the formula in lowercase letters,

$$y = 1 \text{ over sqrt } x$$

and obtain the same result.

The keywords OVER and SQRT are on the Equation Palette. You can select them from the Palette or type them from the keyboard.

To select an item from the Palette, press List to switch to the Palette, press Page Up or Page Down to locate the desired menu, use the cursor keys to move to the command you want, then press Return or Hard Page.

For items in the menus that contain both a symbol and a corresponding keyword, pressing Return puts the keyword (INT) in your equation in the Editing window. If you prefer to have the symbol ($\int$), press Hard Page. This only affects what is shown in the Editing window. In both cases, when you press Display, or when you print the equation, the appropriate symbol is displayed or printed. If there is no keyword or if the keyword is the same as the symbol, there is no difference between Return and Hard Page.

Once you become familiar with the commands and their syntax, it is easier to type in the commands than to retrieve them from the Palette.

The building blocks of the Equation Editor are commands, symbols, numbers, and variables. You can select the commands and most symbols from the Equation Palette, or you can create your own numbers and variables. Each of these functions is explained below.

**Commands**

Commands is one of the menus on the Equation Palette. It contains keywords which the Equation Editor recognizes as commands. Most commands require you to use a specific syntax or structure when you enter the command. All commands have some formatting function, such as drawing a line or arranging variables in the equation.
To select a command from the Equation Palette, press **List** to switch to the Palette, press **Page Up** or **Page Down** to locate the Commands menu, use the cursor keys to move to the command you want, then press **Return**.

All commands on the Commands menu can be typed from the keyboard in uppercase or lowercase letters. For example, the Equation Editor views “OVER” and “over” as the same command. You can also combine uppercase and lowercase letters.

If you type a command, you must separate the command from any variable on either side. You can do this with a space, the Return key, or with any symbol that is part of your equation. For example, if you type

```
x OVER{–y}
```

the Equation Editor recognizes the command OVER and formats the equation correctly. (Braces ({})) are used to group items (see *Grouping* below).

```
x

-y
```

When you retrieve a command from the Palette, the Equation Editor adds a space before the command (unless the command begins the first line in the Editing window) and a space after the command.

For a description of each command, see *Equations, Commands Syntax*.

**Symbols**

There are a variety of symbols you can use in the Equation Editor. You can use keyboard symbols, symbols from Corel WordPerfect character sets, and six menus of symbols on the Equation Palette. The following Palette menus are discussed under *Notes* below: Arrows, Greek, Large, Other, Sets, and Symbols.

For a complete list of the symbols available on the Palette, see *Appendix D: Equation Palette*.

**Variables**

The Equation Editor takes all alphabetic character input it does not recognize as reserved commands and treats the characters as variables. A variable must begin with an alphabetic character. It can be one or more characters, and can contain numbers. A variable is terminated by a non-alphanumeric character (such as a symbol, space, or Return). For example, x, y1, A1A, abc are valid variables.

Spaces you type in the Editing window are not converted to spaces by the Equation Editor. To insert spaces into your equation, use a backward accent (‘) for a thin space, or a tilde (‘) for a normal space (4 thin spaces = 1 normal space).

Variables are printed in the italic setting for the current base font. For details, see *Fonts* under *Equations*.
Numbers
A number is any non-negative integer (0, 1, 32767) which is terminated by a non-integer (a symbol, space, period, or alphabetic character). Numbers are formatted using the currently selected base font.

You can enter real numbers (including negative and decimal numbers), but the numbers are treated as separate alphabetic, numeric, or operator parts by the Equation Editor. For example, –2 is treated as two parts—a minus sign (–) and 2. 100.5 is treated as three parts—100, a decimal point (.), and 5.

In order to have a construction with more than one part as a single unit, you must enclose the construction in braces. For example, to print \( x \) raised to the power of negative 2, group the minus sign and the 2 as follows:

\[
x^{-2}
\]

Similarly, if you wanted to divide \( x \) by 0.5, you would type \( x \) OVER \( \{0.5\} \)

\[
\frac{x}{0.5}
\]

Notes
Arrows
Arrows is a menu on the Equation Palette. It contains a variety of arrows and several hollow and solid figures, such as triangles, squares, and circles.

To select an arrow key from the Palette, press List to switch to the Palette, press Page Up or Page Down to locate the Arrows menu, use the cursor keys to move to the symbol you want, then press Return.

As you highlight each Arrow symbol on the Palette, the status line shows a description of that symbol.

The Left Arrow and the Right Arrow can be entered by typing \(<-\) \((<\text{ and }-\)) and \(->\) \((-\text{ and }>)\), respectively.

Each symbol on the Arrows menu can also be entered using Compose.

For a complete list of the symbols on the Arrows menu, see Appendix D: Equation Palette.

Commands
Commands is a menu on the Equation Palette. To select a command from the Equation Palette, press List to switch to the Palette, press Page Up or Page Down as necessary to locate the Commands menu, use the cursor keys to move to the command you want, then press Return. You can also type in the command keyword from the keyboard.

As you highlight each command on the Palette, the status line shows the keyword for that command, and a description and an example of the syntax.

Most commands require you to use a specific syntax or structure when you enter the command. See Equations, Commands Syntax for details of individual commands.
Common Operators and Symbols
These common operators and symbols are not on the Equation Palette and must be entered directly from the keyboard.

+ − * / = < > ! ? . | @ " , ;

Dynamic Operators (Delimiters)
Dynamic operators, or delimiters, are special commands used to create symbols. They vary in height or width, depending on the size of the equation part to which they apply.

There are eight dynamic operators: OVER, LEFT, RIGHT, SQRT, NROOT, BINOM, LONDDIV, and LONDDIVS. Each of these operators has a specific syntax that is explained in Equations, Commands Syntax.

Following is an example using four of the six operators. To create this equation, type \( \sqrt{\frac{x}{x+y}} \)

Functions
Functions is a menu on the Equation Palette. It contains commands that are recognized as mathematical functions by the Equation Editor. Function names are formatted in the base font.

To select a function from the Palette, press List to switch to the Palette, press Page Up or Page Down to locate the Functions menu, use the cursor keys to move to the function you want, then press Return.

When you highlight a function on the Palette, the status line shows the complete name for that function.

You can also type the function names from the keyboard. You should separate function names from surrounding items with a symbol, space, or Return. Function names retain the case you type them in.

To create the following equation, type \( \cos^2 \theta \sin^2 \theta = 1 \)

For a complete list of the Functions menu, see Appendix D: Equation Palette.

The Equation Editor also lets you define your own functions. For details, see User-Defined Functions below.

Greek
Greek is a menu on the Equation Palette. It contains uppercase and lowercase Greek characters, and some variants.

To select a Greek character from the Palette, press List to switch to the Palette, press Page Up or Page Down to locate the Greek menu, use the cursor keys to move to the
Greek character you want, then press Return to insert the keyword into your equation in the Editing window, or Hard Page to insert the character itself.

As you highlight each Greek character on the Palette, the status line shows the keyword for that character.

The Greek characters that are not on the Palette are available in the Equation Editor only if they are entered with Compose.

The keywords for uppercase and lowercase letters are differentiated by case. Since Sigma contains an uppercase letter, it refers to an uppercase Greek character and produces $\Sigma$, while sigma produces $\sigma$.

Greek letters are not italicized.

For a complete list of the Greek menu, see Appendix D: Equation Palette.

Grouping Commands
Use braces ({ }) to combine groups of equation symbols and commands in the Equation Editor.

For example, to group characters to superscript, specify $x^{y+2}$.

To determine the order that the Equation Editor uses for ordering commands, see Precedence below.

Large
Large is a menu on the Equation Palette. The Large symbols make available operators that can be one of two sizes—small and large (SMALLSUM and SUM). The smaller size (SMALLSUM) is normally used in Character Equation boxes. The larger size (SUM) is normally used in other anchor box types. See Graphics, Define a Box for more details.

To select a large symbol from the Palette, press List to switch to the Palette, press Page Up or Page Down to locate the Large menu, use the cursor keys to move to the symbol you want, then press Return to insert the keyword into your equation in the Editing window or Hard Page to insert the symbol itself.

When you highlight a Large symbol on the Palette, the status line shows the keyword and a description for the symbol.

You can enter Large commands from the keyboard as keywords or symbols. Keywords for large symbols can be uppercase or lowercase.

For a complete list of the Large menu, see Appendix D: Equation Palette.

Other
Other is a menu on the Equation Palette. It contains diacritical marks (accents) and four orientations of ellipses (see Diacritical Marks and Ellipses below).

To select an item from this Palette, press List to switch to the Palette, press Page Up or Page Down to locate the Other menu, use the cursor keys to move to the item you want, then press Return to insert the keyword into your equation in the Editing window or Hard Page to insert the item itself.
When you highlight an Other symbol on the Palette, the status line shows the keyword for that symbol, and a description and an example of the syntax.

You can also enter Other symbols from the keyboard as keywords; these keywords are not case sensitive.

**Diacritical Marks** • The diacritical command follows the variable to which it applies. For example, to produce the first example below, type `e acute`.

The diacritical marks are placed according to the height of the base character to which they apply.

<table>
<thead>
<tr>
<th>Keyword</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACUTE</td>
<td>´e</td>
</tr>
<tr>
<td>BAR</td>
<td>¯x</td>
</tr>
<tr>
<td>BREVE</td>
<td>¯a</td>
</tr>
<tr>
<td>CHECK</td>
<td>¸x</td>
</tr>
<tr>
<td>CIRCLE</td>
<td>¯x</td>
</tr>
<tr>
<td>DOT</td>
<td>¸x</td>
</tr>
<tr>
<td>DDOT</td>
<td>¸x</td>
</tr>
<tr>
<td>DDDOT</td>
<td>¨x</td>
</tr>
<tr>
<td>DYAD</td>
<td>¸x</td>
</tr>
<tr>
<td>GRAVE</td>
<td>´e</td>
</tr>
<tr>
<td>HAT</td>
<td>¸e</td>
</tr>
<tr>
<td>TILDE</td>
<td>¯i</td>
</tr>
<tr>
<td>VEC</td>
<td>¯x</td>
</tr>
</tbody>
</table>

**Ellipses** • The following commands insert ellipses into an equation as described below. Each ellipsis consists of three dots. The spacing between the dots is the same for all 4 commands—only the orientation is different.

<table>
<thead>
<tr>
<th>Keyword</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DOTSAXIS</td>
<td>A horizontal row of dots centered on the axis</td>
</tr>
<tr>
<td>DOTSLOW</td>
<td>A horizontal row of dots on the baseline</td>
</tr>
<tr>
<td>DOTSVERT</td>
<td>A vertical row of dots</td>
</tr>
<tr>
<td>DOTSDIAG</td>
<td>A diagonally-aligned row of dots (upper left to lower right)</td>
</tr>
</tbody>
</table>

For example, to produce the following equation with a horizontal row of dots on the baseline, type `x DOTSLOW x_n`

\[x_1 \ldots x_n\]

**Precedence**
The Equation Editor groups elements in a specific order. This order is listed below, starting with the highest level of grouping.

1. Groups
2. Diacritical marks
3. Primes, SUB, SUP, FROM, and TO
4. Roots
5. OVER, BINOM
6. Other elements group left-to-right
You can override the normal grouping order by using braces ({} around those elements that you want to keep together as a unit. For example, the Equation Editor treats \(x + y\) as three elements, but \({x + y}\) is treated as a single group. If commands are used inside of braces, these commands are evaluated first. If braces are used inside of braces, the elements in the inner braces are evaluated first. Examples with braces are shown below.

Diacritical marks are attached to the variable immediately preceding them. In the following example, type \(x \text{VEC}'\)

The vector is first attached to the variable \(x\), then the prime is attached to the entire unit.

\(\bar{x}'\)

Primes are attached to the variable immediately preceding them. In the following example, type \(\sqrt{x}^\prime\)

The prime is first attached to the variable \(x\), then the square root radical sign is placed over the entire unit.

\(\sqrt{x}'\)

If you want a subscript and a superscript on the same variable, you must put the subscript first, then the superscript. For example, to produce the following equation, type \(a_{i^2}\)

\(a_i^2\)

If you want a prime and a subscript on the same variable, you must put the subscript first. (The prime operates like a superscript.) For example, type \(x_{\text{SUB}2}'\) to produce the following equation:

\(x_{\text{SUB}2}'\)

To produce the following equation, type \(x_{\text{SUP 2 SUP 3}}\)

The 3 is first attached as the superscript of 2, and the entire unit is attached as the superscript of \(x\).

\(x_{\text{SUP 2 SUP 3}}\)

The following equation demonstrates how some of these levels of grouping work together. Type \(\sqrt{x^3-1}\)

\(\sqrt{x^3-1}\)
The superscript 3 is first attached to the x. This group is then attached to the SQRT function and placed under the square root radical sign. Finally, the remainder of the equation (–1) is bound.

Symbols such as plus (+), minus (–), and decimal point (.) are treated as separate elements by the Equation Editor. For example, to produce the square root of –1, insert braces as follows:

\[ \text{sqrt} \{–1\} \]

The square root function would assume that the minus sign was its sole argument and \( \text{sqrt} –1 \) would be:

\[ \sqrt{-1} \]

Sets

Sets is a menu on the Equation Palette. It contains set symbols, relational operators, and some commonly used Fraktur and hollow letters.

To select a set symbol from the Palette, press List to switch to the Palette, press Page Up or Page Down to locate the Sets menu, use the cursor keys to move to the symbol you want, then press Return to insert the keyword into your equation in the Editing window (if there is no keyword, the symbol is inserted) or Hard Page to insert the symbol itself.

When you highlight a Set symbol on the Palette, the status line shows the keyword for that symbol (if a keyword is available), and a description for that symbol.

For a complete list of the Sets menu, see Appendix D: Equation Palette.

Two common set symbols, union and intersection, are located on the Palette in the Large menu.

Spaces and Line Breaks

Spaces and hard returns serve as delimiters (separators) in the Editing window, but they are not translated into spaces or hard returns in your equation.

To insert spaces in your equation, type a backward accent (\(^\prime\)) for a thin space or a tilde (\(\tilde{}\)) for a normal space (4 thin spaces = 1 normal space). See Equations, Commands Syntax for more information on the backward accent (\(^\prime\)) and the tilde (\(\tilde{}\)).

To insert line breaks in your equation, use the pound sign (#) or the MATRIX, STACK, or STACKALIGN commands. See Equations, Commands Syntax.

Spacing Commands

Three commands you can use to manually adjust the spacing of your equation in the equation box are HORZ, VERT, and LINESPACE. See Equations, Commands Syntax for details on these three commands.
Symbols
Symbols is a menu on the Equation Palette. It contains miscellaneous symbols, such as $\infty$, $\pm$, and $\equiv$.

To select a symbol from the Palette, press List to switch to the Palette, press Page Up or Page Down to locate the Symbols menu, use the cursor keys to move to the symbol you want, then press Return to insert the keyword into your equation in the Editing window or Hard Page to insert the symbol itself.

When you highlight a symbol on the Palette, the status line shows the keyword and a description for that symbol.

You can also type in keywords for a symbol, which are not case sensitive.

Some of the keywords are two or more keyboard symbols typed together without a break. For example, you can enter $a \pm b$ by typing $+\!\!\!-$ These sequences of symbols include $\prime$ (double prime), $''$ (triple prime), $+-$ (plus or minus), $-+$ (minus or plus), $<=$ (less than or equal), $>=$ (greater than or equal), $<<$ (much less than), $>>$ (much greater than), $==$ (equivalent).

You can use any of the symbols on the Symbols menu singly, with the exception of three primes. Each prime must be attached to a variable: $x'$, $x''$, $x'''$.

For a complete list of the Symbols menu, see Appendix D: Equation Palette.

User-Defined Functions
The Equation Editor formats variables in an italic font. To print a character string in the normal base font, define the string as a function using the FUNC command. Functions are formatted as normal text and retain the case with which they are typed in.

If you spell out “cosine” in your equation, the Equation Editor treats the word as a variable and italicizes it. If you type FUNC cosine in the Editing window, the Equation Editor formats “cosine” in the normal base font.

To apply FUNC to more than one variable, group the variables with braces (\{ \}) and place FUNC in front of the group. To italicize an item, use the ITAL command (see ITAL under Equations, Commands Syntax).

See Also: Equations; Equations, Commands Syntax; Appendix D
Equations: Commands Syntax

The following words and symbols are keywords recognized as commands. They are located under the Commands menu on the Equation Palette. All commands have a formatting function, such as drawing a line in an equation or arranging variables in an equation.

To insert a command into your equation, switch to the Equation Palette by pressing List, move the reverse video bar to the command you want (using Page Up, Page Down, or the cursor keys), then press Return.

Commands require a specific syntax or structure. An example of the proper syntax is shown on the status line when you highlight each of the commands.

As an alternative to retrieving the commands from the Palette, you can type them from the keyboard in uppercase or lowercase. For example, the Equation Editor views “OVER” and “over” as the same command. You can also mix case (“Over”) if you find it useful.

You can have a maximum of 40 nested levels in the Equation Editor.

In the following descriptions, a subgroup is used to refer to a part of an equation. Also, wherever a variable is indicated in the syntax of a command, you can substitute a group (enclosed in braces) for the variable.

<table>
<thead>
<tr>
<th>Commands</th>
<th># (pound sign)</th>
</tr>
</thead>
</table>
| This symbol is a row separator and indicates a line break (or a new subgroup) in MATRIX, STACK, and STACKALIGN. The basic syntax is $x \# y \# \ldots \# z$, although the syntax for each of the above commands is slightly different. For the correct usage for each command, see MATRIX, STACK, and STACKALIGN below. At the outermost level of an equation, the pound sign can be used by itself to separate lines in an equation ($a=b-c\#a=d+3$).

<table>
<thead>
<tr>
<th>&amp; (ampersand)</th>
</tr>
</thead>
</table>
| This symbol has two functions. When used in MATFORM or MATRIX, it is a matrix column separator. The basic syntax is $\text{MATRIX} \{x \& y \& \ldots \& z\}$ (see MATFORM and MATRIX below for details).

When used in STACKALIGN, ampersand ($\&$) indicates the character on each row on which to align. The basic syntax is $\text{STACKALIGN} \{x\&y\}$, where $x$ is the character on which you want to align (see STACKALIGN below for details).

<table>
<thead>
<tr>
<th>. (period)</th>
</tr>
</thead>
<tbody>
<tr>
<td>This symbol is used with dynamic operators to indicate that there is no corresponding opening or closing delimiter (see Dynamic Operators (Delimiters) under Equations: Commands and Symbols). LEFT and RIGHT must always be used together. If you want only one dynamic delimiter, you must indicate that the other end is open. LEFT . or RIGHT . is the syntax.</td>
</tr>
</tbody>
</table>
For example, type `LEFT LANGLE x OVER {x+1} RIGHT` to create the following equation:

\[
\frac{x}{x+1}
\]

For more information, see _LEFT_ below.

`(backslash)``
This symbol indicates that the following symbol or command is treated as a literal. The syntax is `\command`. For example, type `\` if you want a tilde to print as a tilde instead of as a space.

You can also use the backslash to print commands such as `OVER`, rather than have the command perform its normal function. If you type `\OVER`, the word is treated literally, and the command is no longer recognized by the Equation Editor as a command.

` (backward accent)``
This symbol is translated into a thin space (one-quarter space) by the Equation Editor. Insert this symbol where you want to print a thin space.

Below is an example of no space (x+y), one thin space after the x (x`+y), two thin spaces after the x (x``+y), and three thin spaces after the x (x```+y).

\[
x+y \; x+y \; x\;+y \; x\;+y
\]

For information on a normal space, see _˜ (tilde)_ below.

{ (left brace)``
This symbol signals the start of a group. It is used with the right brace (`}) symbol, which signals the end of a group. The syntax is `{x...y}`. For example, type `{x+1} OVER {x–2}` to print the following equation.

\[
\frac{x+1}{x-2}
\]

Without the braces (`{}`). your equation would print like this:

\[
\frac{x+1}{x-2}
\]

` (right brace)``
This symbol signals the end of a group (see _{ (left brace)_ above).

``(tilde)``
This symbol is translated into a normal space by the Equation Editor. Insert this symbol where you want to print a normal space.
Below is an example of no space \((x+y)\) and one normal space after the \(x\) \((x + y)\).

\[
x + y
x + y
\]

For information about thin spaces, see \(\backslash (\text{backward accent})\) above.

**ALIGNC**
This command aligns its accompanying argument in the center of the current subgroup or matrix column. Because center alignment is the default for most commands, ALIGNC is useful only in matrices. The syntax is **ALIGNC** \(x\).

For more information, see **MATFORM** below.

**ALIGNL**
This command aligns its accompanying argument on the left margin of the current subgroup or matrix column. ALIGNL can be used with OVER, FROM, TO, and matrices. The syntax is **ALIGNL** \(x\).

For example, type **ALIGNL 1 OVER 10000** to left-align the 1 in the equation below.

\[
\frac{1}{10000}
\]

For more information, see **MATFORM** below.

**ALIGNR**
This command aligns its accompanying argument on the right margin of the current subgroup or matrix column. ALIGNR can be used with OVER, FROM, TO, and matrices. The syntax is **ALIGNR** \(x\).

For example, type **ALIGNR 1 OVER 10000** to right-align the 1.

\[
\frac{1}{10000}
\]

For more information, see **MATFORM** below.

**BINOM**
This command creates a binomial construction. The left and right parentheses are placed around the binomial and are dynamically sized. The syntax is **BINOM** \(x y\).

For example, type **BINOM alpha beta** to produce the equation below.

\[
\binom{\alpha}{\beta}
\]
**BINOMSM**
This command works like BINOM with the exception that the entire construction is printed in the next smaller font. The syntax is `BINOMSM x y`. For example, type `BINOMSM alpha beta` to produce the equation below.

\[
\binom{a}{b}
\]

**BOLD**
This command causes its argument to be bolded. The syntax is `BOLD x`.

**FROM**
This command works with TO and provides beginning and ending limits for symbols. These limits are always placed below and above the symbol. If you want side limits, use SUB and SUP.

The syntax is `operator FROM x TO y`, where `operator` is some symbol such as SUM or INT, and `x` and `y` are the beginning and ending limits.

For example, to produce the following equation, type `SUM FROM {k=0} TO INF`.

\[
\sum_{k=0}^{\infty}
\]

**FUNC**
This command causes any variable to be treated as a function name, instead of as a variable. The variable is then printed in the base font. The syntax is `FUNC variable`, where `variable` is a single variable or a group enclosed in braces ({}).

For example, if you type Corel WordPerfect, it prints in an italic font—*Corel WordPerfect*. Type `FUNC Corel WordPerfect` if you want it to print in a non-italic font.

**HORZ**
Corel WordPerfect calculates correct spacing for equation commands and operators. The equation itself is centered vertically in the equation box in relation to the “baseline” of the equation. You can use the following keyword commands to adjust the spacing manually:

\[
\text{HORZ } n
\]

\[
\text{VERT } n
\]

where `n` is the percentage of the current font size to move in a relative direction to the right or left for HORZ and up or down for VERT. If the number is positive, the direction is right or up. If the number is negative, the direction is left or down.

For example, if you are using a 12 point font and type `HORZ 100 x=y`, the equation is moved 12 points (approx. 1/6") to the right.
ITAL
This command italicizes its argument. It is useful for italicizing functions (\(\cos\)), numbers, or symbols (\(\text{INT}\) or \(\text{SUM}\)). The syntax is \textbf{ITAL} \(x\). (Compare \textit{FUNC} above.)

If you use ITAL with a symbol keyword (\(\text{INT}\) or \(\text{SUM}\)), the keyword is still correctly translated into the symbol (\(\Sigma\)), but the symbol will be italicized.

LEFT
\textbf{LEFT} or \textbf{RIGHT} inserts a delimiter which expands according to the size of the subgroup it encloses. The syntax is \textbf{LEFT} \textit{delimiter} (or \textbf{RIGHT} \textit{delimiter}), where \textit{delimiter} is one of the following delimiters:

<table>
<thead>
<tr>
<th>Delimiter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>(</td>
<td>left parenthesis</td>
</tr>
<tr>
<td>)</td>
<td>right parenthesis</td>
</tr>
<tr>
<td>/</td>
<td>slash</td>
</tr>
<tr>
<td>[</td>
<td>left bracket</td>
</tr>
<tr>
<td>]</td>
<td>right bracket</td>
</tr>
<tr>
<td>DLINE</td>
<td>double vertical line ( )</td>
</tr>
<tr>
<td>LANGLE</td>
<td>left angle bracket ( )</td>
</tr>
<tr>
<td>LBRACE</td>
<td>left brace ( )</td>
</tr>
<tr>
<td>LCEIL</td>
<td>left ceiling ( )</td>
</tr>
<tr>
<td>LFLOOR</td>
<td>left floor ( )</td>
</tr>
<tr>
<td>LINE</td>
<td>single vertical line ( )</td>
</tr>
<tr>
<td>RANGLE</td>
<td>right angle bracket ( )</td>
</tr>
<tr>
<td>RBRACE</td>
<td>right brace ( )</td>
</tr>
<tr>
<td>RCEIL</td>
<td>right ceiling ( )</td>
</tr>
<tr>
<td>RFLOOR</td>
<td>right floor ( )</td>
</tr>
</tbody>
</table>

For example, type \textbf{LEFT} [ \textit{STACK} \{x=1 \# y=2\} \textbf{RIGHT} ] to create the following equation:

\[
\begin{bmatrix}
x = 1 \\
y = 2
\end{bmatrix}
\]

\textbf{LEFT} and \textbf{RIGHT} must be used together. However, the left and right delimiters do not need to be identical (for example, [ ]). You can choose any of the above delimiters for the left or right delimiter.

If you want one end open, use \textbf{LEFT} or \textbf{RIGHT} followed by a period (.) to indicate an open or null delimiter (see . (period) above).

If delimiters are used by themselves (without a preceding \textbf{LEFT} or \textbf{RIGHT} command), the symbol is inserted without any automatic sizing. The equation
above would look different without using the dynamic delimiters. For example,

\begin{equation}
\left( \begin{array}{c}
\alpha \\
\beta
\end{array} \right)
\end{equation}

Delimiters can have limits associated with them. Use the \texttt{SUB} and \texttt{SUP} commands. For example, type \texttt{LEFT [ x OVER y RIGHT ] _1^\infty} to produce the following equation.

\begin{equation}
\left( \begin{array}{c}
\alpha \\
\beta
\end{array} \right)_1^\infty
\end{equation}

\textbf{LINESPACE}

This command lets you change the vertical line spacing within \texttt{STACK}, \texttt{STACKALIGN}, and \texttt{MATRIX} structures. The command must be placed before any of these structures. The syntax is \texttt{LINESPACE n}, where \textit{n} is the percentage of normal line spacing for these structures. For example, \texttt{LINESPACE 200} is double line spacing.

\textbf{LONGDIV}

This command creates the long division character over the accompanying variable. The long division character expands to cover the variable. The syntax is \texttt{LONGDIV x}.

\textbf{LONGDIVS}

Performs the same function as \texttt{LONGDIV}, but leaves the left end of the long division character straight.

\textbf{MATFORM}

This command is used in a \texttt{MATRIX} command to indicate the alignment formats. It is followed by a row of alignment formats: \texttt{MATFORM {alignment & alignment & ... & alignment}}, where \textit{alignment} is \texttt{ALIGNC}, \texttt{ALIGNL}, or \texttt{ALIGNR}, and \& is a matrix column separator. In a \texttt{MATRIX} command, you might use \texttt{MATFORM} as follows: \texttt{MATRIX {MATFORM {ALIGNL & ALIGNR} aaa&bbb # ii&jj # x&y}}

\begin{align*}
\texttt{aaa} & \texttt{ bbb} \\
\texttt{ii} & \texttt{ jj} \\
\texttt{x} & \texttt{ y}
\end{align*}

The first alignment format is paired with the first element in each row, the second alignment format with the second element, and so on. The number of alignments should match the number of matrix columns in \texttt{MATRIX}.
**MATRIX**

This command creates a matrix in the equation. The syntax is \textbf{MATRIX} \{ \textbf{x} \& x_1 \& x_2 \# x_3 \& x_4 \& x_5 \}, where \# is used to delimit rows and \& is used to delimit matrix columns. The Equation Editor makes no assumptions about the type of brackets which surround your matrix. With LEFT and RIGHT (see \textit{LEFT} above), you have several options for your left and right delimiters. For example, to produce the following equation, type

\begin{equation}
\text{LEFT LINE}\;\text{MATRIX}\;\{1\;\&\;2\;\&\;3\;\#\;4\;\&\;5\;\&\;6\}\;\text{RIGHT LINE}
\end{equation}

\begin{pmatrix}
1 & 2 & 3 \\
4 & 5 & 6 \\
\end{pmatrix}

**NROOT**

This command creates the $n$th root of the accompanying argument. The radical sign expands to enclose the variable. The syntax is \textbf{NROOT} \textbf{n} \textbf{x}, where \textbf{n} is the $n$th root and \textbf{x} is the variable. To create this example, type $x = \textbf{NROOT} 3 \\{-\frac{27}{8}\}$

\begin{equation}
x = \sqrt[3]{-\frac{27}{8}}
\end{equation}

**OVER**

This command generates fractions. The syntax is \textbf{x}\textbf{OVER} \textbf{y}. Type \textbf{x OVER} \{x+1\} to create the following equation:

\begin{equation}
\frac{x}{x+1}
\end{equation}

All fractions appear with a horizontal bar, as in the above illustration. The Equation Editor does not use the diagonal bar (a/b). The horizontal bar expands according to the size of the numerator or denominator, whichever is larger. (You can, however, type a/b manually, but the “/” does not expand dynamically.)

**OVERLINE**

This command places a bar over the variable included as its argument. The syntax is \textbf{OVERLINE} \textbf{x}. Type \textbf{OVERLINE} \{Hello, \textit{world.}\} to create the following equation:

\begin{equation}
\textit{Hello, world.}
\end{equation}
OVERSM
This command works like OVER, but the entire construction is printed in the next smaller font. The syntax is \texttt{x OVERSM y}. Type \texttt{x OVERSM \{x+1\}} to create the following equation:
\[
\frac{x}{x+1}
\]

PHANTOM
This command generates a place holder. It is useful for aligning elements in a stacked equation when the equations do not contain an equal number of elements. The syntax is \texttt{PHANTOM x}. For example, in the equation below,
\[
x + y = 1
x = \phantom{+y} = 2
\]
if you want the two \(x\)'s and the equal sign to align, you would insert a PHANTOM command containing the elements in the upper equation missing in the lower equation. You would type
\[
\text{STACK \{x+y=1 \# x PHANTOM \{+y\}=2\}}
\]
This would cause blank space equivalent to that taken up by \(+y\) to be inserted into the lower equation.

RIGHT
For information on RIGHT, see \texttt{LEFT} above.

SCALESYM
This command can scale normal symbols, numbers, or text when you print the equation as graphics. The syntax is \texttt{SCALESYM n symbol}, where \(n\) is the percentage of the normal size of the symbol. For example, to make the integral sign 300 percent larger, enter \texttt{SCALESYM 300 int}.

When printing the equation as text, SCALESYM only scales the delimiters \((), [],\) and \{\}. If you are scaling the \{ or \} delimiters, you must precede them with a backslash (\) (such as \texttt{SCALESYM 250\\}).

SQRT
This command creates the square root of the accompanying variable. The radical (or square root) sign expands to cover the variable. The syntax is \texttt{SQRT x}. For example, type \texttt{SQRT \{1-x^2\}} to create the following equation:
\[
\sqrt{1-x^2}
\]

STACK
A stack is a vertically aligned set of groups or subgroups. You can have only one equation per box, but you can “stack” equations within a box. An example is
\[
\text{STACK \{x+y \# a+b\}}
\]
where $#$ is used to delimit each subgroup or line within the stack, and $x+y$ and $a+b$ can be any equation.

\[
\begin{align*}
  x+y \\
  a+b
\end{align*}
\]

You can also align subgroups horizontally within a stack. To format the subgroup flush left, flush right, or centered, use ALIGNL, ALIGNR, or ALIGNC, before the subgroup you want to align. For example, to align the lower subgroup flush right in the equation below, type

\[
\text{STACK \{x+y+z \# ALIGNR a+b\}}
\]

\[
\begin{align*}
  x+y+z \\
  a+b
\end{align*}
\]

You can also align entire stacks within larger structures. Place the appropriate alignment command in front of the \text{STACK} command.

\textbf{STACKALIGN}

This command lets you align a stack of equations on an arbitrary symbol or symbols. For example, you can align the stack on a decimal point or on an equal sign. The syntax is \text{STACKALIGN \{x alignchar&y \# a alignchar&b\}}, where \text{alignchar} is the character on which you want to align, \& follows and marks the align character, and \# creates a line break. For example, \text{STACKALIGN \{x>\&y+z \# a+b<\&c\}} would produce the following:

\[
\begin{align*}
  x>\&y+z \\
  a+b<\&c
\end{align*}
\]

\textbf{SUB or _}

Both commands generate subscripts. The syntax is \text{x SUB y} (or \text{x_y}), where \text{x} has the subscript \text{y}.

\[
x_y
\]

If you want a subscript and a superscript at the same time, enter the subscript first, then the superscript. For example, type \text{x_1^2}

\[
x_1^2
\]

If you type \text{x^2_1}, the 1 is subscripted to the 2.

\[
x^{2_1}
\]

\text{SUB} and \text{SUP} are also used to indicate lower and upper limits for functions and large operators. These limits are always placed on the side of the operator. If you want bottom and top limits, use \text{FROM} and \text{TO}. 

134 Equations: Commands Syntax
For example, type \texttt{INT \_0^1 1 OVER x = y} to create the following equation:

\[ \int_0^1 \frac{1}{x} = y \]

\textbf{SUP or ^}

Both commands generate superscripts. The syntax is \texttt{x SUP y} (or \texttt{x^y}), where \( x \) is to be raised to the power of \( y \). For more information, see \texttt{SUB or _} above.

\( x^y \)

\textbf{TO}

For information on \texttt{TO}, see \texttt{FROM} above.

\textbf{UNDERLINE}

This command places a bar under the variable included as its argument. The syntax is \texttt{UNDERLINE x}, where \( x \) can be a single variable or a group.

Type \texttt{UNDERLINE \{Hello, world.\}} to create the following equation:

\textit{Hello, world.}

\textbf{VERT}

For information on \texttt{VERT}, see \texttt{HORZ} above.

\textbf{See Also: } Equations; Equations: Commands and Symbols; Appendix D: Equation Palette

\textbf{Exit}

Exit can quickly take you out of an option, a menu, a document, or the program. It also lets you save any changes you have made.

To exit a document from the normal editing screen,

1. Press \texttt{Exit} to begin exiting.
   \texttt{Or \ \select{Exit} from the Menu.}

2. Type \texttt{n} to continue exiting without saving the on-screen document, then go to step 4 below.
   \texttt{or}
   Type \texttt{y} to save the document on the screen. You will be asked to name the document.

You can use long document names or standard UNIX filenames (see \textit{Long Document Names} below).

3. Enter a filename (see \textit{Entering Filenames} below).
4 Type y to exit Corel WordPerfect.
   or
   Type n to clear the screen and begin a new document.

Notes

**Backtracking**
If you do not want to exit, you can press **Cancel** at the Save or Exit prompts to return to the document on the screen.

**Built-in Safety Features**
Corel WordPerfect has several built-in safeguards to protect you from accidentally losing or replacing a document you have created.

When you exit a document, you are asked if you want to save the document on your screen. If you have not made any changes to the document since it was last saved, a “(Text was not modified)” message appears on the right end of the status line. If this message does not appear, you probably made changes you will want to save.

If you try to replace an existing document you will be asked to confirm the replacement (see **Entering Filenames** below).

**Entering Filenames**
A standard UNIX filename can include up to 160 characters.

When an existing filename is displayed, pressing any character key erases the existing filename so you can start typing a new name. However, before you press a character key, you can use Left Arrow or Right Arrow to move through the existing filename to edit it. Use Backspace, Delete, or Delete to End of Line to delete existing characters. You can also press **Insert** to move between inserting and typing over characters (see **Typeover**).

When you enter a filename that already exists, you will be asked if you want to replace the existing file. Type y to replace the existing file with the document on your screen. If you press n (or any other key), you are prompted for a new filename. Enter a different filename to save both documents.

If you do not enter a full pathname, the file is saved in the current default directory. You can use Location of Files in Setup to specify a directory where you want the files to be saved when you do not enter a full pathname.

**Exit vs. Save**
Exit lets you save your work and clear the screen to begin a new document. When you edit a document, you can use Save to save the document periodically without exiting.

**Exiting Menus and Options**
You can press **Exit** to leave the special editing screen you are in when you type a header, footer, footnote, or endnote.

When you use Exit to leave a menu or an option, any changes you made are automatically saved. To ignore the changes you made, press **Cancel** instead of **Exit**.
Exiting Multiple Documents
You can have nine documents active in memory at the same time (see Switch). If both documents are open when you complete step 3 at the beginning of this section, you are asked if you want to leave the screen you are in (“Exit Doc 4? No (Yes)”). Type n (or any other key) to clear the current screen, or type y to close the screen you are in and switch to the other screen.

Mass Exit lets you quickly exit all unmodified documents in screens 1 to 9. If you have modified one or more documents, you will be asked if you want to save the modified documents before exiting.

To Mass Exit,

1  Press Home, Exit.
2  Type y or press any other key (except n) and enter a filename to save the modified documents on your screen.
   or
   Type n to continue exiting without saving the documents on your screen.

Long Document Names
Long Document Name lets you enter an additional name that is saved with the standard UNIX filename for each document you create. The UNIX filename is 160 characters, and the long document name can contain up to 70 characters and spaces, excluding the additional space required for extended characters. You can turn on Long Document Name by setting the Long Document Names entry to Yes in Environment Setup. When you exit a document, you are asked to enter a long document name and document type before you enter a standard UNIX filename. The “Long Document Name:” prompt appears immediately after step 2 at the beginning of this section.

When you enter a long document name, you can include spaces and type any character on the keyboard. You can also use Compose to add other character. You can use Left Arrow or Right Arrow to edit or scroll through the document. Use Backspace, Delete, or Delete to End of Line to delete existing characters. You can also press Insert to move between inserting and typing over characters.

Once you enter a long document name, you are asked to enter the document type. The document type is a way to categorize your documents. It can include any information that helps you group and identify your files. A document type can contain 20 characters, excluding any additional space required for extended characters.

After you enter a name, the filename prompt appears (“Document to be Saved:”). You can then continue the exiting process as explained in steps 3 and 4 at the beginning of this section.

When you use long document names, only the standard filename is displayed on the left end of the status line in the normal editing screen. Long document names are displayed only in the List Files Long Display screen and in Document Summary.
You can display documents alphabetically by long document names when you use List to list the files in a directory. You can also display and enter long document names in the Document Summary menu.

See Also: Cancel; Location of Files; Save; Switch
Fast Save (unformatted)

When you print a document that has been fast saved, Corel WordPerfect “retrieves” the document in the background without displaying it on-screen and formats it for printing. Fast Save does not format documents for printing.

You can turn off Fast Save to format each document when it is saved.

1. Press Setup.
   Or  Select Setup from the File menu.
2. Select Environment (2).
3. Select Fast Save (unformatted) (4), then type n to turn off Fast Save.
4. Press Exit to return to your document.

Notes

Disk Space and File Size
Fast saving a document can increase the size of the document, depending on changes you made and the features you used to edit a document. Settings which are not in effect (former printer definitions, former styles) are not deleted when a document is fast saved. They are deleted, however, when fast save is set to no, or when you retrieve a file for editing.

See Also: Print, Document on Disk

Find

Find gives you several options to search a directory for a specific file. You can find a file by filename or list only those files that contain a specific word or phrase.

For example, if you know a memo was sent to Mr. Claussen, but you cannot remember the name of the file, you can search the files in your memo directory to locate the memo that contains Mr. Claussen’s name.

To use Find to locate a specific file,

1. Use List to display the files in the directory where the file is located.

You can limit your search to specific files (see Limiting a Search below).

2. Select Find (9).

3. Select an option to specify where you want to search (see Filenames and Documents below and Find, Conditions).

4. Enter the word or phrase you want to search for (see Search Patterns below).

The files are listed that meet your conditions.
You can use the cursor keys to move through the filenames, press Return or select Look to display the contents of certain files, and use •Search in Look to search for the word or phrase. You can use Find again to search the selected group of files. When you find the file you want, you can select Retrieve (1) to retrieve it. You can redisplay the reduced list by pressing List twice. If no files are found, a “Not Found” message appears briefly at the status line, followed by a blank List Files screen.

Pressing List twice does not redisplay the list if you changed the default setting for Long Document Name.

**Notes**

**Conditions**
Select Conditions (5) to enter specific conditions to limit a search (see Find, Conditions).

**Documents**
Three of the options on the Find menu let you specify which part of the file you want to search. Select Doc Summary (2) to search only the text of the document summaries. Select First Page (3) to search only the first pages or the first 4000 characters. Select Entire Doc (4) to search the entire contents of each document, excluding the document summary.

**Filenames**
Select Name (1) to search for a file by name.

If you use Name Search, you must begin with the first letter of a filename to move to that file. The Name option works more like Search in the normal editing screen. You can enter part of a filename to list the filenames that contain the same letters in that same order. For example, you can enter et to display files called letter, letters, better, or get set.

When entering filenames, you can use the question mark (?) and the asterisk (*) to represent other characters (see Search Patterns below).

Only filenames that match the pattern you enter remain on-screen when the search is done.

If you want the filenames that match the pattern you enter to be removed from the screen and only filenames which do not match the pattern to remain on-screen, use the dash (–). You can also use other logical operators to limit the scope of a search (see Search Patterns below).

Using Name on the Find menu lets you reduce a long list of files to a few that match a certain pattern. When you want to move to a certain filename without changing the current file list, you can use •Search or •Search (see Short Cuts below).

**Limiting a Search**
You can search through parts of files (see Documents above). When you display the files, you can use a filename pattern to display specific files in a directory. Before you begin the search, you can move the cursor through the filenames and
type an asterisk (*) to mark each file you want to include in the search. Only the marked files will be searched.

**Search Patterns**

You can enter a search pattern in the “Word Pattern:” prompt that appears when you select options 1 through 4 on the Find menu. You can also enter a search pattern in the entries on options 4 and 5 on the Find: Conditions screen (see *Find, Conditions*). When entering the word or phrase you want to find, you can include up to 39 characters. You can use uppercase or lowercase letters.

*The 39 characters can have up to five words, and a word can contain 20 characters.*

You can use the question mark (?) and the asterisk (*) to represent other characters within words and phrases. The question mark takes the place of a single character, while the asterisk takes the place of zero or more characters.

To search for a pattern of words, enclose the pattern in quotation marks. To search for an exact phrase, include a space between the last letter and the last quotation mark. If a phrase contains a single quotation mark, use double quotation marks around the phrase.

The following table gives examples of search patterns.

<table>
<thead>
<tr>
<th>Pattern</th>
<th>Selection</th>
</tr>
</thead>
<tbody>
<tr>
<td>book</td>
<td>Files that contain the word “book”</td>
</tr>
<tr>
<td>d?sk</td>
<td>Files that contain words that match the d?sk pattern (desk, disk)</td>
</tr>
<tr>
<td>&quot;replace disk&quot;</td>
<td>Files that contain patterns such as “replace disks” and “replace diskette”</td>
</tr>
<tr>
<td>&quot;replace disk &quot;</td>
<td>Files that contain the exact phrase “replace disk”</td>
</tr>
<tr>
<td>&quot;replace“disk&quot;</td>
<td>Files that contain a pattern that starts with “replace” and ends with “disk” plus any other characters</td>
</tr>
</tbody>
</table>

You can also combine words with the following logical operators:

- The semicolon (;) selects files which contain both of the words it joins.
- The space ( ) selects files which contain both of the words it joins.
- The comma (,) selects files which contain either word it joins.
- The dash (–) works like a minus sign and is used to conduct an exclusive search. Corel WordPerfect then excludes all files that match any pattern which follows the dash. To search for an actual dash (–), enclose the dash within quotation marks (“–”).

Corel WordPerfect performs the operations from left to right.

The following list gives a few examples of using logical operators.

<table>
<thead>
<tr>
<th>Operator</th>
<th>Selection</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bill Sue or Bill;Sue</td>
<td>All files that contain both Bill and Sue.</td>
</tr>
<tr>
<td>Bill,Sue</td>
<td>All files that contain either Bill or Sue.</td>
</tr>
</tbody>
</table>
**Operator** | **Selection**
---|---
Bill, Sue; Ted | All files that contain either Bill or Sue and also Ted.
Bill "replace disk" | All files that contain Bill and the phrase “replace disk.” Bill can occur before or after the phrase.
-way | Only the files that do not contain way.
four-way | Files contain four, but do not contain way.
"four-way" | The files that contain “four-way”.

**Short Cuts**
You can use *Search or @Search to move to a filename whenever a file list is displayed on-screen.

Press *Search or @Search, type a word or phrase found anywhere in the filename, then press Return or a search key. You do not have to begin the search pattern at the first letter in the filename. This is a fast way to move through a file list when you are using long document names. You can enter a word or word pattern in the long name, the type, the UNIX filename, or the subdirectory name.

Some of the Find features work more quickly than other features. The fastest way to move to a filename is *Search. Name, Document Summary, First Page, and Entire Document are features listed in their order of speed.

**Undo**
Undo works in much the same way Undelete does in the normal editing screen. Once a search is complete, you can select Undo (6) from the Find options menu to return the file list to its original display format. Undo keeps up to three different backup levels of file lists. As you narrow the scope of a search, Undo lets you back up a previous list if you do not find the file you want.

**See Also:** Find, Conditions; List Files; Search

---

**Find, Conditions**

When you use Find to search for a specific file in a directory, you can display a Conditions screen which lets you enter specific conditions for the search.

To use the Conditions screen,

1. Display the files in the directory where the file is located (see List Files).
2. Select Find (9).
3. Select Conditions (5).

When any conditions appear on this screen, only the files which meet all the conditions are listed after a search. You can reset the screen at any time (see Reset Conditions below).
4 Enter the conditions you want to use for the search (see Document Summary, Text, and Revision Date below).

5 Select Perform Search (1) to perform the search.

Corel WordPerfect searches the files, then rewrites your screen, listing only the files that meet your conditions.

Notes

Document Summary
To limit a search to a specific item in the document summary (creation date, document name, or document type), select Document Summary (5) from the Conditions menu, then enter the word or phrase under that item (see Search Patterns under Find). You can press Down Arrow or Up Arrow to move from item to item. The Document Summary Creation Date entry gives the date of the file when the document summary was created, not the date the document was created (see Revision Date below).

Perform Search
When you have entered all the conditions you want, select Perform Search (1) to perform the search.

Reset Conditions
The conditions of the last search are in effect until you change them to do another search. Selecting Reset Conditions (2) clears the screen and empties all existing search conditions.

Revision Date
Select Revision Date (3) from the Conditions screen to search only for files which have been edited between certain dates. Enter the month, day, and year (9/9/99 or 09/09/1999).

Text
The options on the Find menu let you limit a search to document summaries, the first page, or the entire document. Selecting Text (4) from the Conditions screen lets you combine the three types of searches. You can enter a different search pattern for the document summary, the first page, and the complete document. Select Perform Search (1) to search for the three patterns at the same time. You can press Down Arrow or Up Arrow to move from item to item.

See Also: Find
Flush Right aligns dates, titles, or headings flush against the right margin.

You can also use Flush Right with Home to insert a Hard Right Tab [RGT TAB] (see Hard Right Tab below).

To align text with the right margin,

1. Press Flush Right.

   Or Select Align from the Layout menu, then select Flush Right.

The cursor moves to the right margin.

2. Type the text you want aligned at the right margin.

3. Press Return to open a new line and end the flush right alignment.

Notes

Codes
When you align text, a Flush Right code [Flsh Rgt] is placed immediately to the left of the aligned text. When you press Return, a Hard Return code [HRt] is inserted, and the alignment ends.

A Flush Right code takes precedence over other text. For example, if you are in the middle of a line when you press Flush Right, and type text that runs into existing text, on-screen text may disappear. If this happens, use Reveal Codes to view and delete the unwanted text or codes.
**Dot Leader**
When aligning text flush right, you can insert a dot leader before the aligned text by pressing **Flush Right** twice, as in the following example.

<table>
<thead>
<tr>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preface</td>
</tr>
<tr>
<td>Chapter 1</td>
</tr>
<tr>
<td>Chapter 2</td>
</tr>
<tr>
<td>Chapter 3</td>
</tr>
<tr>
<td>Chapter 4</td>
</tr>
<tr>
<td>Chapter 5</td>
</tr>
<tr>
<td>Appendix A</td>
</tr>
<tr>
<td>Appendix B</td>
</tr>
<tr>
<td>Appendix C</td>
</tr>
<tr>
<td>Index</td>
</tr>
</tbody>
</table>

You can also insert a dot leader with a Hard Right Tab [RGT TAB] (see **Hard Right Tab** below).

**Existing Text**
You can flush right an existing line or part of a line of text. Make sure that the line ends with a Hard Return code [HRt], place your cursor at the beginning of the text you want to flush right, press **Flush Right**, then press **Down Arrow**.

**Hard Right Tab**
A Hard Right Tab aligns text with the next tab stop. To create a Hard Right Tab at the next tab stop, press **Home, Flush Right**. Corel WordPerfect inserts a Hard Right Tab code [RGT TAB]. To create a Hard Right Tab with dot leaders, press **Home, Home, Flush Right** (see **Types of Tab Settings** under **Tab Set**).

**Multiple Lines**
You can use Block to flush right one or more lines of existing text. Block the lines you want at the right margin, press **Flush Right**, then type y. All the lines in the block are aligned against the right margin.

When a block of text is aligned, a Right Justification code [Just:Right] is placed at the beginning of the text and a code matching the original justification setting is placed at the end (Left, Center, or Full).

**Part of a Line**
The cursor does not have to be at the left margin when you press **Flush Right**. You can use **Flush Right** to type new text and align it on lines that include tabs, indents, and centered text.
Move the cursor to the right edge of existing text or codes, press **Flush Right**, then type the text you want at the right margin. This lets you create headings with text aligned at the left or right margin, or centered all in one line.

**See Also:** Center Text; Justification

---

**Font**

Font refers to the appearance of characters on a printed page. A font consists of three elements: typeface (Times Roman), weight (Bold or Light), and point size (for proportionally spaced fonts) or pitch (for mono-spaced fonts). Your printer comes with the capability to print in at least one font.

*A point is approximately 1/72".*

The base font is the font in which normal text (text without attributes) is printed. For example, if your normal text is printed in Times Roman 10pt, your base font is Times Roman 10pt.

Attributes can usually print in variations of the base font. The selection of your base font also selects the fonts for your attributes. For example, if your base font is Times Roman 10pt, italicized text is probably Times Roman 10pt italic. Large text is probably Times Roman, but in a larger point size than 10pt.

The capability to print a font attribute depends, however, on what fonts your printer has available. If your printer has one font, then all text is printed in that font. If your printer has hundreds of fonts that can be scaled to size, you can use a different font for each attribute.

To tell Corel WordPerfect which fonts your printer has available, use Cartridges and Fonts (see Cartridges/Fonts/Print Wheels).

You can change the base font several ways.

**Important:** Do not use more than 255 unique fonts in one document.

Your printer has an initial base font selection. This selection is made on the Select Printer: Edit menu. Instructions on how to set it can be found under Printer, Edit. Unless you change the base font with one of the two options discussed below, the setting made on the Select Printer: Edit menu determines the base font for all future documents you create.

*Only portrait fonts are shown on the Select Printer: Edit menu.*

**Document Initial Base Font**

You can also set the base font on the Format: Document menu. This setting applies only to the document on the screen and overrides the initial base font setting on the Select Printer: Edit menu.

To change this setting,
1 Press Format, then select Document (3).
   Or  Select Document from the Layout menu.

2 Select Initial Base Font (3).

   A list of portrait fonts is displayed on the screen. These fonts are a duplication of
   the information entered in Cartridges/Fonts/Print Wheels (this excludes
   landscape fonts).

3 Move the cursor to the font you want to select as your base font, then choose
   Select (1).

4 Press Exit to return to the normal editing screen.

   The setting you make on this menu takes precedence over the setting on the
   Select Printer: Edit menu. Unless you change your base font with the option
   discussed below, your base font will be printed according to the setting.

Base Font Code

   The Base Font menu lets you insert a code and changes the base font from the
   location of the code forward in your document. The code overrides the Initial
   Base Font option on both the Select Printer: Edit and Format: Document
   menus.

   To change this option,

1 Move the cursor to the location in your document where you want to change
   the base font.

2 Press Font, then select Base Font (4).
   Or  Select Base Font from the Font menu.

   A list of fonts is displayed on the screen. Depending on your paper size/type
   information, the fonts listed are landscape fonts or portrait fonts (see Landscape
   and Portrait Fonts below). Both types of fonts are listed in Cartridges and Fonts.

3 Move the cursor to the font you want to select as your base font, then choose
   Select (1).

   The font selection you make inserts a code in your document. From that point
   forward in the document (or until you make another font change), the base font
   is changed to the selection you made.

   Base Font codes can be entered in sub-editing screens such as header, footer,
   footnote, endnote, and graphics caption screens. When a Base Font code is
   located in one of these screens, it affects only the information on that screen.

   You can also insert Base Font codes in Setup: Initial Codes and Document:
   Initial Codes (see Initial Codes). A Base Font code is inserted in the Initial Codes
   screen, so text in the document will be printed in that font. Footnotes,
   endnotes, equations, and graphics box captions, however, will use the Document
   Initial Base Font unless a Graphics Box Options, Footnote Options, or Endnote
   Options code is located in the document (see Document Initial Base Font above).
If one of the options codes listed in the paragraph above is located in the document, subsequent graphics box captions, footnotes, and endnotes (depending on the options code) are printed in the base font that is in effect at the options code.

**Notes**

**Attributes**

Attributes are usually printed in variations of the base font depending on the fonts your printer has, and what your printer can do with the fonts. When you select fonts in Cartridges/Fonts/Print Wheels and select a base font, Corel WordPerfect determines which fonts will represent the different attributes.

To see how attributes with a particular base font will be printed, retrieve the printer.tst file, select your printer, change the Base Font code with the Initial Base Font option on the Format: Document menu, then print the document from the screen.

The printer.tst file is installed separately with the Corel WordPerfect files. It is initially installed in the wplrn directory.

You can change the font assignments Corel WordPerfect makes for your attributes in two locations.

The first location is the Size/Attribute Ratio feature. You can enter sizes for some of the attributes the same as in the base font option. It is discussed in Initial Settings.

The second location is in the Corel WordPerfect Printer Program. This program lets you change font assignments for all attributes. It is discussed in Printer Program, Modify Automatic Font Changes.

**Landscape and Portrait Fonts**

The fonts that are displayed on the various Base Font menus are fonts that come with your printer and fonts you mark in Cartridges/Fonts/Print Wheels. Portrait fonts and landscape fonts, however, cannot be displayed on any of the Base Font menus at the same time.

Whether portrait fonts or landscape fonts are displayed on the Base Font menu depends on the Font Type of the current Paper Size/Type. If the Font Type is Portrait, portrait fonts are displayed. If the Font Type is Landscape, landscape fonts are displayed.

For more information on font types, see Paper Size/Type and Printing, Landscape.

**Name Search**

You can quickly select a font from the font menus by using Name Search, then type letters to move the cursor to the first font that begins with those letters.

If you define a macro that selects a font, we suggest you use Name Search to locate that font.
Printer Selection
Fonts are printer specific. If you enter a base font in a document, then print the
document on a printer that does not have the font, the font will not be printed.
In this situation, Corel WordPerfect makes a “best guess” from the available
fonts and tries to print the document in a similar font.

If you create a document for one printer, then save it with another printer, some
font codes ([Font: Tms Rmn 10pt]) may be replaced by codes with an asterisk
before the font name ([Font: *Tms Rmn 10pt]). The asterisk indicates the
printer does not have the original font. When the document is printed, Corel
WordPerfect makes a “best guess” and prints the document in a similar font.

See Also: Attributes; Printer Program, Modify Automatic Font Changes;
Printing—General Information; Cartridges/Fonts/Print Wheels

Footnotes and Endnotes

Footnotes and endnotes cite sources and provide detailed information about an
item in your text. Footnotes are usually printed at the bottom of the page where
they are referenced. Endnotes are usually printed at the end of the document.

Corel WordPerfect automatically numbers notes and places them on each page,
adjusting the text in your document. Footnotes are placed at the bottom of the
page, and endnotes are placed at the end of the document or at a location you
specify.

Footnotes and Endnotes
In this section, the word “note” refers to both footnotes and endnotes.

To create a note,

1. Move to the place in your document where you want the number for the new note inserted.
2. Press Footnote, then select Footnote (1) or Endnote (2).
   Or Select Footnote or Endnote from the Layout menu.
3. Select Create (1).
4. Type the text of the note.
5. Press Exit to return to your document.

**Adding and Deleting Notes**

You can add new notes in a document (except in columns and footnotes) by following the steps above.

Creating a note inserts a Note code into your document. The format for the code is `[note:#][Note Num]text` where `note` is Footnote or Endnote, `#` is the note number and `text` is the text of the note, up to 50 characters.

When you add or delete a note, the remaining notes in your document are renumbered automatically.

**Editing a New Note**

Selecting Create (1) places you in a special Note Editing screen. The number, letter, or character for the note you are creating appears in the upper left corner of the screen. The type of note you are creating (Footnote or Endnote) appears on the status line.

Enter text using editing features (Bold, Underline, Center, Tab, Flush Right, etc.). A single footnote or endnote can contain 65,000 bytes (approximately 65,000 characters). Use Move, Block, or Cancel to move, delete, and restore text in the note. Move can move text from your document into a footnote and back again. You can use the Speller and Thesaurus in this screen.
Unless a Base Font code exists in the note, a note is printed in the initial base font for that document as displayed in the Initial Base Font entry on the Format: Document screen (see Document Format).

However, if a note options code precedes a note, the notes from that point forward are printed in the font that is in effect wherever the options code is found (see Footnotes and Endnotes, Options) as the following example demonstrates.

Press Exit once you have finished typing the text of the note to save the note and return to your document. If you forget to exit the Note Editing screen, you may be typing part of your document in the Note Editing screen by mistake. If this happens, you can use Block and Move to block the unwanted text and move it back into your document.

Editing an Existing Note
If you know the current number, letter, or character for a note, you can edit any of the notes you created in the main body of the document.

To edit an existing note, press Footnote, select Footnote (1) or Endnote (2), then select Edit (2). You are asked which note you want to edit. The number (or letter or character) displayed is one number greater than the number of the note that immediately precedes the cursor position. Enter the number of the note you want to edit, using your current numbering style (for a discussion of numbering styles, see Footnotes and Endnotes, Options).

After you enter a number, if that note exists, the note editing screen appears with the current text for that note displayed on the screen. Edit the note, then press Exit to save your changes and return to the normal editing screen.

If the number you enter is not found, a *Not Found* message appears briefly at the left end of the status line and returns you to the normal editing screen.
Endnote Placement
Normally, endnotes are printed at the end of your document. There is no code that indicates where the endnotes are printed, but you can see the endnotes when the document is printed, or when you use View Document to preview the printed document. If endnotes exceed one page, only one page of endnotes can be viewed.

You can, however, place endnotes at a different location in your document. For example, if one document contains several chapters, you can compile each chapter's endnotes at the end of that chapter.

To specify an endnote location, move the cursor to where you want to insert the Endnote Placement code, press **Footnote**, then select Endnote Placement (3). You are asked if you also want endnote numbering to start over from that point. Type `y` to have endnotes renumbered from that point or type `n` to have numbering continue from the current number. An Endnote Placement code [Endnote Placement] is inserted at the cursor, followed by a Hard Page code [HPg]. If you want the endnotes numbered from that point, a New Endnote Number code [New End Num:#] is then inserted, where `#` is the first number in the current numbering method (1 or a).

When you print the document, the endnotes are printed at the location of the Endnote Placement code. All endnotes from the beginning of the document or from the point of the last Endnote Placement code are printed at this location.

The Endnote Placement code follows the code with a Hard Page code to separate the endnotes from the next page of text. If you want the endnotes to begin on a separate page, you must insert a Hard Page code before the Endnote Placement code.

In the normal editing screen, the Endnote Placement code is represented by a box which contains a message informing you that you must generate your endnotes. This box is followed by a hard page, as in the following example.

<table>
<thead>
<tr>
<th>Endnote placement code</th>
<th>Hard page code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Endnote Placement</td>
<td>[Endnote Placement] [HPg] [New End Num:#]</td>
</tr>
</tbody>
</table>

If you use Endnote Placement, generate the endnotes in the document to determine how much space they will occupy in the printed document. Press **Mark Text**, select Generate (6), select Generate Tables, Indexes, or Cross...
References (5), then type y. The message in the box changes to “Endnote Placement,” indicating that the endnotes have been generated (see Generate).

You do not have to generate endnotes to print them.

**Footnote Placement**

When you add a footnote to your text, it appears at the bottom of that page. The text on the page is automatically reduced to insert the footnotes and a blank line between the footnotes and the text.

If a footnote is too long to fit on one page, Corel WordPerfect tries to keep at least one half inch of the note on the same page as the number that references that footnote. If that is not possible, the footnote and the line of text containing the footnote reference is moved to the next page.

You can change the spacing between footnotes, the amount of footnote text to be kept on a page, and whether you want to print footnotes at the bottom of the page, or after the last line of text (see Footnotes and Endnotes, Options).

**Graphics**

Only a graphics box with a character anchor type can be included in a note (see Graphics, Create).

**Master Documents**

If your document is extremely long, you can use Master Document to divide it into smaller files. Footnotes and endnotes are numbered consecutively in a master document.

**Options**

Several options let you determine the numbering style of your notes and the way notes are formatted (see Footnotes and Endnotes, Options).

**Renumbering Notes from a Given Point**

When a document is divided into several files, start note numbering at a specific number. Press **Footnote**, select Footnote (1) or Endnote (2), select New Number (3), then enter a number using the current note numbering method (see Note Numbering Method under Footnotes and Endnotes, Options).

This inserts a New Number code into your document, [New note type Num: #] where note type is Footnote (Ftn) or Endnote (End), and # is the new number. The notes of that type from that point forward in the document will be numbered consecutively, starting with the new number.

**See Also:** Footnotes and Endnotes, Options

---

**Footnotes and Endnotes, Options**

You can determine the numbering style and format for your footnotes and endnotes, or you can use default choices.

To change note options,
1 Press **Footnote**, then select Footnote (1) or Endnote (2).

   *Or* Select Footnote or Endnote from the Layout menu.

2 Select **Options** (4).

3 Select an option and enter the necessary information (see the option headings under **Notes** below).

4 Press **Exit** to return to the normal editing screen.

---

**Notes**

**Amount of Note to Keep Together**

If a note is too long to fit on a page, it is continued on the next page. This option sets the amount of space in a note (not necessarily the number of lines) that is to be kept on one page. The default is one-half inch.

**Codes**

Changing note options inserts an options code ([Ftn Opt] or [End Opt]) which can be seen in Reveal Codes. The options code affects only the notes from that point forward in the document. If you want the new format to affect all the footnotes in your document, the options code must be placed before any notes in the document.

An options code cannot be edited. The only way to change your option settings is to delete the options code or to create a new code using the steps given at the beginning of this section.

Each time you display an Options menu, the settings it contains reflect any changes made by any previous options code.

You can include the options code in your Initial Settings to have the footnote and endnote options you want placed in every subsequent document you create (see **Initial Settings**).

**Footnote Options**

Four options are available only for footnotes:

**Footnotes at Bottom of Page** • When text does not fill a page, this option determines whether footnotes are printed at the bottom of the page or just below the last line of text. If this option is set to Yes, blank lines are inserted between text and footnotes, when necessary, to keep all footnotes at the bottom of each page.

**Line Separating Text and Footnotes** • This option determines whether Corel WordPerfect prints a line to separate text from footnotes. You can
select No Line (1), 2-Inch Line (2), or Margin to Margin (3), as in the following illustration.

Print Continued Message • If a footnote must be split between two pages, setting this option to Yes prints “(continued...)” on the last footnote line of the first page and “(...continued)” on the first footnote line of the next page. You can change the language in which this message is printed by inserting a language code in the initial codes for a document (see Language). You can also change the text for these messages by editing the wp.lrs file (see Language Resource File).

Start Footnote Numbers Each Page • If this is set to Yes, footnote numbering starts at 1 on every page. If this is set to No, footnotes are numbered continuously throughout the document.

Note Numbering Method
Normally, notes are ordered by numbers (1, 2, 3). The Note Numbering Method option lets you select Numbers (1), Letters (2), or Characters (3).

When you select Characters (3), you must enter the character(s) you want to use.

The character used most often to number notes is an asterisk (*). However, you can enter any Corel WordPerfect character using Compose. A character is used once, then doubled, then tripled (*, **, ***). If you want a different character for each note, you can enter up to five different characters (* ‡ § •). Corel WordPerfect uses each character in sequence, and doubles, then triples the characters. After each character has been repeated 15 times, Corel WordPerfect starts over with the first one again.
Spacing Within and Between Notes
Normally, notes are single spaced with .167” (the height of a 12-point font) blank space between each note. Within notes, you can enter 1 for single, 1.5 for one-and-a-half line spacing, and 2 for double. To vary the spacing of a particular note, use Line Spacing in Format to set line spacing within the note in the Note Editing screen.

Style for Numbers
You can specify how note numbers appear in the main text (Style for Number in Text) and in the note itself (Style for Number in Note).

In the main document the note number is displayed in superscript (Footnote1). Within a footnote, the superscripted number is indented. Within an endnote, the number is followed by a period (1.).

When you select either Number Style option, a “Replace With:” prompt appears. You can enter characters using Font to specify size or appearance attributes (see Font). You can also add and delete spacing. Within a style, the Note Number code [Note Num] indicates where the note number will print. When creating a note numbering style, you can insert the Note Number code by pressing Footnote, selecting Footnote (1) or Endnote (2), then selecting Number Code (2).

See Also: Compose; Font; Footnotes and Endnotes

Force Odd/Even Page
You can make sure certain pages in a document have an odd or even page number. For example, it is customary to begin each chapter in a book with an odd-numbered page.

You can have blank pages inserted where necessary to make sure that a certain page always has an odd or even number.

1 Move the cursor to the page where you want to force the number (see Codes below).

2 Press Format, then select Page (2).

   Or Select Page from the Layout menu.

3 Select Force Odd/Even Page (2).

4 Select Odd (1) to force the page to have an odd number.
   Or
   Select Even (2) to force the page to have an even number.

5 Press Exit to return to your document.

The page number is forced to odd or even. It appears in the Pg # indication on the status line.
Forcing a page number inserts a Force Page code ([Force:Odd] or [Force:Even]). A Force Page code will be placed at the top of the page it is forcing. When necessary, Corel WordPerfect inserts an extra Soft Page code [SPg] directly before this code to create a blank page and make certain the forced page retains an odd or even number.

**Force Odd/Even Page vs. New Page Number**

Forcing a page inserts blank pages where necessary, but it keeps the pages in your document numbered consecutively. If you want a page in your document to begin with a certain number that is not in consecutive order, you can use New Page Number.

**See Also:** Page Numbering; Auto Code Placement

---

**Format**

To make format changes to your current document,

1. Press **Format**.

2. Select **Line** (1), **Page** (2), **Document** (3), or **Other** (4) (see **Line**, **Page**, **Document**, and **Other** below).

   * Or **Select Line, Page, Document, or Other from the Layout menu.**

3. Select a format option and change it.

4. Press **Exit** to return to the document.

---

**Notes**

Default settings that format your text are not displayed on the normal editing screen or in Reveal Codes.

There are standard settings for several of the most commonly used formatting features (left and right margins, tabs, and top and bottom margins). These settings are inserted when you create a new document. For a list of these settings, see **Appendix G: Initial Settings**.

To display the current Format settings, press **Format** to select the menu which displays the option. The menu displays the current setting, which you can change.

For the Line, Page, and Other Format menus, changing a setting inserts a code which changes the setting from that point forward in a document. Paragraph Format codes will come at the beginning of a paragraph, and Page Format codes will come at the beginning of a page (see **Auto Code Placement**).

For the Format: Document menu, changing a setting does not insert a code into your document but it does change that setting for the entire document.
You can customize the standard initial format settings with Initial Codes on the Setup: Initial Settings Menu (see Initial Codes).

**Document**
You can change settings that affect the entire document. For example, you can create a Document Summary or change the initial base font for your document. For more information, see *Document Format*.

**Line**
Use Line to change the way text is formatted horizontally on a line. For more information, see *Line Format*.

**Other**
The Other submenu contains several advanced formatting options. For more information, see *Other Format* and *Auto Code Placement*.

**Page**
Use Page to specify the arrangement of text on a page, and from page to page throughout a document. For example, you can center text vertically on the page, or add page numbers and special headings to pages. Generally, these codes are placed at the top of the page.

**See Also:** Document Format; Line Format; Other Format; Page Format; Appendix G
Generate

Generating is the final step in creating a table of contents, table of authorities, list, or index. Generating also updates cross-references and the space used for endnotes (if you are using Endnote Placement). Before you generate, make sure you mark the text you want, insert any Endnote Placement codes, and define your table, list, or index. For more information, see the appropriate Define heading for each in Reference (such as Index, Define). Also see Cross-Reference, Mark Text, or Footnotes and Endnotes.

To generate,

1. Press Mark Text, and select Generate (6).
   
   Or Select Generate from the Mark menu.

2. Select Generate Tables, Indexes, or Cross-References, etc.

3. Type y to generate cross-references, endnotes, tables, lists, or indexes, replacing any previously existing ones.
   
   or
   
   Type n to return to your document without generating.

Once generating begins, a counter at the bottom of the screen indicates the progress of generation. All tables, lists, and indexes in the document are generated, and cross-references and endnote placement are updated in the same generating process.

Each time you generate, cross-references and endnote placement are updated, and the previous versions of tables, lists, and indexes are deleted before the new ones are created. (See [Def Mark:] and [End Def:] below).

If you make any changes to marked text, cross-references, endnotes, or endnote placement, or the definition of tables, lists, or indexes, your changes will not be included unless you generate again.

Notes

Cross-Referencing

When you generate cross-references, question marks are replaced with numbers, and existing numbers are updated.

[Def Mark:] and [End Def:]

When you define your table, list or index [Def Mark: type, #] (where type represents the type of reference — ToC, List, or Index — and # represents the numbering style) is inserted in your document at the cursor position. Each table, list, or index is generated at its [Def Mark:]. When generating is complete, [End Def:] is inserted at the end of each table, list, or index.

When you generate again, everything between [Def Mark:] and [End Def:] is deleted before creating a new table, list, or index. When editing your document, make sure you are not adding text between the two codes, unless you want to edit a generated table, list, or index.
If you delete [Def Mark:] and leave [End Def:], a message appears the next time you generate stating that a necessary [Def Mark:] is missing.

Both [Def Mark:] and [End Def:] are needed to replace an old table, list, or index with a new one. If you delete [End Def:], Corel WordPerfect leaves your old table, list, or index and generates a new one. If you define a new table, list, or index, you should delete the old [Def Mark:], or the item is generated twice.

When you change the definition for tables, lists, or indexes, you create a new [Def Mark:] code. Make sure you delete the old [Def Mark:] before you create a new [Def Mark:].

**Editing Tables, Lists, and Indexes**

Corel WordPerfect uses standard formatting features to format tables (contents and authorities), lists, or indexes. Once they have been generated, you can edit them like other documents. For example, a table of contents is formatted using indents [Indent] and margin releases [Mar Rel]. These codes align on tab stops. If the table is not aligned properly, you may need to change the tab stops (see *Tab Set*). However, if you edit the text in a table, list, or index, and then regenerate it, the old table, list, or index will be replaced with a new one, and you will lose editing you made to the old one.

As you edit, do not delete [Def Mark:] or [End Def:] before and after the table, list, or index. This will cause problems if you generate again.

**Endnote Placement**

To print endnotes at a place other than at the end of the document by using Endnote Placement (see *Footnotes and Endnotes*). When you insert an Endnote Placement code into a document, the following message appears at the insertion point:

“Endnote Placement. It is not known how much space endnotes will occupy here. Generate to determine.”

Corel WordPerfect can determine how many pages the endnotes occupy by using Generate.

After you generate the document, a new “Endnote Placement” message replaces the original message. This new message takes up as many pages of the document as the endnotes will require. You can identify the number of pages by moving the cursor past the message and past the page break under the message. The status line will reflect which page the rest of the document starts on.

After adding or deleting endnotes, regenerate to see whether the endnotes will take up a different number of pages.

**Sorting Order**

Index entries and authorities are sorted alphabetically when generated. Entries in lists or a table of contents are sorted according to the order in which they appear in the document.
**Table of Authorities**
When you define a table of authorities, set a new page number between the table of authorities definition and the next page of the document (see *Page Numbering*). If you do not set a new page number, page number references may not be accurate after the table is generated (since the table itself will probably introduce new pages into the document). A warning message appears when the table of authorities is generated if a New Page Number code is not found.

**See Also:** Index; Lists; Table of Authorities; Table of Contents

---

**Go To**
Instead of moving the cursor, you can use Go To to move quickly to a specific location.

1 Press **Go To**, then press an appropriate keystroke (see *Go To Keystrokes* below).

**Notes**

<table>
<thead>
<tr>
<th>Go To</th>
<th>Keystrokes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Immediate right of the next occurrence of any character</td>
<td>Go To, <em>character</em></td>
</tr>
<tr>
<td>Next Hard Return code [HRt]</td>
<td>Go To, Return</td>
</tr>
<tr>
<td>Top of the current page or column</td>
<td>Go To, Up Arrow</td>
</tr>
<tr>
<td>Bottom of the current page</td>
<td>Go To, Down Arrow</td>
</tr>
<tr>
<td>Top of any page in your document</td>
<td>Go To, <em>page number</em>, Return</td>
</tr>
<tr>
<td>Beginning of a block (when Block is on)</td>
<td>Go To, Block</td>
</tr>
</tbody>
</table>

**In Columns**
When you use Columns (Newspaper and Parallel), you can use Go To with the Left and Right Arrow keys to move the cursor from column to column when you edit existing text (see *Columns, Newspaper* and *Columns, Parallel*).

**Not Found**
When Go To searches for a character or a Hard Return code [HRt], if that character is not found in the next 2000 characters, a beep sounds and the cursor remains in place.
**Previous Position**

After using the following keys you can press **Go To** twice to return the cursor to its previous location:

- Block
- Replace
- Escape
- Screen Up
- Go To
- Screen Down
- Home, arrow keys
- • Search
- Page Up
- • Search
- Page Down

**See Also:** Columns, Newspaper; Columns, Parallel

---

**Go to Corel Shell**

Under Corel Shell, you can leave Corel WordPerfect and return to the shell without exiting Corel WordPerfect.

1 Press **Home, Return** to go directly to Corel Shell, then go to step 3.
   
   or

   Press **Shell** to display Corel Shell options.

   Or  
   Select Go to Shell from the File menu, then go to step 3.

2 Select Go to Shell (1).

3 You can start another shell program, select a shell feature, or go to UNIX.

4 Select the Corel WordPerfect program letter to return to Corel WordPerfect.

Your cursor is returned to the same place as it was when you left Corel WordPerfect.

---

**Notes**

**Caution**

If Corel Shell is running while you are at UNIX, a “(Shell)” message precedes the UNIX prompt at the command line. If Corel WordPerfect is running, do not return to it by entering **wp** from the UNIX prompt. This will load Corel WordPerfect a second time. To return to the current copy of Corel WordPerfect, enter **exit** to return to the shell, then go to Corel WordPerfect.

**UNIX Command**

While running Corel WordPerfect from the shell, you can also perform a UNIX command. Press **Shell**, then select UNIX Command (5). You are prompted for
the command at the status line. After the command has been performed, press any key to return to Corel WordPerfect.

**Corel Shell Clipboard**
The Clipboard is a special file Corel Shell uses to hold the text you transfer from program to program.

While running Corel WordPerfect under the Corel Shell, pressing Shell from the normal editing screen displays the Shell Clipboard options. You can then select Save (2) to save the current document to the Clipboard, and then select Append (3) to add the current document at the end of any existing text in the Clipboard, or Retrieve (4) to retrieve the contents of the Clipboard at the cursor.

If Block is on when you press Shell and select Save (2) or Append (3), only the blocked text is saved or appended to the Clipboard.

**See Also:** Go to UNIX

---

**Go to UNIX**

When you start Corel WordPerfect from the UNIX prompt, you can return to UNIX without exiting Corel WordPerfect.

1. Press Shell, then select Go to UNIX (1).
2. Perform any UNIX commands.
3. Type `exit` and press Return to return to Corel WordPerfect. You cannot return by pressing Exit (see Caution below).

Your cursor is returned to its original position when you left Corel WordPerfect.

**Notes**

**Caution**

If Corel WordPerfect is running while you are at the UNIX prompt, an “Enter ‘EXIT’ to return to Corel WordPerfect” message is displayed above the UNIX prompt. You must type `exit` and press Return to return to Corel WordPerfect. Do not try to return by entering `wp`. This loads Corel WordPerfect a second time into memory.

You can run other programs from UNIX before returning to Corel WordPerfect.

**UNIX Command**

While running Corel WordPerfect from UNIX, you can also perform a UNIX command. Press Shell, then select UNIX Command (5). You are prompted for the command at the status line. After the command has been performed, press any key to return to Corel WordPerfect.
Under Corel Shell
Different Corel Shell menu options appear when you press Shell if you run Corel WordPerfect under the Corel WordPerfect Shell.

See Also: Go to Corel Shell

---

**Graphics, Conversion Program**

The Graphics Conversion Program converts files in various graphics formats to Corel WordPerfect (.wpg) format. Many files can be converted directly through the Graphics feature. See *Graphics, Formats and Programs* for more information before using the Graphics Conversion Program.

Use the Graphics Conversion Program to convert files in supported formats if:

- You must use the startup options available with the Conversion Program to affect the way the file is converted (see *Startup Options* below).
- You want to convert multiple files (see *Multiple Files* below).
- You are using the Graphic on Disk feature and want to save time printing, viewing, and editing the display parameters of the graphic (see *Graphic on Disk* below).

**Important:** The Graphics Conversion Program file (graphcnv) needs to be installed properly before using the program. If you did not install the utility programs when you installed Corel WordPerfect, you must do so to use the Graphics Conversion Program.

To run the program,

1. Go to UNIX.
2. Change to the wpbin directory where the graphcnv executable is located.
3. Enter `graphcnv` to start the program.
4. Enter the file to be converted (input file).
5. Confirm or edit the default filename, or create a different one (output file).

When you see the “->ok” message, the conversion is complete.

6. Press any key to exit the program.

**Notes**

**Error Messages**
As the Graphics Conversion Program converts your files, the following error messages may appear.

**Bad Format** • The input file format is not supported by the Graphics Conversion Program. Export the file to another supported format in your graphics program. For a list of supported formats, see *Graphics, Formats and Programs*.  

164 Graphics, Conversion Program
Bad Input File • The specified path to the input file cannot be found or does not exist. This message can also indicate that an error occurred while converting a file. For example, the input file may be corrupt, or it may contain information not readable because of the type of input file it is.

Check the path and run the Graphics Conversion Program again to enter the correct path. If the original path was correct, re-export the file with your graphics program, then run the Graphics Conversion Program again.

End of File • An unexpected end of file was encountered while trying to convert the file. Export the file from your graphics program in another supported format. See Graphics, Formats and Programs for a list of supported formats.

File Not Found • The specified file could not be found. Check the path and filename.

Graphic on Disk
When Corel WordPerfect needs to use an image located in a graphic file on disk, it must find the file and convert it. The converted file is placed in a temporary file which is deleted when the file is no longer needed. The conversion occurs every time you print or view a document using a graphic on disk, or when you edit the display parameters of a graphic on disk (see Graphics, Edit for more information).

If you pre-convert the file by using the Graphics Conversion Program, you will reduce the time required for these tasks, but the graphics program you used to create the file may not be able to edit the converted file.

Multiple Files
You can use wildcard characters when specifying the input filename to convert multiple files. Use “?” to represent a single character, and “*” to represent zero or more characters in succession. The output filenames will match the input filenames, but will have a .wpg extension.

For example, if you have a series of graphics named graphic1.dxf, graphic2.dxf, graphic3.dxf, and other files with the same extension, you could convert them at the same time to Corel WordPerfect format by entering graphic2.dxf as the input filename. The output files would be named graphic1.wpg, graphic2.wpg, graphic3.wpg, and other files with a .wpg extension. To convert any file with a .dxf extension to Corel WordPerfect format, you would enter *.dxf as the input filename.

Startup Options
The following startup options can be used with the Graphics Conversion Program:

\texttt{inputfilename outputfilename} • You can specify both the input filename and output filename when you start the Graphics Conversion Program by entering \texttt{graphcnv inputfilename -o outputfilename}, where \texttt{inputfilename} is the name of the file to be converted, and \texttt{outputfilename} is the name of the output file.
You can also use wildcard characters in the input filename without using an output filename to convert multiple files. See Multiple Files above for more information.

- **c 2** Converts color values in the input file to monochrome (black and white).

- **c 16** Converts color values in the input file to the Corel WordPerfect standard 16-color palette.

- **c 256** Converts color values in the input file to the Corel WordPerfect standard 256-color palette. (Use this option when you have a graphics adapter capable of displaying 256 simultaneous colors.)

- **c b** Converts all color values in the input file to black (not for use with bitmap images).

- **c w** Converts all color values in the input file to white (not for use with bitmap images).

- **g 16** Converts color values in the input file to the Corel WordPerfect standard 16 shades of gray palette.

- **g 256** Converts color values in the input file to the 16 shades of gray present in the Corel WordPerfect standard 256-color palette. (Use this option when you have a graphics adapter capable of displaying 256 simultaneous colors.)

- **h** Displays helpful information about the Graphics Conversion Program.

- **O** Lets you override the “Replace files?” user prompts. This is known as unattended mode. When the Graphics Conversion Program writes an output file with a filename that already exists, it will replace the existing file without issuing a prompt.

**See Also:** Graphics, Create; Graphics, Edit; Graphics, Formats and Programs

---

**Graphics, Create**

You can insert pictures or images from many sources into your document.

*For a list of supported graphics formats and the programs that produce those formats, see Graphics, Formats and Programs.*

You can create a box and wrap text around the box. The location, appearance, and size of the box can be adjusted, and a graphics image, an equation, or another document (less than a page long) can be retrieved into the box. You can
define columns, create tables, enter merge codes, and import a spreadsheet into a graphics box.

On the normal editing screen, an outline of the graphics box is displayed in your document if you are wrapping text around the box (see *Wrap Text Around Box* under *Graphics, Define a Box*). To see the contents of the box, you must use View Document or select Edit (9) on the box definition menu (see *Graphics, Edit*).

You can also place horizontal or vertical lines on a page with the Graphics feature.

You can include graphics in a document even if you do not have a graphics display card installed in your terminal, but only a rough image of the graphics figures is displayed (see *Graphics Screen Type*).

If your printer supports graphics, you can print text and graphics in a document even if your terminal cannot display graphics (see *Print, Document on Disk* and *Print, Document on Screen*).

To create a graphics box,

1. Press Graphics, then select a box type (see *Box Types* below).
   
   Or Select a box type (Figure, Table Box, Text Box, User Box or Equation) from the Graphics menu.

2. Select Create (1), then define the box (see *Defining a Box* below).

3. Press Exit to return to the document.
Notes

Box Types
There are five graphics box types from which to choose:

- Figure
- Table
- Text
- User
- Equation

The main distinguishing feature between the boxes is the border style: a Figure box has a single border, a Table box has a bolded top and bottom border, and a Text box has a bolded top and bottom border with shading. (The User box and the Equation box have no borders and are not illustrated here.)

You can retrieve graphic images, text, or equations into any of the box types, or you can leave a box empty. The box type does not necessarily refer to the contents of the box, but to which of the independent lists of graphics boxes it belongs.

Each box type is numbered on a separate list and has its own set of options. For example, the default numbering mode for Table boxes is Roman numerals (Table I), while the default numbering mode for Figure boxes is numbers (Figure 1). The numbering mode, border styles, and other options can be changed with the Graphics Options menu, and Equation boxes have different Caption Position choices (see Graphics Options).

A separate list for each box type can be generated with the List feature.

You can use Figure boxes for graphic images, diagrams, and charts. Table boxes are useful to create tables, tables of numbers, maps, and statistical data. You can use text boxes for quotes, sidebars, or other special text that is set off from the rest of the document. Use equation boxes for mathematical and scientific equations. User boxes can be used for any images in the document that do not fall into any of the other categories.

If you edit or create a graphics box and want to change the box type (for instance, change a Table box into a Figure box), press Graphics while in the box definition menu and select the desired box type.

Defining a Box
Once you select a box type and select Create (1) to create a graphics box, you must define the box. You can retrieve a graphics image into a box by selecting Filename (1), then entering the name of a file created in one of the graphics formats that Corel WordPerfect supports (for a list of supported graphics formats and the programs producing those formats, see Graphics, Formats and Programs). You can also retrieve a table or text by entering the name of a Corel WordPerfect file containing one of these (see Table, Create). To retrieve an equation into a box, first select Equation (4) as the contents (see Contents under Graphics, Define a Box).
To include the graphics image, table, text, or equation in your document with all the default settings, press **Exit** to exit the definition. For information about changing the size and position of the graphics box on the page, see *Graphics, Define a Box*.

**New Number**
Graphics boxes are numbered consecutively according to the box type. You can start numbering with a new number at any point in the document.

1. Move the cursor to where you want to enter the new number.  
   Use **Reveal Codes** to find the box code ([Fig Box:3;filename;caption]), then make sure your cursor precedes the box code you want renumbered.

2. Press **Graphics**, then select the type of box you want to renumber.  
   Or, select the type of box you want to renumber (Figure, Table Box, Text Box, User Box, or Equation) from the **Graphics menu**.

3. Select **New Number** (3), then enter a number.  
   From that point forward in the document, graphics boxes of the type you selected in step 2 are renumbered starting with the new number.

   *The maximum number for any type of graphics box is 2047. Numbering starts over with 1 after 2047.*

**See Also:** Equations; Graphics, Define a Box; Graphics, Edit; Graphics Lines; Graphics Options
Graphics, Define a Box

To define a graphics box,

1. Press **Graphics**, then select the type of box you want to define.
   
   Or  
   Select a box type (Figure, Table Box, Text Box, User Box, or Equation) from the Graphics menu.

2. Select **Create** (1), then select an option and enter any necessary information (see the information for each option under Notes below).

3. Press **Exit** to return to the document.

---

**Notes**

**Anchor Type**

Determines whether the graphics box remains placed at a fixed position on a page (page type), moves with the text that wraps around it (paragraph type), or is treated as part of the text on a line (character type).

- **Page** • To keep the graphics box at a fixed position on a specified page, make sure the cursor is at the top of the current page when you create the box, select Page (2) as the anchor type, then enter the number of pages you want skipped. For example, if you want a page type box to appear on the current page, enter 0 as the number of pages to skip. If you want the box to appear on page 3 and the cursor is on page 1, enter 2 as the number of pages to skip. Make sure the cursor is at the top of page 1, and the graphics box will appear on page 3. If you edit the text after creating the box, make sure the graphics box code (see Codes below) remains at the top of the page.

   If your document does not contain as many pages as the “pages to skip” number you enter, the box will appear on the page following the last page of the document. For example, if your document has only one page and you enter 4 as the number of pages to skip, the box will appear on page 2.

   The code for a page box (see Codes below) is inserted at the cursor position.

- **Paragraph** • If you want the graphics box to stay with its surrounding text, select Paragraph (1). The code for a paragraph box (see Codes below) is placed at the beginning of the paragraph the cursor is in (after the last hard return or hard page code).

   If the paragraph is too close to the bottom of the page for the graphics box to fit on the page, the box is bumped to the top of the next page or column. However, the text of the paragraph containing the box does not move with it.

   When the box is bumped, text that normally follows the box is moved in front of the box to fill the empty space.

   You can use Block Protect to keep the text of the paragraph with the graphics box.

   When editing the paragraph, make sure you do not add text in front of the graphics box code. The code should be the first code in the paragraph.

---

170  Graphics, Define a Box
Character • Boxes with a character anchor type are treated as a single character, regardless of the box size. When the line containing the box is wrapped, the next line starts below the box. Use this anchor type to position images or equations in a line of text.

The code for a character box (see Codes below) is placed at the cursor position.

The outside border space (see Outside Border Space under Graphics Options) is not used with character-type boxes.

Bumping Graphics Boxes
If you edit a graphics box (or the text surrounding the box) and it no longer fits on the current page, it is bumped to the next page. If you edit another box so it cannot fit on the first page, it is also bumped to the next page. However, if the two boxes cannot fit together on the next page, the second box is bumped again. A box can be bumped up to 255 pages. (The graphics boxes will overlap after 255 pages.)

Caption
This option lets you create a caption for the box with text and codes. The current box number is a numbering code that is displayed when you enter this...
screen. This number automatically updates as you create other boxes of the same type (all types of graphic boxes are numbered consecutively).

Current box number

You can use the number or you can delete it in the caption editing screen with Backspace. Press Graphics to reinsert the number.

The text for the caption wraps according to the width of the graphics box you define. You can use up to 256 bytes in the caption.

To change the position of the caption relative to the box or the caption numbering style, use Graphics Options (see Graphics Options).

Press Exit when you finish creating the caption to return to the box definition menu.

Changing a Box Definition

If you already created a graphics box following the steps above and want to edit the box definition, select Edit (2), then enter the number of the box you want to edit. (The number displayed is one higher than the box number preceding the cursor position.) The box definition menu is displayed and you can edit or change any of the options information.

Codes

A code is inserted into your document when you create a graphics box. Its placement depends on the anchor type (see Anchor Type above for details). The code contains the name of the type of graphics box, the box number, the filename, and the caption, if you are using one. To delete the box, delete the code.

Contents

This option (2) lets you choose the information to put in the graphics box. The Contents option you select determines which Editor (Equation, Graphics, or Text) will be displayed when you select Edit (9) from the box definition menu (see Graphics, Edit). It also lets you decide if graphics information is stored on disk in a separate file or as part of the document.

If you specify a filename before selecting this option (see Filename below), the Contents option will display a default depending on the type of file you
specified. For example, if you retrieve a graphics file, the Contents option will default to Graphic.

If there is information inside the box and you select a Contents option that differs from the option already displayed, you will be asked if you want to delete the current contents of the box. For example, if you retrieve a text file into a box, the Contents option will display “Text.” If you change the Contents option to Graphic, you are asked if you want to delete the current contents. Type y to replace the text file in the box with a graphic image. Type n to leave the text in the box.

**Equation** • Select this option (4) before you create or edit an equation. Selecting Edit (9) displays the Equation Editor.

**Graphic** • This option (1) is the Contents default if you specified a graphics image with the Filename option (see **Filename** below). (If you select this option with “Graphic on Disk” already displayed, the graphics image will be retrieved from disk into the document.)

If you select this option and then select Edit (9), the image will be displayed in the Graphics Editor (if an image has been retrieved into the box). If you have not retrieved a graphics image into the box, the Contents option will display “Empty” and selecting Edit will display the Text Editor (see **Graphics Editor** and **Text Editor** under Graphics, Edit for details on the Graphics and Text Editors).

**Graphic on Disk** • Select this option (2) to store your graphics information in a separate file on disk, instead of saving it with the document. This option is the only method for placing a graphics box containing a graphics image into a style (see **Style**). It also lets you reference the graphics image multiple times in a document without saving the information in the document each time. This conserves space in the document file.

Selecting Edit (9) after selecting this option retrieves the image from disk and displays it in the Graphics Editor if you already specified a filename. If no filename is specified, selecting Edit does nothing.

When you want to view the graphics image in the View Document screen or from the Graphics Editor (by selecting Edit from the box definition menu), or when you want to print the document, Corel WordPerfect looks for the graphics file first in your graphics directory, then in the default directory.

If Corel WordPerfect cannot find the graphics file and you try to view the graphics image in the View Document screen, a blank box is displayed. If you try to view it in the Graphics Editor, an error message appears stating that the graphics file cannot be found. Copy the graphics file into the graphics or default directory, then select Edit (9) from the box definition menu to correctly display the image.

If you try to print the graphics image and Corel WordPerfect cannot find the file, an error message stating that the graphics file cannot be found appears in the Printer Control screen. Type c to cancel the print job, or copy the file.
into your graphics or default directory, then type g from the Printer Control screen to continue printing.

If you type g to continue without copying the graphics file into your graphics or default directory, a blank box is printed.

Text • This option (3) identifies the contents of a graphics box as text. Selecting Edit (9) displays the Text Editor where you can enter text or codes (see Text Editor under Graphics, Edit for details on the Text Editor).

Edit
This option (9) lets you rotate, scale, or move a graphics image in the box (see Graphics, Edit) if a filename has been specified and the Contents option is set to Graphic, or Graphic on Disk. If the Contents option is set to Text or Empty, this option displays the Text Editor where you can edit text in the box. If the Contents option is set to Equation, this option displays the Equation Editor.

Filename
Select this option (1) to specify a file you want in a graphics box. To retrieve text into the box, specify a document filename. To retrieve a graphics image, enter the name of a file created in one of the graphics formats Corel WordPerfect supports (for a list of supported graphics formats and programs producing those formats, see Graphics, Formats and Programs). To retrieve an equation, select Equation (4) from the Contents menu (see Contents above), then specify the filename of an existing equation. (If you do not select Equation before specifying a filename, the file will be interpreted as text.)

You can press List at the “Enter Filename” prompt and retrieve a file from the List Files screen. Your graphics directory is displayed as the default when you press List. You can also press Shell at the “Enter Filename” prompt (if you are running Corel WordPerfect under the Corel Shell), then type y to retrieve the contents of the Clipboard into a graphics box (see Go to Corel Shell).

When you specify a filename, Corel WordPerfect determines the format of the file and retrieves the image or text into the box. If the file was not created in a supported format, an error message is displayed (for a list of supported graphics formats and programs producing those formats, see Graphics, Formats and Programs).

To leave the box empty, do not enter a filename for the box. To delete the contents of a box without deleting the box, select Filename (1), press Delete to End of Line, press Return, then type y. The Contents option on the menu is changed to “Empty.” (If the Contents option says “Graphic on Disk” before you delete the filename, it stays “Graphic on Disk.”)

Horizontal Position
This option (6) is based on the choice you made for the Anchor Type option (see Anchor Type above). These choices and their effects on this option are described below.

Character • If you select Character (3) as the anchor type, you cannot enter a horizontal position. The box is positioned after the character to its left.
Page • If you select Page (2) as the anchor type, you can choose Margins, Columns, or Set Position.

Selecting Margins (1) displays a menu to align the box with the Left (1) or Right (2) margin, Center (3) it between the margins, or expand the box to the Full (4) horizontal width between the left and right margins. The last option also aligns the box with the left and right margins.

Columns (2) lets you enter column numbers, then aligns the box with the Left (1) edge, the Right (2) edge, or Center (3) it between one or more columns. If you enter a range of columns (2-3), the box is left-aligned, right-aligned, or center-aligned over the range of columns.

You can also select Full (4) to expand the box to align with the specified column margins. If no columns are defined when you select this option, the box is aligned with the margins.

Set Position (3) lets you enter an absolute measurement from the left edge of the form to position the box horizontally. This positions the outside border space at that measurement.

Paragraph • If you select Paragraph (1) as the anchor type, you can align the box with the Left (1) edge, the Right (2) edge, or Center (3) it in the area where the text currently wraps. You can also select Full (4) to have the box fill this area from left to right. A box with a paragraph anchor type can be positioned only within the area where the text currently wraps.

Size

Three of the four options include complete or partial automatic sizing. When you select option 1, 2, or 4, the automatic part of these options is displayed in parentheses next to the Size option. For example, if you select Set Height/ Auto Width (2), the word “wide” appears in parentheses following the measurement because the width is automatically determined.
The default width for graphics boxes (except Equation boxes) is equal to one half of the available space between the left and right margins. For example, if you have 1” margins on an 8.5” x 11” form, there are 6.5” of available space, so the default width for a graphics box would be 3.25”. Equation boxes default to fill the space between the margins (6.5” in this example).

**Auto Both** • Select this option (4) with a graphics image or equation to restore the original dimensions of the image or equation. Corel WordPerfect automatically calculates the height and width, preserving the original shape of the graphics image or equation.

*When you retrieve a scanned image into a graphics box, Corel WordPerfect scales the image to fit in the box. The Auto Both option can help restore the original dimensions and resolution of the scanned image.*

If you select this option for a Text box and there is only one line of text, the box fits around the words. If there is more than one line of text, the height fits the text and the width returns to the default.

**Set Both** • Select this option (3) if you want a particular height *and* width, then enter the measurements.

Because you are manually changing the dimensions, a graphics image may appear and print distorted.

**Set Height/Auto Width** • Select this option (2) if you want the box to be a specific height, but want the width calculated automatically, preserving the original shape of the graphics image.

For text and equations, the automatic width is determined by the last width measurement entered, and the text or equation will not reformat in the box.

**Set Width/Auto Height** • Select this option (1) if you want the box to be a specific width, but want the box height calculated automatically so that the original shape of the graphics image is preserved.

With this option, text reformats to the width you enter and adjusts the height accordingly. Equations are centered horizontally and the height adjusts as needed. You can change this default setting for equations using Equations Options.

When Corel WordPerfect must reduce the desired height and width settings for a box to fit within the margins on the page, it readjusts the height and width of the box if space becomes available after editing.

**Vertical Position**

This option (5) is dependent on the choice you made for the Anchor Type option.

**Character** • If you selected Character (3) as the anchor type, a menu is displayed that lets you position the box so the Top (1), Center (2) or Bottom (3) of the box is aligned with the baseline of the line of text containing the box. You can also select Baseline (4).
If you select Baseline for a box containing an equation, the baseline of the equation is aligned with the baseline of the line of text containing the box. If the box contains text, the baseline of the last line of text inside the box is aligned with the baseline of the line of text containing the box.

To align the bottom of a graphics image box with the baseline of the line of text containing the box, select Bottom (3).

Page • If you selected Page (2) as the anchor type, then entered the number of pages to skip, a menu is displayed that lets you align the box with the Top (2) (even with the first line of text—below any headers, or page numbers) or Bottom (4) (above any footers, page numbers, or footnotes) of the page. You can also Center (3) the box on the page or select Set Position (5), then enter an offset measurement from the top edge of the form.

If you select Full Page (1), the graphics box fills the page area within the top and bottom margins. (A graphics image will maintain the proper dimensions.)

Paragraph • If you selected Paragraph (1) as the anchor type, enter an offset measurement from the top of the paragraph your cursor is on. For example, enter 0 to align the top of the box with the top of the first line of the paragraph.

If you enter anything other than 0 for this option, the outside border space (instead of the top edge of the box) is placed at the vertical position.

After creating the graphics box, the default shown for the Vertical Position option is the distance the cursor is from the top of the current paragraph. The offset you enter changes the setting unless the paragraph is at the bottom of the page and the box does not fit on the page. The box is moved up in the paragraph to try to keep the box within the paragraph. If there is not enough room on the page, the box is bumped to the next page.

You can control how far the box can move up in the paragraph before being bumped to the next page with the Minimum Offset from Paragraph option on the Graphics Options menu (see Graphics Options).

For example, if you set the Minimum Offset option on the Graphics Options menu to .5" and the Vertical Position option on a paragraph type box to 1", the paragraph containing the box is moved down the page. When the bottom of the box reaches the bottom margin of the page, the box starts moving up in the paragraph. If there is not enough room when the top of the box reaches the .5" mark in the paragraph, it is bumped to the next page.

Wrap Text Around Box
If you want the box ignored and continue printing text from margin to margin, type n for this option. Setting this option (8) to No is a method you can use (in
conjunction with Advance) to superimpose one graphics box on top of another, or to print text on top of a graphics image, as shown in the illustration below.

![HELP!](image)

When Wrap Text Around Box is set to No, the box outline is not shown in the normal editing screen. To view the box on the page, you must use View Document.

If you set this option to No for a box with a Paragraph anchor type, the figure cannot be bumped to the following page. If there is not enough room for the entire figure to fit on the current page, the amount of the figure that fits on the page is printed.

Text can be wrapped around a maximum of 100 boxes on one page. More boxes can be created, but the option must be set to No.

**See Also:** Graphics, Create; Graphics, Edit; Graphics Options

---

**Graphics, Edit**

Once you create a graphics box in your document, you may need to edit the way the graphics image is displayed.

As you edit graphics, you can change the contents of the box to a different type (you can retrieve a graphics figure into a Text box or an equation into a Figure box).

1. Press **Graphics**, then select the type of box you want to edit.

   Or [ ] Select a box type (Figure, Table Box, Text Box, User Box, or Equation) from the Graphics menu.
2 Select Create (1).

or

Select Edit (2), then enter the number of the box you want to edit.

The screen displayed is the box definition menu which lets you define the graphics box (see Graphics, Define a Box for details on this menu).

3 Select Edit (9) from the box definition menu.

Three different screens can appear, depending on the type of information you are editing: the Equation Editor, Graphics Editor, or Text Editor (see the different editors listed under Notes below).

4 Select a feature (Move, Scale, Rotate, Invert On, Black and White), which is displayed at the bottom of the editing screen, then enter any necessary information (see the information for each editor under Notes below).

5 Press Exit twice to return to the document.

---

**Notes**

**Equation Editor**

If the Contents option on the box definition menu is set to Equation, selecting Edit (9) from the box definition menu displays the Equation Editor. This screen lets you create and edit scientific and mathematical equations.

**Graphics Editor**

If the Contents option on the box definition menu is set to Graphic or Graphic on Disk and a filename has been specified, selecting Edit (9) will display the Graphics Editor.

Black & White • Select this option, then type y to display or print a color image with black and white, instead of a shading or fill pattern.

Go To • Press Go To to redisplay the image with the default settings.

---

*Graphics, Edit* 179
**Insert (%) Change** • Press **Insert** to change the percentage amount displayed in the lower right corner of the screen to 1, 5, 10, or 25 percent. The percentage determines the extent to which the arrow keys, Page Up/Down, and Screen Up/Down affect the image for moving, scaling, and rotating.

**Invert On/Off** • If this option says “Invert On,” select it for a bitmap image to display the complementary color of the background (black becomes white and vice versa). Select it again to return to the original display.

You will not see the Invert effect on color monitors, but the image will print inverted.

With figures that are line drawings (vector-type graphics), select this option to switch only the background color. If the background color is white, it becomes black. If you switch the background color to black and the print color is black, nothing will print when you print the graphic. Corel WordPerfect will not try to print color values that match the background color.

*Graphics from scan and paint programs are usually bitmapped. CAD and draw program graphics are usually vector-type graphics (see Graphics, Formats and Programs).*

**Move** • The **Move** option (and the arrow keys) lets you move the image horizontally and vertically in the box. You can move the image the percentage displayed in the lower right corner of the screen by pressing the arrow keys. Move the image a specific amount by selecting **Move** (1), then enter the horizontal and vertical measurements in positive or negative numbers.

Entering positive numbers for horizontal and vertical moves the image up and to the right. A positive horizontal and negative vertical moves it down and to the right. Negative numbers for both moves it down and to the left. A negative horizontal and positive vertical moves it up and to the left.

When you enter horizontal and vertical measurements, the numbers you enter move the image from the starting point, not from any measurements you have previously entered. For example, if you enter .5 for both the horizontal and vertical measurements, the image moves up and to the right. If you want the image moved half again as far up and to the right, you would not enter .25, you would enter .75.

*If you move the image in the screen, then want to move it back to the original position, press **Go To**. This resets any changes you have made, including any changes to rotate and Scale.*

**Rotate** • Rotate (and the Screen Up and Screen Down keys) lets you rotate the image. You can rotate the image the percentage displayed in the lower right corner of the screen by pressing Screen Up or Screen Down. To rotate the image a specific amount, select **Rotate** (3), then enter the number of degrees.

When you enter the number of degrees, the image is rotated from the starting point, not from the rotation amount you previously entered. For example, if you enter 180 to rotate the image halfway around in the box, you
cannot enter 180 again to return it to its previous position. You must enter 360 (or 0) to return the image to the starting point.

If you select Rotate, you are asked if you want a mirrored image. A mirrored image changes the dots in the image so they display from right to left. For example, if the box contains the profile of a person facing right, the mirror image would show the profile facing left.

If you rotate or mirror the image in the screen, then want to return it to the original position, press Go To. This resets any other changes you made as well.

Save • Once a graphics image is displayed inside the Graphics Editor, it can be saved in Corel WordPerfect graphics format by pressing Save and entering a filename. If you specified a graphics directory in the Setup: Location of Files option, the filename displayed includes your graphics directory in the path. A .wpg extension is added unless you specify a different extension.

When you enter a filename, only the data inside the image is saved, not any editing changes you have made. If you retrieve the saved file as a graphics image into another box, any editing changes you made before saving will not be displayed.

Scale • Scale (and the Page Up or Page Down keys) lets you expand or contract the image in a horizontal and vertical direction. You can scale the image the percentage displayed in the lower right corner of the screen by pressing Page Up or Page Down. You can scale the image a specific amount by selecting Scale (2), then entering the horizontal (x) and vertical (y) percentages.

For example, if you select Scale, then enter 80 for the x value and 80 for the y value, the image will be 80% of the original size. If, however, you enter 80 for x and 110 for y, the image will be 80% as wide, but 110% as tall as the original size. (Page Up and Page Down scale x and y the same amount.)

When you enter x and y percentages, the image is scaled from the starting point, not from the x and y amounts you previously entered.

If you scale the image larger or smaller, then want to return it to the original size, press Go To. This resets any other changes you have made.

Corel Shell • If you are running Corel WordPerfect under the Corel Shell, you can press Shell while in the Graphics Editor to Go to Shell (1), Save (2) the graphics image to the Clipboard, or Retrieve (3) the contents of the Clipboard into the Graphics Editor.

You can integrate Corel WordPerfect with other programs you run under the Corel Shell. For example, you can save a graphics image to the Clipboard, go to Shell and start another program, then retrieve the contents of the Clipboard into that program. You can then make changes to the image, repeat the process to come back to Corel WordPerfect and Retrieve (3) the contents of the Clipboard into the Graphics Editor (see Go to Corel Shell).

Switch • Pressing Switch in the Graphics Editor does the same thing as selecting Invert On/Off (4) (see Invert On/Off above).
Text Editor
If you create or edit text inside a box (the Contents option on the box definition menu is set to Text or Empty), selecting Edit (9) displays a blank Text Editor (if you have not yet entered a filename for the graphics box) or the Text Editor with text in it (if you are editing existing text). You can enter the text or codes you want in the box. Press Exit to exit the Text Editor or press Graphics, then select the option with the number of degrees you want to rotate the text in the box (text is rotated counterclockwise). To print rotated text in a box, your printer must be able to rotate fonts (see Printing, Landscape).

Retrieving a document that is longer than one page generates an error message stating that the file contains too much text when you try to exit the Text Editor. Delete text until the remaining text fits on the page.

Features in the Text Editor • In the Text Editor you can define columns, use Text In/Out to import and export files (including spreadsheets), enter Merge commands, and create tables.

You can also retrieve a document or display the files in a directory. If you are using Corel Shell, press Shell to Go to Shell (1), or Save to (2), Append to (3), or Retrieve from (4) the Clipboard. You can also enter a UNIX Command (5) from the Text Editor (see Go to Corel Shell).

See Also: Graphics, Create; Graphics, Define a Box; Graphics Options

Graphics, Formats, and Programs
You can use graphics created in any supported format by converting it to Corel WordPerfect Graphic format.

UNSUPPORTED -> SUPPORTED -> .wpg

Conversion A  Conversion B

Conversion A is for files in formats not supported by Corel WordPerfect. Your graphics program must perform this conversion. If your graphics files are in a supported format, conversion is not necessary. (For information about converting it to another supported format see Supported Formats, Conversion Notes below.)

Supported graphics formats:

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Export Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>CGM</td>
<td>Computer Graphics Metafile</td>
</tr>
<tr>
<td>DHP</td>
<td>Dr. Halo PIC format</td>
</tr>
<tr>
<td>DXF</td>
<td>AutoCAD® format</td>
</tr>
<tr>
<td>EPS</td>
<td>Encapsulated PostScript</td>
</tr>
<tr>
<td>GEM</td>
<td>GEM® Draw Format</td>
</tr>
</tbody>
</table>
### Abbreviation | Export Format
--- | ---
HPGL | Hewlett-Packard® Graphics Language Plotter File
IMG | GEM® Paint Format
MSP | Microsoft® Windows Paint Format
PCX | PC Paintbrush Format
PIC | Lotus 1-2-3® PIC Format
PNTG | Macintosh® Paint Format
PPIC | PC Paint Plus Format
TIFF | Tagged Image File Format
WPG | Corel WordPerfect Graphics Format
( none) | Sun™ RasterFile
( none) | X.11 Bitmap Standard
xwd | X Window Image Dump

Conversion B is from a supported format to .wpg format:

- Retrieve the graphics file with Graphics (see Graphics, Define a Box). Retrieving the graphic into a graphics box automatically converts it to .wpg format.
- Print or preview a document that uses a graphic on disk, or edit the display parameters of a graphic on disk in a Corel WordPerfect document (see Graphics, Define a Box and Graphics, Edit). This conversion is only temporary and does not affect the graphics file on disk, but does allow Corel WordPerfect to use the image.
- Use the Graphics Conversion Program (a utility program that comes with Corel WordPerfect) to convert the file. The Graphics Conversion Program creates a copy of the image and stores it in a .wpg formatted file. (See Graphics, Conversion Program.) This file can then be retrieved through the Graphics feature or used as a graphic on disk.

Graphics files in any of the formats on the above list (except DXF format) may be converted by retrieving the graphic in Graphics, with no additional conversion.

Files in DXF format must be converted by the Graphics Conversion Program before they can be retrieved.

The Graphics Conversion Program can convert files of the supported formats to .wpg format. Whether you want to use the Graphics Conversion Program to do the conversion or retrieve the file through the Graphics feature depends on several factors. See Graphics, Conversion Program for more information.

---

**Notes**

**Graphics Programs**
The following graphics programs have been tested with Corel WordPerfect. If your graphics program is not on this list, you may still be able to use it if it can generate a supported graphics format (see the list of supported formats above).

The Export column lists compatible formats that can be created with each graphics program. You may need to consult your graphics program documentation for information on creating a specific format.
<table>
<thead>
<tr>
<th>Program</th>
<th>Export</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adobe Illustrator®</td>
<td>EPS</td>
</tr>
<tr>
<td>Anvil-5000</td>
<td>HPGL</td>
</tr>
<tr>
<td>Arts &amp; Letters</td>
<td>CGM</td>
</tr>
<tr>
<td>AutoCAD® 9.0, 10.0</td>
<td>DXF,HPGL</td>
</tr>
<tr>
<td>AutoSketch 1.03</td>
<td>DXF,HPGL</td>
</tr>
<tr>
<td>Boeing Graph 4.0</td>
<td>IMG</td>
</tr>
<tr>
<td>CCS Designer</td>
<td>HPGL</td>
</tr>
<tr>
<td>ChartMaster 6.21</td>
<td>HPGL</td>
</tr>
<tr>
<td>Chemfile 11</td>
<td>EPS</td>
</tr>
<tr>
<td>Chemtext</td>
<td>TIFF</td>
</tr>
<tr>
<td>CIES (Compuscan)</td>
<td>HPGL</td>
</tr>
<tr>
<td>Designer 1.2 (Micrografx)®</td>
<td>EPS,CGM,PCX,TIFF</td>
</tr>
<tr>
<td>Designer 2.0 (Micrografx)®</td>
<td>IMG,TIFF</td>
</tr>
<tr>
<td>DFI Handy Scanner</td>
<td>HPGL</td>
</tr>
<tr>
<td>DiagramMaster 5.02</td>
<td>HPGL</td>
</tr>
<tr>
<td>Diagraph</td>
<td>DHP (PIC)</td>
</tr>
<tr>
<td>Dr. Halo II,III</td>
<td>CGM,HPGL,WPG</td>
</tr>
<tr>
<td>DrawPerfect®</td>
<td>HPGL</td>
</tr>
<tr>
<td>Easyflow 4.4</td>
<td>IMG,TIFF</td>
</tr>
<tr>
<td>Energraphics 2.1</td>
<td>CGM</td>
</tr>
<tr>
<td>Freelance® Plus 2.0, 3.0</td>
<td>GEM</td>
</tr>
<tr>
<td>GEM Draw™</td>
<td>IMG,TIFF</td>
</tr>
<tr>
<td>GEM Paint™ 2.0</td>
<td>IMG,TIFF</td>
</tr>
<tr>
<td>GEM Scan™</td>
<td>TIFF</td>
</tr>
<tr>
<td>Generic CAD</td>
<td>HPGL</td>
</tr>
<tr>
<td>GeniScan</td>
<td>TIFF</td>
</tr>
<tr>
<td>Graph-in-the-Box 2.0</td>
<td>HPGL</td>
</tr>
<tr>
<td>Graph Plus 1.3 (Micrografx)®</td>
<td>HPGL,EPS,CGM,PCX,TIFF</td>
</tr>
<tr>
<td>Graphics Editor 200</td>
<td>HPGL</td>
</tr>
<tr>
<td>GraphWriter®</td>
<td>CGM</td>
</tr>
<tr>
<td>Harvard Graphics® 2.1</td>
<td>HPGL,CGM,EPS</td>
</tr>
<tr>
<td>HiJaak</td>
<td>WPG</td>
</tr>
<tr>
<td>HOTSHOT Graphics 1.5</td>
<td>WPG</td>
</tr>
<tr>
<td>HP Scanning Gallery A.01</td>
<td>TIFE,PCX</td>
</tr>
<tr>
<td>IBM® CADÂM</td>
<td>HPGL</td>
</tr>
<tr>
<td>IBM® CATIA</td>
<td>HPGL</td>
</tr>
<tr>
<td>IBM® CBDS</td>
<td>HPGL</td>
</tr>
<tr>
<td>IBM® GDDM</td>
<td>HPGL</td>
</tr>
<tr>
<td>IBM® GPG</td>
<td>PHGL</td>
</tr>
<tr>
<td>Javelin Plus</td>
<td>HPGL</td>
</tr>
<tr>
<td>Lotus 1-2-3® 1A, 2.0</td>
<td>PIC</td>
</tr>
<tr>
<td>Lotus 1-2-3® 3.0</td>
<td>PCX,CGM</td>
</tr>
<tr>
<td>Macintosh® Paint 1.5</td>
<td>PNTG</td>
</tr>
<tr>
<td>Microsoft® Chart</td>
<td>HPGL</td>
</tr>
<tr>
<td>Microsoft® Excel™</td>
<td>HPGL</td>
</tr>
<tr>
<td>Mirage</td>
<td>HPGL</td>
</tr>
<tr>
<td>Paradox® 3.0</td>
<td>PIC</td>
</tr>
<tr>
<td>Program</td>
<td>Export</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>----------------------</td>
</tr>
<tr>
<td>PC Paint Plus 1.5, 2.0</td>
<td>PPIC</td>
</tr>
<tr>
<td>PicturePak</td>
<td>WPG, CGM, PCX</td>
</tr>
<tr>
<td>Pixie</td>
<td>CGM</td>
</tr>
<tr>
<td>Pizazz 1.01</td>
<td>PCX, TIFF</td>
</tr>
<tr>
<td>PlanPerfect® 3.0*, 5.0</td>
<td>CGM</td>
</tr>
<tr>
<td>PFS: First Publisher</td>
<td>PCX (MAC)</td>
</tr>
<tr>
<td>Reflex® 2.0</td>
<td>PIC</td>
</tr>
<tr>
<td>Quattro®</td>
<td>PIC, EPS</td>
</tr>
<tr>
<td>SAS®/Graph (6.03 and later)</td>
<td>HPGL</td>
</tr>
<tr>
<td>SAS® Graph (6.04 and earlier)</td>
<td>CGM</td>
</tr>
<tr>
<td>ScanMan</td>
<td>TIFF</td>
</tr>
<tr>
<td>Schema</td>
<td>HPGL</td>
</tr>
<tr>
<td>SignMaster 5.11</td>
<td>HPGL</td>
</tr>
<tr>
<td>SlideWrite Plus 2.1</td>
<td>HPGL, TIFF, PCX</td>
</tr>
<tr>
<td>Sun’s® screendump</td>
<td>Sun Rasterfile</td>
</tr>
<tr>
<td>SuperCalc®</td>
<td>PIC</td>
</tr>
<tr>
<td>Symphony®</td>
<td>PIC</td>
</tr>
<tr>
<td>Versacad</td>
<td>HPGL</td>
</tr>
<tr>
<td>VGA Paint</td>
<td>WPG, PCX, TIFF</td>
</tr>
<tr>
<td>VP Graphics</td>
<td>HPGL</td>
</tr>
<tr>
<td>VP Planner</td>
<td>PIC</td>
</tr>
<tr>
<td>Windows® Draw</td>
<td>HPGL</td>
</tr>
<tr>
<td>Windows® Paint 2.11</td>
<td>MSP</td>
</tr>
<tr>
<td>Words &amp; Figures</td>
<td>PIC</td>
</tr>
<tr>
<td>X’s bitmap</td>
<td>X.11 Bitmap</td>
</tr>
<tr>
<td>Xwd</td>
<td>XWD</td>
</tr>
<tr>
<td>Z-Soft PC Paintbrush</td>
<td>PCX</td>
</tr>
</tbody>
</table>

**Supported Formats, Conversion Notes**

Corel WordPerfect-supported graphics formats are listed below with information regarding the conversion of each format to .wpg format.

**CGM (Computer Graphics Metafile)**

- Fonts are converted to one of the following Corel WordPerfect vector fonts: WP Courier, WP Helv, or WP Roman.
- Drawn patterns (hatch patterns) are converted to the Corel WordPerfect fill pattern most closely resembling the original pattern. Color patterns are not converted in color, but are converted to the Corel WordPerfect fill pattern which most closely resembles it.
- Multiple pictures within a single file are superimposed.

**DHP (Dr. Halo PIC Format)**

- Supported up to Dr. Halo III.
- Area cut pictures are not supported.
DXF (AutoCAD Format) *
- The following DXF attributes are not converted: text obliquing, text control codes and special characters, curve fitting, and 3D rendering.
- DXF files must be converted to .wpg files with the graphcnv program.

EPS (Encapsulated PostScript) *
- An EPS file should conform to version 2.0 of the Adobe PostScript document structuring conventions.
- EPS files begin with the standard 30 byte header or the following string: “%!PS-Adobe” or “%!PS-Adobe” or “%!PS!Adobe-2.0”. The string indicates a PostScript-only file.
- The Show Page, Copy Page, and Erase Page commands are redefined to be null commands since page handling is controlled by Corel WordPerfect.
- The EPS file may have a graphics screen representation that can be manipulated and displayed in Corel WordPerfect. If contained within the file, only TIFF bitmap images are supported. The TIFF representation also can print the graphic with a non-PostScript printer.
- If no graphics screen representation is available, the image will be represented as a box with the message “Graphics Contains Data for PostScript Printers Only” in the Graphics Editing and View Document screens. The image can only be printed with a PostScript printer.

GEM (GEM Draw Format) *
- Rounded boxes are not supported. They are converted as regular boxes.

HPGL (Hewlett-Packard Graphics Language Plotter File) *
- Several graphics programs can create HPGL plotter files by redirecting the output to a disk file rather than directly to the plotter. If given the choice, select the HP 7475A plotter.
- Fonts are all converted to Monospaced WP Helv.
- Not all plotters support the same HPGL commands. The most commonly used commands, however, are supported.

IMG (GEM Paint Format) *
- Tested with version 2.0.

MSP (Microsoft Windows Paint Format) *
- The images are saved as a full page.

PCX (Zsoft PC Paintbrush Format) *
- PC Paintbrush files are created using the Save As option.

PIC (Lotus 1-2-3 PIC Format) *
- Once a graph is created in Lotus 1-2-3, a .PIC file can be saved with the /GS command.
PNTG (Macintosh Paint Format)*
- The MacPaint version used to create the image must be prior to version 2.0.
- Pictures are always transferred as a full 8 1/2" x 11" page. Images conforming to the size of the Macintosh screen are reproduced in the upper left corner of the page.

PPIC (PC Paint Plus Format)*
- Packed picture file format is supported (PC Paint Plus 2.0 and PC Paint 1.5).
- Unpacked picture file format is supported (PC Paint 1.5).
- BSAVE format is not supported (PC Paint 1.0 or 1.01).

Sun Rasterfile*
- This is a bitmap format used by SUN in some applications.
- A depth of 8 or 1 can be converted.
- A depth of 24 cannot be converted.

TIFF (Tagged Image File Format)*
- Modified CCITT/3 (standard compression) and PackBits compression formats are supported.
- TIFF format 4.2 is supported. Version 5.0 color format is not.
- Monochrome TIFF for mat and either 16 or 256 level grayscale TIFF images are supported.
- Six-bit-per-sample images are not supported.

WPG (WordPerfect Graphics Format)*
- This is the internal graphics format.

X.11 Bitmap Standard*
- Used for X.11 bitmaps.

xwd*
- Stores window images in a specially formatted window dump file. This file can then be read by other X utilities for redisplay, printing, editing, formatting, archiving, and image processing.

See Also: Graphics, Conversion Program; Graphics, Create; Graphics, Define a Box; Graphics, Edit.

**Graphics Lines**

You can use Graphics Lines to place horizontal and vertical lines in your document. The lines can be black or shaded.
1 Press Graphics, then select Line (5).
   Or □ Select Line from the Graphics menu.
2 Select Create Horizontal Line (1) or Create Vertical Line (2).
3 Select an option, then enter any desired information (see Horizontal Lines and Vertical Lines below).
4 Press Exit to return to the document.

Notes

Codes
Graphics Lines inserts a code (HL:horizontal position, vertical position, length of line, width of line, gray shading) for a horizontal line in your document that puts a horizontal or vertical line at the position specified in the horizontal and vertical position fields.

Editing a Line
You can edit a graphics line by selecting Edit Horizontal Line (3) or Edit Vertical Line (4) in step 2 above. Corel WordPerfect searches backward from the cursor for the first graphics line of that particular type (horizontal or vertical). If it cannot find one, it returns to the cursor position, then searches forward before displaying the Graphics Line definition. You can edit the definition as necessary.

Horizontal Lines
Although the options on the Horizontal Line menu match those on the Vertical Line menu, some options work differently.

Gray Shading • This option (5) lets you determine how much a line should be shaded (100% is black).

Horizontal Position • This option (1) lets you position the line against the Left (1) or Right (2) margin, Center (3) it between the left and right margins, or start at a Set Position (5) from the left edge of the page.

A Golden Years Weekly
September 23 1991
50¢

Fitness for the 90s
Alert: Retirement may be hazardous to your health. A recent study conducted by the Institute of Health and Wellness shows that older adults who engage in an exercise program during their 60s and 70s fare better in their 80s. This is significant because more and more older adults are living to see their 85th and 86th birthdays. By 1995, 10 percent of all Americans will be over 65.

is not only fun, but also safe. In order to avoid injury, the older adult should choose a low-impact activity. For many, the answer is the bicycle. One of the most accessible forms of exercise, a bicycle can be ridden in all kinds of weather and at any time of the day. A 20- minute to 30-minute ride three times a week is a sufficient cardiovascular workout. This can either

stroking. Water aerobics can be learned quickly and easily, and there hasn’t been one reported drowning since its inception in 1977.

Second to water aerobics is the backstroke stroke. This allows the head to remain above water so that breathing is not restricted.

The primary drawback to swimming is pool availability. Most spas offer swimming facilities.
You can also select Full (4) to have the line fill the area from the left to the right margin.

The lines are positioned against the margins in effect at the time. For example, if you press ▶Indent before creating a horizontal line, then select Left as the horizontal position, the line will be positioned against the temporary margin.

**Length of Line** • This option (3) lets you specify the length of a horizontal line.

For lines that have a horizontal position of Left or Right, the default line length is calculated from the cursor to the specified margin. If a line has a horizontal position of Full, you cannot change the line length. If a line has a horizontal position of Center, the default line length is 0", and you must enter a line length.

**Line Height** • If you place a horizontal line in your document (with the vertical position set to Baseline), and the Horizontal Line code [HLine] is the only thing on the line (no other text or codes), the height of that line is determined by the width of the horizontal line. However, if there is any text (even a space) on the same line as the Horizontal Line code, the line height is determined by the font and point size being used.

**Vertical Position** • Select Baseline (1) to align the bottom of the graphics line with the baseline of the line of text that contains the Graphics Line code [HLine]. Select Set Position (2) to specify a distance from the top of the form for the horizontal line.

**Width of Line** • This option (4) lets you specify how thick (wide) the line should be. As you make the line wider, the top of the line stays in the same position and the line expands down if the vertical position is set to Set Position. If the vertical position is set to Baseline, the bottom of the line stays in the same position and the line expands up.

**Vertical Lines**
Although the options on the Vertical Line menu match those on the Horizontal Line menu, some options work differently.

**Gray Shading** • This option (5) lets you determine how much a line should be shaded (100% is black).

**Horizontal Position** • This option (1) displays a menu that lets you position the line to the Left (1) of the left margin or to the Right (2) of the right
margin. You can also select Between Columns (3) and enter a column number to position the line between that column and the one to its right.

Set Position (4) lets you enter a specific horizontal offset from the left edge of the form for the vertical line.

Length of Line • This option (3) lets you specify how long you want a vertical line to be.

For lines with a vertical position of Top or Bottom, the default line length is calculated from the cursor to the specified margin. If a line has a vertical position of Full Page, you cannot change the line length. If a line has a vertical position of Center, the default line length is the distance between the top and bottom margins.

Vertical Position • This option (2) displays a menu that lets you position the line against the Top (2) or Bottom (4) margin, Center (3) it between the top and bottom margins, or start a Set Position (5) from the top of the form.

Select Full Page (1) to have the line extend from the top to the bottom margin.

Width of Line • This option (4) lets you specify how thick (wide) the line should be. As you make the line wider, it will always expand to the right, regardless of the Horizontal Position.

See Also: Graphics, Create; Graphics Options

---

Graphics Options

The Graphics Options screen lets you make changes to settings such as caption style, border style, or gray shading for a box.
1 Move the cursor to where you want to change the option.

Important: Make sure you place the cursor before the graphics box codes you want affected by the option change.

2 Press Graphics, then select the type of box options you want to change.

Or Select the type of box you want to change (Figure, Table Box, Text Box, User Box, or Equation) from the Graphics menu.

3 Select Options (4).

4 Select an option, then make the necessary changes (see the information for each option under Notes below).

5 Press Exit to return to the document.

Notes

Border Style
This option (1) lists the border styles you can use for each box border. Select an option for each border, or use the default settings.

To make specific settings for each type of border you create (Single, Thick), select Format, Other, and Border Options. This menu determines the appearance of the border type you select.

You can use this option to give the border of your box a 3-dimensional effect. As you select an option for each border, select Thick (6) or Extra Thick (7) for two adjacent borders and select Single (2) for the other two adjacent borders.

Caption Number Style
This option (6) lets you use text and some codes to define a style for caption numbers. The caption numbering style is printed or displayed when Corel WordPerfect encounters a numbering code [Box Num] in a caption. Enter 1 in the style where you want the first level caption number. Enter 2 in the style
where you want the second level caption number (see Level Numbering Methods below).

The numbering method for a specific level must be turned on before it will appear in the caption, even if you have entered it in the caption number style.

For example, entering “Fig. 1-2” causes numbering codes in captions to display “Fig. ”, followed by the first level box number, a dash, and the second level box number. You can include Bold, Italics, Underline, Small Caps, or text in the caption style (see Attributes).

Second Level Numbering will number boxes to 31. After that, the first level moves up one number and the second level starts over (1-31 is followed by 2-1).

Codes
A code ([Fig Opt] for a Figure box) is inserted into the document when you use this feature. Any options you change for the box type are changed from the code forward in the document.

You cannot edit a graphics options code. To change the options again, insert a new code, then delete the old code.

Font
Graphics box text and captions are printed in the font that is the base font where the option code is located. If there is no option code, text and captions are printed in the initial base font for the document.

Gray Shading
Select this option (9) to enter a shading intensity (by percentage) for graphics boxes. The closer the percentage is to 100, the more the box is shaded (100% means the box is black).

Initial Settings
The initial settings for this menu vary according to the type of box (Text Box options have different settings than Figure Box options). When you have changed the settings, you can delete the code to return to the initial settings.

You can change the initial settings using Initial Codes in Setup (see Initial Settings). These settings will be in effect each time you create a document.

Inside Border Space
These measurements determine the amount of space between each border of your box and the information inside the box. Select this option (3), then enter a setting for each border or press Return to leave a setting as it is and continue on to the next border setting.

Level Numbering Methods
There are two level numbering methods listed on this menu: First (4) and Second (5). These methods let you define up to two levels of numbering for captions. Select an option, then select a numbering style from the menu displayed.

You cannot select Off for the first level. To turn off first level numbering, exclude a 1 in the caption numbering style (see Caption Number Style above).
Letters or Roman numerals are shown in uppercase when used for first level numbering and lowercase when used for second level numbering. For example, if you are writing a book with several illustrations in each chapter, and your second level numbering method is Letters, the illustrations could be numbered 1.a, 1.b, or 1.c for chapter 1; 2.a, 2.b, 2.c, for chapter 2, and so on.

**Minimum Offset from Paragraph**

When you position a paragraph-type graphics box a specific distance (offset) from the top of the current paragraph (see *Graphics, Define a Box*), the offset you specify is honored unless the paragraph is too close to the bottom edge of the page for the box to fit. If this is the case, the offset measurement is reduced to try to keep the text and box together on the same page. If the offset cannot be reduced to fit the box on the page, the box is bumped to the top of the next page (or column).

The Minimum Offset option (8) specifies how far the box can move up into the paragraph when Corel WordPerfect needs to reduce the offset measurement. For example, if you enter 1" for this option, graphics boxes can move up to 1" from the top of the paragraph before being bumped to the next page.

To use the offset measurement regardless of how close the text is to the bottom of the page, set the minimum offset to a large value (11" on an 11" long page).

**Outside Border Space**

These measurements determine the amount of space between each border of the box and the text outside the box. Select this option (2), then enter a setting for each border or press Return to leave a setting as it is and continue on to the next border setting.

If the box is aligned with any setting (left margin, right margin), the outside border space on that side of the box is ignored.

**Position of Caption**

This option (7) lets you set the position of the caption Below (1) or Above (2) the box, and Outside (1) or Inside (2) the border.

For Equation boxes, this option lets you position the caption Below (1) or Above (2) the equation, or on the Left (3) or Right (4) side of the equation. All these options are inside the Equation box.

If you select Left or Right and the equation is too wide for the caption to fit inside the box, the caption will be placed below the equation.

**See Also:** *Graphics, Create; Graphics, Define a Box; Graphics, Edit*

---

**Graphics Screen Type**

Before you can display graphics in the Figure Edit or View Document screen, you must select a Graphics Screen Type. When you select a type, it is saved in the .wp7c.set file.

---

*Graphics Screen Type* 193
To select a Graphics Screen Type,

1 Press Setup.

   Or □ Select Setup from the File menu.

2 Select Display (1), then select Graphics Screen Type (2).

3 Move the cursor to the graphics screen type you have, then choose Select (1).

   If you do not know your terminal type, contact your system administrator.

4 Press Exit to return to the normal editing screen.

---

**Notes**

**Screen Types**

Several screen types are listed below which will be in one of the following categories.

- **High Resolution Graphics** • When you select a Graphics Screen Type for your graphics terminal, Corel WordPerfect uses the full capabilities of your terminal’s color or monochrome graphics. Examples of selections include vga, visual1603_sixel, hds3200_tek, or kermit30_ega.

- **Mosaic** • If you have a non-graphics terminal which supports downloadable soft character fonts, Corel WordPerfect uses this feature to display a mosaic-like representation of graphics in the figure Edit and Print Preview screens. Even if you have a graphics terminal, you can select mosaic to view a graphic more quickly (and use less memory) than real graphics. Examples of selections include vt220_mosaic, or wyse60_mosaic.

- **Line Draw** • Linedraw characters are available on most non-graphics terminals which do not support downloadable soft character fonts. Choose this option when only a rough view of the graphics is needed for alignment, or other options are not available.

- **Text** • If your terminal does not support graphics, or if no other graphics driver is available, choose Text characters to give a visual representation of what is on the screen. Selecting Text switches View Document from a graphical representation to a text-oriented one.

- **Multiple Terminals**

  If you use different terminals which have the same WPTERM, but require different Graphics Screen Types, set the WPGRAPHICS environment variable to the name of the Graphics Screen Type you need to run Corel WordPerfect. This lets you switch screen types easily, and only requires that you enter Setup when you want the current Graphics Screen Type saved in the .wp7c.set file.

  If you do not see a selection for your graphics terminal, contact your system administrator.
**Function/Arrow Key Substitutes** • If your terminal’s function keys or arrow keys do not work while in graphics mode, you may have to use the following substitute keys in the Figure Edit and View Document screens.

<table>
<thead>
<tr>
<th>Key</th>
<th>Equivalent</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cancel</td>
<td>c</td>
</tr>
<tr>
<td>Exit</td>
<td>x or 0 (zero)</td>
</tr>
<tr>
<td>Home</td>
<td>h</td>
</tr>
<tr>
<td>Page Up</td>
<td>U</td>
</tr>
<tr>
<td>Page Down</td>
<td>D</td>
</tr>
<tr>
<td>Switch</td>
<td>i</td>
</tr>
<tr>
<td>Go To</td>
<td>g</td>
</tr>
<tr>
<td>Shell</td>
<td>e (Figure Edit screen only)</td>
</tr>
<tr>
<td>Insert</td>
<td>n</td>
</tr>
<tr>
<td>Save</td>
<td>a</td>
</tr>
<tr>
<td>End</td>
<td>e (Print Preview screen only)</td>
</tr>
<tr>
<td>Up Arrow</td>
<td>u</td>
</tr>
<tr>
<td>Down Arrow</td>
<td>d</td>
</tr>
<tr>
<td>Right Arrow</td>
<td>t</td>
</tr>
<tr>
<td>Left Arrow</td>
<td>l</td>
</tr>
</tbody>
</table>

**See Also:** Display Setup; Text Screen Size
A hard space holds the words on each side of it together on one line.

For example, you can use a hard space to keep dates or names from being split by a soft return.

To insert a hard space,

1. Press **Hard Space** (Home, Space Bar).

**Notes**

**Codes**

The Hard Space code is `[ ]`.

**Hyphenation**

Words joined by hard spaces are considered one word. When Hyphenation is on, you may be asked if you want to hyphenate the combined words. Press **Cancel** to wrap the combined words to the next line.

---

**Headers and Footers**

You can create headers and footers to place text on the top or bottom of every page of a document. For example, you might want to put a chapter title, a date, or the company name at the top of each page, or on certain pages.

1. Move the cursor to the top of the first page on which you want the header or footer.

2. Press **Format**, then select **Page** (2).

   Or **Select Page from the Layout menu**.

3. Select **Headers** (3) or **Footers** (4).

---

**New Employees**

- Paul Litchfield
- Rebecka Crowley (HR)
- Renae Steiner (Pub)
- Richard Knudsen (Acc)
- George LeRois (Rec)

**Meeting Change**

There will be no meeting this Friday because too many people will be out of the office, so we will have it next Tuesday, the 16th of June. Please plan to attend. We will be making some changes in location of management and accounting. We will also need your input on some new ideas that have been suggested for more efficient handling of mail distribution.

**Important Dates**

- 3 July Managers Conf.
- 8 July New Emp. Mtg.
- 12 July Company Party
- 23 July End-user Conf.
- 17 Aug. Acc. Training
- 23 Aug. Summer Social
4 Select a (1) or b (2) to create the first or second header or footer (see Number of Headers/Footers Allowed below).

5 Select Every Page (2), Odd Pages (3), or Even Pages (4) (see Placement Options below).

6 Type the text of the header or footer (see Entering Header and Footer Text below).

7 Press Exit twice to return to your document.

---

**Notes**

**Codes**
The header or footer code is \{header/footer letter;location;text\} where header/footer letter is the letter of that header or footer (Header A or Footer A), location is the placement of that header or footer (every page or odd pages), and text is the text of the header or footer, up to the first fifty characters. If a header or footer contains more than fifty characters, three dots appear at the end of the header or footer text.

**Entering a Header or Footer Only Once**
Header and Footer codes only affect the text in your document from the page where they are inserted forward.

You can place headers or footers at the beginning of your document, then use Page Format: Suppress to keep them from appearing on specific pages. For example, when the first page of your document is a title page, you can place the header or footer code at the beginning of page 1 and then suppress it on page 1 so it does not appear until page 2.

**Entering Header and Footer Text**
In step 6 above, enter text as you normally would, using editing features (Bold, Underline, Center, Tab, Flush Right). Use Move, Block, or Cancel to move, delete, or restore text within the header or footer. You can also use Speller, Thesaurus, and the Date feature. If you do not want to use the current margin settings of your document, you can use Line Format to set new left and right margins for your header or footer.

Unless a Base Font code exists in the header or footer, it is printed in the font that is the base font at the point where the Header or Footer code is located (see Codes above and Font).

Press Exit twice when to exit a header or footer. Pressing Return will only add an extra line of space to the header or footer.

**Editing an Existing Header or Footer**
To edit an existing header or footer, place the cursor immediately after the header or footer you want to edit, then,

1 Press Format.

2 Select Page (2).

3 Select Headers (3) or Footers (4).
4 Select A or B, then select Edit (5). Corel WordPerfect searches backward then forward.

5 Make changes, then press Exit twice.

If you have different headers and footers in a document, you can search for a specific one by pressing a Search key and then pressing the Format keystrokes necessary to insert that Header or Footer code into a search string.

Where you edit an existing header or footer affects the header or footer. For example, if you want Header A to be in a specific format on pages 1 through 5 of your document, then change the format beginning on page 5, you cannot edit Header A on page 5. You must discontinue the current header, then redefine a new Header A on that page (see Number of Headers/Footers Allowed below).

**Number of Headers/Footers Allowed**
You can add two headers or footers to each page.

**Page Numbers**
You can include page numbering within the text of a header or footer by inserting a ^B code into the text.

If you use the Page Numbering feature (rather than including the number in your header or footer) and the Headers and Footers features in the same document, the header or footer and page number may overlap. To avoid this, insert an extra blank line at the top of the header when you use Page Numbering at the top of the same document. Insert an extra blank line at the end of a footer to leave space for Page Numbering when you use Page Numbering at the bottom of the same document. If you use a single line header or footer with Page Numbering, you can also avoid overlapping by leaving blank space in the header or footer where the page number will print.

**Placement Options**
When you create a header or footer, you can place it on every page, odd pages, or even pages. You can also discontinue existing headers and footers.

The header or footer appears on the pages you select, and blank space (usually .33") is inserted between the header or footer and the existing text on the page. The header or footer is considered part of the text and not part of the top or bottom margin of a page. A header or footer is never printed in the top or bottom margin. If you use headers and footers, and need more space on a page, use Margins, Top and Bottom in Page Format to change your top and bottom margins.

If you use two headers or footers on the same page, be sure that one is flush right or printed on a different line. Otherwise, one may print on top of the other.

**Turning Off a Header or Footer**
You can print a header or footer on several pages, then discontinue it at a specific point in your document.
To discontinue an existing header or footer,

1. Press **Format**.

2. Select Page (2).

3. Select Headers (3) or Footers (4), select A or B.

4. Select Discontinue (1).

You can also use Suppress on the Page Format menu to suppress a header or footer on specific pages.

**See Also:** Suppress Page Format

---

**Help/Keystrokes**

Help lets you learn more about Corel WordPerfect without referring to the manual. You can use Help to find out what keystrokes to use for a specific feature. Use Help to display any of the following:

- An alphabetical listing of features and their keystrokes.
- Descriptions of features and menu options.
- Information about the current feature you are using.
- A template listing the keystrokes and names of the function keys.

1. Press **Help**.

   *Or*  
   Select **Help**.

   The type of information displayed depends on your current task.

2. Press **Return** or the **Space Bar** to return to the previous screen or menu.

---

**Notes**

**Alternate Keyboard**

The Alternate Keyboard option lets you assign Help to F1. For more information, see **Alternate Keyboard** under **Environment Setup**.

**Help When You Want It**

When you are using a certain feature, you can press **Help** to learn more about it.

For example, if you press **Format** and display the Format menu on-screen, but are not certain which option you need to select, you can press **Help** to see descriptions of available options.

Some of the help screens look the same as the menus they describe. To make sure you are in a help screen, look for the “Press ENTER to Exit Help” prompt which appears at the lower right corner of the status line on every help screen.
Help File
The information necessary to display Help is in wphlp.us. If Help is not currently available, run the Installation Program and answer Yes when asked if you want to install Help.

Normal Editing Screen
Pressing Help from the normal editing screen displays the main Help menu.

If you are using Corel WordPerfect on a network, your three-letter file ID will also appear in the upper right corner of the menu.

The text on the main Help menu tells you how to use the Help feature.

When you use Help, you can display alphabetical lists of features or on-screen help about specific features.

If you do not know the keystrokes for the feature you want to learn, you can press any letter of the alphabet to display a list of features that start with that letter. Each list includes features by keystroke, feature name, and keystroke name. You can press a keystroke to learn more about any feature on the list.

For example, to learn how to make letters uppercase or lowercase when you do not know what the feature is called, type u for Uppercase from the main Help menu. The list of features displayed shows you that the Uppercase/Lowercase feature is called Switch. Press Switch to display information on how to switch existing text from uppercase to lowercase.

For more keystroke information, press the keystrokes. For example, when using Help, press Bold to learn about Bold, Setup to learn about Setup, or Right Arrow to learn about cursor movement.

You can also display an on-screen template by pressing Help again in any Help screen. From the on-screen template, press a feature keystroke to learn more about the feature.

See Also: Getting Started
Hyphenation

Normally, when a word extends beyond the right margin setting, the word is wrapped to the next line on the page. To hyphenate words at the right margin, use Hyphenation. As you type text or scroll through existing text, words will be hyphenated as necessary.

When Hyphenation is on, three things determine when and how to hyphenate: the hyphenation zone, the hyphenation dictionary, and the Hyphenation Prompt option.

To turn on Hyphenation,

1. Move the cursor to where you want to start hyphenation.
2. Press **Format**, then select **Line** (1).
   
   *Or Select Line from the Layout menu.*
3. Select **Hyphenation** (1).
4. Type **y** to turn on Hyphenation.
5. Press **Exit** to return to the normal editing screen.

If Hyphenation is on and you want to turn it off, follow the steps above, but type **n** in step 4.

Notes

Canceling Hyphenation

To cancel hyphenation for a word that is already hyphenated, move to the first letter of the word, press **Home**, type a slash (/), then move to the hyphen and delete it. To cancel hyphenation for a word that is displayed at the “Position Hyphen; Press ESC” prompt, press **Cancel**.

When you cancel hyphenation for a word, the word wraps to the next line.

Hyphenation Alternatives

There are characters you can type from the keyboard and codes Corel WordPerfect can enter in a document to handle long words, or words you want to keep together. These characters and codes are discussed below.

A **Hyphen Character** is the character that is placed in your document when you type a dash (–). Displayed and printed as a dash, the Hyphen Character determines where a word is hyphenated when the word needs to be hyphenated (even if Hyphenation is off). If the word is hyphenated at a Hyphen Character, it does not add a Soft Hyphen.

A **Hard Hyphen** is the character that is placed in your document when you press **Home**, then type a dash. Displayed and printed as a dash, the Hard Hyphen tells Corel WordPerfect that a word should be treated as one word and should not necessarily be hyphenated at the dash. Corel WordPerfect will follow regular hyphenation procedure (checking the dictionary, prompting for assistance if appropriate) if it needs to hyphenate the word.
A *Soft Hyphen* is a code (–) that is placed in your document when Corel WordPerfect hyphenates a word or when you hold down **Control**, then type a dash. This tells Corel WordPerfect where a word should be hyphenated when it needs to be hyphenated. If the word does not need to be hyphenated, the Soft Hyphen code remains in the document but has no effect.

An *Invisible Soft Return* is a code [ISRt] placed in your document when you press **Home**, **Home**, then press **Return**. It tells Corel WordPerfect where a word should be broken when it needs to be hyphenated. It is useful for words separated by en dashes, em dashes, and slashes (Colors/[ISRt]Fonts/[ISRt]Attributes). If the word does not need to be hyphenated, the Invisible Soft Return remains in the document but has no effect.

A *Deletable Soft Return* is a code [DSRt] inserted by Corel WordPerfect when it needs to break a word that extends from left margin to right margin. The Deletable Soft Return is deleted and the word it divides is pulled together when the code is not at the end of a line or page.

**Hyphenation Dictionary**

Two hyphenation dictionaries are available. The internal dictionary is built into Corel WordPerfect. The external dictionary is contained in the wplex.us file. It contains more words and more hyphenating alternatives than the internal dictionary, but takes up more disk space. You can select which hyphenation dictionary you want to use.

To select a dictionary, go to the normal editing screen,

1. Press **Setup**.
2. Select **Environment** (2).
3. Select **Hyphenation** (5).
4. Select **External Dictionary/Rules** (1) for the external dictionary or **Internal Rules** (2) for the internal dictionary.
5. Press **Exit** to return to the normal editing screen.

When you select Hyphenation, the setting is stored in .wp8c.set.

**Important:** If you select External Dictionary/Rules, wplex.us must be installed in the thesaurus/spell/hyphenation directory. These files are installed when the Speller is installed. If the Speller is not installed, contact your system administrator.

For more information see *Location of Files*.

To add words to or change the hyphenation criteria for words in the External Dictionary, use the Speller Utility.

**Hyphenation Prompt**

There are three Hyphenation Prompt options: Never, When Required, and Always.
Go to the editing screen,

1. Press **Setup**.

2. Select **Environment (2)**.

3. Select **Prompt for Hyphenation (6)**.

4. Select an option from the bottom of the screen, then press **Exit** to return to the normal editing screen.

Never (1) will hyphenate the word according to the instructions in the hyphenation dictionary you chose (see *Hyphenation Dictionary* above). If the word does not exist in the dictionary, the entire word is wrapped to the next line.

When Required (2) will hyphenate the word according to the instructions in the hyphenation dictionary you selected (see *Hyphenation Dictionary* above). If the word does not exist in the dictionary, a “Position Hyphen; Press ESC” message appears (see *Position Hyphen; Press ESC* below).

Always (3) will stop at each word that needs to be hyphenated, then display the “Position Hyphen; Press ESC” message (see *Position Hyphen; Press ESC* below).

This setting is stored in the .wp8c.set file and is in effect each time you start Corel WordPerfect.

**Hyphenation Zone**
The hyphenation zone determines when a word needs to be hyphenated. It establishes a region (zone) across which a word must be located if it is to be hyphenated. If the word is not located in that zone, it is kept intact on the current line of text or wrapped to the next line.

If you want more or less hyphenation in your document, you can change the size of the hyphenation zone (see *Hyphenation Zone*).

**Language**
There are hyphenation/speller dictionaries in different languages. When Hyphenation is on and you are using the External Dictionary, Corel WordPerfect searches for the dictionary that matches the current language code (see *Language*).

**Position Hyphen; Press ESC**
When this prompt appears on the status line, use Left or Right Arrow to position the hyphen, then press **Escape** to insert the hyphen into your document.

If you cannot move the hyphen as far as you want, it is because the cursor must be located between the first letter of the word and the right hyphenation zone setting (see *Hyphenation Zone* above).

If you press **Cancel**, the entire word wraps to the next line. The space before the word is changed to a soft return and a Cancel Hyphenation code [/] is inserted in front of the word.
You can select a beep to accompany the “Position Hyphen; Press ESC” message (see Beep Options).

**Turning Off Hyphenation**
To turn off Hyphenation, see the steps at the beginning of this section. To turn off Hyphenation temporarily during spell-checking or any scrolling command (Home,Home,Down Arrow), press **Exit** at the first “Position Hyphen; Press ESC” prompt.

## Hyphenation Zone

The Hyphenation Zone specifies which words need to be hyphenated. Increasing the size of the zone decreases the number of words that need to be hyphenated, while decreasing the size of the zone increases the number of words that need to be hyphenated.

There is a left and a right hyphenation zone setting. If Hyphenation is on and a word starts before the left hyphenation zone setting and extends past the right hyphenation zone setting, the word needs to be hyphenated. If the hyphenation zone is small, more words will meet these criteria.

The hyphenation zone uses a percentage measurement. The percentage is a percentage of the line length. For example, if a line is 6.5" long and the hyphenation zone is 10% and 4%, the left hyphenation zone setting is .65" (.10 x 6.5 = .65") to the left of the right margin, and the right hyphenation zone is .26" (.04 x 6.5 = .26) to the right of the right margin.

The hyphenation zone is a percentage measurement instead of an absolute value, because it allows the size of the hyphenation zone to change with the line length. This is useful in columns where the line length of a column may be smaller than the non-column line length.

To set the hyphenation zone,

1. Move the cursor to the line in the document where you want to change the hyphenation zone.
2 Press **Format**, then select **Line** (1).  
   *Or* **Select Line** from the Layout menu.

3 Select **Hyphenation Zone** (2).

4 Enter the left hyphenation zone setting.

5 Enter the right hyphenation zone setting.

6 Press **Exit** to return to the document.

---

### Notes

**Hyphen Position**

When Hyphenation is on and a word falls in the hyphenation zone, Corel WordPerfect searches the specified hyphenation dictionary to see where the hyphen should be placed.

If Corel WordPerfect finds an appropriate location in the hyphenation zone, it positions the hyphen there. If not, Corel WordPerfect checks to the left of the hyphenation zone, and if it finds an appropriate location there, it positions the hyphen. If Corel WordPerfect cannot find an appropriate location, it positions the hyphen at the right margin.

Whether you are prompted for hyphenation assistance depends on the setting for the Prompt for Hyphenation option. If Prompt for Hyphenation is set to Never and Corel WordPerfect cannot find an appropriate hyphenation location, it wraps the entire word to the next line. For information on the Prompt for Hyphenation option, see **Hyphenation Prompt** under **Hyphenation**.

When the “Position Hyphen; Press ESC” is displayed on the status line with the word to be hyphenated, use the Left and Right Arrow keys to move the hyphen anywhere between the first two letters of the word to before the letter that is located at the right hyphenation zone. The hyphenation zone must contain at least two characters to allow you some flexibility in hyphenation.

**Hyphenation and Full Justification**

Like hyphenation, full justification lets you make lines of text more even at the right margin.
Use Indent to indent a paragraph without changing the margins. **Indent** sets up a temporary left margin at the next tab setting. The text you type is indented to that tab stop until you press **Return**.

There are three indentation keystrokes:

- Indent all the lines in a paragraph from the left margin (left indent).
- Indent all the lines in a paragraph from both margins (double indent).
- Keep the first line in a paragraph flush with the left margin while indenting the remaining lines (hanging indent).

<table>
<thead>
<tr>
<th>Left indent</th>
<th>Double indent</th>
<th>Hanging indent</th>
</tr>
</thead>
<tbody>
<tr>
<td>The <em>Indent</em> feature indents an entire paragraph one tab stop from the left margin. Simply press <em>Indent</em> and start typing. Notice that every line is indented from the left margin. When you are finished with the paragraph, press <strong>Return</strong> and you are returned to the left margin.</td>
<td>The <em>Indent</em> feature indents an entire paragraph one tab stop from the left margin and an equal distance from the right margin. Press <em>Indent</em> and start typing. Notice that every line is indented one tab stop from the left margin and an equal distance from the right margin. When you are finished with the paragraph, press <strong>Return</strong> and you are returned to the left margin.</td>
<td>You can create a hanging indent by pressing <em>Indent</em>, then pressing <em>Margin Release</em>. The first line in the paragraph starts at the left margin while the rest of the lines are indented.</td>
</tr>
</tbody>
</table>

To indent text,

1. Press the appropriate indentation keystroke (see **Indentation Keystrokes** below).

   * Or □ Select **Align** from the **Layout** menu, then select the indentation you want.

2. Type the text you want indented.

3. Press **Return** to end the indentation and return the cursor to the left margin.

<table>
<thead>
<tr>
<th>Notes</th>
<th>Indentation Keystrokes</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Indentation</strong></td>
<td><strong>Keystroke</strong></td>
</tr>
<tr>
<td><em>Left</em>-Left side of paragraph only, at the next tab stop.</td>
<td><em>Indent</em></td>
</tr>
</tbody>
</table>

206  **Indent**
Indentation

**Double** - Both sides of a paragraph, an equal distance from the left and right margins. (The left side is indented at the next tab stop. The right side is indented an equal distance in from the right margin).

**Hanging Indent** - First line of the paragraph remains at the left margin. Remaining lines are indented at the next tab stop.

Keystroke

- Indent
- Margin Release

Tab Stops

The indentations inserted in your document are based on the existing tab stops. You can change the distances that text is indented by changing the tab settings (see Tab). You can also press an indentation key more than once to indent text more than one tab stop.

Index

You can generate an index for your document. Headings and subheadings are options in Index, and you can choose one of five numbering styles.

To create an index,

- Select the words or phrases you want included in the index by marking them in the document or by creating a concordance file.
- Define the location and numbering style for the index.
- Generate the index.
Each step is exclusive of the other steps. For example, you can mark text as you write, define the index while formatting the document, and generate the index before your final edit. Later, you can edit the marked text or the index definition, and regenerate the index.

The instructions for the three steps are divided into separate sections in Reference. See Index, Concordance and Mark Text, see Index, Define, and Generate.

Notes

Master Documents

If your document is long, you can divide it into smaller pieces with Master Document. You can then generate one index for the master document and all subdocuments (see Master Documents).

See Also: Generate; Index, Concordance and Mark Text; Index, Define

Index, Concordance, and Mark Text

The first step in creating an index is to decide the words and phrases you want to include. When the index is generated, the words and phrases (entries) become the headings and subheadings of the index.

![Index Table]

There are two ways to select entries for an index:

- Create a concordance file.
- Manually mark entries throughout the document.

You create a concordance file by listing each index entry in a file (see Concordance below). When you use a concordance file, each occurrence of an entry and the page numbers are inserted in the index. You manually mark entries by searching through the document and marking each occurrence you
want in the index (see Mark Text below). When you mark entries in the document, the index page numbers are generated for only those entries you marked.

A concordance file saves you the time of manually searching for entries in the document. However, marking text within the document lets you select existing phrases instead of having to compose a master list of index entries. Also, when you use a concordance file, Corel WordPerfect only searches for exact matches. For example, if “Bird” is an entry in the concordance file, an occurrence of “Birds” in the document will not be included in the index.

You can use both options at the same time, marking some entries within the document and using a concordance file for others. Corel WordPerfect generates the index using entries from the concordance file and the text marked in the document.

Once you select the index entries, you must then define the index location and numbering style. See Index, Define.

### Notes

**Concordance**

To create a concordance file,

1. Start with a blank document screen.
2. Type an entry for the index and press Return. Repeat this step for each entry you want to include.
3. Save the document.

Below is a sample concordance file.

You can edit the list and resave the file as needed.

When you define the index (see Index, Define), you are asked for the name of the concordance file. When you generate the index (see Generate), each occurrence of the entries in the concordance file and their page numbers are inserted in the index.
The length of each entry in the concordance file is unlimited, but you must end
it with a hard return [HRt]. If the line automatically wraps, this inserts a soft
return [SRt], not a hard return [HRt].

An index will generate faster if you sort the entries in the concordance file
alphabetically before using it (see Sort). Sorting a concordance file is easiest if
each entry is only one line long.

Each concordance entry is a heading in the index. If you want an entry in the
concordance file to be a subheading in the index, mark it in the concordance file
using steps 1 through 4 under the Mark Text heading below. If you want a
concordance entry to be a heading and subheading, mark it once as a heading,
and once as a subheading (see Mark Text below).

The index heading has a size limit of 76 characters.

**Mark Text**

To mark text to appear in an index,

1. Move the cursor to the word you want in the index, or if it is more than one
   word, block the phrase.

2. Press **Mark Text**, and select Index (3).
   
   Or  □ **Select Index from the Mark menu.**

3. Press **Return** to use the displayed text as an index heading.

   or

   Enter your own text for the heading.

4. Press **Return** to use the displayed text (if any) for the subheading.

   or

   Enter your own text for the subheading.

You can also press **Cancel** in step 4 if you do not want a subheading.

The text you selected in step 1 appears as the index heading in step 3. If you do
not use the displayed text as the heading, it appears as the subheading in step 4.
If you use the displayed text as a heading, no text appears for the subheading.

Mark all the entries you want in the index. If you want an entry to be a heading
and a subheading, you must mark it once as a heading and once as a subheading.

If you have phrases that occur frequently in the document, you can include them
in a concordance file (see Concordance above). You can mark entries in a
concordance file using steps 1 through 4 above.

When you mark an entry, [Index:heading:subheading] (where *heading* is text of
the heading and *subheading* is the text of the subheading) is inserted in the
Reveal Codes screen next to the word or phrase. If you do not want the entry in
the index, delete the [Index:] code.
**Master Documents**
If you use Master Documents, you can mark index entries in the subdocuments. When you generate the index, the entries are combined into one index. Corel WordPerfect also searches each subdocument for entries you listed in a concordance file (see *Master Documents*).

**See Also:** Generate; Index; Index, Define

---

**Index, Define**

Once you select the entries you want (see *Index, Concordance and Mark Text*), the next step in creating an index is to define the location and numbering style for the index. The following instructions assume you want the index at the end of the document. For details, see [Def Mark:] below.

1. Move the cursor to the end of the document.
2. If you want the index to start on a separate page, press **Hard Page**.
3. If you want a heading (title) for the index, type it now, then press **Return** for extra spacing.
4. Press **Mark Text**, select Define (5), then select Define Index (3).
   
   Or Select Define from the Mark menu, then select Index.
5. Enter the concordance filename (include the full path if it is not in your default directory), if you are using one (see *Index, Concordance and Mark Text*).
   
   or
   
   Press **Return** if you are not using a concordance file.
6. Select a numbering style (see *Numbering Styles* below).

Once you have defined the index numbering style, you are ready to generate the index (see *Generate*).

**Notes**

[Def Mark:] When you select a numbering style while defining an index, [Def Mark:Index,#,filename] (where # represents the numbering style you selected and filename represents the concordance file, if you entered one) is inserted into the Reveal Codes screen at the cursor position. The index is generated at this code. If you marked index entries in a document, they will only be included in the index if they occur before the [Def Mark:] code. All concordance file entries are included in the index, regardless of where [Def Mark:] is located.

If you use Master Documents, place the [Def Mark:] code at the end of the master document, not inside a subdocument (see *Master Documents*).
**Numbering Styles**

Numbering styles refer to the way the page numbers for headings and subheadings are displayed. You can choose from five numbering styles.

To change the type of number used (from Arabic to Roman), use New Page Number. Changing the page number affects both page numbers displayed in the document and those generated in a table, list, or index. See Page Numbering.

---

**Initial Codes**

Use Initial Codes if you want specific documents to always have the same codes. For example, your margins may always be set to 2", you may always have Left Justification off, and you may always have a particular page numbering format.

Initial Codes is an option on both the Setup: Initial Settings menu and the Format: Document menu. The method for entering the codes is the same for both codes. The option on the Setup: Initial Settings menu sets codes for all subsequently created documents, while the option on the Format: Document menu sets codes for the document on the screen. The option on the Format: Document menu overrides the option on the Setup: Initial Settings menu.

For example, if most of your documents have 2" left and right margins, enter the setting in Initial Codes on the Setup: Initial Settings menu. If you have a specific document that has 1" left and right margins, make the setting in Initial Codes on the Format: Document menu. For that document, the left and right margins will be set to 1". For the rest of your documents, the setting will be 2".

To select the Initial Codes option on the Format: Document menu,

1. Press **Format**, then select **Document (3)**.

   *Or*  
   Select Document from the Layout menu.

2. Select Initial Codes (2).
3 Select a feature, then enter the information. When you select a feature, a code is inserted in the bottom half of the screen.

The list of codes you can enter is discussed in Codes below. Do not enter text in an Initial Codes screen.

4 Press Exit to return to the normal editing screen.

When you create a document for the first time, the settings you make on both the Setup: Initial Settings menu and Format: Document menu are saved with the document. From that point on, the only way you can change the initial codes for that document is to change them in Initial Codes on the Format: Document menu with the document on the screen. You must save the document to save any changes with the document.

Codes entered in the document always override initial codes.

Notes

The following codes are allowed in the Initial Codes screen:

- Base Font
- Column Definition
- Column On
- Decimal/Align Character
- Endnote Number
- Endnote Options
- Footnote Number
- Footnote Options
- Graphics Box Number
- Graphics Box Options
- Hyphenation On/Off
- Hyphenation Zone
- Justification
- Kerning
- Language
- Line Height
- Line Numbering
- Line Spacing
You may be able to enter other codes and text, but they will have no effect.

A list of initial settings for these and other codes is shown in Appendix G: Initial Settings.

Existing Documents
A document retrieved into an existing document does not retain its initial codes. It uses the initial codes for the existing document.

To change initial codes for an existing document, retrieve the document to the screen, edit the codes in the Initial Codes option on the Format: Document menu, then save the document.

Initial Codes on the Format: Document Menu
The codes in Initial Codes on the Setup: Initial Settings menu also appear in Initial Codes on the Format: Document menu.

Merge
If you use a primary file and several records from a secondary file to create a mass-mailing, we recommend you include initial codes for the primary file in Initial Codes on the Format: Document menu. If you do not, the codes at the top of the document are repeated each time the primary file is repeated.

If you use merge to create labels, the Paper Size/Type code must be placed in Initial Codes. Only one entry per page of labels prints if it is not placed in Initial Codes. For more information, see Labels.

See Also: Initial Settings; Appendix G

---

Initial Settings

Setup: Initial Settings specifies default settings for features that affect all subsequently created documents.
Several of the options on the Setup: Initial Settings menu are repeated on other keys. The difference is that Initial Settings sets options for all subsequently created documents. These options can be temporarily overridden for a single document with similar options on different keys.

To set an option for all future documents,

1. Press Setup.

Or Select Setup from the File menu.

2. Select Initial Settings (3), then select the option of your choice.

3. Change the settings for the option. The options are discussed under Notes below.

4. Press Exit to return to the normal editing screen.

The settings are stored in the .wp8c.set file. They are also saved with subsequently created documents when you save the documents, and are in effect when you retrieve those documents.

Documents created before you change these settings retain their old settings.

### Notes

#### Date Format

This option lets you change the format for dates that you enter in your documents with the Date feature. A similar feature exists on the Date Format menu. The method for creating a format is the same (see Date).

Settings made with the options on the Date Format menu insert a code in your document and affect the document from the code forward. The code overrides the same settings made with the Date Format option in Initial Settings.

See Language to learn about other ways to change the date format.

#### Equations

This option lets you determine printing and alignment options for equations. It also lets you select a keyboard layout that can be used only when you are in the Equation Editor.

Printing and alignment options made in the Equation Editor itself override settings made with this option, but if you do not make settings in the Equation Editor, the equations use the settings made with this option. Once an equation is created, the only way you can change the printing and alignment options is in the Equation Editor.

To select the equations keyboard,

1. Select the Equations option from the Setup: Initial Settings screen.

2. Select Keyboard for Editing (5).

3. Move the cursor to the keyboard you want to select, then choose Select (1).

4. Press Exit to return to the normal editing screen.
To learn how to create a keyboard layout (remap keys), see Keyboard Layout. For more information about equations or the equation keyboard, see Equations.

Format Retrieved Documents for Default Printer
When a document is saved, the printer selection is saved with the document. If you retrieve a document that was saved for a printer that is not the current printer, Corel WordPerfect needs to know if you want to reformat the document for the currently selected printer, or select the printer with which the document was saved.

Yes re formats the document for the currently selected printer. It can change the way certain fonts and attributes are printed.

No selects the printer for which the document was created. If the printer is not on your list of printers, and the .prs file is not found in the printer directory, a message tells you that the document is not formatted for the currently selected printer, then formats the document for the currently selected printer.

For more information on printer selection and the printing process, see Printing—General Information and Printer, Select.

Initial Codes
This option lets you enter codes that are in effect each time you create a new document. A feature similar to this option is located on the Format: Document menu. The method for entering the codes is the same (see Initial Codes).

You can enter settings such as margins, justification, tab, and paper size/type settings in Initial Codes.

Any settings made on the Format: Document screen override settings made with this option. Any settings made in the document itself override settings made with both options.

Merge
This option determines the field and record delimiters for a UNIX text secondary merge file. When you merge information using a UNIX text file as a secondary file, this option determines how fields and records are divided in the secondary file.

Select Field Delimiters (1) or Record Delimiters (2). Type the characters that determine where fields or records begin, press Down Arrow, and type the characters that determine where fields or records end. You may not have beginning characters, but you should have ending characters. Pressing Return inserts a Line Feed code [LF]. Pressing Ctrl-m inserts a Carriage Return code [CR].

Print Options
These options let you change the appearance of a printed document.

Settings made on the Print menu override settings made with this option, but are only in effect until you exit the current document.

An option that is located on this menu, but not on the Print menu, is the Redline Method. It is also located on the Format: Document menu. The
method for setting it is the same, but the setting on the Format menu overrides the setting on this menu (see Redline/Strikeout).

The other option, Size Attribute Ratios, lets you determine the size ratio of text with certain attributes as a comparison to the current base font. For example, to change Large to be twice as large as normal text, enter 200% next to the Large heading.

The Size Attribute Ratio option does not change your printer's capabilities. The fonts your printer has, or what it can do with those fonts, determines how the Size Attribute Ratio affects your printed text. If you have a printer with numerous fonts that can be scaled to size, the Size Attribute Ratio will have a large effect. If you have a printer with one font or print wheel, the Size Attribute Ratio will have no effect.

If you do not have a font that is the exact size you specify, the font closest to that size is used.

Changes to the Size Attribute Ratio option only affect printer definitions. You must update the printer definition for changes to take effect for a non-PostScript printer (see Update under Printer, Select). After updating the definition, documents saved with the printer selected reflect the changes.

You do not have to update PostScript printer definitions.

For a discussion on how fonts are assigned to attributes, see Font.

**Repeat Value**
This option determines the initial (default) value for Repeat Value. You can also set this value with the Repeat Value feature, and the setting made with the Repeat Value feature overrides the setting made with this option.

**Save with Original Privileges**
This option lets you save all documents with the same privileges they had prior to editing. If this option is not selected, documents are saved according to your UNIX unmask.

**Save/Retrieve with .wp Extension**
When this option is set to Yes, files you retrieve and then save are saved with a .wp extension. This lets users with Desktop applications create rules for retrieving files based on the .wp extension. They can then open Corel WordPerfect and retrieve the file by selecting the file in their Desktop.

**Table of Authorities**
This option determines how entries in your table of authorities are formatted. The information is the same as on the Definition for Table of Authorities menu. Settings made on the Definition for Table of Authorities menu insert a code in your document and override settings made with this option (see Table of Authorities).

See Also: Date; Equations; Initial Codes; Merge; Print Options; Repeat Value
Job Control

When you send a document or part of a document to the printer, Corel WordPerfect creates a print job. You can have several print jobs waiting to be printed. The Job Control screen provides a way to manage and check the status of these print jobs.

If you receive the message “Action Required in Job Control”, you need to go to the Job Control screen and read the displayed message to find out what you need to do.

1  Press Print.
   Or  Select Print from the File menu.
2  Select Control Printer (4).
3  Check the status of the current print job.
   and/or
   Select an option, then enter any requested information (see the information on each option under Notes below).
4  Press Exit to exit the Job Control screen.

Notes

Cancel
Select this option (1) to cancel one or all print jobs (see Print Job, Cancel).

Go/Restart
Restarts the printer after it has been stopped for a form or print wheel change, after you have used the Stop option (see Printing, Stop), or if your paper definition has been set up to prompt you for loading (see Paper Size/Type).

Hold
Lets you put a job on hold in the job list. If the job is active, it is aborted then held. The next available job will start to print.

Lower Screen Information

Job # • Gives the number of the job.

Pri • Lists the job’s priority. You can change the priority of a job by selecting Modify (2).

User • Lists the name of the user.

Document • Lists the full pathname and document name. If the pathname is too long for the line, it will be truncated from the left.

Destination • Lists the Corel WordPerfect port name or the print to disk file name. You can change the destination from the Job Control screen by selecting Modify (2).

Status • The status column refers to the current condition of the print job. It is possible for status code entries to appear together. This field may include any of the following:
**Status | Meaning**
---|---
C | Canceled (may appear only momentarily)
D | Downloading (the file is listed)
E | Error (the error will be listed)
F | Forms request (see Paper and Location below)
H | Held
P | Printing
Q | Queued
R | Return paper to original location (see Paper and Location below)
S | Stopped
u | Submitted to local spooler
W | Waiting

**Modify**
Allows you to change a job’s priority or the destination port.

**Stop**
Stops the printer without canceling any print jobs. For example, you might use this if the paper jammed. After fixing the problem, type g (for Go) twice to restart the print job. If Corel WordPerfect had passed page 1 before you stopped the print job, you will be prompted for the page number to restart printing on. The default is the page that was printing when you stopped the print job (see Printing, Stop).

When you select this option, a warning appears telling you that you may need to reinitialize your printer (see Initialize Printer under Printing—General Information).

**Text at the Printer (Buffer)**
Corel WordPerfect has no control over text after it has been sent to the printer. If your printer has a buffer (a storage area for text waiting to be printed), printing does not stop until the buffer is empty. Turning off the printer empties the buffer.

If the buffer is large enough, it may contain more than one print job. Once a print job has been completely loaded into the buffer, Corel WordPerfect deletes it from the job list and has no control over it. If you turn off the printer with a document in the buffer that is no longer on your screen and has not been saved on disk, the document is lost.

If you turn off your printer, you may need to reinitialize the printer (if you are using downloadable soft fonts) regardless of whether or not there was a Corel WordPerfect print job in the buffer (see Initialize Printer under Printing—General Information).

Because of the printer’s buffer, your printer may be several pages behind the page number displayed on the Job Control screen.
Upper Screen Information
Additional information is listed in the top half of the screen. As you scroll through the highlighted job entries, the upper fields rewrite to correspond to your selection.

- **Port**: Lists the Corel WordPerfect port name.
- **.prs File**: Lists the name of the selected .prs file.
- **Options**: Lists either the job type, graphics quality, text quality, number of copies, or binding width. This selection is made on the Print screen by selecting the appropriate Options.
- **Paper**: Lists the paper type and orientation which you selected in Format, Page, Paper Size/Type.
- **Location**: If you have a Paper Size/Type code in the document that requires a different form that is not available in a bin, the Paper field will indicate the form type, size, and so on. This field will indicate where you need to put the form.
- **Action**: Instructs you (when appropriate) to take certain action to correct situations and resume printing.
- **Page**: Lists the page number which is currently printing.
- **Copy**: Displays the number of the copy currently printing and the number of copies selected from the Print screen.

See Also: Print, Document on Disk; Print, Document on Screen; Print Job, Cancel; Printing, Stop

---

**Job Type**

Job Type lets you group print jobs together that have similar printing instruction. For example, you can print a number of envelopes together by assigning them a common Job Type. When you are ready to print envelopes, all jobs marked with that Job Type will be printed. The name you enter must match the Port Job Type in order for the job to print. To select a Job Type for a print job,

1. Press **Print**.
2. Select **Job Type** (J).
3. Select a group name.
4. Send the print job to the print queue using the normal print commands.

The print job will be held in the port’s print queue until the Job Type you have chosen is printed.
Printing a Job Type

When you want to print all print jobs with the same Job Type (for example, envelopes or letterhead),

1. Press **Print**.
2. Select Control Port (8).
3. Select **Hold** (6) and press **y** to hold the port (if necessary).
4. Change to the appropriate type of paper at the printer (if necessary).
5. Select Job Type (2).
6. Select a group name and press **Return**.
7. If the port is on hold, select **Go** (4) and press **y** to send the port a Go.

After your group jobs have finished printing, you can again Hold the port, change to the desired type of paper at the printer, and resume printing through the port by sending the port a Go (if a Hold was necessary).

**See Also:** Job Control; Port Control; Print Options; Printing—General Information

### Justification

Use Justification to align text on the right or left margin, on both margins, or centered between margins. You can align one or more lines of text.

- **Left justification**
- **Full justification (left and right)**
- **Right justification**
- **Center justification**

You can also use **Flush Right** and **Center** to right align or center a single line of text.

To change justification,
1. Move the cursor to the paragraph where you want to change justification.

2. Press **Format**, then select Line (1).
   
   *Or* Select **Line** from the **Layout** menu.

3. Select **Justification** (3).

4. Select the justification option of your choice (details about the options are described below).

5. Press **Exit** to return to the normal editing screen.

Justification is set from the beginning of the paragraph forward in the document. If you want to change the justification again, repeat the steps above.

**Center Justification**
Center Justification centers lines of text between margins.

This setting is like the **Center** feature. However, if you use Center to center multiple lines of text, you must insert the Center code at the beginning of every line. Center Justification centers the first line and all lines following the code.

**Full Justification**
Full Justification aligns lines of text on both the left and right margins. Spaces between words must be compressed or expanded as necessary (see **Word Spacing Justification Limits** below).

Full Justification does not show on the normal editing screen, but it displays in the View Document screen.

**Left Justification**
Left Justification produces a **ragged right** margin. Text is aligned at the left margin, but not at the right margin.

**Right Justification**
Right Justification produces a **ragged left** margin. Text is aligned at the right margin, but not at the left margin.

Right Justification is better than the **Flush Right** feature for right-aligning multiple lines of text. If you use Flush Right to right-align multiple lines of text, you must insert the Flush Right code at the beginning of every line. With Right Justification, the first line and all lines following the code are right justified.

<table>
<thead>
<tr>
<th>Notes</th>
<th>Existing Text</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Notes</strong></td>
<td><strong>Existing Text</strong></td>
</tr>
<tr>
<td>If you want to Center or Right Justify existing lines of text, block the text, press the <strong>Center</strong> key or <strong>Flush Right</strong> key, then type y. A Justification code is placed in front of the block, instead of a Center or Flush Right code. At the end of the block, another Justification code is inserted.</td>
<td></td>
</tr>
<tr>
<td><strong>Hyphenation</strong></td>
<td>Like Justification, Hyphenation improves the look of the printed page. You cannot, however, hyphenate right- or center-justified text.</td>
</tr>
</tbody>
</table>

---

222 | **Justification** |
Search
If you enter a Justification code in Search, the code is represented as [Just]. This code finds any of the four types of Justification codes.

Tables
In tables, justification is turned off at the beginning of the table, then turned on again at the end of the table. Within the table, the Table Position option determines the alignment of the entire table structure (see Position under Table, Edit Structure).

Justification can be used within a table to determine text alignment inside cells. When a justification setting is selected, it affects only text in the cell where that code is inserted.

You can also change the Justify settings under the Table Format options to make justification settings for individual cells or entire columns of cells. Table Justify settings, however, are overwritten by any settings you make with Justification inside the table. The Table Justify settings let you select Decimal Align, which aligns text on a decimal character. This is useful if the table contains numbers.

Word Spacing Justification Limits
With Full Justification on, spacing between words is expanded or compressed to justify the text on a line. Use Word Spacing Justification Limits to limit the expansion and the compression. When a word spacing limit is reached, adjustment between characters begins.

To set Word Spacing Justification Limits,

1. Move the cursor to where you want to set the limits.
2. Press Format, then select Other (4).  
   Or Select Other from the Layout menu.
3. Select Printer Functions (6), then select Word Spacing Justification Limits (4).
4. Enter a compression percentage, then enter an expansion percentage.

The percentages you enter are percentages of an existing space. For example, if you do not want compression more than 60% (.6), enter 60% for compression. If you do not want more than 120% (1.2) expansion, enter 120% for expansion.

For the expansion percentage, any percentage over 999% is considered unlimited.

5. Press Exit to return to the normal editing screen.

If your printer does not support this feature, Word and Letter Spacing has no effect.

See Also: Center; Flush Right; Tab Align
Kerning

On the printed page, certain letter pairs appear to have more space between them than others because of the shape and slant of each letter. To reduce the space between the letters, use Kerning.

Un kerned letter pairs

WALTER

Kerned letter pairs

WALTER

Some fonts are defined with kerning tables while others are not. For example, there is no monospaced font with defined kerning tables. The printer resource file (.prs file) determines which letter combinations are kerned.

1 Move the cursor to where you want kerning to begin.
2 Press Format, then select Other (4).
   Or Select Other from the Layout menu.
3 Select Printer Functions (6).
4 Select Kerning (1).
5 Type y to turn on kerning.
   or
   Type n to turn off kerning.
6 Press Exit to return to the document.

Notes

Codes
Kerning starts at the [Kern:On] code and affects text from that point forward in the document until it reaches a [Kern:Off] code.

Manual Kerning
You can manually kern by inserting an Advance code between the pair of characters to be kerned (see Advance).

Printers and Kerning
You can define kerning tables for specific sets of characters by making adjustments to your .all file. For more information, see Printer Program.

Test File
The file kern.tst contains the letter pairs which are most often kerned. Retrieve this file, select the printer you are using, and change the base font to the font you want to test. You can print the file to see how the letter pairs are kerned for the selected font.

The kern.tst file is installed with the Printer Program files. You must install the Printer Program files if you want to use kern.tst.
Keyboard Layout

You can change keystroke assignments for features by selecting a new keyboard definition. For information about assigning keys, see Keyboard Layout, Edit and Keyboard Layout, Map.

To select a keyboard layout,

1   Press Setup.

   Or □  Select Setup from the File menu.

2   Select Keyboard Layout (4).

3   Move the cursor to the keyboard of your choice, then choose Select (1) to select it.

The keyboard names displayed on the Setup: Keyboard Layout menu are the keyboard files (files with a .wpk extension) listed in the keyboard/macro directory (see Location of Files). If you have not created a keyboard, see Create below. If it is not located in the keyboard/macro directory, see Location of Files.

4   Press Exit to return to the normal editing screen.

The keyboard selection you make is stored in the .wp8c.set file.

Notes

Copy

Copy lets you copy an existing keyboard layout. Use this option if you want to create a keyboard layout using an existing keyboard layout as a model.

To copy a keyboard layout,

1   Move the cursor to the name of the keyboard layout you want to copy in the Setup: Keyboard Layout menu.

2   Select Copy (5).

3   Enter a name (up to eight characters) for the new keyboard and press Return.

If you give the keyboard the name of an existing keyboard, you will receive an error message and must give the new keyboard a different name.

Create

Create lets you create and name a keyboard layout.

To create a new keyboard layout,

1   Select Create (4) from the Setup: Keyboard Layout menu.

2   Enter a name (up to eight characters) for the keyboard and press Return.
When you give a keyboard a name, it is stored as a file in the keyboard/macro directory and a .wpk extension is added to the name (see Location of Files).

The new keyboard has the same key assignments as the original keyboard. For information on editing the keyboards you create, see Keyboard Layout, Edit.

Delete
Delete lets you delete a keyboard on the menu.

To delete a keyboard layout,

1 Move the cursor to the name of the keyboard you want to delete in the Setup: Keyboard Layout menu.

2 Select Delete (2).

3 Type y.

The keyboard is deleted from the Setup: Keyboard Layout menu. The .wpk file associated with the keyboard is deleted from your disk.

Edit
Edit lets you edit key assignments for a keyboard layout. You can assign features, macros, Compose characters, and keyboard characters to the various keyboard keys. For more information, see Keyboard Layout, Edit.

The Map option lets you perform many of the same operations as the Edit option. For more information on the Map option, see Keyboard Layout, Map.

When you edit a keyboard layout, you may receive a message under the key columns which says “Unusable”. You can remap this key which is unusable by selecting the move feature.

Keyboard Layouts and Macros
If you have defined a Quick Macro and execute it by pressing Quick Macro-letter, Corel WordPerfect looks to see if a feature or operation has been assigned to that Quick macro letter key on the current keyboard layout. If it has been assigned, Corel WordPerfect uses the key assignment. If not, Corel WordPerfect searches for the macro file, then executes it.

For example, if you have a Quick Macro that normally inserts the date in your document, but are using a keyboard where Quick Macro has been defined to turn on Bold, pressing Quick Macro will turn on Bold. If Quick Macro is not assigned in the keyboard layout you are using, pressing Quick Macro will insert the date in your document.

To make sure the macro file is executed, press Macro, then enter the name of the Quick Macro.

Non-Quick Macros (macros invoked with the Macro Key) are accessible, regardless of the keyboard which is active. Their operation, however, depends on several factors (see Key Macro under Keyboard Layout, Edit and Keyboard Layout, Map).
**Keyboard Layouts vs. Quick Macros**

Keyboard layouts let you assign features and operations to Quick Macro character keys. Keyboard layouts give you more flexibility than Quick Macros and let you assign more than macros to most keys on the keyboard.

Another difference between keyboard layouts and Quick Macros is that a Quick Macro file takes up less disk space than a keyboard layout file (see Macros, Define).

**Map**

Map gives you a “map” of key assignments that lets you assign features, Compose characters, and keyboard characters to different keyboard keys. For more information, see Keyboard Layout, Map.

Edit is similar to the Map option. It can perform all of the same operations and more, including making assignments for function keys and assigning macros to a keyboard key. For more information on Edit, see Keyboard Layout, Edit.

**Name Search**

Name Search lets you easily move the cursor to the keyboard name you are looking for. Select Name Search (n) in the Setup: Keyboard Layout menu, then begin typing the name of the keyboard you are looking for. As you type letters, the cursor moves to the keyboard name that matches those letters. To exit Name Search, press Return or one of the arrow keys.

**Original**

Original lets you re-select the original keyboard. To do so, select Original (6) in the Setup: Keyboard Layout menu.

You can also switch to the original keyboard from anywhere by pressing Reset Keyboard (usually Ctrl-6). Unlike the Original option, Reset Keyboard temporarily disables the selected soft keyboard. If you do not use the Original option or select another keyboard on the Setup: Keyboard Layout menu, the keyboard you selected prior to pressing Reset Keyboard will be in effect the next time you start Corel WordPerfect.

To switch back to the keyboard you selected without using the Setup menus, press Reset Keyboard twice. The message, “Active keyboard-[keyboard name]” is displayed.

**Rename**

Rename lets you rename a keyboard. Move the cursor to a keyboard on the menu, select Rename (3), then enter the new name. The filename for the keyboard layout is changed to the new filename. The filename maintains the .wpk extension and is stored in the keyboard/macro directory (see Location of Files).

**See Also:** Compose; Keyboard Layout, Edit; Keyboard Layout, Map
Use the Edit option on the Setup: Keyboard Layout menu to re-assign features to keystrokes. These keystrokes become part of a keyboard layout. For more information see Keyboard Layout.

To use the Edit option,

1. Press Setup.

   or Select Setup from the File menu.

2. Select Keyboard Layout (4), then move the cursor to the keyboard you want to edit.

The keyboard names displayed on the Setup: Keyboard Layout menu are the keyboard files (files with a .wpk extension) listed in the keyboard/macro directory (see Location of Files). If the keyboard you want to edit is not listed, either you have not created it, or it is not located in the keyboard/macro directory you specified in Location of Files. If you have not created it, see Create under Keyboard Layout. If it is not located in the keyboard/macro directory, see Location of Files.

3. Select Edit (7).

The Name heading appears at the top of the screen to remind you which keyboard layout you are editing.

4. Move the cursor to the key you want to edit.

   If the key you want to edit is not displayed, its function is the same as on the original keyboard (see Create below). You can move to a key on the list by selecting Name Search, then pressing the key.

5. Select one of the options and perform the necessary operations (see the option headings under Notes below).

6. Press Exit to return to the Setup: Keyboard Layout menu.

You can select one of the options from the Setup: Keyboard Layout menu, or you can press Exit to return to the normal editing screen. If you want to select the keyboard for use, move the cursor to the keyboard name, then choose Select (1).
Action takes you to a macro editing screen where you can assign a feature or operation to a key.

When you edit a keyboard layout, you may receive a message under the key columns which says “Unusable”. You can remap this key which is unusable by selecting the move feature.

To use this option, move the cursor to the key on the Keyboard: Edit menu whose assignment you want to change, select Action (1), then edit the key as necessary. Press Exit when you finish.

The procedure for editing in the Key: Action screen is the same as editing in the Macro Editor. Before you decide to edit in the Key: Action screen, you may want to read Macros, Macro Editor to learn about the things you can do in the Key: Action screen.

The following are some operations you can perform:

To assign a function key feature to the key, press the function key for that feature. For example, press the function key for Indent if you want to assign the Indent feature to the key.

If you want to assign Cancel, Exit, Help, or other cursor movement keys (arrow keys), you must press Ctrl-v before pressing the key assigned to those features.

To assign a Compose character,

1 Press Compose.

2 Type the Corel WordPerfect character set number, followed by a comma.

3 Type the character within the character set, then press Return (see Compose).

To use the Corel WordPerfect macro programming language,

1 Press Macro Commands.

2 Move the cursor to the command you want, then press Return.

Commands such as Block Append/Copy/Move and Item Up/Down/Left/Right are located on the list of programming commands.
**Cancel**

Pressing **Cancel** in the Keyboard: Edit menu displays the prompt “Cancel Changes? No (Yes).” Typing **n** keeps you in the Keyboard: Edit menu. Typing **y** cancels all changes you made since you entered the Keyboard: Edit menu and exits you to the Setup: Keyboard Layout menu. If you do not want to cancel the changes, press **Exit** instead of **Cancel** to exit the menu and save the changes.

**Create**

Create lets you assign a feature or operation to a key that is not listed on the Keyboard: Edit menu. Select **Create** (4) from the Keyboard: Edit menu, then press the key you want to assign the feature or operation to.

After you press the key and enter a description for the key, you can follow the same procedure as if you had selected the Action option for an existing key assignment. Read the information under **Action** above to find out what your options are at this point.

**Delete**

If you want to delete a key and its assignment from the Keyboard: Edit menu, move the cursor to the key you want to delete, press **Delete** or **Backspace**, then type **y** to confirm the deletion. When you delete a key from the Keyboard: Edit menu, its assignment is returned to what it was on the original keyboard.

**Description**

This option lets you enter or add a description for a key. The description tells you what the key does and is displayed on the Keyboard: Edit screen.

To use this option, move the cursor to a key on the Keyboard: Edit menu, select **Description** (2), then enter a description for the key.

**Key Macro**

If you retrieve a macro file to a key (see **Retrieve** below) or if you create a macro for a key (see **Action** above), the macro is represented as **{Key Macro #}** under the Action heading on the Keyboard: Edit screen.

The Key Macro command is used in macros when you press the key associated with the key macro. For example, suppose you assign a macro to the **Cancel** key in a keyboard layout called testkey, and suppose that macro becomes **{Key Macro 1}**. If you are using testkey while defining a macro called macro, and then press Cancel, **{Key Macro 1}** is inserted into the macro (and can be viewed in the Macro Editor).

When you execute the macro, Corel WordPerfect interprets the **{Key Macro 1}** command. It looks in the keyboard layout you are currently using, then executes the steps associated with the key assigned to **{Key Macro 1}**.

We suggest you create your macros with the original keyboard in effect. With the original keyboard in effect, it is impossible to insert **{Key Macro}** commands into a macro. If the macro is created correctly, it should execute properly regardless of the keyboard layout you use. The only exception is a Quick Macro which is discussed in **Keyboard Layouts and Macros** under **Keyboard Layout**.
**Keyboard Layout: Map**
The Map option is similar to the Edit option discussed in this section. This option lets you assign features and operations to keys. It also lets you edit the same keyboard layout.

Map does not let you assign an existing macro to a key, save a key assignment as a macro, or assign features and operations to function keys. It gives you a “complete picture” of your keyboard layout, and shows most of the keys on your keyboard and the features or operations assigned to them. More information on this option can be found in *Keyboard Layout, Map.*

**Move**
Move lets you move a key assignment from a key existing on the Keyboard: Edit menu to a key that may or may not exist on the menu. To use the option, move the cursor to the key on the Keyboard: Edit menu whose assignment you want to move, select Move (5), then press the key you want to move the feature or operation to.

For example, if you retrieved a macro named test.wpm to F6 and you want to change its assignment to the Format key, move the cursor to the F6 key assignment on the Keyboard: Edit menu, select Move (5), then press **Format**.

If you replace a key assignment that existed on another key, you must type **y** to confirm the replacement. The key from which an assignment was moved is returned to its assignment on the original keyboard and is no longer displayed on the Keyboard: Edit menu.

**Original**
Original lets you return a key’s function to what it was on the original keyboard. In effect, it deletes the “remapped” definition of this key from the keyboard layout.

To use this option, move the cursor to the key on the Keyboard: Edit menu you want to change, select Original (3), then type **y**.

**Retrieve**
Retrieve lets you assign an existing macro to a key. To do so, select Retrieve (7) from the Keyboard: Edit menu, press the key you want to assign the macro to, then enter the name of the macro. If you replace a key assignment that previously existed on another key, you must type **y** to confirm the replacement.

Corel WordPerfect looks for the macro in the keyboard/macro directory unless you enter a different pathname.

Once a macro is retrieved to a key, the association with the macro ends.

More information about naming macros can be found in *Macros, Define.* More information about the keyboard/macro directory can be found in *Location of Files.*
**Save**

Save lets you save a key assignment as a macro. You can use the assignment as a macro regardless of which keyboard is selected.

For example, if you have a key assignment that saves a document, then clears the screen, you can store the assignment as a macro. It can then be executed with the Macro feature regardless of the keyboard layout you are using.

Move the cursor to the key on the Keyboard: Edit menu whose assignment you want to save as a macro. Select Save (6) from the Keyboard: Edit menu, then enter the name you want to call the macro. If you replace a macro that previously existed under the same name, you must type y to replace the macro. The macro will be saved to the keyboard/macro directory (unless you enter a pathname to a different directory) and a .wpm extension will be added.

More information about naming macros can be found in *Macros, Define*. More information about the keyboard/macro directory can be found in *Location of Files*.

**See Also:** Compose; Keyboard Layout; Keyboard Layout, Map; Macros, Macro Editor

---

**Keyboard Layout, Map**

The Map option on the Setup: Keyboard Layout menu lets you see the key assignments for most keys on a keyboard layout. You can assign features and operations to keys on the Keyboard: Map menu.

If you want to assign Corel WordPerfect characters to keys on a keyboard layout, Map can help you determine which keys the characters are assigned to.

To use the Map option,

1. Press **Setup**.
   - Or **Select Setup from the File menu.**

2. Select Keyboard Layout (4), then move the cursor to the keyboard whose map you want to display.

The keyboard names displayed on the Setup: Keyboard Layout menu are the keyboard files (files ending with a .wpk extension) listed in the keyboard/macro directory (see *Location of Files*). If you did not create a keyboard, see Create under Keyboard Layout. If it is not located in the keyboard/macro directory, see Location of Files.

3. Select Map (8).
The Keyboard: Map menu is shown below. Notice that the name of the keyboard is located near the top of the screen.

<table>
<thead>
<tr>
<th>Quick macro keys</th>
<th>Ctrl keys</th>
<th>Character and shift-character keys</th>
<th>Shift keys</th>
<th>Normal keys</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Quick macro keys</strong></td>
<td><strong>Ctrl keys</strong></td>
<td><strong>Character and shift-character keys</strong></td>
<td><strong>Shift keys</strong></td>
<td><strong>Normal keys</strong></td>
</tr>
<tr>
<td><strong>Name</strong></td>
<td><strong>Action</strong></td>
<td><strong>Name</strong></td>
<td><strong>Action</strong></td>
<td><strong>Name</strong></td>
</tr>
<tr>
<td>All Key: ABCDEFGHIJKLMNOPQRSTUVWXYZ1234567890</td>
<td>Ctrl Key: ABCDEFGHIJKLMNOPQRSTUVWXYZ1234567890</td>
<td>Ctrl Key: ABCDEFGHIJKLMNOPQRSTUVWXYZ1234567890</td>
<td>Ctrl Key: ABCDEFGHIJKLMNOPQRSTUVWXYZ1234567890</td>
<td>Ctrl Key: ABCDEFGHIJKLMNOPQRSTUVWXYZ1234567890</td>
</tr>
</tbody>
</table>

The keyboard map menu shows all of the assignable or mappable keys on your keyboard (minus the function keys and a few others). A non-bolded letter or character on the Action row beneath the key means the letter or character is assigned to that key. A bolded C on the Action row indicates a non-macro feature or operation is assigned to the key, while a bolded M indicates a macro is assigned to the key.

If you want to make assignments for the function keys, you must do so with the Keyboard: Edit option (see Keyboard Layout, Edit).

As you move the cursor from key to key on the Keyboard: Map menu, notice the “Key,” “Action,” and “Description” headings at the bottom of the screen. “Key” indicates the key on which the cursor is located, “Action” represents the feature or operation assigned to the key, and “Description” is the description associated with the action.

4 Move the cursor to the key whose assignment you want to change.

5 Select one of the options on the Keyboard: Map menu (see the option headings under Notes below).

6 Press Exit to return to the Setup: Keyboard Layout menu.

You can select one of the options from the Setup: Keyboard Layout menu, or you can press Exit to return to the normal editing screen. If you want to select the keyboard, move the cursor to the keyboard name, then choose Select (1).

Notes

Pressing Cancel in the Keyboard: Map menu displays the “Cancel Changes?” prompt. Typing n keeps you in the Keyboard: Map menu, while typing y cancels all changes you made since you entered the Keyboard: Map menu and exits you to the Setup: Keyboard Layout menu. If you do not want to cancel the changes, press Exit instead of Cancel to exit the screen and save the changes.
Compose
This option on the Keyboard: Map menu lets you enter a Corel WordPerfect character for a key.

To use the Compose option,
1. Move the cursor to the Action line under the key.
2. Select Compose (5).
3. Type the Corel WordPerfect character set number, followed by a comma.
4. Type the character within the character set, then press Return (see Compose).

Since the Keyboard: Map menu is in text mode, the number of characters Corel WordPerfect can display is limited by the terminal. If a character cannot be displayed, a tilde or box appears on the screen. Read the Printing—General Information section to learn how Corel WordPerfect characters are printed.

Delete
If you want to delete a key assignment for a key, move to the Action line under that key on the Keyboard: Map menu, press Delete or Backspace, then type y (if necessary) to confirm the deletion. When you delete a key assignment, the key is then assigned to its function on the original keyboard.

Description
This option on the Keyboard: Map menu lets you enter a description for the key.

To use this option, move the cursor to the Action line under the key on the Keyboard: Map menu whose description you want to change, select Description (3), then enter a description for the key.

Key
This option on the Keyboard: Map menu lets you assign a feature or operation that exists on one key to the key on which the cursor is resting. To use this option, move the cursor to the Action line under a key on the Keyboard: Map menu, select Key (1), then press the key whose feature or operation you want to assign.

For example, move the cursor to Quick Macro c, select Key (1), then press Cancel to assign Cancel to Quick Macro.

If you replace an existing macro, Corel WordPerfect displays the “Replace KEY MACRO?” message before letting you replace the macro. Type y to confirm.

If the key you press after selecting this option already has a function or operation assigned to it in the current keyboard, it executes that function. We suggest you use Reset Keyboard or the Original option on the Setup: Keyboard Layout screen to make sure the original keyboard is in effect before you make assignments with this feature (see Original under Keyboard Layout, Edit).
**Key Macro**

If you create a macro for a key (see Macro below), the macro is represented as {Key Macro #} under the Action heading on the Keyboard: Map screen.

The Key Macro command is used in macros when you press the key associated with the key macro. For example, if you assign a macro to the Cancel key in a keyboard layout called testkey, the macro becomes {Key Macro 1}. If you are using testkey while defining a macro called macro, and then press Cancel, {Key Macro 1} is inserted into the macro (and can be viewed in the Macro Editor).

When you execute the macro, Corel WordPerfect interprets the {Key Macro 1} command, looks in the keyboard layout you are currently in, then executes the steps associated with the key assigned to {Key Macro 1}.

We suggest you create your macros with the original keyboard in effect. With the original keyboard in effect, it is impossible to insert {Key Macro} commands into a macro. If the macro is created correctly, it should execute properly regardless of the keyboard layout you are using. The only exception to this is an Alt-macro, which is discussed in *Keyboard Layouts and Macros* under *Keyboard Layout*.

**Keyboard Layout: Edit**

Edit is similar to the Map option discussed in this section. It lets you assign features and operations to keys, and is another way to edit the same keyboard layout.

Edit lets you retrieve an existing macro to a key, save a key assignment as a macro, or assign features and operations to function keys and other keys such as Escape, Backspace, and the arrow keys that are not located on the Keyboard: Map menu.

More information on this option can be found in *Keyboard Layout, Edit*.

**Macro**

Macro lets you use the Key: Action screen to create a macro for a key. To do so, move the cursor to the Action line under a key on the Keyboard: Map menu, select Macro (2), then edit the key as necessary. Press Exit when you are finished.

The procedure for editing in the Key: Action screen is the same as editing in the Macro Editor. Before you edit in the Key: Action screen, we suggest you read *Macros, Macro Editor* to learn about the options in the Key: Action screen.

The following are some operations you can perform:

To assign a function key feature to the key, press the function key for that feature. For example, press the function key for ▲Indent if you want to assign the ▲Indent feature to the key.

If you want to assign Cancel, Exit, Help, or many of the cursor movement keys (arrow keys), you must press Ctrl-v before pressing the key assigned to those features.
If you want to assign a Compose character, press **Compose**, type the Corel WordPerfect character set number, a comma, the character within the character set, then press **Return** (see **Compose**).

If you want to use the macro programming language, press **Macro Commands**, move the cursor to the command you want, then press **Return**.

**Name Search**

Key Name Search lets you easily move the cursor to the key you are looking for. To use this option, select Key Name Search in the Keyboard: Map menu, then press the key you are looking for.

**Original**

Original lets you return a key’s function to what it was on the original keyboard layout. To use this option, move to the Action line under a key on the Keyboard: Map menu, select **Original** (4), then type `y` (if asked to confirm).

*You will be asked to confirm if you are deleting a key macro.*

**See Also:** Compose; Keyboard Layout; Keyboard Layout, Edit; Macros, Macro Editor

---

**Labels**

Use Labels to produce mailing labels. You can type labels individually or merge multiple labels from a secondary file into a primary file.

Labels is an option on the Paper Size/Type menu that can be used for forms other than labels (program covers, side-by-side landscape pages). For information about Paper Size/Type see **Paper Size/Type**.

The steps below can help you create paper size and type information for labels. If you already created the information, skip to the notes at the end of the steps.

1. Press **Format**, then select **Page** (2).
   
   *Or* `Page` from the Layout menu.

2. Select **Paper Size/Type** (7).

3. Select **Add** (2).

4. Select a paper type. We suggest you select **Labels** (4) to make the paper type easy to recognize. You have the option, however, to select any of the other paper types listed or create your own paper type definition.

5. You can select and change any of the Format: Edit Paper Definition options. These options determine the page size you are using, the font orientation, and where the form is located in your printer. These options are explained in **Paper Size/Type**.
If you print an entire sheet of labels, enter the dimensions of the entire sheet. If you use tractor-fed labels, see Tractor-Fed Labels under Notes below.

6 Select Labels (8), then type y to move to the Format: Labels screen.

7 Change your label settings, if necessary, to match the dimensions of your label.

8 Press Exit twice to return to the Paper Size/Type menu.

To select the new label, choose Select (1), then press Exit to return to the normal editing screen. To select an existing label definition, move the cursor to where you want to start using labels, go to the Paper Size/Type menu, highlight the correct Paper Type, choose Select (1), and press Exit.

If you are not merging information (see Merge), place the code at the top of the page where you want it to take effect. If you do not place it at the top of the page, it will take effect on the next page.

Important: If you create a primary file, (see Merge), you must place the Paper Size/Type information in Document Initial Codes (see Initial Codes).

If you cannot enter the Paper Size/Type code, set the left and right page margins, and the top and bottom page margins (not the label margins) to 0" before entering the Paper Size/Type code.

Once you select the paper size and type, you can type the text for the labels if you are not merging information from a secondary file. If you are merging information from a secondary file, create a primary file.

When you enter a Paper Size and Type code, any subsequent editing changes you make to the information on the Paper Size/Type menu do not affect the existing code. To apply your changes to the document, delete the existing code, then re-enter the paper size/type information.

When you finish typing label text, insert the labels into the printer and print them as you would any other document (see Printing Labels under Notes below).

Label Size
Use this Format: Labels option to enter the width and height of an individual label. For labels 2.75" wide by 1" high, enter this information as your label size.

Number of Labels
Use this Format: Labels option to enter the number of columns and rows.

Top-Left Corner
Use this Format: Labels option to enter the location of the top-left corner of the first label on the sheet of labels. The top measurement is measured from the top edge of the page to the top edge of the first label. The left measurement is measured from the left edge of the page to the left edge of the first label.

If the first label starts .5" from the top of the page and .5" from the left edge of the page, these are the measurements you should enter for this option. If the labels start at the top-left edge of the page, enter 0" and 0".
For tractor-fed labels, set the top-left corner measurements to 0", 0". Position the labels in the printer to print on the first line of the top left label (see *Tractor-Fed Labels* under *Notes* below).

**Distance Between Labels**
Use this Format: Labels option to enter the distance between columns and between rows of labels.

If there is no space between labels on the page, enter 0" and 0" for the measurements.

**Label Margins**
Use this the Format: Labels option to enter the left, right, top, and bottom margins for individual labels.

**Notes**

**Centering Text on Labels**
To vertically center text on a label, enter a Center Page code at the top of each label. If you are merging information and want to vertically center text on every label, place the Center Page code at the top of the primary file (not in Document Initial Codes).

**Code**
The labels Paper Size/Type code (which you can see in Reveal Codes) displays like other Paper Size/Type codes, but the label size is also displayed ([(Paper Sz/Type:8.5"x11",Labels,2"x3")].

**Entering Measurements**
You can enter fractions in this and other measurement features (see *Units of Measure*).
Label Information Needs to be Updated for Paper Size
You changed the paper size for a paper type that was initially set to print labels. The current label information is not correct for the new paper size. Update the label information to match the paper size.

Make the necessary corrections to label size, the number of rows and columns on the page, the label margins, and the location of the top left label.

Label Margins Increased Due to Printer's Minimum Margin
At least one of the label margins had to be increased because of an unprintable region for your printer.

An unprintable region is an area measured from the edge of the page in which your printer cannot print. If one or more of your label margins is less than the unprintable region, the margins will be increased automatically for all labels on the page.

Check your printer manual or printer manufacturer for information about your printer's unprintable region.

Labels Macro
Use the macro labels.wpm to create and insert a label Paper Size/Type code into Document Initial Codes. Press Macro, then enter labels.

Corel WordPerfect will search the keyboard/macro directory for the labels macro (see Location of Files). If the macro is elsewhere, you must enter the full pathname (including the filename) to the macro after pressing Macro.

When you retrieve the labels macro, a list of preset label definitions for laser printers is displayed. Press Switch to see a list of label definitions for tractor-fed (dot matrix) printers.

To scroll through a list, press the arrow keys, or PageUp or PageDown keys. You can also move the cursor to a specific definition by typing the name of the definition. With the definition highlighted, press Return to select the label.

Corel WordPerfect prompts you to specify how paper is fed into your printer. For location information see Editing a Definition under Paper Size/Type.

When you select an option, a message on the status line asks whether you want to insert the label definition into Document Initial Codes. If you do not insert the label definition into Document Initial Codes, the definition is still added to your Format: Paper Size/Type menu.

Labels Will Not Fit on Paper Size
The labels you defined cannot fit on the page. Correct the information on the Format: Labels menu or the Format: Edit Paper Definition settings.

Check the size of the page of labels, the number of rows and columns on the page, the label margins, and the location of the top left label.
Merging Labels

To create multiple labels, merge information in a secondary file with a primary file. The secondary file contains your list, and the primary file contains the merge codes (see Merge).

An example of a primary file that extracts the first three fields of each record in your secondary file is shown below.

```
@FIELD1@  
@FIELD2@  
@FIELD3@  
```

An example of two records in a secondary file is shown below.

```
Bob Smith  123 Main St.  San Francisco, CA 94111
Mary Jones  456 Oak Ave.  San Francisco, CA 94112
```

If you merge records, go to Document Initial Codes, select Paper Size/Type, highlight the labels paper size/type, choose Select (1), then press Exit to insert the labels Paper Size/Type code into the Document Initial Codes of the primary file.

Physical Page vs. Logical Page

The entire sheet of labels is a physical page, and each label a logical page. The size information for the physical page comes from the Paper Size on the Format: Edit Paper Definition menu. The size information for the logical page comes from the Format: Labels menu. It numbers the logical pages from left to right,
then top to bottom from the top left label to the bottom right label. For example,

Label one  
Label four  
Label seven  

Label two  
Label nine

After you select the label paper size/type, the “Pg” heading on the status line in the normal editing screen reflects the logical page the cursor is on. Use View Document to see the entire physical page.

Press Page Down to go to the next label or Page Up to go to the previous label. Go To, then a page number, sends you to a specific label.

Because labels are considered separate “pages,” formatting features that affect subsequent pages, such as Page Numbering, Headers, and Footers, are in effect for each label. For example, if you defined a header for every page at the top of the document, the header code is inserted in each label.

If you select print page in the print feature, only one label will be printed.

**Printing Labels**

There are several measurements you must enter when you create labels. Use View Document to make sure the document displays correctly.

*If only one label on a sheet of labels appears in the View Document screen, make sure your Paper Size/Type code is in Document Initial Codes.*

Print a few sample labels on regular paper to make sure the labels are positioned correctly.

*If you receive a beep from your computer or a message from your printer when you print labels, check the Control Printer menu. If it instructs you to insert your label sheets, do so, then press g to continue. To avoid this prompt, set the Prompt to Load setting for the labels Paper Size/Type to No (see Paper Size/Type).*

If you print selected logical pages of labels, the labels will be printed on a single physical page of labels until that page is full. For example, if you are printing labels 1, 15, 40, and 75 on a sheet which has 30 labels per sheet, the four labels will print on the same sheet.
Program Covers
You can also use Labels to create program covers or print two pages of information side-by-side as shown below.

- Friday Meeting
  1. Introduce New Employees
     Dana Loveless
     Richard Knudsen
     Ian Sorensen
     Howard Jensen
     Inga Hunter
     Randy Richards
  2. Farewell To Departing Employees
     James Phillips
     Annalee Witney
     Tim Morris
     Jonathon Lysenko
     Holly Toomey
     Craig Williamson
  3. New Break Policy
     John Richards
  4. Open House Next Thursday
     Alex Smith
     Aaron Christiansen
  5. Ted Houghton
     Parking Spaces
     Music in the Office
     Materials List
  6. National Secretary Day
     Susan Williams
  7. Comments by Dave Jensen
  8. Security Cards
     Officer Payne
  9. New Phones
     Rick Sumner
  10. Management Changes
    Harvey Carter
  11. Vacation and Sick Days
    Mike Jensen
  12. Concluding Remarks
    John Johansen

Specify the physical page as a landscape form, then treat each half of the page as a “label” and enter the appropriate measurements. For example, you may use an 11” x 8.5” page with two 5.5” x 8.5” “labels.”

Tractor-Fed Labels
Tractor-fed labels are labels on a sheet that has holes along the sides of the paper to guide the labels through the printer. Tractor-fed labels are frequently used on dot-matrix and daisy-wheel printers.

To position the labels, set your label margins (not your page margins; see Label Margins above) to 0”, print a test label and calculate how far you need to move
the labels in the printer to have the first character in the label print at the top left corner of the row of labels.

Once the labels are positioned correctly, they should print correctly if you entered the paper size/type and label information correctly.

When you enter label information for tractor-fed labels, treat each row of labels as a “sheet” of labels.

When you treat each row of labels as a sheet of labels, the number of rows is always 1, and the distance between rows is always 0. However, the paper size should account for the distance between labels.

For example, if you have two-across labels that are 4" wide with a .5" space between columns, the paper width is 8.5" (4" + .5" + 4"). If you have labels that are 15/16" long with 1/16" between rows of labels, your paper height is 1" (15/16" + 1/16").

This does not change the information you enter for the label size or the distance between columns (if you have multiple columns). Those measurements should reflect the actual label size. Using the example in the paragraph above, your labels are still 4" wide and 15/16" high.

**Typing Label Text**

As you type label text, you can end the information for one label and move to the next by pressing **Hard Page**. If you want to leave a label blank (maybe you already peeled it off and do not want to waste the rest of the sheet), press **Hard Page** without entering text for the label.

If you exceed the number of lines Corel WordPerfect can fit on a label, you can change the base font to a smaller font, decrease the line height, or change the top and bottom label margins (see **Label Margins** above). If you exceed the number of lines, a soft page break is inserted (represented by a row of dashes), and the remaining text is moved to the next label.

You can end a line of text by pressing **Return**. If you exceed the amount of text Corel WordPerfect can fit on one line of a label, the text is wrapped to the next line.

Use View Document to see if the labels are correct before you print them.

**See Also:** Merge; Paper Size/Type

---

**Language**

Versions of Corel WordPerfect are available in several languages. You can change the language being used as a reference for your document at any time by entering a language code.
1 Press **Format**, then select **Other** (4).

   *Or* Select **Other** from the **Layout** menu.

2 Select **Language** (4), then enter the letters which represent the language you want to use (see **Language Codes** below).

3 Press **Exit** to return to your document.

If you want the language code to affect all text in a document (including substructures such as footnotes), place the code in **Document: Initial Codes**.

---

### Notes

**Keyboard Layout**

If a language you use contains extended characters, you can create a keyboard for that language by mapping the special characters to the keys of your choice (see **Keyboard Layout**).

**Language Codes**

Corel WordPerfect is available in the following languages:

<table>
<thead>
<tr>
<th>Language</th>
<th>Language Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Catalan</td>
<td>ca</td>
</tr>
<tr>
<td>Croatian</td>
<td>hr</td>
</tr>
<tr>
<td>Czechoslovakian</td>
<td>cz</td>
</tr>
<tr>
<td>Danish</td>
<td>dk</td>
</tr>
<tr>
<td>Dutch</td>
<td>nl</td>
</tr>
<tr>
<td>English—Australia</td>
<td>oz</td>
</tr>
<tr>
<td>English—United Kingdom</td>
<td>uk</td>
</tr>
<tr>
<td>English—United States</td>
<td>us</td>
</tr>
<tr>
<td>Finnish</td>
<td>su</td>
</tr>
<tr>
<td>French—Canada</td>
<td>cf</td>
</tr>
<tr>
<td>French—France</td>
<td>fr</td>
</tr>
<tr>
<td>Galician</td>
<td>ga</td>
</tr>
<tr>
<td>German—Germany</td>
<td>de</td>
</tr>
<tr>
<td>German—Switzerland</td>
<td>sd</td>
</tr>
<tr>
<td>Greek</td>
<td>gr</td>
</tr>
<tr>
<td>Hungarian</td>
<td>ma</td>
</tr>
<tr>
<td>Icelandic</td>
<td>is</td>
</tr>
<tr>
<td>Italian</td>
<td>it</td>
</tr>
<tr>
<td>Norwegian</td>
<td>no</td>
</tr>
<tr>
<td>Russian</td>
<td>ru</td>
</tr>
<tr>
<td>Slovak</td>
<td>sl</td>
</tr>
<tr>
<td>Spanish</td>
<td>es</td>
</tr>
<tr>
<td>Swedish</td>
<td>sv</td>
</tr>
<tr>
<td>Turkish</td>
<td>tk</td>
</tr>
<tr>
<td>Ukranian</td>
<td>yk</td>
</tr>
</tbody>
</table>

You can also display the most current list of language codes on-screen by pressing **Help** while the cursor is on the **Language** entry in the **Format: Other** menu in step 2 above.
When you select a reference language using steps 1 through 3 above, the language code [Lang:xx] is inserted in your document, where xx represents the language you are using (ca for Catalan, dk for Danish).

That language is used for Sort and Date. When you sort the document, Corel WordPerfect uses the guidelines of that language's alphabet. When you insert a date, the date is inserted in the format dates are written in that language (12 décembre 1992 for French).

Inserting a language code does not change the display of menus.

Inserting a language code within the text of a document does not change the way the “(continued)” message is displayed in footnotes. If you want the “(continued)” message printed in a different language, you must enter the language code for the language in the Initial Codes for that document. You must also set the Print Continued Message entry in Footnote Options to Yes (see Footnote and Endnote, Options). This affects only how the “(continued)” message is printed, not how it is displayed in the normal editing screen. You can view the change on-screen using View Document.

The wp.lrs file determines how to format dates and write the “(continued)” message in a given language. When you install Corel WordPerfect, a wp.lrs file is stored in the shlib directory. If you want to change the information concerning a language, you can edit the wp.lrs file (see Language Resource File).

For Corel WordPerfect to find and use a Speller, Thesaurus, or Hyphenation dictionary, the dictionary must be stored in the /wplib directory, or the path to the directory where the dictionary is stored must be listed on the Location of Files entry in Setup.

If a dictionary is correctly installed, at any point following the language code, Corel WordPerfect uses that language’s Speller for spell-checking, its Thesaurus to display synonyms and antonyms, and its Speller, hyphenation dictionary, or hyphenation guidelines as a reference for hyphenation.

When Corel WordPerfect cannot find a dictionary for a specific language, it displays an error message, “wplex.xx Not Found” where xx is the language code you are using.

See Also: Language Resource File

---

**Language Resource File**

When you install Corel WordPerfect, a wp.lrs file is stored in the /shlib directory. The wp.lrs file is the Corel WordPerfect language resource file. Corel WordPerfect refers to it when you use the date feature, print the “(continued)” message in footnotes, print the Document Summary menu, or display the date and time for each file in List Files. You can change the language information by editing the wp.lrs file.
For example, you can use different abbreviations for the months and days than those contained in the wp.lrs file. You can also modify the information in the wp.lrs file to meet your language needs, or you can change the entries being used for the language you are using (see Package Language below).

The wp.lrs file is a WordPerfect Corporation's WordPerfect 5.0 secondary merge file. It can also be saved in a format which is useable in the Notebook program.

You can edit the wp.lrs file in the normal editing screen as you would edit a secondary merge file.

1. Press Retrieve, then enter wp.lrs. If the file is not found in your default directory, you must enter the full pathname (/wplib/wp.lrs).

2. Make any changes you want (see Editing the Language Resource File below).

3. Press Exit, then type y to indicate that you want to save the new file.

4. Press Return and type y to replace the old wp.lrs, then type n to remain in Corel WordPerfect and return to the normal editing screen.

Notes

Editing the Language Resource File

A secondary merge file consists of records which are divided into fields. The merge codes in the wp.lrs secondary merge file are in WordPerfect Corporation's WordPerfect 5.0 format and WordPerfect Corporation's Office 2.0 Notebook format. In this format, each record ends with a ^E code and the fields in each record end with a ^R code. You can move from record to record by searching for the ^E codes, or from field to field by searching for the ^R codes.

You can convert the merge codes in the wp.lrs file into Corel WordPerfect 8c merge code format (see Previous Versions under Merge). However, if you do, you cannot use the wp.lrs file with WordPerfect Corporation's WordPerfect 5.0 or WordPerfect Corporation's Office 2.0 Notebook.

Each record in the wp.lrs secondary merge file begins with a field containing the language code for the language referenced by that field.

You can move to the record for a specific language by searching for the field which contains that language code. For a list of the language codes, see Language.
For example, you can press ✪Search, type us, then press ✪Search to begin the search.

The cursor then moves to the record for the English—United States language.

<table>
<thead>
<tr>
<th>US language code</th>
<th>Date format</th>
<th>Months of the year</th>
<th>Months abbreviated</th>
</tr>
</thead>
<tbody>
<tr>
<td>US</td>
<td>mm/dd/year</td>
<td>January, February, March, April, May, June, July, August, September, October, November, December</td>
<td>Jan, Feb, Mar, Apr, May, Jun, Jul</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Each field in the record is separated by a ^R code.
Do not change the number of fields within the record or the number of lines within each field. You can, however, edit the information contained in each field.

The first field in each record contains the language code.

Fields 2 through 6 apply to Date. These fields determine the date information that is inserted when the language code for that language appears in your document.

Field 2 contains the information which controls the way a date is written when you insert Date Text. The first line of field 2 contains the format in which the date is written (see Date Format under Date). The second line of field 2 determines the way a.m. is written when it follows a time. The default is a.m. The third line determines the way p.m. is written. The default is p.m.

Field 3 contains the complete names of the months of the year. Each name is on a separate line so the different names are separated by Hard Return codes [HRt].

Field 4 contains the abbreviated names of the months of the year, separated by Hard Return codes [HRt].

Field 5 contains the complete names of the days of the week, separated by Hard Return codes [HRt].

Field 6 contains the abbreviated names of the days of the week, separated by Hard Return codes [HRt].

Fields 7 and 8 contain the footnote “(continued)” messages. When you insert the language code into the Initial Codes of the document, these fields determine the way the continued messages appear in the footnotes for the document.
Fields 1 through 6 determine how the items appear when Corel WordPerfect inserts them into your document after you place the language code in the document (see Language).

**Package Language**

The package language is the language of the version of Corel WordPerfect you are using.

For example, if you purchased an English version of Corel WordPerfect for the United States, your package language is English—United States and your package language code is us. If you purchased an English version of Corel WordPerfect for England or Canada, your package language is English—United Kingdom and your package language code is uk.

The package language determines which record in the wp.lrs file your version of Corel WordPerfect uses to obtain the default settings when you use Date, print the “(continued)” message in footnotes, print the Document Summary menu, or display the date and time of each file in List Files.

For example, if your package language is English—United States, Corel WordPerfect searches for the us Language code and the us record in wp.lrs to determine the default entries for these items. If your package language is English—United Kingdom, Corel WordPerfect searches for the uk Language code and the uk record to determine the default entries.

If you want to change the default settings, you must edit the record for your package language. You can change the fields in this record to another language if you want that language to be used as the default.

Fields 9 through 31 in the records of the wp.lrs file are referenced only for the package language for your version of Corel WordPerfect. If you want to change the entries for these fields, you must edit the record for the package language.

Fields 9 through 20 contain the prompts that appear on the different entries in the Document Summary menu. These entries do not change the way the menu appears on the screen. They appear only when you print the document.
summary. You can do this in the Document Summary menu when you view a document summary using Look in List Files.

Fields 21 through 25 contain information which determines how the file attributes are displayed on the List Files screen. These file attributes include the date and time for each file, and the thousands separator which can appear in the file size for each file (see List Files).

Field 21 contains a number that determines the order in which the items in the date are displayed for each file on the List Files screen, as detailed in the following list.

<table>
<thead>
<tr>
<th>Number</th>
<th>Order of Display</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Day Month Year</td>
</tr>
<tr>
<td>2</td>
<td>Month Day Year</td>
</tr>
<tr>
<td>3</td>
<td>Year Month Day</td>
</tr>
</tbody>
</table>

Field 22 contains the two characters that separate each of the items in the date. The two characters are separated by a Hard Return code [HRt].

Field 23 contains the number 12 or the number 24. This determines whether the time on the List Files screen is displayed according to a 12- or 24-hour clock.

Field 24 contains the character to separate hours from minutes, followed by the letters to indicate a.m. and p.m. when a 12-hour clock is used. Each of the entries is separated by a Hard Return code [HRt].

Field 25 contains the thousands separator that is used when a file size is displayed for each file on the list files screen.

Fields 26 and 27 contain information to be used with other operating systems. They are not applicable to the UNIX versions of Corel WordPerfect.

Fields 28-31 contain symbols that are used when you import spreadsheets. For more information, see Currency Symbols under Spreadsheet, Import and Link.

Field 28 contains the character to separate decimal numbers from whole numbers. Field 29 contains the currency symbol. Fields 30 and 31 contain the credit and debit symbols.

See Also: Language
Line Draw

Line Draw lets you draw boxes, graphs, borders, and other illustrations. Using the arrow keys, you can draw on a clear screen or around existing text. Corel WordPerfect inserts corners automatically as you draw, and fills blank areas with spaces or hard returns. Any codes in front of the cursor are pushed forward.

You must select a mono-spaced font that has a line draw automatic font change or a line draw font to print correctly. Most proportionally-spaced fonts cannot be used with Line Draw.

1 Press Screen, then select Line Draw (2).

Or Select Line Draw from the Tools menu.

2 Type 1 and move the cursor with the arrow keys to begin drawing with a single line.

or

Type 2 and move the cursor with the arrow keys to draw with a double line.

To choose one of the remaining Line Draw options, refer to Notes below.

3 Press Exit when you finish drawing to return to normal editing.

Notes

Arrows and Lines

The arrows that appear on the screen as you draw have two functions. They represent a line that does not connect to another line. They also represent half-space lines, which means if printed or seen in the View Document screen, the arrows appear as a line one half-space long.

You can erase these arrows and remove the half-lines (see Erase below), or extend the half-line into a full-space line by pressing the End key. The arrows do not show on a printed document.

When you have one space representing a single line adjacent to a space representing a double line, Corel WordPerfect inserts a character (0) to represent the intersection of the two lines. This character will not show on your printed document. To preview how the intersection will look when printed, look in the View Document screen.

Character Options

This option lets you draw with an optional character. The third character is preset as an asterisk, but you can change the character with the Change option.

For example, if you select Change (4) from the Line Draw menu, you can select one of the menu characters by typing the corresponding number. You can select Other (9) and enter the character of your choice. The chosen character appears on the menu, and you can select it by typing 3. You can use Compose to create any of the characters in the Corel WordPerfect character sets.
Dot-Matrix Lines
If you have a dot-matrix printer, vertical lines can appear broken or separated on
the printed page. This happens because the initial setting for Line Height is
Automatic, and the lines are not tall enough to connect to the lines above them.
To correct the problem, set the Line Height to .125” (8 lines per inch) (see Line
Height).

Erase
If you want to delete a line, select Erase (5) from the Line Draw menu. As you
move the cursor, lines are erased from the screen. Spaces and hard returns may
be left or added to keep the unerased part of the illustration intact.

Graphics Lines and Tables
Lines and boxes can also be created by using Graphics Lines and Tables.

Justification
Using Full Justification with Line Draw can create problems with the borders of
illustrations you create. If you use Line Draw, set Justification to Left.

Move
When you want to move through lines or illustrations without disturbing
characters, select Move (6) from the Line Draw menu. As you move the cursor,
spaces and hard returns may be added to allow the cursor to move freely.

Repeat
You can press Escape to repeat a line of a specific length. For example, if you
press Escape, type 54, and then press Right Arrow, you will draw a horizontal
line 54 characters long. The line is drawn in the direction of the arrow key you
press, but will not draw past your right or left margin.

You can also use the Home key to repeat the value of your line. For example, if
you press Home and Right Arrow, the line would extend to the right margin of
your screen. However, when a previous line is drawn that acts as a border, the
new line extends only as far as the border line. If you want to move through the
border line to the right margin, press Home,Home,Right Arrow.

Text in a Line Draw Box
The area inside a Line Draw box is filled with spaces and hard returns. If you
want to keep your structure intact while including text, you must use Typeover.

See Also: Graphics Lines; Table, Create

Line Draw 251
Line Format

Line Format options determine how text is formatted horizontally on a line, between the left and right margins.

Text automatically wraps the text at the end of each line, and determines hyphenation, justification, and line numbering.

To change a line format setting,

1. Move the cursor to where you want the setting changed.
2. Press Format, select Line (1), then select an option and make the necessary adjustments (see the options described in Notes below).
   
   Or Select Line from the Layout menu.
3. Press Exit to return to your document.

Notes

Codes
When you change any of the Line Format options, it inserts a code into your text which changes the setting from that point forward in your document. Some codes are inserted automatically at the beginning of a line, or at the beginning of a paragraph (see Auto Code Placement).

Hyphenation
The Hyphenation options determine whether words are hyphenated at the end of a line, or the region ("zone") in which a word must be located to be hyphenated (see Hyphenation and Hyphenation Zone).

Initial Codes
If you want different line format settings than the default settings, you can enter your own settings using Initial Codes in Setup (see Initial Codes). These settings will then be used each time you create a document.

Justification
You can have text centered, aligned at the left margin, at the right margin, or at both the left and right margins. Full justification is the default setting.

Line Height
This option calculates the space assigned to each line of text. It also determines the number of lines on a page. You can set your own line height or have automatic line height (see Line Height).

Line Numbering
Line Numbering numbers the lines in your text and prints a number for each line at a defined position (see Line Numbering).

Line Spacing
Line Spacing lets you increase or decrease the amount of spacing between lines. The amount you enter is multiplied by the current line height to create the new line spacing.
Margins
This option lets you set new left and right margins for your document (see *Margins, Left and Right*).

Tabs
Standard tabs are set at every one-half inch. You can use this option to change the tab settings and to select several different types of tabs (see *Tab Set*).

Widow/Orphan Protection
A *widow* is the last line of a paragraph that appears alone at the top of a page. An orphan is the first line of a paragraph that appears alone at the bottom of a page. If this option is set to Yes, widows or orphans will not appear in your text.

See Also: Hyphenation; Hyphenation Zone; Justification; Line Height; Line Numbering; Line Spacing; Tab Set; Widow/Orphan

---

**Line Height**

Corel WordPerfect uses Line Height to calculate the space assigned to each line of text. You can adjust the line height to create documents that must meet exact publishing specifications.

Normally, a line height measurement is automatically assigned to each font or attribute you use. The line height and any additional leading is automatically calculated for that font (see *Leading Adjustment* below).

When you use single spacing, you can usually measure the line height from the baseline of one line to the baseline of the next. The *baseline* is the line on which the characters are placed. Each letter sits immediately on the baseline, with the exception of letters such as *g, j, y,* and *p,* which drop below the baseline.

![Diagram of baseline and line height](Image)

Normally, the line height entry on the Format: Line menu is set to Automatic. This means that as you change fonts and attributes, the line height is adjusted to match the space required for the largest font on a line.

If some of the letters on a line are in a large font, you may not want your lines of text to be spaced according to the largest font on a line. You can then assign your own line height measurement.

A fixed line height measurement fixes the value of each Line Return code in your document (see *Return, Soft and Hard*). This causes the lines in your document to be of equal height, regardless of the font.
To set a fixed line height,

1 Press **Format**, then select Line (1).
   
   Or  \[ Select Line from the Layout menu. \]

2 Select Line Height (4), then select Fixed (2).

3 Enter a line height measurement.

4 Press **Exit** to return to the normal editing screen.

**Notes**

**Baseline Placement for Typesetters**

When you set the Baseline Placement for Typesetters entry on the Format: Printer Functions menu to Yes, you must set a fixed line height.

This places the baseline for the first line of text on the top margin of your page, which keeps the baseline constant. For example, if you place a grid over your page, all the measurements on the page are measured from the top margin and every line height has a constant value (see *Printer Functions*).

**Codes**

Changing the line height inserts a Line Height code \[Ln Height: \#\] at the beginning of the line, where \# is the current line height. It takes effect from that point in your document forward, until you change the line height again (see *Auto Code Placement*).

You can delete the line height setting by deleting the code.

To return the line height setting to Automatic, press **Format**, select Line (1), select Line Height (4), select Auto (1), then press **Exit** to return to your document. This inserts a Line Height code \[Ln Height:Auto\] which adjusts the line height automatically.

**Exceptions**

If your printer can only print 6 lines per inch, adjusting the line height will not have any effect on printed text.

**Initial Codes**

If you want to use a specific line height each time you create a document, you can enter it in Setup, Initial Codes.

**Leading Adjustment**

Leading is the extra space that is added to the height of fonts you use which inserts white space between the lines in your text. The term *leading* refers to the long strips of lead that typesetters once placed between lines of text when they prepared a page for printing.

The height of a font includes any leading which is built into that font.

There are two different types of fonts, mono-spaced fonts and proportionally-spaced fonts. For a definition of these font types, and of font sizes (points), see the *Glossary*. 

254  *Line Height*
With mono-spaced fonts, the extra leading is built into the font size by the manufacturer. Corel WordPerfect does not add any additional leading when it calculates the line height. For example, if the font size for a mono-spaced font is 10 points, then the line height is 10 points. With single spacing, that makes the distance from baseline to baseline 10 points (see Spacing below).

Using proportionally-spaced fonts, Corel WordPerfect always adds an extra two points of leading to the height of a font, in addition to any leading built into the font size by the manufacturer. For example, if the font size of a proportionally-spaced font is 10 points, then Corel WordPerfect adds 2 points, making the actual line height 12 points. With single spacing, that makes the distance from baseline to baseline 12 points (see Spacing below).

The default line height Corel WordPerfect calculates always includes the leading value added by Corel WordPerfect. This is the line height Corel WordPerfect displays in the Line Height entry on the Format: Line menu. For example, a 12 point mono-spaced font has a line height of 12 points. A 12 point proportionally-spaced font has a line height of 14 points.

Corel WordPerfect also gives you the option to add or subtract your own leading values. You can add or subtract leading from line heights by using the Leading Adjustment option on the Format: Printer Functions menu (see Printer Functions). This changes the distance from the baseline of one line of text to the baseline of the next line of text. You can also change the distance from baseline to baseline by changing the current line spacing (see Spacing below).

However, changing the Leading Adjustment or changing the line spacing does not change the line height which Corel WordPerfect assigns to a line of text. Any leading value you enter in the Leading Adjustment option on the Format: Printer Functions menu is not reflected on the Line Height entry on the Format: Line menu.

Spacing
With single spacing, the default setting for the distance from baseline to baseline is one line height. To change the line spacing, enter a different number in the Line Spacing entry on the Format: Line menu. The number you enter is multiplied by the current line height, changing the distance from the baseline of one line of text to the baseline of the next line of text (see Line Spacing).

Changing the spacing does not change the distance Corel WordPerfect calculates as a line height.

Total Lines
Corel WordPerfect uses the line height, page length, and top and bottom margins to calculate the total number of lines on a page.

See Also: Line Format; Line Spacing; Printer Functions
Line Numbering

Line Numbering numbers the lines in your text and prints a number for each line at a defined position. The actual numbers appear only when the document is printed or when you preview the document using View Document.

To turn on Line Numbering,

1. Move the cursor in your document where you want line numbering to begin.
2. Press Format, then select Line (1).
   Or □ Select Line from the Layout menu.
3. Select Line Numbering (5), then type y.
4. Select or change any option you want (see Notes below).
5. Press Exit to return to your document.

Notes

Codes
You can start and stop numbering anywhere in a document. The Line Numbering code is inserted automatically at the beginning of the paragraph (see Auto Code Placement). When you turn on Line Numbering using the above steps, you place a Line Numbering On code [Ln Num:On] in your document. If the code is not at the beginning of the line, line numbering starts on the next line. Lines will be numbered until you turn off Line Numbering again. You can do so by pressing Format, selecting Line (1), selecting Line Numbering (5), then typing n.

Line numbers are printed in the base font that is in effect where the Line Numbering On code is found (see Font).

Footnotes and endnotes are included in line numbering; headers and footers are not included.

Count Blank Lines
If this option is set to No, any lines that contain only a Hard Return code [HRt] will not be counted.

Display
The numbers that are displayed on screen are an approximation of what will be printed. When an approximation is not accurate, a “#” is displayed in the margin where the number will appear when printed.

Number Every n Lines
This option lets you print the line numbers every n number of lines, where n is the number you specify.

Position of Number from Left Edge
Using this option, you can enter the distance from the left edge of the page where you want the line numbers to appear.
Restart Number on Each Page
Selecting No for this option gives you consecutive line numbering throughout the document. If this option is set to Yes, numbers restart with each new page from 1, or from a starting number you select (see Starting Number below).

When you preview the printed page in View Document, numbers restart with every page, regardless of how this option is set. If this option is set to No, the numbers are still numbered consecutively throughout the document when it is printed.

Starting Number
Corel WordPerfect starts numbering lines from 1. If you enter a number other than one, the lines in your document will begin with that number.

See Also: Line Format

Line Spacing

Line Spacing determines the number of lines that will be inserted for each Soft Return code [SRt] and Hard Return code [HRt] in your document. Documents are single spaced unless you change the line spacing.

To change the line spacing in your document,

1  Press Format, then select Line (1).
   Or Select Line from the Layout menu.
2  Select Line Spacing (6), then enter a number (see Spacing below).
3  Press Exit to return to your document.

Notes

Codes
Changing the line spacing inserts a Line Spacing code [Ln Spacing:#] in your document where # represents the current line spacing. The line spacing changes after the Line Spacing code. Any text before the code uses the previous setting. The codes is placed at the beginning of the paragraph.

To change the line spacing of existing text, follow steps 1 through 3 above to insert a Line Spacing code immediately before the text.

Initial Codes
If you want line spacing settings other than the default settings, you can enter your own settings using Initial Codes in Setup. They will be in place each time you create a document.

Leading Adjustments
Leading is the amount of space which is added to the height of the characters in a line of text (see Leading under Line Height).
You can change line spacing by changing the amount of leading added to the Soft Return codes [SRt] or Hard Return codes [HRt] in your document (see Return, Soft and Hard and Printer Functions).

**Spacing**

Line Spacing lets you increase or decrease the amount of spacing between lines. For example, entering 2 for the line spacing doubles the current setting and creates double spacing. You can also enter any fraction to accurately adjust the line spacing.

The number you enter is multiplied by the current line height to create the new line spacing (see Line Height).

**See Also:** Line Format; Line Height; Return, Soft and Hard

---

**List Files**

Files are stored in directories. List Files lets you change the default directory and display the names of files in a directory. It is an important feature for organizing and working with files.

Using List Files, you can retrieve, delete, rename, print, or copy a file. You can also look at a file or directory, or display all files that contain the same words.

1. Press **List** to display the name of the default directory at the bottom left of your screen.
   
   *Or* Select **List Files** from the **File** menu.

2. Press **Return** to display the names of the files in the default directory.

   *or*

   Enter the name of another directory to display the names of the files in that directory.

3. Move the cursor to the name of a file, select an option from the List Files menu at the bottom of the file list, then enter any requested information (see the options listed under List Files Menu below).

   *Some options on the List Files menu do not need a file highlighted first. These options are explained under List Files Menu below.*

4. Press **Exit** to return to the normal editing screen.

---

**Notes**

**Current and Parent Directories**

At the top of the list on the List Files screen are the words “Current” and “Parent.” The “<DIR>” on the same line indicates that these are directories. The Current directory is the one currently being displayed. It is listed in the header at the top of the screen. For example, if letters/memos is displayed at the
top of the screen, memos is the current directory, and letters is the parent directory.

**File List**

The major portion of the List Files screen consists of the file list. Specific aspects of this list are displayed according to the wp.lrs file. To make changes to the file list display, see Language Resource File.

When you display the List Files screen, you can display the file list with “short”, “long”, or “detailed” filenames. Use Short/Long Display (5) on the List Files menu to display the screen the three different ways (see Short/Long Display under List Files Menu below). The appearance of the file list is one of the major differences between short and long display.

Each type of display lists the subdirectories first in alphabetical order, followed by an alphabetical listing of files. However, when long display is on, only files created in Corel WordPerfect (no UNIX, macro files, or Corel WordPerfect program files) appear on the screen. The files are alphabetized by descriptive name instead of filename.

**Detailed Display**

- Detailed Display is the default display in List Files.

There are also Long Display and Short Display. Detailed Display shows you the filename and size, the file revision date, and the number of links. It also displays the file permissions mode, the owner, and the group.

**Long Display**

- When you use long display, the information in each filename takes up one line of the list instead of two filenames per line (as in the short display). The header at the top of the screen increases by one row to display several column headings, only if you change from short display to long display.

Use Long Display to add another level of organization to your files. For example, you can give the same “Type” name to a group of similar files, then use the Find option (9) on the List Files menu to display just the files with that document type (see Find).

The Descriptive Name column lists the long document name. If you did not enter a long document name, nothing is displayed in this column.
If you have a locked document in your directory, “[Locked]” is displayed in this column instead of the long document name.

The Type column lists the long document type you entered (if any) when you saved the file with a long document name (see Environment Setup and Document Summary).

The Filename column lists the UNIX filename or directory name.

The Size column lists the size of the file or “<DIR>” if referring to a directory.

The Revision Date column lists the date and time the file or directory was revised.

**Short Display** • When you use short display, the file list is displayed with two filenames on each line. Each file or directory is identified by a filename, and the date and time the file or directory was revised. The size of the file is also displayed. An arrow at the bottom or top of the vertical line that divides the filenames indicates more files in the directory that can be scrolled onto the screen.

**Filename Patterns**

After pressing List, you can change the directory and include a filename pattern to display selected files. For example, /usr/home/*.ltr would list all files with an .ltr extension in the home directory (see Search Patterns under Find).

**Header**

The header (the bar at the top of the List Files screen) includes the current date, the time of day, the name of the directory being displayed, the size of the document on your screen, the amount of used space in the current directory, and the number of files listed. “Long” display and “detailed” display also have several column headings on the bottom line of the header (see Long Display above).

**List Files Menu**

The options on the List Files menu are described below. Before you select an option, highlight the desired file or directory by using the cursor keys (if necessary).
Change Mode • Select Change Mode (6) to give access privileges (read, write, and execute) of a Corel WordPerfect file to various users. As the creator of the document, you are called the file owner. Only the file owner or person with superuser privileges can change a file’s access privileges. The combined access privileges assigned to a file are called the file’s “privileges mode”.

Copy • Use Copy (8) to copy the highlighted file to another file or directory.
When copying to another file, you can enter a new filename to create a file or enter an existing filename, then type y to replace a file. When copying to another directory, enter a directory name, then use the same filename or include a new or existing filename with the directory.
If you mark files (see Marking Files below) before selecting this option, you will be asked if you want to copy the marked files. Type y, then enter the directory where you want them copied, or type n and you can copy only the currently highlighted file.

Delete • Select Delete (2) to delete a filename or directory. (A directory must be empty before it can be deleted.) A prompt appears asking if you want to delete the file or directory. Type y to delete it. Type another key if you do not want to delete the file or directory. Once deleted, a file cannot be retrieved.
If you mark files (see Marking Files below) before selecting this option, you will be asked twice if you want to delete the files. Type y twice to delete the marked files. If you type n with either prompt displayed, you will be asked if you want to delete the currently highlighted file. Type y to delete this file only or type n to return to the List Files menu.

Find • Use Find (9) to search for files in the current directory that meet specific conditions.

Look • If you highlight a directory on the List Files screen, you can select Look (L), then press Return to display the names of the files in that directory on the List Files screen. If you highlight a file, select Look to display the text or document summary of that file in a Look screen.

Move/Rename • Select Move/Rename (3), then enter a new filename to move or rename the highlighted file. If you enter the same filename, but specify a different path, the file is moved to another directory. If you enter a new filename, the file is renamed. If you specify a different path and enter a new filename, the file is moved and renamed. If you enter a filename that already exists, you will be asked if you want to replace that file. Type y to replace it or type n to return to the List Files menu.
If you mark files (see Marking Files below) before selecting this option, you will be asked if you want to move the marked files. Type y, then enter the directory where you want them moved, or type n and you can move or rename the currently highlighted file.
Name Search • You can move the cursor to a specific file by selecting Name Search (N), then typing the filename.

You can also use • Search to move the cursor to a specific file (see Search under Features in List Files below).

When you use this option, a “Name Search” message appears at the bottom right of the screen. When you type the first letter of the filename (or descriptive name if long display is on), the cursor moves to the first file that begins with that letter. As you continue to add letters to the name, the cursor moves to the first filename that matches the displayed letters.

You may only need to type part of the filename (or descriptive name) to move the cursor to that file. You can erase characters with Backspace. Press Return, Exit, or an arrow key to exit Name Search and redisplay the List Files menu.

You can also use this option to move the cursor to a subdirectory. After typing n, type a slash (/), then start typing the subdirectory name.

Other Directory • Use Other Directory (7) to change the default directory or create a new directory (see Directories).

Print • Use Print (4) to send a file to the printer. After selecting Print, you are asked for the pages you want printed. You can print all of the file or selected pages, including the document summary (see Print, Document on Disk for details).

If you mark files (see Marking Files below) before selecting this option, you will be asked if you want to print the marked files. Type y to print all the marked files, then enter selected pages. The same pages in each file will be printed. Type n to print the currently highlighted file.

If a file has been formatted for another printer, you will receive an error message. Typing y will print the document on the printer for which the document was created. If Corel WordPerfect cannot find your printer on the printer list, you receive an error message that requires you to select a new printer for the document or retrieve the document, then print it. Type n to not print that file. You must then retrieve the file before printing (see Print, Document on Screen for details on printing once a file has been retrieved).

Retrieve • Use Retrieve (1) to retrieve a copy of the file to your screen at the cursor position. If there is already text in the normal editing screen, a message appears asking if you want to retrieve the file into the current document. Type y to place the contents of the retrieved file at the cursor position in the document on the screen. Text below the cursor is pushed down to make room for the incoming file.

You can select this option with a UNIX text file highlighted, and the file will automatically be converted to Corel WordPerfect format and retrieved to the screen. If you save this document using the same filename, it replaces the UNIX text file and is saved as a Corel WordPerfect document. If you want
to keep the UNIX file on disk, enter a different filename when you save the
document on the screen.

If you select this option with a locked document highlighted, you will be
asked to enter the password (see Locked Documents).

**Short/Long Display** • Select Short/Long Display (5) to display a menu that
lets you switch between the short, long, or detailed display of the List Files
screen (see Long Display and Short Display under File List above). After you
select an option, the current directory name is displayed in the bottom left
corner of the screen. Press **Return** to display that directory, or enter another
directory name.

*This option can be selected with a file or directory highlighted.*

**Marking Files**
You can copy, delete, find, move, or print a group of files by “marking” each file
with an asterisk (*). Move the cursor to a file in the list and type an asterisk.
Once the files are marked, select a menu option and enter the requested
information.

You can “unmark” a file by moving the cursor to a marked file and typing
another asterisk. To mark or unmark every file on the List Files screen, press
**Mark Text** or **Home**.

As you mark files, the asterisk (*) appears to the left of the filename, and the Files
amount in the header changes to the number of files marked. The Used amount
changes from the amount of disk space used by all the files in the list to the
amount of disk space used only by the marked files.

**Redisplaying List Files**
You can press **List** twice to redisplay the most recently displayed List Files
screen. This is useful if you changed the List Files screen the last time it was
displayed (marked files or used Find to display selected files).

This feature will not display the files if you have changed the default setting for
Long Document Name. You can rewrite the currently displayed List Files screen
by pressing **Screen**.

**Features in List Files**
There are several features you can use with the List Files screen displayed. They
are described below.

**List** • You can press **List** anywhere in the List Files screen to display the
current directory name at the bottom left of the screen. You can then enter a
different directory name or press **Return** to display the names of the files in
that directory.

**Print** • You can print a list of all the filenames in the current directory list by
pressing **Print** with the List Files screen displayed. (The current directory is
the one currently being displayed on the List Files screen.) The format in
which the directory is printed depends on the type of display you selected
(short, long, or detailed).
The list is automatically sent to the selected printer (see Printer, Select).

**Search** • You can move the cursor forward or backward through the file list using Search or Backward Search. With long display on, Search looks through the Descriptive Name, Type, and Filename columns. With short display or detailed display on, Search looks through the filenames and subdirectory names. You can use patterns when searching (see Search Patterns under Find).

**Text In/Out** • You can use Text In/Out with the List Files screen displayed to import a UNIX file into Corel WordPerfect.

This feature only works when short display is on. UNIX files do not appear in long display (see Long Display under File List above).

**See Also:** Directories; Find; Find, Conditions; Look

---

**Lists**

You can include up to ten lists of figures, illustrations, tables, or maps in a document. Five numbering styles are available for each list. When a list is generated, the entries are listed in the order in which they appear in the document.

---

<table>
<thead>
<tr>
<th>Numbering style</th>
<th>Tables</th>
</tr>
</thead>
<tbody>
<tr>
<td>Import/Export Firms—Total (23)</td>
<td></td>
</tr>
<tr>
<td>HAVLA Sales (27)</td>
<td></td>
</tr>
<tr>
<td>Merchandising Results (31)</td>
<td></td>
</tr>
<tr>
<td>Net Profit (33)</td>
<td></td>
</tr>
<tr>
<td>Quarterly Results (33)</td>
<td></td>
</tr>
<tr>
<td>Market Share (34)</td>
<td></td>
</tr>
<tr>
<td>Major Distribution Centers (40)</td>
<td></td>
</tr>
<tr>
<td>Non-HAVLA Quarterly Results (43)</td>
<td></td>
</tr>
<tr>
<td>Non-HAVLA Market Share (44)</td>
<td></td>
</tr>
<tr>
<td>Non-HAVLA Major Distribution Centers (50)</td>
<td></td>
</tr>
<tr>
<td>Individual Sales (53)</td>
<td></td>
</tr>
<tr>
<td>Music Box Sales (58)</td>
<td></td>
</tr>
<tr>
<td>Price Differential (60)</td>
<td></td>
</tr>
<tr>
<td>Overhead (62)</td>
<td></td>
</tr>
<tr>
<td>Number of Employees (80)</td>
<td></td>
</tr>
<tr>
<td>Number of Branches (88)</td>
<td></td>
</tr>
</tbody>
</table>

---

To create a list,

- Mark the text you want included in the list
- Define the location and numbering style for the list
- Generate the list
Each step is exclusive of the other steps. For example, you can mark text as you write, define the list as you format the document, and generate the list before your final edit. Later, you can edit the marked text or the list definition, and regenerate the list.

The instructions for the three steps are divided into separate sections in Reference. See Lists, Mark Text; Lists, Define; and Generate.

**Notes**

**Graphics**
If you want a list of captions from figure, table, text, equation, or user-defined boxes, you do not have to mark text. You can define a list to include one of the caption types, and the appropriate captions are inserted when the list is generated (see Lists, Define).

**Master Documents**
If your document is very long, you can use Master Documents to break it into smaller subdocuments. You can then generate a list which will include any text marked in the subdocuments.

See Also: Generate; Lists, Define; Lists, Mark Text

---

**Lists, Define**

Once you have marked the text you want (see Lists, Mark Text), you must define the location and numbering style for each list.

1. Move the cursor to the place in your document where you want the list to appear.
2. If you want the list on a separate page, press Hard Page, then move the cursor to the page where you want the list generated.
3. Type a heading (title) for the list, and press Return if you want to add extra spacing.
4. Press Mark Text, select Define (5), then select Define List (2).
   
   Or Select Define from the Mark menu, then select List.
5. Enter the number of the list you want to define (1 through 10).
6. Select a numbering style for the list (see Numbering Styles below).

Repeat steps 1 through 6 for each list you want to define. Once you have defined and marked text for the list, you are ready to generate it (see Generate).
When you select a numbering style, [Def Mark:List, list#:numbering style#] is inserted at the cursor position. The list will be generated at this code. If you are using Master Documents, [Def Mark:] should be in the master document and not in one of the subdocuments.

**Graphics**

Lists 6 through 10 are pre-set to assemble captions. For example, you can follow the steps above and type 6 in step 5 to define list 6. When you generate the list, all captions for figure boxes are automatically included in the list. You do not have to mark any text.

Captions of table boxes are included in list 7, captions of text boxes are included in list 8, captions of user-defined boxes are included in list 9, and captions of equation boxes are included in list 10 (see Graphics, Create).

You can include other text or phrases in lists 6 through 10 by marking text for them (see Lists, Mark Text). When you mark text for one of these lists, the text will be included with the captions pre-assigned to the list. If you do not have captions for lists 6 through 10, you can use the list just as you would use lists 1 through 5 by marking and defining the text.

**Numbering Styles**

Numbering styles refer to the way the page numbers for each list entry are displayed. You can choose from the five numbering styles below when defining a list:

- No page numbers
- Page numbers following the entries (separated by a space)
- Page numbers in parentheses following the entries (separated by a space)
- Flush right page numbers
- Flush right page numbers with dot leaders

These five options affect the placement of page numbers in a list. If you want to change the type of number used (Arabic to Roman), you can use New Page Number. Changing the page number type with New Page Number affects all page numbers displayed in the document, and those generated in a table, list, or index. See Page Numbering.

**See Also:** Generate; Lists; Lists, Mark Text

---

**Lists, Mark Text**

If you want to create a list of captions from figure, table, text, equation, or user-defined boxes, you do not have to mark the text of the captions. The list is generated when you define the list (see Lists, Define).

*The table boxes referenced in this section are created using Graphics. They should not be confused with Tables created using the Tables features.*
Mark the text you want in the list to create other lists. If you want to create multiple lists, mentally assign each list a number before marking the text. You will be asked for this list number in step 3 below.

1. Block the word or phrase you want included.
2. Press Mark Text and select List (2).
   
   Or Select List from the Mark menu.
3. Enter the list number (1 through 10).

Repeat the steps above for each item you want included in the list. Once you have marked all the entries you want, you should define the lists (see Lists, Define).

Notes

Graphics

If you want a list of captions from graphic, table, text, equation, or user-defined boxes, you do not have to mark text. You can define a list to include one of the caption types, and the appropriate captions are included when the list is generated (see Lists, Define).

[Mark:] and [End Mark:]

When you mark text, [Mark:List, #] (where # represents the list number you entered for the marked item) is inserted before the text, and [End Mark:] is inserted after. Any codes included in the block of text (Bold, Underline, Center) are included with the text when the list is generated.

If you do not want a marked word or phrase included in a list, delete [Mark:] before generating.

See Also: Generate; Lists; Lists, Define

Location of Files

To help you efficiently organize all of the files you use or create, you can use Location of Files.

Location of Files determines where certain files are located. For example, when you spell-check a document, Corel WordPerfect looks for the dictionary file in the shlib directory. If no location is specified, the Speller may not work.

When Corel WordPerfect is installed, the Installation Program organizes your files. If you want to change the way the files are organized, you can select one of several features, including Location of Files.

Before you use Location of Files, a directory should have been created that you want to use. If you have not created a directory, you can use the UNIX mkdir command or the Other Directory option in List Files.
You should also copy the correct files to the appropriate directory (see the information pertaining to each option under Notes below to determine which files should be copied to each directory).

1 Press Setup.
   Or Select Setup from the File menu.

2 Select Location of Files (6).

3 Select the option of your choice (see the information pertaining to each option under Notes below).

4 Enter the directory, the full pathname, or the relative pathname for the option (see the information pertaining to each option under Notes below).

5 Press Exit to exit the Setup menu.

Notes

Backup Files
Enter the directory where you want the timed backup files (wp_bk1.<pid> and wp_bk2.<pid>) to be stored. If you are using Timed Backup, timed backup files are created in the directory you specify. If you do not specify a directory, the backup files are stored in the /tmp directory.

Documents
Enter the name of the directory where you want your documents to be stored. Once you enter a directory for this option, that directory becomes the default directory.

If you want to save or retrieve a document from this directory, you do not need to enter a full pathname for the document. You can move or copy previously existing documents to the directory specified for this option.

You can change the default directory with List Files. If you do, documents will be saved to the new default directory (see List Files). The documents directory overrides any default directory you enter in the Corel Shell Program.

If you want to save or retrieve a document from a directory other than the one specified as the documents directory, you must enter the complete pathname.

Graphic Files
Enter the directory where your graphics files are stored. These graphics files can be used when you retrieve a file to a graphics box.

Once you enter a directory for this option, all subsequent graphics files you retrieve are retrieved from that directory. Enter the name of the graphics file you want to retrieve in Graphics, and the file will be retrieved from the graphics files directory. You do not need to enter a full pathname for the graphics file.

You can move or copy previously existing graphics files to this directory. If you want to retrieve a graphic file from a directory other than the one specified as the graphic files directory, you must enter the complete pathname.
Invalid Drive/Path Specification

If you enter a directory that has not been created, you will receive the “Invalid Drive/Path Specification” error message. Corel WordPerfect marks the path with an asterisk and warns you that the path is invalid.

The maximum path length you can enter in Location of Files is 144 characters (or less if extended characters are used).

You can press Cancel to back out of an option and restore the previous setting.

Keyboard/Macro Files

Enter the directory where your keyboard files (files ending in .wpk) and macro files (files ending in .wpm) are located.

Keyboard files contain information for the various keyboard layouts you can use with Corel WordPerfect. Macro files contain information for macros. Some keyboard and macro files come with Corel WordPerfect, but you can also create your own files.

When you enter a directory for this option, all subsequent keyboard and macro files you define or execute are saved to or executed from that directory. Enter the name of the keyboard definition and the name of the macro before you execute the file you defined. There is no need to enter a full pathname for the keyboard or macro.

You can move or copy previously existing macros to the directory specified for this option. If you want to invoke, create, or save a macro to a directory other than the one specified as the keyboard/macro directory, you must enter a complete pathname. When you edit or execute a macro, Corel WordPerfect will look in the default directory and the directory listed in Location of Files.

Important: You should move all previously existing keyboard files to the keyboard/macro directory. Only keyboard files that exist in the keyboard/macro directory can be displayed on the Setup: Keyboard Layout screen.

Printer Files

Enter the directory where your printer files (files ending in .all and .prs) are stored. These files help Corel WordPerfect communicate with selected printers.

Once you enter a directory for this option, all subsequent printer files you define are saved in that directory. You should move or copy previously existing printer files into the printer files directory.

All printers you select are listed on the Print: Select Printer List, but only the printer files in the printer files directory are shown when you select List Printer Files.

If you want to display printer files that exist in another directory, use the Additional Printers option (see Printer, Select).

For more information on printer files, see Printer, Select.
Unless you enter a directory for downloadable fonts and printer command files on the Select Printer: Edit menu, Corel WordPerfect searches for downloadable fonts and printer command files in the Printer Files menu (see Printer, Edit).

**Spreadsheet Files**
Enter the directory where your spreadsheet files are located. Corel WordPerfect uses this directory when you import or link to a spreadsheet. For more information, see Spreadsheet, Import and Link.

**Style Files**
For the Style Files heading, enter the directory where your style files are located. These files are used when you use Style or Outline Style.

When you enter a directory for this option, all style files are created, saved, or retrieved from that directory. Enter the name of the style file when you save or retrieve a style on the Style or Outline Style menus. The file will be saved to or retrieved from the style files directory. You do not need to enter a full pathname for the style file.

When you retrieve a style file, both outline and non-outline styles appear on the Style menu. Only outline styles appear on the Outline Style menu.

You can move or copy previously existing style files to the style files directory. If you want to save or retrieve a style file to a directory other than the one specified as the style files directory, you must enter the complete pathname.

For the Style Library Filename heading, enter the filename (or the complete pathname if the library is not in the style files directory) of the file you want to use for your style library. The style library is your default list of styles and is retrieved when you enter the Style or Outline Style menu in a document that has no previously defined styles.

**Thesaurus/Spell/Hyphenation Files**
For the Main option, enter the directory where the thesaurus (wpths.us) and speller (wplex.us) dictionary files are located. These dictionaries are used with Thesaurus and Spell.

For the Supplementary heading, enter the directory where your supplementary speller dictionary files are located. They include the supplementary dictionaries you create using the Speller Utility.

See Also: Directories; List Files

---

**Locked Documents**

You can lock documents with a password using Locked Document. Once it has been locked, you cannot retrieve or print the file without knowing the password. You cannot lock directories in Corel WordPerfect.
In most situations, the password gives you the necessary security. The password does not, however, meet U.S. Department of Defense or other high-level security standards.

To lock a document with a password,

1. Press Text In/Out, then select Password (2).
   Or select Password from the File menu.

2. Select Add/Change (1).

3. Enter a password twice.

   Since the password does not appear on the screen, you must enter the same password twice to ensure that the password was correctly entered. The password limit is 23 characters. You can use Compose in a password.

4. Save the document for the lock to take effect.

Notes

Associated Files
When you lock a document, all files associated with the current editing of the document (backup files, undelete files, move files, temporary buffer files, virtual files, and the original file on disk) are also locked.

Document Protection
Locking a document prevents others from retrieving the file, but it does not protect it from being deleted. We recommend you make a copy of the document in another directory.

Find
If you use Find to search a directory, you must enter a password to have the locked document searched. You will also be asked for a password when you merge locked documents or use Look to look at a document.

Retrieve
Once a document has been locked, you must enter the password each time you retrieve the document. If a “File is Locked” message appears when you retrieve the document, you entered an incorrect password.

Text Out
When you use Text In/Out to save a document as a 5.0 document, the file remains locked. If you save the document as a 4.2 file, the file is not locked.

Unlock
To unlock a document, you must remove the password. Follow the same steps as listed above, but instead of selecting Add/Change, select Remove (2). Make sure you save the document so the change can take effect.

See Also: Retrieve; Save
Look

The Look option in the List Files menu lets you view the text or document summary of a Corel WordPerfect 8c or WordPerfect Corporation's 5.1 or 5.0 file, the text of a WordPerfect Corporation WordPerfect's 4.2 or UNIX text file, a Corel WordPerfect 8c macro description, or a list of the files in a directory.

1. With the List Files screen displayed, move the cursor to the file you want to view.

If you want to display the names of the files in a directory, move the cursor to that directory in step 1 (see Directories below).

2. Select Look (L) or press Return to display the file in the Look screen.

   *If the file is an 8c document and contains a document summary, the summary is displayed (see Document Summary below).*

3. Use the cursor keys to scroll through the text.

4. Select Next Document (1) or Previous Document (2) to display the next or previous file from the List Files screen in the Look screen.

5. Press Exit or the Space Bar to return to the List Files screen.

---

Notes

Clipboard

With the Look screen displayed, you can use Block with Shell (if you are running Corel WordPerfect under the Corel Shell) to block a portion of the document and save or append it to the Clipboard.

1. Move to one end of the block of text you want saved to the Clipboard.

2. Press Block, then move the cursor to the other end of the text you want saved.

3. Press Shell, then select Save (1) or Append (2) to save or append the blocked text to the Clipboard.

You can retrieve the contents of the Clipboard into Corel WordPerfect or any other Corel product (see Corel Shell Clipboard under Go to Corel Shell).

*This feature works only if you are also running Corel Shell.*

Cursor Movement

When you enter the Look screen, the cursor is at the bottom of the screen. You can use the arrow keys to move through the document in the Look screen. Press Right or Left arrow to display all of the document if it is wider than the screen. Screen Up, Screen Down, Page Up, and Page Down move the cursor up or down through the document one screen at a time. Home, Home, arrow keys will move the cursor to the edges of the document.

If your document is too wide to be fully displayed on the screen, press End to alternate between showing the right and left ends of the document.
You can scroll backward, forward, left, or right in a Look screen, but because you have not retrieved the file, you cannot edit the file. Type $s$ to scroll forward through the document. Press any other key to stop scrolling.

Directories
You can use Look (L) to display the files in a subdirectory of the current directory. Move the cursor to a directory ("<DIR>" appears in the Size column), then select Look or press Return. The name of that directory appears in the lower left corner of the screen. Press Return again or enter another directory name to display the names of all the files in that directory (see Filename Patterns below for details on entering a pattern at this point).

You can select Look with the Parent directory highlighted, then press Return to move one directory through the path. The path includes the root directory and all other subdirectories listed after the root directory (see Directories).

For example, if the directory currently being displayed in the List Files screen is /usr/wprc/work, selecting Look with Parent highlighted, then pressing Return will display the names of the files and subdirectories of /usr/wprc in the List Files screen. The cursor will be placed on the work subdirectory. If you highlight Parent, select Look, then press Return again, the names of the files and subdirectories of /wprc/ will be displayed in the List Files screen.

Filename Patterns • When you select Look (L) or press Return with a directory on the List Files screen highlighted, the name of the directory is displayed at the bottom of the screen with a filename pattern that includes all files in the directory.

You can press Return to display the names of all the files, or type another pattern to display the names of all the files that match that pattern. For example, entering *.ltr in place of * displays only those filenames that have a .ltr extension (see Search Patterns under Find for details on filename patterns).

Document Summary
The appearance of the Look screen changes if you look at a document that contains a document summary. If the document summary contains only the document name (and type if you are looking at an 8c document), the Look screen appears the same as when there is no document summary. The header increases to two lines to include the long document name, the document type, and the date of creation.

If you create a document summary with more than the name and type, the document summary is displayed in the Look screen instead of the text of the document. A new menu appears at the bottom of the screen when the document summary is displayed (see Look Menu below for details on the menu displayed when there is no document summary, or the long document name and type in the summary). The options are explained below.

Look at Text • Select this option (3) or press Down Arrow to display the text of the document in the Look screen. If you want to return to look at the document summary, select Look at Document Summary (3).
Next • This option (1) is the same as the Next Document option on the regular Look screen (see Look Menu below).

Previous • This option (2) is the same as the Previous Document option on the regular Look screen (see Look Menu below).

Print Summary • Select this option (4) to send the document summary to the printer currently selected.

Save to File • Select this option (5), then enter a filename to save the document summary to a file. The entire summary is included in the file, the UNIX filename (including the path) and type of system that created the document.

If you enter a filename that already exists, you can choose to Replace (1) the existing file or Append (2) the document summary to the existing file.

Header
The Look screen has a header at the top of the screen. It contains information about the file displayed, such as the filename, the revision date and time, and whether it is an 8c file.

If you select Look (L) on a file that contains a document summary, the header changes. A second line is added which includes the long document name and type, and the date the file was created.

Locked Documents
If you select Look (L) with a locked file highlighted (see Locked Documents), you are asked to enter the password of the file. If you cannot remember the password, you cannot look at the contents or document summary of the file.

Look Menu
When you select Look (L) with a file highlighted, the text of the file appears in the Look screen, and a menu appears below the text. The options on this menu are described as follows.

   • Next Document • This option (1) displays the text or document summary of the next file from the List Files screen in the Look screen. You can select this option until the end of the file list is reached.

   • Previous Document • This option (2) displays the text or document summary of the previous file from the List Files screen in the Look screen. You can select this option until you reach the beginning of the files on the file list. When you come to a directory, you are returned to the List Files screen.

Search in the Look Screen
You can search forward or backward for characters or words in the Look screen using •Search or •Search. You cannot search while in the document summary. You must have the text of the file displayed in the Look screen (see Search).

When you display the Look screen, the cursor is positioned at the bottom of the screen. To search through the text displayed in that screen, move the cursor to the top of the screen.

See Also: Directories; List Files
Macros

Use Macros to record keystrokes and play them back, much like the re-dial feature on a telephone. For example, you may perform one of the following tasks several times a day:

- Type a closing to a letter.
- Back up a directory of files.
- Replace several different items in a document.
- Print and save a file.
- Send a “Go” to your printer.
- Print several copies of a document.

Instead of repeating keystrokes manually each time you need to perform the task, you can create a macro to do it for you.

You can also use macros for complex tasks (see Macros, Macro Editor). For most situations you will only need basic macro features. For example, each of the tasks listed above could be included in a macro without using the macro programming language.

There are two steps to using basic macro features. First, you need to define the macro (create it), and then you can execute the macro (run it). For details on these two steps, see Macros, Define and Macros, Execute.

If your macro needs are more sophisticated, and you have a fundamental understanding of logical structures and variables, you may want to explore the macro editor and macro programming language (see Macros, Macro Editor). The language includes such features as the following:

- External condition handling
- Logical structures (for example, if/then, case)
- Subroutine calls
- User-defined prompts and menus
- Variable assignment, storage, and retrieval

Notes

Keyboard Layout

You can also create macros using Keyboard Layout. These macros are assigned to specific keys on the keyboard and can be executed by simply pressing the assigned key.

One advantage to using keyboard layout macros is that you can have multiple keyboard layout definitions, each with different macros assigned to the same keys. For example, you might have one keyboard layout where Quick Macro m marks items for an index and another keyboard layout where Quick Macro m moves paragraphs to document 2. Then depending on the task you need, you can change the keyboard layout for the appropriate macro.

Another advantage to using keyboard layout macros is that they are all stored in one keyboard definition file. If you define multiple macros using Macro, each macro is its own file. Multiple macros in individual files take up more disk space than the same macros in one keyboard file.
Use Macro Conversion to convert 4.2 macros to 8c. You can also break and chain macros that are then too large to edit in the Macro Editor (see -m under Startup Options, and Large Macro Files below).

WordPerfect Corporation’s WordPerfect 5.0 and 5.1 macros do not require conversion. However, because the 5.0 keystrokes to accomplish certain tasks may have changed, you may need to edit the macro in the Macro Editor.

When converting a 4.x macro, the portions of the 4.x macro containing text, cursor keystrokes, and functions that haven’t been changed for Corel WordPerfect 8c are converted directly to the new format. Those that have changed with 8c are converted to comments (see {;}comment˜ in Appendix K: Macros and Merge, Programming Commands). Once you have converted the macro, you can retrieve it in the Macro Editor (see Macros, Macro Editor) and make any additional changes.

To use the Macro Conversion Program to convert a 4.x macro to an 8c macro,

1 Go to UNIX.

2 Change to the directory where macrocnv is located.

The Installation Program copies this file to the wpbin directory.

3 Enter macrocnv macroname (where macroname is the name of the macro to be converted) to start the program and the macro conversion. (Be sure to enter the full pathname of the macro if it is not in the current directory. You need not enter the .mac extension.)

When the conversion is finished, you will see “Done” appear on the screen, along with a report on the macro conversion. Portions of the macro that could not be converted (or which require additional modification to replicate its function in 5.x) are described. To make further modifications to the macro, use the Macro Editor (see Macros, Macro Editor).

The output file generated in the conversion has the same name as the original macro file, except with a “.wpm” extension. It is stored in the same directory as the original file, which remains intact in the directory.

If a file already exists in the directory with the same name as the new output file, you will be asked before the conversion starts whether you want to replace the file. You may either replace it or enter a new name for the output file.
Notes

5.0 vs. 8c
WordPerfect Corporation’s WordPerfect 5.0 macros do not require conversion through the Macro Conversion Program to run with Corel WordPerfect 8c. However, because the 5.0 keystrokes to accomplish certain tasks have changed with Corel WordPerfect 5.1, you may need to edit the macro in the Macro Editor (see Macros, Macro Editor) to make it function properly in Corel WordPerfect 8c.

WordPerfect Corporation’s WordPerfect 4.x macros that you convert with the Macro Conversion Program can be run in 8c. (You will still have to edit the portions of the macro that were not converted in the Macro Editor.)

It is possible to run macros created in Corel WordPerfect 8c in WordPerfect Corporation’s WordPerfect 5.0; however, commands that are specific to 5.1 and keystroke processes which changed from 5.0 to 5.1 will not function correctly.

Large Macro Files
If you defined a macro in WordPerfect Corporation’s WordPerfect 4.x that was very large, it may not fit in the Macro Editor in Corel WordPerfect 8c. The Macro Conversion Program checks the size of the macro it is converting, and if it is too large for the Macro Editor, it automatically breaks it into smaller files (about 4.5K in size) which are chained together. (For an explanation of chained macros, see Chaining Macros under Macros, Define, and Chaining, Nesting, and Substituting under Notes in Appendix K: Macros and Merge, Programming Commands.)

The resulting 8c macro files are named with the same filename as the input file, except a number is appended to the end of the filename. For example, if you converted a very large WordPerfect Corporation’s WordPerfect 4.2 macro called doit.mac, the resulting Corel WordPerfect 8c macro files would be named doit1.wpm, doit2.wpm, doit3.wpm, and so on. Since the Macro Conversion Program chains the macros together, executing doit1.wpm in Corel WordPerfect 8c would automatically execute doit2.wpm, then doit3.wpm, and so on.

Corel WordPerfect 8c macros defined in the normal editing screen can become too large to fit in the Macro Editor. You can use the Macro Conversion Program with the -m startup option to break and chain them. See -m under Startup Options below.

Multiple Files
If you want to convert several macro files at once, use the wildcard character (?) to represent a single character, or * to represent zero or more characters) in the name of the macro file to be converted. For example:

* Would convert all the macros in the directory.
search? Would convert all the macros named “search” followed by a single character.
search* Would convert all the macros named “search” followed by zero or more characters.
Startup Options

-h • This option displays helpful information about the Macro Conversion Program. To use the option, enter macrocnv -h at the UNIX prompt.

-m • If you define a macro at the normal editing screen in 8c, it may be so large that it will not fit in the Macro Editor. If you want to edit the macro in the Macro Editor, use the Macro Conversion Program with this startup option to break the macro into smaller files which are then chained together. See Large Macro Files above for more information on breaking and chaining large macro files.

Important: You should not use this startup option for 4.x macro files since the Macro Conversion Program breaks and chains 4.x macros automatically. This option is for 5.x macros only.

WARNING: Do not use the -m startup option with the Macro Conversion Program to try to break and chain macros that use subroutines (see Subroutines in Appendix K: Macros and Merge, Programming Commands) or any other control direction commands (such as IF, CASE, WHILE, and so on). The Macro Conversion Program breaks and chains macros using a sequential order of commands. Macros whose commands are not meant to be executed in the same order they occur in the file are likely to be non-functional after the Macro Conversion Program breaks and chains them.

-o • This option overwrites existing .wpm files with the newly generated macro files of the same name without a warning prompt.

-p • When you run the Macro Conversion Program, a report is written to the screen. This startup option lets you write the report to a file instead of to the screen. In addition, the report sent to a file contains a representation of the original 4.x macro, with notations of the commands that did not convert or that will need modification.

If you want the report written to a file, enter the following at the UNIX prompt:

```
macrocnv -p macroname >filename
```

where macroname is the name of the macro to be converted, and filename is the name of the file where you want the report written.

See Also: Macros; Macros, Define; Macros, Execute; Macros, Macro Editor; Appendix K

---

**Macros, Define**

You can create a macro in the normal editing screen or in the Macro Editor. To use the normal editing screen,

1 Press Macro Define.
Select **Macro** from the **Tools** menu, then select **Define**.

2 Enter the name for the macro.

You can also choose a Quick Macro key or you can just press **Return** to name a macro (see Naming Macros below).

3 Enter a brief description of the macro (see Macro Descriptions below).

or

Press **Return** to define the macro without a description.

4 Type the keystrokes you want recorded.

5 Press **Macro Define**.

Or  Select **Macro** from the **Tools** menu, then select **Define**.

The keystrokes are saved in a file in the keyboard-macro directory unless you specified a full path when naming the macro. The default setting for the keyboard-macro directory is the current default directory, unless you have changed the pathname in Setup: Location of Files.

A macro file is automatically saved with a .wpm extension.

If you try to name a macro with a name that you have already used, you can replace or edit the original macro. If you select Replace (1) and type y for Yes, the original macro definition is deleted, and you can enter a description for the new macro, then enter keystrokes for the new definition. If you select Edit (2), you can then edit the existing macro. If you select Description (3), you can edit the macro description before entering the macro editing window (see Editing Macros below).

**Notes**

**Chaining Macros**

Chaining macros means that when one macro ends, the next macro starts. You can chain macros both with and without using the macro language. The following example describes how to chain macro B to macro A without using the macro editor.

1 Press **Macro Define** to begin defining macro A.

Or  Select **Macro** from the **Tools** menu, then select **Define**.

2 Enter a for the macro name, then enter a macro description (or just press **Return**).

3 Type the keystrokes for macro A.

4 Press **Macro** to begin chaining macro B to macro A.

Or  Select **Macro** from the **Tools** menu, then select **Execute**.

5 Enter b for the macro name.

6 Press **Macro Define** to end defining macro A.

Or  Select **Macro** from the **Tools** menu, then select **Define**.
If you have not already done so, define macro B.

Pressing Macro while defining macro A (or any macro) records the keystrokes for starting the macro, but does not start macro B. Only when you actually run macro A does Corel WordPerfect start macro B.

When you start macro A, Corel WordPerfect runs through all the keystrokes in macro A before starting macro B.

You can expand a simple chain to include several macros by continuing to start one macro while recording another. This takes some careful planning to make sure the macros are chained in the correct order. Start macro B while recording macro A, start macro C while recording macro B, and so on.

If you want to chain a Quick Macro (see Naming Macros below), you must first press Macro, then the Quick Macro keystroke.

You can also nest macros (execute a macro anywhere within another macro). See Nesting Macros below.

Converting Macros

Portions of WordPerfect Corporation’s WordPerfect 4.2 macros containing text, cursor keystrokes, and functions that did not change in 5.1 can be converted to Corel WordPerfect 8c with the macroconv program (see Macros, Conversion Program). Macros created in 8c will only work in version 5.0 if no new features have been included in the macro, and if the keystrokes required to accomplish the task are the same in both versions.

If you create a 8c macro using features that are not available in 5.0, these features will be represented by a box character in the 5.0 Macro Editor window.

Editing Macros

Corel WordPerfect provides a Macro Editor where you edit macros, whether the macros are simple or complex. However, with some fundamental macros it may be easier to re-create the macro rather than go through the steps of editing it.

If you want to edit a macro, press Macro Define, enter the macro name (you don’t need to type the .wpm extension), then select Edit (2). You are placed in the macro editing window. You can now edit the macro by deleting codes as desired and pressing function keys to enter function codes. You can also enter programming commands with the Macro Commands key. See Macros, Macro Editor and Appendix K: Macros and Merge, Programming Commands for details.

To edit a macro name, press Macro Define, enter the macro name, then select Description (3). Edit the description, then press Return and you are placed in the macro editing window. To exit the macro editing window, press Exit.

To go directly to the macro editing window to create a macro, press Home, Define Macro, enter a new macro name, then enter a description (or press Return).
Ending a Macro Definition
You can press Macro Define to stop defining a macro—even at a message or in a menu. Starting a merge while defining a macro also ends a macro definition.

Macro Commands
The Macro Commands key displays a different menu depending upon the state of Corel WordPerfect. If you press it while in the Macro Editor, a list of macro language commands appears (see Appendix K: Macros and Merge, Programming Commands for details). If you press it while at a document screen, it lets you enter a variable for macro programming. If you press it while Block is on, it assigns the contents of the block to a variable you specify. And if you press it while defining a macro, the following four options become available.

Pause • You can insert a pause so you can enter text from the keyboard while the macro is running. Select Pause (1). Then, you can type any keystrokes (except Return), and these keystrokes will not be included in the macro. Press Return to insert the pause. Continue defining the rest of the macro.

When the macro is running, Corel WordPerfect pauses for an entry from the keyboard. You can then type any text and press Return to continue running the macro.

Display • By default, a macro executes a task without displaying the various prompts and screens included in the task. If you want to see the screen change as the macro executes, turn on the display while defining the macro.

To do so, press Macro Commands, select Display (2), then type y.

Assign • The macro language lets you assign values to variables. The Macro Commands key lets you assign variables without being in the Macro Editor. Select Assign (3), enter the variable name or number, then enter the value you are assigning to the variable.

If you highlight a block of text before selecting Assign, you are asked for the variable name. When you enter the variable name, the contents of the block are assigned to the variable (most codes included in the block will not be included in the variable).

For details on variables, see Appendix M: Macros and Merge, Variables.

Comment • The macro language lets you insert comments to document your macro. These comments can be seen in the macro editing window but do not disturb macro execution. You can insert a comment while defining a macro using the Macro Commands key. Select Comment (4), type the text of the comment, then press Return. The comment is inserted into the macro but can only be seen in the macro editing window. For details on macro comments, see Appendix K: Macros and Merge, Programming Commands.
**Macro Descriptions**
A macro description details the contents of a macro. It is displayed at the top of the macro editing screen (see Macros, Macro Editor). It is also displayed if you select Look in List to view the contents of a macro. The description can be 39 characters.

You do not have to enter a description for a macro.

**Naming Macros**
When you are prompted to enter a name, you have three options:

- Enter 1 to 160 characters.
- Use Quick Macro (choose Help then press q to see the Quick Macro keys on your terminal).
- Press Return.

Corel WordPerfect adds a .wpm extension to all macro names.

The advantage to using a Quick Macro name is that you can simply press the Quick Macro keystroke without pressing the Macro key to run the macro.

If you name a macro with the Return key, Corel WordPerfect creates the macro in the temporary directory, naming it _wp_<process id>_.wpm. However, you do not have to enter this name when you execute the macro. Just press Macro, then Return. The macro file is deleted from the temporary directory when you exit Corel WordPerfect.

Macros are saved as files in the keyboard-macro directory and can be copied like other files. If no directory is specified using Location of Files, the macro is saved in the current directory.

You can define macros using full pathnames (for example, /usr/home/wpfiles). This is useful if you want to store macros in directories other than the keyboard-macro directory. Remember, if you give a macro a full pathname when you create it, you will most likely have to use that full pathname when you execute the macro.

**Nesting Macros**
You can use Quick Macros to nest one macro inside another macro. You do this by pressing Quick Macro, then the letter of the macro while you are defining another macro. Unlike chained macros, Corel WordPerfect does not wait until it completes the first macro before executing the nested macro. Rather, it executes the nested macro at the point it is inserted, and then returns to the original macro after executing the nested macro.

**See Also:** Macros; Macros, Execute; Macros, Macro Editor
The instructions for executing (running) a macro depend on the way you named the macro when you defined it. If you named a macro using the Quick Macro key (see Macros, Define), you can execute it by choosing the keystrokes for Quick Macro on your terminal. You do not have to press the Macro key.

If you named the macro any other way,

1. Press **Macro**.
   
   *Or* Select **Macro** from the **Tools** menu, then select **Execute**.

2. Enter the macro name, or press **Return** (if you named the macro with the Enter key).

When you enter the macro name, you do not have to include the .wpm extension.

### Notes

**-m Startup Option**

You can have a macro execute automatically each time you start Corel WordPerfect using the -m startup option (see Appendix O: Startup Options).

**Pathnames**

You can execute macros using full pathnames (for example, /usr/home/wpfiles). This is useful if you want to execute macros from directories other than the keyboard-macro directory (see Location of Files for details on the keyboard-macro directory).

**Macro Location**

When you execute a macro, Corel WordPerfect searches four directories to find the macro:

- First, Corel WordPerfect searches the keyboard-macro directory that is specified in the Setup menu.
- If the macro is not there, Corel WordPerfect searches in the current directory.
- If the macro is not there, Corel WordPerfect checks the home directory for the macro.
- If the macro is not there, Corel WordPerfect looks in the shlib directory. If the macro is not there, the error message “File not found” is displayed, and the macro is not executed.

**Repeating a Macro**

You can use Repeat to repeat a macro a specific number of times.

1. Press **Repeat**, and type the number of times you want the macro repeated.

2. Press **Macro**.
   
   *or*

   If you named the macro with the Quick Macro key, press the Quick Macro combination you gave it, then skip step 3 below.
3. Enter the macro name.

The macro executes the specified number of times.

**Stopping a Macro**

You can press **Cancel** to stop a macro while it is running. If you include a search in a macro, the macro stops when it can no longer find the searched-for item. A macro also stops if an error is detected.

You can change these three conditions using advanced macro commands. For details, see *Appendix K: Macros and Merge, Programming Commands*.

**See Also:** Macros; Macros, Define; Macros, Macro Editor

---

**Macros, International Interface**

Some menus have options that are chosen by mnemonic letter only and not by number. This can create problems for macros written in one language and running in another because the mnemonics will not always coincide. For example, the mnemonic for Number of Copies on the Print menu is **N** in English and Italian (Numero di Copie), but **A** (Aantal Exemplaren) in Dutch. To help you avoid this difficulty, Corel WordPerfect provides an optional international interface for mnemonics used in macros.

As a general rule, treat mnemonic options in international macros as though they were numbered in sequence with the numbered options. For example, the English Print menu contains eight numbered options followed by nine mnemonic-only options. Select 9 for the first mnemonic-only option (Select Printer). Instead of using two-digit numbers for the international macro interface, use the following characters which have been chosen to represent the numbers 10 through 18.

<table>
<thead>
<tr>
<th>Number</th>
<th>Represented By</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>forward slash (/)</td>
</tr>
<tr>
<td>11</td>
<td>back slash ()</td>
</tr>
<tr>
<td>12</td>
<td>colon (:)</td>
</tr>
<tr>
<td>13</td>
<td>asterisk (*)</td>
</tr>
<tr>
<td>14</td>
<td>question mark (?)</td>
</tr>
<tr>
<td>15</td>
<td>plus (+)</td>
</tr>
<tr>
<td>16</td>
<td>minus (-)</td>
</tr>
<tr>
<td>17</td>
<td>less than (&lt;)</td>
</tr>
<tr>
<td>18</td>
<td>greater than (&gt;)</td>
</tr>
</tbody>
</table>

For any YES/NO menu option, you can use a plus (+) for yes and a minus (-) for no.

Name Search is on several menus in different positions. It is the 10th menu item on the List Files menu, but sixth on the Format Paper Size/Type menu. To
maintain consistency in macros, Name Search is always represented by the equal sign (=).

Macros, Macro Editor

Macros lets you create and edit macros using a programming language. Macro programming is done in the Macro Editor.

The Macro Editor is a special editing window that shows you the individual commands (keystrokes) of your macro. You can insert macro programming commands, keystroke commands, editing keys, and text into your macro. Each command is displayed in braces ({}). Characters and numbers appear without braces.

Below you are shown how to define a new macro and how to edit an existing macro.

Defining a Macro

There are two ways to define a new macro. You can define the macro from the keyboard (see Macros, Define), or you can define it in the Macro Editor.

To use the Macro Editor when defining a new macro,

1 Press Home, then press Macro Define to begin defining the macro.

2 Enter the name of your macro. (You can enter a pathname if you want the macro in a directory other than the default.)

3 Enter a macro description (up to 39 characters).

or

Press Return if you do not want a description.

You are now in the Macro Editor. The Macro Editor screen displays the name of the macro, its description (your explanation of its function), and the keystrokes and commands that you insert.
Create the macro (see Inserting Text, Inserting Macro Programming Commands, and Inserting Editing Keys and Keystroke Commands below).

Press Exit to end macro definition and save the macro.

You cannot use the pull-down menu for rapid entry into a macro.

If you do not want to save your macro, press Cancel instead of Exit. Corel WordPerfect asks if you want to cancel changes. If you choose No (the default), you remain in the Macro Editor. If you choose Yes, your changes are not saved and you are taken back to the normal editing screen.

When you cancel a new macro, any editing that you may have done is disregarded. However, a macro with the name you gave it will exist, containing nothing but a [DISPLAY OFF] command.

The [DISPLAY OFF] command is inserted at the beginning of all macros. (For information on the [DISPLAY OFF] command, see Appendix K: Macros and Merge, Programming Commands.)

However, if a macro that you define from the normal editing screen ends at a menu (for example, Print) or contains a [Pause], the [DISPLAY OFF] command is deleted to let you see the menu.

If you define a macro from the normal editing screen, some commands that you insert from the menu bar are treated specially. If the command displays a menu (for example, Font), the Macro Editor inserts a [MENU OFF] before the command and a [MENU ON] after the command (for example, [MENU OFF]Font[MENU ON]). Turning the menu off prevents any menus from flashing on the screen when you run the macro. See the descriptions for the [MENU OFF] and [MENU ON] commands in Appendix K: Macros and Merge, Programming Commands.

Editing an Existing Macro

There are two ways to enter the Macro Editor when editing an existing macro.

To go directly into an existing macro,

1. Press Home, then press Macro Define.

You are prompted for a macro name and a macro description, then you enter the Macro Editor.

To edit an existing macro without using the rapid entry,

1. Press Macro Define.

   Or Select Macro from the Tools menu, then select Define.

2. Enter the name of your macro.

You are given the option of replacing the old macro:

yourmac.wpm Already Exists: 1 Replace; 2 Edit; 3 Description: 0

If you choose Replace (1), you are asked to confirm that you really want to replace your macro.
Replace yourmac.wpm? No (Yes)

If you choose No (default), you are returned to the normal editing screen. If you choose Yes, your old macro is deleted, you are prompted to enter a description, then you are placed in the normal editing screen where you can begin defining the new macro.

If you choose Edit (2), the macro displays and you can edit it.

If you choose Description (3), you are prompted for your description, then placed in the Macro Editor.

Inserting Text

Once you are in the Macro Editor, you can insert and delete text, keystroke commands, and macro commands, and format your macro.

You can insert text by simply typing it at the desired location. To move your cursor through the macro, use the cursor control keys as you would in the normal editing screen. The cursor keys, as well as Enter, Tab, Page Up, Page Down, Delete, Backspace, and End, perform their normal functions.

Spaces that you type appear as centered dots in the macro editing screen.

You can use Tab and Enter to make your macro more readable. The tabs and hard returns do not affect the execution of your macro. (For details, see Inserting Editing Keys and Keystroke Commands below.)

Comments can also help make a macro easier to read and edit. See the \{;/command \command description in Appendix K: Macros and Merge, Programming Commands.

Typeover cannot be used in the Macro Editor.

Inserting Macro Programming Commands

You can insert both macro programming commands (for example, {DISPLAY ON}, {IF}) as well as keystroke commands (for example, {Spell}, {Tab}) into your macro.

All commands are bolded and enclosed in braces. However, commands that are assigned to a keystroke are shown in initial capital letters (\{Spell\}), while the macro programming commands (those commands not assigned to a keystroke) are shown in all capital letters (\{DISPLAY ON\}).

To insert macro programming commands into your macro,

1 Move the cursor to where you want to insert the command.

2 Press Macro Commands. You can scroll to your desired command or you can use Name Search.

3 When you have highlighted the command you want, press Return to insert it into your macro.

Press Cancel, Escape, or Exit to exit the Macro Commands menu without inserting a command.
You can use the cursor keys to move around in the Macro Commands menu. You can also press the Space Bar to move the cursor to the top of the menu.

Name Search is active while you are in the Macro Commands menu. To use Name Search, start typing the name of the command you want to insert. (You do not need to type the opening brace ({}), just the letters.) The letters you type appear in the lower left corner of your screen, and the cursor moves to the command that most closely matches those characters. You can press Return to insert the command, or you can press one of the arrow keys to reset Name Search (so that you can type characters for another command) and to move the cursor.

You cannot simply type a macro command surrounded by braces—it must be retrieved from the Macro Commands menu. Each macro command that you insert into your macro is treated as a single unit by the Macro Editor. Each command is deleted with a single delete.

Most commands require a specific syntax. For more information, see Appendix K: Macros and Merge, Programming Commands.

Inserting Editing Keys and Keystroke Commands
Besides using the editing keys (for example, Enter, Arrows, Home, Backspace, PgUp) for editing your macro, you may want to insert editing key commands into your macro.

You must enter the Command Insert mode before pressing the key to insert the following commands: macro commands, variables, certain control characters, keyboard macro names, and cursor keys.

To enter Command Insert mode, either press Ctrl-v, which places you in Command Insert mode for the following keystroke, or press Macro Define, which places you in Command Insert mode until you press Macro Define again.

In Command Insert mode, the command for any key you press is inserted into the macro. For example, to insert the {Enter} command into your macro, press Ctrl-v, then press Return.

If you only need to insert one Tab, cursor key, and so on, into your macro, press Ctrl-v, then the key.

If you will be inserting many of these commands, enter the Command Insert mode by pressing Macro Define. While in this mode, all keys you press will insert the key command. When you want to use the editing keys to edit, press Macro Define again to return to edit mode.

You can insert most of the function key commands simply by pressing the corresponding feature key. For example, press Spell to insert the {Spell} command into your macro. Or, if you want to have your macro view a document, press Print, then type v. Your macro should then look like this: {Print}v

However, there are four functions that are executed when you press the corresponding keys: Macro Define (toggles Command Insert mode as described...
above), Cancel, Help, and Exit. You can insert these keystroke commands by entering Command Insert mode, then pressing the function key. You can only insert {Macro Define} into your macro by first pressing Ctrl-v, then pressing Macro Define.

If you want to insert the commands associated with a macro assigned to a key on the current keyboard layout, press Ctrl-v, then press the key.

**Notes**

**Combining Macros**
You can insert the contents of a macro into other macros by assigning it to a key (see Action under Keyboard Layout, Edit). The commands of the macro are inserted into the Macro Editor when you press Ctrl-v, key.

**Macro Size Limit**
The Macro Editor has a limit on the size of macro that it can hold. If you are editing a macro, the Macro Editor simply stops inserting your commands or text when you reach this limit. You can use [CHAIN] or [NEST] to overcome this limitation (see Appendix K: Macros and Merge, Programming Commands).

If you have created a macro (for example, in the normal editing screen) that is larger than can fit in the Macro Editor, an error message appears, “Not enough memory,” and then you are returned to the normal editing screen. In order to edit such large macros, use the -m option of the Macro Conversion Program. This option breaks your large macro into smaller macros and then chains them together.

**Message Display**
You can position your cursor and text on the screen, as well as change attributes of the text that you display. See Macros, Message Display for details.

**Programming Commands**
There is a wide range of programming commands that you can use in your macro. See Appendix K: Macros and Merge, Programming Commands for details.

**Variables and Expressions**
You can assign values to variables and store text in variables. See Appendix J: Macros and Merge, Expressions, and Appendix M: Macros and Merge, Variables.

**See Also:** Macros; Macros, Conversion Program; Macros, Define; Macros, Execute; Macros, Message Display; Appendix I; Appendix J; Appendix K; Appendix M

---

**Macros, Message Display**

You can use control characters to affect the way the messages in the {CHAR}, {INPUT}, {PROMPT}, {STATUS PROMPT}, and {TEXT} macro commands are displayed on the screen. (See Appendix K: Macros and Merge, Programming Commands for details of the above commands.) For example, you can use
control characters to determine the attributes of text in the message (such as bolding or underlining), or to place messages at different locations on the screen.

The following screen shows an example of how you might display a message using these control characters.

The characters are divided into three categories: Attribute On/Off Characters, Attribute Characters, and Cursor Positioning Characters. Some of the characters have different functions depending on where they appear in the message string (for example, which character precedes them). The tables below describe how each control character functions.

In the tables below, the Character column lists the control characters you should press to insert the commands listed in the second column (the Shown As column). In the Character column, ^letter means to hold down the Ctrl key, then press the letter. You can also press the key that corresponds to the command. For example, to display the {Home} command, you can press either ^v followed by ^h (Ctrl-v, Ctrl-h), or Ctrl-v followed by Home.

In order to insert certain commands into your macro, you must be in Command Insert mode (see Inserting Editing Keys and Keystroke Commands under Macros, Macro Editor). The appropriate commands are listed following each table.

**Attribute On/Off Characters**
The following characters control attribute display:

<table>
<thead>
<tr>
<th>Character</th>
<th>Shown As</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>^N</td>
<td>{^N}</td>
<td>Turn on display attribute (followed by attribute character) (see Attribute Characters below).</td>
</tr>
<tr>
<td>^O</td>
<td>{^O}</td>
<td>Turn off display attribute (see Attribute Characters below).</td>
</tr>
<tr>
<td>^Q</td>
<td>{^Q}</td>
<td>Turn off all display attributes. (To insert {^Q}, press Ctrl-v,q.)</td>
</tr>
<tr>
<td>^R</td>
<td>{^R}</td>
<td>Turn on reverse video.</td>
</tr>
<tr>
<td>^S</td>
<td>{^S}</td>
<td>Turn off reverse video. (To insert {^S}, press Ctrl-v,s.)</td>
</tr>
<tr>
<td>^T</td>
<td>{^T}</td>
<td>Turn on underline.</td>
</tr>
</tbody>
</table>
### Character Shown As Action

<table>
<thead>
<tr>
<th>Character</th>
<th>Shown As</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>^U</td>
<td>{^U}</td>
<td>Turn off underline.</td>
</tr>
<tr>
<td>^V</td>
<td>{^V}</td>
<td>Turn on mnemonic attribute (the attribute selected with the Display menu of the Setup key). Turn off with ^Q.</td>
</tr>
</tbody>
</table>

**Important:** To insert {^V} into your macro, you must be in Command Insert mode or press Ctrl-v twice.

#### Attribute Characters

The following control characters turn a display attribute on or off when they are preceded by {^N} or {^O}. To turn on an attribute, precede the appropriate control character with {^N}. To turn off the attribute, precede the control character with {^O}. The attribute is displayed with the settings you have selected on the Screen Attributes menu on the Setup key (see Colors/Fonts/Attributes).

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Character</th>
<th>Shown As</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blink</td>
<td>^P</td>
<td>{^P}</td>
</tr>
<tr>
<td>Bold</td>
<td>^L</td>
<td>{Del to EOP}</td>
</tr>
<tr>
<td>Double Underline</td>
<td>^K</td>
<td>{Del to EOL}</td>
</tr>
<tr>
<td>Fine Print</td>
<td>^D</td>
<td>{^D}</td>
</tr>
<tr>
<td>Italics</td>
<td>^H</td>
<td>{Home}</td>
</tr>
<tr>
<td>Large</td>
<td>^B</td>
<td>{^B}</td>
</tr>
<tr>
<td>Outline</td>
<td>^G</td>
<td>{^G}</td>
</tr>
<tr>
<td>Redline</td>
<td>^J</td>
<td>{Enter}</td>
</tr>
<tr>
<td>Reverse Video</td>
<td>^Q</td>
<td>{^Q}     (To insert {^Q}, press Ctrl-v.q.)</td>
</tr>
<tr>
<td>Shadow</td>
<td>^I</td>
<td>{Tab}</td>
</tr>
<tr>
<td>Small</td>
<td>^C</td>
<td>{^C}</td>
</tr>
<tr>
<td>Small Caps</td>
<td>^O</td>
<td>{^O}</td>
</tr>
<tr>
<td>Strikeout</td>
<td>^M</td>
<td>{^M}</td>
</tr>
<tr>
<td>Subscript</td>
<td>^F</td>
<td>{^F}</td>
</tr>
<tr>
<td>Superscript</td>
<td>^E</td>
<td>{^E}</td>
</tr>
<tr>
<td>Underline</td>
<td>^N</td>
<td>{^N}</td>
</tr>
<tr>
<td>Very Large</td>
<td>^A</td>
<td>{^A}</td>
</tr>
</tbody>
</table>

**Important:** To insert {Del to EOL}, {Home}, {Enter}, or {Tab}, you must be in Command Insert mode.

The following example illustrates one use of underlining.

```plaintext
|ASSIGN|name="Hemingway"
|CHAR|1|is*the*author*{^N}{^N}|[VARIABLE]name | {^O}|{^N}|{Y/N}:
```
The word “Hemingway” is assigned to the variable name. The \texttt{\{CHAR\} \{\textbackslash H\}} command then displays the following message at the bottom of the screen:

\begin{center}
In the author Hemingway.\end{center}

The first \texttt{\{\{\}} signals that an attribute character follows. The second \texttt{\{\}} turns on underline. Notice that the contents of the variable name are displayed next. The \texttt{\{\{\}} signals that the attribute associated with the next character should be turned off. Since \texttt{\{\}} represents underline, underlining is turned off.

The following example illustrates one use of bold.

\begin{verbatim}
{\{\{\}}{\{\}\{\}}{\{\}\{\}}M\{\{\}}emo:\{\{\}\{\}}L\{\{\}}etter:\{\{\}\{\}}I\{\{\}}tinerary:
\end{verbatim}

The \texttt{\{\}} command displays this message at the bottom of the screen:

\begin{center}
Memo; Letter; Itinerary.\end{center}

The \texttt{\{\}} codes turn on bold, the \texttt{\{\}} codes turn off all attributes (including bold). The \texttt{\{\}} codes turn on the mnemonic attribute (in this case, bold). Again, \texttt{\{\}} turns off the mnemonic attribute.

\textbf{Cursor Positioning Characters}

The following control characters affect the location of text in a message on the screen. When a control character is inserted, the cursor is moved to the location indicated, and any text that follows the control character is displayed beginning at that location. You can use as many display position control characters in a message as you need to position and format the message.

<table>
<thead>
<tr>
<th>Character</th>
<th>Shown As</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>\texttt{{}}</td>
<td>{\textbackslash H}</td>
<td>Position cursor at upper-left corner of screen.</td>
</tr>
<tr>
<td>\texttt{{}}</td>
<td>{\textbackslash J}</td>
<td>Position cursor at beginning of next line.</td>
</tr>
<tr>
<td>\texttt{{}}</td>
<td>{\textbackslash K}</td>
<td>Clear text to end of line. Cursor remains.</td>
</tr>
<tr>
<td>\texttt{{}}</td>
<td>{\textbackslash L}</td>
<td>Clear the screen, position cursor at upper-left corner of screen.</td>
</tr>
<tr>
<td>\texttt{{}}</td>
<td>{\textbackslash M}</td>
<td>Position cursor at beginning of line.</td>
</tr>
</tbody>
</table>
Character Shown As Action

^P {^P} Position cursor (followed by two characters: column, then row). See Ctrl-P below.

^W {Up} Position cursor up one line.

^X {Right} Position cursor right one character.

^Y {Left} Position cursor left one character.

^Z {Down} Position cursor down one line.

Important: To insert any of the above codes except {Del to EOP}, {^M}, or {^P}, you must be in Command Insert mode.

The following example illustrates the use of the ^Y control character (displayed as [Left]) for repositioning the cursor.

{ASSIGN}name ˜Hemingway ˜
{CHAR}1 ˜Is•the•author•{^N}{^N}{VARIABLE}name ˜{^O}{^N}?
(Y/N):•Yes{Left}{Left}{Left} ˜

In the author Hemingway? (Y/N): Yes

The three [Left] commands position the cursor three characters to the left. When the message is displayed, the cursor is on the “Y” of Yes.

Notes Conversion Chart, Alphabetic
Use the following chart to determine row and column positions using alphabetical control characters:

<table>
<thead>
<tr>
<th>Screen</th>
<th>Control Character</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>^A</td>
</tr>
<tr>
<td>2</td>
<td>^B</td>
</tr>
<tr>
<td>3</td>
<td>^C</td>
</tr>
<tr>
<td>4</td>
<td>^D</td>
</tr>
<tr>
<td>5</td>
<td>^E</td>
</tr>
<tr>
<td>6</td>
<td>^F</td>
</tr>
<tr>
<td>7</td>
<td>^G</td>
</tr>
<tr>
<td>8</td>
<td>^H</td>
</tr>
<tr>
<td>9</td>
<td>^I</td>
</tr>
<tr>
<td>10</td>
<td>^J</td>
</tr>
<tr>
<td>11</td>
<td>^K</td>
</tr>
<tr>
<td>12</td>
<td>^L</td>
</tr>
<tr>
<td>13</td>
<td>^M</td>
</tr>
<tr>
<td>14</td>
<td>^N</td>
</tr>
<tr>
<td>15</td>
<td>^O</td>
</tr>
</tbody>
</table>

Macros, Message Display 293
Screen Control Character

16 {^P}
17 {^Q}
18 {^R}
19 {^S}
20 {^T}
21 {^U}
22 {^V}
23 {^W}
24 {^X}
25 {^Y}
26 {^Z}

If you want to use ASCII characters for your row and column positions, the ASCII Conversion Chart is in Appendix A.

**Ctrl-P**

You can use the Ctrl-P character {^P} to position the cursor (and hence, the message) on the screen. Ctrl-P is a shortcut to positioning the cursor. Moving the cursor can also be accomplished by using the other control characters as listed in the table under *Cursor Positioning Characters* above.

The two characters following Ctrl-P should be the coordinates for the position on the screen. The screen is divided into columns and rows. Each position that can be occupied by a character on the screen has a column and row coordinate. The column coordinate is listed first, then the row coordinate. For example, the upper left corner of the screen has the coordinates 0,0. The position directly below 0,0 is 0,1. One position to the right of 0,1 is 1,1.

Within the {CHAR}, {INPUT}, {PROMPT}, {STATUS PROMPT}, and {TEXT} commands, the coordinates that follow {^P} must be entered as either control characters or ASCII character equivalents. If you use control characters, {^A} corresponds to coordinate 1, {^B} corresponds to coordinate 2, and so on. If you use ASCII character equivalents, coordinate 1= , 2= , 3= , and so on. Refer to Conversion Chart, Alphabetic above and Appendix A: ASCII Conversion Chart to translate all the row and column positions.

The first row and column of the screen are at position zero. Because there is no letter of the alphabet for zero (A=1), the top row and left-most column are inaccessible using the {^P} positioning feature with control characters. Also, you cannot use the ASCII equivalent of 0 since this is a null character.

However, you can reach row 0 or column 0 using ASCII 254. For example, to position at column 0, row 0, insert a prompt command ({CHAR}, {INPUT}, etc.), press Ctrl-P, then press Alt-254 twice.

Because there are only 26 letters of the alphabet (Z=26), to position a message starting at a row or column position greater than 26 you must use the ASCII equivalents.
To produce the menu shown at the beginning of this section, the command you would enter in the macro would be the following:

```
(CHAR)(\O)(Del to EOP)
(\P)(\U)|\M
```

Notice that this is all one {CHAR} command. {\^Q} turns off all attributes (see Attribute On/Off Characters above). {Del to EOP} clears the screen and positions the cursor at the upper left corner. The first {\^P}{\^U}{\M} positions the cursor at column 21, row 8 (U=21, H=8-see Conversion Chart, Alphabetic above). The rest of the line is simply characters written to the screen as part of the message string. (You can enter these characters like any other ASCII character. See Appendix A: ASCII Conversion Chart.) When the next {\^P} is encountered, the cursor is repositioned to the next row at the 21st column position. {\^P}{\^A}{\R} positions the cursor at column 1, row 24 (the last row on the screen) for the prompt. Finally, the tilde (˜) ends the {CHAR} command.

Using only ASCII equivalents, you would enter this to produce the screen:

```
Display On/Off, Effect on Messages
The messages of the {CHAR}, {INPUT}, {PROMPT}, {STATUS PROMPT}, and {TEXT} commands display on the screen whether Display is on or off (see {DISPLAY ON} and {DISPLAY OFF} under Appendix K: Macros and Merge, Programming Commands).

The message stays on the screen until the screen is rewritten. If Display is on, the screen is rewritten very frequently (at each vertical cursor movement, change of menu, and so on). If Display is off, the screen is not rewritten unless a {DISPLAY ON} code is encountered and a subsequent action rewrites the screen.

However, when Display is off, a new message will overwrite a previous message. If you use cursor positioning, only the part of the screen occupied by the new
message is overwritten. You can use this feature to create a stacking effect with messages.

If you do not want messages stacked, use the ^L ([Del to EOP]) positioning command to clear the screen, as in the example under Ctrl-P above. You can also rewrite the screen to clear a previous message by pressing Screen,Screen.

Even if Display is off in your macro, your document may still be visible under a message, as in this example:

Using the ^L ([Del to EOP]) positioning command in the {CHAR}, {INPUT}, {PROMPT}, {STATUS PROMPT}, or {TEXT} command will also clear the screen in this case.

If Display is off and you use cursor positioning for messages, a message may remain on the screen when the macro has finished. (This may make it look like the macro got “stuck.”) You can cause the screen to rewrite by pressing Home, Home, Up Arrow or Home, Home, Down Arrow. However, if you put [PROMPT][Del to EOP] (inserted using Ctrl-L) somewhere after the last message command in the macro, the screen will be clear when the macro finishes.
Reappearing (PROMPT) Messages
After executing a {CHAR} or {TEXT} command, Corel WordPerfect restores the contents of the status line, even if the contents are the message of a previously executed {PROMPT} command. If you do not want a {PROMPT} message to reappear after the {CHAR} or {TEXT} command, use {PROMPT} before the {CHAR} or {TEXT} command to clear the status line.

Reveal Codes, Effect on Messages
If Reveal Codes is on when you execute a macro using Ctrl-P cursor positioning (see Ctrl-P above), the message may not display correctly. You can use the following commands at the beginning of the macro to turn off Reveal Codes (if it is on):

```
{ASSIGN}RevealCodes ˜
[;]Clear•Reveal•Codes•variable ˜
[IF](STATE)&512 ˜
[IF]Reveal•Codes•on ˜
[;]Turn•Reveal•Codes•off ˜
[ASSIGN]Reveal•Codes•was•on ˜
[;]Set•flag ˜
[END IF]
```

If you want Reveal Codes turned back on when the macro finishes (if it was on when the above codes were encountered by the macro), insert the following commands at the end of the macro:

```
[IF]"{VARIABLE}RevealCodes "="was•on" ˜
[;]If•flag•was•set•(RC•was•turned•off)•by•above•commands ˜
[Reveal Codes]
[;]Turn•Reveal•Codes•back•on ˜
[END IF]
```

If you frequently write macros where you need these commands, we recommend that you save each set of commands as a separate macro and then use {NEST} (see Appendix K: Macros and Merge, Programming Commands) to nest them in macros that need them.

See Also: Macros; Macros, Define; Macros, Execute; Macros, Macro Editor; Appendix A; Appendix I; Appendix J; Appendix K; Appendix M

Make It Fit™

Use Make It Fit™ to make a document fit a certain number of pages.

For example, you can take a resume that is more than one page and shrink it to fit the page. Make It Fit can also expand a letter to fit the number of pages you want.

For more information on using Make It Fit, see Corel WordPerfect’s online Help.
**Margin Release**

Margin Release acts like a reverse tab by moving the cursor and accompanying text one tab stop at a time to the left—even past the left margin.

1. Move the cursor to the beginning of a line.
2. Press **Margin Release** to move the cursor one tab stop to the left.
3. Type to the end of the line or press **Return** to go back to the left margin on the next line.

Each time you press Margin Release the cursor moves one tab stop to the left. When the cursor reaches the tab stop located at the left edge of the page, Margin Release no longer works.

If you use this function in the middle of a text line, some text may disappear from your screen or misprint at the printer.

**See Also:** Tab, Tab Align, Tab Set

---

**Margins, Left and Right**

Left and right margins are measured from the left and right edges of the page. They remain constant regardless of the font size you are using. Text is automatically adjusted as you type to fit within the current margins. The default setting is for a 1” margin on each side of the page.

To change the left or right margin setting,

1. Press **Format**, then select **Line (1)**.
   
   *Or* Select **Line** from the **Layout** menu.

2. Select **Margins (7)**.

3. Enter a left margin measurement, then enter a right margin measurement (see Measurements below).

4. Press **Exit** to return to your document.

**Notes**

**Codes**

Changing the margins inserts a Left and Right Margin code [L/R Mar: #,##] into your document where # represents the left margin and ## represents the right margin. The code takes effect from that point in your document forward, until you change the margins again. The margins are changed after the Left and Right Margin code. Any text before the code uses the previous setting.

This makes it easy to change the margins at any point in the document. To change the margins of existing text, follow steps 1 through 4 above to insert a Left and Right Margin code immediately before the text. The margin code is automatically placed at the beginning of the current paragraph.
In Reveal Codes, the ruler across the center of the screen displays the left margin as a left bracket ([) and the right margin as a right bracket (]). If a margin falls on a tab setting, it is displayed as a left brace ({) or a right brace (}).

**Initial Codes**
If you want to change the default margin settings, you can enter your own margin settings using Initial Codes in Setup. They will then be in place each time you create a document.

**Measurements**
When entering a measurement, you can enter fractions (for example, 1 1/2). The measurement you enter will be converted to a decimal number in the current unit of measure. For example, if inches are the current unit of measure, 1 1/2 is converted to 1.5”. The default unit of measure is selected in Units of Measure in Setup.

If you enter margins that overlap the current paper width, an error message is displayed and you are given the chance to enter new settings (see steps 2 through 4 above).

Most laser printers have a minimum margin setting to allow for an unprintable region. If you enter a margin setting that is less than the minimum margin setting, the margins are reset to equal the minimum margin setting. For example, if your left unprintable region is .25” and you enter 0 for your left margin setting, your left margin will reset to .25”.

**See Also:** Margins, Top and Bottom; Units of Measure

---

**Margins, Top and Bottom**

The top and bottom margins are measured from the top and bottom edges of the page. They remain constant regardless of the font or paper size you are using. Text is placed within the current margins.

The default settings are 1” margin at the top and bottom of the page.

To change the top or bottom margin setting,

1. Press **Format**, then select **Page (2)**.
   
   Or **Select Page from the Layout menu**.

2. Select **Margins (5)**.

3. Enter a top margin measurement, then enter a bottom margin measurement.

4. Press **Exit** to return to your document.
**Baseline Placement**

Normally, text is never printed within the top or bottom margin of a page. The first line of text is printed immediately below the top margin.

You can place the first line of text inside the top margin by setting the Baseline Placement option on the Format: Printer Functions menu to Yes. The first line of text is printed within the top margin, and the baseline of that line is placed on the top margin (see Printer Functions). This measurement will not vary, regardless of the fonts you use in that first line of text.

**Codes**

Changing the top and bottom margins inserts a Top and Bottom Margin code `[T/B Mar: #, ##]` into your document, where `#` represents the top margin and `##` represents the bottom margin. The code is placed at the top of the current page and takes effect from that point in your document forward, until you change the margins again.

Although the top and bottom margins are not displayed in the normal editing screen, the top margin is always taken into account in calculating the position number which is displayed on the right end of the status line (unless you are using 4.2 units of measure). You can also view the current top and bottom margins on-screen by using View Document.

**Headers, Footers, and Footnotes**

Headers, footers, and footnotes are not printed within the top and bottom margins of a page. Headers are immediately below the top margin. Footers and footnotes are immediately above the bottom margin.

**Measurements**

When entering a measurement, you can enter fractions (for example, 1 1/2). The measurement you enter will be converted to a decimal number in the current default measurement, as selected in Units of Measure in Setup.

If the measurements that you enter are greater than the overall length of the page, they will return to the default settings.

Most laser printers have a minimum margin setting to allow for an unprintable region. If you enter a margin setting that is less than the minimum margin setting, the margins are reset to equal the minimum margin setting. For example, if your top unprintable region is .25" and you enter 0 for your top margin setting, the topic margin will be .25".

**See Also:** Line Height; Margins, Left and Right; Printer Functions

---

**Master Documents**

A master document is a document that contains one or more subdocuments as well as intermixed text and codes. Subdocuments are other documents.
For example, a master document could be a book with several chapters. Each chapter could be a subdocument that exists as an individual file.

The benefit of using a master document is that it is very manageable and easy to edit. This is because the subdocuments can easily be removed from or retrieved to the master document. This lets you edit your individual subdocument files without having to scroll through a very large document. It also lets you easily combine several subdocuments to create, among other things, a table of contents, a list, or an index for a large document.

Subdocuments can be easily retrieved or removed from a master document because the master document contains subdocument links. These links, which you insert in a master document, determine where a subdocument should be located in the master document. When you are ready to retrieve the subdocuments to the link locations, you can expand the master document. When you want to remove the subdocuments from the link locations, you can condense the master document.

Subdocument links are represented on the screen as comments. In the screen below, you can see two subdocument links.

```
Subdoc: Noref.txt

Subdoc: Doc1001.txt
```

**Subdocument links**

These links determine the name of the file that will be retrieved to the link location. You can see the filename after the “Subdoc:” heading.

The process of creating a master document is as simple as typing text and inserting codes as you would in a normal document, then inserting the links where you want to include subdocuments.

To insert a subdocument link,

1. Move the cursor to where you want to insert the link.

You may want to insert a hard page break before the location of the subdocument link to make sure that the subdocument starts on a separate page. A hard page break is not inserted for you when you expand the master document.
2 Press **Mark Text** then select **Subdoc (2)**.

*Or* Select **Subdocument from the Mark menu**.

3 Enter the filename (include the pathname if necessary) of the subdocument you want to link to.

You can enter a filename of a subdocument that does not yet exist. However, if the subdocument does not exist when you expand the master document, a prompt appears letting you know that.

You can create as many subdocument links as you want in a master document. You can also save the master document, and use it as a subdocument in other master documents.

---

**Notes**

**Codes**

One of the best things about using a master document is that codes in the master document function just like codes in a normal Corel WordPerfect document. In other words, a code remains in effect until it is replaced by another code of the same type.

For example, if you set a code such as a margin setting anywhere in a master document, including in the subdocuments, that code remains in effect until the next code of the same type. The same holds true for any type of numbering (for example, page numbering, footnote numbering, line numbering) that you may have in your document.

A master document must be expanded, however, for any of the subdocument codes to take effect.

Certain paired codes such as Math, Outline, and Columns cannot be nested. For example, you cannot insert an Outline On code when Outline is already turned on. If you turn on Outline in subdocument 1, and turn it on again in a later subdocument without ever turning it off, Corel WordPerfect finds these nested codes when it expands the master document and deletes all occurrences after the first. When the master document is condensed, the duplicate codes are not restored. If the paired codes need to be retained in the subdocument, include the on and off code within the subdocument.

**Condensing a Master Document**

Condensing a master document removes the subdocuments from the master document. It does not remove the links to the subdocuments, just the subdocuments themselves. If a master document is not expanded, it does not need to be condensed.

To condense a master document, press **Mark Text**, select **Generate (6)**, then select **Condense Master Document (4)**.

When a master document is condensed, you can save any editing changes you have made to the subdocuments while they were in the master document. When the “Save Subdocs?” message appears on the status line, type **y** to save the subdocuments or type **n** to continue condensing the document without saving the subdocuments.
If you type y, you have three choices. Yes (1) replaces the old subdocument with the newly edited subdocument, No (2) lets you enter a new filename for the newly edited subdocument, and Replace All Remaining (3) replaces the old subdocument with the newly edited subdocument and replaces the rest of the subdocuments in the master document.

Cross-References, Tables, Lists, and Indexes
A master document is especially useful for generating cross-references, endnotes, indexes, lists, tables of contents, and tables of authorities for a document. If the proper codes for those features are located in the master document, Generate will work as it does in a normal document.

For most of the features listed in the paragraph above, you should mark the entries in the subdocuments. Then you should include the definition code in the master document. For example, if you are compiling an index, you should mark the index entries in the subdocuments. Then, you should move to the bottom of the master document, insert a hard page break, and insert an Index Definition code.

If you are generating a condensed master document, the document expands during generation, then condenses the document after generation. During the generation, the “Update Subdocs?” message appears. Type n to delete the subdocuments without saving them, or type y to save all subdocuments before deleting them from the master document.

As mentioned in Codes above, numbering in a master document functions just as it does in a normal document. Unless Corel WordPerfect encounters a code calling for a numbering change somewhere in the master document (including the subdocuments), numbering starts at one and continues throughout the document. If Corel WordPerfect does encounter a code calling for a numbering change, it changes numbering at that point, then continues from the specified number.

Unless you have a hard page break as the first thing in a subdocument, you should insert a hard page break before the link to the subdocument. Otherwise, the subdocument will not start on a separate page.

Expanding a Master Document
Expanding a master document retrieves the subdocuments to the master document. If you plan to print a master document, you must expand the document. If you don’t expand the master document, the condensed version is printed.

When a master document is expanded, subdocuments are formatted for the currently selected printer. Thus, if the subdocuments were saved with a different printer definition, fonts and other printer-specific formatting changes may not appear as they did in the subdocument.

To expand a master document, press Mark Text, select Generate (6), then select Expand Master Document (3).
As the master document is being expanded, prompts appear on the status line letting you know which subdocuments are being expanded. If a subdocument doesn’t exist, the “Subdoc Not Found (Press Enter to Skip)” message appears along with the filename of the subdocument that doesn’t exist. You can press Return to skip over that subdocument and continue, or you can re-enter the filename.

When the master document is expanded, the “Subdoc: filename” comments are replaced with a “Subdoc Start: filename” comment at the beginning of the subdocument and a “Subdoc End: filename” comment at the end of the subdocument. These comments let you know which text in the master document is in a subdocument. Like all Corel WordPerfect comments, these comments are not printed.

You can edit any text in a master document, including text in a subdocument. If you save or condense the document, you have the opportunity to save the editing changes in the subdocuments (see Condensing a Master Document above and Saving a Master Document below).

**Saving a Master Document**
You can save a master document just as you can any other document.

If you are saving an expanded master document, however, the “Document is Expanded, condense it?” prompt appears. If you type n, the document is saved in its expanded form and will not display this prompt on subsequent saves. If you type y, Corel WordPerfect begins to condense the master document.

As the master document is condensing, you can save any editing changes you may have made to the subdocuments while they were in the master document. This process is described under Condensing a Master Document above.

**See Also:** Cross-Reference; Generate; Index; Lists; Table of Authorities; Table of Contents

---

**Math**

There are two ways to perform fundamental math calculations in a document: Tables and Math. The Tables feature approaches math operations much like a spreadsheet program, and may be easier for those familiar with such programs.

If you have not used the Math features, we recommend that you try Tables math first (see Table, Math).
The Math feature uses tab stops to designate columns. Both numbers and text can be typed into columns, and numbers can be calculated down or across columns.

<table>
<thead>
<tr>
<th>Monthly Revenues — February</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
</tr>
<tr>
<td><strong>Item</strong></td>
</tr>
<tr>
<td>----------</td>
</tr>
<tr>
<td>Appliances</td>
</tr>
<tr>
<td>Stereos</td>
</tr>
<tr>
<td>Televisions</td>
</tr>
<tr>
<td>Total</td>
</tr>
<tr>
<td>Art</td>
</tr>
<tr>
<td>Paintings</td>
</tr>
<tr>
<td>Sculptures</td>
</tr>
<tr>
<td>Total</td>
</tr>
<tr>
<td>Lamps</td>
</tr>
<tr>
<td>Small</td>
</tr>
<tr>
<td>Medium</td>
</tr>
<tr>
<td>Large</td>
</tr>
<tr>
<td>Total</td>
</tr>
<tr>
<td>Music Boxes</td>
</tr>
<tr>
<td>Crystal</td>
</tr>
<tr>
<td>Plated</td>
</tr>
<tr>
<td>Wood</td>
</tr>
<tr>
<td>Total</td>
</tr>
<tr>
<td>Watches</td>
</tr>
<tr>
<td>Pocket</td>
</tr>
<tr>
<td>Wrist</td>
</tr>
<tr>
<td>Total</td>
</tr>
<tr>
<td>January Total</td>
</tr>
<tr>
<td>February Total</td>
</tr>
<tr>
<td>Year to Date</td>
</tr>
</tbody>
</table>

The simplest way to use the Math feature is to calculate subtotals, totals, and grand totals down the tab columns. This process eliminates the need to define Math columns (step 2 below). The headings under Notes below guide you through the process of performing such fundamental math calculations down columns.

For information about the Math feature in more sophisticated applications, see Math, Define Columns; Math—Row Titles, Numbers, and Functions; and Math, Formulas.

There are six basic steps to creating a math document. For details on each step, see the individual headings under Notes below.

1. Move the cursor to where you want to use the Math feature, then set a tab stop for each math column (see Tab Set for details).
2. Define the math columns only if you need to do more than just calculate down columns.
3. Turn on Math.
4. Enter row titles, numbers, functions, and formulas into the math document.
5. Calculate the operators, functions, and formulas in the math document.
6. Turn off Math.

**Notes**

**Set Tab Stops**

You designate math columns by setting tab stops. You can use the default tab stops, but they will likely provide columns that are too narrow.
You can adjust the space between columns by resetting the tab stops. If the numbers in one column overlap into the next column, the calculations will not be correct, and you will need to reset the tab stops to make more room.

Please note that it is the tab stops that represent columns in Math—not the space between tab stops. When you insert numbers into most math columns, they are aligned at the tab stops. Numbers are preset to align on a decimal character (see Other Format).

Both absolute and relative tabs work with the Math feature.

Since numbers align at the tab stops, the space between the left margin and the first tab stop is not counted as a math column. It can be used for row titles or any text that labels the math document.

**Define the Math Columns**

There are four types of Math columns: Text, Numeric, Total, and Calculation. All Math columns are preset to numeric. In numeric columns, you can type numbers and then calculate subtotals, totals, and grand totals down the columns. If that is all you need, you can skip Define the Math Columns and proceed to Turn On Math below.

If your needs are more sophisticated (for example, calculating across columns), you will need to display the Math Definition menu by pressing Columns/Table, selecting Math (3), then selecting Define (3).

From the Math Definition menu, you can change numeric columns into text, total, and calculation columns. For details, see Math, Define Columns.

To exit the Math Definition menu, press Exit.

**Turn On Math**

When you define Math columns from the Math Definition menu, you are returned to the Math menu. From the Math menu you can turn on Math by selecting On (1).

If you do not need to define your Math columns, you can use the following steps to turn on the Math feature. These steps also apply if you are using Math in multiple locations in a document (with the same definition) and want to turn on Math at any of those locations.

1. Move the cursor to the place in the document where you want Math to start (if you defined math columns, the cursor should be positioned after the Math Definition code).

2. Press Columns/Table, select Math (3), then select On (1).
   
   Or Select Math from the Layout menu, then select On.

Turning on Math inserts [Math On] into the Reveal Codes screen at the cursor position. Whenever the cursor moves to the right of the code, the message “Math” appears at the bottom left of the screen.
Enter Row Titles, Numbers, Functions
Because the space between the left margin and the first tab stop is not used by
the Math feature, you can type any row titles or labels using this space. Once
you have typed a title or label, press Tab to move to the first column. Unless
you have changed it, the first column is a numeric column, and you can type a
number into it. In numeric columns, numbers shift left until you type the
alignment character (usually a decimal point), and then they allow normal entry
to the right (see Other Format). For decimal numbers, Corel WordPerfect will
calculate up to four digits to the right of the decimal.

Once you have typed a number, press Tab again to move to the next Math
column, then type another number. Repeat this process until your first row of
numbers is complete. Then press Return to move to the next line where you
can begin inserting the next row of information.

When you reach the bottom of a column of numbers, you can type a function
instead of a number to designate where a calculation should occur. Functions
are abbreviated formulas. They tell Corel WordPerfect what to do with a
column of numbers. For simple calculations type any of the following functions
(just type the character +, =, or *) to perform the following calculations:

  +  Subtotals numbers above it.
  =  Totals all subtotals above it.
  *  Gives a grand total of all totals above it.

When you type the function, the character appears on the screen (+, = *, and a
code is inserted into the Reveal Codes screen (for example, [+]). The result of
the function does not appear until you calculate the Math document. The
function characters appear on the screen but do not print.

The Math feature includes several other functions in addition to those
mentioned above and allows for more sophisticated calculations and formatting.
For details, see Math—Row Titles, Numbers, and Functions.

Calculate
When you finish creating the math document, you are ready to calculate the
results.

1  Press Columns/Table, select Math (3), then select Calculate (4).

   Or  Select Math from the Layout menu, then select Calculate.

Any function characters you have entered in the document now display the
appropriate calculation results.

If numbers overlap into other columns, calculations may not be accurate, and
you will need to reset your tab stops to allow more space, and then calculate
again (see Tab Set).

If you have more than one math section in a document, Corel WordPerfect
starts at the cursor position and searches backward for the closest math section
and calculates it. If no math section is found in the backward search, then Corel
WordPerfect searches forward from the cursor and calculates the closest math section in that direction. You need to calculate each section separately.

**Turn Off Math**
When you finish working on a math section of the document, you can return to regular editing by turning off Math.

1. Move the cursor to the end of the math section of the document.
2. Press **Columns/Table**, select Math (3), then select Off (2).
   
   **Or** Select Math from the Layout menu, then select Off.

[Math Off] is inserted into the Reveal Codes screen at the cursor position. [Math On] and [Math Off] codes define the limits of the math section of a document. When you move the cursor to the right of [Math Off], the “Math” message disappears from your screen.

By turning on and off Math at different locations, you can have multiple math sections in a document. You can also create distinct math definitions at different locations in a document by moving the cursor to a new position, then defining math columns (see **Math, Define Columns**).

If an entire document includes only math, you do not have to turn off Math.

**See Also:** Math, Define Columns; Math, Formulas; Math—Row Titles, Numbers, and Functions

---

**Math, Define Columns**

Once you have set the tab stops for the columns you want to use in Math, you are ready to define the Math columns. If you only want to add numbers down a math column (or if you have previously defined math columns in your document and want to use the same definition again), you can skip this step and turn on Math to start using the feature (see **Math**). You can define each column to be one of four different types (see **Types of Columns** below), and you can specify the way numbers will be displayed.

To define math columns,

1. Press **Columns/Table**, select Math (3), then select Define (3).
   
   **Or** Select Math from the Layout menu, then select Define.

2. Move through the Math Definition menu with the arrow keys, then edit any of the column settings you want changed (see the headings under **Notes** below).

3. Press Exit to save the definition and return to the Columns/Table menu.
[Math Def] is inserted into the Reveal Codes screen at the cursor position. If you want these changes to affect your math section, the cursor must be positioned after [Math Def] when you turn on Math.

Notes

Calculation Formulas
If you define a calculation column, you can enter a formula to calculate numbers across columns. You can define four calculation columns per Math definition.

For information on calculation formulas, see Math, Formulas.

Decimal/Align Character/Thousands' Separator
Though not listed on the Math Definition menu, Decimal/Align Character/Thousands' Separator also affects the way math results are displayed.

The decimal/align character is the character that separates decimal fractions from whole numbers and is preset to a period (.). The thousands' separator character is the character that separates hundreds from thousands and is preset to a comma (,).

To change these settings,

1. Move the cursor to the place where you want to change the settings (usually before the Math Definition code).
2. Press Format, then select Other (4).
   Or Select Other from the Layout menu.
3. Select Decimal/Align Character/Thousands' Separator (3).
4. Type a decimal character or press Return, then type a thousands' separator character or press Return.
5. Press Exit to return to the document.

The settings change from that point forward in the document. The decimal character also serves as the alignment character in number, total, and calculation columns (see Other Format).

If you are using an international version of Corel WordPerfect, you can use a period (.) as the decimal/align character regardless of the primary decimal/align character of the package language. However, you cannot use a period (.) as the decimal/align character when you are using Math, where both the decimal/align character and the thousands' separator are used together.

Math Definition Menu
The Math Definition menu includes 24 columns (A through X), all of which are available for performing math operations. Column A is at the first tab stop to
the right of the margin; column B is at the second tab stop to the right, and so on.

<table>
<thead>
<tr>
<th>Math Definition</th>
<th>Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Columns</td>
<td>...</td>
</tr>
<tr>
<td>Type</td>
<td>...</td>
</tr>
<tr>
<td>Negative Numbers</td>
<td>...</td>
</tr>
<tr>
<td>Number of Digits to the Right</td>
<td>...</td>
</tr>
<tr>
<td>Calculation</td>
<td>...</td>
</tr>
<tr>
<td>Formulas</td>
<td>...</td>
</tr>
<tr>
<td>Date</td>
<td>...</td>
</tr>
</tbody>
</table>

To change the definition of a column, move the cursor underneath the column letter using Left Arrow or Right Arrow, then select the number corresponding to the column type you want (0-3). If you select Calculation (0), the cursor moves to a calculation formula line where you can enter the formula to be used in the calculation column (see *Math, Formulas*).

With the cursor directly under a column letter, you can also press *Down Arrow* once and change the way negative numbers will be displayed in results by typing ( or – (see *Negative Numbers* below). Press *Down Arrow* again, and you can change the number of digits that will be displayed to the right of the decimal in results by typing a number (see *Number of Digits to the Right* below).

### Negative Numbers
You can choose how to display negative results by typing ( for parentheses or – for the minus sign in the Math Definition menu.

### Number of Digits to the Right
You can choose how many digits (up to 4) to display to the right of the decimal character (in calculated results) by entering a number from 0 to 4 in the Math Definition menu. A trailing digit is rounded up if it is greater than or equal to 5.

### Types of Columns
There are four types of column definitions available in the Math Definition menu. The initial setting for each column is numeric.

- **Calculation** • Select Calculation when you want to create and calculate a formula using the four Math operators. These formulas are calculated across columns and can use numbers from the same row (see *Math, Formulas*).

- **Numeric** • Select Numeric when you want to add positive and negative numbers down a column to create subtotals, totals, and grand totals. All columns are preset to numeric unless you define them otherwise.

- **Text** • Select Text when you want to include descriptions, row titles or labels, and so on, in a column of your math document.
Total • Select Total when you want to display only the totals from the column to the left.

See Also: Math; Math, Formulas; Math—Row Titles, Numbers, and Functions

---

**Math, Formulas**

If you are using the Math feature, you can use math operators, numbers, and column letters to create formulas. Formulas are useful to do more than just add positive and negative numbers down a column. Formulas calculate results across columns.

You can also create formulas if you are using Tables (see Table, Math).

This section is devoted to a description of formulas used with the Math feature. The steps below indicate how to insert formulas into a document.

Formulas can only be inserted into calculation columns. You can define four calculation columns in your math definition. When you define a calculation column, you must also define the formula to be used in that column.

The following steps show you how to enter a formula starting from the normal editing screen. If you are already at the Math Definition menu, skip to step 3 below.

1. If you have already turned on Math, move the cursor immediately to the left of the [Math On] code (in the Reveal Codes screen).
   
or
   Move the cursor to where you want the math definition inserted into the document.

2. Press **Columns/Table**, select **Math (3)**, then select **Define (3)**.

   Or  
   Select **Math** from the **Layout** menu, then select **Define**.

3. Move the cursor directly below the letter of the column you want to define as a calculation column.

   *Each column has a letter associated with it. The first tab stop is column A, the second is column B, and so on.*

4. Select Calculation (0) to define the column as a calculation column.

5. Enter the formula you want calculated for the column.

6. Press **Exit** twice to return to the normal editing screen.

You can create up to four formulas for each Math section in a document (one per calculation column).
As you press Tab to move into a calculation column, an exclamation point (!) appears on the screen, and a ![ ] code is inserted into the Reveal Codes screen. Delete the “!” if you do not want to calculate the formula for that line.

**Notes**

**Calculating Formulas**
To calculate formulas, press **Columns/Table**, select **Math (3)**, then select **Calculate (4)**. The formula is calculated across the columns.

**Calculation Order**
When there are two or more operators, they are calculated from left to right.

<table>
<thead>
<tr>
<th>Formula</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>2*3–1/2</td>
<td>2.5</td>
</tr>
<tr>
<td>2–3*1/2</td>
<td>.50</td>
</tr>
</tbody>
</table>

In the first example, 2*3=6, 6–1=5, and 5/2=2.5. In the second example, 2–3=1, –1*1=−1, and –1/2=−.5.

To change the order of calculation, use parentheses. The operator(s) in parentheses are calculated first.

<table>
<thead>
<tr>
<th>Formula</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>2*(3−1)/2</td>
<td>2.00</td>
</tr>
</tbody>
</table>

In this example, 3−1=2 is calculated first, then 2*2=4, and 4/2=2.

You can nest parentheses within parentheses—for example, 2*((a−1)/2)+b. You can nest up to seven levels.

**Creating Formulas**
Once you have selected a calculation column from the Math Definition menu (see the steps above), you can create a formula for the designated column using operators, numbers, and math column letters, or functions.

There are four operators you can use to create a formula.

<table>
<thead>
<tr>
<th>Operator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>+</td>
<td>Add</td>
</tr>
<tr>
<td>–</td>
<td>Subtract</td>
</tr>
<tr>
<td>*</td>
<td>Multiply</td>
</tr>
<tr>
<td>/</td>
<td>Divide</td>
</tr>
</tbody>
</table>

You use these operators in combination with numbers and the math column letters to create a formula. For example:

<table>
<thead>
<tr>
<th>Formula</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>2*3−1</td>
<td>5.00</td>
</tr>
<tr>
<td>2*3−A</td>
<td>6.00—the number in column A</td>
</tr>
</tbody>
</table>
In the second example, the number in column A (on the same line as the formula) is subtracted from 6.00.

<table>
<thead>
<tr>
<th>Formula</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>(-2\times3\times1)</td>
<td>((7.00))</td>
</tr>
<tr>
<td>(-2\times3\timesA)</td>
<td>((6.00)) — the number in column A</td>
</tr>
</tbody>
</table>

Results displayed in parentheses are negative numbers. You can change the display of negative numbers by changing the math definition (see Math, Define Columns).

There are also four special functions you can use while defining a formula in Math:

- `+` Add numbers across numeric columns.
- `/` Average numbers across numeric columns.
- `=` Add numbers across totals columns.
- `=/` Average numbers across totals columns.

These functions cannot be combined or used with other functions, operators, or numbers.

**Editing Formulas**

To edit a formula, move the cursor immediately to the right of the [Math Def] code you want to edit (in the Reveal Codes screen). Then, display the Math Definition menu, move the cursor directly below the column you want to edit, type 0, make any changes, and press Return. Pressing Return without making any changes erases the formula.

**Fractions**

When you want to use a fraction in a formula, place it in parentheses or use its decimal equivalent (for example, \((1/2), .5\)).
Math—Row Titles, Numbers, and Functions

The Math feature (not Tables math) lets you define four math column types: Text, Numeric, Total, and Calculation. Each type is designed for entering row titles, numbers, functions, and/or formulas. Row titles can only be entered in text columns; functions can only be entered in numeric, total, or calculation columns. Numbers can be entered in all four types of columns but are not calculated when entered in text columns. And formulas can only be entered in calculation columns (for details on formulas, see Math, Formulas).

If you want column titles, you should enter them before turning on Math (see Math).

Notes

Functions
A function is a symbol that determines the way numbers are calculated. In numeric, calculation, or total columns, you can use one of six functions (+, =, *, t, T, and N). You can also use four special functions when creating a formula (see Math, Formulas).

A calculated answer is called a result. Results do not appear until they are calculated.

Functions used in numeric and calculation columns calculate numbers above them, within the same column. Functions used in totals columns calculate numbers in the column to the left above them.

When you type a plus sign (+) as the function, the numbers above the function (the column to the left if a totals column) will be added when you calculate. The result is a subtotal.

### Numeric column

<table>
<thead>
<tr>
<th>Item</th>
<th>Revenue</th>
<th>Year to Date</th>
<th>Sales Tax</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Appliances</td>
<td>25,190.90</td>
<td>175.99</td>
<td>Up</td>
<td></td>
</tr>
<tr>
<td>Televisions</td>
<td>3,050.00</td>
<td>206.40</td>
<td>Up</td>
<td></td>
</tr>
<tr>
<td><strong>Total</strong></td>
<td>28,240.90</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sculptures</td>
<td>1,035.00</td>
<td>72.25</td>
<td>Up</td>
<td></td>
</tr>
<tr>
<td><strong>Total</strong></td>
<td>1,107.25</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Large</td>
<td>5,989.00</td>
<td>258.63</td>
<td>Up</td>
<td></td>
</tr>
<tr>
<td><strong>Total</strong></td>
<td>5,989.00</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>February Total</td>
<td>21,489.00</td>
<td>1,451.68</td>
<td>Up</td>
<td></td>
</tr>
<tr>
<td>January Total</td>
<td>11,823.00</td>
<td>11,823.00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Year to Date</td>
<td>33,312.00</td>
<td>2,902.68</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Math—Row Titles, Numbers, and Functions

314  Math—Row Titles, Numbers, and Functions
When you type an equal sign (=) as the function, only the subtotals above the function are added (the column to the left if a totals column). The result is a total.

### Numeric column

<table>
<thead>
<tr>
<th>Item</th>
<th>Revenue</th>
<th>Year to Date</th>
<th>Sales Tax</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Appliances</td>
<td>3518.80</td>
<td>175.58</td>
<td>Up</td>
<td></td>
</tr>
<tr>
<td>Stereos</td>
<td>3398.80</td>
<td>153.08</td>
<td>Down</td>
<td></td>
</tr>
<tr>
<td>Total</td>
<td>6917.60</td>
<td>328.66</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Totals column

<table>
<thead>
<tr>
<th>Item</th>
<th>Revenue</th>
<th>Year to Date</th>
<th>Sales Tax</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pensions</td>
<td>3049.00</td>
<td>133.09</td>
<td>Down</td>
<td></td>
</tr>
<tr>
<td>Sculptures</td>
<td>1508.80</td>
<td>72.90</td>
<td>Up</td>
<td></td>
</tr>
<tr>
<td>Total</td>
<td>4557.80</td>
<td>205.99</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Total

- **February Total**: 23,808.80
- **January Total**: 11,823.60
- **Year to Date**: 45,632.40

Math: \( 45,632.40 \times 1.0100 \) = \( 46,114.40 \)

When you type an asterisk (*) as the function, only the totals above the function are added (the column to the left if a totals column). The result is a grand total.

### Numeric column

<table>
<thead>
<tr>
<th>Item</th>
<th>Revenue</th>
<th>Year to Date</th>
<th>Sales Tax</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Appliances</td>
<td>3518.80</td>
<td>175.58</td>
<td>Up</td>
<td></td>
</tr>
<tr>
<td>Stereos</td>
<td>3398.80</td>
<td>153.08</td>
<td>Down</td>
<td></td>
</tr>
<tr>
<td>Total</td>
<td>6917.60</td>
<td>328.66</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Totals column

<table>
<thead>
<tr>
<th>Item</th>
<th>Revenue</th>
<th>Year to Date</th>
<th>Sales Tax</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pensions</td>
<td>3049.00</td>
<td>133.09</td>
<td>Down</td>
<td></td>
</tr>
<tr>
<td>Sculptures</td>
<td>1508.80</td>
<td>72.90</td>
<td>Up</td>
<td></td>
</tr>
<tr>
<td>Total</td>
<td>4557.80</td>
<td>205.99</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Grand total

<table>
<thead>
<tr>
<th>Item</th>
<th>Revenue</th>
<th>Year to Date</th>
<th>Sales Tax</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pensions</td>
<td>3049.00</td>
<td>133.09</td>
<td>Down</td>
<td></td>
</tr>
<tr>
<td>Sculptures</td>
<td>1508.80</td>
<td>72.90</td>
<td>Up</td>
<td></td>
</tr>
<tr>
<td>Total</td>
<td>4557.80</td>
<td>205.99</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### February Total: 21,812.80
### January Total: 11,823.60
### Year to Date: 44,636.40

Math: \( 44,636.40 \times 1.0100 \) = \( 45,114.40 \)

Two additional functions let you insert your own subtotals and totals into a column. Type \( t \) in front of a number you want to be calculated as a subtotal and \( T \) in front of a number you want calculated as a total.

### Subtotal

<table>
<thead>
<tr>
<th>Item</th>
<th>Revenue</th>
<th>Year to Date</th>
<th>Sales Tax</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Appliances</td>
<td>3518.80</td>
<td>175.58</td>
<td>Up</td>
<td></td>
</tr>
<tr>
<td>Stereos</td>
<td>3398.80</td>
<td>153.08</td>
<td>Down</td>
<td></td>
</tr>
<tr>
<td>Total</td>
<td>6917.60</td>
<td>328.66</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Totals column

<table>
<thead>
<tr>
<th>Item</th>
<th>Revenue</th>
<th>Year to Date</th>
<th>Sales Tax</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pensions</td>
<td>3049.00</td>
<td>133.09</td>
<td>Down</td>
<td></td>
</tr>
<tr>
<td>Sculptures</td>
<td>1508.80</td>
<td>72.90</td>
<td>Up</td>
<td></td>
</tr>
<tr>
<td>Total</td>
<td>4557.80</td>
<td>205.99</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Total

<table>
<thead>
<tr>
<th>Item</th>
<th>Revenue</th>
<th>Year to Date</th>
<th>Sales Tax</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pensions</td>
<td>3049.00</td>
<td>133.09</td>
<td>Down</td>
<td></td>
</tr>
<tr>
<td>Sculptures</td>
<td>1508.80</td>
<td>72.90</td>
<td>Up</td>
<td></td>
</tr>
<tr>
<td>Total</td>
<td>4557.80</td>
<td>205.99</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### February Total: 21,812.80
### January Total: 11,823.60
### Year to Date: 45,632.40

Math: \( 45,632.40 \times 1.0100 \) = \( 46,114.40 \)

---

**Math—Row Titles, Numbers, and Functions** 315
When you type \( N \) in front of a number, the number is negative when calculated. \( N \) can be combined with other functions. It is especially useful in a Net Worth situation where assets and liabilities are both added up as positive numbers, and then liabilities are subtracted from assets.

For functions to work correctly, they should be entered in the order below (top to bottom).

\[
+, t \quad \text{(Subtotal, Extra Subtotal)} \\
=, T \quad \text{(Total, Extra Total)} \\
* \quad \text{(Grand Total)}
\]

Functions and results both appear on the screen, but the function characters (for example, \(+, =, T\)) are not printed when the document is sent to the printer. The functions appear as codes in the Reveal Codes screen (for example, \([+]\)).

**Numbers**

Numbers can be entered in any column, but are not calculated when entered in a text column. They can be positive or negative. To indicate a negative number, use a minus sign or parentheses (for example, \(-3.45, (3.45)\)).

The Negative Number option on the Math Definition menu specifies how negative results are displayed. You can enter a negative number with the minus sign or parentheses regardless of the negative number setting.

Numbers are preset to align on tab stops at the decimal point. You can change the tab stops or the character preset for decimal alignment (.) to change the way numbers align (see *Tab Set or Other Format*).

**Row Titles**

Row titles can be entered in text columns only. The space between the left margin and the first tab stop is not considered a math column and can be used for row titles that label the rows in the math document.

If you want column titles, you should create them outside of the math document (before the [Math On] code).

**See Also:** Math; Math, Define Columns; Math, Formulas

---

**Menu Options**

You can select an option from most menus with a number or a mnemonic letter. **Menu Options** lets you change the appearance of menus to make option selection easier.

For example, you can make your mnemonic letters “stand out” by assigning them an attribute.

1. Press **Setup**.

   Or \( \mathbb{D} \) Select **Setup** from the **File** menu.
2  Select Display (1), then select Menu Options (4).

3  Select the menu option of your choice (see the option headings under Notes below).

4  Select Size (1) or Appearance (2), then select the attribute of your choice.
   or
   Select Normal (3) to have the option appear as normal text.

   *If you are changing the setting for Menu Bar Separator Line (6), or Menu Bar Remains Visible (7), the only choices are y for Yes and n for No.*

5  Press Exit until you return to the normal editing screen.

   Settings for all of these options are stored in the .wp8c.set file.

---

**Notes**

**Assigning Attributes**
To assign an attribute to a menu option, select the option, select Size (1) or Appearance (2), then select the attribute. The attribute will appear as it is defined in Colors/Fonts/Attributes.

**Menu Bar Remains Visible**
This option determines whether the pull-down menu bar is always displayed at the top of the screen (in screens where you can use the pull-down menus). Once you set this option to Yes, the only way to “hide” the menu bar is to set this option to No.

**Menu Bar Letter Display**
This option determines how the mnemonic letters on the pull-down menu bar appear.

**Menu Bar Separator Line**
This option determines whether you want a double line separating the pull-down menu bar from the rest of the screen.

**Menu Bar Text**
This option determines how the text (other than the mnemonic letter) on the pull-down menu bar appears.

**Menu Letter Display**
This option determines how the mnemonic selection letter in menus (other than pull-down menus) appears.

**Pull-Down Letter Display**
This option determines how the mnemonic selection letters in pull-down menus appear. It does not affect the mnemonic letters on the pull-down menu bar.

**Pull-Down Text**
This option determines how text (other than the mnemonic selection letter) in pull-down menus appears. It does not affect the text on the pull-down menu bar.

**See Also:** Colors/Fonts/Attributes
Merge

Use Merge to produce personalized form letters, mailing labels, contracts, boilerplates, phone lists, and memos.

Merge combines information from two or more sources into a single document. The primary file is a document you create as a template that controls the merge. The primary file uses data in secondary files, information you type during the merge, specially designed Corel WordPerfect document files, UNIX text files, and the Shell Clipboard (if you use Corel Shell). See Primary Files, Secondary Files, Keyboard, Document Assembly, and Corel Shell Clipboard below for an explanation of these information sources.

**Primary Files**
Every merge requires a primary file that controls the merge, inserting a name here, an address there, a date someplace else, and even a selected paragraph in the middle.

A primary file contains text and merge commands. The text and format can be whatever you want, while merge commands must be selected and inserted with care.

```
Text

Sewon Air Freighters
200 N. Main St., Suite A, Newport Beach, CA 92663

April 2, 1992

Dear [FIELD]Name:
[FIELD]Company,
[FIELD]Address:

Before finalizing our agreement, I want to advise you of our shipping limitations. Unlike sea transport, air freight is bound by certain packaging regulations which determine what we can ship by air.

Packaging: To maximize safe transport of your shipment, we suggest that each item be contained in a plasticized crate. Our largest carrier, the NWFF, is limited to crates that are 36 x 20 x 20 in. In size with a maximum payload of 1750 kilograms. As an alternative, you can ship each piece as an indivisible item which requires no packaging. However, we strongly discourage this for fragile items.

```

You can combine merges with macros to create documents. For a description of macro and merge programming commands, see Appendix K.

**Secondary Files**
Sometimes called an address file, the secondary merge file may contain many records (a record is a collection of related information). Records are separated by
the [END RECORD] merge command followed by a hard page break, and can be sorted (see Sort).

Field 1

Field 3

The information in each record is divided into fields. One field may contain a name, another field may contain a company name, and another field may contain an address. These fields are then merged into a primary file. During a merge, only those fields that have been requested by the primary file are merged.

Fields within each record are separated by the [END FIELD] merge command followed by a hard return.

Important: Never separate fields or records with an extra hard return or insert spaces between the last word in a field and the [END FIELD] command. If you do, your merged documents may not look as you expect them to.

Fields may be referenced by number or by name. Fields are numbered from top to bottom in a record. You can assign names to the fields with the [FIELD NAMES] command that includes the names of the fields (in order) at the beginning of the secondary file. For more information see Appendix K.

As you move the cursor to each field, the number or name of the field at the current cursor position appears on the status line. You can clear the name or number from the status line by pressing Home, Home, Up Arrow.

While there is no limit to the number of fields allowed in a record, each record should contain the same number of fields, and each field should contain the same type of information or remain empty. If field 3 of one record contains a phone number, then field 3 of every other record in that file should also contain a phone number—or nothing at all. Even if empty, the field still needs an [END FIELD] command. Records using the [NEXT RECORD] or [FIELD NAMES] commands (see Appendix K) are the only exceptions to this rule.

You do not have to keep the same number of lines or words within each field. For example, you might have two lines in the address field of one record and five lines in the address field of another record.

We recommend that you consider how information is organized into fields. For example, if the city, state, and ZIP Code are in the same field, it is impossible to merge anything but the whole field (city, state, and ZIP Code) into a primary
file. This problem is remedied by reducing the information to smaller categories, (that is, the city in one field, the state and ZIP Code in another).

Secondary files can grow to include many thousands of records. If you are merging with a large secondary file, the merge stops if you run out of disk space. You can break the secondary file into two or more smaller files, or merge to the printer using the [PRINT] command (see Appendix K).

Once the primary file and other information sources are set up properly, you can merge them together. To perform a merge,

1. Press **Merge/Sort**, then select **Merge** (1).

   Or  
   Select **Merge** from the **Tools** menu.

2. Enter the name of the primary file.

3. Enter the name of the secondary file if you are using one.

   or

   Press **Return** if you are not using a secondary file.

When you are prompted to enter the primary or secondary file, you can use the List key to list the files in a directory. When you have found the file you want, select **Retrieve** (1) to select the file and continue the merge.

When you perform the merge, a document is created with the combined information from the sources used in the merge. For example, if you merged a letter (primary file) with an address list (secondary file), a document would be created with a copy of the letter for each record in the secondary file. Each letter would be separated by a hard page [HPg].
Dear Mr. Pierce:

Before finalizing our agreement, I want to advise you of our shipping limitations. Unlike sea transport, air freight is bound by certain packaging regulations which determine what we can ship by air.

Packaging: To maximize safe transport of your shipment, we suggest that each item be contained in a palletized crate. Our target carrier, the B747F, is limited to crates that are 350 x 260 cm. in size with a maximum payload of 750 kilograms. As an alternative, you can ship each piece as an indivisible item which requires no packaging. However, we strongly discourage this for fragile items.

You should be aware that Samson Air Freighters can randomly select and unpack cargo for inspection. If any damage results from this procedure, our underwriter cannot be held responsible for coverage. The crate dimensioning must be done by you for each item, and our underwriter will not cover damage resulting from this procedure. You may want to seek an independent insurer to supplement our schedule.

To make it cost effective for you, you may want to compare the shipping cost against the price we quoted. Any increase in the insurance will affect the price you quoted. Our underwriters will only insure each piece for $1,000,000, which is included in the shipping cost. We recommend that you only ship pieces that are fragile in this manner.

To maximize safe transport of your shipment, we suggest that each item be contained in a palletized crate. Our target carrier, the B747F, is limited to crates that are 350 x 260 cm. in size with a maximum payload of 750 kilograms. As an alternative, you can ship each piece as an indivisible item which requires no packaging. However, we strongly discourage this for fragile items.

Upon arrival at its destination, customs officials will randomly select and unpack cargo for inspection. If any damage results from this procedure, our underwriter cannot be held responsible for coverage. The crate dimensioning must be done by you for each item, and our underwriter will not cover damage resulting from this procedure. You may want to seek an independent insurer to supplement our schedule.

To make it cost effective for you, you may want to compare the shipping cost against the price we quoted. Any increase in the insurance will affect the price you quoted. Our underwriters will only insure each piece for $1,000,000, which is included in the shipping cost. We recommend that you only ship pieces that are fragile in this manner.

Sincerely,

Assistant Director of Shipping

Diana West,
Notes

Canceling a Merge
You can press Cancel to stop a merge. If Cancel has been turned off (see \{CANCEL OFF\} in Appendix K: Macros and Merge, Programming Commands), you must kill the Corel WordPerfect process to cancel the merge. Use caution when using the \{CANCEL OFF\} command. See also Inserting Merge Commands During Execution in Appendix K: Macros and Merge, Programming Commands.

Document Assembly
A primary file can merge with other document files by using the \{DOCUMENT\} command (see Appendix K: Macros and Merge, Programming Commands). These files are usually short paragraphs that can be chosen and inserted into preselected places in the primary file during a merge. This process is sometimes called document assembly.

UNIX Delimited Text Files
Delimiters are the characters in the exported file that determine the beginning and end of each field and record. An exported file may have both beginning and end delimiters for fields and records, or it may have combinations of beginning and/or end delimiters. It must have at least an end delimiter for both fields and records.

You can merge a primary file with spreadsheet or database files if the spreadsheet or database program can export files in a delimited UNIX text format. You can specify delimiters in Setup or at the time of the merge. To use Setup,

1. Press Setup.

   Or  Select Setup from the File menu.

2. Select Initial Settings (3).

3. Select Merge (1).

4. Select Field Delimiters (1), enter the field delimiters of the exported UNIX text file, then press Exit.

5. Select Record Delimiters (2), enter the record delimiters, then press Exit.

To enter a Line Feed command [LF] as a delimiter, press Return. To enter a Carriage Return [CR] as a delimiter, press Ctrl-m. To enter a Form Feed command [FF], press Ctrl-l.

You cannot specify ^C, ^D, ^E, ^F, ^G, ^N, ^O, ^P, ^Q, ^R, ^S, ^T, ^U, or ^V as a delimiter.

If you do not specify the delimiters through Setup, or if you want to change the delimiter specification at the time of the merge,

1. Press Merge/Sort to begin the merge.

   Or  Select Merge on the Tools menu.

2. Enter the name of the primary file.

When the prompt for the secondary file appears,

3. Press Text In/Out to change the prompt to "UNIX Text delimited file:".
Important: Text In/Out must be the first key pressed at the prompt. If you begin typing, then use Backspace to delete the characters, pressing Text In/Out will not bring up the UNIX Text Files menu. You should cancel the merge and begin again.

4 Enter the name of the delimited UNIX text file (include a full pathname if necessary).

You can also use List to list and select the UNIX text file at the prompt.

5 Select Field Delimiters (1) or Record Delimiters (2), enter the delimiters, and press Exit. Press Return when all the delimiters are specified correctly.

The merge continues as usual.

The UNIX Text Files menu also appears if you enter the name of a secondary file that is not in Corel WordPerfect secondary file format. If you have made a mistake, press Cancel to stop the merge. If the file is in delimited UNIX text format, enter the delimiters and proceed with the merge.

POSTNET Bar Codes
To include POSTNET bar codes in a merged file of mailing labels, insert the \{POSTNET\}expr~ merge code in the primary file. At the Enter: prompt, press Return, then move the cursor back one character to the tilde (~) and insert the Field merge code. At the Enter Field: prompt, enter the name or number of the field that contains the ZIP Code. In Reveal Codes you should see [Mrg:POSTNET][Mrg:FIELD]zip~~ (where zip stands for the name of the ZIP Code field). See also Bar Code.

Graphics
If you include graphics in the merge, it is recommended that you use Graphic on Disk to save disk space and merge time (see Graphic on Disk under Graphics, Define a Box).

Initial Codes
When creating a primary file, some formatting codes are better placed in Initial Codes, rather than in the document portion of the primary file. Everything in the document portion of the primary file will be repeated for each record in the secondary file, even formatting codes.

So, for example, if you have a Tab Set code, it will be inserted at the top of each copy of the merged document. Inserting the tab setting in Initial Codes, however, sets the tabs only once for the entire file. Placing codes and text you want to appear only once in the merged document in Initial Codes saves disk space and speeds up merge execution.

Important: Merge commands cannot be used in Initial Codes.

Inserting Merge Commands
1 Press Merge Codes, then select More (6).

or
Press **Merge Codes** twice.

*Or* **Select Merge from the Tools menu, then select Merge Codes.**

2. Use **Up Arrow** and **Down Arrow** to scroll to the command you want to insert.
   
   *or*
   
   Begin typing the name of the command you want until it is highlighted (you need not type the brace (|)).

3. Press **Return** to insert the command in the document.

Some commands require **arguments**, such as a variable name, a field name, or other information. (The arguments and syntax required by the command are displayed in the command access box. For more information on arguments and command syntax, see *Appendix K: Macros and Merge, Programming Commands.*

4. Enter each argument as requested.

   Once the command is entered, you can edit the arguments as regular text.

Some common commands can be entered without going to the command access box. To enter the \{FIELD\}, \{END RECORD\}, \{INPUT\}, \{PAGE OFF\}, and \{NEXT RECORD\} commands,

1. Press **Merge Codes**.

2. Select the command you want from the menu.

   *Selecting the More option (6) on the menu displays the command access box.*

3. Enter any arguments as requested.

   To enter the \{END FIELD\} command,

   1. Press **End Field**.

   Merge commands may be placed in the regular document portion of a file, in graphics boxes that are either empty or designated for text, and in headers, footers, footnotes, and endnotes. Merge commands are not permitted in styles or graphics box captions.
To insert merge codes used in previous versions of Corel WordPerfect (such as ^E, ^Q, ^R, and so on), press **Ctrl-letter**, where *letter* is the letter corresponding to the code. For example, to insert ^Q, press **Ctrl-q**. If the code requires arguments or a terminating ^, you must type them in manually. For more information, see *Previous Versions* below and *Previous Merge Commands* under *Notes in Appendix K: Macros and Merge, Programming Commands.*

**Keyboard**

A primary or secondary file can merge with the keyboard by inserting the [KEYBOARD] or [INPUT] command (see *Appendix K: Macros and Merge, Programming Commands*). The merge pauses at the [KEYBOARD] or [INPUT] command to let you enter information.

**Merge Commands Display**

You can specify whether you want to display merge commands in the normal editing screen. When you are creating a document such as a primary file, it can be helpful to see the commands. However, because these commands do not actually affect the format of the other text and codes in the document, you can turn off Merge Commands Display to have a better idea of how the text will look when the merge is performed.

The following illustrations show how the screen looks with Merge Commands Display on, then with Merge Commands Display off.
To turn Merge Commands Display on or off,

1. Press Setup.
   Or Select Setup from the File menu.
2. Select Display (1).
3. Select Edit-Screen Options (6), then select Merge Codes Display (5).
4. Type y to turn on Merge Commands Display or n to turn it off.
5. Press Exit to return to the normal editing screen.

Previous Versions
Secondary merge files you may have created with previous versions of Corel WordPerfect require no conversion. Primary merge files created with WordPerfect Corporation's WordPerfect 5.0 also require no conversion. If you prefer, however, you can convert the merge codes in these files to the new merge command format. Primary files created with WordPerfect Corporation's WordPerfect 4.2 or earlier versions do need to be converted.

To convert the merge codes in a file to the new command format,

1. Retrieve the document containing the old format merge codes.
2. Press Merge/Sort, then select Convert Old Merge Codes (3).
3. Save the file.

To convert the commands back to the control codes format, use Text Out. You will lose any merge commands unique to 8c in the conversion.

If you save a merge file in Corel WordPerfect 8c, then retrieve it in 5.0 or 5.1, 8c merge commands will appear as [Unknown]. If you retrieve the file again in 8c, the commands will be restored.

Previous version equivalents to the Corel WordPerfect 5.1 merge commands are listed to the right of the command in the command access box (see Inserting Merge Commands above). A list is also included under Previous Merge Commands under Notes in Appendix K: Macros and Merge, Programming Commands. For information on inserting these commands, see Inserting Merge Commands above.

Programming Commands
There are many merge programming commands you can use in both primary and secondary files to control and add flexibility to your merges. You can also use macros to add even more versatility to your merges. See Appendix K: Macros and Merge, Programming Commands for information on programming commands for both Macros and Merge.

Corel Shell Clipboard
If you have Corel Shell, the Corel Shell Clipboard may be used as the source for either the primary or secondary merge file, as long as its contents are in the appropriate format. To use the Clipboard as a file source when executing a merge,
1  Begin executing the merge (see steps above).
2  Press **Shell** at the Primary File: or Secondary File: prompt.

*Important:* Shell must be the first key pressed at the prompt. If you begin typing, then use Backspace to delete the characters, pressing **Shell** will not access the contents of the Clipboard. You should cancel the merge and begin again.

The Setup: Merge UNIX Text File screen will appear. For more information about this screen, see *UNIX Delimited Text Files* above.

3  Continue executing the merge as described in the steps at the beginning of this section.

**See Also:** Labels; Appendix I; Appendix J; Appendix K; Appendix L

---

### Move

Use Move to highlight a sentence, paragraph, or page of text, and then move, copy, or delete it.

1  Place the cursor on the text you want to move.
2  Press **Move**, then select Sentence (1), Paragraph (2), or Page (3) to highlight the sentence, paragraph, or page on which the cursor is resting (see *Text Delimiters* below).

   Or Choose Select from the *Edit* menu, then select Sentence, Paragraph, or Page.

3  Select a Move option (see *Move Options* below) and move the text.

   or

   Select Delete (3) to delete the text. The text is then removed from the screen. It can be retrieved as deleted text (see *Undelete*).

---

### Notes

**Move Options**

When you use Move, the Move options appear the same as when you are using Move with Block. They are Move, Copy, Delete, or Append. Move and Copy are explained in the following paragraphs. The Delete option is explained in step 3 above. To learn about Append, see *Append.*

Selecting either Move (1) or Copy (2) stores text in a temporary buffer. With Move, the text is removed from your document. With Copy, the text remains on the screen but is also held in a temporary buffer. In both cases, a prompt
appears on the status line informing you that pressing **Return** will retrieve the text you have just moved or copied.

You can then move the cursor to any other place in your document and press **Return** to retrieve the text. Or you switch to another document, then press **Return** to retrieve the text. Even if you retrieve another document into the second screen, pressing **Return** will still retrieve the text. The text will not be removed from the temporary buffer until you exit Corel WordPerfect, or use Move again to store new text in the buffer.

While the Move prompt is on the screen, if you decide you do not want to retrieve the text, press **Cancel**. The text remains in the temporary buffer until you move new text into it or exit Corel WordPerfect. As long as the text is in the buffer, you can retrieve it by pressing **Move**, selecting **Retrieve** (4), then selecting **Block** (1).

**Text Delimiters**

The Sentence option is designed to move a sentence from the capital letter that begins the sentence, up to and including the punctuation that ends the sentence, along with as many as three spaces following it. The sentence you move can end with a period (.), question mark (?), or exclamation point (!). However, a Hard Return code [HRt] is always considered to be a definite end of a sentence. Consequently, if a Hard Return code [HRt] occurs before the end of a sentence, text is highlighted only up to the Hard Return code.

You can place the cursor anywhere on a sentence before highlighting it. When the sentence is retrieved, any existing ending spaces are inserted after the end of the sentence. Consequently, if the sentence you move is followed by two spaces, and you move the cursor to the first letter in a sentence before retrieving it, your text will continue to be spaced correctly.

Because paragraphs are normally separated by Hard Return codes [HRt], the Paragraph option is designed to move a paragraph from the last Hard Return code in your text up to, and including, the next Hard Return code. Any spacing at the beginning of the paragraph (for example, a tab or indentation code or a series of spaces, and so on) is included. When the paragraph is moved, the Hard Return code at the end of the paragraph is moved with it. Consequently, if you
move the cursor to the start of a paragraph before retrieving it (and not to any extra line above a paragraph), your text will continue to be spaced correctly.

Pages can be separated by both a Soft Page code [SPg] (represented in the normal editing screen by a single-dashed line) or a Hard Page code [HPg] (represented in the normal editing screen by a double-dashed line). The Page option is designed to move text from one page break to the next. When a page of text is moved, soft page breaks are not moved with it. However, if the bottom of the page is indicated by a hard page break, that page break is moved with the text. Unless every page in your document is separated by hard page breaks, using the Page option usually changes where the page breaks occur in your document.

See Also: Append; Move, Block

Move, Block

To move a block of highlighted text,

1 Block the text.

2 Press Move, then select Block (1), Tabular Column (2), or Rectangle (3). These options indicate the type of block you are moving (see Block, Tabular Column, and Rectangle below).

Or Choose Select from the Edit menu, then select Tabular Column or Rectangle.

The Move options appear.

3 Select Move (1), Copy (2), or Append (4).

or

Select Delete (3). The text is then removed from the screen. It can be retrieved as deleted text (see Undelete).

Notes

Block

Most often, you will probably select Block (1) when you use Move to move text. The Block option lets you block any part of your document by placing the cursor on the first character you want to move, pressing Block to turn on Block, then moving the cursor to the last character you want to move. You can block a heading, a part of a sentence or a paragraph, or any part of a line.

When you use Block to move text, any codes within the blocked text are moved with the block. However, Corel WordPerfect is designed to keep the attributes of blocked text the same whenever it is moved. Consequently, if you block only part of a line, Corel WordPerfect inserts the necessary codes to keep the bolded text bolded, the underlined text underlined, and so on.
The Rectangle option lets you move a rectangular-shaped block without disturbing other parts of the text on a page. Each of the lines of text must end with Hard Returns.

Suppose, for example, you have imported an ASCII text file into Corel WordPerfect which contains several vertical columns of numbers and that these columns of numbers are separated by spaces and not by tabs. You can use the Rectangle option to rearrange the columns and also keep them intact.

To move a rectangular-shaped block, place the cursor at one corner of the rectangle you want to move (for example, upper left or lower right), then press Block. A “Block On” message appears at the left corner of the status line. Move the cursor to the opposite corner of the rectangle. As you do so, an irregular-shaped block of text is highlighted on-screen.

### Rectangle

<table>
<thead>
<tr>
<th>Person</th>
<th>Last Name</th>
<th>First Name</th>
<th>Employee Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hansen</td>
<td>Jean</td>
<td></td>
<td>294123</td>
</tr>
<tr>
<td>Jensen</td>
<td>Jack</td>
<td></td>
<td>294027</td>
</tr>
<tr>
<td>Hawk</td>
<td>Larry</td>
<td></td>
<td>295042</td>
</tr>
<tr>
<td>McMillan</td>
<td>Wendy</td>
<td></td>
<td>362843</td>
</tr>
<tr>
<td>Woods</td>
<td>Heaven</td>
<td></td>
<td>529333</td>
</tr>
<tr>
<td>Forrest</td>
<td>Richard</td>
<td></td>
<td>395267</td>
</tr>
<tr>
<td>Larson</td>
<td>David</td>
<td></td>
<td>570853</td>
</tr>
<tr>
<td>Long</td>
<td>Frank</td>
<td></td>
<td>579076</td>
</tr>
</tbody>
</table>

From Normal Codes to restore screen:

```
Move, Block
```
Keep in mind that this irregular-shaped block is no indication of the actual text that you are going to move. Once you have diagonally spanned the rectangle you want to move, press Move, then select Rectangle (3).

<table>
<thead>
<tr>
<th>Employee Number</th>
<th>Last Name</th>
<th>First Name</th>
<th>Extension</th>
</tr>
</thead>
<tbody>
<tr>
<td>2391</td>
<td>Hansen</td>
<td>Jean</td>
<td>2391</td>
</tr>
<tr>
<td>2392</td>
<td>Hansen</td>
<td>Jack</td>
<td>2392</td>
</tr>
<tr>
<td>2393</td>
<td>Richards</td>
<td>Thora</td>
<td>2393</td>
</tr>
<tr>
<td>2394</td>
<td>Matherbrock</td>
<td>Kendra</td>
<td>2394</td>
</tr>
<tr>
<td>2395</td>
<td>Russell</td>
<td>David</td>
<td>2395</td>
</tr>
<tr>
<td>2396</td>
<td>Roberts</td>
<td>Shrew</td>
<td>2396</td>
</tr>
<tr>
<td>2397</td>
<td>Russell</td>
<td>David</td>
<td>2397</td>
</tr>
<tr>
<td>2398</td>
<td>Shrew</td>
<td>Davis</td>
<td>2398</td>
</tr>
<tr>
<td>2399</td>
<td>Slew</td>
<td>2399</td>
<td></td>
</tr>
<tr>
<td>2400</td>
<td>Burrell</td>
<td>2400</td>
<td></td>
</tr>
<tr>
<td>2401</td>
<td>Dellvery</td>
<td>2401</td>
<td></td>
</tr>
<tr>
<td>2402</td>
<td>Dellvery</td>
<td>2402</td>
<td></td>
</tr>
<tr>
<td>2403</td>
<td>Dellvery</td>
<td>2403</td>
<td></td>
</tr>
<tr>
<td>2404</td>
<td>Dellvery</td>
<td>2404</td>
<td></td>
</tr>
<tr>
<td>2405</td>
<td>Delver</td>
<td>Davis</td>
<td>2405</td>
</tr>
<tr>
<td>2406</td>
<td>Dellvery</td>
<td>2406</td>
<td></td>
</tr>
</tbody>
</table>

The on-screen block changes to highlight only the rectangle which will be moved, and the Move options are displayed on the status line. You can then select Move (1) or Copy (2), move the cursor to the place where you want the rectangle inserted, and press Return to insert it.

While the Move options are displayed, selecting Delete (3) deletes the highlighted text. You can also select Append (4). For more information, see Append.

**Short Cuts**

You can also move a block of text by blocking the text, then pressing Block Move to move the block, or Block Copy to copy it. A prompt appears on the status line informing you that pressing Return will retrieve the text you have just moved. You can then move the cursor to the place where you want the text and press Return to insert the text.

**Tabular Column**

When you press Tab, *Indent*, or Tab Align to create a series of columns across a page, you may sometimes decide that you want to rearrange those columns without typing them in again. For example, if you have typed four tabbed columns across a page, you might want to move the first tabbed column to the right of the page.

<table>
<thead>
<tr>
<th>Employee Number</th>
<th>Last Name</th>
<th>First Name</th>
<th>Extension</th>
</tr>
</thead>
<tbody>
<tr>
<td>2391</td>
<td>Hansen</td>
<td>Jean</td>
<td>2391</td>
</tr>
<tr>
<td>2392</td>
<td>Hansen</td>
<td>Jack</td>
<td>2392</td>
</tr>
<tr>
<td>2393</td>
<td>Richards</td>
<td>Thora</td>
<td>2393</td>
</tr>
<tr>
<td>2394</td>
<td>Matherbrock</td>
<td>Kendra</td>
<td>2394</td>
</tr>
<tr>
<td>2395</td>
<td>Russell</td>
<td>David</td>
<td>2395</td>
</tr>
<tr>
<td>2396</td>
<td>Roberts</td>
<td>Shrew</td>
<td>2396</td>
</tr>
<tr>
<td>2397</td>
<td>Russell</td>
<td>David</td>
<td>2397</td>
</tr>
<tr>
<td>2398</td>
<td>Shrew</td>
<td>Davis</td>
<td>2398</td>
</tr>
<tr>
<td>2399</td>
<td>Slew</td>
<td>2399</td>
<td></td>
</tr>
<tr>
<td>2400</td>
<td>Burrell</td>
<td>2400</td>
<td></td>
</tr>
<tr>
<td>2401</td>
<td>Dellvery</td>
<td>2401</td>
<td></td>
</tr>
<tr>
<td>2402</td>
<td>Dellvery</td>
<td>2402</td>
<td></td>
</tr>
<tr>
<td>2403</td>
<td>Dellvery</td>
<td>2403</td>
<td></td>
</tr>
<tr>
<td>2404</td>
<td>Dellvery</td>
<td>2404</td>
<td></td>
</tr>
<tr>
<td>2405</td>
<td>Delver</td>
<td>Davis</td>
<td>2405</td>
</tr>
<tr>
<td>2406</td>
<td>Dellvery</td>
<td>2406</td>
<td></td>
</tr>
<tr>
<td>2407</td>
<td>Dellvery</td>
<td>2407</td>
<td></td>
</tr>
<tr>
<td>2408</td>
<td>Dellvery</td>
<td>2408</td>
<td></td>
</tr>
<tr>
<td>2409</td>
<td>Dellvery</td>
<td>2409</td>
<td></td>
</tr>
</tbody>
</table>

**Move, Block** 331
You can do this by using the Tabular Columns option.

To move any of the tabbed columns on a page, place the cursor on the first character following the Tab code [Tab] in the first line of the left-most column you want to move, then press **Block**. A “Block On” message begins blinking at the left corner of the status line. You then need to move the cursor through any of the columns you want to move. As you do so, an irregular-shaped block of text is highlighted on-screen.

As with the Rectangle option, this irregular on-screen block is no indication of the actual text that you are going to move.

Once you have moved the cursor through all the columns you want to move, move down to a character in the last line of the right-most column you want to move, press **Move**, then select Tabular Column (2).

The block changes to highlight only the columns which will be moved, and the Move options are displayed at the status line.

---

**Table Example:**

<table>
<thead>
<tr>
<th>Number</th>
<th>First Name</th>
<th>Last Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>1234</td>
<td>Jane</td>
<td>Jones</td>
</tr>
<tr>
<td>5678</td>
<td>John</td>
<td>Johnson</td>
</tr>
<tr>
<td>9012</td>
<td>Susan</td>
<td>Smith</td>
</tr>
<tr>
<td>3456</td>
<td>Michael</td>
<td>Williams</td>
</tr>
</tbody>
</table>

---

**Move Options:**

- Move
- Copy
- Paste
- Append

---

**Move, Block**
You can then select Move (1) or Copy (2), move the cursor to the place where you want the column inserted, and press Return to insert it.

Using Tabular Column to move text moves the Tab code preceding the column, along with the text in the column (for example, [Tab] text).

When the Move options are displayed, selecting Delete (3) deletes the column.
You can also select Append (4). For more information, see Append.

The Tabular Column option can be used to move columns that you create using Tab, Indent, or Tab Align. Do not use it to move text within Newspaper Columns, Parallel Columns, or Tables. For information on moving text in Newspaper Columns, Parallel Columns, or Tables, see Columns, Newspaper; Columns, Parallel; and Table, Create.

See Also: Append; Move
Other Format contains formatting and printing functions, such as changing the language code or selecting whether or not spaces are underlined when you use Underline.

1. Move the cursor to where you want the setting changed.

2. Press Format, select Other (4), then select an option and make the necessary adjustments (see the option headings under Notes below).

   Or Select Other from the Layout menu.

3. Press Exit to return to your document.

Notes

**Advance**
Advance lets you position text at a specific point on a printed page, for example, in a graphics image or in a pre-printed form.

**Border Options**
This menu determines the appearance of the border types you can select for both graphics boxes and tables.

**Conditional End of Page**
This feature protects a specified number of lines from being split between two pages. It is most often used to keep titles with the paragraphs which follow them.

**Decimal/Align Character and Thousands’ Separator**
The decimal/align character is preset to a period (.). It is used as the alignment character when you use Tab Align to align text vertically on a character (see Tab Align).

The decimal/align character is also the character that is used in Math. It separates decimal fractions from whole numbers and serves as the alignment character in number, total, and calculation columns (see Math, Define Columns).

The thousands’ separator character is the character used to separate hundreds from thousands and is preset to a comma (,).

If you want to select other characters for these functions, you can do so using the Decimal/Align Character and Thousands’ Separator options (see Tab Align and Math, Define Columns).

**Language**
When you insert a language code in your document, Sort then uses that language’s alphabet. And Date inserts dates the way dates are written in that language (for example, 12 décembre 1990 for French).

There are also versions of the Speller, Thesaurus, and Hyphenation dictionaries in several languages. If you purchase and install a dictionary for a certain language, Corel WordPerfect uses that language’s Speller for spell-checking, its Thesaurus for displaying synonyms and antonyms, and its hyphenation dictionary as a reference for hyphenation. For more information, see Language.
**Overstrike**
This option lets you print two or more characters in the same location such as combining the / and the 0 to create Ø.

**Printer Functions**
This option lets you set specialized printer functions such as kerning, leading, and the placement of the baseline (see Printer Functions). These functions depend on your printer's capabilities.

**Underline Spaces/Tabs**
Corel WordPerfect is initially set to underline spaces but not tabs when you underline or double underline text.

To change the current settings,

1. Select Underline (7) from the Format: Other menu to move the cursor to the Spaces entry.
2. Type y to underline spaces or type n if you do not want spaces underlined. The cursor moves to the Tabs entry.
3. Type y to underline tabs or type n if you do not want tabs underlined.
4. Press Exit to return to your document.

**See Also:** Advance; Conditional End of Page; Language; Math, Define Columns; Overstrike; Printer Functions; Tab Align

---

**Outline, Create**
You can create outlines similar to the following:

```

- Economics in Education
  1. Perspective
     a. Why Economics Education?
     b. Basic Principles
  2. Case Study
     a. M.S. 1 Community College
     b. Carter State University
        1. Graduate School
        2. Undergraduate College
  III. Moving Toward Discipline-Based Economics
  10. Conclusion
```

Outlines are a hierarchical organization of the paragraphs within your document. Each paragraph is assigned a distinctive paragraph number, using Roman or Arabic numerals, letters, keyboard characters, or Corel WordPerfect characters. Once you have established the different levels within your document, a paragraph number is assigned to each paragraph based on its hierarchical
You can have eight distinct levels of differentiation in a single document.

The example below shows an outline with four levels of differentiation, using Roman numerals, uppercase letters, Arabic numerals, and lowercase letters as paragraph numbers.

You can use numerals, letters, keyboard characters, Corel WordPerfect characters, or styles to number paragraphs. In the rest of this section numbers are used to describe all of the possibilities.

The following instructions explain how to create an outline with Outline. They are written to conform to the default settings for Outline. If you have changed any of these settings with the Paragraph Number Definition menu, you should read Outline, Define to see how these changes affect outlining.

1. Press Date/Outline, then select Outline (4).
   Or Press Outline from the Tools menu.

2. Select On (1) to turn on Outline.

3. Press Return to insert a first level paragraph number.

4. Type the text for the first outline level (see Typing Text below).

5. Press Return to insert another first level paragraph number.
   or
   Press Return, then press Tab to insert a second level paragraph number.

6. Type the text for that outline level.

7. Continue pressing Return to insert a new paragraph number, then press Tab to change the paragraph number to the next level or Margin Release to change the paragraph number to the previous level (see Levels below).
8 When you are finished with your outline, press **Date/Outline**, then select Outline (4).

Or select **Outline** from the **Tools** menu.

9 Select **Off** (2) to turn off Outline.

If the cursor is not at the left margin when you select Off, a hard return will be inserted before the Outline Off code.

### Notes

#### Codes

When you insert a paragraph number in an outline, that number appears as an Automatic Paragraph Number code [Par Num:Auto]. This code is no different from the code inserted with Paragraph Numbering, but there is a difference between the two features (see **Paragraph Numbering vs. Outline** below).

If you delete an Automatic Paragraph Number code, you can reinsert it by pressing **Date/Outline**, selecting Paragraph Numbering (5), and pressing **Return**.

#### Cursor Control

When Outline is on, the following cursor commands can be used:

- **Item Left**: Moves the cursor backward to the first paragraph number or outline style it can find.
- **Item Right**: Moves the cursor forward to the first paragraph number or outline style it can find.
- **Item Up**: Moves the cursor backward to the first paragraph number of the same (or preceding) level it can find. For example, if the cursor is resting on a third level paragraph number, Item Up will move the cursor backward to the nearest third, second, or first level paragraph number it can find.
- **Item Down**: Moves the cursor forward to the first paragraph number of the same (or preceding) level it can find. For example, if the cursor is resting on a third level paragraph number, Item Down will move the cursor forward to the nearest third, second, or first level paragraph number it can find.

#### Return

If you are in an outline and press **Return** immediately after inserting a paragraph number (or after placing the cursor to the immediate right of the Paragraph Number code), **Return** inserts a hard return in front of the paragraph number. If you press **Return** at any other time in an outline, it will insert a hard return, the tabs that are necessary to place a paragraph number at the correct level, then a paragraph number.

You can change this setting on the Paragraph Number Definition menu (see **Outline, Define**).
Level Numbering
Paragraph numbers are updated as necessary to keep numbering current. This is true even when you make editing changes such as inserting new paragraph numbers anywhere in the outline.

Levels
The concept of levels is explained at the beginning of this section, and you can have up to eight levels of numbering in an outline. Return is preset to insert a paragraph number into an outline (see Return above).

Pressing Return inserts a paragraph number at the same level as the current level. In other words, if the current level is the second level, pressing Return inserts another second-level paragraph number.

For example, in the outline below, the current level is the third level.

After you press Return, another third-level paragraph number is inserted.

This insertion is preset. If you want to have a first-level paragraph number inserted when you press Return, or if you do not want Return to insert a paragraph number at all, make the changes on the Paragraph Number Definition menu (see Outline, Define).

If you want to change the paragraph number to the next level (for example, first level to second level), press Tab immediately after inserting the number. If you want to change the paragraph number to the previous level (for example, second
level to first level), press Margin Release immediately after inserting the number.

If you want to return to an existing paragraph number and change its level, use Reveal Codes to make sure the cursor is positioned to the immediate right of the Paragraph Number code you want to change before pressing Margin Release or Tab.

If the paragraph number is not in an outline, the cursor must be positioned to the immediate left of the code to have Tab change the paragraph number to the next level or to have Margin Release change the paragraph number to the previous level.

**Move/Copy/Delete Family**

An outline family is the paragraph number on the line where the cursor is located, plus any subordinate paragraph numbers and text associated with them.

In the example below, the cursor is located on the line where the number II has been inserted. The outline family in this example includes all paragraph numbers and text from the number II to the number III.

<table>
<thead>
<tr>
<th>I. Perspective</th>
</tr>
</thead>
<tbody>
<tr>
<td>A. Why Economics Education?</td>
</tr>
<tr>
<td>1. General Education</td>
</tr>
<tr>
<td>a. High School</td>
</tr>
<tr>
<td>b. College</td>
</tr>
<tr>
<td>2. Vocational Training</td>
</tr>
<tr>
<td>a. College Degrees</td>
</tr>
<tr>
<td>b. Associate Degree</td>
</tr>
<tr>
<td>3. Basic Principles</td>
</tr>
<tr>
<td>1. Government</td>
</tr>
<tr>
<td>2. Money</td>
</tr>
<tr>
<td>3. Control</td>
</tr>
<tr>
<td>II. Case Study</td>
</tr>
<tr>
<td>A. PS 4</td>
</tr>
<tr>
<td>1. Main Concepts</td>
</tr>
<tr>
<td>2. Why it is Important</td>
</tr>
<tr>
<td>3. Summit Community College</td>
</tr>
<tr>
<td>C. Center State University</td>
</tr>
<tr>
<td>III. Moving Toward Discipline-Based Economics</td>
</tr>
<tr>
<td>IV. Conclusion</td>
</tr>
</tbody>
</table>

Using the Move, Copy, and Delete Family options, you can edit entire outline families. Paragraph numbers are automatically updated to reflect your changes.

To use the options, move to the family, press Date/Outline, select Outline (4), then select the option of your choice.

If you select Move Family (3), the family is highlighted, and you can use the arrow keys to reposition the family in the outline. When you are satisfied with the location, press Return and the family will be inserted in that location.

If you select Copy Family (4), a copy of the family is highlighted, and you can use the arrow keys to position the new copy in the outline. When you are satisfied with the location, press Return, and the family will be inserted in that location. The original family will not be moved.

When you are moving or copying a family, Home, Up Arrow moves the family to the top of the outline, while Home, Down Arrow moves the family to the bottom. Left Arrow and Right Arrow move the family in or out a level. If you use Left Arrow and Right Arrow, however, you cannot move the family more than one level past the level of the line preceding the family.
If you select Delete Family (5), then press y to confirm, the family is deleted from the outline and is stored in a temporary file. You can retrieve this file by moving the cursor to where you want to retrieve it, pressing Cancel, then pressing Restore (1). Once the family is moved out of the delete buffer or you exit Corel WordPerfect, however, you cannot restore the family (see Undelete).

You can use Block to block a family, then use Move to move, copy, or delete the block.

**Outline On/Off**

When you turn on Outline, an Outline On code is inserted into the document. When you turn off Outline, an Outline Off code is inserted into the document. This makes it easier to move an entire outline from one document to another. When the cursor is located between Outline On and Off codes, “Outline” is displayed on the status line.

When Corel WordPerfect encounters an Outline On code, it uses the settings for the closest Paragraph Number Definition code preceding the Outline On code. This includes starting the outline with the specified Starting Paragraph Number.

If no Paragraph Number Definition code exists, the outline is formatted according to the default settings (see Outline, Define).

**Paragraph Number Definition Menu**

The Paragraph Number Definition menu has several options which will help you create the kind of outline you need. If you change any of these options, the steps shown above may need some modifications. For more information on the Paragraph Number Definition menu, see Outline, Define.

**Paragraph Numbering vs. Outline**

When you use Outline to create an outline, you are simply inserting automatic paragraph numbers between outline codes.

If you are using Outline, you can insert paragraph numbers by pressing Return. You can move entire families of paragraph numbers and accompanying text to different locations in an outline, and you can keep paragraph numbering intact as you move an entire outline from one document to another.

If you are using Paragraph Numbering, you can insert single paragraph numbers anywhere in a document without having to turn Outline on or off. And, you can “fix” paragraph numbers at a specific level.

If you want to insert fixed paragraph numbers in an outline, you can use Paragraph Numbering.

**Styles**

You can include an Outline On code in a style. More importantly, however, you can define an outline style of your own with a combination of Outline and Style (see Outline, Style).

**Substructures**

Outline in the normal editing screen is independent of the Outline feature in document substructures such as graphics boxes, footnotes, endnotes, headers,
and footers. If you want to turn on Outline in one of the above mentioned features, you must do so in the editing screen for that feature.

**Typing Text**

After you insert a paragraph number, you can type text. As you type text, remember that pressing **Tab** when the cursor is at the immediate right of a Paragraph Number code changes the paragraph number to the next level (see Levels above).

It is a good idea to use **Indent** when you want to move text to a tab stop in Outline. For example, press **Tab** until the paragraph number is at the correct level, then press **Indent** before typing text. If you must use a tab, press **Home**, then **Tab** to insert a hard tab after the Paragraph Number code.

See Also: Outline, Define; Outline, Style; Paragraph Numbering

---

**Outline, Define**

You can tailor Outline and paragraph numbers to your needs. You can do such things as select a style of paragraph numbering, start paragraph numbering at a number other than one, and redefine the function of the Return key in an outline.

These options (with the exception of Automatically Adjust to Current Level) affect paragraph numbers outside of outlines as well as paragraph numbers within outlines.

The Paragraph Number Definition menu is shown below.

![Paragraph Number Definition Menu](image)

1. Move the cursor to a location preceding the spot where you want the changes to take effect.
2 Press Date/Outline, then select Define (6).

Or Select Define from the Tools menu.

3 Select the option of your choice and make the appropriate changes (see the option headings under Notes below).

4 Press Exit until you return to the normal editing screen.

A Paragraph Number Definition code is inserted at that location. From that point forward (or until Corel WordPerfect finds another Paragraph Number Definition code), outlines and paragraph numbers are formatted according to the settings you entered.

### Notes

<table>
<thead>
<tr>
<th>Attach Previous Level</th>
</tr>
</thead>
<tbody>
<tr>
<td>This heading on the Paragraph Number Definition menu determines whether to connect the previous level paragraph number to the current level paragraph number. For example, if you want the first three levels of an outline format connected at the third level (as in I.A.3), you would type y for Yes under the second and third level paragraph numbers. The answers under this heading are set to No for all numbering formats except the legal numbering format. The settings for the established formats cannot be changed. The only way for you to change the Attach setting is to create a user-defined numbering format. After selecting User-Defined (6), you can move to the Attach setting by pressing Down Arrow. Type y if you want to attach the previous level number or type n if you do not want to attach the previous level number. Press Margin Release to move backward through the settings or Tab to move forward. For more information on creating a user-defined numbering format, see Numbering Formats below.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Automatically Adjust to Current Level</th>
</tr>
</thead>
<tbody>
<tr>
<td>This option determines the level an automatic paragraph number in an outline should have when it is inserted. If this option is set to Yes, the number is inserted at the last level that was inserted. For example, if the last number that was inserted was a second level paragraph number in the outline numbering format, the next automatic paragraph number will also be a second level number. If this option is set to No, Corel WordPerfect will always insert a first level automatic paragraph number. Of course, you can still use Tab to move the number to the next level or Margin Release to move the number to the previous level no matter what the setting is for this option (see Levels under Outline, Create and Changing Levels under Paragraph Numbering).</td>
</tr>
</tbody>
</table>

---

342 Outline, Define
Enter Inserts Paragraph Number
This option defines the function of the Return key when Outline is on. Yes means that Return will insert a paragraph number as it normally does. No means that Return will end a line of text but not insert a paragraph number.

If this option is set to No, the only way you can insert a paragraph number is with Paragraph Numbering. You may want to define a macro to perform this task.

If this option is set to Yes and Outline is on, you can insert a hard return without inserting a paragraph number by pressing Compose before pressing Return. Similarly, pressing Compose before pressing Hard Page will insert a hard page break.

Existing Numbers
If you insert a Paragraph Number Definition code prior to an existing outline or paragraph number, the outline and paragraph numbers will be converted to conform to the new definition.

Initial Codes/Settings
You can insert a Paragraph Number Definition code in Initial Codes.

Numbering Formats
You can choose one of four paragraph numbering formats or create your own. The formats and examples of each are displayed under options two through six on the Paragraph Number Definition menu.

Selected formats are displayed next to the Current Definition heading.

To define your own format, select User-Defined (6), then select the option of your choice from the menu at the bottom of the screen. If you want an uppercase Roman numeral for that level, select Uppercase Roman (I). If you want a lowercase letter, select Lowercase Letters (a). If you want a paragraph number to be a Roman numeral at its own level and an Arabic numeral when attached to subsequent levels (for example, I., 1.1, 1.11), select Uppercase Roman/Digits if attached (X) or Lowercase Roman/Digits if attached (x).

To compress a Corel WordPerfect character, press Compose, type the character set number, a comma, the character within the character set, then press Return.
If you want a keyboard character, type the keyboard character. If you do not want any number, letter, or character displayed at that level, delete the displayed number, and leave it blank.

Your choices are displayed under the Current Definition heading. Press Return or Tab to move from one level to the next. Press Margin Release (Shift-Tab) to move backward through the settings.

After you choose the numbers, letters, or characters for all eight levels, you must type y for Yes or n for No in the Attach Previous Level heading. Press Exit at any time when you are satisfied with the displayed settings. For more information on the Attach Previous Level heading, see Attach Previous Level above.

Outline Style Name
Select this option to go into the Outline Style menu and select an outline style. For more information on Outline Style, see Outline, Style.

Starting Paragraph Number
Editing this option lets you start outline numbering at any level with any number. This might be helpful in the following situations:

When you enter a number for this option, you must enter it in a numeric format. This means you should use Arabic numerals separated by commas, spaces, or periods. If you want to start at VI.B.3 in the outline numbering format, enter 6.2.3 for the Starting Paragraph Number option.

One situation where the Starting Paragraph Number option is useful is in a document where you turn off Outline, then turn it on again later in the document. For example, you may have one outline at the beginning of your document that stops with a first level paragraph number of III. Later in the same document, you may want to turn on Outline again but start with a first level paragraph number of IV (rather than I). To do so, you can make the change with the Starting Paragraph Number option.

To make the change, move the cursor to a location after the first outline but before the second outline. Press Date/Outline and select Define (6). Next, select Starting Paragraph Number, delete the default value, and enter 4. Then press Exit until you return to the normal editing screen.

When you move the cursor past the second Outline On code, you will notice that the outline numbers change.

Another thing you could have done in the example above was to delete the starting paragraph number and leave it blank. When you leave the option blank, the numbering continues from any previous paragraph numbers in the document.

In the example above, Corel WordPerfect would have searched for the first paragraph number preceding the numbering change (III), then would have continued paragraph numbering from that point on. This is especially helpful when you add or delete paragraph numbers prior to the location of the numbering change.
Another situation where changing the Starting Paragraph Number option may be useful is when you want to start numbering over on a level without starting the entire outline over.

For example, your cursor may be located at a third level paragraph number as shown below.

To start numbering over at this level without starting numbering for the entire outline over, move the cursor to where you want to make the change. Next, select Starting Paragraph Number and enter the numbers that represent the level and the number at which you want to restart numbering (1.2.1 for the example above). Then press Exit until you return to the normal editing screen.

As you finish your outline, you will notice that numbering started over at that level, but continued on in the rest of the outline.

Another thing you could have done in the example above was to enter the starting paragraph number as ??.1. The question mark (?) will leave the paragraph number at that level as it is.

In the example above, it could have been to determine not to do anything to first and second level paragraph numbers. This is especially useful if you add or delete paragraph numbers prior to the location of the numbering change or if you do not know what the numbers for previous levels were (such as in subdocuments for a master document).
Outline, Style

Outline Style uses the power of the Style feature to let you create styles for your paragraph numbers. This lets you go beyond the simple numbering formats found in the Paragraph Number Definition menu.

Styles consist of codes and text and can be used to format text. Styles are easily created and edited and make editing a document easier. If you are not familiar with the Style feature, read Style.

Once you have selected an outline style, it becomes the numbering format for paragraph numbers (both within and without outlines).

To select an outline style,

1. Move the cursor to the location in your document where you want to begin using outline styles for your paragraph numbers.

2. Press Date/Outline, then select Define (6).
   
   Or Select Define from the Tools menu.

3. Select Outline Style Name (9).

4. Move the cursor to the style you want to select, then choose Select (1).

From that point forward in your document, paragraph numbers will be formatted according to that outline style.

If you have not created an outline style or cannot find the style you want to use, you can create or retrieve an outline style (see Creating an Outline Style and Retrieving an Outline Style below). After you do so, be sure to select it.

Notes

Changing Non-Outline Styles to Outline Styles

To change a non-outline style to an outline style, press Style from the normal editing screen, move the cursor to the style you want to change, then press Edit (4).

Next, select Type (2), select Outline (3), then enter the necessary information to change the style. The necessary information includes the name of the outline style you want to include the style under and the number of the level at which you want to include the style.

For example, if you want to change the style to a third level number under an outline style named “Outline,” you would enter Outline for the style name and 3 for the level.

If the name you enter does not match an existing outline style, an outline style with that name will be created.
After entering the information, you can select the outline style from the Outline Styles menu at any time as you normally would.

**Creating an Outline Style**

Creating an outline style is similar to creating a style on the Styles menu. To do so, select Create (2) from the Outline Styles menu, then enter the necessary information. Press Exit until you return to the Outline Styles menu.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Outline 1</td>
<td>Use paragraph numbers only</td>
</tr>
<tr>
<td>Outline 2</td>
<td></td>
</tr>
</tbody>
</table>

You may notice that there are several other options (Edit, Save, Retrieve, etc.) on the Outline Styles menu. These options function the same way they do in the Style feature.

You create outline styles in the Outline Styles: Edit menu.

| Name: Outline 2 |
| Name: |
| Description: |

<table>
<thead>
<tr>
<th>Level</th>
<th>Type</th>
<th>Enter</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Open</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Open</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Open</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Open</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Open</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Open</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Open</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Open</td>
<td></td>
</tr>
</tbody>
</table>

The Name is the name you want to call an outline style. You do not name the styles for each paragraph numbering level; rather, you use one name for the style that incorporates all of the level styles. Select Name (1), then enter a name for the outline styles.

You can enter up to 12 characters or spaces for an outline style name. Characters entered with Compose may take up more space than regular keyboard characters, so if you decide to enter characters with Compose, you may not be able to use all 12 characters or spaces for the outline style name.

Select Description (2), then enter a description that will help you remember the contents of the outline style.
You can enter 54 characters or spaces for an outline style description. Characters entered with Compose may take up more space than regular keyboard characters.

Creating a style for each paragraph numbering level is very similar to creating a style in the Styles menu. Move the cursor to the level for which you want to create a style, then enter the Type, Enter, and Codes information.

**Type** tells Corel WordPerfect whether the style is paired or open. See *Style, Create* for a discussion on paired and open styles. Select **Type** (3), then Paired (1) or Open (2).

**Enter** lets you define the function of the Return key with regard to a particular style. Once again, this procedure is discussed under *Style, Create*. This option is only in effect for paired styles. Select **Enter** (4), then select the option of your choice.

You may wonder how this Enter option works in conjunction with the setting for the Enter key on the Paragraph Number Definition menu. When you are inside Style On and Off codes, the Enter key setting for the style is in effect. Once you are outside of the Style codes, the Paragraph Number Definition menu setting is in effect.

**Codes** lets you enter the codes for the style. Again, a discussion on this procedure is found under *Style, Create*. Select **Codes** (5), then enter the codes you want to include in the style. Press **Exit** to return to the Outline Styles: Edit screen.

If you do not enter codes for a level in an outline style, Corel WordPerfect inserts a fixed paragraph number for that level.

**Nesting Styles**
You cannot nest outline styles (include one paired outline style completely within another). If you try to do so, Corel WordPerfect will turn the first style off before inserting the second style.

**Non-Existing Styles**
If Corel WordPerfect encounters an Outline Style code in a document that does not have a corresponding style in the Styles or Outline Styles menus, it re-creates the outline style on both the Styles and Outline Styles menus. All codes in the style are preserved.

This will most likely happen because a style was created, used, then deleted from either the Styles or Outline Styles menu. This will also happen when a style is renamed on the Styles or Outline Styles menu but not in the document.

**Retrieving a Style**
If you want to retrieve a previously saved list of outline styles to the Outline Styles menu, select **Retrieve** (6) from the Outline Styles menu, then enter the name of the style file. If you do not enter a complete pathname, Corel WordPerfect will search the style directory (see *Location of Files*). If no style directory exists, Corel WordPerfect searches the default directory.
After you select **Retrieve (6)**, you can press **List**, then enter a directory name to display the files in that directory. With the directory displayed on the screen, select **Retrieve (1)** to retrieve the highlighted file.

When you retrieve a list of outline styles, Corel WordPerfect checks your current list of outline styles for style names that match the incoming styles. If Corel WordPerfect finds a match, it displays the “Style(s) Already Exist, Replace?” message. If you type **n** for No, Corel WordPerfect only retrieves the styles whose names do not match current style names. If you type **y** for Yes, Corel WordPerfect retrieves all of the styles, replacing current styles with the incoming files of the same name.

When you retrieve the style file, all styles (both outline and non-outline) in the file are retrieved to the Styles menu.

**Saving a Style**
If you want to save all of the outline styles on the Outline Styles menu to a separate file that can be used from document to document, select **Save (5)**, then enter a name for the style. Corel WordPerfect will save the outline styles to the style directory (see **Location of Files**). If no style directory exists, Corel WordPerfect will save the outline styles to the default directory.

Keep in mind that this option is only for saving outline styles as a separate file that can be used from document to document. When you save a document, you save the outline styles associated with it, so there is no need to use this option if you plan to use the outline styles in the current document only.

**Important:** We suggest you create a style directory, specify it in **Location of Files**, and name style files with some type of descriptive extension (such as .sty) when you save them. This will help you to remember that a style file is not a document.

When you save outline styles, the styles on the Styles menu are also saved to the file.

**Style vs. Outline Style**
Outline Style is very similar to the Style feature. In fact, you may notice that Outline Style contains all of the options that Style contains with the exception of **On and Off**.

Outline Style replaces On and Off with **Select** which is used to tell Corel WordPerfect that you want to use a particular outline style. Once you have selected an outline style, paragraph numbers are formatted according to the style from that point forward in the document. The style for each numbering level is turned on when you insert a new level number and is turned off when you use the Right Arrow key (or Return, if it is so set) to move past the Style Off code.

If the style is an open style, you cannot turn it off.

As you work with the Style feature, you may notice that your outline styles are also shown on the Styles menu. They are there to remind you that they are part of the document and will be saved with the document when you save the document. You can only turn outline styles on and off from the Styles menu, however, when you are in an outline.
You can change a non-outline style to an outline style (see *Changing Non-Outline Styles to Outline Styles* above). One advantage outline styles have over styles is that outline styles can be changed to a previous or following level with *Margin Release or Tab just like other paragraph numbers.*

**See Also:** Outline, Create; Outline, Define; Style; Style, Create

---

**Overstrike**

You may want to combine the characters found on your keyboard to create new characters. For example, if the printer font you are using does not clearly differentiate a zero (0) from a capital O (O), you may want to combine the zero with a slash (/0). You can do this using Overstrike.

If your printer has the capability, Overstrike lets you combine characters and attributes to create mathematical symbols, chemical symbols, and other character combinations which are not included in the Corel WordPerfect character sets.

1. Move the cursor to where you want to create the overstrike.
2. Press Format, then select Other (4).
   
   *Or* Select Other from the Layout menu.
3. Select Overstrike (5), then select Create (1).
4. Type the characters that you want printed as an overstrike. For example, to get the /0 overstrike you would type /0. You can also use Font to select the attributes you want those characters to have. When you are ready to save the overstrike, press Return.
5. Press Exit to return to your document.

**Notes**

**Codes**

When you select Overstrike (5) from the Format: Other menu, then select Create (1), an Overstrike code [Ovrstk] appears on the status line. Any characters you then type appear side-by-side on the screen. You can type up to 30 characters, discounting the space taken up by the attributes you select.

When the document is printed, all the characters you type will be printed on top of one another. However, only the last character you type appears in the normal editing screen. To see all the characters in the overstrike, you can press **Reveal Codes**. In the Reveal Codes part of the screen, all the characters in an overstrike are included as part of the Overstrike code (for example, [Ovrstk:/0]).

**Editing an Overstrike**

To edit an existing Overstrike, select Edit (2) rather than Create (1) in step 3 of the steps given at the beginning of this reference section. Corel WordPerfect searches through text backward from the cursor position, then forward.
Once an existing overstrike is displayed on the screen, you can edit it. Typing a character key erases the existing overstrike and you have to start over. However, before you press a character key, you can use Left Arrow and Right Arrow to move through the characters and edit them. When you are ready to save the overstrike, press Return, then press Exit to return to your document.

**Overstrike vs. Compose**
Many overstrike character combinations are already provided in the Corel WordPerfect character sets (see Appendix P: Corel WordPerfect Characters). This includes international characters. You can enter these characters into your text using Compose. You can also use Compose to create many of the most common character combinations (for example, é, í, ü).

Whenever possible, it is preferable to use Compose rather than Overstrike to enter characters into your text. If the elements of those characters are available, Corel WordPerfect will then compose the characters for you, even if the total character is not available on a printer.

**Short Cuts**
If there is an overstrike that you use often, you might want to define a macro that creates an overstrike and then map that macro to a certain key on your keyboard using Keyboard Layout in Setup. That would spare you from having to re-create the overstrike each time you want to insert it in your document.

**See Also:** Compose; Keyboard Layout
A soft page break is inserted when you reach the end of a page. Soft page breaks appear as a line of dashes across the width of the screen.

The location of soft page breaks is likely to change as you add and delete text. As you add or delete footnotes, endnotes, headers, or footers in your document, Corel WordPerfect continually reformats your document from page to page, displaying on the status line the page number on which the cursor is found.

You can also insert a hard page break where you want to be sure a new section of text begins on a new page. The location of a hard page break does not change regardless of other changes you make.

To insert a hard page break at the cursor,


According to Dr. Ben Morgan, the best way to prepare for the age of 60 is to exercise now. "It doesn’t really matter what kind of exercise program older adults choose," he states, "just as long as they are active."

The key to sticking with an exercise program is finding one that is enjoyable. For older adults, this means developing a program that is not only fun, but also safe. In order to avoid injury, the

Page, Soft and Hard
A hard page break appears as a line of double dashes across the width of the screen.

**Notes**

**Codes**
In the Reveal Codes portion of the screen, a hard page is represented as [HPg] and a soft page is represented as [SPg].

**Deleting Page Breaks**
You cannot add or delete soft page breaks.

**Other Features**
Although hard page breaks can be used to separate sections or chapters within a document, it is preferable to create documents in small, manageable sizes and then combine them using Master Document.

**See Also:** Block Protect; Conditional End of Page; Headers and Footers; Master Documents; Widow/Orphan

---

**Page Format**

The Page Format menu specifies how text is displayed on the page. For example, you can set the top and bottom margins of a page and select the paper size and type. You can center text vertically on a page, add headers or footers, and have Corel WordPerfect handle page numbering. You can apply an option to every page in a document or turn it off for any given page.

Some of the changes you make are not apparent in the normal editing screen. They only appear on the printed page or when you preview the printed page using View Document.

To change a Page Format option,

1. Move the cursor to the top of the page where you want to change the setting.
2. Press **Format**, then select **Page** (2).
   
   * Or **Select Page from the Layout menu.**
3. Select an option and make the necessary adjustments (see the option headings under **Notes** below).
4. Press **Exit** to return to your document.
Notes

**Center Page Top to Bottom**
Use Center Page to center the entire page of text vertically, between the top and bottom margins on the page.

**Codes**
Changing any Page Format options inserts a code into your text at the top of the current page which determines that setting from that point forward in your document.

**Force Odd/Even Page**
You can specify whether certain pages should have an odd or an even page number. For example, you can begin each chapter in a book on an odd-numbered page by using the Force Odd/Even Page option.

**Headers and Footers**
You can specify certain information (a chapter title, the date, or the company name) to appear at the top (header) or bottom (footer) of every page in a document.

**Margins, Top and Bottom**
You can set new top and bottom margins for the pages in your document.

**Page Numbering**
Page Numbering automatically numbers the pages in your document. You can specify any of eight locations on the page where the numbers will appear. You can also specify text to insert with page numbers (such as Page 10), and begin renumbering at any point in a document (see Page Numbering).

**Paper Size/Type**
In versions sold in the United States, Corel WordPerfect prints on 8 1/2” x 11” paper, with the text running parallel to the narrow edge of the page.

Paper Size/Type options specify common paper sizes and positions. You can also create a new Paper Size/Type definition of your own (see Paper Size/Type).

**Suppress Page Format**
This option turns off page numbering and headers and footers for the current page only.

**See Also:** Center Page; Force Odd/Even Page; Headers and Footers; Margins, Top and Bottom; Page Numbering; Paper Size/Type; Suppress Page Format
Page Numbering

Use Page Numbering to specify numbering type and location. You can specify Arabic (1, 2, 3) or upper or lowercase Roman numerals (i, ii, iii, or I, II, III) and place them at any of eight possible locations. You can also specify text to accompany page numbers, such as Page Number 1 or Economics—Page 1.

Use View Document to see how page numbers will appear on the printed page.

1. Move to the page you want to begin numbering.
2. Press Format, then select Page (2).
   Or Select Page from the Layout menu.
4. Select Page Number Position (4), then select a number indicating where you want the numbers placed (see Page Number Position below).

You can also specify text to accompany the page number (see Page Number Style below) or change the number type (see New Page Number below).

5. Press Exit to return to your document.

Notes

Codes
Page Numbering inserts a Page Numbering code [Pg Numbering: location] into your document, where location indicates where the page numbers will appear on the page (for example, Bottom Center or Top Alternating). From that point forward, page numbers will appear at that location. This code is placed at the top of the page on which you selected page numbering.

Selecting New Page Number (1) from the Format: Page Numbering menu, then typing a number and pressing Exit inserts a New Page Number code [Pg Num:#] into your document, where # is the current number. You can also change the type of number being used by entering another numbering type (for example, i or IV). From that point forward, pages will be numbered consecutively starting with that number and in that type. If no New Page Number code appears, Arabic numerals are used (see New Page Number below).

Selecting Page Number Style (2) from the Format: Page Numbering menu, then changing the text being used with numbers, inserts a Page Numbering Style code [Pg Num Style:style] into your document, where style is the current Style being used (for example, [Pg Num Style:Page ^B]). From that point forward, page numbers will be accompanied by that additional text (see Page Number Style below).

Any changes made by the Page Numbering, New Page Number, and Page Number Style codes are reflected in the numbers which appear in the lists and tables you generate (for example, Indexes, Tables of Contents, Tables of Authorities, Cross-References).
Initial Settings
Page numbering is not on by default. To turn it on for all new documents, insert page numbering codes into the Initial Codes of Setup.

Inserting a Page Number
To insert the current page number anywhere in a document, press Ctrl-b. This also works in headers, footers, footnotes, and endnotes.

To insert the complete current page numbering style into your text (for example, Page ^B), select Insert Page Number (3) from the Page Numbering menu. This returns you to your document, inserting the complete current page numbering style at the cursor.

New Page Number
To change the current page number, select New Page Number (1) from the Format: Page Numbering menu, enter the new starting number, then press Exit. The new number is displayed on the status line, and the pages which follow are numbered consecutively starting with that number.

Three different kinds of numbering are possible: Arabic (1, 2, 3), Lowercase Roman (i, ii, iii), or Uppercase Roman (I, II, III). Unless you make a change in this entry, Arabic numerals are used. You can change to Roman by entering a Roman numeral (for example, i or I) as the new page number. If you want all the numbers in your document to appear as Roman numerals, you must do this on the first page of your document.

Page Number Position
Selecting Page Number Position (4) from the Format: Page Numbering menu displays the possible page number selections graphically on the screen:

<table>
<thead>
<tr>
<th>Selection</th>
<th>Page Number Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Top left corner, every page</td>
</tr>
<tr>
<td>2</td>
<td>Top center, every page</td>
</tr>
<tr>
<td>3</td>
<td>Top right corner, every page</td>
</tr>
<tr>
<td>4</td>
<td>Top left corner for even pages, top right corner for odd pages</td>
</tr>
<tr>
<td>5</td>
<td>Bottom left corner, every page</td>
</tr>
<tr>
<td>6</td>
<td>Bottom center, every page</td>
</tr>
<tr>
<td>7</td>
<td>Bottom right corner, every page</td>
</tr>
<tr>
<td>8</td>
<td>Bottom left corner for even pages, bottom right corner for odd pages</td>
</tr>
<tr>
<td>9</td>
<td>No page numbers</td>
</tr>
</tbody>
</table>

Selecting any of these locations returns you to the Format: Page Numbering menu and displays that selection in the Page Number Position entry. You can then press Exit to return to the normal editing screen. This inserts a Page Numbering code into your document (for example, [Page Numbering:Bottom Center]) as explained in Codes above. The code takes effect from that point forward, until a new one is inserted.
**Page Number Style**

Normally, page numbers include only numerals (for example, 1, 2, 3). This is represented by a Ctrl-B code (^B) in the Page Number Style entry on the Format: Page Numbering menu.

You may sometimes want to accompany page numbers with text (for example, Page 2, or Economics, Page 6). You can do this by adding text to the Page Number Style entry.

When you select Page Number Style (2) from the Page Numbering menu, the cursor moves to the current style. You can then type any character to erase the current style or use the arrow keys to move through the current style and edit it. You can type characters from the keyboard or use Compose to insert any character in the Corel WordPerfect character sets. Up to 28 characters are possible, excluding the extra space required to store extended characters.

Once you have completed the style you want, press Enter to save it.

A page number style must always include the Ctrl-B code (^B). If you forget to include the Ctrl-B code in this entry, Corel WordPerfect inserts it for you at the end of the Page Numbering Style entry.

**Page Numbers with Headers and Footers**

Page numbers are inserted on either the top or bottom line of text on each page. It also inserts a blank line between the page numbers and the rest of the text.

Because headers are also printed on the top line of every page, and footers on the bottom line, this can cause problems when you use both the Page Number feature and the Header and Footer feature in the same document. You can avoid overlapping by inserting an extra line at the top of a header or at the bottom of a footer whenever you are going to use these features along with page numbers.

**Suppressing Page Numbering**

To suppress page numbering for one page,

1. Press Format, select Page (2).
2. Select Suppress (this page only) (8).
3. Select Suppress Page Numbering (4), and type y.
4. Press Exit to return to your document (see Suppress Page Format).

To suppress page numbering for several pages,

1. Move to the page where you want to begin suppressing numbers.
2. Press Format, select Page (2).
4. Select Page Number Position (4), then select No Page Numbers (9).
5. Press Exit to return to your document.
You can then move to the page where you want page numbers to reappear, and turn on page numbering again by following the steps given at the beginning of this reference section. Corel WordPerfect will take the intervening pages into account as it numbers your pages, but it will not print numbers on them when you print your document.

**See Also:** Headers and Footers; Initial Codes

---

**Paper Size/Type**

You need a way to manually select and create different kinds and sizes of paper (forms) to print on. In addition, you need to select which form you are printing on at a particular time.

Paper Size/Type lets you define any kind of form (letterhead, labels, envelopes, and so on), then print on that form. For example, you need to specify the size of the paper, how the paper is inserted into the printer (bin number, for example), and whether or not you want to be prompted to insert the paper.

In addition, this information helps format text on both the screen and the printed page. For example, word wrap and soft page breaks are directly related to the size of the current page.

Paper Size/Type displays a list of all the paper sizes and types defined for the currently selected printer. Each printer you select will have different paper sizes and types already defined. You can edit or delete definitions, or create new ones that will be displayed when you select Paper Size/Type with that printer selected.

Before Corel WordPerfect can use any of the information that is displayed with the list of paper size/type definitions, you need to select a paper size and type.

Each version of Corel WordPerfect has a default form that is used if you do not select a paper size and type. For U.S. versions, this is Standard 8.5” x 11” paper. For non-U.S. versions, the form varies.

To select a paper size and type,

1. Move the cursor to the place in your document where you want to change to a different paper size and type. This should be the top of a page in the document.
2. Press **Format**, then select **Page (2)**.
   
   **Or** Select Page from the Layout menu.
3. Select Paper Size/Type (7), move the cursor to the paper type you want to use (see **Paper Type and Orientation** below), then choose Select (1).

The paper definition currently in use is highlighted when you enter the Paper Size/Type screen.
4. Press **Exit** to return to the normal editing screen.
If you have not yet selected a printer, these steps will work somewhat differently (see Paper Size/Type Screen below).

If Corel WordPerfect cannot find a definition to match the code when printing, it uses the [ALL OTHERS] definition (see [ALL OTHERS] below).

If you attempt to add/edit forms on a system printer, you will receive an error message. Only the system administrator can edit a system printer. You can, however, modify any printers that you have set up.

Notes

Adding a Definition
It is not necessary to define a paper type for every different form you print on. Corel WordPerfect comes with some preset definitions; in addition, the [ALL OTHERS] paper type (see [ALL OTHERS] below) exists so that if you do not have a paper definition to match the Paper Size/Type code in your document, the [ALL OTHERS] definition is used instead. There are some situations, however, where you may want to add a definition.

For example, if you have multiple bins or paper trays from which your printer can retrieve paper, you can create a definition which directs your printer to the proper location for a particular form.

Likewise, if you need to print a landscape document (text is parallel to the long edge of the paper) and can only do so by rotating the form (that is, inserting the long edge of the form into the printer first), you may need to create a definition specifying new dimensions for the form.

If the [ALL OTHERS] definition does not meet your needs, you can add a definition or edit the [ALL OTHERS] definition (see Editing [ALL OTHERS] under [ALL OTHERS] below).

To add a definition, choose Add (2) instead of Select (1) in step 3 above, then select a paper type (see Paper Type under Editing a Definition below). A screen is displayed that lets you accept the defaults for that definition or edit them as necessary (see Editing a Definition below). Press Exit when you finish editing the definition, and you can see that the definition has been added to the Format: Paper Size/Type screen.

[ALL OTHERS]
The [ALL OTHERS] paper definition exists in case Corel WordPerfect cannot find a paper definition to match a Paper Size/Type code in your document (see Code below). It also lets you specify any paper size and type without actually creating a definition. To do this,

1. Choose Select (1) with the [ALL OTHERS] definition highlighted.
2. Select a paper size (or select Other (o) and enter your own dimensions).
3. Select a paper type (or select Other and enter a name).
4. Press Exit to return to the normal editing screen.

The [ALL OTHERS] definition increases your document portability (that is, printing a document from different computers and printers). Because Corel
WordPerfect uses this definition if it cannot find a paper definition to match the code, you can print your document with any printer, whether or not it has the same paper definitions as your printer.

The \[ALL OTHERS\] paper definition has a maximum width associated with it. If your printer cannot rotate fonts and the width of the paper size you select from the Paper Size menu (after choosing Select (1) with \[ALL OTHERS\] highlighted) exceeds this maximum width, the message “Requested Form is Unavailable” appears next to the Paper Size/Type option on the Format: Page menu. The width dimension displayed next to “Paper Size” is then set to the maximum width measurement. The text on the screen and at the printer wraps relative to the maximum width measurement specified by the [ALL OTHERS] definition.

You can enter a new maximum width using the Maximum Width option on the Format: Edit Paper Definition menu for the [ALL OTHERS] definition; however, you should not enter a width that exceeds your printer’s capability (see Editing [ALL OTHERS] below).

If your printer can rotate fonts, the only time you may get the “Requested Form is Unavailable” message is if both the width and height exceed the [ALL OTHERS] maximum width measurement.

For example, if [ALL OTHERS] is set to Width ≤ 8.5” and you select a paper size that is 11” x 12” (for which there is no matching paper definition), Corel WordPerfect uses the location specified in the [ALL OTHERS] definition and positions the right margin relative to 8.5”.

When Corel WordPerfect uses the [ALL OTHERS] definition, it will sound a beep during printing if the Prompt to Load option has been set to Yes (the default setting for [ALL OTHERS]) (see Prompt to Load under Editing a Definition below). When it beeps, you need to insert the correct paper into your printer and select Go (3) from the Job Control menu.

**Editing [ALL OTHERS]** To edit the [ALL OTHERS] definition, select Edit (5) from the Format: Paper Size/Type menu with the [ALL OTHERS] definition highlighted. The screen that appears is slightly different from the one displayed if you highlight any other paper definition (see Editing a Definition below). Several options are not available on the [ALL OTHERS] screen, and one additional option (Maximum Width) has been included.
You might want to enter a bigger number for Maximum Width if you plan
to use paper that is wider than the measurement displayed.

The defaults for this menu are general enough to fit most paper sizes and
types that do not have a corresponding paper definition. However, you can
edit these options if you want (see Editing a Definition below for details).

There is no option for editing the Font Type on the [ALL OTHERS]
definition. If your printer can rotate fonts (for example, most laser printers),
the only way you can use landscape fonts for the [ALL OTHERS] definition
is if your paper width exceeds the maximum width and your paper height
does not. In this case, Corel WordPerfect assumes you want to print in
landscape and uses the landscape fonts.

Codes
When you select a paper size and type (as you did in the steps above), a [Paper
Sz/Typ:size.type] code is inserted into your document at the top of the current
page. That form is used from that point forward.

If you edit the definition after the code has already been inserted into the
document, the code is not changed; you will need to insert a new code and delete
the old one.

Copying a Definition
To make a copy of an existing paper size/type definition, simply highlight the
definition you want to copy, then select Copy (3). Then select Edit (5) to make
any changes you want (see Editing a Definition below).

Deleting a Definition
To delete a paper size/type definition, highlight that definition, select Delete (4)
or press Delete, then type y.

Editing a Definition
If you want to change a setting for any of the paper definitions, move the cursor
to the definition you want to edit, then select Edit (5). The screen displayed lets
you edit all of the information found on the Format: Paper Size/Type screen.

  Binding Edge • Select this option (7) to add the binding offset (see Binding)
to the Top (1) or the Left (2) of the page. (The default for this setting is
Left.)

  Double Sided Printing • Select this option (6) (if your printer is capable of
duplex printing), then type y to print on both sides of the paper. Type n to
return to the default of no double-sided printing.

If you have selected Top or Left for the binding edge, your printer will try to
rotate the paper around the edge you specify. For example, if you want to
bind a document at the top (as in a calendar) and print on both sides of the
page, select Top for the binding edge. The printer will print top to bottom,
turn the paper over (like turning the page of a calendar), then print top to
top bottom again.
Font Type • Select this option (3) to print using Portrait (1) or Landscape (2) fonts. Landscape fonts print text perpendicular to the inserted edge of the paper; portrait fonts print parallel to the inserted edge. (See Printing, Landscape for an explanation of printing landscape versus printing portrait.)

This feature must be used with Paper Size (see Paper Size below) for you to print in landscape.

If your printer cannot rotate its fonts (for example, dot-matrix and daisy wheel printers), you should only specify Portrait for this option. (See Printing, Landscape for details on landscape printing with a printer that cannot rotate fonts.)

Labels • Select this option (8), then type y to define labels corresponding to this paper definition (see Labels).

Location • After selecting Location (5), you can determine how the paper is fed to the printer. Select Continuous (1) if your printer is dot-matrix or daisy wheel and the paper is tractor-fed with perforated holes on each side. Continuous forms on laser printers are single sheets of paper that are fed with a paper cassette or a single bin sheet feeder.

Sometimes it is difficult to determine if the paper in a laser printer is continuous or comes from a sheet feeder with more than one bin. Generally, if a laser printer has only one place to get paper, the paper should be defined as continuous.

If your printer has more than one paper bin from which it can get paper, select Bin Number (2), then enter the number of the bin where the paper is located. The Helps and Hints screen for your sheet feeder may contain information about your sheet feeder bins.

Select Manual (3) if your paper is fed into the printer one sheet at a time.

Paper Size • This option (1) displays several common paper sizes to choose from. Select one that is displayed, or select Other (o) and enter your own dimensions.

Paper Size refers to the dimensions of the paper on which you will print. The dimensions are determined by the way the document is to be read. In other words, the first measurement (width) represents the edge of the paper parallel to text.
For example, on a 9.5" x 4" envelope, text is parallel to the long edge of the paper, so the paper width is 9.5". The paper height is 4".

If your printer cannot rotate its fonts (see Printing, Landscape) and you want to print a page landscape (long edge of the form parallel to text), the only possible way you can do so is to insert the long edge of the paper into the printer first. Make sure that the long edge of the paper (the insertion edge) is represented as the width measurement in the paper size. More information on landscape printing can be found in Printing, Landscape.

You cannot select Other, then enter a height or width that is smaller than your top or side margin settings (for example, .75" x 2" labels when the margins are 1"). You cannot create a definition smaller than your margins. You must first change your margins, then enter the desired height and width.

**Paper Type** • Paper Type is the name of the paper you are defining. You can select from several different predefined types of paper (for example, Cardstock or Letterhead). If you want to use a form other than those listed, select Other (9), then enter any name you want (for example, Susan’s Second Sheet Paper) to name your own paper type.

**Prompt to Load** • Select this option (4), then type y to have Corel WordPerfect prompt you when it is ready to print on this paper type. Your computer will beep and a message telling you to insert the paper will appear on the Job Control screen. Insert the paper, then type g to continue printing.

If you are printing directly to a remote printer, remotelp, remote lpr, remote aix, other spooler, or print to disk, this option has no effect.

**Text Adjustment** • If you find that text on the printed page is not located where you expect it should be (according to your margins), you may need to select this option (9) to make adjustments to the text.

If, for example, you set your top and left margins at the default of 1" and text does not start printing 1" from the top and left edges of the paper, try adjusting the text using this option.

This option moves text on the page. If you want to move text up, select Up (1), then enter the distance. If you want to move text down, select Down (2), then enter the distance. Always enter a positive number for the distance you want the text moved. If you select Up or Down, the amount you enter is displayed next to “Top.” If you select Left (3) or Right (4), the amount...
you enter is displayed next to “Side.” You can enter a text adjustment up or down and left or right.

If you want to return to the default of 0", select the same option you selected to adjust the text (for example, select Up (1) if the Text Adjustment option says “Up” next to it), then enter 0.

**Paper Size/Type Screen**

When you select Paper Size/Type (7), the screen displayed lists information about all the paper definitions for the currently selected printer. You can edit this information using the screen that is displayed when you select Edit (5) (see *Editing a Definition* above).

You can add, delete, or select the definitions displayed on this screen. (You cannot delete the [ALL OTHERS] definition.)

If you have not yet selected a printer, selecting Paper Size/Type takes you straight into the Format: Paper Size menu. Select a paper size (see *Paper Size* above), then select a paper type from the Format: Paper Type menu (see *Paper Type* above). “Requested Form is Unavailable” will appear next to Paper Size/Type on the Format: Page menu; however, a Paper Size/Type code is inserted into your document.

**Paper Type and Orientation**

The far left column of the Format: Paper Size/Type screen displays the Paper Type and Orientation of those definitions set up for the currently selected printer. This column displays the type of paper you selected (or that is already defined); if the width of the paper is greater than the height, the word “Wide” appears next to the type.

**See Also:** Printing—General Information; Printing, Landscape

---

**Paragraph Numbering**

Paragraph numbers can be used in Outline. Paragraph numbers also can be inserted anywhere in a document to number individual paragraphs. They are automatically updated to reflect any editing changes.

Paragraph numbers are differentiated by levels, then by numerals, letters, keyboard characters, Corel WordPerfect characters, or styles within a level. You
can have up to eight levels of paragraph numbering within a document, and this
differentiation lets you organize text in a hierarchical manner.

---

First level number

Second level number

Third level number

You can use numerals, letters, keyboard characters, Corel WordPerfect
characters, or styles to number paragraphs. Numbers are used in the rest of this
section to illustrate all of the possibilities.

If you are using paragraph numbers to create an outline, we suggest you also read
Outline, Create. Although you can create and edit an outline without using
Outline, it is easier to do so with Outline.

To insert paragraph numbers in your document,

1. Move the cursor to where you want to insert the paragraph number.
2. Press Date/Outline, then select Paragraph Number (5).
   Or □ Select Paragraph Number from the Tools menu.
3. Enter a level number to fix the number at a certain level (see Levels below).
   or
   Press Return to let Corel WordPerfect automatically determine the level for
   the paragraph number (see Levels below).

---

Notes

Appearance
The appearance of paragraph numbers is determined by Paragraph Number
Definition. When a Paragraph Number Definition code is located in a
document, all subsequent paragraph numbers conform to that definition. If no
Paragraph Number Definition code is located in a document, paragraph
numbers conform to the default (initial) settings for Paragraph Number
Definition.

Paragraph Number Definition lets you determine the starting number for
paragraph numbers as well as the appearance of the numbers themselves. Several
common paragraph numbering formats are included with Corel WordPerfect,
and you can define formats of your own.

For more information on the Paragraph Number Definition feature, see Outline,
Define.
Changing Levels

To change the level of an automatic paragraph number to the next level, move the cursor to the immediate left of an existing paragraph number, then press Tab or •Indent. To change the level of an automatic paragraph number to the previous level, move the cursor to the immediate left of an existing number, then press •Margin Release.

If the paragraph numbers are in an outline, you must place the cursor to the immediate right of the paragraph number for Tab to change the paragraph number to the next level or for •Margin Release to change the paragraph number to the previous level.

You can change the level of a fixed paragraph number in an outline by performing the same operation described in the paragraph above. Only the level number (not the position of the number) will change. You cannot change the level of a fixed paragraph number outside of an outline or an outline style inserted as a paragraph number.

Editing Paragraph Numbers

If you add or delete paragraph numbers from a document, the rest of the paragraph numbers are updated to keep numbering sequential. To delete a paragraph number, move the cursor to the number, then press Delete.

Levels

When you insert a paragraph number, you must determine its level, and you are given two ways of doing so. Using the first way, you insert a level number. Using the second way, you let Corel WordPerfect determine the level number.

If you decide to insert a level number, the paragraph number is a Fixed Paragraph Number [Par Num: number] (where number is the level number). This means that the paragraph number does not change its level number based on its tab stop position. For example, if you want the number to be a third level number even though it may be located at the left margin, enter 3 in step 3 above.

If a fixed paragraph number is in an outline, you can change its level number without changing its position on the page. If a fixed paragraph number is not in an outline, you cannot change its level number (see Changing Levels above).

If you let Corel WordPerfect enter a level number for you, the number is an Automatic Paragraph Number [Par Num:Auto]. This means that the paragraph number’s level depends on several factors, but that the level can always be changed with Tab and •Margin Release (see Changing Levels above).

The paragraph number’s level depends on the settings for the Paragraph Number Definition options and the location of any Paragraph Number Definition codes in your document. If you are interested in the Paragraph Number Definition options, read Outline, Define. Remember that the Paragraph Number Definition code affects all subsequent paragraph numbers.
Numbering
You can determine (or have Corel WordPerfect determine) the level for a paragraph number. The actual number for the paragraph number depends on the last paragraph number or Paragraph Number Definition code prior to the one you are entering.

Keep in mind that paragraph numbers are sequential in a document. You can restart paragraph numbering from time to time in a document, or you can start numbering at a number other than one. Numbers will continue sequentially from that point on in a document until you change numbering again.

When Corel WordPerfect encounters an Outline On code, it searches for the closest Paragraph Number Definition code preceding the Outline On code and uses those settings. This includes starting the outline with the specified Starting Paragraph Number.

For information on restarting or changing paragraph numbering in a document, see Starting Paragraph Number under Outline, Define.

Outline and Paragraph Numbers
When you use Outline to create an outline, you are simply inserting automatic paragraph numbers between outline codes.

If you are using Outline, you can insert paragraph numbers by pressing Return. You can move entire families of paragraph numbers and accompanying text to different locations in an outline, and you can keep paragraph numbering intact as you move an entire outline from one document to another.

If you are using Paragraph Numbering, you can insert single paragraph numbers anywhere in a document without having to turn Outline on or off. And, you can fix a paragraph number at a specific level.

If you want to insert fixed paragraph numbers in an outline, you can do so with Paragraph Numbering.

See Also: Outline, Create; Outline, Define; Outline, Style
Port Control options manage printer ports.

1. Press Print.
2. Select Control Port (8).

All defined ports are displayed on the screen.

3. Use the arrow keys to highlight the port you want to see. The upper portion of the screen details information about that port.

4. Select an option, then enter any requested information (see the specific option in Notes below).

5. Press Exit to exit the Port Control menu.

If you attempt to change the port on a system printer, you will receive an error message. Only the system administrator can modify a system printer. You can, however, modify any printer ports that you have set up.

**Notes**

Several options let you control the printer from Corel WordPerfect. Messages appear from time to time to assist you in solving most printing problems.

<table>
<thead>
<tr>
<th>Port Name</th>
<th>Date</th>
<th>Job Type</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Home User’s Home</td>
<td>1</td>
<td>FILE</td>
<td>Printing</td>
</tr>
<tr>
<td>Job Name</td>
<td>1 of 1</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Brief descriptions for each option on the Port Control menu follow. More detailed information on some can be found in other sections of Reference.

**Cancel**

Lets you cancel the current job (see Print Job, Cancel).

**Go**

Lets you enable a port by removing a hold.

**Hold**

Lets you disable a port. The current job will finish printing, but no other jobs will start.
Job Control
Lets you enter the Job Control menu. Only jobs for the port you select are displayed, and they are listed by priority. To list all your print jobs, select Job Control from the main Print menu (see Job Control).

Job Type
Lets you change a port’s Job Type (see Job Type).

Lower Screen Information

- **Job Type** • Lists the name you selected for a group of print jobs.
- **Jobs** • Gives the number of jobs in the port’s queue.
- **Port Name** • Gives the name of the port.
- **Status** • Refers to the current condition of the port. This field may include any of the following:
  - **E** Error (the error will be listed in the upper section)
  - **Idle** Idle
  - **H** Held
  - **P** Printing
  - **S** Stopped
  - **t** Starting print process
- **User** • Gives the name of the user currently printing on the selected port.

Stop
Stops the current job without canceling it. For example, you may want to use this feature if the paper jams or the ribbon runs out.

After fixing the problem, move to the Job Control menu by selecting Job Control (3), then choose Go/Restart (3) to continue or restart the job. The job resumes printing at the page you select (see Printing, Stop). While a job is stopped, no other jobs will print on that port.

Upper Screen Information
Additional information is listed in the top half of the screen. As you scroll through the highlighted port entries, these upper fields rewrite to correspond to your selection.

A brief description follows of items that are different from the categories in the lower screen.

- **Action** • Instructs you (when appropriate) to take certain action to correct situations and resume printing.
- **Copy** • Displays the number of the copy currently printing in relation to the number of copies selected from the Print screen.
- **Current Job #** • Lists the number of the job currently printing.
- **Current User** • Lists the user’s name for the job currently printing.
Print, Document on Disk

You may want to print a document that has already been saved on disk without retrieving the document to the screen. Print lets you print part or all of a document from disk, and also print the document summary.

1 Press Print.
   Or Select Print from the File menu.
2 Select Document on Disk (3), then enter the filename of the document you want to print.
3 Press Return to print the entire document.
   or Enter the pages you want printed (see Selected Pages below).

If the printer does not respond at this point, select Control Printer (4) to check for any messages or instructions (see Job Control). If you see a message telling you the document is not formatted for the current printer, see Printer Format below.

4 Press Exit to return to the normal editing screen.

Notes

Document Summary
You can print just the document summary for a document on disk by entering s when you are asked to enter the pages in step 3 above (pressing Return to print all the pages will not print the document summary). To print the document summary along with selected pages of a document, type s in step 3 above, type a comma (,), then enter the selected pages. Type s before entering the selected pages. For example, enter s,1–3 to print the document summary and pages 1 through 3. To print the entire document, including the document summary, enter s–. See Selected Pages below for details on printing selected pages of a document.

Even/Odd Pages
You can print the even or odd pages in a document by entering e for even or o for odd when asked which pages you want to print. The e or o must be the first thing listed or must follow the s for document summary (see Selected Pages below).
You can also print the even or odd pages in a range of pages (for example, e, 2-20). Similarly, you can print the even or odd logical pages (for example, labels) by entering le or lo.

**Fast Save**
A document saved with Fast Save (the default method for saving) can take longer to print than one saved when Fast Save is turned off. You need to be particularly aware of this when you print several documents from disk at the same time.

**List Files**
You can print any Corel WordPerfect file listed on the List Files screen without retrieving it first.

**Printer Format**
If the document you are printing from disk has been formatted for another printer, Corel WordPerfect indicates this and asks if the document should be printed anyway. Type y to print the document with the current printer. Printer-specific codes may be changed for the new printer.

**Selected Pages**
You can indicate individual pages or groups of pages to be printed by following these guidelines:

<table>
<thead>
<tr>
<th>Type:</th>
<th>To Print:</th>
</tr>
</thead>
<tbody>
<tr>
<td>n</td>
<td>Page n</td>
</tr>
<tr>
<td>s,n,m</td>
<td>Document Summary and pages n and m</td>
</tr>
<tr>
<td>n m</td>
<td>Pages n and m</td>
</tr>
<tr>
<td>n—</td>
<td>Page n through the end of the document</td>
</tr>
<tr>
<td>n–m</td>
<td>Pages n through m</td>
</tr>
<tr>
<td>s–</td>
<td>The beginning of the document through page m</td>
</tr>
<tr>
<td></td>
<td>Document Summary and entire document</td>
</tr>
</tbody>
</table>

For example, if you enter 4,7 or 4 7 as the selected pages, pages 4 and 7 are printed. If you enter 4,7,10–15 as the pages, then pages 4, 7, and 10 through 15 are printed.

If you have renumbered your pages with the New Page Number option on the Format: Page menu, Corel WordPerfect uses the new numbers when it prints selected pages.

**Section Numbers** ♦ For some larger documents, you may have used New Page Number several times to divide the document into sections. For example, you may have numbered a document in the following way:

<table>
<thead>
<tr>
<th>Section</th>
<th>Page Numbering</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preface</td>
<td>i–vii</td>
</tr>
<tr>
<td>Chapter 1</td>
<td>1–12</td>
</tr>
<tr>
<td>Chapter 2</td>
<td>1–20</td>
</tr>
<tr>
<td>Chapter 3</td>
<td>1–10</td>
</tr>
<tr>
<td>Index</td>
<td>i–iii</td>
</tr>
</tbody>
</table>
Notice in the above example that the preface and index have been formatted for lowercase Roman numerals, while the chapters are formatted for Arabic numerals.

When entering the numbers of individual pages to be printed, you can indicate a section by typing the section number, a colon, then the pages you want printed in that section (for example, 2:4–7 will print pages 4 through 7 of chapter 2). Sections for the two styles of page numbering (Roman and Arabic) are counted separately by Corel WordPerfect. So 1:12 indicates chapter 1, page 12, while 1:vi indicates preface, page vi.

The following table lists pages that can be entered for the example given above:

<table>
<thead>
<tr>
<th>Type:</th>
<th>To Print:</th>
</tr>
</thead>
<tbody>
<tr>
<td>i</td>
<td>Preface, page i</td>
</tr>
<tr>
<td>1</td>
<td>Chapter 1, page 1</td>
</tr>
<tr>
<td>11 or 1:11</td>
<td>Chapter 1, page 11</td>
</tr>
<tr>
<td>13</td>
<td>Chapter 2, page 13 (chapter 1 has only 12 pages)</td>
</tr>
<tr>
<td>2:i</td>
<td>Index, page i</td>
</tr>
<tr>
<td>–12</td>
<td>Preface and chapter 1</td>
</tr>
<tr>
<td>1–</td>
<td>Chapter 1, page 1 through the end of the document</td>
</tr>
<tr>
<td>2,2:2</td>
<td>Chapter 1, page 2 and chapter 2, page 2</td>
</tr>
<tr>
<td>1:1–2:3</td>
<td>The first page of chapter 1 (whether it is numbered as page 1 or not) through chapter 2, page 3</td>
</tr>
<tr>
<td>3:1–3:999</td>
<td>All of chapter 3</td>
</tr>
<tr>
<td>i–vii,i–iii</td>
<td>All of the preface and index</td>
</tr>
<tr>
<td>1:i–ii</td>
<td>Preface, pages i through ii</td>
</tr>
</tbody>
</table>

Notice that if no section number is entered, the first page of the document matching the entered page number (Roman or Arabic) is printed.

When printing selected pages, you must enter the page numbers in numerical order (for example, 1 must come before 3). If you enter 3,1 as the pages to print, only page 3 will print. If you have two sections, however, and you enter 3,1, page 3 of section 1 and page 1 of section 2 will print.

Spaces are allowed with section and page numbers only when used as range delimiters (for example, 2–5<space>8–10). For example, 1–35 prints pages 1 through 35, but 1–3 5 prints pages 1 through 3, then page 5.

See Also: Page Numbering; Print, Document on Screen; Print Options; Printing—General Information
Print, Document on Screen

As you create a document, you will often want to print part or all of that document. Print lets you print the page currently on the screen, selected pages of the document on the screen, the whole document, or just the document summary.

1 Press Print.

Or Select Print from the File menu.

2 Select Full Document (1), Page (2), or Multiple Pages (5) to print the whole document, the current page, or selected pages.

If you select Multiple Pages, enter the pages you want printed. If you press Exit with the “Page(s):” prompt on the screen, the full document is printed. (See Selected Pages under Print, Document on Disk for a detailed explanation of printing selected pages of a document.)

If your printer does not respond, display the Job Control screen to check the status of the print job.

Notes

Block
To print a block of text from the screen, block the text you want to print, press Print, then type y to send the block to the printer.

When you print a block of text, the text is printed on the page in the same format as in the document. For example, if the block of text you print starts 3 inches from the top of the page, the printed block will start 3 inches from the top of the page.

Document Summary
You can print just the document summary for the document on the screen by entering s after selecting Multiple Pages in step 2 above. To print the document summary with selected pages of the document, type s after selecting Multiple Pages, type a comma (,), then enter the selected pages. Type s before entering the selected pages. You can print the document summary plus the entire document by entering s— at the “Page(s):” prompt.

Full Document
This option prints the entire document, except the document summary. You must use the Multiple Pages option to print the document summary.

Multiple Pages
Select this option to print the document summary or selected pages of the document currently on the screen (see Selected Pages under Print, Document on Disk for a complete explanation).

Page
Select this option to print the page the cursor is on.

See Also: Page Numbering; Print, Document on Disk; Print Options; Printing—General Information
Print Color

Print Color lets you select the color of text on the printed page (if you have a color printer).

1. Press Font, then select Print Color (5).
   *Or* Select Print Color from the Font menu.

2. Select a color, then press Exit to return to the document.

3. Type the text you want printed in the new color.

Notes

Codes
Corel WordPerfect places a Print Color code (for example, [Color:Red]) in your document at the position where you select the color. Any text following the code is printed in that color until another Print Color code is encountered in the document.

Color Options
You have 11 preset colors that you can print. You can also create your own colors (see Creating Colors below).

- Black
- Blue
- Brown
- Cyan
- Gray
- Green
- Magenta
- Orange
- Red
- White
- Yellow

Color Percentages
The percentage amounts next to each print color represent the intensity level of red, green, and blue that combine to create the print color.

Creating Colors
To create any color you want, select Other (o) from the Print Color menu, then enter the desired intensity percentages for each displayed color (red, green, blue). You can also create a color by editing the color percentages of an existing print color. Select the color you want to edit, select Other, then enter the new intensity percentages.

*Not all color printers allow the changing of intensity percentages. Consult your printer manual for your printer's color capabilities.*
Existing Text
To change the print color of existing text, move the cursor directly before the text you want to change, then go through the steps for changing the print color, as described above. Then move the cursor to the end of the text you want printed in another color and repeat the process, selecting the original color.

On-Screen Color
Print color is independent of the on-screen color of text. When you want to change the on-screen color of text (for a color monitor), use Colors/Fonts/Attributes, not Print Color. Print Color does not change the display color, even on a color monitor.

Resetting Print Color
To reset the print color back to the original color (for example, black), press Font, select Print Color (5), select Black (1) (or whatever the original color was), then press Exit. From that point on in the document, the text will be printed in the original color.

To reset the entire document back to black, search for the Print Color code by pressing Search, selecting Font, then choosing Print Color (5). This sets the search line [Color]. Press Search again to begin the search. Then go into Reveal Codes and delete the Print Color code.

Selecting the Normal font does not reset the font color back to black.

Reversed-out Text
Use Print Color combined with a graphics box when you want to print reversed-out text (white text on a black background) on PostScript printers. You need to first go into the Graphics Options menu and specify 100% as the gray shading, then create a graphics box using Graphics. Next, you need to select Edit (9) from the box definition menu, go through the above steps for selecting a print color (specifying White (2) as the print color), then type the text you want reversed-out (see Graphics, Create and Graphics Options for details).

This method for printing reversed-out text currently works only with PostScript printers. Other printers may do this in the future.

See Also: Colors/Fonts/Attributes; Print, Document on Disk; Print, Document on Screen

Print Job, Cancel

If you discover that something is wrong with a print job (it is printing on the wrong type of paper, using the wrong font, and so on), you can cancel the print job.

1 Press Print.

Or Select Print from the File menu.
2 Select Control Printer (4), then select Cancel (1).

3 Enter the number of the print job you want to cancel.
   or
   Type an asterisk (*), then type y to cancel all print jobs.

4 Press Exit to exit the Job Control screen.

This process stops the flow of information from Corel WordPerfect to your printer. However, there
may be information left in the printer.

Notes

Additional Print Jobs
You can cancel additional print jobs not listed under the Job List heading. Just enter the number of the print job you want to cancel.

Advancing Paper
If you cancel a print job while it is printing, Corel WordPerfect advances the paper in your printer to the top of the next page. If you type c again after canceling a print job to cancel it immediately (see Canceling Immediately below), Corel WordPerfect does not eject the page and the paper may not be in the correct position. In this case, you will need to reset the printer.

Canceling Immediately
When you cancel a print job, Corel WordPerfect tries to complete a number of tasks in preparation for the next print job (for example, advance the paper to the top of the next page, unload any soft fonts marked with a plus sign (+)). If you type c again, then type y to cancel the print job immediately, these tasks are not completed and the printer will not be ready for the next print job.

The only time we recommend canceling a print job immediately is if the printer is not accepting input (so you cannot do a normal cancel). If you do cancel immediately, you will need to reset the forms in the printer and, if you have marked any downloadable soft fonts with an asterisk (*) (see Marking Cartridges/Fonts/Print Wheels under Cartridges/Fonts/Print Wheels), reinitialize the printer (see Initialize Printer under Printing—General Information).

Job Number
Every time you send a document to the printer, Corel WordPerfect assigns a number to that print job. The job number is listed in the far left column under the Job List heading. You can have as many as 999 print jobs waiting to print.

Print Spooler
If you are printing to a remote printer, this is an intermediate step on the way from Corel WordPerfect to the printer. Once Corel WordPerfect has sent the print job to the remote spooler, you can no longer cancel that print job from Corel WordPerfect.

Printer Buffer
Depending on the size of the printer’s buffer, a cancel may take a while. Everything that has already been sent to the printer must print before the printer will stop.
If an entire print job has already been sent to the printer’s buffer, canceling the print job will display a “Job not found” message. You can no longer cancel that print job.

See Also: Print, Document on Disk; Print, Document on Screen; Job Control; Printing, Stop

Print Options

The Print screen is divided into two different sections.

The Print Options section (the bottom half of the screen) gives you several options for changing the appearance of a printed document. These settings let you select a new printer and change the binding offset, number of copies, and print quality of a print job.

1 Press Print.

Or Select Print from the File menu.

2 Select an option, then enter the requested information (see the information on each option under Notes below).

3 Press Exit to display the document again.

Any changes you make to the options listed in the bottom half of the Print screen (except Number of Copies and Multiple Copies Generated by) are saved with the document. The settings for Number of Copies and Multiple Copies Generated by remain in effect until you change them again or exit the current document.

Notes

Banner
A banner records information about your print job that distinguishes and divides one print job from another. You can print a banner at the beginning of your job (header), at the end (trailer), or both by selecting yes or no at the option. (In order to print header and trailer pages, they must be defined by the system administrator.)

Binding Offset
Enter the amount of space you want text shifted to the right on odd-numbered pages and to the left on even-numbered pages for binding two-sided copies (see Binding).

Changing the Default
You can change the default setting for all the options on the Print Options section (the bottom half) of the Print screen (except Select Printer) using the Print Options menu on the Setup: Initial Settings menu (see Initial Settings). The changes you make there will remain in effect until you change them again.
Graphics Quality
Select this option, then enter the quality level at which you want to print graphics in your document (see Print Quality).

Job Type
Choose a name to group jobs together for printing at the same time (see Job Type).

Multiple Copies Generated by
This option lets you determine if multiple copies will be generated by Corel WordPerfect or by your printer. If the Output Type was defined as Remote Printer or Other Spooler within wpport, you can choose to have the spooler generate the multiple copies (see your system administrator for more information).

If Corel WordPerfect generates the multiple copies, it creates \( x \) number of copies of the print job, then sends them to the printer. The copies come out of the printer already collated. If you have your printer generate the copies, Corel WordPerfect sends one copy of the print job to the printer and tells the printer to make \( x \) copies of it (where \( x \) is the number entered for the Number of Copies option). The copies are not collated in this case. For example, if you are making 2 copies of a 3-page document, the printer will print 2 copies of page 1, then 2 of page 2, and so on.

The benefit of this option is that printing time can be shortened if you select Printer (or Spooler). However, if your selected printer does not support this feature, Corel WordPerfect will automatically generate the multiple copies at print time.

Number of Copies
Enter the number of copies of the document or portion of the document you want printed.

Printing
Many of the options listed in the Print section (the top half) of the Print screen send a document or part of a document to the printer. See Print, Document on Disk and Print, Document on Screen for details on these options.

Priority
Enter a number (1 to 100) to set the priority of a print job in the list of jobs to be printed. The lower the number, the higher the priority. The default priority number is 50 unless modified by the system administrator.

Select Printer
Select the printer where you want the document or portion of the document printed. The printer you select here remains selected unless you select another or retrieve a document that has been formatted for a different printer. However, when you exit the retrieved document, the Select Printer option returns to the default printer.
**Text Quality**
Select this option, then enter the quality level at which you want to print text in your document (see Print Quality).

The text quality you assign overrides any quality selections made directly at the printer.

*See Also:* Print, Document on Disk; Print, Document on Screen; Print Quality; Printing—General Information

---

**Print Quality**

When you want to print a “rough” draft of a document or increase the resolution of a graphics image printed in a document, use Print Quality. You can also print text and graphics in separate printings with this feature.

1. Press **Print**.
   
   *Or* Select **Print** from the **File** menu.

2. Select **Graphics Quality** (g), then select a print quality setting for graphics (see **Quality Settings** below).

3. Select **Text Quality** (t), then select a print quality setting for text (see **Quality Settings** below).

4. Press **Exit** to exit the Print menu.

   These settings affect the document on the screen and are saved with the document.

   *If your printer cannot print different qualities, this feature will have no effect.*

---

**Notes**

**.drs Characters**

If you are trying to print a character that your printer does not support (for example, one from a Corel WordPerfect character set), Corel WordPerfect creates that character from the .drs (driver resource) file that is included with Corel WordPerfect and prints the character graphically (if your printer prints graphics). See Appendix P: Corel WordPerfect Characters for details on extended characters.

Because these .drs characters are considered text and graphics, the Text and Graphics Quality settings must work together. If either of these is set to Do Not Print, .drs characters will not print. If neither is set to Do Not Print, .drs characters will print at the current Graphics Quality setting, unless the Text Quality is set to High. In this case, the .drs characters will print at the Text Quality setting.
Quality Settings
As print quality increases, text and graphics are printed with better resolution on the printed page. However, the higher the quality (particularly when printing graphics), the more time required to complete the print job (and the more memory required by laser printers). Rough drafts are printed faster because, by decreasing the print quality, you decrease the amount of data being sent to the printer.

Text, Graphics, or Both
Corel WordPerfect can print text and graphics together on most printers. Some printers, however, have trouble printing both text and graphics in the same printing. In these cases, you can use the Do Not Print option to print text only, reinsert the paper, then print graphics only.

If you use this method for printing, the .drs characters will not print at all (see .drs Characters above).

1 Press Print.
Or Select Print from the File menu.
2 Select Graphics Quality (g), then select Do Not Print (1).
3 Select Text Quality (t), then select a print quality setting for text (other than Do Not Print).
4 Print the document on the screen in the usual fashion (see Print, Document on Screen).
5 Select Graphics Quality (g), then select a print quality setting (other than Do Not Print).
6 Select Text Quality (t), then select Do Not Print (1).
7 Reinsert the paper and print the document again.
8 Change the quality settings back to their normal settings, if desired.
9 Press Exit to exit the Print menu.

Important: If you are printing graphics with double-high fonts on a dot-matrix printer, you may need to use the above procedure to print the page correctly.

See Also: Print, Document on Disk; Print Options; Printing—General Information

---

Printer, Edit
You can edit a printer’s name or settings when you define the printer. You can also change printer settings after you have defined the printer. See Printer, Select for details on defining a printer.
Corel WordPerfect automatically takes you to the Select Printer: Edit screen when you are defining a printer. Once in the screen, the information given under Notes below applies.

To edit the printer settings of a printer you have already defined,

1. Press Print.
   Or Select Print from the File menu.

2. Choose Select Printer (s), move the cursor to the printer definition you want to edit, then select Edit (3).

3. Make any desired changes by selecting an option, then entering the change (see the information for each option under Notes below).

4. Press Exit twice to return to the Print menu, saving any changes you made.

Notes

**Cartridges/Fonts/Print Wheels**
This option (4) lets you select the cartridges and fonts (in addition to the printer’s built-in fonts) you plan to use when printing a document (see Cartridges/Fonts/Print Wheels).

**Initial Base Font**
When you select a printer (see Printer, Select), Corel WordPerfect automatically selects an initial base (default) font for the printer from the list of the printer’s built-in portrait fonts (see Cartridges/Fonts/Print Wheels). To change the initial base font for the current printer, use Initial Base Font (5). A list of your printer’s built-in portrait fonts, plus any portrait fonts you marked with the Cartridges/Fonts/Print Wheels feature, is displayed. Move the cursor to the font you want to select, then choose Select (1).

The Initial Base Font setting affects all new documents you create. For information about changing the base font for one document or part of a document, see Font.

**Name**
When you are defining a printer, Corel WordPerfect enters the name of your printer for you. Use Name (1) to change the name of the printer definition. You can enter as many as 36 characters. The following characters cannot be used when naming a printer definition: ;<>?@.

The printer name appears on the Print: Select Printer screen and is independent of the printer definition filename (displayed at the top of the Select Printer: Edit screen).

**Path for Downloadable Fonts and Printer Command Files**
This option (6) displays the directory where Corel WordPerfect should look for downloadable font files (see Cartridges/Fonts/Print Wheels) and printer command files (see Printer Commands). Use this option if your downloadable font files are stored somewhere other than the printer files directory (specified using Location of Files on the Setup menu). Be sure to enter a complete pathname.
Port
Port (2) designates the location of output during a print job. A port must be chosen for each printer selected. Select any of the locations defined by your System Administrator or select Disk to print to disk.

Sheet Feeder
A sheet feeder is used to feed paper into a printer. If you have a sheet feeder, use this option (3) to select it (see Sheet Feeder).

*If you have a laser printer with a single paper bin, this bin is not considered a sheet feeder.*

See Also: Cartridges/Fonts/Print Wheels; Printer, Select

---

**Printer, Select**

Before you can print a document, you need to select a printer. The process of selecting a printer includes installing information specific to your printer into a directory where Corel WordPerfect can find it. It also includes entering information that Corel WordPerfect uses to communicate with your printer.

The printer selection process begins when you install Corel WordPerfect. During installation, you are taken through the steps of telling Corel WordPerfect which printer you will be using and installing a printer file into the appropriate spot for Corel WordPerfect to access that file.

You can select a printer during installation; however, once you have used the Installation Program to install your printer files into a directory, you can also select a printer from within Corel WordPerfect.

Corel WordPerfect comes with several .all files (located on the Printer diskettes or tape) that contain information about various printers. When you select a printer, Corel WordPerfect installs the information specific to your printer from the .all file, then creates a file with a .prs extension. Every time you print, Corel WordPerfect accesses that .prs file (see .all and .prs Files under Printing—General Information).

Select Printer lets you select, copy, delete, edit, or update a printer definition.

1. Press **Print**.
   
   *Or  **Select Print from the File menu.***

2. Choose Select Printer (s) and the Print: Select Printer screen is displayed.

   This screen lists the currently defined printer definitions from which you can select your printer.

3. Choose an option, then enter the necessary information (see the information for each option under Notes below).

4. Press **Exit** until you return to the normal editing screen.
Additional Printers

Select Additional Printers (2) to select a printer that is not listed on the Print: Select Printer screen. A list of all the printers found on the .all files you installed during installation is displayed when you select this option. The list displays all the printers found in the printer files directory—specified using Location of Files in Setup.

To display more printers, run the Installation Program again, installing additional printer files. If you install all the printer files and your printer is still not displayed, see Printer Not Found below.

Help • Selecting Help (3) in this screen does the same thing as selecting Help in the Print: Select Printer screen (see Help below).

List Printer Files • Each printer you add to the printer definition list on the Print: Select Printer screen is saved as a printer file with a .prs extension. Use this option (4) to view all printer files (those ending in .prs) in the printer files directory, even those that have been deleted from the Print: Select Printer screen.

Once you display these files, you can choose Select (1) to add the printer to the printer definition list again. If you choose Select with a printer file that is already on the Print: Select Printer screen, the printer will appear twice on the list. These two definitions reference the same printer file; however, some options on the Select Printer: Edit menu can be different. To create a new definition by copying an existing definition (thus creating a separate printer file), use Copy (4) on the Print: Select Printer screen (see Copy below).

Name Search • Select this option (n), then start typing the name of a printer to move the cursor to that printer on the list. Press Return or an arrow key to exit Name Search.

Other Directory • Use this option (2) to specify where (in which directory) the printer files (those ending in .all) have been installed. This option is especially helpful if you have printer files in a directory other than the shlib directory.

Select • Use this option (1) to add a printer definition to the Print: Select Printer screen.

After you select this option, a filename for the printer definition is displayed. Press Return to accept the filename or type a new filename (be sure to include a .prs extension). The Printer Helps and Hints screen for that printer is then displayed (see Help below). Press Exit when you finish reading the information there, and the Select Printer: Edit screen is displayed. This screen lets you edit the name and settings for the printer you are adding to the Print: Select Printer screen (see Printer, Edit). When you finish editing the printer settings, press Exit to display the definition on the Print: Select Printer screen.
Copy
This option (4) lets you make a copy of a printer definition. When you select this option, a filename appears that is slightly different from the one being copied. Press Return to accept the new filename, and you are taken through the same steps as when you are adding a printer to the Print: Select Printer screen (see Select under Additional Printers above).

Delete
Select this option (5), then type y to delete a printer definition from the list.
Although this deletes the definition from the Print: Select Printer screen, the .prs file (where the definition is saved) remains in your printer files directory. (To completely delete a definition, you must delete the .prs file also.)
You can restore a deleted printer definition with List Printer Files (4) on the Select Printer: Additional Printers menu (see List Printer Files under Additional Printers above).

Edit
Use this option (3) to change the settings Corel WordPerfect needs to communicate properly with a printer (see Printer, Edit).

Help
Select this option (6) to display the Printer Helps and Hints screen for the highlighted printer definition. If you have selected a sheet feeder, press Switch after selecting Help to see the Sheet Feeder Helps and Hints screen.

Printer Not Found
If your printer is not displayed after you have installed all the .all files using the Installation Program, consult your printer manual or manufacturer for a suitable emulation, or select the “Standard Printer” definition.
We suggest you do not use the Standard Printer definition to print on a laser printer because many features are lost.

Select
Use this option (1) to select a printer definition. All new documents are saved with that definition’s formats and settings until you select a different printer definition. The name of the printer appears next to the Select Printer option on the Print menu.

Update
This option (7) is used to update your .prs (printer resource) files if you receive a newer version of a .all file. The .all files are found on the Printer disks and contain all the printer information.
To use Update, rename or delete the old .all file from which your .prs file came. Then run the Installation Program, installing the printer disks into the same directory as the old .all file. Once the disks have been installed, go into the Print: Select Printer screen in Corel WordPerfect, highlight a printer name, then select Update.
If you have altered your old .all file or .prs file with a soft font installation program or with the Corel WordPerfect Printer program, you will probably want to rename (using Move/Rename on the List Files menu) rather than delete the .all and .prs files. This way they will still be available if you want to use them (see Font Libraries under Printer Program).

See Also: Printer, Edit; Printing—General Information

### Printer Commands

Your printer manual may contain several printer commands that take advantage of the special functions of your printer. Printer Commands lets you insert these commands into your document.

**Important:** The commands do not affect the formatting of your document on the screen.

Be aware that most situations in which you might want to use a printer command are taken care of by Corel WordPerfect features. Sometimes the use of printer commands leaves the printer in an unpredictable state. Use printer commands with care.

1. Move the cursor to where you want to insert the printer command.
2. Press **Format**, then select **Other (4)** from the Format menu.
   
   *Or* **Select Other from the Layout menu.**
3. Select Printer Functions (6), select Printer Command (2), then select Command (1).
4. Enter the commands to be sent to the printer (see **Entering Command Codes** below).
5. Press **Exit** to return to the normal editing screen.

#### Notes

**Entering Command Codes**

Command codes less than 32 decimal and greater than 126 must be entered in angle brackets (<>). Codes between 32 and 126 decimal (printable characters) may be typed or entered in decimal or in angle brackets.

If a large number of codes must be sent to the printer, you can create a file of these codes using a text editor. Corel WordPerfect sends the entire file to the printer.

To insert a printer command file code into a document,

1. Move the cursor to where you want to enter the file.
2. Press **Format**, then select **Other (4)** from the Format menu.
   
   *Or* **Select Other from the Layout menu.**
3. Select Printer Functions (6), select Printer Command (2), then select Filename (2).
4 Enter the filename, then press Exit to return to the document.

The contents of the printer command file are not displayed on the screen but are sent to the printer when the document is printed.

If the text of a printer command prints, your printer is not recognizing it as a printer command. Check your printer manual and make sure you have entered the command correctly.

You do not need to enter a path with the filename in step 4 above. In fact, any path you enter is ignored. The file must be located in the directory specified using Path for Downloadable Fonts and Printer Command Files (6) on the Select Printer: Edit menu (see Printer, Edit).

Resetting the Printer
If you send a printer command (whether by itself or in a file) to your printer, you may need to reset the printer to make sure that the command does not corrupt the remainder of the print job.

Reveal Codes
You can see the printer commands you enter by pressing Reveal Codes.

See Also: Print, Document on Disk; Print, Document on Screen; Printing—General Information

Printer Functions

After printing a document (or looking at it in View Document), you may see things you want to change. For example, you might have too much white space between letters in a word or between words. You can instruct your printer how to handle special printing situations like these.

With the cursor at the point in the document where you want the feature to start,

1 Press Format, then select Other (4).

   Or Select Other from the Layout menu.

2 Select Printer Functions (6).

3 Select an option, then make the desired adjustments (see the information for each option under Notes below).

4 Press Exit.
Normally, text is not printed within the top margin of a page. The top of the first line of text is even with the top margin. The letters in the line sit right on the baseline, placing the baseline of the text below the top margin.

Alert: Retirement may be hazardous to your health. A recent study conducted by the Institute of Health and Wellness shows that older adults who engage in an exercise program during their 60s and 70s fare better in their 80s.

This is significant because more and more older adults are living to see their 85th and 86th birthdays. By 1995, 10 percent of all Americans will be octogenarians.

Also by that date, expenses for hospital care are expected to double. This is an important consideration since many insurance companies are limited in the amount of medical coverage they can extend to older adults.

According to Dr. Dan Maryon, the best way to prepare for the age of 80 is to exercise now. "It doesn't really matter what kind of exercise program older adults choose," he states, "just as long as they are active."

Bicycling

The key to sticking with an exercise program is finding one that is enjoyable. For older adults, this means developing a program that is not only fun, but also safe. In order to avoid injury, the older adult should choose a low-impact activity. For many, the answer is to ride the bicycle.

One of the most accessible forms of exercise, bicycling can be done in all kinds of weather and at any time of the day. A 20-minute to 30-minute ride three times a week is a sufficient

Because Corel WordPerfect places the first baseline of the page below the top margin, changing the fonts in that first line of text causes the placement of the baseline to vary.

When you want to be precise in placing text on a page, you need that first baseline to remain constant. Setting the Baseline Placement for Typesetters option (5) to Yes causes the first baseline to be placed even with the top margin of the page (that is, the text sitting on that baseline extends up into the margin). This ensures that the first baseline of the page will always be placed in the same spot (that is, even with the top margin), regardless of the font.

This option affects any feature that places text in a specific position on the page. For example, if you use Advance to move text down the page a specified distance, the baseline of the line of text is placed below that specified distance, unless you set the Baseline Placement for Typesetters option to Yes. If you set this option to Yes, the baseline of the text being advanced is placed precisely at the measurement you enter.

Once you set this option to Yes, you need to set the Line Height to Fixed and enter a fixed line measurement (see Line Height).
For example, with the Baseline Placement for Typesetters option set to Yes, an 8.5" x 11" page with a 1" top margin and a 1" fixed line height would have constant baselines one inch apart on the page, as in the following illustration.

![Baseline Placement Illustration](image)

Every line on the page will be placed on one of these baselines, regardless of the font sizes you use.

**Codes**
When you select a printer function, that setting remains in effect from that point forward.

**Kerning**
This option (1) allows for space reduction between specific letter pairs (for example, W, A) as defined in the .prs file. This eliminates excessive white space (see Kerning).

*Not all printers support kerning.*

**Leading Adjustment**
This option (6) lets you set the amount of spacing assigned to Soft Return codes [SRt] and Hard Return codes [HRt] (see Return, Soft and Hard).

Normally, hard and soft returns are assigned the same amount of spacing. However, you might want to add different amounts to these codes in certain applications. For example, suppose you wanted to get double-spacing between single-spaced paragraphs without having to press Return twice. Select Leading Adjustment (6), and the cursor moves to the Primary [SRt] entry. Press Return to accept the default setting and move the cursor to the Secondary [HRt] entry. Enter 1u as the value for Hard Return codes [HRt].

Entering 1u tells Corel WordPerfect to *add* one line of space in the current unit of measurement (see Units of Measure) to the amount already allotted for a hard return. Corel WordPerfect then calculates the exact measurement for that line of space and displays it on the screen in the Secondary [HRt] entry. This saves you from having to calculate that measurement.
You can then press **Exit** to return to your document. A Leading code [Leading: #, ##] is inserted into your document, where # is the leading being added to Soft Return codes and ## is the leading being added to Hard Return codes.

From that point forward when you type single-spaced text, press **Return** once to separate two paragraphs. Corel WordPerfect inserts the equivalent of two blank lines between all paragraphs that are separated by a Hard Return code. This extra blank space does not appear in the normal editing screen. You can only see it using View Document or by printing the document.

If you want triple spacing between paragraphs that have double-spaced text (see **Line Spacing** for details on double spacing text), enter 1/2u in the Secondary [HRt] entry. This tells Corel WordPerfect to add one half the current measurement or, in other words, one line of space to the amount already allotted to every Hard Return code [HRt].

Consider another application of this feature: You can enter 2p for both the [SRt] and [HRt] options if you want 2 points of leading added to any leading assigned to each line (regardless of the point size of the font). This means that you will always have 2 extra points of leading added to every line. This adjustment will be made whether the line height is fixed or automatic.

You can also enter negative numbers for this feature to decrease the amount of leading.

**Printer Command**
This option (2) lets you enter a string of printer codes or download a file that is sent directly to the printer when the document is printed.

**Word and Letter Spacing**
This option (3) lets you fine-tune the spacing between words and/or letters.

**Word Spacing Justification Limits**
This option (4) adjusts spacing between words in justified text.

**See Also:** Justification; Kerning; Line Height; Printer Commands; Word and Letter Spacing
To print documents, codes must be interpreted for your printer. The "translation" codes are held in the .all files. Each .all file contains translation information for similar printers.

When you select a printer, a .prs file is created specific to that printer from the information in the .all file. You edit the .prs file in the Select Printer: Edit menu (see Printer, Select).

The Printer Program makes the adjustments to .prs files (or .all files) that cannot be made in the Select Printer: Edit menu. Although most users will never use the Printer Program, some users may use it quite often. Some Printer Program tasks require a great deal of technical knowledge.

This section describes basic Printer Program concepts. The Printer Program, Customize Substitute Fonts and Printer Program, Modify Automatic Font Changes sections document two of the more common applications associated with the Printer Program. The PTR program has an extensive Help menu to assist you (see Help below).

Before starting the Printer Program, make a backup of the .prs or .all file you want to edit.

To start the Printer Program,

1. Be sure you have a backup copy of the .prs or .all file you want to edit.
2. Go to the UNIX prompt.
3. Change to the directory where the Printer Program is located.
   The Installation Program copies this file to the shbin directory.
   The WPTERM7 environment variable must be set for your terminal before you start ptr.
4. Enter `ptr` at the UNIX prompt to start the Printer Program.
5. Once in the Printer Program, press Retrieve, then enter the name of the file you want to edit (for example, hplaseii.prs or wphp1.all). You may include a full pathname if the file is not in the current directory.
   If you have forgotten the name of the .prs or .all file, use List Files to find and retrieve the file. If you have already saved a file during this session with the Printer Program, the name of that file appears as a default when you press Retrieve.

---

**Notes**

**Consistency Check**

To check for any inconsistencies in the new .prs or .all file, press Consistency Check at the Printers menu (see Menu Structure below). The Printer Program performs a consistency check on the printer definition currently highlighted. The information about any inconsistencies is saved in a file named prs.err (located in the current directory), and the contents of the file are displayed on the screen in Look mode (where you can look at but not edit the file).
You can scroll up and down in the document with the arrow keys, or use Search to go to specific points in the document. If there are no inconsistencies, no information is displayed and no prs.err file is created. Press Exit, Return, or the Space Bar to exit the document. You can also retrieve the prs.err file into Corel WordPerfect.

Subsequent consistency checks (pressing Consistency Check) replace the prs.err file without prompting you.

Convert to New Format
If a “Convert to New Format? (Y/N) N” message appears when you are retrieving a .prs or .all file, the file was created under a version of the Printer Program that is older than the one currently on your screen. In most cases, you will want to type y to convert the file. Once the file is converted and saved, however, you will not be able to retrieve it again into an older version of the Printer Program.

Any .prs or .all files that you have customized with 5.0 or 5.1 can be converted to 7c format by answering Yes to the “Convert to New Format? (Y/N) N” prompt. You can also convert them by using the -convert filename startup option (see Startup Options below). However, you may have better results using the printer definitions that come with Corel WordPerfect 7c.

Exiting the Printer Program
To exit the Printer Program, press Exit at each menu until you arrive at one of the seven main menus (see Menu Structure below). Once you arrive at one of the seven main menus, press Exit one more time to exit the Printer Program. As a shortcut to pressing Exit repeatedly, you can press Quit to exit from anywhere in the program.

The prompts that appear when you exit are the same as in Corel WordPerfect. To save changes after pressing Exit at a main menu or Quit from any menu, type y to save the file, press Return (or enter a new filename), then type y to replace the current file (or create a new file). Remember to include a .prs or .all extension as part of the filename. The actual type of the file and the extension must match. If you give a .all file a .prs extension or a .prs file a .all extension, the file will no longer be usable. (If you make this mistake, rename the file with the correct extension.)

The .prs files are created (extracted from the .all file) when you select printers. If the file you are using was not created this way, use a .all extension.

If you do not want to save the changes, type n when asked if you want to save the file. When the exit message appears, type y to exit the Printer Program or type n to stay in the Printer Program.

Font Libraries
Font libraries are groups of fonts. Shareable font libraries may have any name (up to 36 characters). Non-shareable font libraries have the exact name as the printer for which they were created. Fonts in a shareable library can be copied to a non-shareable library and vice versa, but only shareable libraries can be copied from one .all file to another.
You can use the Printer Program to create and copy fonts within a .all file or shareable font libraries from one .all file to another. This is useful when you have added fonts from a third-party software company to a 5.0 .all files, and you want to copy them to the 8c file.

1. Retrieve the 5.0 .all file that has the fonts you need into the Corel WordPerfect 8c version Printer Program. Because it is a 5.0 file, type y when you are prompted to convert the file.

2. Highlight the printer you want to edit and press Return.

3. At the menu that appears, highlight Fonts and press Return.


5. Enter a name to create a shareable font library.
   
   or
   
   Press Return without entering a name to create a non-shareable font library.

6. Select Soft (KB) (2).

7. Highlight the library on the list that contains the fonts you want to copy and press Return.

   If you convert a 5.0 .all file, all font libraries will have the same name as the printer because they are non-shareable.

8. Use the arrow keys and asterisk (*) to mark each font you want copied to the new font library, then select Copy (4).

9. Highlight the font library you just created and press Return.

10. Press Exit to return to the list of font libraries.

11. Highlight the font library you just created and select Copy (4).

12. Enter the name of the 8c .all file to which you want to copy the new font library.

13. Exit the .all file you are editing, then retrieve the .all file to which you copied the font library.

14. Highlight the printer and press Return.

15. Highlight Fonts and press Return.

16. Highlight the font library you copied and type an asterisk (*).

17. Exit and save the .all file, then exit the Printer Program.

Help
You can press Help from any place in the Printer Program to display a template for the Printer Program with some information about using Help.

If you press Help again, you are placed in a help screen with the cursor on the information available for the items in the current menu.
You can display the information for a given feature by pressing the keystrokes for the feature (as listed on the template). Other keys, such as Backspace and Delete, display a glossary of keystrokes and text describing the keystrokes’ purpose.

Press the Space Bar to return to the menu.

**List Files**

List Files has been included in the Printer Program. Whenever you are requested to enter a filename, (for example, when you press Retrieve to retrieve a .prs or .all file), you can press List Files, then enter the path and filename pattern for the directory you want to see.

The default path that appears when you press List Files includes the path to the current directory, plus an extension in the filename pattern. If you have already retrieved a file, the extension is the same as the file you have retrieved. If you used the -afc or -sub startup options (see Startup Options below), the extension is .prs. Otherwise, the extension is .all.

**Menu Structure**

The Printer Program has seven main menus:

- Printers
- Font Libraries
- Sheet Feeders
- Typefaces
- Character Maps
- Proportional Spacing Tables
- Kerning Tables

When you start the Printer Program, the Printers menu is displayed. Press Help for a list of the keys used on your terminal to access each of the other menus. You can add, delete, rename, or copy any of the items listed in these menus.

Each item represents an organized group of information. Some information is organized in tables while other information is organized in submenus. By placing the cursor on an item listed in a menu and pressing Return, a table or another menu (submenu) is displayed.

When you are in a menu, you can continue moving to the information you need to add or edit by placing the cursor on an option and pressing Return. As you move through a series of menus, a “map” is displayed at the top of the screen that traces the path through which you moved to reach the current menu or table.

*If you use a function key to move to a menu, the map displays only the menu from which you started.*

You can move back through the path a menu at a time by pressing Exit until you reach the menu where you started. At that point, press Exit again to exit the program and save the changes to the .prs or .all file. (You can also use Quit as a shortcut to exit the Printer Program. See Exiting the Printer Program above for more information.)
Printing a Definition
Text In/Out in the Printer Program creates a Corel WordPerfect document containing the information in a printer definition. You can retrieve or print this document to get an overall view of what is defined for a printer.

1. Retrieve the .prs or .all file.
2. If you retrieved a .all file, move the cursor to the definition you want to print.
3. Press Text In/Out.
4. Enter a filename (or full pathname) for the document to be created.

If you do not enter a filename (or pathname) in step 4, the document is saved as ptr.out in the current directory.

One of two basic versions of the document is created. If the .prs or .all file contains only one printer definition, information on every aspect of the definition is included in the file. (It may be very long.) If the .prs or .all file contains multiple printer definitions, a shorter version of the file is created, containing abbreviated information about the definition currently highlighted.

Generally a .prs file contains only one definition. However, if you want the shorter version, you can add a dummy definition using Add (1) at the Printers menu, then use Text In/Out. Be sure to delete the dummy definition before saving the file.

Startup Options
The following startup options are available for the Printer Program:

`filename` • Automatically retrieves the named .prs or .all file into the Printer Program (for example, ptr /shlib/hplassen.prs).

`-50point filename` • Converts a .prs or .all file to 8c. This maintains line height and spacing values but cannot be used with PostScript files.

`afc` • Provides a shortcut for getting to the Automatic Font Changes list in the program (see Printer Program, Modify Automatic Font Changes). After starting the Printer Program with this option, you would retrieve the .prs file, cursor to the printer and press Return, then press Return again at the font for which you want to modify the automatic font changes. The Automatic Font Changes list then appears.

`-autofont` • The -autofont startup option allows you to add third-party font information to your .all files. For more information on AutoFont, see Printer Program, AutoFont.

`-convert filename` • Converts a .prs or .all file to 8c format and exits the Printer Program. Using this option is the same as answering Yes to the “Convert to New Format? (Y/N) N” prompt (when retrieving the file) and then saving the file, except that with this option, the file is immediately converted (there is no confirmation prompt).
-mono • Use this option if you have a plasma, LCD, or composite display monitor.

-sub • Provides a shortcut for getting to the Substitute Fonts list in the program (see Printer Program, Customize Substitute Fonts). After starting the Printer Program with this option, you would retrieve the .prs file, cursor to the printer and press Return, then press Return again at the font for which you want to substitute another font. The Substitute Fonts list then appears.

-units=n • Sets the units of measure to inches, centimeters, points, or Corel WordPerfect units, where n is:

  i or " for inches
  c for centimeters
  p for points
  w for 1200ths of an inch

See Units of Measure for more information.

-update inputfilename outputfilename • Copies the font libraries (or font groups) from the input .all file to the output 8c .all file. For example, suppose you have added a font library to a .all file, then you receive an updated .all file that has enhancements you want to use. You could use this option to copy the font information from your modified .all file (input file) to the updated .all file (output file). For information about copying font libraries from a 5.0 .all file, see also Font Libraries above.

See Also: Printer, Select; Printer Program, Customize Substitute Fonts; Printer Program, Modify Automatic Font Changes

Printer Program, AutoFont

The Corel WordPerfect Printer Program (ptr) has a -autofont startup option that supports the AutoFont technology recently introduced. This option allows users to add third-party font information to their .all files. This option affects cartridge, built-in, and soft fonts.

For now, ptr -autofont only works with PCL 4 compatible printers such as the HP LaserJet Series II for non-scalable typefaces, and with PCL 5 compatible printers, such as the HP LaserJet III, that support scalable typefaces.

You must first run the AutoFont Support Installer that the font vendor supplies. This creates the AutoFont directory from the root directory and installs the glue.txt and tfm files that the Printer Program uses to modify the .all files.

You can check for the glue.txt and tfm files by looking in the AutoFont directory.

Each time you use AutoFont Support to add new typefaces to your hard disk, you should run ptr -autofont to update your .all files.
To use ptr/autofont,

1 Switch to the directory where the Printer Program is located.

2 Enter `ptr -autofont`. The Printer Program searches available .all files and displays a list of printers supporting AutoFont. Highlight the printer that you want to update with AutoFont information, then choose Select Printer(s) (1) to mark the printer. You can then mark additional printers.

   or

   Enter `ptr -autofont filename.all` from the UNIX prompt, where `filename.all` is the .all file that needs added information.

To update multiple .all files, do not include the .all filename when invoking ptr -autofont.

If glue.txt is not in the AutoFont directory of the current drive, you are prompted for the path.

The Printer Program looks in the current directory, then the directory that holds ptr, for the required .all file. If the Printer Program cannot find the .all file, it prompts you to enter the full pathname for the file. In this case, you should know the location of the .all file. If the .all file cannot be found, you may not have installed your printer .all files. You may need to run the Corel WordPerfect Install Program to install the .all file for your printer.

3 Select Add Autofont (2), then type `y` to add AutoFont to the selected printers. If the Printer Program does not encounter any problems, it displays the message "Autofont successfully installed. Press any key to continue." Press a key.

4 Press Return to exit the Printer Program.

For more help with -autofont, press Help twice from the Printer Program.

---

**Notes**

**Necessary Files**

You need the .all file that contains the information used to create your printer definition. The default directory during installation for .all files is your shlib directory.

If you are not sure in which directory your printer files are located, go into Corel WordPerfect, press Setup, then Location of Files (6). The directory where Corel WordPerfect looks for your printer files is listed under Printer Files (4). If the Printer Files directory is not shlib, use the Printer Files directory instead to look for your files.

ptr -autofont requires two types of files which are created by the font vendors’ AutoFont installer: a tfm (Tagged Font Metrics) file for each font, and a glue.txt file that tells the Printer Program which fonts to load into specific font libraries in the .all file. Information extracted from the tfm files include character maps, proportional spacing tables, and select strings.
Symbol Sets
You can use the -symset startup option with -autofont. This option allows you to add fonts with a specific symbol set. To use this option,

1. Enter `ptr -autofont -symset`.

This displays a menu of supported symbol sets. Only those fonts in glue.txt that support the requested symbol set will be added. You can select the symbol set directly by entering `ptr -autofont -symset=x`, where x is the value from the menu for the desired symbol set.

If you do not use the -symset option, the following priorities determine the symbol set used for each font. If, in glue.txt, all the symbol sets used in the HP III PC-8 character map are available, this map will be used with the default symbol set of PC-8. If all the symbols are not available, the DeskTop symbol set will be used. If DeskTop is not available, the last symbol set listed for the font in glue.txt is selected. ITC Zapf Dingbat fonts are added with the PS ITC Zapf Dingbat symbol set. Dingbats map to the Corel WordPerfect character set 12.

Typefaces/Fonts
To make your typefaces or fonts active so you can select them within your document, perform the following steps after AutoFont has been installed and the .all file has been updated:

2. Press Print, then choose Select Printer (s). Highlight your printer, then select Edit (3).
3. Select Cartridges/Fonts/Print Wheels (4) to change the cartridge and font information.

If your typeface collection is on a cartridge,

1. Select Cartridges.
2. Type an asterisk (*) to mark the name of the cartridge you want to install. Continue with Step 4 below.

If you are using disk-based typefaces,

1. Select Soft Fonts.
2. Select the AutoFont font group that contains the typefaces you want to use.
3. Mark all the typefaces that you want to use in Corel WordPerfect.

You can mark typefaces with an asterisk (*) or a plus (+) symbol, or both, depending on the way you use them in Corel WordPerfect. (See Marking Cartridges/Fonts/Print Wheels under Cartridges/Fonts/Print Wheels for details.)

Important: Marking soft fonts tells Corel WordPerfect which soft fonts you have. You must tell Corel WordPerfect where these fonts are by specifying a path using the Path for Downloadable Fonts and Printer Command Files option on the Select Printer: Edit menu (see Printer, Edit).
4 Press **Exit** until you return to the Print: Select Printer menu. Select the printer which has the fonts that you just marked, then press **Exit** until you return to the normal editing screen.

5 Press **Font**, then select Base Font (4) to select or change fonts within your document.

If you select a scalable font, the screen will prompt you to enter a point size. You can enter any point size ranging from 0.2 point to 999.7 points (about 14 inches).

**See Also:** Cartridges/Fonts/Print Wheels; Printer, Edit

---

**Printer Program, Customize Substitute Fonts**

You may want to use the Printer Program for customizing substitute fonts.

Substitute fonts are used by Corel WordPerfect on a character-by-character basis to produce characters that are not found in the current font. By assigning substitute fonts, you can usually print more characters. A useful application for Substitute Fonts involves printing characters in the Corel WordPerfect character sets.

*Substitute fonts are automatically set up when you select printers. Use the Printer Program to change the default substitutions.*

In the discussion below, “character” refers to a character in one of the 12 character sets.

When sending characters to the printer, Corel WordPerfect first looks for each character in the base font. (If there is an Automatic Font Change (AFC) set up for the character set, the AFC font becomes the base font while Corel WordPerfect tries to print it.) If the character is found, it is printed. If the character is not found, Corel WordPerfect tries to build it using a base character and diacritical marks. If it can’t build the character, it looks for it in the substitute fonts for the base font. If it can’t find the character in the substitute fonts, Corel WordPerfect prints it in graphics (if the printer you are using supports graphics).

The difference between an automatic font change and a substitute font for characters in character sets is that an automatic font change is used for *every* character in a specific character set, while a substitute font is used only for missing characters, but in *all* character sets.

Up to nine substitute fonts are automatically assigned when you create, edit, or update a .prs file. You can use Substitute Font in the Printer Program to assign and prioritize up to nine substitute fonts.

For example, suppose your Times Roman 10 point font contains many more characters than your Courier 10 point font. If you like to use Courier 10 point...
as normal text but need to print characters that font does not contain, you should assign the Times Roman 10 point as a substitute font for the Courier 10 point font.

Substitute characters come from a different font and may be in a different typeface, size, or weight than the current font.

To assign substitute fonts,

1. Enter **ptr -sub** at the UNIX prompt to start the Printer Program.
2. Press **Retrieve** and enter the filename of your printer (.prs) file. Include the .prs extension. If you are not sure of the filename, check the Select Printer: Edit menu in Corel WordPerfect before you start the Printer Program (see *Printer, Select*), or use List Files at the “File to be Retrieved:” prompt.
3. Highlight the printer you want, then press **Return** to display the list of fonts for the printer file.
4. Move to the font for which you want to assign a substitute font, then press **Return**.
5. Move to the font you want as a substitute for the font you highlighted in step 4.
6. Type a priority indication 1–9 (1 is first priority), or type an asterisk (*) to have the Printer Program use the next priority. Priority numbers are automatically updated as you make editing changes to the substitute fonts list.
7. Repeat steps 5 and 6 to mark additional substitute fonts.
8. Press **Exit** to return to the list of fonts.
9. Repeat steps 4 through 9 to assign substitute fonts to any other fonts.
10. Press **Quit**, then type **y** to begin saving the file.
11. Press **Return**, then type **y** to replace the old file with the new file. Enter a new filename.
12. Type **n** to clear the screen and remain in the Printer Program. Type **y** to exit the Printer Program.

### Notes

**Startup Option**
The -sub startup option provides a shortcut to moving to the Substitute Fonts list in the Printer Program. For more information, see *Startup Options* under *Printer Program.*
Subsequent Editing of .prs Files in Corel WordPerfect

Once you use the Printer Program to change substitute fonts in the .prs file, you may be asked if you want new substitute fonts when you edit or update the .prs file in Corel WordPerfect.

For example, after editing a .prs file in the Printer Program, you may go into Corel WordPerfect and mark a cartridge in Cartridges/Fonts/Print Wheels. When you exit, you will be prompted with “Do you want new substitute fonts?” Typing y at this prompt causes Corel WordPerfect to select new substitute fonts for the fonts in the .prs file. Changes you made using the Printer Program are overwritten as Corel WordPerfect selects new substitute fonts. Typing n leaves existing substitute fonts as they are. In this case, the newly-marked cartridge fonts will not have substitute fonts unless you then use the Printer Program to set them up.

Testing Substitute Fonts

One way to see if the substitute fonts have been set up correctly is to retrieve the charmap.tst document into Corel WordPerfect, move to the top of the document, change the Base Font to the font you have selected substitute fonts for in the Printer Program, then view or print the document (see Font, Print, and View Document).

If your printer supports graphics, be sure to set Graphics to “Do not print” (see Print Quality) before printing the file.

See Also: Printer, Select; Printer Program; Printer Program, Modify Automatic Font Changes; Printing—General Information

Printer Program, Modify Automatic Font Changes

There are several attributes on the Font key in Corel WordPerfect. Italics, Large, Fine, and Double Underline are a few examples of these attributes. Fonts are automatically assigned to an attribute when you create or edit a .prs file in Corel WordPerfect. Usually, the attribute fonts are various weights or point sizes of the current font typeface. You may want to modify the font attributes assignments with Automatic Font Changes in the Printer Program. See Printer Program, Customize Substitute Fonts for additional information on automatic font changes, and on substitute fonts, which are closely related to automatic font changes.

For example, if the current font is Courier 10 point, then Corel WordPerfect usually assigns Courier Bold 10 point (if that font is available) to the Bold attribute. Likewise, if the current font is Courier 10 point, the font assigned to the Large attribute usually has a Courier typeface with a point size larger than 10 (if such a font is available).

If an attribute cannot be created with another font, Corel WordPerfect may try another method to create the attribute (for example, double-striking for Bold, underlining for Italics).
To modify automatic font changes,

1. Enter `ptr -afc` at the UNIX prompt to start the Printer Program (see *Startup Option* below).

2. Press *Retrieve*, then enter the filename of your printer (.prs) file. Include the .prs extension. If you are not sure of the filename, check the Select Printer: Edit menu before starting the Printer Program (see *Printer, Select*), or use List Files at the “File to be Retrieved:” prompt.

3. Press *Return*.

4. Move the cursor to the base font whose attributes you want to change, then press *Return*.

5. Move to the attribute whose font assignment you want to change, then press *Return*.

6. Move to the font you want to assign to that attribute, then type an asterisk (*) next to the font (or press *Return*, then type *y*).

7. Press *Exit* to return to the list of attributes.

8. Make changes to other attributes by following steps 5 through 7.

9. Press *Exit* to return to the list of fonts.

10. Repeat steps 4 through 9 to make automatic font changes to other fonts.

11. Press *Quit*, then type *y* to begin saving the file.

12. Press *Return*, then type *y* to replace the old file with the new file.

   or

   Enter a new filename.

   If you are entering a new filename, be sure to include the .prs extension.

13. Type *n* to clear the screen and remain in the Printer Program.

   or

   Type *y* to exit the Printer Program.

---

**Notes**

**Attributes, Character Sets, and Orientations**

Also included among the attributes on the Automatic Font Change menu are the names of character sets and font orientations. By following the steps above, you can assign a font to those character sets or orientations.

After assigning a font to an attribute and saving the change, all characters for that attribute come from the assigned font. In addition, additional attributes will come from the assigned font’s automatic font changes.

For example, if text is formatted for extra large and italics, Corel WordPerfect switches to the font assigned to extra large, then uses the italics automatic font change for that extra large font to print the italicized text. If you wanted to change the setting, you would start the Printer Program, go into the Automatic
Font Change for the font assigned to extra large, then look for the setting for italics.

The same is true for an orientation. After assigning a font to an orientation and saving the change, all characters for that orientation come from the assigned font. Additional attributes will come from the assigned font’s automatic font changes.

After assigning an automatic font change to a character set, Corel WordPerfect switches to that font for every character in that character set. The switch is done on a character set-by-character set basis.

Because Corel WordPerfect switches to the character set automatic font change only for specific character sets, text that uses multiple character sets will print in different fonts, which may not look as you expect.

Delete Font Selection
A font selection can be cleared from the automatic font change list by following steps 1 through 6 above, then placing the cursor on the font selection and pressing Backspace or Delete.

Small Caps
If a font is selected for small caps, Corel WordPerfect checks to see if it is a true small caps font. If it is, all the characters are printed in that font. If it is not, lowercase letters are converted to uppercase and printed in the selected font. Uppercase letters are printed in the current font. In order for small caps to print as expected, a font should be selected that is about 80% of the size of the base font.

Startup Option
The -afc startup option is a shortcut to moving to the Automatic Font Change list in the Printer Program. For more information, see Startup Options under Printer Program.

Subsequent Editing of .prs Files in Corel WordPerfect
Once you use the Printer Program to modify automatic font changes in the .prs file, you may be asked if you want new automatic font changes when you edit or update the .prs file in Corel WordPerfect.

For example, after editing a .prs file in the Printer Program, you may go into Corel WordPerfect and mark a cartridge in Cartridges/Fonts/Print Wheels. When you exit, you will be prompted with “Do you want automatic font changes?” Typing y at this prompt causes Corel WordPerfect to select new automatic font changes for the fonts in the .prs file. Changes you made using the Printer Program are overwritten as Corel WordPerfect selects new automatic font changes. Typing n leaves existing automatic font changes as they are. In this case, the newly marked cartridge fonts will not have automatic font changes unless you then use the Printer Program to set them up.

See Also: Printer, Select; Printer Program; Printer Program, Customize Substitute Fonts; Printing—General Information
Print lets you print part or all of a document currently on the screen or one that has been previously saved to disk.

You can print a block of the document on the screen, selected pages of a document from either the screen or disk, and you can also print the document summary (see Print, Document on Disk and Print, Document on Screen for details).

**Notes**

**.all and .prs Files**
Corel WordPerfect cannot print anything unless you have a printer selected (see Printer, Select). However, a printer should have been selected during installation. The process of printer selection involves copying information from the media into a file in Corel WordPerfect.

Printer information is stored in files with .all extensions on media included in your Corel WordPerfect package. When you select a printer, Corel WordPerfect takes the information specific to your printer from the .all file and creates a file containing that information with a .prs (printer resource file) extension. Corel WordPerfect uses this .prs file every time you print.

When you edit a printer definition, your changes are made to the .prs file. The ptr Program is available for you to make more extensive changes to your printer definition or .prs file (see Printer Program).

**Background Printing**
Print lets you continue working in the document screen while you are printing (this is called background printing). When you print a document (whether from the screen or from disk) a copy of the document is sent to the printer. If you are printing a document from the screen, you are automatically returned to the normal editing screen. If you are printing a document from disk, press Exit to return to the normal editing screen to continue working.

**Graphics**
If your printer prints graphics, you can use Print to print a page or document that includes graphics or .dri characters (see Printable Characters below).

**Important:** If you are printing large, full-page graphics or several graphics on a single page to a laser printer, and not all of the graphics print completely, your laser printer may have insufficient memory for that print job.

If you have a PostScript printer capable of printing color graphics, you can print color graphics images in color. If not, color graphics images are printed in black and white using shading or fill patterns.

**Initialize Printer**
This option is found on the Print screen. Use it only if you have a printer with soft fonts that you have marked with an asterisk (*) (see Marking Cartridges/Fonts/Print Wheels under Cartridges/Fonts/Print Wheels) to load those fonts into the printer. You should use it every time you turn on your printer prior to the print job. When you select this option, type y to confirm...
initialization, and the soft fonts you have marked with an asterisk (*) (meaning initially present) are downloaded to the selected printer to be readily available for printing.

**Landscape/Portrait Printing**

In Landscape printing, text prints parallel to the long edge of the form. In Portrait printing, text prints parallel to the short edge. Some printers rotate fonts (or have landscape fonts available) to print in landscape, while others do not.

<table>
<thead>
<tr>
<th>Class Schedule</th>
</tr>
</thead>
<tbody>
<tr>
<td>Monday</td>
</tr>
<tr>
<td>8:00 a.m.</td>
</tr>
<tr>
<td>9:00 a.m.</td>
</tr>
<tr>
<td>10:00 a.m.</td>
</tr>
<tr>
<td>11:00 a.m.</td>
</tr>
<tr>
<td>12:00 p.m.</td>
</tr>
<tr>
<td>1:00 p.m.</td>
</tr>
<tr>
<td>2:00 p.m.</td>
</tr>
<tr>
<td>3:00 p.m.</td>
</tr>
<tr>
<td>4:00 p.m.</td>
</tr>
<tr>
<td>5:00 p.m.</td>
</tr>
</tbody>
</table>

If your printer cannot rotate fonts and does not have landscape fonts available (for example, dot-matrix and daisy wheel printers), print in landscape by inserting the paper lengthwise into the printer.

If your printer can rotate its fonts (for example, most laser printers), you must change the font type or select a landscape font to print in landscape (see Font Type under Paper Size/Type).

See Printing, Landscape for details on landscape and portrait printing.
**Paper Size/Type**  
This feature tells Corel WordPerfect what size and kind of paper you will be printing on. The code inserted specifies the dimensions and name of the form (see Paper Size/Type).

**Preview Copy**  
Any document can be printed on any printer, although the appearance may vary from printer to printer. When you select a new printer, the document on the screen is reformatted to match the capabilities of the new printer.

You can print a “preview” copy of a document even if the document has not been formatted for the current printer. Print the document with Document on Disk on the Print menu or Print on the List Files screen without retrieving the document. A message appears stating that the document has not been formatted for the current printer. It then asks if you want to continue printing. Type y to print on the new printer.

Font selections in the document will be converted to the font most similar on the new printer. Other printer-specific codes in the document may also appear different in the printout; however, there will be no changes to the document on disk. Line endings will remain the same with the new printer, which may cause an odd appearance in the printout.

**Print Quality**  
The print quality of a document is determined by the Graphics and Text Quality options on the Print menu.

Graphics Quality and Text Quality let you print graphic images and text with a greater or lesser degree of resolution. However, the higher the quality, the longer it takes to print (see Print Quality).

**Printable Characters**  
Corel WordPerfect is capable of printing all characters found in the Corel WordPerfect character sets (see Appendix P: Corel WordPerfect Characters for a list of all the character sets). If your printer does not have a particular character available and it can print graphics, Corel WordPerfect accesses that character from the .drs (driver resource) file that is included with Corel WordPerfect, and then creates the character as a graphic image.

Corel WordPerfect tries to emulate the font currently being used in your document. However, the .drs fonts may not match the fonts in your document. When Corel WordPerfect creates a character graphically, it uses the font among those in the .drs file that is most like the font currently being used.

When Corel WordPerfect tries to access the character from the .drs file, it looks for the .drs file first in your printer directory (see Location of Files), then in the shared data directory. It also looks in the data files directory (see Location of Files) and in the current directory. If it cannot find the .drs file, a space is inserted where the character should be.

Your printer must be able to print graphics for this feature to work.

*Characters that cannot be displayed on the screen appear as a square box (□).*
Because these .drs characters are considered text and graphics, their printing is affected by both the Text and Graphics Quality settings (see .drs Characters under Print Quality for details).

**Important:** If you try to print a document with many .drs characters, the print job will take considerably longer to complete. If the print job is not completed, it might be that your printer does not have enough memory.

**Job Control**
The Job Control screen helps you manage and check the status of print jobs. If your printer does not respond when you send all or part of a document, check the Job Control screen for any messages (see Job Control).

**Printer Troubleshooting**
If nothing happens when you send a document to the printer, display the Job Control screen to see any explanatory messages that may be displayed. These messages often indicate why the printer is not printing and what can be done about it.

**Two-Sided (Duplex) Printing**
You can print on both sides of the paper if your printer is capable of duplex printing (see Double Sided Printing under Paper Size/Type).

**See Also:** Print, Document on Disk; Print, Document on Screen; Print Options; Printer, Select

---

**Printing, Landscape**

You will likely want to print the text parallel to the short edge of the paper most of the time (portrait printing). Sometimes, however, you may need to print the text parallel to the long edge of the paper (landscape printing). For example,
when you print envelopes, the name and address are printed parallel to the long edge of the paper.

Portrait printing

Landscape printing

There are two methods for printing in landscape—one is used if your printer can rotate its fonts, the other if your printer cannot. Both of these methods require you to define a landscape paper size and type. If you are unsure about your printer's ability to rotate fonts, consult your printer manual or dealer.

1. Press **Format**, then select Page (2).

   Or **Select Page** from the **Layout menu**.

2. Select **Paper Size/Type** (7).

3. Select **Add** (2) to add a new paper definition.

   or

   Highlight the definition you want to change to landscape, then select **Edit** (5).
Depending on whether your printer can rotate fonts, follow the corresponding instructions for defining a landscape paper type under Printer Can Rotate Fonts and Printer Cannot Rotate Fonts below.

Choose Select (1) with the landscape paper type highlighted to insert a Paper Size/Type code into your document (see Codes below).

Press Exit to return to the normal editing screen.

Print the document in the normal fashion (see Print, Document on Screen).

Notes

**Printer Can Rotate Fonts**

If your printer *can* rotate fonts (for example, many laser printers), you probably cannot change the way paper is inserted into the printer to print in landscape (that is, the insertion edge stays constant). You can, however, change the font orientation.

To print in landscape in this case, select Font Type (3) from the Format: Edit Paper Definition menu, then select Landscape (2). Next you need to select Paper Size (1) from this same menu, then make sure you select a landscape paper size from the Format: Paper Size menu. All the landscape paper sizes have the long edge of the paper as the first dimension (for example, 11" x 8.5").

If you select Other (o) to specify your own dimensions, enter the long edge of the paper as the width. See Editing a Definition under Paper Size/Type.

For example, to print in landscape on an 8.5" x 11" paper using a laser printer, select Font Type (3), Landscape (2), Paper Size (1), then select Standard Landscape (2). Press Exit to return to the Format: Paper Size/Type screen. The Paper Size column will display 11" x 8.5" for that paper type.

*Important:* If you select Landscape as the Font Type, Corel WordPerfect assumes the second dimension (height) is the edge of the paper being inserted into the printer.

If you specify the long edge of the paper as the second size dimension when you have selected Landscape as the Font Type and you are not inserting the long edge of the paper into the printer, the printer might not respond the way you want.

**Printer Cannot Rotate Fonts**

If your printer *cannot* rotate fonts (for example, most dot-matrix and daisy wheel printers), the only way you can print in landscape is by inserting your paper into the printer lengthwise (that is, changing the insertion edge). For an 8.5" x 11" page, you have to insert the 11" edge of the paper into the printer.

*If your printer cannot rotate fonts and will not let you insert the paper lengthwise, you will not be able to print in landscape on a full sheet of paper.*

To print in landscape if your printer cannot rotate fonts, leave your Font Type on the Format: Edit Paper Definition menu at Portrait, select Paper Size (1) from this same menu, then select a landscape paper size from the Format: Paper Size menu. If you select Other (o) to enter your own dimensions, specify the long edge as the width. Press Exit to return to the Format: Paper Size/Type.
screen, and the Paper Size column should read 11” x 8.5” for that paper type. See Editing a Definition under Paper Size/Type.

**Important:** If you select Portrait as the Font Type, Corel WordPerfect automatically assumes the first size dimension (width) is the edge of the paper being inserted into the printer.

**See Also:** Paper Size/Type; Printing—General Information

---

## Printing, Stop

Use Stop to temporarily stop a print job because of a paper jam, ribbon problem, and so on. Once the printer stops, you can correct the problem, then continue the print job by using the Go option on the Job Control menu.

*You cannot use the Stop option to stop a print job, then resume printing it at the same place on the page (see Restarting the Printer below). However, you can take your printer off-line to accomplish this.*

1. Press **Print**.
   
   *Or* Select **Print from the File menu.**

2. Select Control Printer (4), select Stop (4), then type **y** to stop printing.

3. Make any necessary corrections, reset the forms in the printer (advance the paper to the top of the next page), then select Go/Restart (3).

4. Reset the printer (press Reset on a laser printer, or turn it off and then on again), select Go/Restart (3), then enter the page number on which you want the printing to restart (if requested).

5. Press **Exit** to exit the Job Control screen.

---

### Notes

#### Canceling a Print Job

To start a print job from the beginning again or to cancel the print job, select Cancel (1) from the Job Control menu. Cancel stops information being sent to the printer, clears the print job from the job list, then advances the next sheet of paper to the top of the page when the printer’s buffer is empty (see Print Job, Cancel).

You can also cancel a print job after you have stopped it by typing **c** from the Job Control screen in step 3 above.

#### Restarting the Printer

When you select Go/Restart (3) after using the Stop (4) option on the Job Control menu, you will be asked to enter the page where you want printing to start. If the print job was still on the first page when you stopped it, printing is automatically restarted at the top of page 1.

**See Also:** Print Job, Cancel; Job Control
Printing to Disk

Printing to Disk is useful if you will be printing from a computer that does not have Corel WordPerfect, or if you want someone who does not have Corel WordPerfect to be able to print your Corel WordPerfect document. You can output a file to your disk in a printer format. While the file is stored as a UNIX file, it also contains all the characters and codes which ordinarily would have been sent to the printer you selected. The document can then be printed from UNIX (see Printing from UNIX below).

1 Press Print.

Or select Print from the File menu.

2 Choose Select Printer (s), then move the cursor to the appropriate printer.

3 Select Edit (3) to display the list of settings for the selected printer.

4 Select Port (2), select Disk, then enter a filename.

5 Press Exit twice to return to the Print menu.

6 Print the document as usual (see Print, Document on Disk and Print, Document on Screen).

Any prompting for form insertion, print wheel changes, and so on, is disabled.

7 Change the port back to its original setting, if desired.

The document is sent to a file on disk rather than to a port on your computer. For example, entering /usr/pfile as the filename in step 4 above creates a file named “pfile” in the /usr directory.

If you attempt to change the port to Disk on a system printer, you will receive an error message. Only the system administrator can modify a system printer. You can, however, modify any printers that you have set up.

Notes

UNIX File

Although the file you print to disk is saved as a UNIX file, it is not the same thing as a UNIX text file. For example, if you retrieve the file into Corel WordPerfect, it will not look like a normal UNIX text file. You can, however, print the file from UNIX (see Printing from UNIX below).

Filename

If you enter a filename without a path in step 4 above (for example, LETTER), the file is saved in the default directory.

Printer Troubleshooting

You can also use Print to Disk for troubleshooting purposes. For example, if your printer is not printing correctly, you can print the document to a file, then use a text editor to inspect the file and see exactly which characters are being sent to the printer.
Printing from UNIX
When you use Print to Disk to create a UNIX file and then print that file from UNIX using the UNIX Print or Copy command (see your UNIX manual), occasionally a problem occurs with the printing. The problem usually involves the print job ending prematurely, graphic images not printing properly, or garbage appearing in the printout. Check with your system administrator for details on using print and copy commands.

Resetting the Port
The filename you entered for the port in step 4 above remains the destination port unless you changed it back in step 7. If you do not change that setting, the next document you print will be printed to disk, replacing the file indicated by the filename. Be sure to reset the port when you want to resume printing to your printer (see Printer, Edit).

See Also: Print, Document on Disk; Print, Document on Screen; Printer, Edit; Printing—General Information

Pull-Down Menus

Corel WordPerfect has a function key interface, which means that you can select features with the function keys on your keyboard.

Corel WordPerfect also has a pull-down menu interface. This means that you can select the same features with a series of menus that “pull-down” from the top row of the screen.

An example of one of the Corel WordPerfect pull-down menus is shown below.

The pull-down menus can be accessed with the keyboard. A list of the items on the pull-down menus can be found in Appendix N: Pull-Down Menus.

To display the pull-down menus,

1 Press Esc=.

2 Select a menu of your choice (see Selecting Menus below).
To back out of the pull-down menus one menu at a time without making a selection, press **Cancel**, **Escape**, or the **Space Bar**. To exit all the way out of pull-down menus in one operation, press **Exit**.

**Selecting Menus**
To select a pull-down menu from the pull-down menu bar, move the cursor to the menu of your choice with the Right or Left Arrow keys, and press **Return**. Or, type the mnemonic letter associated with the menu.

From that point you can select an option on the displayed menu by moving the cursor to it with the Up and Down Arrow keys, then pressing **Return**. Or, you can select the mnemonic letter for that option (see **Menu Options** for information on ways of displaying mnemonic letters).

Home,Left Arrow and Home,Right Arrow move you to the ends of the menu bar, while Home,Up Arrow and Home,Down Arrow move you to the top or bottom of the pull-down menus. Page Up/Down and Screen Up/Down also move you to the ends of the menu bar and pull-down menus.

**Notes**

**Brackets**
If an item on the pull-down menu is displayed in brackets (for example, [List Files]), it cannot be selected at that time. This happens when a feature that cannot be used with the bracketed feature is active.

When Block is active, for example, several features cannot be used and they are displayed on pull-down menus with brackets. The cursor will skip over bracketed menu items.

**Function Keys**
If you press a function key while in the pull-down menus, you are exited from the menus, and the feature associated with the function key is accessed. For example, if you press **Center**, the Center feature is turned on.

**Macros**
When you define macros, you may select items from the pull-down menus. Regardless of the way you select the items, the selections are stored as keystrokes. This is helpful when you edit the macro in the Macro Editor.

**Menu Bar Remains Visible**
If you want the pull-down menu bar always displayed in the screens where it can be used, you may display it by setting the Menu Bar Remains Visible option on the Setup: Menu Options menu to **Yes**. If you do so, the only way you can “hide” the menu bar is by re-setting the same option to **No**. For more information, see **Menu Options**.

**Menu Options**
An option on the Setup: Display menu called Menu Options lets you tailor the appearance of the pull-down menus. For example, it lets you display the menu bar and the menu text in the on-screen attribute of your choice. It also lets you select an on-screen attribute for mnemonic letters. For more information, see **Menu Options**.
Pull-Down Menu Icon
The feature key selection is emphasized in this manual, with pull-down menu notes included in instructional steps. Pull-down notes are marked by an icon to identify where pull-down menu instructions differ from feature key instructions.

Submenus
Some items on pull-down menus display submenus. The items that do so are marked with a ● (this symbol may vary depending on the terminal) to the right of the item in the menu. When you highlight the item on the main menu, the submenu is displayed.

Once a submenu is displayed, selecting an item from a submenu is the same as selecting an item from the main menu (see Selecting Menus above). To cancel out of a submenu and return to the main menu without making a selection, press Cancel, Escape, or the Space Bar.

To exit all the way out of the pull-down menus, press Exit.

See Also: Menu Options

QuickCorrect™

Use QuickCorrect™ to automatically correct common typing mistakes, accelerate text entry, and begin bulleted, numbered, and alphabetical lists. For example, QuickCorrect can fix typing errors by replacing “teh” with “the” or an asterisk (*) with a bullet (•). You can add and delete items from the QuickCorrect list to accommodate your typing style.

With QuickWords, you can type a few characters to represent other information, such as an address or a company logo. QuickWords can include formatting (such as bold or italics) and graphics.

QuickCorrect also provides easy formatting solutions such as fixing capitalization (for example, changing “dANIEL” to “Daniel”), creating graphics lines (QuickLines), making quotation marks curly (SmartQuotes), and replacing numbers such as 1st and 2nd with superscript ordinal numbers (QuickOrdinals). These options can be turned on or off at any time.

When you type text that is identical to the complete misspelled or abbreviated word in QuickCorrect’s list, it is automatically replaced with the correct or expanded text when you press the Spacebar.

For information on how to use QuickCorrect, see Corel WordPerfect’s online Help.
Redline/Strikeout

Redline and Strikeout are used to mark text that has been added to (redline) or deleted from (strikeout) the original draft.

Redline and Strikeout are appearance attributes. For information about adding these attributes to text, see Attributes.

To remove the redline markings and the strikeout text,

1 Press **Mark Text**, then select **Generate (6)**.
   
   Or  
   
   2 Select **Remove Redline Markings and Strikeout Text from Document (1)**, then type **y** to confirm the deletion.

This deletes each pair of Redline On and Off codes—[REDLN][redln]—in the document. It also deletes each pair of Strikeout On and Off codes—[STKOUT][stkout]—and any text found between them.

Once the process has been completed, the cursor is placed at the end of the document.

**Notes**

**Document Compare**
You can have Corel WordPerfect use Redline and Strikeout in Document Compare to mark the phrases that have been added to or deleted from a document.

**On-Screen Appearance**
The way redline and strikeout text is displayed in the normal editing screen depends upon your monitor or terminal capabilities (see **Colors/Fonts/Attributes**).

**Redline Appearance in Print**
On the printed page, redline text is marked according to the redline string in the Printer Definition file and the capabilities of your printer. On most laser printers, it is printed on a shaded background. You can also have redline text marked by a vertical bar (|) in the left margin, or vertical bars which alternate between the left and right margins (see **Redline Method** under **Document Format**).

**Strikeout Appearance**
Normally, the strikeout character is a dash (–) which is printed across the middle of text.

**See Also:** Attributes; Colors/Fonts/Attributes; Font

**Repeat Value**

You can use Repeat Value to repeat characters or certain features a specific number of times.
1 Press **Escape** to display the current repetition number. You can also change the repetition number at this point (see **Repetition Number** below).

2 Press a key (see **Features** below).

**Notes**

**Alternate Keystroke**
You can also press **Escape** to back out of menus and prompts in the same way you would use **Cancel**.

**Features**
You can use Repeat Value with the following keys, where # represents the repetition number:

<table>
<thead>
<tr>
<th>Feature</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Characters</td>
<td>Repeats a non-numeric character # times</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes # characters to the right of the cursor (including spaces)</td>
</tr>
<tr>
<td>Delete EOL</td>
<td>Deletes # lines from the cursor down</td>
</tr>
<tr>
<td>Delete EOP</td>
<td>Deletes # pages from the cursor down</td>
</tr>
<tr>
<td>Delete Word</td>
<td>Deletes # words to the right of cursor</td>
</tr>
<tr>
<td>Down Arrow</td>
<td>Moves cursor down # lines</td>
</tr>
<tr>
<td>Left Arrow</td>
<td>Moves cursor to the left # characters</td>
</tr>
<tr>
<td>Macro</td>
<td>Repeats the macro # times</td>
</tr>
<tr>
<td>Page Up</td>
<td>Moves cursor back # pages</td>
</tr>
<tr>
<td>Page Down</td>
<td>Moves cursor forward # pages</td>
</tr>
<tr>
<td>Right Arrow</td>
<td>Moves cursor to the right # characters</td>
</tr>
<tr>
<td>Space Bar</td>
<td>Inserts # spaces</td>
</tr>
<tr>
<td>Up Arrow</td>
<td>Moves cursor up # lines</td>
</tr>
<tr>
<td>Word Left</td>
<td>Moves # words to the left of the cursor</td>
</tr>
<tr>
<td>Word Right</td>
<td>Moves # words to the right of the cursor</td>
</tr>
<tr>
<td>Item Left</td>
<td>Moves # columns to the left</td>
</tr>
<tr>
<td>Item Right</td>
<td>Moves # columns to the right</td>
</tr>
<tr>
<td>Paragraph Down</td>
<td>Moves # paragraphs down</td>
</tr>
<tr>
<td>Paragraph Up</td>
<td>Moves # paragraphs up</td>
</tr>
</tbody>
</table>

**Repetition Number**
Normally, the repetition number that appears when you press **Escape** is 8. To change that number for one repetition, press **Escape**, then type a new number before typing a character or pressing a feature. To change the repetition number for one editing session, press **Escape**, type a new number, then press **Return**. The number you entered will stay in effect until you exit Corel WordPerfect.

To change the preset number permanently, use the Initial Settings in Setup.
Replace

You may want to change a certain word or phrase that appears several times in a document. For example, you may have typed a letter to John Simpson, and you now want to send the same letter to Katie Jones. Or, perhaps you have typed a letter to Katie Jones only to discover that she spells her first name Katy.

You can use Replace to search for and replace every occurrence of a word, phrase, or code.

However, keep in mind that using Replace can often make multiple changes to your document. You may want to make a backup copy of the document before using Replace. Then, if you run into problems, you can exit the altered document without saving it and retrieve the backup copy.

1 Press Replace.
   
   Or Select Replace from the Search menu.

You are asked if you want to confirm each replacement.

2 Type y to replace with confirmation, or type n to replace without it (see Confirming Replacements below).

At this point you have the option of changing the direction of the search.

3 Press Down Arrow to search forward from the cursor. (This is the default direction.)
   
   or
   
   Press Up Arrow to search backward from the cursor.

4 Type what you want to replace (commonly referred to as the search string), then press *Search.

5 Type the replacement, then press *Search.
   
   or
   
   Press *Search without entering a replacement to delete every occurrence of the search string (see Codes below).

Notes

Capitalization

In a search string, lowercase characters match both lowercase and uppercase. Uppercase match only uppercase. For example, bill will find Bill, but Bill will not find bill.

If you search for a lowercase word (for example, dog) and replace it with a lowercase word (for example, cat), Corel WordPerfect preserves the case of the word found. However, if “dog” were capitalized because it was at the beginning of a sentence, it would be replaced by “Cat.”
Codes
When typing a search string (in step 4 above), you can include codes by pressing the function keys and also selecting options to actually select the feature you want. For example, to insert an underline code into a search string, press **Underline**.

Remember, you must actually select the feature. For example, you could not search for an Underline code [UND] by typing an open bracket (()), then typing UND and typing a closed bracket () as the search string.

To search for a pair of codes, press the function key twice. For example, to search for [UND][und], press **Underline** twice.

Replace is particularly valuable in helping you to find and delete troublesome codes. If you do not enter a replacement (in step 5 above), the code you search for is deleted (see also Delete Codes).

For example, to delete any unnecessary paired Bold codes (such as [BOLD][bold]) in a document, you could move the cursor to the beginning of the document, press Replace, type n to not confirm, press **Bold** twice to make [BOLD][bold] the search string, then press *Search* twice.

When typing a replacement (in step 5 above), you can only use certain codes. At the Search prompt, press the keystrokes for the feature you want to find. A list of the possible codes is displayed.

Confirming Replacements
Replace can be a fast and efficient way to update your documents. However, if you are not careful in choosing what you are replacing, you cause unwanted changes in a document. As an example, you might want to replace the word indent by using Replace, but not indentation, indentation, indentured, indentor, indenturing, or any occurrences of indent followed by punctuation. If you do not enter spaces in a search string, the Replace will affect any occurrence of that word even when it is found in other words (see Words below).

When you want to be certain of each replacement, you can use Replace with Confirm by typing y in step 2 above. Corel WordPerfect then stops at each occurrence of the search string and pauses, letting you indicate whether or not to replace it. It then moves on to the next replacement.

Editing Search Strings
When you type a search string (in step 4 above), you can use the arrow and delete keys to move through and edit it just as you would edit text in the normal editing screen.

Search Keys
Once you are at a Search or Replace prompt, you can press *Search, *Search, Replace, or **Escape** to continue the search (in steps 4 and 5 above). However, these keys have no effect on the direction of the search.
Variations
You can do a Replace on a block of text by blocking the text, then following the steps given at the beginning of this section.

Normally, Replace searches only the main text of a document. If you want Replace to include any text in headers, footers, footnotes, endnotes, graphics box captions, and text boxes, press Home before pressing Replace. This is called an Extended Replace.

You can include a Ctrl-X in a Search string by pressing Ctrl-v, Ctrl-x. However, the Ctrl-X cannot be the first letter in the search string. Ctrl-X matches any character except a function code.

You can include a Soft Page code [SPg] in a Search string by pressing Ctrl-v, Ctrl-k. You can include a Soft Return code [SRt] in a search string by pressing Ctrl-m.

You can only search for Soft Page codes [SPg] which were originally Soft Return codes [SRt]. You cannot search for Soft Page codes which were originally Hard Return codes [HRt-SPg].

Words
When you are replacing a particular word, press the Space Bar to include spaces before and after the word. Otherwise, the Replace will affect any occurrences of that word even when it is found in other words. For example, insert spaces before and after the word the to replace the only when it appears alone, and not in such words as these, therefore, and other.

Remote Open
You can open a file an another UNIX computer connected to your network. Make sure you have read/write permission to the files you want to open.

See Also: Block; Delete Codes; Search

Retrieve

The documents that are created in Corel WordPerfect are usually stored on disks. When you want to edit a document, you need to retrieve a copy of the file from a disk.

If you know the name of a document and where it is located, you can use Retrieve to quickly retrieve it.

1 Press Retrieve.

Or Select Retrieve from the File menu.

2 Enter the filename of the document (see Entering Filenames below).

The document appears on the screen at the cursor.
The cursor is placed immediately after any of the codes that are found at the beginning of the new document. Any changes you make will affect only the document on the screen. They will not be recorded on disk until you save them to a disk using Save or Exit.

Notes

Entering Filenames
If Corel WordPerfect cannot find the filename you enter, it displays a File Not Found message. If you have typed the filename incorrectly, you can enter the correct name. If you are unsure of the exact filename, you can use List to search your directory for the appropriate file.

When you use Retrieve to retrieve files, you can retrieve a document that is found in any directory. If you are already in the directory where the document is found, all you need to enter is the document name. However, if the document is found in some other directory, you also need to include the full pathname for the document.

For example, if you are in the WORK directory and you want to retrieve a document called study.doc found in that directory, then you need only enter study.doc. However, if you are in some other directory, you need to also include the full pathname, including the work directory (for example, /home/work/study.doc).

You can determine what directory you are in by pressing List. The name of your default directory then appears in the status line at the bottom left corner of the screen (for example, Dir /home/work/*). You can then press Cancel to return to the normal editing screen.

You can enter a default directory for your documents in Location of Files in Setup. If a directory name exists in this entry, your files will always be saved and retrieved from that directory unless you enter the full pathname of a different directory.

For more information on drives, directories, and pathnames, see Directories.

Initial Codes
You can use Initial Codes in Setup to have certain formatting codes preset at the beginning of each document you create (see Initial Settings). Any document you retrieve to a clear screen retains the Initial Codes settings that were given to it at the time it was created. Any document you retrieve into an existing document takes on the Initial Code settings of the on-screen document.

List Files
You can also retrieve documents by using List. This is especially helpful when you are not sure of the document name, but you do know the name of the directory where the document is found. Use List to alphabetically display on-screen the names of all the files in that directory, then move the cursor to the filename and select Retrieve (1).

You can also use List to locate a filename when you are using Retrieve (see step 1 above).
However, when you use List, it is possible to forget you already have a document on-screen and accidentally retrieve another document into it. In order to help you avoid this problem, when you attempt to retrieve one document into another using List, Corel WordPerfect always asks you if you are sure you want to do this. You can then type y to retrieve the document.

Locked Files
If you attempt to retrieve a locked document, you are asked for the password. Once you enter the correct password, the file is retrieved at the cursor.

Other Corel WordPerfect Formats and Non-Corel WordPerfect Files
You can retrieve character-based files and X Windows files created in other versions of Corel WordPerfect and WordPerfect Corporation’s WordPerfect. You can also open Microsoft Word documents in Corel WordPerfect 8c. These documents are automatically converted to Corel WordPerfect 8c format as they are retrieved.

You can also save files in formats that can be used directly by other applications by using the Convert Program.

When you retrieve and convert a UNIX text file, Save or Exit saves the document in Corel WordPerfect 8c format. You might want to save it under a different filename to avoid replacing the UNIX text version of the file.

Read Only
If you attempt to retrieve a file that is already in use, you will be prompted that the file is currently open and that you will have read-only permission. The filename is placed inside brackets to indicate that there is no write or save privileges associated with the file in this directory.

Retrieving Blocks
When you are blocking and moving text, you can place text in a temporary buffer. If text is in that temporary buffer when you press Retrieve, you can press Return without entering a name to retrieve that text at the cursor.

See Also: Exit; List Files; Locked Documents; Save; Text In/Out

---

**Return, Soft and Hard**

You do not need to divide the text you type into lines. Each time you come to the end of a line, text automatically wraps to the next line and a line divider is inserted. The line dividers are called soft returns because their location is likely to change as you add and delete text. This lets you add a word, a phrase, or a sentence without having to reformat an entire paragraph.

Sometimes you need to insert your own line dividers. For example, to put a line break at the end of each paragraph. You can do this by inserting a hard return.

To insert a hard return at the cursor,
1 Press Return.

A hard return ends the line on which the cursor is resting and moves the cursor to the next line. If there is no text in a line, a hard return is represented on-screen and in print by a blank line.

Press Return.

Notes

Codes

In the Reveal Codes part of the screen, a hard return is represented by a Hard Return code [HRt] and a soft return is represented by a Soft Return code [SRt].

Deleting Hard and Soft Returns

You can delete a hard return in either the normal editing screen or in Reveal Codes.

It is not necessary to add or delete Soft Return codes. Corel WordPerfect does this for you as you make changes to your text. Because a Soft Return code was originally a space, deleting a Soft Return code deletes the space and combines the words on either side of that space into one word. A new Soft Return code is usually inserted in a different place.

Dormant Hard Return

Just as the line dividers that are inserted for you are called soft returns, the page dividers that are inserted for you are called soft page breaks because their location is likely to change as you add and delete text in your document. In the Reveal...
Codes screen, a soft page break is represented by a Soft Page code [SPg] (see Page, Soft and Hard).

Whenever a Hard Return code [Hrt] appears alone on a line at the top of a page that is started by a soft page break, the Hard Return code is changed to a Dormant Hard Return code [Dorm Hrt] to ensure that an unwanted blank line is not inserted into your text at the top of a page. If a Dormant Hard Return code is moved from the top of the page, it changes back to a normal Hard Return code.

Hyphenation
You can have Corel WordPerfect divide the words that fall at the end of a line into syllables and insert the necessary hyphens for you.

Leading for Hard Returns
When you use single spacing, you can insert an extra hard return between each paragraph to separate the paragraphs in your document with a blank line.

At times you may want to single-space your paragraphs and yet insert two blank lines between each paragraph. If you do not want to insert extra hard returns, you can have Corel WordPerfect insert the extra space by changing the leading values assigned to the Hard Return codes in your document.

Leading is the amount of white space which is added to the height of the characters in a line of text (see Leading under Line Height).

Normally, Corel WordPerfect calculates leading for you. For Soft Return codes [SRt] and Hard Return codes [Hrt], Corel WordPerfect first calculates the height of the font. No extra leading is added to the Hard and Soft Return codes in mono-spaced fonts. Two extra points of leading are added to the Hard and Soft Return codes in proportionally-spaced fonts.

See the Glossary for a definition of mono-spaced fonts and proportionally-spaced fonts.

You can change the amount of space allotted to the Soft Return codes [SRt] or Hard Return codes [Hrt] in your document by changing the amount of leading which Corel WordPerfect adds to them. This is determined by the leading adjustment entries for Soft and Hard Return codes on the Format: Printer Functions menu (see Printer Functions).

To get double spacing between single-spaced paragraphs, select Leading Adjustment (6) from the Format: Printer Functions menu. The cursor moves to the Primary [SRt] entry. Press Return to accept the default setting and move the cursor to the Secondary [Hrt] entry. Enter 1u as the value for Hard Return codes [Hrt].

Entering 1u adds one line of space in the current unit of measurement. Corel WordPerfect then calculates the exact measurement for that line of space and displays it on-screen in the Secondary [Hrt] entry.

You can then press Exit to return to your document. A Leading code [Leading Adj: #, ##] is inserted into your document where # is the leading being added to Soft Return codes and ## is the leading being added to Hard Return codes.
From that point forward in single-spaced text, Corel WordPerfect inserts the equivalent of two blank lines between all paragraphs that are separated by a Hard Return code. This extra blank space does not appear in the normal editing screen. You can see it by using View Document or by printing the document.

Be aware that these settings will not change when you change fonts. If you use Base Font to change point sizes in your document, you will need to repeat the above process so that the measurement in the Secondary [HRt] entry will coincide with the new font.

To get one and one-half line spacing between paragraphs, enter $\frac{1}{2}u$ or $.5u$. This adds one-half the current line height measurement to each line created by a Hard Return code [HRt]. This creates one and a half line spacing.

If you want triple spacing between paragraphs that have double-spaced text, enter $\frac{1}{2}u$ in the Secondary [HRt] entry. This adds one-half the current line height to each line created by a Hard Return code [HRt]. Because each Hard Return code creates two blank lines, this creates triple spacing.

**Line Spacing**

You can change the line spacing of text before or after you type it.

By default, documents are single-spaced. However, you can change to double or triple spacing. You can also space by any number of lines or any fraction of a line.

You change line spacing by changing the number of lines inserted into your text for each Soft Return code [SRt] and Hard Return code [HRt] in your document (see Line Spacing).

You can also change the spacing by changing the leading value used for Hard Return codes [HRt] in your document (see Leading for Hard Returns above).

**See Also:** Line Spacing

---

**Reveal Codes**

Corel WordPerfect is a *clean screen* program. As closely as possible, it displays your text just as it will appear on the printed page.

Consequently, the codes which Corel WordPerfect uses to determine the appearance of your text are not visible in the normal editing screen.

However, the codes you insert are very important to your document. You insert a code almost every time you use a feature. For example, when you bold text, change margins, or change page numbering, a code is inserted into your text. These codes determine how your document will look when it is printed.

Since the placement of these codes is essential, you sometimes need to observe their exact location.
1 Press **Reveal Codes** to display the codes in your text (see **Codes** below).

Or □ Select **Reveal Codes** from the **Edit** menu.

2 Press **Reveal Codes** again to return to the normal editing screen.

---

### Notes

#### Codes

Pressing **Reveal Codes** divides the screen into two parts. The top part is the normal editing screen. The lower part displays the same text, accompanied by the codes it contains. A tab ruler divides the two parts of the screen.

**Normal text**

**Cursor in normal text**

**Tab ruler**

**Cursor in text with codes**

**Text with codes**

In the ruler line which splits the screen, a triangle (^) represents each tab. A left bracket ([]) represents the left margin; a right bracket (]) represents the right margin. If a margin falls on a tab stop setting, it is displayed as a left brace (a) or a right brace (}).

If you are editing a table in the normal editing screen, the ruler line indicates where the table columns are found. The table columns are shown in brackets, such as [ ] unless they match a tab stop setting, in which case they are shown in brackets, such as [ ].

Normally, 11 lines appear above the ruler line, and 12 lines below. You can adjust this while in Reveal Codes by using Screen (see **Window**).

You can also change the Reveal Codes window size permanently in Setup (see **Edit-Screen Options**). If you use a 1-line Reveal Codes screen, you will be prompted for confirmation when you delete codes.

The cursor appears at the same location in both parts of the screen. In the normal editing screen it is usually displayed as a dash. In the Reveal Codes part of the screen, the cursor is displayed in the same way you have chosen to display blocked text. This selection is made on the Attributes menu in Colors/Fonts/Attributes in Setup. Normally, the cursor is displayed in the Reveal Codes part of the screen as a rectangle which highlights in reverse video any character on which it is resting.

You can use the cursor keys to move through text in the normal editing screen. Moving the cursor changes its position in both parts of the screen.
As you move through text, about five lines of text stay below the cursor in the
Reveal Codes part of the screen. Consequently, the larger the Reveal Codes part
of the screen is, the more lines can remain above the cursor.

**Editing in Reveal Codes**
You can use all features and edit text in the Reveal Codes screen. However,
when you delete codes, you are not asked to confirm the deletion.

The only way to return to the normal editing screen is by pressing **Reveal
Codes**. Reveal Codes is also turned off when you exit Corel WordPerfect.

For a list of all the codes used in Corel WordPerfect and the function of each
code, see *Appendix B: Codes*.

**See Also:** Delete Codes

---

### Rewrite

As you move the cursor through text in your document, Corel WordPerfect
rewrites the text from the cursor to the end of the document.

To be certain that the text in a document is correctly formatted, use Rewrite to
completely reformat the text on your screen at any time, without moving the
cursor. If the text on your screen is jumbled for any reason, you can quickly use
Rewrite to correct the problem.

Rewrite is particularly useful when you are editing graphics images. Each time
you edit an existing graphics image (for example, change the horizontal or
vertical position of a graphics box), you will want to rewrite your screen when
you return to the normal editing screen (see *Graphics, Define a Box*).

To rewrite the screen,

1. Press **Screen**, then select Rewrite (3) or press **Return**.

### Notes

**Automatic Formatting**
At times you may not want to wait for the text in a document to be continually
reformatted. To turn off this feature,

1. Press **Setup**.
2. Select Display (1), then select Edit-Screen Options (6).
3. Select Automatically Format and Rewrite (1), and type n.
4. Then press **Exit** to return to your document.

When Automatic Formatting is off, text is only rewritten one line at a time as
you scroll through it using a cursor key.

**See Also:** Graphics, Define a Box; Screen
Save

When creating or editing a document, any changes you make are only stored temporarily in your computer’s active memory. If a power failure occurs or if your computer crashes, the work you have done would be lost.

A document is not stored permanently until you save it to a disk. It is a good idea to frequently save the document you are working on.

You can save a document without losing your place on the screen.

To save a document you are creating,

1. Press Save.
   
   Or Select Save from the File menu.

2. Enter a filename (see Entering Filenames below).

Notes

Backup Files
You can also protect your work against loss by using the Backup features. Original Backup protects you from accidentally replacing an existing file with a newer version. Timed Backup saves your document at timed intervals.

UNIX Text Files and Password Locking
To save your document in UNIX text format and to password lock files, use Text In/Out.

Entering Filenames
Unless you enter a full pathname, a file is saved in your default directory. You can determine what your default directory is by pressing List. Its name then appears on the status line at the bottom left corner of the screen (for example, Dir /usr/work/*). You can then press Cancel to return to the normal editing screen (see Default Directory under Directories).

You can also use longer filenames. If you are using Long Document Name, you must enter a long document name and a document type before entering the UNIX filename (see Environment Setup).

Once you have saved a document, the current document name appears at the save prompt whenever you save it again (see Saving an Existing File below).

Fast Save
In Corel WordPerfect you can save unformatted files or have files formatted before they are saved (see Fast Save).

Initial Settings
Any initial codes you have placed in Initial Settings in Setup or Document Format are saved with your document (see Initial Codes).

Saving an Existing File
Corel WordPerfect is designed with safeguards to protect you from replacing an existing file accidentally.
When you press **Save** to save a newer version of a file that already exists, Corel WordPerfect displays the existing filename. You can press **Return** if you want to replace the existing file, or you can enter a new filename. If you press **Return**, Corel WordPerfect asks you to confirm the replacement.

Type **y** to replace the existing file on disk with the document on your screen. If you press **n** (or any other key), you are prompted for a new filename. You can enter a different filename to keep both copies of your document.

When an existing filename is displayed, typing any character key erases the existing filename, and you have to start over. However, before you press a character key, you can use Left Arrow and Right Arrow to move through the existing filename and edit it. Use Backspace, Delete, or Delete to End of Line to delete existing characters.

**Saving With Exit**

When you are ready to exit a file, you can save your file as you leave by using Exit.

**Remote Save**

You can save a file to another UNIX computer connected to your network. Make sure you have read/write permission to the directory in which you want to save a file.

See Also: Exit; Fast Save; Text In/Out

---

**Screen**

Screen lets you use Line Draw, rewrite the screen, and create and adjust windows.

**Notes**

**Line Draw**

Use Line Draw (2) to create lines, boxes, and borders.

**Rewrite**

Select Rewrite (3) to rewrite the screen.

**Terminal Help**

Select Terminal Help (3) to display information about your specific terminal. These helps and hints are useful in explaining and expanding on items that are not listed by pressing Help twice.

**Window**

Select Window (1) to divide your screen into two parts so you can see and edit two documents at once. You can also use Window to adjust the number of lines contained in the normal editing screen in Reveal Codes (see Window).

See Also: Line Draw; Rewrite; Window
Search

When editing a document, you may sometimes need to move to a certain passage, but you might not remember exactly where it is. You can use Search to quickly move to a word, phrase, or code in your text.

1 Press a Search keystroke (see Search Directions below).

Or Select Forward or Backward from the Search menu.

2 Type the characters and/or codes you want to find (commonly referred to as the search string).

3 Press the Search keystroke to begin the search (see Codes and Editing Search Strings below).

4 After the cursor stops at the first match, press the Search keystroke twice to continue the search.

Or Select Next or Previous from the Search menu.

For example, with the cursor at the beginning of a document in which you mention Mrs. James, you can press Search, type james, then press Search again to move the cursor to the first occurrence of Mrs. James’ name. You can then continue pressing Search twice to move forward through the document to every occurrence of Mrs. James’ name until you find the exact reference you want.

Notes

Capitalization
In a search string, lowercase characters match both lowercase and uppercase. Uppercase characters match only uppercase. For example, bill will find Bill, but Bill will not find bill.

Codes
When typing a search string (in step 2 above), include codes by pressing the function keys and also selecting options to actually select the feature you want. For example, to insert an Underline code into a search string, press Underline.

Remember, you must actually select the feature. For example, you could not search for an Underline code [UND] by typing an open bracket (.), then typing UND and typing a closed bracket (.) as the search string.

To search for a pair of codes, press the function key twice. For example, to search for [UND][und], press Underline twice.

To search for the second code in a set of paired codes, you need to first insert both codes in the pair into the search string and then delete the first code. For example, to search for the Bold Off code [bold], press Search, press Bold twice to insert a pair of bold codes (for example, [BOLD][bold]) into the search string, press Left Arrow to move to the immediate right of the Bold On code [BOLD], press Backspace to delete it, then press Search to begin the search.
Editing Search Strings
When you type a search string (in step 2 above), you can use the arrow and
Delete keys to move through and edit it just as you would edit text in the normal
editing screen.

Search Directions
To search from the cursor forward, press *Search. To search from the cursor
backward, press *Search. While a Search prompt is displayed on the status line,
you can change the search direction by pressing Up Arrow or Down Arrow.

Once you have typed a search string, you can press *Search, *Search, or Escape
to perform the search.

Variations
When block is on, you can use Search to expand or contract the block to include
the next occurrence of the search string. For example, with block on in a
document in which you mention Mrs. James, you can press *Search, type james,
then press *Search again to extend the block to include the next occurrence of
Mrs. James’ name. In the same way, you can also use *Search to contract the
block back to the last occurrence of Mrs. James’ name.

Normally, Search searches only the main text of a document. A Search that
includes any text in headers, footers, footnotes, endnotes, graphics box captions,
and text boxes is called an Extended Search. To perform an extended search,
press Home before beginning the Search. The word extended is then displayed
within the search prompt, (for example, “-> Extended Srch.”).

When you type in a search string, you can use a Ctrl-X to represent any single
character. To include a Ctrl-X (^X) in a Search string, press Ctrl-v, Ctrl-x. If
you use Ctrl-X be aware that Ctrl-X does not represent function codes and it
cannot be the first letter in the search string. For example, the search string s^Xe
finds any words which contain “s” and “e” separated by any other single letter
(for example, cluster, speller, stellar, step, systems).

To include a Soft Return code [SRt] in a search string, press Ctrl-m.

You can include a Soft Page code [SPg] in a search string by pressing Ctrl-v,
Ctrl-k. However, Corel WordPerfect finds only those Soft Page codes which
were originally Soft Return codes [SRt]. You cannot search for Soft Page codes
which were originally Hard Return codes [HRt-SPg]. Instead, search for the
Hard Return code and it will find the Hard Return code [HRt-SPg] that caused
that soft page.

Words
When you are searching for a particular word that is surrounded by spaces, press
the Space Bar to include spaces before and after the word. Otherwise, the
Search will include any occurrences of that word even when it is found in other
words. For example, insert spaces before and after the word the to find the only
when it appears alone, and not in such words as these, therefore, and other.

See Also: Block, Define; Replace
Setup

The default (or initial) settings are set to accommodate a variety of users and situations. You can customize these settings for your own needs.

Settings made with features on the Setup key are stored in your home directory in a file called .wp7c.set. Some of these settings can be temporarily overridden with other features.

To change settings,

1  Press Setup.

Or  Select Setup from the File menu.

2  Select the option of your choice. The option headings are listed under Notes below. More specific information about those options and the items on their menus is found in specific locations in Reference.

Notes

Display Menu
This menu lets you make default settings for the way menus, screens, and text are displayed on the monitor in Corel WordPerfect. Its options include:

- Colors/Fonts/Attributes
- Menu Options
- Edit-Screen Options
- Text Screen Size
- Graphics Screen Type
- View Document Options

More information about the Display menu itself can be found in Display Setup. Check the Index for more information about the options.

Environment Menu
This menu lets you make default settings for several features. Its options include:

- Alternate Keyboard
- Backup Options
- Beep Options
- Document Management/Summary
- Fast Save
- Hyphenation (Dictionary)
- Prompt for Hyphenation
- Text In/Out Format
- Units of Measure

More information on the Environment menu itself can be found in Environment Setup. Check the Index for more information about the options.
Initial Settings Menu
This menu lets you make default settings for several features as well as for documents you create. Its options include:

- Date Format
- Equations (Options)
- Format Retrieved Documents for Default Printer
- Initial Codes
- Merge (Options)
- Print (Options)
- Repeat Value
- Save with Original Privileges
- Save/Retrieve documents with .wp extension
- Table of Authorities (Options)

More information on the Initial Settings menu itself can be found in Initial Settings. Check the Index for more information about the options.

Keyboard Layout Menu
This menu lets you map your keyboard. This means you can assign features, Corel WordPerfect characters, and macros to almost any key on the keyboard. For more information about this menu, see Keyboard Layout.

Location of Files Menu
This menu helps you organize your files. With it, you can specify directories for the following files:

- Backup Files
- Document Files
- Graphic Files
- Keyboard/Macro Files
- Printer Files
- Spreadsheet Files
- Style Files (Style Library and Filename)
- Thesaurus/Spell/Hyphenation Files (Main and Supplementary)

More information about the Location of Files menu itself can be found in Location of Files. Check the Index for information about the files represented on this menu.

See Also: Display Setup; Environment Setup; Initial Settings; Keyboard Layout; Location of Files

Sheet Feeder

A sheet feeder contains one or more paper bins and feeds paper from those bins to the printer one sheet at a time.

If you have a laser printer with a single paper bin, this bin is not considered a sheet feeder.
If you use a sheet feeder with your printer, you must select the feeder on the
Select Printer: Edit menu.

1 Press **Print**.
   
   *Or* **Print** from the **File** menu.

2 Choose Select Printer (s), move the cursor to the printer whose sheet feeder
you want to select, then select **Edit** (3).

3 Select Sheet Feeder (3), move the cursor to the name of the sheet feeder you
are using, then choose **Select** (1).

   *If you receive a “Printer files not found” message, Corel WordPerfect cannot find the .all file that
was used to define your printer. You need to specify the shlib directory or the where the .all file was
copied.*

A Helps and Hints screen appears after the sheet feeder is selected. Press **Exit**
after reading the information to exit the screen.

4 Press **Exit** until you return to the normal editing screen.

### Notes

**Bin Number**

Once you select a sheet feeder, you need to indicate which bin number you will
be using. (This information is found on the Sheet Feeder Helps and Hints
screen displayed after you selected a sheet feeder in step 3 above.) You specify
the bin number when you create a paper definition (see *Editing a Definition*
under *Paper Size/Type*).

**.prs File**

The sheet feeder definition is copied from the .all file to the Printer Resource
(.prs) file. (See *all and .prs Files* under *Printing—General Information* for an
explanation of the .prs file.)

**Selecting a Printer**

In addition to using the above steps to select a sheet feeder, you can also select
one when you select a printer.

**See Also:** Paper Size/Type; Printer, Select

---

**Sort**

Sort lets you select and sort (alphabetize) lines, paragraphs, secondary merge
records, or rows in a table. You can sort the contents of entire documents or use
Block to sort portions of a document.

The document or block you want to sort is referred to as the *input* file. It can be
on your screen or in a file on disk. After the document (or block) is sorted, it is
referred to as the *output* file. The output file can either replace the document (or
block) on-screen, or it can be sent to a file on disk.
The input file (unsorted) and output file (sorted) can be different files (if you use different names for each). This lets you sort a file without replacing the original, unsorted file. If you use the same name for the input and output file, you will be asked if you want to replace the existing input file. If you answer Yes, the output file will replace the input file.

The following steps explain how to sort an entire document. If you want to sort a block of information or rows in a table, see Block Sort or Table Sort below. You should always save your document before sorting.

1. Press Merge/Sort, then select Sort (2).
   Or  Select Sort from the Tools menu.

2. Press Return to sort the document on your screen.
   or
   Enter the name of the file on disk that you want to sort.

3. Press Return to replace the document on your screen (input) with the sorted document (output).
   or
   Enter the name of the output file (the file where you want the sorted information saved).

If you use the same name in both steps 2 and 3, you will be asked if you want to replace the existing input file with the sorted output file. Type y to replace the file or n to enter a new output filename.

4. When the Sort menu appears at the bottom of the screen, enter the keys and other criteria you want to use for sorting the document (see Sort Menu and Records and Fields below).

5. Select Perform Action (1) to begin sorting.

It is possible to use a file on disk as the input file and the screen as the output file. If you do so, the input file will be sorted and then inserted into the document on screen at the cursor position.

The default setting for the Sort menu is to sort lines, alphabetically sorting each line by the first word in the line. Using the Sort menu options (see Sort Menu below), you can change sorting criteria such as the type of sort (merge file, paragraph) the sort order (ascending, descending) and others. Any changes you make to the sort criteria are saved for the next sort until you exit Corel WordPerfect then start it again.

Codes on a line will sort with the line. Place codes at the top of the document or in Document: Initial Codes.

---

**Notes**

**Block Sort**

To sort a section of a document, block the text you want to sort, then press Merge/Sort. When sorting a block of text, you are not asked for input or output files but are taken directly to the Sort menu. When you select Perform
Action (1), the block is sorted on the screen and the sorted block replaces the original block.

If you have a Language code in your document, and you want it to affect the sorting of a block of text, the Language code should be before the block in the document (see Language).

Languages
Some languages include characters not available in the English alphabet. Corel WordPerfect can identify these characters for sorting purposes only if you use Language to specify the language you are sorting (see Language). To specify a language, you usually insert a Language code into your document. For the Language code to affect sorting, it must be inserted into the Initial Codes screen. The only exception to this rule is if you are sorting a block. Then the Language code can be inserted anywhere in the document before the selected block of text.

Records and Fields
Records are the units that are sorted in a file. In a line sort, each line is a record and can end with a hard or soft return. In a paragraph sort, each paragraph is a record and must end with two or more hard returns [HRt]. In a merge file sort, records are separated by {END RECORD} (see Merge). And in a table sort, each row is a record.

Each record is divided into parts that you can use to specify key words by which the record may be sorted. These parts include fields, lines, and words.

Fields • Secondary merge records (merge sort), lines (line and paragraph sort), and rows in a table can be divided into fields. For example, you could have a group of addresses. Each address is a record which can be divided into fields of information. The city may be a field and the ZIP Code may be another.

Corresponding fields from each record should contain the same type of information. For example, if field 1 of the first record contains a ZIP Code, then field 1 of every record in that file should contain a ZIP Code.

You can have as many fields as you like within a record. Each field is numbered consecutively: field 1, field 2, field 3, and so on. Using our address example, field 1 might be the street address, field 2 the city, field 3 the state, and field 4 the ZIP Code.

Fields are separated by tabs or indents in lines or paragraphs and by {END FIELD} in secondary merge files. In a table, each cell is a field. When you specify keys, you will need to enter a cell number. Cells are numbered from left to right, starting with cell 1.

If you are sorting lines or paragraphs, be sure to insert only one tab or indent between each field. Two tabs or indents next to each other (with nothing between them) will be interpreted as a blank field. Inconsistent use of tabs and indents between fields will lead to inconsistent results.
Be aware that Flush Right, Center, Margin Release, and Dec Tab also act as field delimiters within a sort.

**Lines** • Lines are used in merge, paragraph, and table sorting and can end with hard or soft returns. In line sorting, each line is considered a record.

Lines are usually counted from the top of the record to the bottom, but when sorting merge records or rows in a table, can be counted from bottom to top by using negative numbers. However, when you are sorting paragraphs, you cannot use negative numbers to indicate line numbers (see **Sort, Keys**).

**Words** • Words are separated by spaces, forward slashes (/), and Hard Hyphens within a line or field. Words are usually counted from left to right but can be counted from right to left by using negative numbers to specify a key (see **Sort, Keys**).

**Sort Menu**

Once you have specified the input and output files for the sort, the Sort menu appears in the lower half of the screen.

All of the current sort criteria are displayed. At the bottom of the screen is a menu of options which you can use to change the sort (and select) criteria.

**Perform Action** • Select Perform Action (1) to begin sorting or selecting. When sorting is complete, the sorted document is either displayed on your screen or saved in a file on disk, depending on the output file you indicated.

**View** • Select View (2) to scroll through the input file displayed in the upper half of the screen. You can use any of the cursor keys or the search keys to scroll through the text. When you finish, press Exit to return to the Sort menu.

**Keys** • Keys are words, fields, or phrases within a record used to sort and/or select specific items in a document. Select this option to define the keys you want to use for sorting the document.

For example, if you had a list of first and last names, key1 might be the last names, and key2 might be the first names. When sorting, Corel
WordPerfect would first sort the list using the last names (key1). Corel WordPerfect would use the first name (key2) only to sort people in the list who had the same last name.

Keys can be alphanumerical or numeric. See Sort, Keys for details.

Select • When you use this option, you are asked to enter a statement that specifies records to be extracted from the file before sorting. For example, you might use Select if you have a list of addresses, but you only want to sort the addresses with the same ZIP Code. See Sort, Select Records.

Action • If you are only sorting text, you will not need to use this option. Action (5) lets you specify whether you want to Select and Sort (1) or Select Only (2). If you choose Select and Sort, Corel WordPerfect always performs the selection before sorting the selected records. You cannot select this feature unless you have entered a select statement (option 4 on the Sort menu). See Sort, Select Records.

Order • Select Order (6), then select Ascending (1) or Descending (2). In ascending order, letters are sorted from A to Z and numbers from 0 to 9. In descending order, letters and numbers are sorted in reverse order.

Type • If you want to change the displayed type of sort, select Type (7), then select Merge (1) for secondary merge records, Line (2) for line records, or Paragraph (3) for paragraph records.

Table Sort
If you want to sort rows of information in a table (Table feature), you must first move your cursor into a cell within the table. Once the cursor is inside the table, press Merge/Sort. When sorting table information, you are not asked for input or output files but are taken directly to the Sort menu. When you select Perform Action (1), the table rows are sorted on the screen, replacing the original table information on the screen.

Each row in a table is a record, and each cell in a row is a field within the record. Rows are numbered from top to bottom starting with 1, and cells are numbered from left to right starting with 1.

You should only sort rows with the same number of cells. You should also avoid sorting rows with cells that span multiple rows.

If you use a select string that deletes an entire table in a table sort, you can restore the table by pressing Cancel, then selecting Restore (1). For more information about selecting records, see Sort, Select Records.

See Also: Sort, Keys; Sort, Select Records
In a sort, *keys* define words by which lines, paragraphs, merge records, and rows (Table feature) are selected and sorted.

You can sort the records in a file by using up to nine keys. Key1 has first priority, key2 has second priority, and so on. If the information in key1 is the same for more than one record, then key2 (if it exists) may be used to sub-sort all records having the same key1 value.

For example, you may have a phone list with the following information in each record (in this case the record is a line).

<table>
<thead>
<tr>
<th>Field 1</th>
<th>Field 2</th>
<th>Field 3</th>
<th>Field 4</th>
<th>Field 5</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cabano, Henry J</td>
<td>Religion</td>
<td>505-3956</td>
<td>Tall</td>
<td>1st C</td>
</tr>
<tr>
<td>Thompson, Robert R</td>
<td>Holland</td>
<td>505-1996</td>
<td>United</td>
<td>coach</td>
</tr>
<tr>
<td>Barnett, Gerald</td>
<td>Orlando</td>
<td>505-2222</td>
<td>Western</td>
<td>1st C</td>
</tr>
<tr>
<td>Castaneda, John</td>
<td>California</td>
<td>505-2222</td>
<td>Republican</td>
<td>coach</td>
</tr>
<tr>
<td>Young, Doug</td>
<td>New York</td>
<td>505-2222</td>
<td>NLM</td>
<td>1st C</td>
</tr>
<tr>
<td>Clegg, Ted</td>
<td>Umpire</td>
<td>505-2222</td>
<td>Delta</td>
<td>coach</td>
</tr>
<tr>
<td>Anderson, Sherry</td>
<td>Houston</td>
<td>505-3333</td>
<td>Eastern</td>
<td>1st C</td>
</tr>
<tr>
<td>Bennett, Ron</td>
<td>England</td>
<td>505-5555</td>
<td>Tall</td>
<td>1st C</td>
</tr>
</tbody>
</table>

The first field in each record contains at least two words—last name and first name. If you want to sort the records by last name *then* first name, the last name becomes key1 and the first name becomes key2.

Key 1

<table>
<thead>
<tr>
<th>Field 1</th>
<th>Field 2</th>
<th>Field 3</th>
<th>Field 4</th>
<th>Field 5</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cabano, Henry J</td>
<td>Religion</td>
<td>505-3956</td>
<td>Tall</td>
<td>1st C</td>
</tr>
<tr>
<td>Thompson, Robert R</td>
<td>Holland</td>
<td>505-1996</td>
<td>United</td>
<td>coach</td>
</tr>
<tr>
<td>Barnett, Gerald</td>
<td>Orlando</td>
<td>505-2222</td>
<td>Western</td>
<td>1st C</td>
</tr>
<tr>
<td>Castaneda, John</td>
<td>California</td>
<td>505-2222</td>
<td>Republican</td>
<td>coach</td>
</tr>
<tr>
<td>Young, Doug</td>
<td>New York</td>
<td>505-2222</td>
<td>NLM</td>
<td>1st C</td>
</tr>
<tr>
<td>Clegg, Ted</td>
<td>Umpire</td>
<td>505-2222</td>
<td>Delta</td>
<td>coach</td>
</tr>
<tr>
<td>Anderson, Sherry</td>
<td>Houston</td>
<td>505-3333</td>
<td>Eastern</td>
<td>1st C</td>
</tr>
<tr>
<td>Bennett, Ron</td>
<td>England</td>
<td>505-5555</td>
<td>Tall</td>
<td>1st C</td>
</tr>
</tbody>
</table>

Key 2

<table>
<thead>
<tr>
<th>Field 1</th>
<th>Field 2</th>
<th>Field 3</th>
<th>Field 4</th>
<th>Field 5</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cabano, Henry J</td>
<td>Religion</td>
<td>505-3956</td>
<td>Tall</td>
<td>1st C</td>
</tr>
<tr>
<td>Thompson, Robert R</td>
<td>Holland</td>
<td>505-1996</td>
<td>United</td>
<td>coach</td>
</tr>
<tr>
<td>Barnett, Gerald</td>
<td>Orlando</td>
<td>505-2222</td>
<td>Western</td>
<td>1st C</td>
</tr>
<tr>
<td>Castaneda, John</td>
<td>California</td>
<td>505-2222</td>
<td>Republican</td>
<td>coach</td>
</tr>
<tr>
<td>Young, Doug</td>
<td>New York</td>
<td>505-2222</td>
<td>NLM</td>
<td>1st C</td>
</tr>
<tr>
<td>Clegg, Ted</td>
<td>Umpire</td>
<td>505-2222</td>
<td>Delta</td>
<td>coach</td>
</tr>
<tr>
<td>Anderson, Sherry</td>
<td>Houston</td>
<td>505-3333</td>
<td>Eastern</td>
<td>1st C</td>
</tr>
<tr>
<td>Bennett, Ron</td>
<td>England</td>
<td>505-5555</td>
<td>Tall</td>
<td>1st C</td>
</tr>
</tbody>
</table>

Key1 indicates that you want the records sorted by the first word (last name) in the first field (Name) of each record. Key2 indicates that you want the records sorted by the second word (first name) in the first field if two or more last names are identical.

To enter key information, you must first display the Sort menu (Merge/Sort, 2, enter the input file, then enter the output file). From the Sort menu,
1 Make sure you have selected the type of sort you want (merge, line, or paragraph) using the Type option (7). See Sort.

2 Select Keys (3) and type the key type (a for alphanumeric and n for numeric). See Key Type below.

3 Enter the field or cell (tables) number, the word number, and the line number (if you are using a paragraph, merge, or table sort). For example, type 1 for first, 2 for second, and so on, if you are counting from left to right or top to bottom, or type –1 for first, –2 for second, and so on, if you are counting from right to left or bottom to top.

Negative numbers can only be used for words and fields.

The cursor automatically moves to the next set of key information after you enter the last number. You can follow steps 1 and 2 above to enter information for the second key, or you can press Exit to finish entering key information.

Once you have selected Keys (3), you can also use Insert and Delete to add and delete keys. Insert (Ins) adds keys at the cursor position, and Delete (Del) deletes the key at the cursor position.

Notes

Dates
If you want to sort dates, you can treat the month, day, and year as separate words if you divide them with forward slashes or Hard Hyphens (for example, 11/08/59, 11-08-59). This means you can set up separate keys for each. For example, key1 could be the year (the third word in 11/08/59), and key2 could be the month (the first word in 11/08/59).

To insert a Hard Hyphen, press Home and then press the dash character key (–). If you just press the dash character key alone, you insert a hyphen which is ignored by Sort. This means your date will be treated as a single number (for example, 110859).

Key Type
The first item in each key identifies the sort as alphanumeric or numeric.

Alphanumeric keys are made up of letters or numbers and are indicated with an “a” in the key information. Numbers, such as ZIP Codes, telephone numbers, and social security numbers, must be of equal length if you want to designate them as alphanumeric keys.

Numeric keys are numbers that can be of unequal length. Numeric keys can contain dollar signs, commas, and periods. Some examples are $25.00, 7,250, 26,000. Letters and non-numeric characters (for example, commas, and dollar signs) in numeric keys are ignored during selecting and sorting.

See Also: Sort; Sort, Select Records
At times you may want to select specific records from a file or document before sorting them. For example, you may want to create a sorted list of individuals that have the same ZIP Code.

Save your document before beginning a select. The output file (even if you are outputting to the screen) will only include selected items.

First define the keys you want to use when you sort or select text (see Sort, Keys). When you want to select as well as sort, display the Sort menu (Merge/Sort, enter an input file, enter an output file), then type 4 for Select.

From this menu you can create a select statement. A select statement specifies the criteria you want to use to select records. The menu includes several logical symbols which you can combine with keys (for example, key1, key2, key3) to create a select statement.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>+</td>
<td>(OR) Select records that meet the conditions of either key. Example: key1=Smith + key3=Nevada would select records which include a “Smith” for key1 or a “Nevada” for key3.</td>
</tr>
<tr>
<td>*</td>
<td>(AND) Select records meeting the conditions of both keys. Example: key1=Smith * key3=Nevada would select records for every “Smith” in “Nevada.”</td>
</tr>
<tr>
<td>=</td>
<td>Select records that have exactly the same information in an indicated key. Example: key4=84057 would select only those records with this ZIP Code.</td>
</tr>
<tr>
<td>&lt;&gt;</td>
<td>Select records that do not match the information for an indicated key. Example: key3&lt;&gt;Nevada would select all records that do not have “Nevada” for key3.</td>
</tr>
<tr>
<td>Symbol</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| >      | Select records that have information greater than the information for an indicated key.  
**Example:** key3>Nevada would select records with states for key3 alphabetically greater than “Nevada” (for example, “Ohio,” “Washington”). |
| <      | Select records that have information less than the information for an indicated key.  
**Example:** key4<84601 would select records with ZIP Codes for key4 numerically less than “84601” (for example, “43230,” “48236”). |
| >=     | Select records that have information greater than or equal to the information for an indicated key.  
**Example:** key4>=84601 would select records with ZIP Codes greater than or equal to “84601.” |
| <=     | Select records that have information less than or equal to the information for an indicated key.  
**Example:** key3<=Nevada would select records with states alphabetically less than or equal to “Nevada” (for example, “Nevada,” “Michigan,” “California”). |

**Notes**

**Global Select**  
You can do a global select to request all records containing key words by typing a g after the key. You do not have to define keyg as a key word. For example,  
keyg=Hawaii  
In this example, all records that have the word “Hawaii” in any field will be selected.

**Select Only**  
If you want to select records without sorting them, select Action (5) from the Sort menu, then choose Select Only (2).  
You need to create a select statement before you can use the Action option.

**Select Statement Order**  
Selection is done from left to right unless parentheses are used to change the order. For example:  
key1=male * key2=Krieger + key2=Gleed  
This statement first selects all males named Krieger and then adds everyone named Gleed. You could use parentheses to create the following statement:  
key1=male * (key2=Krieger + key2=Gleed)  
The statement now looks for everyone named Krieger or Gleed, but then only selects the males with those two names.

**See Also:** Sort; Sort, Keys
Speller, Check Spelling

The Speller checks the spelling in your document and it looks for double words, words with numbers, and certain types of capitalization errors. You can check a word, page, document, or block of text without leaving your document. You can also look up words phonetically, do a word count, or display all the words in the dictionary that match a pattern.

Speller is not intended to be a comprehensive dictionary. Because the main purpose of Speller is to help you keep misspelled words out of your documents, it lists only the most common correct spelling of a word. It does not list all possible spellings or words in the language.

Important: The Speller needs to be installed properly before it is used. If the Speller files have not been installed, check with your system administrator.

Save your document before spell-checking.

1 Retrieve the document you want to spell-check.

2 Press Spell.

Or 

2 Select Spell on the Tools menu.

3 Select Word (1), Page (2) for current page, or Document (3).

4 When the Speller stops and highlights a word, use the menu in the lower half of the screen to make any corrections and continue (see Double Word, Irregular Case, or Word Not Found below).

5 When checking is complete, press Exit to return to your document.

6 Replace the original document with the spell-checked version (use Save or Exit).

Notes

Adding Words

When the Speller stops on a word that you know is spelled correctly, you can use the Add Word option to add it to the dictionary. The words you add are saved in the wplexsup.us (U.S. English version) file created by Corel WordPerfect.
This file is located in your current directory unless you specify another directory with Location of Files.

If you chose New Supplementary Dictionary (4) before spell-checking, the words are added to your own supplementary dictionary file instead of wplexsup.us. (See New Supplementary Dictionary below, and Speller, Dictionaries.)

**Canceling Spell-Checking**
Press Cancel at any time to stop the spell-checking, then press any key to return to your document.

**Checking a Block**
You can spell-check a block of text by blocking the text, then pressing Spell. (The New Supplementary Dictionary and Word Count options are not available when checking a block.)

**Dictionaries**
The Speller helps you proof the document on your screen by comparing each word in your document with the list of words in a dictionary (wplex.us) supplied by Corel WordPerfect. It also checks a supplementary dictionary you create when you add words during spell-checking. Words in the supplementary dictionary are used to check spelling but are not displayed as options for replacement. In addition, you can create other dictionaries for use during spell-checking.

**Dictionary Full**
A temporary area in memory is used to save skipped words and to keep a copy of added words before they are written to the supplementary dictionary file. If this area becomes full, skipped words are removed to make room for added words. If the area is filled with added words, a “Dictionary Full” message appears. To correct this problem, you may want to exit the Speller to let Corel WordPerfect add the words in memory to the supplementary dictionary, then spell-check the rest of the document using Block.

**Dictionary Not Found**
If no path for the dictionary file is specified in Location of Files, Corel WordPerfect checks your current directory, then the wplib directory. If it is not found in any of these locations, you will receive an error message which allows you to enter the location of the file. To avoid getting the message each time you use the Speller, use Location of Files to specify the directory.
Double Word
When the Speller finds a double word occurrence, the two words are highlighted and the following menu appears.

Skip • Spell-checking continues; the double word is left as it was in the document. The Speller will stop on subsequent occurrences of the same double word.

Delete 2nd • The second occurrence of the word is deleted.

Edit • Change the text of the document using Left Arrow, Right Arrow, Backspace, Delete, or text characters, then press Exit or Return to continue spell-checking.

You can also press Left Arrow or Right Arrow to begin editing.

Disable Double Word Checking • Ignore double-occurring words for the rest of the document.

Irregular Case
The Speller checks for five types of capitalization errors. It then lets you change the capitalization pattern to a predetermined format. The errors the Speller looks for, and the capitalization pattern they are changed to (upon your confirmation) are:

In the following list, U represents an uppercase letter; l represents a lowercase letter.

- UUU... is changed to Ull... (for example, “THis” becomes “This”).
- IUl... is changed to Ull... (for example, “tHis” becomes “This”).
- IUU... is changed to UUU... (for example, “tHIS” becomes “THIS”).
- Iiu... is changed to Ill... (for example, “tHiS” becomes “this”).
- IU is changed to Ul (in two-letter words only; for example, “iS” becomes “Is”).

The capitalization of the entire word is based on the first three characters only. For example, “aPPle,” “APple,” “aPPlE,” and “APple” would all be replaced with “Apple” because in each case the first three letters fit the IUl... pattern.
When the Speller finds a word with any of the above types of capitalization patterns, it highlights the word and displays the following menu.

**Skip** • Spell-checking continues without changing the capitalization of the word; the word with its capitalization pattern is only skipped once. If it occurs subsequently in the document, the Speller will stop at each occurrence.

**Replace** • Rewrites the word with the new capitalization pattern as described in the list above. Subsequent occurrences of the word with the same capitalization pattern are not replaced automatically. Rather, the Speller stops at each occurrence.

**Edit** • Change the text of the document using Left Arrow, Right Arrow, Backspace, Delete, or text characters, then press Exit or Return to continue spell-checking.

You can also press Left Arrow or Right Arrow to begin editing.

**Disable Case Checking** • Ignores case in words for the rest of the document.

### New Supplementary Dictionary
To change the supplementary dictionary to be used for spell-checking,

1. Press Spell.
   
   Or Select Spell on the Tools menu.

2. Select New Supplementary Dictionary (4), then enter the full pathname of the supplementary dictionary you want to use.

If you have specified the location of personal supplementary dictionaries in Location of Files, you need only enter the filename of the supplementary dictionary.

**Password**
If a “Password:” prompt appears when you start the Speller, the supplementary dictionary file you are using is locked. This prompt also appears when you enter the name of a locked supplementary file after choosing New Supplementary Dictionary (4).
To use the locked supplementary dictionary, enter the password to the file. If you press Return or Cancel at the prompt, or if you enter an incorrect password, “1 Re-enter Password; 2 Continue Without Supplementary Dictionary” appears. Select Re-enter Password (1) to try again, or Continue Without Supplementary Dictionary (2) to have no supplementary dictionary in effect.

**Substructures**
The Speller checks regular document text and text in substructures (like headers, footers, footnotes, endnotes, graphics boxes with text, and so on). It does not check the spelling of text inside styles. Only the captions of equation boxes are checked by the Speller, not the text of the equation. To spell-check only the text in a substructure, you must invoke the Speller while in that substructure.

**Word Count**
When the spell-check is complete, a count of the number of words in the block, page, or document is displayed at the bottom of the screen. If you want to count words without spell-checking, use the Word Count option on the menu (see Speller, Word Count).

**Word Not Found**
When a word is not found in any of the dictionaries used by the Speller, it is highlighted and a list of possible replacement words is displayed. The replacement list includes words that are different by a single letter or two letters typed out of sequence. The list also includes words that sound similar to the word you are checking.

Replacement words come only from the Corel WordPerfect dictionary, not from the supplementary dictionary. For information on having words from other dictionaries appear as replacements, see Speller, Dictionaries.

Should the list extend beyond the screen, press Enter to view more words in the replacement list.

You can type the letter next to the correct spelling in the replacement list to replace the highlighted word (subsequent occurrences of the misspelled word are then replaced automatically as the Speller finds them), or select one of the following options.
Add • The word is saved in the supplementary dictionary and spell-checking continues.

You can edit the supplementary dictionary in Corel WordPerfect, or use the Speller Utility to add the supplementary dictionary to the main dictionary (wplex.us).

Edit • Correct the spelling in the document by using Left Arrow, Right Arrow, Backspace, Delete, or text characters, then press Exit to continue spell-checking.

You can also press Left Arrow or Right Arrow to begin editing.

The word is redisplayed if it is still not found in the dictionary. If you know the word is spelled correctly, use the Add Word or Skip option.

Ignore Numbers • Spell-checking continues; the Speller ignores words containing numbers in the rest of the document.

Look Up • You can look up a word in the main dictionary that matches a pattern. Use “?” to represent a single letter, and “*” to represent zero or more letters in succession in the pattern. If you do not enter a word pattern, a list of phonetically similar words is displayed when you use this option.

When the list is displayed, you can replace the misspelled word with the correct spelling by typing the letter next to the word in the replacement list. Subsequent occurrences of the misspelled word are then replaced automatically as the Speller finds them.

If you do not want to replace the word with any of the words in the list, press Exit to enter a new word or word pattern. If you do not want to enter another word or word pattern, press Exit again to return to the Word Not Found menu where you can then select any of the other options on the menu.

Skip • Spell-checking continues; recurrences of the word are ignored for the rest of the spell-check.

Skip Once • Spell-checking continues; the Speller will stop at the next occurrence of the word.

See Also: Speller, Dictionaries; Speller, Look Up Words; Speller, Word Count; Speller Utility; Thesaurus

Speller, Dictionaries

The Speller helps you proof the document on your screen by comparing each word in your document with the lists of words in a dictionary (wplex.us for the U.S. English version) supplied by Corel WordPerfect. It also checks a supplementary dictionary (wplexsup.us) which contains words you add during
spell-checking. In addition, you can create your own dictionaries for use during spell-checking (see Personal Dictionaries below).

**Notes**

**Editing Dictionaries**

You can add, delete, or edit words in any of the word-list-based dictionary files. There are two ways to edit a dictionary file.

- Use the Speller Utility program.
- Edit the file in Corel WordPerfect.

The type of dictionary and whether or not it has been compressed determine whether you should use the Speller Utility or Corel WordPerfect to edit the file.

The Corel WordPerfect dictionary (wplex.us) can only be modified by the System Administrator. If you want to modify wplex.us, copy the file to your own work directory. You can then edit the file using the Speller Utility. To use the edited dictionary, change the path to your Thesaurus/Spell/Hyphenation files in Location of Files in Setup.

Uncompressed supplementary dictionaries (or uncompressed portions of supplementary dictionaries) can be edited in Corel WordPerfect. Simply retrieve the file in Corel WordPerfect. The words must be entered one per line, and separated by a Hard Return code [HRt]. After making any changes, save the file, replacing the old version.

The Speller Utility has a feature which compresses a supplementary dictionary file. Compressing a file moves the words from the document portion of the file to the header portion which you cannot see or edit in Corel WordPerfect. For more information on the advantages of compressed files, see Optimize Dictionary under Speller Utility.

Compressed supplementary dictionaries (or compressed portions of supplementary dictionaries) must be edited using the Speller Utility. Words added to a compressed supplementary dictionary during spell-checking are not compressed. They are stored in the document portion of the file, and can be edited in Corel WordPerfect.

**Hyphenation**

The Corel WordPerfect dictionary file (see Corel WordPerfect Dictionary below) is also the file used to determine hyphenation. Supplementary dictionaries (see Supplementary Dictionary below) do not affect hyphenation.

The words in the Corel WordPerfect dictionary have dashes (−) indicating where they may be hyphenated. If words have been added to the Corel WordPerfect dictionary without hyphenation indicators (such as if you use the Speller Utility to add your wplexsup.us file to the Corel WordPerfect dictionary), the words may not be hyphenated by the Hyphenation feature of Corel WordPerfect. See Hyphenation and Hyphenation Zone for more information on hyphenation.

You can add words to the Corel WordPerfect dictionary with indicators for where they may be hyphenated by using the Speller Utility. See Speller Utility for more details on adding words with hyphenation indicators.
International Dictionaries
Corel WordPerfect has created dictionaries in several languages. The two letters after the period (.) indicate the language of the dictionary. For example, wplex.us is the United States English version of the Corel WordPerfect dictionary, wplex.fr is the French (National) version.

Corel WordPerfect offers the following versions of the dictionary:

- Afrikaans (AF)
- Catalanian (CA)
- Danish (DK)
- Dutch (NL)
- English – Australia (OZ)
- English – U.K. (UK)
- English – U.S. (US)
- Finnish (SU)
- French – Canada (CF)
- French – National (FR)
- German – National (DE)
- German – Switzerland (SD)
- Italian (IT)
- Norwegian (NO)
- Portuguese – Brazil (BR)
- Portuguese – National (PO)
- Spanish (ES)
- Swedish (SV)

New dictionaries may have been added since this printing.

The dictionaries listed above function on a word-list basis, except for Finnish, French-Canada, French-National, Italian, and Swedish, which use algorithmic dictionaries. Algorithmic dictionaries use rules instead of word lists to check spelling. Because they use rules, they can find more words than word-list dictionaries. Algorithmic dictionaries cannot be modified, either in the Speller or in the Speller Utility Program.

To use an international dictionary instead of wplex.us, insert a Language code in your document (see Language). The Speller will use the dictionary corresponding to the code until it finds another Language code or until you exit the Speller.

If you commonly use more than one language, you may want to combine Corel WordPerfect dictionaries of different languages, so that the Speller will recognize words of any of those languages. Use the Speller Utility to combine Corel WordPerfect dictionaries.

You can only combine word-list dictionaries. You cannot combine algorithmic dictionaries.
**Personal Dictionaries**

You can create your own supplementary dictionary by typing a list of words in Corel WordPerfect and saving it in any directory. When you run the Speller, select New Supplementary Dictionary (4), then enter the full pathname of your personal dictionary so that the Speller will use your supplementary dictionary instead of wplexsup.us.

As long as the new supplementary dictionary is selected, any words you add while spell-checking are added to your personal dictionary. Your new supplementary dictionary selection remains in effect until you exit Corel WordPerfect, or select another supplementary dictionary.

You can enter the directory name for your supplementary dictionaries on the Location of Files menu. Then you only need to enter the filename of the supplementary dictionary instead of the full pathname when you select a new supplementary dictionary.

**Supplementary Dictionary**

The default supplementary dictionary file (wplexsup.us) contains words you add during spell-checking, and is saved in the current directory unless you enter another location with Location of Files.

**Corel WordPerfect Dictionary**

The dictionary supplied with Corel WordPerfect (wplex.us) is made up of a main word list and a common word list. To speed up proofing, the Speller first looks for the word in the smaller, common word list. The main list is checked only if the word is not found in the common word list.

In order to run the Speller, wplex.us must be located in the current directory or the wpplib directory, unless you enter another location in Location of Files.

**See Also:** Speller, Check Spelling; Speller, Look Up Words; Speller, Word Count; Speller Utility; Thesaurus

---

**Speller, Look Up Words**

You can use the Speller to look up a word whose spelling you are unsure about.

**Important:** The Speller needs to be installed properly before it is used. If the Speller files have not been installed, check with your system administrator.

1 Press Spell.

Or Select Spell on the Tools menu.

2 Select Look Up (5).

3 Enter a pattern that matches the word you want to find, or enter a word that sounds like the word you want to find (see Word Patterns below).
Notes

**Word Patterns**

To enter a word pattern, enter the characters you know, and use wildcards to represent letters you do not know. Use a question mark (?) to represent a single character, and an asterisk (*) to represent zero or more letters in succession.

A list of all the words matching the pattern is displayed. For example, entering `re?d` matches “read” and “reed” but not “red.” `Bl*ot` matches “blot,” “Blackfoot,” and “bloodshot.” `Bl*fo?t` matches “Blackfoot” only.

You can use any combination of question marks and asterisks. Looking up words takes much longer, however, when a question mark (?) or an asterisk (*) is used as the first letter.

If you enter a word without a ? or *, Corel WordPerfect lists the words in the dictionary that sound like the word you entered.

**See Also:** Speller, Check Spelling; Speller, Dictionaries; Speller, Word Count; Speller Utility; Thesaurus

---

**Speller, Word Count**

Many academic and professional publishing environments require that you submit a count of the words in a document.

**Important:** The Speller needs to be installed properly before it is used. If the Speller files have not been installed, check with your system administrator.

To display word count,

1. Retrieve the document whose words you want to count.
2. Press Spell.
   
   Or [Select Spell on the Tools menu.]
3. Select Count (6).
4. When the count is displayed, press any key to return to the Speller menu, then press Exit to return to your document.

---

Notes

**Block**

The Word Count option is not available when Block is on. However, you can count the words in a block of text by spell-checking it. The number of words is displayed when the spell-check is complete.

**Count While Spell-Checking**

The Speller also counts words when you spell-check a block, page, or document.
What is Counted
Corel WordPerfect counts as a word any continuous series of valid characters. The following characters are valid:

- a-z
- A-Z
- International alphabetic characters (such as Ç, é, and ä)
- Apostrophe (’)

Numeric digits 0-9 are also valid characters; however, “words” that consist entirely of numbers are not counted. All other characters are invalid (including spaces and punctuation). In the following example, “23” is not counted because it is a number. “B214” is counted because B, 2, 1, and 4 are each valid characters, and are not all numbers.

Your interview will be held Friday, June 23, in room B214. Please bring your resume.

See Also: Speller, Check Spelling; Speller, Dictionaries; Speller, Look Up Words; Speller Utility; Thesaurus

Speller Utility

The Speller Utility performs various editing functions on the dictionaries used by the Speller. For example, you can use the Utility to add or delete words from the dictionary (wplex.us), display the common word list, or check the location of a word.

Some editing tasks on dictionaries can be done in Corel WordPerfect. See the Editing Dictionaries subheading under Speller, Dictionaries for more information before using the Speller Utility.

Important: The Speller Utility file (wspell) needs to be installed properly before using the program. If the Corel WordPerfect Utility Programs have not been installed, check with your system administrator.

To start the Speller Utility,

1. Go to a UNIX prompt. Ensure that the Speller Utility (wspell) is in your path.

2. Change to the directory that contains the dictionary file.

The Installation Program copies the wplex.us file to the uplib directory.
3 Enter `wpspell` to start the Speller Utility.

<table>
<thead>
<tr>
<th>Spell -- wordPerfect Speller Utility</th>
<th>wples.ux</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 - Exit</td>
<td>wples.ux</td>
</tr>
<tr>
<td>1 - Change/Create Dictionary</td>
<td>wples.ux</td>
</tr>
<tr>
<td>2 - Add Words to Dictionary</td>
<td>wples.ux</td>
</tr>
<tr>
<td>3 - Add Words From Dictionary</td>
<td>wples.ux</td>
</tr>
<tr>
<td>4 - Optimize Dictionary</td>
<td>wples.ux</td>
</tr>
<tr>
<td>5 - Display Common Word List</td>
<td>wples.ux</td>
</tr>
<tr>
<td>6 - Check Location of a Word</td>
<td>wples.ux</td>
</tr>
<tr>
<td>7 - Book Mark</td>
<td>wples.ux</td>
</tr>
<tr>
<td>8 - Add Words to Dictionary</td>
<td>wples.ux</td>
</tr>
<tr>
<td>9 - Convert 6.2 Dictionary to 5.1</td>
<td>wples.ux</td>
</tr>
<tr>
<td>A - Combine Other 5.2 or 5.1 Dictionary</td>
<td>wples.ux</td>
</tr>
<tr>
<td>C - Extract added words from wordlist-based dictionary</td>
<td>wples.ux</td>
</tr>
</tbody>
</table>

Selection: 

4 Select an option (see instructions for each option under Notes below).

**Notes**

Add Words to Dictionary

This option adds words to the compressed portion of the dictionary currently selected (see Change/Create Dictionary below). Words to add can be entered using existing files (for example, wp lex sup.us) or by typing them in at the keyboard. Be sure to enter all files and words before selecting Exit on the Add Words menu since the update process takes about the same amount of time no matter how many words are being added. This process may be quite lengthy, up to 20 minutes.

The update process will be somewhat faster if the words are sorted alphabetically before the update.

If you have many words to add, we recommend you put them in a file and sort them before using the Speller Utility to add them to the dictionary.

You have the following options when adding words:

<table>
<thead>
<tr>
<th>Spell -- Add Words</th>
<th>wples.ux</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 - Cancel - do not add words</td>
<td>wples.ux</td>
</tr>
<tr>
<td>1 - Add to common word list (from keyboard)</td>
<td>wples.ux</td>
</tr>
<tr>
<td>2 - Add to common word list (from a file)</td>
<td>wples.ux</td>
</tr>
<tr>
<td>3 - Add to main word list (from Keyboard)</td>
<td>wples.ux</td>
</tr>
<tr>
<td>4 - Add to main word list (from a File)</td>
<td>wples.ux</td>
</tr>
<tr>
<td>5 - Exit</td>
<td>wples.ux</td>
</tr>
</tbody>
</table>

Selection: 

If a supplementary dictionary is currently selected (see Change/Create Dictionary below), options 1 (Add to Common Word List (from Keyboard)) and 2 (Add to Common Word List (from a File)) are not available (although they appear on the screen).

Words added to the common word list are automatically added to the main word list.
Hyphenation Indicators • The Corel WordPerfect dictionary (wplex.us) is also used to determine hyphenation. If you add words to this dictionary, insert dashes (-) at each location where you want Corel WordPerfect to hyphenate the word. You can either type a dash (Hyphenation Character) or press Home, then type a dash (Hard Hyphen). Both will work to produce hyphenation in the wplex file. If you do not include these hyphenation indicators in the words you add, Corel WordPerfect will not hyphenate them when you use the Hyphenation feature. Instead they will be wrapped to the next line.

If you are adding the words in a supplementary file to the main dictionary, insert the dashes by editing the file in Corel WordPerfect first. If you are adding individual words, insert the dashes as you type the words.

Algorithmic Dictionaries (International)
Algorithmic dictionaries that are available in some languages (see Speller, Dictionaries) cannot be modified.

Change/Create Dictionary
This option selects the dictionary on which the actions of the other options will be performed. Depending on the type of dictionary you change to, some of the other options are not available. If the dictionary name you enter when you use this option does not exist (or is not found), you are asked if you want it created.

If you create a main dictionary that you want to use with the Speller, you must use a valid filename for the dictionary. These filenames follow the pattern wplex.xx, where xx is the two-letter language code for the dictionary. See Language for a list of the codes.

Check Location of a Word
You can see if a word is found in either the common or main word lists of the dictionary currently selected. This option is not available if a supplementary dictionary is currently selected (see Change/Create Dictionary above).

Combine Other &c Dictionaries
Corel WordPerfect has dictionaries in several languages. The two letters after the period (.) indicate to the Speller the language of the dictionary. For example, wplex.no is the Norwegian version.

If you commonly use more than one language, you may want to use this option to combine dictionaries of different languages, so that the Speller will recognize words of either language. The resulting dictionary retains the name of the dictionary originally selected (see Change/Create Dictionary above), but contains the word lists of both dictionaries.

Important: You can only combine word-list dictionaries. Algorithmic dictionaries cannot be combined. See Speller, Dictionaries for more information.

Compress/Expand Supplemental Dictionary
This option compresses a supplementary dictionary file. Compressing a file moves the words from the document portion of the file to the header portion.
which you cannot see or edit in Corel WordPerfect. Compressing the file has the following advantages:

- The amount of disk space required to store the file is reduced.
- The Speller will not ignore words in the supplementary dictionary that do not fit in memory.
- Words in the compressed portion of the dictionary will appear as replacement words when a word is not found during spell-checking.

**Convert 4.2 Dictionary to 5.1**

Choose this option, enter the name of an existing WordPerfect Corporation’s WordPerfect 4.2 dictionary, then enter another filename to convert a 4.2 dictionary to a 5.1 dictionary. The 5.1, 5.2+, and 8c dictionaries are identical.

*The resulting 5.1 dictionary will not contain hyphenation indicators. If you want to include hyphenation indicators, follow the procedure described under Convert 5.0 Dictionary to 5.1 below, except enter in step 2 the name of the 5.1 dictionary that resulted from your conversion of the 4.2 dictionary.*

**Convert 5.0 Dictionary to 5.1**

The difference between WordPerfect Corporation’s WordPerfect version 5.0 and version 5.1 of the dictionary are the inclusion of hyphenation indicators in version 5.1 (see *Hyphenation* under *Speller, Dictionaries*).

If you have not altered the 5.0 dictionary, use the new version that came with Corel WordPerfect 8c. Version 5.0 supplementary dictionary files require no conversion to work with 8c.

If you have added words to your 5.0 dictionary and want to use that dictionary and add hyphenation indicators to the file,

1. Start the Speller Utility (see the steps at the beginning of this section).
2. Select Change/Create Dictionary (1), then enter the name (include a path if necessary) of your 5.0 dictionary file (for example, /wplib/wplex.us).
3. Select Combine Other 8c Dictionaries (A), then enter the name (include a path if necessary) of your 8c dictionary file (for example, /wplib/wplex.us).

The 5.1, 5.2+, and 8c dictionaries are identical. The words in the 8c dictionary that duplicate words in the 5.0 dictionary overwrite the 5.0 words in the combined dictionary, so that they will have hyphenation indicators. Words you added will remain as they were, without hyphenation indicators. If you want to add the indicators for these words, re-add the words using the Add Words to Dictionary (2) option (see *Add Words to Dictionary* above).

**Delete Words from Dictionary**

This option deletes words from the compressed portion of the dictionary currently selected (see *Change/Create Dictionary* above). Words to be erased can be entered from existing files or the keyboard. Be sure to enter all files and words before selecting Exit on the Delete Words menu since the delete process takes the same amount of time no matter how many words are being deleted. This process may be quite lengthy, up to 20 minutes.
The delete process will be somewhat faster if the words are sorted alphabetically before the update. If you have many words to delete, we recommend you put them in a file and sort them before using the Speller Utility to delete them from the dictionary.

You have the following options when deleting words:

<table>
<thead>
<tr>
<th>Spell Utility Delete Words</th>
<th>Option</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 - Cancel: do not delete words</td>
<td></td>
</tr>
<tr>
<td>1 - Delete from common word list (from keyboard)</td>
<td></td>
</tr>
<tr>
<td>2 - Delete from common word list (from a file)</td>
<td></td>
</tr>
<tr>
<td>3 - Delete from main word list (from keyboard)</td>
<td></td>
</tr>
<tr>
<td>4 - Delete from main word list (from a file)</td>
<td></td>
</tr>
<tr>
<td>5 - Exit</td>
<td></td>
</tr>
</tbody>
</table>

Options: 

- Display Common Word List
  This option lets you view the words in the common word list. Press Return to see additional words. Press Cancel to return to the menu.

- Extract Added Words from Word-List Based Dictionary
  Use this option when you are changing from a word-list dictionary to an algorithmic dictionary.
  1. After selecting the option, enter the name of the word-list dictionary (include a path if necessary).
  2. Select the name of the algorithmic dictionary.
  3. Enter the name of the supplementary dictionary where you want non-matching words to be written (see note below).

The Speller Utility uses the algorithmic dictionary you selected to check the spelling of the words in the word-list dictionary. Unrecognized words (usually words you added) are written to the supplementary file you entered.

- Look Up
  This option works the same as Look Up on the Not Found menu in the Speller. To use this option with a supplemental dictionary, the dictionary must be compressed (see Compress/Expand Supplemental Dictionary above).

- Optimize Dictionary
  This option optimizes the compressed portion of a dictionary file, making the dictionary take less disk space and run faster.
**Phonetic Look Up**

This option lets you look up all the words in the compressed portion of the selected dictionary that sound like the word or word pattern you enter after selecting Look Up (5). To use this option with a supplemental dictionary, the dictionary must be compressed (see Compress/Expand Supplemental Dictionary above).

**See Also:** Speller, Check Spelling; Speller, Dictionaries; Speller, Look Up Words; Speller, Word Count

---

**Spreadsheet, Import and Link**

To include spreadsheet data in a Corel WordPerfect document, use Spreadsheet Import and Spreadsheet Link.

For example, the statistical information in the document below was imported from a spreadsheet to create a financial report.

![Spreadsheet Import and Link Example](image)

Spreadsheet Import imports the information from the spreadsheet file *one time only*. Spreadsheet Link provides a way for you to continuously update the imported information to reflect changes made to the spreadsheet file.

You can import Lotus 1-2-3, Excel, and Corel Quattro Pro files as a table or as text. You can also open Excel and Corel Quattro Pro spreadsheet files directly into tables.

To import a spreadsheet file,

1. Move the cursor to where you want to import the spreadsheet file.
2. Press **Text In/Out**.

   _Or_  
   **Select Text In from the File menu.**
3 Select Spreadsheet (5), then select Import (1).

To create a spreadsheet link (see Links below), select Create Link (2) instead of Import (1) in the step above.

4 Select Filename (1), then enter the filename of the spreadsheet file you want to import. Unless the spreadsheet file is in your spreadsheets directory, you must enter the full pathname to the file.

If you enter the name of a file that is not in a supported format, Corel WordPerfect displays the “Incompatible File Format” error message.

You can also press List after selecting Filename, then enter a pathname to display the files in a directory. Selecting Retrieve (1) from the List Files screen selects the highlighted file as the file to be imported.

5 Select Range (2), then enter the range (or block) of cells in the spreadsheet file you want to import. The default is the entire spreadsheet file.

Acceptable ways of entering a range allow for a colon, a period, or two periods between the beginning and ending cells of a range (for example, A1:C3, A1..C3, A1..C3). Also, if you have defined a named range (or block) in your spreadsheet, you can simply enter the name of that range (for example, Expenses).

You can press List after selecting Range to display the ranges you have defined in your spreadsheet file. Moving the cursor to one of these ranges and pressing Return selects that range as the range of cells to be imported.

More information on the Range option can be found in Range (Block) below.

6 Select Type (3), then select Table (1) or Text (2) to import the spreadsheet file as a Corel WordPerfect table or as text. More information on this option can be found in Type below.

At this point, your options should be set, and the Spreadsheet: Import or Spreadsheet: Create Link menu should look something like the following.

7 After your options are set, select Perform Import (4) (or Perform Link (4)) to import the spreadsheet file to the cursor location.
While the spreadsheet file is being imported, an “Importing Spreadsheet” prompt is displayed on the status line. Corel WordPerfect is searching for and importing the specified information.

If you are using Spreadsheet Import, the spreadsheet file is not imported until you select Perform Import (4) from the Spreadsheet: Import menu. If you are creating a link, however, and you press Exit to exit the Spreadsheet: Create Link menu without selecting Perform Link (4), the link codes are included in your document (but the spreadsheet file is not imported). This enables you to create a link to a spreadsheet file that may not yet be created.

To exit the Spreadsheet: Create Link menu without inserting link codes into your document, press Cancel.

You can also press Retrieve from the normal editing screen, then enter the name of a spreadsheet file to import the file. Or, you can press List, enter a directory name, highlight a spreadsheet file, then select Retrieve (1) to import the file. In either case, the entire file will be imported into a table.

Notes

Appearance
When Corel WordPerfect imports a spreadsheet file, it tries to preserve the file’s appearance as it was formatted by the spreadsheet program.

When a spreadsheet file is imported, column widths are determined by the base font in effect at the location of the import (see Font).

If you import a spreadsheet file as a table (see Type below), the cells are separated into columns by [Cell] codes and are separated into rows by [Row] codes. Alignment and justification of text within a table cell is maintained by Table Format options.

Important: If you lock cells in a spreadsheet file, those cells are locked when you import them as a table. You can unlock them with the Lock option in the Table feature (see Cell, Lock under Table, Format Columns and Cells).

If you import a spreadsheet file as text (see Type below), tab stops are set according to the column widths in the spreadsheet. Cells are converted to tabbed columns. Rows are marked with hard returns. The beginning of a column is marked with a left tab and the end of a column is marked with a right tab. Left- and right-aligned text is supported, but text that was center-aligned in the spreadsheet becomes left-aligned text. Tabs are reset at the end of the imported file.

If the number of columns you want to import exceeds the maximum number of table (32) or text (20) columns Corel WordPerfect allows, Corel WordPerfect does not import the columns that exceed the limits.

Second, even if you are importing an allowable number of columns, the columns might not fit between the page margins. In this case, Corel WordPerfect will display a warning message and treat the text differently depending on whether it is imported as a table or as text.

If the file is imported as a table (see Type below), Corel WordPerfect will import up to 32 columns on a row and display those columns in the normal editing
screen. Only the columns that fit between the left margin and the right edge of the paper, however, will be displayed in View Document and printed.

If the file is imported as text (see Type below), Corel WordPerfect will import up to 20 columns on a row. If Corel WordPerfect reaches the right margin before it imports all 20 of the cells, it will insert a soft return or deletable soft return and continue the remainder of the cells on the next line of the page.

In either case, you will probably want to edit the spreadsheet file appearance. One place you can edit the spreadsheet file appearance is in the spreadsheet program itself. Try reducing the column widths. Information on this procedure can be found in your spreadsheet manual.

Within Corel WordPerfect, changing the base font prior to the location of the import will reduce the size of the columns. If you change the base font, however, change it before you import the file. If you have already imported the file, delete the imported file from the Corel WordPerfect document, change the base font, then import the file again.

Also, try reducing the left and right page margins in Corel WordPerfect prior to the location of the import. This will fit more text on a line.

If you are importing the spreadsheet file as a table, you may want to set the Table Position option to Full (see Options under Table, Edit Structure). Doing so sizes the table to fit between the left and right margins.

You can also print in landscape (text parallel to the long edge of the paper) if your printer has that capability (see Printing, Landscape).

**Important:** If you are linking to a spreadsheet file, editing changes made to the text of the imported file in Corel WordPerfect will be replaced the next time you update the link.

**Currency Symbols**
When you import a spreadsheet, the Language Resource file “translates” decimal separators, currency symbols, and credit and debit symbols according to the current language code.

**Date Cells**
When you import a spreadsheet that contains date cells, these dates are formatted according to field 2 for the current language code in the Language Resource file.

**Existing Table**
If you position your cursor in an existing Corel WordPerfect table, you can import a spreadsheet file into that table. When you do so, the spreadsheet information will overwrite existing information in the cells where the spreadsheet information is being imported.

If you import the file as text (see Type below), the file will be imported into the cell in which your cursor is located. If you import the spreadsheet file as a table, each cell in the file will be imported into a different cell of the table, but only the number of cells that exist in the table (from the cursor forward) can be imported.
If the table (from the cursor forward) is not big enough to accommodate the entire range of cells, some of the cells will not be imported. Corel WordPerfect will start at the beginning of the range and import only the number of cells that exist in the table. For example, if your range is A1:E5 and the table (from the cursor forward) is three rows long and three columns wide, only cells A1:C3 will be imported.

**Export**
To export information to WordPerfect Corporation’s PlanPerfect (versions 3.0 or 5.0), the information must be divided into columns by tabs and into rows by hard returns. If the information is in a table, delete the [Table Def] code in Reveal Codes. If you delete a [Table Def] code without using Block, you cannot restore it.

Information about exporting a file to PlanPerfect can be found in the *PlanPerfect Reference Manual*.

**Graphics Boxes**
You can import a spreadsheet file into a graphics box (see *Text Editor* under Graphics, *Edit*). If the information you are importing is longer than a page, however, you will get an error message and must edit the information to keep it within the bounds of a page.

If you create a link in the graphics box, you can import information that exceeds a page by performing the link outside of the graphics box. The information that extends beyond the page, however, will not display in View Document, nor will it print. Also, if you go into the graphics box to edit the spreadsheet file once it is imported, you will have to edit it to keep it within the bounds of a page.

The size of the spreadsheet file and the size of the graphics box you are importing it into will affect the appearance of the imported file. In addition to changing the box size, you can edit the spreadsheet file appearance in several ways (see *Appearance* above).

**Links**
A spreadsheet link lets you import a spreadsheet file into a document, then update the imported information as often as necessary to reflect editing changes you may have made in the spreadsheet file itself. When you create a link, two codes showing where the link begins and ends are inserted into your document.

![Spreadsheet Link Example](image-url)
The comment representing the beginning link code lists the filename and the range of cells you are linking to. The comment representing the ending link code simply displays “Link End.” The comments representing the link codes are never printed.

If you don’t want the comments representing the link codes to be displayed in the normal editing screen, change the Show Link Codes option on the Link Options menu. Instructions for doing so are found under Spreadsheet, Link Options.

When you import a spreadsheet into an existing table or into columns, the comments representing the link codes are not displayed in the normal editing screen regardless of the Show Link Codes setting.

**Deleting a Link** • To delete a link, delete either the Link or Link End codes.

**Editing Links** • Once a link is created, the only way to edit it is with the Edit Links option. After you make the necessary changes, you can update the link by selecting Perform Link (4). More information on updating a link can be found under Updating Links below.

To edit a link, position the cursor after the link you want to edit (you may want to use Reveal Codes to be sure). Then, press Text In/Out, select Spreadsheet (5), and select Edit Link (3). Edit the options as necessary. Select Perform Link (4) to change the link and import the newly-specified information.

Corel WordPerfect searches for a link backward from the cursor position, then forward.

**Nesting Links** • You should not include one link inside of another (“nest”). If you do, updating a link deletes all the information between the Link and Link End codes before the new information is retrieved (see Updating Links below).

**Updating Links** • Updating links is the process of updating the information in your Corel WordPerfect file with the current information in your linked file. You can do this at any time or have Corel WordPerfect do it for you each time you retrieve the Corel WordPerfect document. The last spreadsheet information imported to a link is the information that is printed.

To update links in the document on the screen at any time, press Text In/Out, select Spreadsheet (5), select Link Options (4), then select Update All Links (3). When you do so, Corel WordPerfect imports the current information from the linked file and places it in the link. The linked file must have been saved in the spreadsheet program for Corel WordPerfect to get the correct information. Any existing information in the link is deleted.

To update a single link, use the Perform Link (1) option on the Spreadsheet: Edit Link menu (see Editing Links above).

To update your links each time you retrieve the document (see Spreadsheet, Link Options).
**Range (Block)**

The range (or block) of cells is a rectangular region on your spreadsheet file defined by the cell at the upper left-hand corner of the range and the cell at the lower-right corner of the range. When you enter a range for Spreadsheet Import and Spreadsheet Link, you are specifying the rectangular block of cells you want to import. The two numbers representing the upper-left and lower-right cells should be separated by a colon, a period, or two periods.

After you select **Range (2)** from the Spreadsheet: Import or Spreadsheet: Create Link menus, you can enter the numbers as described above or a range name. You can also press **List** to display a list of named ranges. These are ranges that you may have defined in your spreadsheet program.

If you display the list of named ranges, you can use Up and Down arrows to move the cursor through the displayed ranges, or you can begin typing letters to move the cursor to the name of a range that matches those letters. When the cursor is on the range you want to import, press **Return**.

**Type**

The Type option specifies whether you want to import spreadsheets as a table or as text.

If you select **Table (1)**, the information is divided by Cell and Row codes in a table structure. Once imported, the table can be edited like any other table and will have the same restrictions as other tables. One restriction that may be important to you is that tables cannot be placed in columns.

For more information on the numerous editing options you have with Corel WordPerfect tables, see **Table, Create** and **Table, Edit Structure**.

If you select **Text (2)**, the imported cells are divided into columns by tabs and into rows by hard returns. Once imported, the spreadsheet file can be edited like any other Corel WordPerfect text.

**See Also:** Spreadsheet, Link Options

---

**Spreadsheet, Link Options**

The Link Options let you update spreadsheet links and determine whether link codes are displayed. **Spreadsheet, Import and Link** explains in detail how to create a spreadsheet link that will let you retrieve current data from a spreadsheet file.

To set Link Options,

1. Press **Text In/Out**.
   
   Or **Select Text In from the File menu**.

2. Select Spreadsheet (5), then select Link Options (4).
3 Select the option of your choice and make the necessary settings (see the heading corresponding to an option under Notes below).

4 If necessary, press Exit to return to the normal editing screen.

Changes made with the Link Options are only in effect for the document on the screen and do not insert a code in the document.

<table>
<thead>
<tr>
<th>Notes</th>
<th>Show Link Codes</th>
</tr>
</thead>
<tbody>
<tr>
<td>This option determines whether Corel WordPerfect displays the beginning and ending link comments on the screen. Type n to keep them from being displayed.</td>
<td></td>
</tr>
<tr>
<td>The comments mainly serve as a reminder that you are in a link. They are never printed regardless of the setting for this option. Also, they are never displayed if the link was created in an existing Corel WordPerfect table or columns.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Update all Links</th>
</tr>
</thead>
<tbody>
<tr>
<td>If you select this option, Corel WordPerfect updates all of the links in the document on the screen, retrieving the current information from the linked files.</td>
</tr>
<tr>
<td>The spreadsheet file must have been saved for Corel WordPerfect to retrieve the most current information.</td>
</tr>
<tr>
<td>The information that is printed in a link is the last information that is retrieved to the link. When you update a link, any existing information in the link is deleted.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Update on Retrieve</th>
</tr>
</thead>
<tbody>
<tr>
<td>This option determines whether Corel WordPerfect will update your links each time you retrieve the Corel WordPerfect document in which the links are located. Type y to have Corel WordPerfect update the links on document retrieval, bringing in the most current information from the linked file.</td>
</tr>
<tr>
<td>The spreadsheet file must have been saved in the spreadsheet program for Corel WordPerfect to retrieve the most current information.</td>
</tr>
<tr>
<td>Keep in mind that the information that is printed is the last information that is retrieved to the link. If it's absolutely necessary that your Corel WordPerfect file has the current information from the spreadsheet file, it's a good idea to set the option to Yes.</td>
</tr>
<tr>
<td>When you update a link, any existing information in the link is deleted.</td>
</tr>
</tbody>
</table>

See Also: Spreadsheet, Import and Link

**Style**

You can insert *styles* that format your text. Unlike other codes, styles can contain text and multiple formatting codes that create a text appearance. Since styles can
be easily inserted into a document, they are best used to create and insert an often-used format.

For example, if you are writing a book, you may have a certain appearance for your text. You can create a style called “Text” and use it anytime you want that appearance to take effect. Similarly, you can create styles called “Chapter Head” and “Long Quotes” that format chapter headings and long quotes. When you reach a place where you want to create a chapter heading and long quote, you can easily insert the style rather than re-entering the same formatting codes every time.

The Styles menu and some examples of styles on the menu are shown below.

Information on creating a style is found in *Style, Create*. Styles are saved with a document when the document is saved.

To insert a style into your document,

1. Press **Style**.

   *Or* **Select Styles from the Layout menu.**

2. Move the cursor to the style you want to turn on.

3. Select **On** (1).

Styles are either paired or open. Paired styles have an On [Style On] code and an Off [Style Off] code, while open styles simply are turned on and cannot be turned off. As you create styles with *Style, Create* you will learn more about paired and opened styles.

The important thing to know right now is that you can turn off a paired style by repeating steps 1 and 2 above, then selecting Off (2), or by moving the cursor past the Style Off code. You can also place paired style codes around existing text by blocking the text, then following the steps above.

**Notes**

**Creating a Style**

Before you can insert a style, the style must be created. To create a style, press **Style**, select Create (3), then enter information for the style. For specific information about creating a style, see *Style, Create.*
Deleting a Style
To delete a style from the Styles menu, press Style, move the cursor to the style you want to delete, then select Delete (5).

After you do so, Corel WordPerfect will give you three options. Leaving Codes (1) deletes the style from the Styles menu and all Style codes with the same name from the document. All codes that the style contains, however, replace the Style codes. For example, if your style called for 2" left and right margins, the Style code would be deleted, but a code calling for 2" left and right margins would be inserted into the document.

Including Codes (2), deletes the style from the Style menu and all Style codes with the same name from the document. When the Style codes are deleted, the codes within the style are also deleted.

Definition Only (3) deletes the style from the Styles menu. Style On and Off codes with the same name in the document remain intact. When Corel WordPerfect encounters those codes in the document, it recreates them on the Styles menu. If you have a long list of styles and want to find out which ones you are actually using in a document, you can delete all of the styles with Definition Only, then return to the document and press Home, Home, Down Arrow to recreate the styles that exist in the document.

Editing a Style
To edit an existing style, press Style, move the cursor to the style you want to edit, select Edit (4), then edit the style. See also Editing a Style under Style, Create.

Graphics
To include graphics images in a style, use the Graphics on Disk option (see Graphics, Define a Box).

Name Search
To search for a style on the Styles menu, press Name Search (n), then type the style name. As you type, the cursor moves to the first style name that matches the letters. To reset Name Search, press Return or any of the arrow keys.

If you are searching for a style in a macro definition, we suggest you use Name Search to find the style.

Nesting Styles
Nesting a style refers to including a paired style within another paired style. You can nest styles with one exception:

You cannot include Style On and Style Off codes for the same style immediately next to each other. If the Style On and Style Off codes are separated by a Style On and Style Off code from another style, however, you can nest a style within a style of the same name.

For example, this is not allowed:
[Style On:a][Style On:a][Style Off:a][Style Off:a]

The following, however, is allowed:
Outline Styles

Outline styles are styles that are used with Outline and Paragraph Numbering. If you are within Outline On and Off codes and are using outline styles as your method of outline numbering, you can turn on an outline style from the Styles menu by following the steps at the beginning of this section. If you are not within Outline On and Off codes, you can only turn on outline styles with the Outline Styles menu.

For more information on outline styles, see Outline, Style.

Retrieving Styles

To retrieve a list of styles previously saved to the Styles menu, press Style, select Retrieve (7), then enter the name of the style list. If you don’t enter a complete pathname, Corel WordPerfect will search the style directory (see Location of Files). If no style directory exists, it searches the default directory.

After you select Retrieve, you can press List, then enter a pathname to view the files in that directory. Positioning the cursor on a style file, then selecting Retrieve (1) will retrieve that file to the Styles menu.

When you retrieve a list of styles, Corel WordPerfect checks your current list of styles for style names that match the incoming styles. If Corel WordPerfect finds a match, it displays the “Style(s) Already Exist, Replace?” message. If you type n for No, Corel WordPerfect only retrieves the styles whose names do not match current style names. If you type y for Yes, all the styles are retrieved, replacing current styles with the incoming files of the same name.

Outline styles in the file you retrieve are also retrieved to the Outline Styles menu (see Outline, Style).

Saving Styles

To save all of the styles on the Styles menu to a separate file that can be used from document to document, press Style, select Save (6), then enter a name for the list of styles. They will be saved to the style directory (see Location of Files). If no style directory exists, they will be saved to the default directory. You can also enter a full pathname to save the file elsewhere.

This option is only for saving styles as a separate file that can be used from document to document. When you save a document, you save the styles associated with it, so there is no need to use this option if you use the styles in the current document only.

Important: We suggest you create a style directory, specify it in Location of Files, and name style files with some type of descriptive extension (for example, .sty) when you save them. This may help you remember that a style file is a style file and not a document.

When you use the Save option, outline styles on the Outline Styles menu are also saved to the file.
Style Library
The style library is a default list of styles. This means that if you press Style and no styles exist, the style library is retrieved to the Styles menu.

Once the style library is retrieved to the Styles menu, it is like any other list of styles. If you make editing changes to it, then save the document, the editing changes are saved for that document only. However, if you make editing changes to the style list, then save it as a separate file under the same name, the changes are made to the style library file.

To specify a location, a style library, press Setup, select Location of Files (6), select Style Files (5), enter the pathname to the style directory, then enter the filename to the style library. Corel WordPerfect will use the pathname to locate the style library when it is needed.

If the style library is in a directory other than where your style files are located, you will need to enter a complete pathname (rather than just a filename) for the style library.

The style library is also retrieved to the Styles menu any time you select Update (8) from the Styles menu (see Update below).

Styles and Master Documents
If you are creating a master document, the styles in all the subdocuments (and any styles in the non-subdocument portion of the master document) are combined on the Styles menu for the master document when the master document is expanded. However, if two styles in the master document have the same name, the one closest to the top of the document is used.

Also, if you decide to save the subdocuments when the master document is condensed, the combined list of styles is saved with each subdocument.

Styles vs. Macros
Styles and macros are similar in that they are a way to “short cut” entering frequently used series of codes and text. Styles, however, are easier to edit than macros.

Macros must be edited individually. If you used the same macro 45 times in a document, then find that a change is necessary, you must edit all 45 occurrences of the macro. If you used styles in the same situation, you just need to edit the style on the Styles menu once, and it changes all occurrences of the style.

To learn more about editing styles, see Style, Create.

Update
This option on the Styles menu retrieves the style library to the screen. If you select this option, existing styles with the same names as any styles in the style library will be overwritten.

In addition, this option will retrieve all outline styles in the style library to the Outline Styles screen.

See Also: Outline, Style; Style, Create
A style is useful for formatting a document. To create a style,

1. Press Style.  
   Or Select Styles from the Layout menu.
2. Select Create (3).
3. Select an option to begin creating a style (see the option headings below).
4. Press Exit to return to the Styles menu.
5. To insert the style in your document, select On (1). Or press Exit to return to your document.

Styles are saved with a document when the document is saved. You can also save the styles on the Styles menu as a separate file.

**Name**
Name lets you enter a name for the style. You can enter 12 characters or spaces for a style name. Characters entered with Compose may take more space than regular keyboard characters.

_The style names are not case sensitive. For example, style 1 and STYLE 1 are considered the same name._

**Type**
There are three types of styles you can create: Paired, Open, and Outline.

Paired (1) is a style that has a beginning and an end. In other words, it has a Style On code and a Style Off code. Anything between the On and Off codes conforms to the style.

Open (2) is a style that takes effect from a point in a document forward to the end of a document. It has no Off code. Anything after an Open Style code conforms to the style.

Outline (3) is a style that is used with Outline and Paragraph Numbering. Outlines and paragraph numbers can have up to eight levels of paragraph numbering, and when you specify this type of style, you can define a style for each level of numbering.

After you select Outline as the style type, you must give it a name and a level number. When you enter a name, that name becomes the name of the entire outline style. When you enter a level number, any codes you may have previously entered for the style become the codes for the paragraph numbering level you enter.

For example, if you enter Outline1 as the name and 4 as the level number, any codes you may have previously entered become the codes for the fourth-level paragraph number in the outline style called “Outline1.”

Once you enter a level number, you are placed in the Outline Styles: Edit screen where you can create styles for each paragraph numbering level.
Outline styles can be created and are displayed in two places. One is on the Styles menu, while the other is on the Outline Styles menu. More information on outline styles can be found in Outline, Style.

**Description**
The description appears on the Styles menu. You can enter 54 characters or spaces for a style description. Characters entered with Compose may take up more space than regular keyboard characters.

**Codes**
The Codes option is where you enter the codes and text you want to include in a style. To enter codes, insert them just as you would in the normal editing screen. Codes function differently depending on if they are located in a paired or open style.

Outline styles are also paired or open styles at the various numbering levels, so their codes function as described below.

If a code is in an open style, it is not turned off. The screen below shows codes in an open style. In this case, the margin setting would take effect from the point where the style is inserted in a document and would remain in effect until the end of a document (or until you insert another margin setting).

Open codes are useful for creating formats that you want to affect an entire document, such as margin settings, tab settings, and most other settings that you normally set with features on the Format key.
Codes in paired styles function differently. The Style Codes screen for a paired style has an On section and an Off section. These sections are divided by a comment.

Codes in the On section are turned on when you turn the style on. Codes in the Off section are turned on when you turn the style off. This is true with the following exceptions:

- Codes in the On section are reset when you turn off a style. If they have a corresponding code in the Off section, that code will not be turned on when the style is turned off. For example, in the screen above, when the style is turned off, the Left/Right Margin setting will be returned to whatever it was before you turned on the style. This is true even if you enter a margin setting in the Off section.

- The only codes the paragraph above does not apply to are the codes on the Format: Page menu. These codes include Center Page, Force Odd/Even Page, Headers/Footers, Top/Bottom Margins, Page Numbering, Paper Size/Type, and Suppress Page Format. They will remain in effect when the style is turned off if they are entered in either the On or Off sections.

- Codes in any text that is affected by the paired style override (take precedence over) codes in the On section. They are, however, reset if they have a corresponding code in the On section. For example, in the screen above, a Left/Right Margin setting in text affected by the style will override the Left/Right Margin setting in the On section. When the style is turned off the Margin setting will be returned to whatever it was before you turned on the style because there is a Left/Right margin setting in the Off section.

**Enter**

This option determines what the Enter key will do when you are in a paired style. If you are in an open style, this option has no effect, and that is why this option does not appear when you are defining an open style.

H R (1) tells Enter to function just as it normally does. Pressing Return will insert a hard return.

O ff (2) tells Enter to turn off a paired style. Pressing Return will move the cursor past the Style Off code.

O ff/O n (3) tells Enter to turn off a paired style, then turn it on again. Pressing Return will move the cursor past the Style Off code, then insert a Style On code. If you move past a Style Off code with an arrow key, Enter will function as it normally does (insert a hard return).

**Notes**

**Editing a Style**

When you want to edit a style, press Style, move the cursor to the style you want to edit, then select Edit (4). From that point, you can select an option, then change the information as necessary like you did when you created the style. The editing changes will affect all styles of the same name in the document. A few things you should be aware of are listed below.
Name • If you are editing an existing style and decide to change the style name, you will be asked if you want to rename the styles in the document. If you type y for Yes, the previous style name is changed to the new style name for styles in the document. If you type n for No, the style names in the document remain unchanged.

If you type n for No, the old style name will be recreated on the Styles menu when the style is next encountered. All codes in the style will be preserved.

For example, if you rename a style from “Heading” to “Heading One,” “Heading” will be recreated on the Styles menu the next time it encounters a “Heading” code in the document. The recreated “Heading” style will be exactly like the old “Heading” style.

This means that renaming styles, then typing n to not rename the styles in the document is a good way to make minor modifications to an existing style rather than creating a new one. It saves you the trouble of entering all of the codes for a new style if all you really want to do is pattern a style after an existing style. The old style will not be lost because it will be recreated when Corel WordPerfect encounters it in a document.

Type • If you are changing a style type from paired to open, all codes in the Off section of the paired style as well as Style Off codes for that style in the document are deleted. This is because open styles don’t have an Off section.

If you are changing a style type from open to paired, all codes are placed in the On section of the paired style. For styles existing in the document, the Style code does not change.

If you are changing a paired or open style type to outline, the name you enter determines which outline style the style will be added to (if it doesn’t exist, it is created for you). The level number you enter is the outline or paragraph numbering level within the outline style you are assigning the style to. For example, if you enter 4 for the level number, the style becomes the fourth level paragraph numbering style within the outline style.

You cannot change an outline style to a paired or open style.

Codes • Any codes you include in a style must be edited by editing the style. This includes tables and graphics boxes.

Existing Text
You can create a style from existing codes by using Block to block the codes, then pressing Style, and selecting Create (3). You should then enter a name for the style, or one will be provided for you. Any codes existing after text in the block will not be copied to the style.

The style type is initially set to Paired, but you can change that to Open. If you do, any codes located after the On section of the Style Codes screen are deleted because open styles can’t be turned off.

If you are copying codes from a screen other than the normal editing screen, you should block the codes, press Move, select Block (1), select Copy (2), then press
Exit until you return to the normal editing screen. Next, press Style, select Create (3), select Codes (4), then press Return to retrieve the codes to the Style Codes screen.

Generate
Some features that must be generated (for example, Cross-Reference, Subdocuments, and Endnote Placement) are not allowed in styles.

Graphics
To include a graphics image in a file, use the Graphics on Disk option (see Graphics, Define a Box).

See Also: Outline, Style; Style

---

**Suppress Page Format**

Suppress Page Format prevents page numbers, headers, and footers from being printed on a certain page without changing the page numbering sequence in your document.

For example, suppose you want to number the pages in your document consecutively from the title page forward, but you don’t want a page number to appear on the title page. You can use Suppress Page Format to keep the page number from being printed on the first page, and yet display the subsequent page numbers as page 2, 3, 4, and so on.

To suppress an item,

1. Move to the top of the page on which you want to suppress an item (see Location of Codes below).
2. Press Format, then select Page (2).  
   Or Select Page from the Layout menu.
3. Select Suppress (this page only) (8).
4. Select the items you want suppressed (see Codes and Selections below).
5. Press Exit to return to the normal editing screen.

**Notes**

**Codes and Selections**

Selecting a Suppress Page Format option inserts a Suppress code [Suppress:item], where item represents the item that is being changed, as listed in the following table.
<table>
<thead>
<tr>
<th>Selection</th>
<th>Code</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>PgNum, HA, HB, FA, FB</td>
<td>Suppress all page numbering, headers, and footers</td>
</tr>
<tr>
<td>2</td>
<td>HA, HB, FA, FB</td>
<td>Suppress all headers and footers</td>
</tr>
<tr>
<td>3</td>
<td>PgBC</td>
<td>Print page numbers bottom, center</td>
</tr>
<tr>
<td>4</td>
<td>PgNum</td>
<td>Suppress all page numbering</td>
</tr>
<tr>
<td>5</td>
<td>HA</td>
<td>Suppress Header A</td>
</tr>
<tr>
<td>6</td>
<td>HB</td>
<td>Suppress Header B</td>
</tr>
<tr>
<td>7</td>
<td>FA</td>
<td>Suppress Footer A</td>
</tr>
<tr>
<td>8</td>
<td>FB</td>
<td>Suppress Footer B</td>
</tr>
</tbody>
</table>

You can display these codes using Reveal Codes.

For selections 1 and 2, you need only select the number and then press Exit to return to your document and insert the Suppress code.

For selections 3 through 8, you need to select the number, type y or n to turn that option on or off, then press Exit to return to your document and insert the corresponding Suppress code. The current setting for selections 3 through 8 is always displayed in the Format: Suppress (this page only) menu.

You can select any combination of options 3 through 8.

**Graphs and Charts**

Suppress Page Format also lets you keep page numbers or headers and footers from conflicting with graphics (for example, charts, line draw boxes, graphic boxes with equations) which fill a page. If a graphic fills a page, you can suppress page numbers or headers or footers completely. If page numbers at the top of a page conflict with a graphic, you might not have to suppress the page number. Instead, you may be able to select Print Page Number at Bottom Center (3) to move the number to the last line of text on the page, below the graphic.

In order for the Suppress code to take effect on a page, it must be found at the top of the page, immediately after the Soft Page code [SPg] or Hard Page code [HPg] which starts that page (see Page, Soft and Hard). Otherwise, the Suppress code takes effect on the next page (see Page Format).

Consequently, when you want a page number, header, or footer to begin appearing on the second page of a document, it is a good practice to define that item immediately at the beginning of your document, then use Suppress to suppress it. This will make certain that the code takes effect on the correct page.

Although Suppress codes are automatically placed at the top of the current page, keep in mind that Soft Page codes move as you add and delete text from your document. Consequently, when you use Suppress on a page that is not the first page in your document, you need to always make certain that the Suppress code remains at the top of the page. You may sometimes have to move the Suppress code to accomplish this. When you do not need to have text flow onto a page as you edit your document, you can press Hard Page to insert a Hard Page code.
Switch

You can keep up to nine documents active in memory at the same time. Each document is displayed on its own separate screen, and pressing Switch moves you between the last nine active documents.

Using Switch is almost like having nine copies of Corel WordPerfect running at once, without having to tie up additional memory in your computer.

From the normal editing screen,

1. Press Switch to open another screen.
   Or Select Switch Document on the Edit menu.

A separate editing screen appears with its own status line. The number 2 in the “Doc” item on the status line indicates that you are in the Document 2 screen.

You can continue pressing Switch to move between the two screens. Switching from document to document does not change the position of the cursor in either document. For example, if the cursor is at the top of document 1 when you switch to document 2, it will still be at the top of document 1 when you return to document 1.

To open more than two screens,

1. Press Home and type a document number.

A new editing screen appears. You can do this for screens 1 through 9. You can also display a list of all the documents currently open by pressing Home and typing 0.
Switch works differently when Block is on or when you are using the Window feature (see *Case Conversion* and *Window* below).

**Notes**

### Case Conversion
When you have used Block to highlight text, pressing **Switch**, then selecting Uppercase (1) or Lowercase (2) converts the blocked text to either uppercase or lowercase letters.

### Closing Screens
If there is no document in the screen, Corel WordPerfect closes it automatically for you when you exit Corel WordPerfect.

However, if you make changes to a document in another screen and switch out of it without saving those changes, Corel WordPerfect will return you to it before letting you exit. You can then exit from the screen just as you would from the first screen.

### Editing Multiple Documents
When you have more than one document screen open, you can use List and Retrieve to retrieve documents into any screen just as you normally would (see *List Files* and *Retrieve*). You can also use Block and Move to cut, copy, and move information from one document to another (see *Block, Define* and *Move*).

### Window
To see two documents on-screen at the same time, use the Window option on the Screen feature. Pressing **Switch** then moves the cursor from window to window.

**See Also:** Capitalization; Window
Tabs are a precise measurement for indenting text in a document. They are especially useful in aligning vertical rows of text.

Since tabs are seen as an exact measurement by your printer, use tabs rather than spaces for aligning vertical columns. If you use spaces, the actual amount of space that you insert between the rows can vary slightly from printer to printer. Using proportional spacing or justifying each line of text against the left and right margins can make the size of spaces vary even more.

In the following illustration both documents were printed on the same printer, but the columns are straighter when tabs are used to align them.

A tab is displayed on the screen as a certain amount of space. You can change how much actual on-screen space is given to each tab setting (see Display Pitch Reference).

To move the cursor to the next tab setting,

1. Press Tab to insert a tab.

The cursor moves to the next tab setting (see Tab Settings below).

Notes

Four tab alignment settings are available: Left, Center, Right, and Decimal. The kind of Tab code inserted when you press Tab is determined by the alignment setting for that tab stop. You can change the tabs that already exist in a document by changing the tab alignment setting prior to those tabs. You can also insert Hard Tabs that will not change, regardless of the alignment setting (see Tab Alignment Settings under Tab Set).
Normally, pressing Tab inserts a Left Tab code [Tab] into your document. You can display this code in Reveal Codes. A Left Tab code [Tab] indicates that text will be left-aligned at that tab setting.

Although pressing Tab in the normal editing screen always inserts a Tab code, the cursor does not move forward if no more tab settings remain on that line. If you have more Tab codes than tab settings on a line, the extra Tab codes remain dormant. They can be seen in Reveal Codes, but they will not take effect unless you change the tab settings.

When you are using Typeover, you can press Tab to move from one existing Tab code to another without inserting a new Tab code.

If there is not enough space for one character in the current font to fit between the cursor and the next tab stop, pressing Tab moves the cursor past that tab stop to the next tab stop.

Math
While using the Math feature, pressing Tab inserts a Decimal Tab code [Dec Tab] in numeric or calculation columns and a Left Tab code [Tab] in text columns.

Outline
Pressing Tab while using Outline moves the paragraph number to the next numbering level and inserts a Hard Tab code [TAB] (see Outline, Create).

Tab Ruler
Ordinarily, the actual tab settings are not displayed in the normal editing screen. If you want an on-screen representation of the current tab settings in your document, use the Window feature to display the tab ruler at the bottom of your screen (see Window Size under Window). The tab ruler is also displayed on-screen in Reveal Codes.

Tab Settings
You do not need to set tabs unless you want to change the current tab settings. Standard tab settings have been pre-set at one-half inch intervals, up to 14". They are in place every time you create a document.

However, you can set tabs at any intervals you want, from zero up to 54 1/2". There are also four tab alignment settings available (see Tab Alignment Settings under Tab Set).

Tab vs. Indent
Pressing Tab lets you indent only one line of information at a time. Consequently, it can only be used to indent the first line of a paragraph. When you want to indent an entire paragraph without changing the current left and right margin settings, use Indent. Indent is useful for creating a temporary left margin at the next tab setting.

See Also: Flush Right; Math; Outline, Create; Split Screen; Tab Align; Tab Set; Window
Tab Align

Tab Align aligns text on a specific character. For example, Tab Align can be used to align memo headings on a colon (:).

1. Press Tab Align.

   Or Select Align from the Layout menu, then select Tab Align.

The cursor moves to the next tab setting and the current alignment character appears on the status line (see Alignment Character below).

2. Type the text and numbers you want aligned, including the alignment character.

The cursor remains at the tab setting and the characters you type are inserted to the left of it, until you type the alignment character. Text typed after the alignment character is then inserted normally.

You can end alignment without typing the alignment character by pressing Tab, Tab Align, or Return.

Notes

Alignment Character

Normally, the alignment character is a period or decimal point (.) because this is the character most often used in aligning dollar amounts and mathematical figures. However, you can select any character you choose.

To change the current alignment character, press Format, select Other (4), select Decimal/Align Character (3), then enter the alignment character. You can type any character on the keyboard including a space, or use Compose to enter other Corel WordPerfect characters. You may also enter a new character to be used to separate hundreds from thousands in the Math feature or you may press Return to skip over this entry. Press Exit to return to your document.

An Alignment Character code [Decml/Algn Char:#,##] is inserted into your document at the beginning of the current paragraph, where # is the alignment character and ## is the thousands’ separator. This code takes effect from that point forward in the document, until you change the alignment character again.

The alignment character is also used as the decimal character in math (see Math, Define Columns).

Codes

Using Tab Align inserts a Hard Decimal Align Tab code [DEC TAB] into your document. This is a permanent Tab code that will not change, even if you change the tab setting for that Tab code (see Types of Tab Settings under Tab Set).

Decimal Tabs vs. Tab Align

When a period (or decimal point) is the alignment character, you can press Tab Align in the normal editing screen to temporarily turn any tab setting into a decimal tab.
However, when you are typing several columns filled with numbers and you want the numbers aligned on a decimal point, you will probably want to change the tab setting for each column to a decimal tab setting. You can then align the text on a decimal point simply by pressing Tab (see Types of Tab Settings under Tab Set).

See Also: Tab Set

---

**Tab Set**

Standard tab settings have been pre-set at one-half inch intervals. These tab settings are in place every time you create a document.

While this is often convenient, you may not always want your tab stops to be set one-half inch apart. For example, if you only need 3 tabular columns on a page, you will want to change your tab settings so that you do not have to press Tab several times to move from column to column.

Also, you may want to use different tab alignment settings. For instance, you may want to center text at a tab stop, right-align text at a tab stop, or align numbers on a decimal point at a tab stop. You may also want Corel WordPerfect to insert dot leaders between the text found at each tab stop.

You can change the current tab alignment settings whenever you choose. You have four tab alignment settings to choose from (see Tab Alignment Settings below).

You can have your tab settings measured from the left edge of the page or from the left margin (see Type below).

To change the current tab settings,

1. Press Format, then select Line (1).
   
   Or select Line from the Layout menu.

2. Select Tab Set (8) to display the Tab Set menu at the bottom of the screen (see Tab Set Menu below). You can set up to 40 tabs.

3. Make the changes. You can delete existing settings (see Deleting Tab Settings below), change the current tab settings one at a time (see Single Tab Settings below), or set several evenly-spaced tabs at once (see Multiple Tab Settings below).

4. Press Exit twice to return to the normal editing screen.

**Tab Set Menu**

When you display the Tab Set menu using step 1 above, you see the tab settings that are in effect.

The top line of the menu is the tab set line, where the current tab settings (or tab stops) are displayed and changed.
Below the tab set line, the current line measurements are displayed. The standard unit of measurement is inches, unless you change it in Setup (see Units of Measure). Tab settings can be measured either from the left margin or from the left edge of the page (see Type below).

The next line lists the keystrokes that can be used to change tab settings, and the last line lists the possible types of tab settings.

When the Tab Set menu is first displayed, the cursor retains the same line position that it has in your document. For example, if you are measuring your tab settings in inches from the left edge of the paper (see Type below), and your cursor is at the 5” position in the normal editing screen, it will also be at the 5” position when you go to the Tab Set menu. You see only the part of the tab set line which matches the width of text currently being displayed on-screen.

Moving the cursor on the tab set line in the Tab Set menu does not change the cursor position in your document. For example, if your cursor is at the 5” position in the normal editing screen when you go to the Tab Set menu, it will still be at the 5” position when you return to your document, no matter how much you move the cursor on the tab set line.

You can move the cursor across the tab set line on the Tab Set menu by using the keystrokes listed in the following table.

<table>
<thead>
<tr>
<th>Location</th>
<th>Cursor Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Left one character</td>
<td>Left Arrow</td>
</tr>
<tr>
<td>Right one character</td>
<td>Right Arrow</td>
</tr>
<tr>
<td>Left one tab stop</td>
<td>Down Arrow</td>
</tr>
<tr>
<td>Right one tab stop</td>
<td>Up Arrow</td>
</tr>
<tr>
<td>To the left edge of the screen</td>
<td>Home,Left Arrow</td>
</tr>
<tr>
<td>To the right edge of the screen</td>
<td>Home,Right Arrow</td>
</tr>
<tr>
<td>To the left edge of the tab set line</td>
<td>Home,Home,Left Arrow</td>
</tr>
<tr>
<td>To the right edge of the tab set line</td>
<td>Home,Home,Right Arrow, or End</td>
</tr>
</tbody>
</table>

You can also press Item Left to move the cursor left one tab stop and Item Right to move the cursor right one tab stop.

You can also quickly move the cursor to any position on the tab set line and set a standard (left) tab at that position by typing the position number and then pressing Return. For example, if you are measuring your tab settings in inches from the left edge of the paper, entering 5 at the tab set line will move your cursor to the 5” position and set a left tab there. Since you can include up to four decimal points with the number you enter, this is the most accurate method of moving to an exact position. This method is particularly valuable when you are using proportional spacing. Once the cursor is at the position you want, you can change the left tab setting to any type you want (see Types of Tab Settings below).

While the cursor is on a tab setting, you can slide that tab stop to the left by pressing Word Left. To slide the tab setting to the right, press Word Right.
While the Tab Set menu is displayed, you can change one tab setting at a time (see Single Tab Settings below) or several tab settings at once (see Multiple Tab Settings below).

When you are ready to leave the Tab Set menu, pressing Exit twice will return you to your document and insert a code which puts those new tab settings into effect (see Codes below). If you do not want to record your new settings, you can press Cancel to return to your document and ignore any changes you have made.

**Notes**

**Codes**

Changing the tab settings inserts a Tab Set code [Tab Set: *type*#] into your document, where *type* indicates whether tabs are being placed at an absolute location on the line or relative to the current left margin (see Type below), and # represents the number(s) of the tab settings. If tabs are set at regular intervals, # is represented as “# every #”, where the first number indicates the starting point and the second number represents the distance between tabs (for example, 1", every 0.5").

A Tab Set code takes effect from that paragraph forward in the document. Any tabs following the Tab Set code will be spaced according to the measurements given in the code. The Tab Set code also determines the types of tabs that appear from that point forward (see Types of Tab Settings below).

**Deleting Tab Settings**

To delete a single tab setting in the Tab Set menu (see Tab Set menu above), move the cursor to that tab setting then press Delete or Backspace.

To delete all existing tab settings from the cursor forward, press Delete to End of Line. However, remember that the complete Tab Set menu may not be currently displayed on the screen. Consequently, when you want to clear all tabs, you should first press Home, Home, Left Arrow to move the cursor to the very left edge of the Tab Set line, then press Delete to End of Line.

**Dot Leaders**

A dot leader inserts a row of dots between the text and the next tab stop. To include a dot leader with any tab setting, move the cursor to the tab on the Tab Set menu, then type a period (.). When a tab setting has been set for a dot leader, the tab setting appears in reverse video or your current selection for the block attribute (see Colors/Fonts/Attributes).

**Initial Codes**

If you prefer different tab settings than the ones normally in place each time you create a document, you can use Initial Codes under Setup to enter your own tab settings. These tab settings will then be in place each time you create a document (see Initial Codes).
**Multiple Tab Settings**

To set tabs at regular intervals in the Tab Set menu, enter the position number for the first tab stop, followed by a comma (,), then by a number indicating the amount of space you want between tabs. Unless you indicate a specific unit of measure, the tab will be set in the current unit of measure (see Units of Measure).

For example, if you are measuring tabs from the left margin of the page in inches, you can set tab stops one inch apart beginning at the left margin by entering 0,1 in the Tab Set menu.

Unless a tab type is already set at the position of the first tab stop, left tab settings are inserted. Otherwise, the tab settings inserted match the type of tab setting found at the first tab stop (see Types of Tab Settings below).

**Single Tab Settings**

You can set a left tab anywhere on the Tab Set line by entering the number of that position. For example, to set a left tab at the 2” position, enter 2.

However, remember to enter a zero before any fraction of an inch (for example, 0.5 and not .5), since typing a decimal point (.) creates a dot leader tab at the current cursor position on the tab ruler (see Dot Leaders above).

To set any other type of tab setting, move the cursor to that location on the tab set line, then select the type of tab you want to set (see Types of Tab Settings below). As a shortcut, you may want to enter the number of a location to move the cursor to that location and set a standard (left) tab there, then select a type of tab to change it to that tab type.

**Tab Ruler**

The normal editing screen is a clear screen, with no tab ruler to show you where your tab settings are. They only appear on-screen when you display the Tab Set menu (see Tab Set Menu above).

If you want to display a tab ruler at the bottom of the normal editing screen, you can do so using Screen (see Window Size under Windows). You will then be able to see exactly where your tab settings are at all times.

The tab ruler is displayed on-screen whenever you are in Reveal Codes.

**Type**

Type lets you determine whether tab settings are measured from the left edge of the page, or from the left margin. Select Type from the Tab Set menu, then select Absolute (1) or Relative to Margin (2). Relative to Margin is the default setting.

When you select Absolute (1), tabs are measured from the left edge of the page, regardless of your current margin settings. The left edge of the page is displayed as zero (0), with positive numbers to the right of it (for example, 1", 2", 3").

When you select Relative to Margin (2), tabs are measured relative to the left margin. The left margin setting is displayed as zero (0), with negative numbers to the left of it (for example, –1") and positive numbers to the right (for example, +1", +2", +3").
The negative numbers let you use Margin Release to move to the left of the left margin.

When you use this selection, the distance between tab settings and the left margin always stays the same, regardless of how often you change your margins.

The Relative option is particularly useful when you are using Newspaper or Parallel Columns. In Newspaper or Parallel columns, when you select Relative to Margin (2), tabs are measured from the left margin of each column. For example, if you are formatting text into newspaper columns and you have three columns across the page, you can set one relative tab at the +0.5" position to have a tab one-half inch in from the left margin of each column (see Columns, Newspaper and Columns, Parallel).

Tab Alignment Settings

Four tab alignment settings are available. Each one aligns text differently. On the top line of the Tab Set menu (see Tab Set Menu above), each tab alignment setting is represented by the letter used to select it, as listed in the following table.

<table>
<thead>
<tr>
<th>Selection</th>
<th>Tab Alignment Setting</th>
<th>Codes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Left</td>
<td>Text is left-aligned at the tab stop (standard tab).</td>
<td>[Tab]</td>
</tr>
<tr>
<td>Center</td>
<td>Text is centered over the tab setting (like Center).</td>
<td>[Cntr Tab]</td>
</tr>
<tr>
<td>Right</td>
<td>Text is right-aligned at the tab stop (like Flush Right).</td>
<td>[Rgt Tab]</td>
</tr>
<tr>
<td>Decimal</td>
<td>Text is aligned at the align character (like Tab Align).</td>
<td>[Dec Tab]</td>
</tr>
</tbody>
</table>

You can change the tabs that already exist in a document by changing the tab alignment settings prior to those tabs. For example, if you change a left tab setting to a center tab, all the left tabs at that tab stop from that point forward in your document become center tabs.

If you want to insert tabs that will not change regardless of the tab alignment setting, use a Hard Tab. You can insert hard tabs by using the keystrokes given in the following table.

<table>
<thead>
<tr>
<th>Keystroke</th>
<th>Permanent Tab Alignment</th>
<th>Codes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Home,Tab</td>
<td>Hard Left</td>
<td>[TAB]</td>
</tr>
<tr>
<td>Home,Center</td>
<td>Hard Center</td>
<td>[CNTR TAB]</td>
</tr>
<tr>
<td>Home,Flush Right</td>
<td>Hard Right</td>
<td>[RGT TAB]</td>
</tr>
<tr>
<td>Tab Align</td>
<td>Hard Decimal Align</td>
<td>[DEC TAB]</td>
</tr>
</tbody>
</table>

Hard Tab codes do not change when you change the type of tab stop settings which precede them in a document.

See Also: Center Text; Flush Right; Initial Codes; Tab; Tab Align; Units of Measure; Window
Table, Create

Use Table to create and edit organized rows and columns of tabular data.

### Future Trends

<table>
<thead>
<tr>
<th>Stock</th>
<th>Purchase Date</th>
<th>Number</th>
<th>Shares</th>
<th>Cost/Share</th>
<th>Initial Invest</th>
<th>Current Mkt Value</th>
<th>Dividend per Share</th>
<th>Gain/Loss %</th>
<th>Gain/Loss ($)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Atwater</td>
<td>8/16/88</td>
<td>40</td>
<td></td>
<td>92.375</td>
<td>3,695.00</td>
<td>101.125</td>
<td>1.00</td>
<td>3.15</td>
<td>10.55</td>
</tr>
<tr>
<td>CanNa</td>
<td>3/24/89</td>
<td>300</td>
<td></td>
<td>57.125</td>
<td>17,137.50</td>
<td>59.50</td>
<td>.79</td>
<td>1.55</td>
<td>949.50</td>
</tr>
<tr>
<td>Dulaney</td>
<td>2/12/88</td>
<td>75</td>
<td></td>
<td>12.50</td>
<td>937.50</td>
<td>22.00</td>
<td>1.34</td>
<td>-1.05</td>
<td>86.72</td>
</tr>
<tr>
<td>EmmTM</td>
<td>5/5/89</td>
<td>100</td>
<td></td>
<td>34.00</td>
<td>3,400.00</td>
<td>37.625</td>
<td>.56</td>
<td>1.20</td>
<td>12.30</td>
</tr>
<tr>
<td>MP&amp;L</td>
<td>12/27/89</td>
<td>500</td>
<td></td>
<td>60.25</td>
<td>30,125.00</td>
<td>65.125</td>
<td>.13</td>
<td>.71</td>
<td>8.31</td>
</tr>
<tr>
<td>WestAm</td>
<td>10/19/88</td>
<td>95</td>
<td></td>
<td>45.625</td>
<td>4,334.38</td>
<td>28.75</td>
<td>0.00</td>
<td>-36.99</td>
<td>-1603.13</td>
</tr>
</tbody>
</table>

Total $59,629.38 $3470.38

Blue-chip buying led the Dow Jones Industrial Average to another record close, though trading was the slowest in more than seven weeks. The Dow Jones Industrial Average climbed 11.00 to 2743.36, topping the record of 2734.64 set last Thursday, the first time the average had closed above its 1987 pre-crash high. On Friday, the industrials fell 2.28. Just 131,180,000 shares were traded on the New York Stock Exchange, the lightest volume since July 5, when 127,7000,000 shares changed hands. The total would have been even lower if not for heavy dividend-related trading in some of the big oil firms. Traders said a number of investors pursued big blue-chip shares, particularly those in the Dow Jones averages. One of the most active stocks on the Big Board led the industrial average, rising to 118 on 1.7 million shares. Traders said stocks again shook off a weaker bond market. They said a number of investors are buying shares in the industrial average in the expectation that the average will outperform the broader market in a march to the 300 level. Some investors remain wary, however. Trades allowing institutions to capture special dividends of cash and preferred value swelled Big Board composite volume in the stock to 6.5 million shares.

This graph was created with DrawPerfect.

As the broad market rebounded, the Dow Jones Transportation Average recorded its third consecutive all-time high. The latest round of takeover-related buying among airline stocks and across-the border gains in the railroad group pushed the average up 24.90 to 1492.89. Winterhaven climbed 2 to 32.5 as rumors of a foreign buyer for the stock circulated in the market. There were reports this month that investor Robrett Wilcox owns about 4% of the company's shares. Market sources cited Stan-Collins as a big buyer of Winterhaven, according to Dow Jones Professional Investor Report; a source at the firm acknowledged its buying interest but declined to elaborate. Other winners among rumored takeover candidates included StopandShop, which jumped to 15.5, Covina Crayons, which soared to 33, Tetonbrands, which gained 2 to 75,5; and Verden Airlines, which advanced to 19.25 despite moving to strengthen its takeover defenses through an amendment to a shareholder rights plan.

Braden-Ashley financial plunged to 3.2. The company said it doesn't expect to complete debt-restructuring talks with its lenders by Friday. The American Stock Exchange Index rose 0.49 to 381.67. Volume was 10,550,000 shares, compared with 13,560,000 Friday.
4 Enter the number of columns you want in your table (maximum of 32).

5 Enter the number of rows you want in your table (maximum of 32,765).

The table is displayed on the screen. At this point, you need to be aware that there are two screen modes for a table. In the normal editing mode, you can enter text in the table and do other things which are described in this reference section. In the table editing mode, you can position the table and edit the table structure, but you cannot enter text in the table.

When you are in the table editing mode, the Table Edit menu is displayed on the screen as it is now.

6 Press Exit to return to the normal editing mode.

Anytime the Table Edit menu is displayed on the screen, you can press Exit to return to the normal editing mode. Unless otherwise noted, all information in this reference section pertains to table options in the normal editing mode.

If you want to learn about the table editing mode, read Table, Edit Structure and Table, Format Columns and Cells.

Table Text
To include text in a table, use one of the cursor keys to move to the cell where you want to type the text, then type the text. When you are finished typing text in a cell, press Tab to move to the next cell or Margin Release to move to the previous cell.

If you want to insert a Tab code into a cell (rather than move to the next cell), press Compose, then press Tab. If you want to insert a Margin Release code into a cell (rather than move to the previous cell), press Compose, then press Margin Release.

Enter is preset to insert a hard return and move the cursor to the next line in the cell. If you want your cells to be only one line high regardless of the amount of text in the cell, you can make the change with an option on the Table Edit menu (see Row Height under Table, Format Columns and Cells).

You can use most features in tables including footnotes, endnotes, font changes, and mark text features (that is, cross-reference, index, table of contents, table of authorities, and lists).
Adding a Row
To quickly add a blank row to the table, move the cursor to an existing row and press Ctrl-Insert. The blank row is added before the existing row, patterned after the existing row (keeping the same column and cell attributes as well as the same justification, column width, and line appearance settings specified in the Table Edit menu.)

If you want to know how to add a row or column from the Table Edit menu, see Adding Rows or Columns under Table, Edit Structure. See the same section if you want to add multiple rows or columns, or want to know how adding a row works with a row that contains a cell that spans more than one row.

Attributes
You can use attributes such as Bold, Italics, and Underline on text in a table by selecting them as you normally would.

For information on other ways to assign attributes to table cells and columns, see Table, Format Columns and Cells.

Base Font
You can enter a Base Font code anywhere in a table, and the text following the code will be printed in that base font (see Font). Changing the base font to a smaller font is a good way to fit more text on a line in a cell.

Columns
You cannot include tables in newspaper or parallel columns, nor can you include newspaper or parallel columns in tables. You can, however, include tables in graphics boxes, which in turn can be included in columns. So, if you want to include tables in columns or create two tables side-by-side, put them in graphics boxes (see Graphics Boxes below).

Cross-Reference
A number is assigned to each table (for example, I, II, III), and these numbers fall in the same numbering sequence as table graphics boxes. Therefore, if you have a table graphics box (whether or not it contains a table) at the beginning of a document, a table in the middle, and another table graphics box at the end, the first table graphics box is numbered one, the table is numbered two, and the last table graphics box is numbered three.

If you are using Cross-Reference to reference a table, you must reference the table as a table graphics box.

Cursor Movement
The following is a list of table locations and the cursor keys that can move you to those locations (when the Table Edit menu is not displayed). To learn more about the cursor functions that are allowable when the Table Edit menu is displayed, see Cursor Movement under Table, Edit Structure.

Notice that in some cases you can get to the same location with different combinations of cursor keys. This lets you choose the keys you feel most comfortable with. Remember that a dash means for you to hold the first key down and press the next key, while a comma means to press the first key, release it, then press the second key.
If there is no text in the cell where the cursor is located, the arrow keys move the cursor one cell in the direction of the arrow.

<table>
<thead>
<tr>
<th>Location</th>
<th>Cursor Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>One Cell Down</td>
<td>Item Down</td>
</tr>
<tr>
<td>One Cell Left</td>
<td>Shift-Tab</td>
</tr>
<tr>
<td></td>
<td>Go To, Left Arrow</td>
</tr>
<tr>
<td></td>
<td>Item Left</td>
</tr>
<tr>
<td>One Cell Right</td>
<td>Tab</td>
</tr>
<tr>
<td></td>
<td>Go To, Right Arrow</td>
</tr>
<tr>
<td></td>
<td>Item Right</td>
</tr>
<tr>
<td>One Cell Up</td>
<td>Item Up</td>
</tr>
<tr>
<td>Beginning of Text in Cell</td>
<td>Go To, Up Arrow</td>
</tr>
<tr>
<td>Last Line of Text in Cell</td>
<td>Go To, Down Arrow</td>
</tr>
<tr>
<td>First Cell in a Column</td>
<td>Go To, Home, Up Arrow</td>
</tr>
<tr>
<td>Last Cell in a Column</td>
<td>Go To, Home, Down Arrow</td>
</tr>
<tr>
<td>First Cell in a Row</td>
<td>Go To, Home, Left Arrow</td>
</tr>
<tr>
<td></td>
<td>Home, Home, Home, Left Arrow</td>
</tr>
<tr>
<td>Last Cell in a Row</td>
<td>Go To, Home, Right Arrow</td>
</tr>
<tr>
<td></td>
<td>Home, Home, Home, Right Arrow</td>
</tr>
<tr>
<td>First Cell in the Table</td>
<td>Go To, Home, Home, Up Arrow</td>
</tr>
<tr>
<td>Last Cell in the Table</td>
<td>Go To, Home, Home, Down Arrow</td>
</tr>
</tbody>
</table>

Deleting a Row
You can delete a single table row and the text inside the row by moving the cursor to the row, pressing Ctrl-Delete, then typing y to confirm.

To undelete a deleted row, you must have the Table Edit menu displayed on the screen, then press Cancel, and type y.

For information about deleting a row or column from the Table Edit menu, or deleting multiple rows or columns under Table, Edit Structure, see Deleting Rows or Columns under Table, Edit Structure.

For information about how deleting a row works with a row that contains a cell that spans more than one row, see Adding Rows or Columns under Table, Edit Structure.

Deleting a Table
To delete the table structure but not the text inside the table, delete the Table Definition code [Tbl Def]. To delete the entire table (structure and text), block the table (including the Table Definition and Table Off codes [Tbl Off]) with Block, press Delete or Backspace, then type y.

If you delete the Table Definition code without using Block, you cannot use Cancel to restore the code.

If you delete the structure but not the text, the columns will be separated by tabs, and the rows will be separated by hard returns.
Deleting Text
To delete text in a table cell, use the delete keys (or Block and delete) as you would with normal text. Delete to End of Line does not cross cell boundaries.

Edit Option
The Edit option instructs Corel WordPerfect to search backward from the cursor position and move the cursor to the first table it can find. If Corel WordPerfect cannot find a table searching backward, it searches forward. Once the cursor is placed in a table, you can select an option from the Table Edit menu, or you can press Exit and edit the table text.

More information on the Table Edit menu can be found in Table, Edit Structure.

Existing Text
If you want to turn existing tabular columns or parallel columns into a table, you must block the text with Block, press Columns/Table, select Tables (2), then select Create (1). Next, select Tabular Column (1) or Parallel Column (2) depending on the text you are converting.

If you are converting tabular columns, the current tab settings will be used to define the table columns, while the hard returns in the text will define the table rows. If you are converting parallel columns, the parallel column definitions will be used to define the table columns, while Hard Page codes will define the table rows.

Formatting Codes
You can enter formatting codes such as Center, Tab Align, Flush Right, and Justification in a table by selecting them as you normally would. For information on other ways to assign formatting codes to table cells and columns, see Table, Format Columns and Cells.

Forms Fill-In
Use Tables to create a form or to fill out pre-printed forms by creating the structure of the form with a table(s) and using merge codes to prompt you for proper input (as illustrated below). For more information on merge codes, see Merge.
Graphics Boxes
You can include tables in graphics boxes by creating the table in the graphics box Text Editor. This is the way to include tables in columns, and it is also the way to wrap text around a table on a page or create side-by-side tables.

If the table is larger than the graphics box, the rows and columns that do not fit within the box but still fit on the page will display in View Document and will still print. Some things you can do to keep a table within a graphics box are edit the size of the table, edit the size of the graphics box, or make sure that the table Position option is set to Full.

For more information on editing the size of the table, see Column, Width under Table, Format Columns and Cells. For more information on editing the size of the graphics box, see Graphics, Edit. For more information on the table Position option, see Options under Table, Edit Structure.

You can also create graphics boxes in tables if the table itself is not in a graphics box. As long as your cells are not set for a fixed height (see Format under Table, Edit Structure), the cells will expand lengthwise with a graphics box that has a Character or Paragraph anchor type. You cannot enter a box width larger than the cell width.

If a graphics box with a Page anchor type is positioned on a table, the text in the table will wrap around the box (if you specify that it should when you define the box), but the table lines will print on the graphics box. You can remedy this by turning off the table lines (see Lines under Table, Edit Structure).

Math
The Math feature helps you perform mathematical calculations independently of tables. The Table Math feature performs the same calculations as Math but in some instances may be easier to use.

By default, Table Math is on in tables. For more information on using Table Math, see Table, Math. For more information about Math, see Math.

Move
In the normal editing screen, pressing Move in a table displays the same options as it does in normal text. If the cursor is in a table and you select Sentence or Paragraph, however, no more than one entire cell of text is highlighted.

If the Table Edit menu is displayed, Move is specially tailored to moving text in tables, with options for moving rows and columns (see Table, Edit Structure).

If you use Block to move or copy the entire table (structure and text), you must include both the Table Definition and Table Off codes in the block. If you use Block to move the table text (without the table structure), you must not include either of the codes. In no situation should you include one code without the other.

When you move or copy table text (without the table structure), the text is separated into columns by tabs and into rows by hard returns.
Page Breaks
A table can span a page break. In other words, a table is broken at the page break and continued on the next page. If you want to protect a table that is less than one page in length from being split by a page break, use Block Protect.

Corel WordPerfect breaks pages at a row boundary. Text within rows cannot be split by a page break.

If you want the same information repeated on the top row(s) of the table at the top of each page, use Header on the Table Edit menu (see Header under Table, Edit Structure).

Parallel Columns
You can create parallel columns with the Parallel Columns feature and with Tables. You can create parallel columns with both features and decide which is easiest for you. The following set of columns was created using the Table feature with the lines turned off around the cells.

<table>
<thead>
<tr>
<th>Item</th>
<th>Quantity</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ceramic Figurines</td>
<td>345,000</td>
<td>Should last until December. Sold 200,000 in last quarter of last year.</td>
</tr>
<tr>
<td>Clocks</td>
<td>234,000</td>
<td>Should reorder. Sold quickly last year in third and fourth quarters.</td>
</tr>
<tr>
<td>Crystal Watches</td>
<td>432,980</td>
<td>Should last until June. Sold 150,000 in last 3 months. Down 100,000 from last year.</td>
</tr>
<tr>
<td>Glass Figurines</td>
<td>123,000</td>
<td>Should last until June. Numbers don't show big inventory, but these are real slow movers. Suggest discontinuing line.</td>
</tr>
<tr>
<td>Jewelry Boxes</td>
<td>234,000</td>
<td>Should last for another year. Haven't been moving well. Perhaps a sale is in order?</td>
</tr>
<tr>
<td>Music Boxes</td>
<td>400,000</td>
<td>Need to reorder. Number one seller—sold half a million in last quarter of last year.</td>
</tr>
</tbody>
</table>

Printing
The lines that are printed around a table are graphics lines. If your printer cannot print graphics, it may not be able to print table lines.

Occasionally, as in the case with imported spreadsheets or tables retrieved to a graphics box, a table can be wider than the actual page width. If it is, only the information that fits on the page will be printed.

Sort
If the cursor is in a table and you select Sort, you should notice that Sort is tailored to tables. The main difference between a table sort and other types of sorts is that you specify which cell you want to sort when you define the sorting keys. In a sort, the cells are numbered from left to right on a row, with the leftmost cell on a row numbered one.
If you sort a table, we recommend that you do not have cells in the table that span multiple rows. For an example of such cells, see *Adding Rows or Columns* under *Table, Edit Structure*.

**Spreadsheets**
You can import data from WordPerfect Corporation’s PlanPerfect, Lotus 1-2-3®, Microsoft® Excel™, Quattro, or Corel Quattro® Pro spreadsheet into a table. For more information on doing so, see *Spreadsheet, Import and Link*.

**Status Line**
When the cursor is located in a table, the “Cell” heading is added to the status line. This heading tells you the cell location of the cursor.

**Styles**
You can include styles in tables and tables in styles. To edit a table in a style, first edit the style.

**Table Codes**
Tables are marked with a Table Definition and a Table Off code. Row and Cell codes are located between the Table Definition and Table Off codes.

You cannot delete the Row, Cell, and Table Off codes, but you can delete the Table Definition code. Then Cell codes will be converted to tabs, Row codes will be converted to hard returns, and the Table Off code will be deleted (see *Deleting a Table* above).

**See Also:** Columns, Parallel; Table, Edit Structure; Table, Format Columns and Cells; Table, Math

---

**Table, Edit Structure**

*Table, Create* discusses how to create the table grid on the screen. It also outlines the two modes (normal editing and table editing) that are available with a table on the screen. This section discusses table editing mode. In this mode, you can position a table and edit its structure. Unless otherwise noted, the information in this reference section pertains to table options in the table editing mode.

When you create a table, the table is created according to default settings. For example, the lines bordering the outside of the table are double lines, the cell height varies according to the size and amount of text in the cell, text is left aligned in a cell, and so on.
While these settings are useful in many situations, they may not be exactly what you want for your table. Using the options on the Table Edit menu, you can change the table structure.

You can edit the existing table structure by selecting a Table Edit option (see the option headings under Notes below). If you do not know how to create a table or simply want to learn how to enter text in a table, see Table, Create.

If the Table Edit menu is not displayed, you can display it by following the steps below.

1. Move the cursor to a location inside the table.
2. Press Columns/Table.
   
   Or Select Tables from the Layout menu, then select Edit.

3. Select a menu option from the Table Edit menu and follow the procedure for making the change you want to make (see the option headings under Notes below).

If your cursor is not located in a table, you can edit a table structure by pressing Columns/Table, selecting Tables (2), then selecting Edit (2). Corel WordPerfect searches backward from the cursor position for the first table it can find, then searched forward.

Notes

Adding Rows or Columns
With the Table Edit menu displayed on the screen, press Insert, select Rows (1) or Columns (2), then enter a number to insert copies of the row or column where the cursor is located. The new row or column will be added immediately before the row or column where the cursor is located and will contain the same column and cell attributes as well as the same justification and column width settings as the row where the cursor is located. Text is not copied.

If you use Block before pressing Insert, you do not need to enter the number of rows or columns you want to add. Corel WordPerfect assumes that the number of rows or columns that are blocked is the number of rows or columns you want to add.

If you are adding a column and the table does not occupy the entire space between the left and right margins, Corel WordPerfect will try to give the new
column the same width as the current column, or at the very least, insert the column with a minimum width. If the table already occupies the entire space between the margins, Corel WordPerfect will split the current column into two columns.

*For more information about how the table is positioned between margins see Options below.*

You may wonder what happens when you add a row patterned after a row that spans multiple rows in other columns, such as row two below. Notice that the first cell in row two spans three rows.

In this case, Corel WordPerfect functions differently depending on the cursor location at the time you add the new row.

If the cursor is located in the cell that spans multiple rows, this is what happens:

Notice that the entire row, including the large cell and its sub-rows, were duplicated in the table.
If the cursor is not located in the cell that spans multiple rows, this is what happens:

![Diagram showing added row]

Notice that only a sub-row was duplicated, and the large cell was simply expanded.

Corel WordPerfect follows the same principle when deleting the same type of rows and when adding or deleting columns that have a cell that spans several columns.

For information on adding rows or columns to the end of a table, see Size below.

**Cursor Movement**

When the Table Edit menu is displayed, the cursor occupies an entire table cell.

The following is a list of table locations and the cursor keys that can move you to those locations when the Table Edit menu is displayed. To learn more about the cursor functions that are allowable when the Table Edit menu is not displayed, see Cursor Movement under Table, Create.

Notice that in some cases you can move to the same location with different sets of cursor keys. This lets you choose the keys you feel most comfortable with. Remember that a dash means for you to hold the first key down and press the next key, while a comma means to press the first key, release it, then press the second key.

<table>
<thead>
<tr>
<th>Location</th>
<th>Cursor Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>One Cell Down</td>
<td>Down Arrow, Go To, Down Arrow, Item Down</td>
</tr>
<tr>
<td>One Cell Left</td>
<td>Left Arrow, Shift-Tab, Go To, Left Arrow, Item Left</td>
</tr>
</tbody>
</table>
**Location**  
One Cell Right  
Right Arrow  
Tab  
Go To, Right Arrow  
Item Right  

One Cell Up  
Up Arrow  
Go To, Up Arrow  
Item Up  

First Cell in a Column  
Home, Up Arrow  
Go To, Home, Up Arrow  

Last Cell in a Column  
Home, Down Arrow  
Go To, Home, Down Arrow  

First Cell in a Row  
Home, Left Arrow  
Home, Home, Left Arrow  
Go To, Home, Left Arrow  

Last Cell in a Row  
Home, Right Arrow  
Home, Home, Right Arrow  
End  
Go To, Home, Right Arrow  

First Cell in the Table  
Home, Home, Up Arrow  
Go To, Home, Home, Up Arrow  

Last Cell in the Table  
Home, Home, Down Arrow  
Go To, Home, Home, Down Arrow  

Specific Cell  
Go To, Cell Location (for example, A1)

**Deleting Cell Contents**

If the Table Edit menu is displayed and you want to delete the text in a block of cells without deleting the table structure, you may do so by blocking the text of the cells you want to delete, pressing Backspace, then typing `y`.

Pressing **Delete to End of Line** with the Table Edit menu displayed deletes all of the text on a row from the cursor forward.

**Deleting Rows or Columns**

Press **Delete**, select **Rows (1)** or **Columns (2)**, then enter a number to delete that many rows or columns from the table. Both text and table structure from the row on which the cursor is located forward will be deleted.

*If you use Block before pressing **Delete**, you do not need to enter the number of rows or columns you want to delete. Corel WordPerfect assumes that you want to delete the rows or columns you have blocked.*

To find what happens when you delete a row or column that contains a cell that spans multiple rows or columns, see **Adding Rows or Columns** above.
Format
Format lets you format a single cell in a table or an entire column of cells. It also lets you change the height of a row of cells. Since this option has several sub-options, it is discussed in detail in Table, Format Columns and Cells.

Header
Header rows are rows that are repeated at the top of every page for tables that span page breaks. Select Header (4), then enter a number if you want header rows. The number you enter is the number of header rows (starting from the top of the table) you want. For example, if you enter 2, the first two rows of the table will be the header rows.

The example below has two header rows.

Selecting Header and entering zero (0) means that you do not want any header rows.

When the cursor is located in a header row, an asterisk (*) appears next to the cell name on the status line. Header rows are not displayed on pages other than the first one on which they appear in the normal editing screen but may be seen in the View Document screen.

Join
To create one cell out of multiple cells, use Block in the Table Edit menu to block the cells you want to join, select Join (7), then type y to confirm.

Text that was previously separated by columns will be separated by tabs in one cell and will continue to be positioned in approximately the same way. Likewise, text that was previously separated by rows will be separated by hard returns. Should you then split the cell, the text can be repositioned in its original cell.

For information on splitting a cell, see Split below.
**Lines**

Lines lets you decide the type of lines used in your table. While in the Table Edit menu, use Block to block the group of cells for which you want to change line settings, then select Lines (3).

*If you do not use Block, only the cell in which the cursor is positioned is affected.*

The first submenu that is displayed asks you which lines you want to change. For example, Left changes the left border of the group of cells you have blocked. Inside refers to the lines inside the highlighted cells, and Outside refers to the outside borders of the highlighted cells. All will change both Inside and Outside borders.

Each cell in a table has four borders and a setting for any one of the four borders is independent of borders on adjoining cells. In addition, there is no space between borders of adjoining cells. Thus, a change to a border setting, when combined with the existing border of an adjacent cell, may produce a thicker line than expected. To see what your borders will look like, use View Document.

Initially, the top and left borders for each cell are set as a single or double line, while the bottom and right borders are set for no line. This is true for all cells except the cells in the right-most column or the bottom row of the table where the right or bottom borders must be set to create the table borders.

The Shade option asks you whether you want to turn shading on or off for the blocked cells. You can set the percentage of shading with Options (see Options below). If shading is on, the “Cell” heading on the status line is shown in reverse-video when the cursor is in a shaded cell.

When you select a location option (for example, Left, Right, All) from the first submenu, you are placed in a submenu that lets you select the line style you want to use. In the example below, all of the cells are blocked and the All option has been selected from the first submenu. The next selection will determine the style for all of the lines in the table.

---

You can determine the appearance for each style with the Border Options menu.
To create a 3-dimensional effect for a cell, a group of cells, or an entire table, specify Thick (6) or Extra Thick (7) for two adjacent borders and Single (2) for the other two adjacent borders.

Arrows represent half-cell lines on the display screen. When you print a table, a line that is the same length as half of a space will be printed instead of the arrow.

Math
Selecting Math (5) displays a menu of Table Math options. Corel WordPerfect has a Math feature that is independent of tables, but you may find Table Math more suitable for your mathematical applications. Because this option contains several sub-options, it is discussed in detail under Table, Math.

Move
After you press Move in the Table Edit menu, you can choose the current block of text or the row or column of cells where the cursor is located. You can then move, copy, or delete the block, row, or column just as you can normal text. If you choose a row or column, the table structure codes are moved as well as the text inside the cells.

To retrieve the block, row, or column, move the cursor to a table location and press Return. When you do so, the block, row, or column will be retrieved at the cursor position. If you are retrieving a row or column, Corel WordPerfect inserts it in front of the row or column where the cursor is located.

You must retrieve the same type of item that you moved or copied. In other words, you cannot move a row and retrieve it as a column. You can, however, retrieve a row or column as a block of cells by pressing Cancel to clear the “Move Cursor ...” message, pressing Move, selecting Retrieve (4), then selecting Block (1).

If you are retrieving a block, Corel WordPerfect inserts the text into existing cells and deletes any text that may have previously existed in those cells. It inserts the text in the same layout as the original block.

For example, if you block the following cells, move them as a block, and retrieve them as a block in cell B1,
your new table will look like this.

<table>
<thead>
<tr>
<th>Month</th>
<th>Shift Name</th>
<th>Shift Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>January</td>
<td>Judy</td>
<td>Bill</td>
</tr>
<tr>
<td>February</td>
<td>Jolin</td>
<td>Sarah</td>
</tr>
<tr>
<td>March</td>
<td>Trish</td>
<td>Michael</td>
</tr>
<tr>
<td>April</td>
<td>Carla</td>
<td></td>
</tr>
</tbody>
</table>

If you retrieve table text into a table that has a different number of columns, only the number of columns that will fit into the new table will be retrieved.

A separate buffer (or storage area) saves text that is moved or copied with Move in the Table Edit menu. This lets you retrieve text into other tables in the same or different documents. To do so, move to the table, then with the Table Edit menu displayed, press Move, select Retrieve (4), and select the item you want to retrieve.

When you exit Corel WordPerfect, the buffer is emptied.

If you are not in the Table Edit menu, Move works differently. For more information, see Move under Table, Create.

Multiple Tables
You can create a second table immediately following the first and use the Lines option on the Table Edit menu to make the two tables appear as one (see Lines above).

Options
Select Options (6) to change certain settings for all cells in the current table.

- **Display Negative Results** • Select Display Negative Results (2), then select With minus signs (1) to display negative numbers with minus signs, such as -23, or select With parentheses (2) to display negative numbers inside of parentheses, such as (23). This affects how results are displayed in math calculations. You can enter negative numbers yourself with either a minus sign or parentheses.

  For information on math and tables see Table, Math.

  If a result is already displayed with a minus sign and you decide to re-display it with parentheses, you must delete the minus sign before recalculating the number. Otherwise, the number may appear with both a minus sign and parentheses, such as -(98).

- **Gray Shading** • Select Gray Shading (4), then enter a percentage to determine how much a cell will be shaded (100% is black). To turn shading on or off, use the Lines option (see Lines above).
**Position of Table** Select Position of Table (3), then select the alignment option of your choice for the table. Left aligns the table with the left margin, Right aligns the table with the right margin, and Center centers the table between margins. Full adjusts the table width to fill the current margins.

*Left is the default (initial setting) unless the table is being created in a graphics box. If so, Full is used to keep the width of the table within the graphics box.*

If you select Full and the table moves to an area with different margins (for example, a graphics box), or you change the margins where the table is located, Corel WordPerfect adjusts the table width so the columns will fit between the margins.

Set Position prompts you to enter a specific position location for the table. For example, if you enter 2", the table is aligned 2" from the left edge of the paper.

You should realize that when a table is originally created and Left is selected for the table position, Corel WordPerfect checks the current margins, formats the table to occupy the entire space between the left margin and right margin and aligns the table with the left margin. Only when the table occupies less space than the entire distance between margins do the Right and Center options come into effect.

One way to create a table that occupies less space than the entire distance between margins is to set the Position option to Left or Right, then decrease the size of one or more columns in the table. When you decrease the size of a column and the Position option is set to Left or Right, the size of the entire table decreases (see Column, Width under Table, Format Columns and Cells).

**Spacing Between Text and Lines** Spacing Between Text and Lines determines how much space you have between text and cell borders. To change spacing, select Spacing Between Text and Lines (1), press Return until you move to the spacing value you want to change, then enter a measurement. This lets you tighten or loosen the table appearance.

**Restoring a Row or Column**

Pressing Cancel, then typing y for Yes while the Table Edit menu is displayed lets you restore the last row, column, or block of cells (text and structure for rows and columns, text only for blocks) that you moved, copied, or deleted. Only the last row, column, or block that you moved, copied, or deleted is stored in the buffer.

The Table Delete buffer is a separate buffer than the one for non-table text, so you can use Cancel (with the Table Edit menu displayed) to move table contents from one table to another in the same or different documents.

*You cannot restore rows or columns that were deleted with the Size option (see Size below).*
Size
Size is used to add rows and columns to or delete them from the end of a table.

Columns • Select Columns (2), then enter a number to add columns to or delete them from the right side of the table. The number that is displayed after you select this option is the number of columns that currently exist in the table.

For example, if your table has four columns and you want to add two columns to the right end of the table, enter 6. When you add columns with this option, Corel WordPerfect uses the structure of the right-most column in the table as the pattern for the columns you are adding. Text is not copied to the new column.

Rows • Select Rows (1), then enter a number to add rows to or delete rows from the end of the table. The number that is displayed after you select this option is the number of rows that currently exists in the table.

For example, if your table has four rows and you want to add two rows to the end of the table, enter 6. When you add rows with this option, Corel WordPerfect uses the structure of the last row in the table as the pattern for the rows you are adding. Text is not copied to the new rows.

Additional information on adding and deleting columns and rows may be found under Adding Rows or Columns and Deleting Rows or Columns above.

Split
To split a single cell into multiple rows or columns, move the cursor to the cell, then select Split (8). After selecting Split, select Rows (1) or Columns (2) to split the cell into rows or columns, then enter the number of rows or columns you want to create from the single cell.

For example, if you want to split a cell into 3 rows, select Split (8), select Rows (1), then enter 3.

When you split a cell into rows or columns, the existing rows or columns are used as a pattern for the new columns.
In the example below, the highlighted cell in the first screen is split into three columns in the second screen.

You can also split several cells at once by blocking the cells with Block in the Table Edit menu. The number you enter is the number of rows or columns that will be created in each blocked cell.

See Also: Columns, Parallel; Table, Create; Table, Format Columns and Cells; Table, Math

**Table, Format Columns and Cells**

This section describes the Format option on the Table Edit menu. For information about creating or editing text in a table, see Table, Create. For other Table Edit options, see Table, Edit Structure. Unless otherwise noted, the information in this section pertains to table options in the table edit mode (when the Table Edit menu is displayed).

Use the Format option on the Table Edit menu to assign a particular format (attributes, size, justification, and so on) to cells or columns in a table.

For example, in the screen below, the numbers in the left-most column of the table are bolded and right-justified, while the numbers in the right-most column...
of the table are decimal-aligned. All of these settings were made with the Format option on the Table Edit menu.

You can use Block to format several cells or columns. Simply block the cells or columns you want to format, then follow the steps below. If you are blocking columns, you only need to block one cell in the column to represent the entire column.

1. Make sure that the cursor is in a table and the Table Edit menu is displayed.

   To display the Table Edit menu, move the cursor to the table, then press Columns/Table.

2. Use Block to block the cells or columns you want to format.

3. Select Format (2).

4. Select Cell (1).

   or

   Select Column (2).

A third option, Row Height, also appears at this point. For information on Row Height, see Row Height under Notes below.

5. Select an option and enter the information. For information on each of the Cell and Column options, see the appropriate heading below.

**Cell, Attributes**

Select Attributes (2) from the Cell Format menu, then select the attribute of your choice for text in the cell. Normal turns off all attributes for text in the cell, while Reset resets the cell attributes to the column attributes setting (see Column, Attributes below). Settings made with Attributes in the normal editing screen are added to any settings made with this option (see Attributes).

You can also bold or underline a cell by moving to the cell (with the Table Edit menu displayed) and pressing Bold or Underline.

**Cell, Justify**

Select Justify (3) from the Cell Format menu, then select the justification setting of your choice (Left, Right, Center, Full, Decimal-Align) for text in the cell. Reset resets the cell justification to the column justification setting (see Column,
Settings made with Justification in the normal editing screen override any settings made with this option.

**Cell, Lock**
Select Lock (5), then select On (1) from the Cell Format menu when you want to “lock” a cell. Locking a cell prevents you (or anybody else) from changing the information in the cell. Lock is especially useful when you are using the Table feature to fill out forms, because you can display a form heading without worrying about someone altering information in that cell.

You can move the cursor into a locked cell when the Table Edit menu is displayed (see *Table, Edit Structure*). When the cursor is located in a locked cell, the Cell heading on the status line is shown in brackets.

Even if the formula is located in a locked cell, Math formulas will always be calculated when you select Calculate (see *Table, Math*). Spreadsheet data can also be imported into locked cells (see *Spreadsheets, Import and Link*).

You cannot use Move to move text to a locked cell.

Select Lock (5), then select Off (2) when you want to unlock a cell.

**Cell, Type**
Selecting Type (1) from the Cell Format menu displays two options: Numeric and Text. Normally, all cells are numeric, which means that as long as they contain a valid number they can be calculated with the Math options (see *Math* below).

To mark a cell as non-numeric, select Text (2). In text cells, a pair of quotation marks (“”) are placed next to the Cell heading on the status line (for example, “A1”).

If you mark a cell that contains a formula as a text cell, it will not be calculated. Text cells cannot be referenced by formulas in other cells. For more information on math in tables, see *Table, Math*.

**Cell, Vertical Alignment**
Selecting Vertical Alignment (4) from the Cell Format menu displays three options: Top, Bottom, and Center. You will not notice the change on the screen, but the text will display in View Document and will print properly.

**Column, Attributes**
Select Attributes (2) from the Column Format menu, then select an attribute for text in the column. Normal turns off all column attributes.

**Column, # Digits**
Select # Digits (4) from the Column Format menu, then enter a number (up to 15) to specify the allowable number of digits to the right of a decimal point. For example, enter 4 to specify four digits to the right of a decimal point (such as 35.4654). Math results will be calculated and displayed according to this setting. This option also helps position the decimal point if you select decimal-aligned justification for the column or cell.
This option affects only math calculations and does not limit the numbers to the right of the decimal point that you can enter manually.

**Column, Justify**

Select Justify (3) from the Column Format menu, then select an option (Left, Center, Right, Full, or Decimal Align) to change the justification for text in a column.

More information about Justification can be found in *Justification*. Decimal Align justification means that characters will be aligned on the alignment character. For more information, see Column, # Digits above and Alignment Character under Tab Align.

**Column, Width**

When you create a table, Corel WordPerfect uses the margins and the number of columns you specify, then sets default column widths. Selecting Width (1), then entering a measurement allows you to change the width of a column to that measurement.

When a column width is increased, the table becomes larger until the right margin is reached. When the right margin is reached, the largest column to the right of the expanded column is decreased to make room for the expanded column. When a column width is decreased, the table width decreases.

In the first screen below, notice that the cursor is located in cell C1.
When you expand the width of cell C1, the width of cell D1 (the widest cell to the right of C1) decreases.

When the Table Edit menu is displayed, you can also increase and decrease column widths in one-character increments by moving the cursor to a column and pressing Word Right to increase width and Word Left to decrease width.

Notes

Codes
Changes made with Cell and Column options do not insert codes into your document. They simply modify the existing [Cell] and [Tbl Def] codes.

Precedence
When assigning formats to a table, Corel WordPerfect has a system of precedence.

First of all, settings made with individual features in the normal editing screen (for example, Attributes, Justification) are added to or override (depending on the feature) any settings made with Table Format.

For example, if you turn on Bold, all text between the Bold codes is bolded regardless of any settings you make with the Table Format option. The text may be bolded and italicized or bolded and underlined (depending on your Table Format settings), but at the very least, the text will be bolded.

If you set Justification to Right with the Justification feature, that setting overrides any setting you make with the Cell or Column, Justify options.

Second, settings made with the Cell option override any settings made with the Column option. If text is located in a cell where the Cell option calls for right-aligned text and the Column option calls for left-aligned text, the text in the cell will be right aligned.

Row Height
Select Format (2) from the Table Edit menu, then select Row Height (3). Select an option to determine how the row height is calculated.

You can use Block while in the Table Edit menu to block several rows of text, then use the Row Height option to change the height for all the rows in the block.
The Single Line settings allow for only one line of text in a cell. You cannot insert text that extends beyond one line in Single Line cells. Pressing **Return** in a cell with a single line row height moves the cursor to the next cell.

If you already had more than one line of text in a cell and used this option to change the row height to a single line setting, you will notice that text that extends beyond the right border of the cell will not wrap, will not be displayed, will not show in Reveal Codes, and will not print. It will, however, be remembered by Corel WordPerfect in case you reset the row height to a multi-line setting.

Select Single Line Fixed (1), then enter a measurement to set the row height at that measurement regardless of text size. Text that will not fit in the measurement you enter will not be displayed in View Document, nor will it print. Select Single Line Auto (2), to have Corel WordPerfect calculate the row height according to the height of the text in the cell.

The Multi-line settings allow text to wrap within the cell (just as it does outside of tables when you reach the end of a line). Pressing **Return** in a cell with a multi-line row height inserts a hard return and moves the cursor to the next line of the cell.

Select Multi-line Fixed (3), then enter a measurement to set the row height at that measurement regardless of text size. With this setting, text that wraps below the specified height will not print and cannot be viewed in View Document. Select Multi-line Auto (4), to have Corel WordPerfect calculate the row height according to the height of the text in the cell.

**See Also:** Table, Create; Table, Edit Structure; Table, Math

---

**Table, Math**

Math lends itself well to tabular form, and you can perform four-function math in tables. In fact, depending on your application, you may prefer to use Table Math rather than the Math feature described in *Math*. You should try both Table Math and the Math feature to see which is best for you.
The following invoice was created and calculated with the Table feature:

```
<table>
<thead>
<tr>
<th>Item #</th>
<th>Description</th>
<th>Unit Price</th>
<th>Qty.</th>
<th>Price</th>
</tr>
</thead>
<tbody>
<tr>
<td>8413</td>
<td>Music Box</td>
<td>25.90</td>
<td>2</td>
<td>51.80</td>
</tr>
<tr>
<td>790</td>
<td>Glass Figurine</td>
<td>12.50</td>
<td>4</td>
<td>50.00</td>
</tr>
<tr>
<td>4681</td>
<td>Wrist Watch</td>
<td>55.60</td>
<td>1</td>
<td>55.60</td>
</tr>
<tr>
<td>345</td>
<td>Picture Frame</td>
<td>15.85</td>
<td>2</td>
<td>31.70</td>
</tr>
</tbody>
</table>
```

Sub: 189.10
Tax: 11.35
Tot: 200.45

1. Make sure that the cursor is in a table and the Table Edit menu is displayed. *To display the Table Edit menu, move the cursor to the table, then press Columns/Table.*

2. Select Math (5).

3. Choose a math option and enter the appropriate information (see the options under Notes below).

**Notes**

**Calculate**
When you enter a formula in a table, Corel WordPerfect immediately calculates it.

To have Corel WordPerfect re-calculate all formulas or functions you may have entered in the table (see Formula and Functions below), select Math (5) from the Table Edit menu, then select Calculate (1).

If you make changes to any cells that would affect a calculated result, re-calculate the results. The last result calculated is the result that is displayed and printed.

**Copy Formula**
To copy a formula from one cell to another, move the cursor to the cell that contains the formula you want to copy, then select Math (5) from the Table Edit menu. Next, select Copy Formula (3), select Cell (1), move to the cell where you want to copy the formula, then press Return.

To copy a formula from one cell to the cell(s) underneath or to the right of the cell, move the cursor to the cell that contains the formula you want to copy, select Math (5), select Copy Formula (3), select Down (2) or Right (3), then enter a number to copy the formula down or to the right the specified number of times.
For example, if you enter 3 after selecting Down, Corel WordPerfect will copy the formula to the three cells directly beneath the left margin of the cell in which the cursor is located.

*Only the formula is copied to the cell with this option. Cell attributes, justification, and other cell contents are not.*

**Formula**

To enter a math formula in the cell where the cursor is located, select Math (5) from the Table Edit menu, then select Formula (2). A formula may reference any cell in the table. The following are some examples of formulas that you can enter in a table:

<table>
<thead>
<tr>
<th>Formula</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>A1*A2</td>
<td>Multiplies the number in cell A1 by the number in cell A2.</td>
</tr>
<tr>
<td>B1-B2/C1</td>
<td>Subtracts the number in cell B2 from the number in cell B1, then divides the difference by the number in C1.</td>
</tr>
<tr>
<td>D3+D4-A1</td>
<td>Adds the number in cell D3 to the number in D4, then subtracts the number in A1 from the sum.</td>
</tr>
</tbody>
</table>

If you begin to create a formula, then realize you need to exit the formula definition to check the location of a cell, you can do so. Corel WordPerfect maintains the formula, so that you can return to the formula and make the necessary editing changes.

Or, you can simply create a formula for a table cell that does not reference any other cells (for example, 65.4*34). This is useful for any quick calculations you may need to make.

You can also enter column letters without numbers (B*C) as a formula. If you do, Corel WordPerfect assumes that you are referring to the specified columns on the row where the formula is located. For example, if you enter (B*C) in a cell on row 2, the formula is treated as B2*C2.

For a formula to calculate, the cells represented in the formula must contain a valid number. Positive and negative decimal numbers (for example, 23.4) as well as integers (for example, -45) are considered valid numbers. Cells with letters only are not considered valid numbers, but cells that contain any numbers at all are considered to contain valid numbers. To mark a cell as non-numeric, use the Format option (see Cell, Type under Table, Format Columns and Cells).

If a cell contains two numbers on separate lines, Corel WordPerfect uses the number closest to the bottom in calculations. If the two numbers are on the same line, any spaces between the digits are ignored and the two numbers are interpreted as one number (for example, 2 4 is interpreted as 24 in calculation).

If Corel WordPerfect cannot calculate the formula (for example, one of the cells you are referencing in a formula is a text cell), the calculated result will be displayed as two question marks (??). Check the formula to make sure that it is correct and that the cells you are referencing are numeric cells.
You must enter the addition (+), subtraction (–), multiplication (*), and division (/) operators from the keyboard. Do not confuse them with the functions (see Functions below).

Math formulas in tables are calculated the same as in the Math feature. When there are two or more operators, they are calculated from left to right. Parentheses can change the order of operation. For more information on calculation order, see Calculation Order under Math, Formulas.

As you add rows or columns to your table or when you copy formulas to other cells, Corel WordPerfect uses a concept called relative cell references to update formulas in your table. For example, if you have a formula in cell B1 that references cell A1 (the cell that is one cell to the left) and move that formula to cell D8, the formula will reference cell C8 (the cell that is one cell to the left).

If rows or columns are inserted or deleted between a formula and the cell it references, the formula may need to be edited. If you are unsure about the formula, move to the cell that contains the formula. When you are in a cell that contains a formula, the formula is shown at the left edge of the screen just below the table.

To delete a formula from a cell, move to a location inside the table, press Columns/Table (Alt-F7) to enter the Table Edit menu. Move the cursor to the cell that has the formula and press Backspace.

Functions (+, =, *)

The functions (+, =, *) are used in calculations and operate the same way they do in the Math feature. You can enter a function by selecting Math (5) from the Table Edit menu, then selecting the function, or by selecting Math, selecting Formula (2), then entering the function. If you type a plus sign, an equal sign, or an asterisk from the keyboard without selecting Math, selecting Formula, Corel WordPerfect will not treat those symbols as functions.

The Subtotal function (+) adds the numbers directly above the function. For example, Subtotal functions in cells B3 and B6 below display the following results when calculated:

<table>
<thead>
<tr>
<th>Subtotal one</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Nominal 1</td>
<td>94.56</td>
<td></td>
</tr>
<tr>
<td>Nominal 2</td>
<td>89.54</td>
<td></td>
</tr>
<tr>
<td>Subtotal 1</td>
<td>184.10</td>
<td>90.90 Down</td>
</tr>
<tr>
<td>Nominal 3</td>
<td>98.65</td>
<td></td>
</tr>
<tr>
<td>Nominal 4</td>
<td>83.23</td>
<td></td>
</tr>
<tr>
<td>Subtotal 2</td>
<td>181.88</td>
<td>94.94 Up</td>
</tr>
<tr>
<td>Total 1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Nominal 5</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Subtotal 3</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Total 2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Grand Total</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Subtotal two</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Nominal 1</td>
<td>94.56</td>
<td></td>
</tr>
<tr>
<td>Nominal 2</td>
<td>89.54</td>
<td></td>
</tr>
<tr>
<td>Subtotal 1</td>
<td>184.10</td>
<td>90.90 Down</td>
</tr>
<tr>
<td>Nominal 3</td>
<td>98.65</td>
<td></td>
</tr>
<tr>
<td>Nominal 4</td>
<td>83.23</td>
<td></td>
</tr>
<tr>
<td>Subtotal 2</td>
<td>181.88</td>
<td>94.94 Up</td>
</tr>
<tr>
<td>Total 1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Nominal 5</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Subtotal 3</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Total 2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Grand Total</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
The Total function (=) adds the subtotals directly above the function. For example, Total functions in B7 and B10 below display the following result:

| Subtotal one | | Subtotal two | | Subtotal three | | Total one | | Total two |
|-------------|---|-------------|---|-------------|---|-----------|---|
| B1          | 95.56 | B1          | 95.56 | B1          | 95.56 | B1          | 95.56 |
| Subtotal 1   | 109.18 | B2          | 92.80 | Subtotal 3   | 197.88 | Total 1      | 307.98 |
| B2          | 98.85 | B2          | 92.80 | B2          | 92.80 | B2          | 92.80 |
| Subtotal 2   | 197.88 | B3          | 93.49 | Subtotal 4   | 197.88 | Total 2      | 395.38 |
| B3          | 93.49 | B3          | 93.49 | B3          | 93.49 | B3          | 93.49 |
| Total 3      | 197.88 | B4          | 93.49 | Grand Total  | 495.38 | Grand Total  | 495.38 |

The Grand Total function (*) adds the totals directly above the function. For example, the Grand Total function in B11 below displays the following result:

| Total one | | Total two | | Grand total |
|-----------|---|-----------|---|
| B1         | 95.56 | B1         | 95.56 | B1         | 95.56 |
| Total 1    | 307.98 | Total 2    | 395.38 | Grand total| 495.38 |

Negative Numbers

By default, negative numbers are displayed with a minus sign. You can change them to be displayed with parentheses by using a setting on the Options menu (see Options under Table, Edit Structure).

See Also: Table, Create; Table, Edit Structure; Table, Format Columns and Cells
A table of authorities is a list of citations. This table is used primarily for legal briefs to list where citations of specific cases and statutes occur in a document.

A table of authorities can be divided into one or more sections (for example, cases, statutes, regulations) with a different format for each section. The authorities within each section are sorted alphanumerically.

<table>
<thead>
<tr>
<th>Section heading</th>
<th>Authority (citation)</th>
<th>Page numbering style</th>
</tr>
</thead>
<tbody>
<tr>
<td>Constitution, Statutes, and Regulations:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>United States Constitution:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fifth Amendment (Equal Protection Clause)</td>
<td>4, 6, 9, 11, 15, 16</td>
<td></td>
</tr>
<tr>
<td>Sixth Amendment (Right to Speedy Trial)</td>
<td>12, 19, 54</td>
<td></td>
</tr>
<tr>
<td>Civil Rights Act of 1964:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>42 U.S.C. 1981</td>
<td>4, 5</td>
<td></td>
</tr>
<tr>
<td>42 U.S.C. 1982</td>
<td>4, 5</td>
<td></td>
</tr>
<tr>
<td>42 U.S.C. 1983</td>
<td>4</td>
<td></td>
</tr>
<tr>
<td>42 U.S.C. 1988</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>Equal Access to Justice Act:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>28 U.S.C. 2412(b)</td>
<td>4, 22, 41</td>
<td></td>
</tr>
<tr>
<td>28 U.S.C. 2412(d)</td>
<td>22, 41</td>
<td></td>
</tr>
</tbody>
</table>

To create a table of authorities:

- Mark the authorities you want included in the table.
- Define each section of the table.
- Generate the table.

Each step is exclusive of the others. For example, you could mark text as you write, define the different sections while formatting the document, and generate the table just before your final edit. Later, you could edit the marked text or the table definition, and then regenerate the table.

The instructions for these three steps are divided into separate sections in Reference. To begin, see Table of Authorities, Mark Text, then see Table of Authorities, Define, and finally see Generate.

Notes

Master Documents

If your document is extremely long, you may want to use Master Documents to break it into smaller pieces. You can still generate one table of authorities for the master document and all subdocuments.
Table of Authorities Design

Before you begin marking the authorities for a table, you should consider the design of the table, especially the number of sections and the order in which each section will appear. When you mark an authority, you will be asked for the section number.

See Also: Generate; Table of Authorities, Define; Table of Authorities, Mark Text

Table of Authorities, Define

Once you have marked the authorities you want (see Table of Authorities, Mark Text), you are ready to define where and how they should appear in the table of authorities.

Since you marked each authority in the document for a specific section in the table, you should already know what type of authority each section will include. One or more of the following categories are commonly used (and may even serve as section headings):

- Cases
- Constitution, Statutes, and Regulations
- Legislative Material
- Treaties
- Miscellaneous

For each section you include, you need to create a heading, then define the format for that section.

1. Move the cursor to the place in your document where you want the section to appear when it is generated.

2. Press Hard Page if you want the section on a separate page.

3. Type a heading (for example, Cases: or Treaties:), then press Return as many times as you want to add extra spacing.

You can use any formatting you want for the heading (for example, bold or indent).

4. Press Mark Text, select Define (5), then select Define Table of Authorities (4).

   Or Select Define from the Mark menu, then select Table of Authorities.

5. Enter the number of the section you want to define (1 to 16).

   Sections do not have to be ordered sequentially in the document.

6. Set the dot leader, underlining, and blank line options from the displayed menu (see Format Options below).
Press Exit or Return to save the section definition.

Follow the steps above for each section you want in the table (you will probably want to skip step 2 for each additional section). Each section can have its own unique format if you choose.

You should now set a new page number for the page immediately following the table of authorities. If you do not, page number references may not be accurate after the table is generated (since the table will likely introduce new pages into the document). If a New Page Number code is not found when the table is generated, a warning message will appear.

To set a new page number,

1. Press Hard Page to insert a hard page break after the table of authorities.
2. Press Format, then select Page (2).
   Or Select Page from the Layout menu.
3. Select Page Numbering (6), select New Page Number (1), and enter the page number you want the document to start with after the table of authorities.
4. Press Exit.

Once you have defined all the sections of the table, inserted a new page number, and marked the text for each section, you can generate the table (see Generate).

Notes

[Def Mark:]
Each time you define a section of the table, [Def Mark:ToA, #] (where # represents the section number you defined) is inserted into the Reveal Codes screen at the cursor position. The table section will be generated at this code. If you are using Master Documents, [Def Mark:] should be in the master document and not in one of the subdocuments (see Master Documents).

Format Options

After entering the section number, a menu appears:

- **Dot Leaders (1)** • Type y to include a dot leader with page numbers aligned at the right margin; type n to keep the numbers flush right, without a dot leader.

- **Underlining Allowed (2)** • Type y to keep Underline codes in the text of the entries in this section; type n to have all Underline codes deleted when the table is generated.

- **Blank Line Between Authorities (3)** • Type y for double spacing between authorities; type n for single spacing.

You can change these settings permanently with the Initial Settings option on the Setup key.
Numbering Type
To change the type of number used in a table of authorities (from Arabic to
Roman, for example), use New Page Number. Changing the page number type
with New Page Number affects both page numbers displayed in the document
and those generated in a table, list, or index.

See Also: Generate; Table of Authorities; Table of Authorities, Mark Text

Table of Authorities, Mark Text
After you have a firm idea of how you would like your table of authorities
organized (for example, number of sections, section headings, section order), the
next step in creating a table of authorities is to mark the authorities (citations)
you want listed in the table. You can mark authorities within the body of the
document, as well as in footnotes, endnotes, and graphic boxes.

The first time you mark an authority, you edit the text as you want it to appear
in the table. This mark is called the full form. As part of the full form mark, you
also assign a nickname or short form, which may simply be a part of the full form
text (for example, the first name in the case being cited). The short form is used
for convenience in subsequent marking, so you do not have to keep entering the
full form.

To mark an authority,

1. Find an occurrence of the authority within the document and block the text.
2. Press Mark Text and select ToA (4).
   Or Select Table of Authorities from the Mark menu, then select Mark Full.
3. Enter the section number of the table where you want the authority inserted
   (1 through 16).
4. Edit the text in the special editing screen to make it appear as you want it in
   the table.

You can use most editing and formatting features to edit the full form text (see
Full Form below).

5. Press Exit to save the edited text.

You are now asked to enter a short form nickname.

6. Press Return to use the displayed text as the short form name.
   or
   Edit the text and press Return to use the short form name you want.

The short form name must be unique, since it is used to identify other
occurrences of the same authority in the text (see Short Form below).
A [ToA: #; text; Full Form] code (where # represents the section number you defined, and text represents the text of the short form) is inserted into the Reveal Codes screen at the cursor.

Now you can mark all subsequent occurrences of that authority with the short form.

7 Press Home, Home, Up Arrow to move the cursor to the beginning of the document.

8 Press Extended Search (Home, F2) to search through text, footnotes, endnotes, and graphic boxes for an occurrence of the authority.

9 Type a few characters or words of the authority (or type the entire authority if you want), then press *Search to start the search.

When the search ends, the cursor will be to the right of the characters you searched for.

10 Press Mark Text and select ToA Short Form (4).

Or Select Table of Authorities from the Mark menu, then select Mark Short.

11 If the short form name is displayed, press Return to accept it.

or Enter the correct short form name.

Repeat steps 8 through 11 until you have marked every occurrence of the authority.

If you block the short form text before step 10 above, the short form name will always be displayed in step 11.

After entering the short form name, a [ToA: text] code (where text represents the text of the short form) is inserted into the text at the cursor position.

Once you have marked all your authorities, you are ready to define the table of authorities (see Table of Authorities, Define).

Notes

**Full Form**
A full form contains the text of a complete citation as it will appear in the table of authorities. The text of a full form citation can be 30 lines long. You may want to include bold, italics, and so on. You may also want to shorten the lines with Enter or indent the beginning of all lines after the first line by pressing *Indent, then *Margin Release at the beginning of the first line.

**Full Form, Edit**
After you have generated a table of authorities, you may need to change a full form. To edit a full form, find the first occurrence of the authority (use *Search or the page reference listed in the original table).

1 Move the cursor to the immediate right of the [ToA:] code (use Reveal Codes to be sure).
2 Press **Mark Text**, select Define (5), then select **Edit Table of Authorities Full Form** (5).

   *Or*  
   Select **Table of Authorities** from the **Mark menu**, then select **Edit Full**.

3 Edit the Full Form text (if desired).

4 Press **Exit** to save the changes.

5 Enter the section number.

   *If there is no Mark Text code for the full form before the cursor, the text of the nearest full form after the cursor is displayed.*

Once you have edited the full form, you will need to generate the table of authorities again to display the changes.

**Short Form**

A short form is an abbreviation of the full form. It is used for convenience in marking, so you do not have to keep entering the complete text of the full form. Only one short form name can be assigned to any single authority in the document. If the short form you enter is already associated with another full form of an authority, an error message appears when you generate the table of authorities, and Corel WordPerfect places asterisks instead of page numbers next to the text of the second full form.

If you enter a short form name that does not match any existing full forms, the short form name appears with an asterisk at the beginning of the table of authorities when generated.

**See Also:** Generate; Table of Authorities; Table of Authorities, Define
Table of Contents

You can create a table of contents for a document with up to five levels and define the numbering style for each level.

<table>
<thead>
<tr>
<th>Level one</th>
<th>Numbering style</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chapter 1: Management Fundamentals</td>
<td></td>
</tr>
<tr>
<td>What is Management?</td>
<td></td>
</tr>
<tr>
<td>Management: A Historical Perspective</td>
<td></td>
</tr>
<tr>
<td>Where To Begin</td>
<td></td>
</tr>
<tr>
<td>Why Me?</td>
<td></td>
</tr>
<tr>
<td>Accepting the Position</td>
<td></td>
</tr>
<tr>
<td>Self-Esteem</td>
<td></td>
</tr>
<tr>
<td>The Plan</td>
<td></td>
</tr>
<tr>
<td>The Managing Leader</td>
<td></td>
</tr>
</tbody>
</table>

| Level two                                      |                 |
| Chapter 2: Useful Goals                       |                 |
| Goals vs. Wishes                              |                 |
| Behavioral Objectives                         |                 |
| Evaluation                                    |                 |

| Level three                                     |                 |
| Chapter 3: The Hiring Process                  |                 |
| Finding the Right Person for the Job           |                 |
| Interviewing with a Purpose                    |                 |
| Evaluating Applicants                          |                 |
| Making a Decision                             |                 |

| Level three                                     |                 |
| Chapter 4: Training the New Employee           |                 |
| Fundamental Training Approaches                |                 |
| Mentor Training                               |                 |
| Formalized Curriculum                         |                 |
| Combination Training                          |                 |
| On the Job Helps                              |                 |

| Level three                                     |                 |
| Chapter 5: Problem Solving                     |                 |
| Defining the Problem                           |                 |
| Finding the Source                             |                 |
| Model Construction                             |                 |
| Beyond Brainstorming                           |                 |
| A Five Step Approach to Solutions              |                 |

| Level three                                     |                 |
| Chapter 6: Interpersonal Relationships         |                 |
| Mutual Respect                                 |                 |
| Earning Trust                                  |                 |
| When to Put Your Foot Down                     |                 |
| Being Tactfully Honest                         |                 |
| Building Rapport                               |                 |
| Helping Employees Feel Useful                  |                 |
| Sharing Problems                               |                 |
| Avoiding Discrimination                        |                 |
| Caring                                         |                 |

| Level three                                     |                 |
| Chapter 7: Effective Communication             |                 |
| The Message                                    |                 |
| Understanding Your Own Message                 |                 |
| Preparing the Message                          |                 |
| Encoding and Decoding                          |                 |

When the table of contents is generated, the entries will be listed in the order in which they appear in the document.

To create a table of contents,

- Mark the text you want included in the table.
- Define the location of the table and the numbering style for each level.
- Generate the table.

Each step is exclusive of the others. For example, you could mark text as you write, define the table while formatting the document, and generate the table just before your final edit. Later, you could edit the marked text or the table definition, and then regenerate the table.

The instructions for these three steps are divided into separate sections in Reference. To begin, see Table of Contents, Mark Text, then see Table of Contents, Define, and finally see Generate.

Notes

Master Documents
If your document is extremely long, you may want to use Master Documents to break it into smaller pieces. You can still generate one table of contents for the master document and all subdocuments (see Master Documents).

See Also: Generate; Table of Contents, Define; Table of Contents, Mark Text
Once you have marked the text you want (see Table of Contents, Mark Text), you need to define the location for the table of contents and the numbering style for each level of heading.

To define the location and numbering style,

1. Move the cursor to the place in the document where you want the table to appear (usually the beginning of the document).

2. If you are at the beginning of the document and want the table generated on a page of its own, press Hard Page to create a page break, then press Up Arrow.

3. To type a heading (title) for the table, type it now, then press Return as many times as you want to add extra spacing.

4. Press Mark Text, select Define (5), then select Define Table of Contents (1).

   Or  [ ] Select Define from the Mark menu, then select Table of Contents.

5. Enter the number of heading levels you want in the table by selecting Number of Levels (1) and entering a number (1 through 5).

6. Select Display Last Level in Wrapped Format (2) and type y to wrap the last level of entries (if you selected more than one level). See Wrapped Levels below.

   or

   Skip to step 7 if you do not want the last level to wrap (if you have selected more than one level).

7. Select Page Numbering (3) and enter a numbering style for each level (see Numbering Styles below). Use the arrow keys to move among the levels.

8. Press Exit to exit the Page Numbering menu. Then press Exit again to return to the normal editing screen.

At this point, you may want to set a new page number for the page immediately following the table of contents. If you do not, page number references may not be accurate after the table is generated (since the table will likely introduce new pages into the document).

To insert a new page number,

1. Move the cursor down until it is just below the page break you created in step 2 above.

2. Press Format, then select Page (2).

   Or  [ ] Select Page from the Layout menu.

3. Select Page Numbering (6), select New Page Number (1), and enter the page number you want the document to start with after the table of contents.
Once you have defined the table of contents, set a new page number if you wanted, and marked the text for the table, you are ready to generate it (see Generate).

Notes

When you select a numbering style, [Def Mark: ToC, $#] (where the first # represents the number of levels in the table, and the second # represents the numbering style for each level) is inserted into your text at the cursor position. The table will be generated at this code. If you are using Master Documents, [Def Mark:] should be in the master document and not in one of the subdocuments (see Master Documents).

Numbering Styles

Numbering styles refer to the way the page numbers are displayed. You can choose one of the following five numbering styles for each level of heading:

- No page numbers
- Page numbers following the entries (separated by a space)
- Page numbers in parentheses following the entries (separated by a space)
- Flush right page numbers
- Flush right page numbers with dot leaders

You cannot select a flush right style for the last level if you also want it to wrap (see Wrapped Levels below).

The five options above affect the placement of page numbers in a table of contents. To change the actual type of number used (from Arabic to Roman, for example), use New Page Numbering on the Format menu. Changing the page number type with New Page Number affects both page numbers displayed in the document and those generated in a table, list, or index.

Wrapped Levels

When Corel WordPerfect wraps the last level of heading in a table of contents, the headings follow one another, wrapping at the right margin as if they were one paragraph of information. Page numbers are placed in parentheses following each heading.

You cannot select a flush right style for the last level if you also want it to wrap.

See Also: Generate; Table of Contents; Table of Contents, Mark Text

Table of Contents, Mark Text

The first step in creating a table of contents is marking the text you want included in the table.

To mark text,
1 Block the word or phrase you want included.

2 Press **Mark Text** and select **ToC** (1).

    * Or [ ] Select **Table of Contents** from the **Mark menu**.

3 Enter the table level number in which you want to include the text (1 through 5).

Repeat the steps above for each item you want included in the table. Once you have marked all the entries you want, you should define the table. See *Table of Contents, Define*.

---

### Notes

**[Mark:] and [End Mark:]**

When you mark text, [Mark:ToC, #] (where # represents the level number for the marked text) is inserted before the text in the Reveal Codes screen, and [End Mark:] is inserted after. Any codes included in the block of text (Bold, Underline, Center) are included with the text when the table is generated.

If you decide you do not want a word or phrase included in a table, delete [Mark:] before generating.

**See Also:** Generate; Table of Contents; Table of Contents, Define

---

### Text In/Out

Text In/Out is used to import and export text in various usable formats. It does the following:

- Retrieves a UNIX (ASCII) text file into Corel WordPerfect.
- Saves the document on your screen as a UNIX text file, as a WordPerfect Corporation’s WordPerfect 4.2 or 5.0 file, or in a generic word processing format.
- Converts a block of text to a comment.
- Imports information from cells in a spreadsheet, or links spreadsheet cells to a Corel WordPerfect document. For more information on these features, see *Spreadsheet, Import and Link*.

For document conversions other than those listed above, look under **See Also** at the end of this section.

The Text In/Out key also contains the Locked Document (Password) and Document Comments features (see *Locked Documents and Document Comments*).

To retrieve (import) a UNIX text file into Corel WordPerfect,
1 Press **Text In/Out**, select UNIX Text (1), then select Retrieve (NL to [HRT]) (2), or Retrieve (NL to [SRt] in H-Zone) (3) (see **NL** below).

Or  
Select Text In on the File menu, then select UNIX Text (NL to HRT) or UNIX Text (NL to SRt).

2 Enter the filename of the UNIX text file to be retrieved.

To save (export) a Corel WordPerfect document in a different file format,

1 Press **Text In/Out**, select UNIX Text (1), then select Save (1) to save the file in UNIX Text format.

or

Press **Text In/Out**, select Save As (3), then select Generic (1), version 5.0 (2), or version 4.2 (3) to save the file in another format.

Or  
Select Text Out on the File menu, then select UNIX Text, Generic, WP5.0 or WP4.2.

2 Enter a filename for the converted (output) file.

*If the filename already exists, you are prompted to replace the file. Type y to replace the file, or n to enter a different filename.*

---

### Notes

#### Block to Comment

If Block is on when you press **Text In/Out**, you will be asked if you want to create a comment (see **Document Comments**). If you type y for yes, the blocked text becomes a comment.

#### NL

NL (New Line) is a code in a UNIX text file that ends a line and moves the cursor to the beginning of the next line. If you choose to have NLs converted to soft returns, the retrieved text file more closely matches Corel WordPerfect format.

When NLs are converted to soft returns in the hyphenation zone, hard returns in the middle of a paragraph are eliminated. Any sequence of two or more <NL> codes preserves the original format (that is, converts each pair of codes to hard returns).

If you are converting NLs to hard returns, you may want to reset your margins to make them wider than those of the document which you are retrieving. This helps to preserve the current format of your document.

If you are converting NLs to soft returns, you should set the width of your margins as close as possible to the margins of your UNIX text file.

#### Default Filename

When you use Text Out to save a UNIX text or generic word processor file that was retrieved using Text In in the same format, a default filename appears next to the prompt. You can press **Return** to save the file under its original name and format.
If you use Save or Exit to save a file which was retrieved as UNIX text through Text In, no default filename appears. If you enter a filename, the file is saved in Corel WordPerfect format, not UNIX text format.

When you save any version of a Corel WordPerfect document in the same or later version Corel WordPerfect format, a default filename appears. If you save it to a previous version Corel WordPerfect format, the filename does not appear.

**UNIX Text Files**

Sometimes you may want to preserve just the text of a document, without any of the formatting codes. You can accomplish this by saving the file as a UNIX text file. A UNIX text file contains text, spaces, and carriage returns. Formatting codes are eliminated to make the file acceptable to many other programs. For example, some grammar-checkers cannot handle Corel WordPerfect documents, but can check a UNIX text file. Some output devices also require a UNIX text file.

When you save a Corel WordPerfect document as a UNIX text file, codes for features such as Date, Soft Hyphens, and Paragraph Numbering are converted to ASCII text. *Indent*, *Indent*, Center, Tab Align, and Flush Right are converted to spaces. Columns, footnotes, endnotes, headers, footers, and so on, are deleted. You can preserve these formats with space-fill in the file by printing to disk. If you do so, however, all the printing codes will also be contained in UNIX format in the file. (See *Printing to Disk* for more information on using this feature.)

When you use Text In to retrieve a UNIX text file as a Corel WordPerfect document, you must specify how you want the end-of-line codes converted (see NL above). You can also retrieve the file through the List Files menu (see *List Files*); however, you cannot specify how you want the New Lines converted when you retrieve them this way.

To edit a UNIX text file, use Text In/Out to retrieve and save the file. If you use Text In to edit shell scripts, be sure to save your changes as a text file using Text Out. If you use Save, the text file will be saved as a Corel WordPerfect document and will no longer be recognized as a shell script by UNIX. (To correct this situation, retrieve the file in Corel WordPerfect using Retrieve or List, then use Text Out to export the file in UNIX Text format.)

**Extended Characters**

Extended characters from the Corel WordPerfect character sets that are not located in the IBM character set are stored as a space when converted to a UNIX text, generic word processor, or WordPerfect Corporation’s WordPerfect 4.2 or 5.0 file.

**Generic Word Processor Format**

A file saved in a generic word processing format is saved without Corel WordPerfect-specific codes. Text format is maintained, however. Spaces are used in place of Center, *Indent*, Flush Right, and Soft Return codes. `<NL>` is used in place of hard returns, and Tab codes are retained.
**WordPerfect Corporation’s WordPerfect 4.2 or 5.0 Format**

You can save Corel WordPerfect 8c documents in WordPerfect Corporation’s WordPerfect 4.2, 5.0, or 5.1 format.

If a Corel WordPerfect 8c code has no corresponding 4.2 code, the code is deleted from the document during the conversion to 4.2 format. (See Document Conversion, versions 8c to 4.2). If an 8c code has no corresponding 5.0 code, [Unknown] appears in place of that code in the 5.0 document. The [Unknown] codes are ignored by WordPerfect Corporation’s WordPerfect 5.0; however, you can see them in the Reveal Codes screen. Although the codes are ignored in 5.0, the original meaning of each code is preserved. If you retrieve the document back into 8c format, they are restored as originally entered. (You can check this in Reveal Codes.)

Because the [Unknown] codes are not recognized in WordPerfect Corporation’s WordPerfect 5.0, you may have to make some formatting adjustments to the converted file.

Tables in 8c documents are converted to parallel columns, merge commands that have a 5.0 or 4.2 equivalent are converted to their 4.2 or 5.0 equivalent code, and left and full justification are converted to justification off and on, respectively.

Files in 4.2, 5.0, or 5.1 format require no manual conversion to be compatible with Corel WordPerfect 8c.

**See Also:** Convert Program; Document Comments; Document Conversion, versions 8c to 4.2; Locked Documents; Spreadsheet, Import and Link

---

**Text Screen Size**

Use Text Screen Size to change the display mode of your terminal to wide mode or long mode. Not all terminals support these display modes. See your system administrator if you have a question about your terminal.

To change the display mode,

1. Press **Setup**. Select Display (1).
2. Select Text Screen Size (3).
3. Select the mode you want to change (Wide or Long), then type y to enable that mode.

**Notes**

**Wide Mode**

Wide mode increases the number of characters that can be displayed on one line. If your terminal has the capability, Corel WordPerfect can display 132 characters on the same line.
Long Mode
Long mode increases the number of lines that can be displayed on the screen. If your terminal has the capability, Corel WordPerfect can display 42 lines on the screen.

Reset Screen Size on Exit
Set the Reset Screen Size on Exit option to yes if you want the screen size to return to its previous default when you exit Corel WordPerfect. If you set this option to no, Corel WordPerfect will use the current display mode the next time it is started.

Thesaurus
The Thesaurus searches for and displays synonyms (words with the same or very similar meaning) of words in the text or words you enter from the keyboard. Antonyms (words with the opposite meaning) are also displayed.

Up to 3 words and their references can be displayed side-by-side on a single screen.

Important: The Thesaurus file needs to be installed properly before you use the Thesaurus. If the Thesaurus file has not been installed, see your system administrator.

To look up words with the Thesaurus,
1. Move the cursor to the word you want to look up.
2. Press Thesaurus.
   Or Select Thesaurus on the Tools menu.
3. Select an option (see the information pertaining to each option under Notes below).

Notes
Clearing Columns
A column in the Thesaurus screen can be cleared by pressing Left or Right Arrow to move the Reference menu to the column (see Reference Menu below), and selecting Clear Column (4) or pressing Backspace or Delete.

Exiting the Thesaurus
Should you finish using the Thesaurus without replacing a word, press Exit to return to your document.
Headwords, References, and Subgroups

When alternatives for a word are displayed, they are arranged according to headwords, references, and subgroups.

A headword is a word that can be looked up in the Thesaurus. The words under the headword are divided into nouns (n), verbs (v), adjectives (a), and antonyms (ant), and are called references. References marked with a bullet (*) are other headwords or words which, if selected, will display other useful words.

A subgroup is a group of words with the same basic meaning. Subgroups are numbered under the headword.

Look Up Word

While in the Thesaurus screen, you can look up other words in one of the following ways:

* Select Look Up Word (3) from the Thesaurus menu and enter the word.
* Type the letter which is next to a word marked with a bullet (*).
* Select View Document (2), move the cursor to another word in the document, then press Thesaurus. This clears the screen of all headwords except the one you are looking up.

The selected headword and its references fill the column(s) to the right. If the columns are already filled, then the last column is replaced by the new headword.

Moving Through Columns

When you first display the Thesaurus screen, the references for the headword that do not fit in the first column spill over to the second and third columns.

If you select a second headword, any references from the first headword in columns 2 and 3 are moved to column 1 below the screen, so that they are not visible. The same is true if you select a third headword. All references are placed beneath column 2 and cannot be seen without scrolling through the list. Any references in column 3 from the second headword are moved back to column 2.

You can scroll through all the references in a column by moving the Reference menu to the column and using Up Arrow, Down Arrow, Screen Up, Screen Down, Page Up, or Page Down. Press Home twice and then
Up Arrow or Down Arrow to move to the first or last subgroup. Go to a particular subgroup by pressing Go To, then entering the subgroup number.

Reference Menu
The Reference menu is the column of bolded letters next to the words, and can be moved from column to column with Left Arrow and Right Arrow. You can use the Reference menu letters to look up headwords listed on the Thesaurus screen (see Look Up Word above).

Replace Word
Once you have found the word in the Thesaurus that you want to substitute for the word in your document, move the Reference menu to the column where the word is listed, select Replace Word (1) (or press Insert), then type the bolded letter next to the word.

The word is replaced, the Thesaurus is exited, and you are returned to your document.

View Document
When the Thesaurus screen is displayed, four lines of your document are displayed at the top of the screen with the headword highlighted. When you want to view another part of the document or look up another word, select View Doc (2) and use the cursor keys to scroll through the text.

When you finish, press Exit to return to the Thesaurus.

wpths.us Not Found
Corel WordPerfect first looks for the wpths.us file in the directory specified in Location of Files. If it is not found, Corel WordPerfect looks in the wplib directory. If the file is not found in either of these locations, “Error: File not found -- wpths.us” appears.

See Also: Speller, Look Up Words

---

Typeover

Normally, text is inserted as you type, pushing forward any existing text and rewriting the text from the cursor forward.

As you edit a document, it is sometimes easier to type over the top of existing text rather than to delete and replace it. Suppose, for example, you spot a word with transposed characters (for example, hte for the or gvie for give), or several words that you want to capitalize. Typeover lets you type over those characters without having to use the delete keys to delete them.

Typeover is necessary when you are editing a document you have created using Line Draw and you want to add text to the boxes you have created without disturbing the box borders.

To use Typeover,

1  Press Insert to begin typing over text.
The word “Typeover” replaces the current filename at the left end of the status line. As long as “Typeover” is displayed on the screen, characters are replaced, and codes are pushed in front of the text you type (see Codes below).

2 Type the new text.
3 Press Insert to return to inserting text.

Notes

Codes
In Typeover, you cannot type over codes. If the text you type encounters a code, it will simply be inserted before the code. For example, you cannot type over the Hard Return code [HRt] at the end of a sentence or paragraph.

The exception is Tab codes. You can type over Tab codes.

Also, while you are in Typeover, pressing a key that inserts a code (for example, Bold, Underline) simply inserts that code. It does not replace existing text.

Forced Insert
Sometimes, when creating macros, you need to be certain that you are turning on Insert and not Typeover. While you are defining a macro, you can press Home,Home,Insert to make sure that Insert is in effect as you run the macro. If you want typeover to be in effect when you run the macro, press Home,Insert.

Keystroke Function Changes
Typeover changes the function of certain keys, as explained in the following list.

<table>
<thead>
<tr>
<th>Key</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Backspace</td>
<td>Replaces the character to the left of the cursor with a space. (However, in Reveal Codes, Backspace deletes codes normally even when Typeover is on.)</td>
</tr>
<tr>
<td>Space Bar</td>
<td>Replaces the character at the cursor with a space, rather than inserting a space.</td>
</tr>
<tr>
<td>Tab</td>
<td>Moves the cursor through the text to the next tab stop or inserts a tab if none exists.</td>
</tr>
<tr>
<td>◆Margin Release</td>
<td>Moves the cursor back through text to the previous tab stop, or inserts a Margin Release code if the cursor is already at the left margin.</td>
</tr>
</tbody>
</table>

Line Draw
Normally, the word “Typeover” is displayed at the left of the status line whenever you are using Typeover. When you are in Line Draw, however, Typeover is always in effect, even though “Typeover” is not displayed on the status line.

Restoring Typed-Over Text
When you use Typeover, you are actually deleting text. If you accidentally type over something you do not want to delete, you can use Cancel to display your last nine deletions on-screen and restore the deletion of your choice (see Undelete).

See Also: Line Draw; Undelete
Undelete

Corel WordPerfect stores up to nine text deletions. You can display them on-screen in reverse video at any time, and restore the deletion of your choice.

To restore a deletion,

1 Press **Cancel** to display your last deletion.

   Or **Select Undelete from the Edit menu.**

Your last deletion is displayed in reverse video at the cursor position.

2 Select **Restore (1)** to restore the highlighted text.

   or

   Select **Previous Deletion (2)** or use Up Arrow and Down Arrow to continue displaying up to three levels of deletions, then select **Restore (1)** when the one you want appears on-screen.

The deletion is restored at the cursor.

Notes

**Codes**

When you delete text and codes using Backspace, or Delete, the paired codes (for example, [BOLD][Bold], [UND][Und]) within the text are not restored when you restore the deleted text. Other codes are usually restored.

When you delete text and codes using the other deletion keystrokes, both the text and the codes within the text are usually restored. Codes are restored at the cursor position; they are not “auto placed.” For a list of the deletion keys and the text they delete, see *Delete Text*.

Even though codes may be restored when you restore text, the actual codes themselves do not appear in the normal editing screen. You can display them in Reveal Codes. If you attempt to restore a deletion and nothing appears on the screen, you may want to use Reveal Codes to see if the deletion contains only codes.

**Deletions**

A deletion is any group of characters and/or codes which you delete before moving the cursor to another place in your document. You can use several keys to delete text (see *Codes* above).

**Files**

Although the text you delete is not immediately lost when you delete it, this is not the case with the files you create. When you delete a file using Delete in List Files, it is lost. It cannot be restored with Corel WordPerfect.

**Memory**

Once you have made nine deletions, your oldest deletion is removed from memory each time you make a new deletion. It can then no longer be restored.

The only practical limit to the amount of text you can delete at one time is your available disk space. Deletions are stored on disk. When you attempt to delete
text, if there is not enough room to save a deletion, you are asked if you still want to delete it. You can then type y to delete the text permanently, or you can type n to cancel the deletion.

When you exit Corel WordPerfect, all temporary deletions are removed. They can no longer be restored.

See Also: Cancel; Delete Files; Reveal Codes

Units of Measure

Corel WordPerfect uses measurements to position text on a page. For example, Corel WordPerfect measures the margins, the height of each line on a page, and the distance between tab settings. You also need to enter measurements when you create graphics boxes, or use Advance, or various other features. Corel WordPerfect needs to know the units you want to use for these measurements.

By default, inches are the standard unit of measurement. That means that top and bottom margins, left and right margins, and so on, are all measured in inches. In addition, each time you enter a number without specifying a measurement, it is converted to inches.

You can change to other units of measurement. You can use any one of these units for just one entry, or you can select a unit to be used permanently, as the standard unit of measurement.

To change the standard unit of measurement,
1 Press Setup, then select Environment (2).
   Or Select Setup from the File menu, then select Environment.
2 Select Units of Measure (7).
3 Select a new unit of measurement (see Units of Measure below).
4 Press Exit to return to your document.

All the measurements throughout Corel WordPerfect then use that unit.

Notes

Entering Units of Measurement
When you enter a number for measurement, it is converted to the current unit of measurement. You can also enter fractions, and have Corel WordPerfect convert them into decimals for you. For example, if inches are the current unit of measurement, and you enter 1 1/8, Corel WordPerfect converts it into 1.13”.

You can enter any unit of measurement other than the standard simply by typing the letter used to identify that unit of measurement after an entry (for example, c for centimeters, p for points, as listed below). Corel WordPerfect then converts each entry to the current standard unit of measurement. For example, if inches
are the standard unit of measurement, and you enter 12p for 12 points, it is converted to 0.167”.

**Units of Measure**

The standard units of measure being used at any time are displayed in the entries in the top half of the Units of Measure screen.

Select Display and Entry of Numbers for Margins, Tabs, etc. (1) to determine the unit of measure used throughout Corel WordPerfect, with the exception of on the status line. Although only one, two, or three digits right of the decimal point are displayed in Corel WordPerfect menus, Corel WordPerfect calculates up to six places. For example, if you enter 2.3679, only 2.37 is displayed on-screen, but 2.3679 is used in the calculation.

Select Status Line Display (2) to determine the unit of measure displayed on the status line. Usually, you will want both your display and status line choices to be in the same unit of measurement.

On the status line, the Line entry (Ln) measures how far down the cursor is from the top of the page; the Position entry (Pos) measures how far the cursor is from the left edge of the page. However, when you are using WordPerfect Corporation’s WordPerfect 4.2 units of measurement, the Line entry measures how far down the cursor is from the top line on the page, without taking into account any space allotted to the top margin.

You can select from five different units of measure:

<table>
<thead>
<tr>
<th>Selection</th>
<th>Measurement</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot; or i or \</td>
<td>Inches (1/12 of a foot)</td>
</tr>
<tr>
<td>c or :</td>
<td>Centimeters (1/100 of a meter or .39&quot;)</td>
</tr>
<tr>
<td>p or *</td>
<td>Points (1/72&quot;, as opposed to 1/72.27&quot; in the publishing industry)</td>
</tr>
<tr>
<td>w or ?</td>
<td>1200ths of an inch (300 for 1/4&quot;, 600 for 1/2&quot;, 900 for 3/4&quot;, and so on)</td>
</tr>
<tr>
<td>u or +</td>
<td>WordPerfect Corporation’s WordPerfect 4.2 units (lines and columns)</td>
</tr>
</tbody>
</table>

Since the w selection lets you measure in very small increments of an inch, use it to make minute changes to a setting.

The u selection is the standard measurement type used in WordPerfect Corporation’s WordPerfect 4.2. It measures vertically by lines, and horizontally by columns. The actual size of a line or column is determined by the current font size. When you enter these measurements, enter a v for line (or vertical) measurements, and enter an h for column (or horizontal) measurements.

**See Also:** Format
View Document

View Document lets you view the format of a document before it is printed. Headers, footers, footnotes, endnotes, margins, page numbers, and graphics are displayed along with the text. Everything is displayed as close in appearance as possible to the printed page.

Many terminals cannot display high resolution graphics, while others can display only a textual view of the document. The default setting is Text, but can be changed to Graphics by going to the Setup menu, selecting Display, then choosing Graphics Screen Type.

To view a document,

1 Press Print.
   Or Select Print from the File menu.
2 Select View Document (6).
3 If in Text mode, you can move through the document to preview it.
   or
   If in Graphics mode, select 100% (1), 200% (2), or Full Page (3) to display views of the current page (see Current Page below). You can also select Facing Pages (4) to view facing pages (see Facing Pages below).
4 Use the Page Up/Down, Screen Up/Down, Home,arrow keys, and Go To to move through the document.
5 Press Exit to exit the View Document screen and return to the original document.

You cannot edit your document while in the View Document screen.

Notes

Current Page
Select 100% (1) to view the document at its actual size or 200% (2) to view the document at twice its actual size. You can use the arrow keys while in these two screens to move through the document. Select Full Page (3) to view the entire page.

Facing Pages
If you select Facing Pages (4), even-numbered pages are displayed to the left, and odd-numbered pages are displayed to the right. Because of this, there is no facing page to match page one (unless you have a page 0).

Foreground and Background Colors
To switch the foreground and background colors in the View Document screen, press Switch. This has no effect on the printed document.

View Document and the Printer
View Document gets the information it needs to display a document from the .prs file you have selected for the document. In order for View Document to
display a document as it will be printed, you must select a printer and enter the correct information for that printer (see Printer, Select).

**View Document Options**

If you have a color monitor, there are other View Document options available to you.

**See Also:** View Document, Options

---

**View Document, Options**

If you have a terminal that can display high resolution graphics, and would like to change the appearance of certain attributes or graphics in the View Document screen, use **View Document Options**. These options do not affect the way a document will look when printed.

1. Press **Setup**, then select **Display** (1).
   
   Or **Select Setup from the File menu, then select Display.**

2. Select View Document Options (5).

3. Select an option (see option headings under **Notes** below).

4. Press **y** to turn on the option.
   or
   Press **n** to turn off the option.

5. Repeat steps 3 and 4 above for any other options you want to change.

6. Press **Exit** to exit the View Document Options menu.

---

**Notes**

**Bold Displayed With Color**

By selecting Yes for this option, bolded text on the menu line will appear on your screen according to the color defined in Colors/Fonts/Attributes.

It is possible to change the color of boldfaced text on the menu line in the View Document screen through Colors/Fonts/Attributes. You should bear in mind that doing so will change the color in your normal editing screen as well.

By selecting No for this option, bolded text on the menu line will appear as it generally does on a monochrome monitor, usually as thicker or brighter characters.

*Because of the color maps in certain Corel WordPerfect graphics, it is possible that your bolded menu text can change colors or disappear altogether while using these graphics. For example, if you have a graphic with a certain color mapping to red, your bolded text may disappear if it is also set to red. To counteract this, you should either select a different bold color or set this option to No.*
Graphics in Black & White
This option makes it possible for you to view any color graphic images in the View Document screen in black and white. The color-shaded areas appear as a pattern which Corel WordPerfect uses to represent the actual color, while the remainder of the image appears as black lines on a white background. Any text you have surrounding the image will still appear according to the text option you have chosen (see Text in Black & White below).

Text in Black & White
Select this option to view your text in the View Document screen in black and white. The text will appear as black letters on a white background. Any graphic images you have on the page will still appear according to the graphics options you have chosen (see Graphics in Black & White above).

See Also: Colors/Fonts/Attributes; View Document

Widow/Orphan

It is generally considered a good practice in printed documents to avoid having one line of a paragraph printed by itself at the top or bottom of a page.

When the last line of a paragraph appears alone at the top of a page it is called a widow. When the first line of a paragraph appears alone at the bottom of a page it is called an orphan.

You can have Corel WordPerfect prevent widows and orphans by turning on Widow/Orphan.

1 Press Format, then select Line (1).
   Or □ Select Line from the Layout menu.

2 Select Widow/Orphan Protection (9), then type y.

3 Press Exit to return to the normal editing screen.

Notes

Codes
Setting Widow/Orphan Protection (9) to On inserts a Widow/Orphan On code [W/O On] at the top of the current page. This code takes effect from that point forward in your document, or until you turn off Widow/Orphan protection.

Keeping Text Together
You can also hold groups of lines together with Block Protect and Conditional End of Page. You can use Block Protect to keep a block of text together as you add or delete text from the block. You can use Conditional End of Page to keep certain lines together, such as a heading and the first two lines of a paragraph.

See Also: Block Protect; Conditional End of Page
Window

You can use Window to split the screen into two separate windows, so that you can display two documents on the screen at once and then compare and edit them.

1. Press Screen, then select Window (1).
   
   Or Select Window from the Edit menu.

You are asked to enter the number of lines you want in the current window.

2. Enter the number of lines you want in the current window (see Window Size below).

   or

   Press Up Arrow or Down Arrow to move the reverse video bar to a line on the screen, then press Return.

Each window becomes a separate editing screen, with its own status line. The number of each separate window is displayed as the document number on each window's status line.

A reverse video bar divides the two windows. In the reverse video bar, a triangle (▲) represents each tab setting. The triangles in the reverse video bar point to the window that the cursor is in. A left bracket ([ ) represents the left margin; a right bracket ( ] ) represents the right. If a margin falls on a tab setting, it is displayed as a left brace ( {) for the left margin or a right brace ( }) for the right margin.

Press Switch to move from one window to the other.

Notes

Closing the Window
To close a window, enter 0 (zero) in step 2 above, or press Up Arrow or Down Arrow to move the reverse video bar off the screen then press Return. If a document is still active in the window when you close it, it is switched off-screen. You can still move to it using Switch.

Editing Documents in the Windows
Each window you open is actually a separate editing screen. Use the cursor keys to move through and edit the text in each window. You can use List and Retrieve to retrieve documents into the window just as you normally would. You can also use Block and Move to cut, copy, and move information from one document to another.

Switch vs. Window
While Window lets you display two documents on-screen at once, Switch lets you open up to nine editing screens so you can keep several documents active at the same time. Unless you use Window with Switch, each document that you switch to is displayed on its own separate screen.
Using Screen in Reveal Codes
Screen has a different function when you are in Reveal Codes. Rather than splitting the normal editing screen into two separate windows, Screen lets you adjust the location of the ruler line which separates the two parts of the Reveal Codes screen.

Press Screen, then select Window (1). You are asked to enter the number of lines you want displayed in the normal editing part of the screen. You can use Up Arrow and Down Arrow to adjust the location of the ruler line and then press Return, or you can simply enter the number of lines you want to have in the normal editing part of the screen.

The Reveal Codes window size you have selected remains in place until you change it or until you exit Corel WordPerfect. You can also change the Reveal Codes window size permanently in Setup (see Edit-Screen Options).

Window Size
Entering 11 splits the standard terminal screen roughly in half, giving you 11 lines in each window.

Since a window must contain at least 2 lines, if you enter 1, Corel WordPerfect gives you 2 lines in the window. Entering 0 (zero) or any number higher than the maximum closes the window the cursor is not currently in. Entering the maximum number of lines places the tab ruler on the bottom line of the screen. Sometimes you might like to use this on-screen tab ruler to indicate where your tab settings are.

See Also: Retrieve; Switch

Word and Letter Spacing

When printing documents, you might want to increase or decrease the spacing between adjacent words and letters. Word and Letter Spacing lets you adjust this spacing.

1 Move the cursor to where you want to change the setting.
2 Press Format, then select Other (4).
   Or Select Other from the Layout menu.
3 Select Printer Functions (6), then select Word Spacing/Letter Spacing (3).
4 Select a setting for word spacing and enter any required information (see Setting Adjustments below).
5 Select a setting for letter spacing and enter any required information (see Setting Adjustments below).
6 Press Exit to exit the Printer Functions menu.
Notes

Codes
A Word and Letter Spacing code [Wrd/Ltr Spacing; word setting, letter setting] is inserted into your document at the beginning of the paragraph (see Auto Code Placement). The change is in effect from that point forward in your document.

Printer Support
Not all printers support this feature. Test this with your printer to see if it is supported. You can test this feature by following the steps above, typing text, then printing the document (see Print, Document on Screen).

Setting Adjustments
You can select from four settings for word and letter spacing. The default setting for both word spacing and letter spacing is Optimal.

- **Normal** • Select this option (1) to use the spacing that looks best according to the printer manufacturer’s opinion.

- **Optimal** • Select this option (2) to use the spacing that looks best according to Corel WordPerfect. Sometimes this setting does the same thing as selecting Normal (1), but on many printers it is different.

  For a proportionally-spaced font, this option sets the width of a space to 1/3 the point size of the font. On a mono-spaced font, this setting is the pitch.

- **Percent of Optimal** • Select this option (3) to enter a width of your own. The setting you enter is a percentage of the Optimal setting. Numbers less than 100% reduce the amount of space while numbers greater than 100% increase the amount of space. Entering 100% is exactly like selecting Optimal (2).

- **Set Pitch** • Select this option (4), then enter a pitch (characters per inch) setting to change word and/or letter spacing to an exact pitch. The pitch you specify is displayed and saved in the same manner as a Percent of Optimal setting.

  This setting does not, however, change the pitch to a specific value for all fonts. Instead, it chooses the correct Percent of Optimal setting required to obtain the desired pitch in the current font.

  If your printer cannot move the exact amount you enter, Corel WordPerfect instructs it to move as close to the amount as possible.

See Also: Kerning; Printer Functions
The ASCII characters in the following list can be used to position the cursor in a macro. The numbers indicate the corresponding screen position (see Ctrl-P under Macros, Message Display).

<table>
<thead>
<tr>
<th>Screen Position</th>
<th>ASCII Character</th>
<th>Screen Position</th>
<th>ASCII Character</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>☐</td>
<td>34</td>
<td>&quot;</td>
</tr>
<tr>
<td>2</td>
<td>☠</td>
<td>35</td>
<td>#</td>
</tr>
<tr>
<td>3</td>
<td>♀</td>
<td>36</td>
<td>$</td>
</tr>
<tr>
<td>4</td>
<td>♠</td>
<td>37</td>
<td>%</td>
</tr>
<tr>
<td>5</td>
<td>♣</td>
<td>38</td>
<td>&amp;</td>
</tr>
<tr>
<td>6</td>
<td>♦</td>
<td>39</td>
<td>'</td>
</tr>
<tr>
<td>7</td>
<td>✶</td>
<td>40</td>
<td>(</td>
</tr>
<tr>
<td>8</td>
<td>☘</td>
<td>41</td>
<td>)</td>
</tr>
<tr>
<td>9</td>
<td>○</td>
<td>42</td>
<td>*</td>
</tr>
<tr>
<td>10</td>
<td>☐</td>
<td>43</td>
<td>+</td>
</tr>
<tr>
<td>11</td>
<td>♀</td>
<td>44</td>
<td>,</td>
</tr>
<tr>
<td>12</td>
<td>♀</td>
<td>45</td>
<td>–</td>
</tr>
<tr>
<td>13</td>
<td>~</td>
<td>46</td>
<td>.</td>
</tr>
<tr>
<td>14</td>
<td>♪</td>
<td>47</td>
<td>/</td>
</tr>
<tr>
<td>15</td>
<td>♩</td>
<td>48</td>
<td>0</td>
</tr>
<tr>
<td>16</td>
<td>♦</td>
<td>49</td>
<td>1</td>
</tr>
<tr>
<td>17</td>
<td>♦</td>
<td>50</td>
<td>2</td>
</tr>
<tr>
<td>18</td>
<td></td>
<td></td>
<td>51</td>
</tr>
<tr>
<td>19</td>
<td>!</td>
<td>52</td>
<td>4</td>
</tr>
<tr>
<td>20</td>
<td>¶</td>
<td>53</td>
<td>5</td>
</tr>
<tr>
<td>21</td>
<td>§</td>
<td>54</td>
<td>6</td>
</tr>
<tr>
<td>22</td>
<td>–</td>
<td>55</td>
<td>7</td>
</tr>
<tr>
<td>23</td>
<td>†</td>
<td>56</td>
<td>8</td>
</tr>
<tr>
<td>24</td>
<td>‡</td>
<td>57</td>
<td>9</td>
</tr>
<tr>
<td>25</td>
<td>-</td>
<td>58</td>
<td>:</td>
</tr>
<tr>
<td>26</td>
<td>-</td>
<td>59</td>
<td>;</td>
</tr>
<tr>
<td>27</td>
<td>-</td>
<td>60</td>
<td>&lt;</td>
</tr>
<tr>
<td>28</td>
<td>–</td>
<td>61</td>
<td>=</td>
</tr>
<tr>
<td>29</td>
<td>–</td>
<td>62</td>
<td>&gt;</td>
</tr>
<tr>
<td>30</td>
<td>^</td>
<td>63</td>
<td>?</td>
</tr>
<tr>
<td>31</td>
<td>¥</td>
<td>64</td>
<td>@</td>
</tr>
<tr>
<td>32</td>
<td>(space)</td>
<td>65</td>
<td>A</td>
</tr>
<tr>
<td>33</td>
<td>!</td>
<td>66</td>
<td>B</td>
</tr>
<tr>
<td>Screen Position</td>
<td>ASCII Character</td>
<td>Screen Position</td>
<td>ASCII Character</td>
</tr>
<tr>
<td>-----------------</td>
<td>----------------</td>
<td>----------------</td>
<td>----------------</td>
</tr>
<tr>
<td>67</td>
<td>C</td>
<td>105</td>
<td>i</td>
</tr>
<tr>
<td>68</td>
<td>D</td>
<td>106</td>
<td>j</td>
</tr>
<tr>
<td>69</td>
<td>E</td>
<td>107</td>
<td>k</td>
</tr>
<tr>
<td>70</td>
<td>F</td>
<td>108</td>
<td>l</td>
</tr>
<tr>
<td>71</td>
<td>G</td>
<td>109</td>
<td>m</td>
</tr>
<tr>
<td>72</td>
<td>H</td>
<td>110</td>
<td>n</td>
</tr>
<tr>
<td>73</td>
<td>I</td>
<td>111</td>
<td>o</td>
</tr>
<tr>
<td>74</td>
<td>J</td>
<td>112</td>
<td>p</td>
</tr>
<tr>
<td>75</td>
<td>K</td>
<td>113</td>
<td>q</td>
</tr>
<tr>
<td>76</td>
<td>L</td>
<td>114</td>
<td>r</td>
</tr>
<tr>
<td>77</td>
<td>M</td>
<td>115</td>
<td>s</td>
</tr>
<tr>
<td>78</td>
<td>N</td>
<td>116</td>
<td>t</td>
</tr>
<tr>
<td>79</td>
<td>O</td>
<td>117</td>
<td>u</td>
</tr>
<tr>
<td>80</td>
<td>P</td>
<td>118</td>
<td>v</td>
</tr>
<tr>
<td>81</td>
<td>Q</td>
<td>119</td>
<td>w</td>
</tr>
<tr>
<td>82</td>
<td>R</td>
<td>120</td>
<td>x</td>
</tr>
<tr>
<td>83</td>
<td>S</td>
<td>121</td>
<td>y</td>
</tr>
<tr>
<td>84</td>
<td>T</td>
<td>122</td>
<td>z</td>
</tr>
<tr>
<td>85</td>
<td>U</td>
<td>123</td>
<td>{</td>
</tr>
<tr>
<td>86</td>
<td>V</td>
<td>124</td>
<td>}</td>
</tr>
<tr>
<td>87</td>
<td>W</td>
<td>125</td>
<td>}</td>
</tr>
<tr>
<td>88</td>
<td>X</td>
<td>126</td>
<td>~</td>
</tr>
<tr>
<td>89</td>
<td>Y</td>
<td>127</td>
<td>△</td>
</tr>
<tr>
<td>90</td>
<td>Z</td>
<td>128</td>
<td>Ç</td>
</tr>
<tr>
<td>91</td>
<td>[</td>
<td>129</td>
<td>ü</td>
</tr>
<tr>
<td>92</td>
<td>\</td>
<td>130</td>
<td>é</td>
</tr>
<tr>
<td>93</td>
<td>]</td>
<td>131</td>
<td>à</td>
</tr>
<tr>
<td>94</td>
<td>^</td>
<td>132</td>
<td>ä</td>
</tr>
<tr>
<td>95</td>
<td>_</td>
<td>133</td>
<td>à</td>
</tr>
<tr>
<td>96</td>
<td>`</td>
<td>134</td>
<td>à</td>
</tr>
<tr>
<td>97</td>
<td>a</td>
<td>135</td>
<td>ç</td>
</tr>
<tr>
<td>98</td>
<td>b</td>
<td>136</td>
<td>è</td>
</tr>
<tr>
<td>99</td>
<td>c</td>
<td>137</td>
<td>ê</td>
</tr>
<tr>
<td>100</td>
<td>d</td>
<td>138</td>
<td>è</td>
</tr>
<tr>
<td>101</td>
<td>e</td>
<td>139</td>
<td>ĭ</td>
</tr>
<tr>
<td>102</td>
<td>f</td>
<td>140</td>
<td>i</td>
</tr>
<tr>
<td>103</td>
<td>g</td>
<td>141</td>
<td>ì</td>
</tr>
<tr>
<td>104</td>
<td>h</td>
<td>142</td>
<td>Å</td>
</tr>
<tr>
<td>Screen Position</td>
<td>ASCII Character</td>
<td>Screen Position</td>
<td>ASCII Character</td>
</tr>
<tr>
<td>-----------------</td>
<td>-----------------</td>
<td>-----------------</td>
<td>-----------------</td>
</tr>
<tr>
<td>143</td>
<td>Å</td>
<td>181</td>
<td>¬</td>
</tr>
<tr>
<td>144</td>
<td>É</td>
<td>182</td>
<td>¬</td>
</tr>
<tr>
<td>145</td>
<td>æ</td>
<td>183</td>
<td>¬</td>
</tr>
<tr>
<td>146</td>
<td>Æ</td>
<td>184</td>
<td>¬</td>
</tr>
<tr>
<td>147</td>
<td>ô</td>
<td>185</td>
<td>¬</td>
</tr>
<tr>
<td>148</td>
<td>ö</td>
<td>186</td>
<td>¬</td>
</tr>
<tr>
<td>149</td>
<td>û</td>
<td>187</td>
<td>¬</td>
</tr>
<tr>
<td>150</td>
<td>ũ</td>
<td>188</td>
<td>¬</td>
</tr>
<tr>
<td>151</td>
<td>û</td>
<td>189</td>
<td>¬</td>
</tr>
<tr>
<td>152</td>
<td>ý</td>
<td>190</td>
<td>¬</td>
</tr>
<tr>
<td>153</td>
<td>Ö</td>
<td>191</td>
<td>¬</td>
</tr>
<tr>
<td>154</td>
<td>Ü</td>
<td>192</td>
<td>¬</td>
</tr>
<tr>
<td>155</td>
<td>ø</td>
<td>193</td>
<td>¬</td>
</tr>
<tr>
<td>156</td>
<td>ë</td>
<td>194</td>
<td>¬</td>
</tr>
<tr>
<td>157</td>
<td>¥</td>
<td>195</td>
<td>¬</td>
</tr>
<tr>
<td>158</td>
<td>Ñ</td>
<td>196</td>
<td>¬</td>
</tr>
<tr>
<td>159</td>
<td>$</td>
<td>197</td>
<td>¬</td>
</tr>
<tr>
<td>160</td>
<td>á</td>
<td>198</td>
<td>¬</td>
</tr>
<tr>
<td>161</td>
<td>ì</td>
<td>199</td>
<td>¬</td>
</tr>
<tr>
<td>162</td>
<td>ó</td>
<td>200</td>
<td>¬</td>
</tr>
<tr>
<td>163</td>
<td>û</td>
<td>201</td>
<td>¬</td>
</tr>
<tr>
<td>164</td>
<td>ñ</td>
<td>202</td>
<td>¬</td>
</tr>
<tr>
<td>165</td>
<td>Ñ</td>
<td>203</td>
<td>¬</td>
</tr>
<tr>
<td>166</td>
<td>a</td>
<td>204</td>
<td>¬</td>
</tr>
<tr>
<td>167</td>
<td>ò</td>
<td>205</td>
<td>¬</td>
</tr>
<tr>
<td>168</td>
<td>i</td>
<td>206</td>
<td>¬</td>
</tr>
<tr>
<td>169</td>
<td>r</td>
<td>207</td>
<td>¬</td>
</tr>
<tr>
<td>170</td>
<td>¬</td>
<td>208</td>
<td>¬</td>
</tr>
<tr>
<td>171</td>
<td>½</td>
<td>209</td>
<td>¬</td>
</tr>
<tr>
<td>172</td>
<td>¼</td>
<td>210</td>
<td>¬</td>
</tr>
<tr>
<td>173</td>
<td>i</td>
<td>211</td>
<td>¬</td>
</tr>
<tr>
<td>174</td>
<td>«</td>
<td>212</td>
<td>¬</td>
</tr>
<tr>
<td>175</td>
<td>»</td>
<td>213</td>
<td>¬</td>
</tr>
<tr>
<td>176</td>
<td>·</td>
<td>214</td>
<td>¬</td>
</tr>
<tr>
<td>177</td>
<td>·</td>
<td>215</td>
<td>¬</td>
</tr>
<tr>
<td>178</td>
<td>·</td>
<td>216</td>
<td>¬</td>
</tr>
<tr>
<td>179</td>
<td></td>
<td></td>
<td>217</td>
</tr>
<tr>
<td>180</td>
<td></td>
<td></td>
<td>218</td>
</tr>
<tr>
<td>Screen Position</td>
<td>ASCII Character</td>
<td></td>
<td></td>
</tr>
<tr>
<td>-----------------</td>
<td>----------------</td>
<td></td>
<td></td>
</tr>
<tr>
<td>219</td>
<td>¦</td>
<td></td>
<td></td>
</tr>
<tr>
<td>220</td>
<td>¨</td>
<td></td>
<td></td>
</tr>
<tr>
<td>221</td>
<td>¦</td>
<td></td>
<td></td>
</tr>
<tr>
<td>222</td>
<td>¦</td>
<td></td>
<td></td>
</tr>
<tr>
<td>223</td>
<td>α</td>
<td></td>
<td></td>
</tr>
<tr>
<td>224</td>
<td>β</td>
<td></td>
<td></td>
</tr>
<tr>
<td>225</td>
<td>ı</td>
<td></td>
<td></td>
</tr>
<tr>
<td>226</td>
<td>π</td>
<td></td>
<td></td>
</tr>
<tr>
<td>227</td>
<td>Σ</td>
<td></td>
<td></td>
</tr>
<tr>
<td>228</td>
<td>σ</td>
<td></td>
<td></td>
</tr>
<tr>
<td>229</td>
<td>μ</td>
<td></td>
<td></td>
</tr>
<tr>
<td>230</td>
<td>τ</td>
<td></td>
<td></td>
</tr>
<tr>
<td>231</td>
<td>φ</td>
<td></td>
<td></td>
</tr>
<tr>
<td>232</td>
<td>Θ</td>
<td></td>
<td></td>
</tr>
<tr>
<td>233</td>
<td>Ω</td>
<td></td>
<td></td>
</tr>
<tr>
<td>234</td>
<td>δ</td>
<td></td>
<td></td>
</tr>
<tr>
<td>235</td>
<td>≠</td>
<td></td>
<td></td>
</tr>
<tr>
<td>236</td>
<td>ñ</td>
<td></td>
<td></td>
</tr>
<tr>
<td>237</td>
<td>ε</td>
<td></td>
<td></td>
</tr>
<tr>
<td>238</td>
<td>∩</td>
<td></td>
<td></td>
</tr>
<tr>
<td>239</td>
<td>±</td>
<td></td>
<td></td>
</tr>
<tr>
<td>240</td>
<td>≤</td>
<td></td>
<td></td>
</tr>
<tr>
<td>241</td>
<td>≥</td>
<td></td>
<td></td>
</tr>
<tr>
<td>242</td>
<td>≤</td>
<td></td>
<td></td>
</tr>
<tr>
<td>243</td>
<td>∫</td>
<td></td>
<td></td>
</tr>
<tr>
<td>244</td>
<td>÷</td>
<td></td>
<td></td>
</tr>
<tr>
<td>245</td>
<td>≈</td>
<td></td>
<td></td>
</tr>
<tr>
<td>246</td>
<td>°</td>
<td></td>
<td></td>
</tr>
<tr>
<td>247</td>
<td>•</td>
<td></td>
<td></td>
</tr>
<tr>
<td>248</td>
<td>†</td>
<td></td>
<td></td>
</tr>
<tr>
<td>249</td>
<td>‡</td>
<td></td>
<td></td>
</tr>
<tr>
<td>250</td>
<td>√</td>
<td></td>
<td></td>
</tr>
<tr>
<td>251</td>
<td>ⅱ</td>
<td></td>
<td></td>
</tr>
<tr>
<td>252</td>
<td>ⅱ</td>
<td></td>
<td></td>
</tr>
<tr>
<td>253</td>
<td>ⅱ</td>
<td></td>
<td></td>
</tr>
<tr>
<td>254</td>
<td>ⅱ</td>
<td></td>
<td></td>
</tr>
<tr>
<td>255</td>
<td>ⅱ</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
The following list shows codes as they appear in Reveal Codes. In Reveal Codes, *On* codes for the attribute features appear in uppercase letters, while *Off* codes appear in lowercase letters, as in this example: [BOLD][bold].

<table>
<thead>
<tr>
<th>Code</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>[ ]</td>
<td>Hard Space</td>
</tr>
<tr>
<td>[–]</td>
<td>Hyphen Character</td>
</tr>
<tr>
<td>–</td>
<td>Soft Hyphen</td>
</tr>
<tr>
<td>[/]</td>
<td>Cancel Hyphenation</td>
</tr>
<tr>
<td>[Adv]</td>
<td>Advance</td>
</tr>
<tr>
<td>[Bline]</td>
<td>Baseline Placement</td>
</tr>
<tr>
<td>[Block]</td>
<td>Beginning of Block</td>
</tr>
<tr>
<td>[Block Pro]</td>
<td>Block Protection</td>
</tr>
<tr>
<td>[Bold]</td>
<td>Bold</td>
</tr>
<tr>
<td>[Box Num]</td>
<td>Caption in Graphics Box</td>
</tr>
<tr>
<td>[Brdr Opt]</td>
<td>Border Options</td>
</tr>
<tr>
<td>[Cell]</td>
<td>Table Cell</td>
</tr>
<tr>
<td>[Center]</td>
<td>Center</td>
</tr>
<tr>
<td>[Center Pg]</td>
<td>Center Page Top to Bottom</td>
</tr>
<tr>
<td>[Cndl EOP]</td>
<td>Conditional End of Page</td>
</tr>
<tr>
<td>[Cntr Tab]</td>
<td>Centered Tab</td>
</tr>
<tr>
<td>[CNTR TAB]</td>
<td>Hard Centered Tab</td>
</tr>
<tr>
<td>[Col Def]</td>
<td>Column Definition</td>
</tr>
<tr>
<td>[Col Off]</td>
<td>End of Text Columns</td>
</tr>
<tr>
<td>[Col On]</td>
<td>Beginning of Text Columns</td>
</tr>
<tr>
<td>[Color]</td>
<td>Print Color</td>
</tr>
<tr>
<td>[Comment]</td>
<td>Document Comment</td>
</tr>
<tr>
<td>[Date]</td>
<td>Date/Time Function</td>
</tr>
<tr>
<td>[DbI Und]</td>
<td>Double Underline</td>
</tr>
<tr>
<td>[Dec Tab]</td>
<td>Decimal Aligned Tab</td>
</tr>
<tr>
<td>[DEC TAB]</td>
<td>Hard Decimal Aligned Tab</td>
</tr>
<tr>
<td>[Decml/Algn Char]</td>
<td>Decimal Character/Thousands Separator</td>
</tr>
<tr>
<td>[Def Mark:Index]</td>
<td>Index Definition</td>
</tr>
<tr>
<td>[Def Mark:List]</td>
<td>List Definition</td>
</tr>
<tr>
<td>[Def Mark:ToA]</td>
<td>Table of Authorities Definition</td>
</tr>
<tr>
<td>[Def Mark:ToC]</td>
<td>Table of Contents Definition</td>
</tr>
<tr>
<td>[Dorm HRt]</td>
<td>Dormant Hard Return</td>
</tr>
<tr>
<td>[DSRt]</td>
<td>Deletable Soft Return</td>
</tr>
<tr>
<td>[End Def]</td>
<td>End of Index, List, or Table of Contents</td>
</tr>
<tr>
<td>[End Mark]</td>
<td>End of Marked Text</td>
</tr>
<tr>
<td>[End Opt]</td>
<td>Endnote Options</td>
</tr>
<tr>
<td>[Endnote]</td>
<td>Endnote</td>
</tr>
<tr>
<td>[Endnote Place]</td>
<td>Endnote Placement</td>
</tr>
<tr>
<td>[Equ Box]</td>
<td>Equation Box</td>
</tr>
<tr>
<td>[Equ Opt]</td>
<td>Equation Box Options</td>
</tr>
<tr>
<td>[Ext Large]</td>
<td>Extra Large Print</td>
</tr>
<tr>
<td>Code</td>
<td>Definition</td>
</tr>
<tr>
<td>--------------</td>
<td>-----------------------------------</td>
</tr>
<tr>
<td>[Fig Box]</td>
<td>Figure Box</td>
</tr>
<tr>
<td>[Fig Opt]</td>
<td>Figure Box Options</td>
</tr>
<tr>
<td>[Fine]</td>
<td>Fine Print</td>
</tr>
<tr>
<td>[Flsh Rgt]</td>
<td>Flush Right</td>
</tr>
<tr>
<td>[Font]</td>
<td>Base Font</td>
</tr>
<tr>
<td>[Footer]</td>
<td>Footer</td>
</tr>
<tr>
<td>[Footnote]</td>
<td>Footnote</td>
</tr>
<tr>
<td>[Force]</td>
<td>Force Odd/Even Page</td>
</tr>
<tr>
<td>[Ftn Opt]</td>
<td>Footnote Options</td>
</tr>
<tr>
<td>[Header]</td>
<td>Header</td>
</tr>
<tr>
<td>[HLine]</td>
<td>Horizontal Line</td>
</tr>
<tr>
<td>[HPg]</td>
<td>Hard Page Break</td>
</tr>
<tr>
<td>[Hrd Row]</td>
<td>Hard Row</td>
</tr>
<tr>
<td>[HRet]</td>
<td>Hard Return</td>
</tr>
<tr>
<td>[HRt–SPg]</td>
<td>Hard Return–Soft Page</td>
</tr>
<tr>
<td>[Hyph Off]</td>
<td>Hyphenation Off</td>
</tr>
<tr>
<td>[Hyph On]</td>
<td>Hyphenation On</td>
</tr>
<tr>
<td>[HZone]</td>
<td>Hyphenation Zone</td>
</tr>
<tr>
<td>[-Indent]</td>
<td>Indent</td>
</tr>
<tr>
<td>[-Indent–]</td>
<td>Left/Right Indent</td>
</tr>
<tr>
<td>[Index]</td>
<td>Index Entry</td>
</tr>
<tr>
<td>[Insert Pg Num]</td>
<td>Insert Page Number</td>
</tr>
<tr>
<td>[ISRt]</td>
<td>Invisible Soft Return</td>
</tr>
<tr>
<td>[Italc]</td>
<td>Italics</td>
</tr>
<tr>
<td>[Just]</td>
<td>Justification</td>
</tr>
<tr>
<td>[Just Lim]</td>
<td>Word Spacing Justification Limits</td>
</tr>
<tr>
<td>[Just Off]</td>
<td>Justification Off (WP 5.0)</td>
</tr>
<tr>
<td>[Just On]</td>
<td>Justification On (WP 5.0)</td>
</tr>
<tr>
<td>[Kern]</td>
<td>Kerning</td>
</tr>
<tr>
<td>[L/R Mar]</td>
<td>Left and Right Margins</td>
</tr>
<tr>
<td>[Lang]</td>
<td>Language</td>
</tr>
<tr>
<td>[Large]</td>
<td>Large Print</td>
</tr>
<tr>
<td>[Leading Adj]</td>
<td>Leading Adjustment</td>
</tr>
<tr>
<td>[Link]</td>
<td>Spreadsheet Link</td>
</tr>
<tr>
<td>[Link End]</td>
<td>Spreadsheet Link End</td>
</tr>
<tr>
<td>[Ln Height]</td>
<td>Line Height</td>
</tr>
<tr>
<td>[Ln Num]</td>
<td>Line Numbering</td>
</tr>
<tr>
<td>[Ln Spacing]</td>
<td>Line Spacing</td>
</tr>
<tr>
<td>[-Mar Rel]</td>
<td>Left Margin Release</td>
</tr>
<tr>
<td>[Mark:List]</td>
<td>List Entry</td>
</tr>
<tr>
<td>[Mark:ToC]</td>
<td>Table of Contents Entry</td>
</tr>
<tr>
<td>[Math Def]</td>
<td>Definition of Math Columns</td>
</tr>
<tr>
<td>[Math Off]</td>
<td>End of Math</td>
</tr>
<tr>
<td>[Math On]</td>
<td>Beginning of Math</td>
</tr>
<tr>
<td>![]</td>
<td>Formula Calculation</td>
</tr>
<tr>
<td>[t]</td>
<td>Subtotal Entry</td>
</tr>
<tr>
<td>[+</td>
<td>Calculate Subtotal</td>
</tr>
</tbody>
</table>

546  Appendix B: Codes
<table>
<thead>
<tr>
<th>Code</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>[T]</td>
<td>Total Entry</td>
</tr>
<tr>
<td>[=]</td>
<td>Calculate Total</td>
</tr>
<tr>
<td>[*]</td>
<td>Calculate Grand Total</td>
</tr>
<tr>
<td>[N]</td>
<td>Negate</td>
</tr>
<tr>
<td>[New End Num]</td>
<td>New Endnote Number</td>
</tr>
<tr>
<td>[New Equ Num]</td>
<td>New Equation Box Number</td>
</tr>
<tr>
<td>[New Fig Num]</td>
<td>New Figure Box Number</td>
</tr>
<tr>
<td>[New Ftn Num]</td>
<td>New Footnote Number</td>
</tr>
<tr>
<td>[New Tbl Num]</td>
<td>New Table Number</td>
</tr>
<tr>
<td>[New Txt Num]</td>
<td>New Text Box Number</td>
</tr>
<tr>
<td>[New Usr Num]</td>
<td>New User Box Number</td>
</tr>
<tr>
<td>[Note Num]</td>
<td>Footnote/Endnote Number</td>
</tr>
<tr>
<td>[Open Style]</td>
<td>Open Style</td>
</tr>
<tr>
<td>[Outline Lvl:Open Style]</td>
<td>Open Outline Style</td>
</tr>
<tr>
<td>[Outline Lvl:Style On]</td>
<td>Paired Outline Style On</td>
</tr>
<tr>
<td>[Outline Lvl:Style Off]</td>
<td>Paired Outline Style Off</td>
</tr>
<tr>
<td>[Outline Off]</td>
<td>Outline Off</td>
</tr>
<tr>
<td>[Outline On]</td>
<td>Outline On</td>
</tr>
<tr>
<td>[Outln]</td>
<td>Outline (Attribute)</td>
</tr>
<tr>
<td>[Ovrstk]</td>
<td>Overstrike</td>
</tr>
<tr>
<td>[Paper Sz/Typ]</td>
<td>Paper Size and Type</td>
</tr>
<tr>
<td>[Par Num]</td>
<td>Paragraph Number</td>
</tr>
<tr>
<td>[Par Num Def]</td>
<td>Paragraph Numbering Definition</td>
</tr>
<tr>
<td>[Pg Num]</td>
<td>New Page Number</td>
</tr>
<tr>
<td>[Pg Num Style]</td>
<td>Page Number Style</td>
</tr>
<tr>
<td>[Pg Numbering]</td>
<td>Page Numbering</td>
</tr>
<tr>
<td>[Ptr Cmd]</td>
<td>Printer Command</td>
</tr>
<tr>
<td>[Redln]</td>
<td>Redline</td>
</tr>
<tr>
<td>[Ref]</td>
<td>Reference (Cross-Reference)</td>
</tr>
<tr>
<td>[Rgt Tab]</td>
<td>Right Aligned Tab</td>
</tr>
<tr>
<td>[RGT TAB]</td>
<td>Hard Right Aligned Tab</td>
</tr>
<tr>
<td>[Row]</td>
<td>Table Row</td>
</tr>
<tr>
<td>[Shadw]</td>
<td>Shadow</td>
</tr>
<tr>
<td>[Sm Cap]</td>
<td>Small Caps</td>
</tr>
<tr>
<td>[Small]</td>
<td>Small Print</td>
</tr>
<tr>
<td>[SPg]</td>
<td>Soft Page Break</td>
</tr>
<tr>
<td>[SRT]</td>
<td>Soft Return</td>
</tr>
<tr>
<td>[StkOut]</td>
<td>Strikeout</td>
</tr>
<tr>
<td>[Style Off]</td>
<td>Style Off</td>
</tr>
<tr>
<td>[Style On]</td>
<td>Style On</td>
</tr>
<tr>
<td>[Subdoc]</td>
<td>Subdocument (Master Documents)</td>
</tr>
<tr>
<td>[Subdoc Start]</td>
<td>Beginning of Subdocument</td>
</tr>
<tr>
<td>[Subdoc End]</td>
<td>End of Subdocument</td>
</tr>
<tr>
<td>[Subscpt]</td>
<td>Subscript</td>
</tr>
<tr>
<td>[Suppress]</td>
<td>Suppress Page Format</td>
</tr>
<tr>
<td>[Suprscpt]</td>
<td>Superscript</td>
</tr>
<tr>
<td>[T/B Mar]</td>
<td>Top and Bottom Margins</td>
</tr>
<tr>
<td>Code</td>
<td>Definition</td>
</tr>
<tr>
<td>-------------</td>
<td>-----------------------------------------</td>
</tr>
<tr>
<td>[Tab]</td>
<td>Left-Aligned Tab</td>
</tr>
<tr>
<td>[TAB]</td>
<td>Hard Left-Aligned Tab</td>
</tr>
<tr>
<td>[Tab Set]</td>
<td>Tab Set</td>
</tr>
<tr>
<td>[Target]</td>
<td>Target (Cross-Reference)</td>
</tr>
<tr>
<td>[Tbl Box]</td>
<td>Table Box</td>
</tr>
<tr>
<td>[Tbl Def]</td>
<td>Table Definition</td>
</tr>
<tr>
<td>[Tbl Off]</td>
<td>Table Off</td>
</tr>
<tr>
<td>[Tbl Opt]</td>
<td>Table Box Options</td>
</tr>
<tr>
<td>[Text Box]</td>
<td>Text Box</td>
</tr>
<tr>
<td>[ToA]</td>
<td>Table of Authorities Entry</td>
</tr>
<tr>
<td>[Txt Opt]</td>
<td>Text Box Options</td>
</tr>
<tr>
<td>[Und]</td>
<td>Underlining</td>
</tr>
<tr>
<td>[Undrln]</td>
<td>Underline Spaces/Tabs</td>
</tr>
<tr>
<td>[Unknown]</td>
<td>Non-Corel WordPerfect 5.1 Code</td>
</tr>
<tr>
<td>[Usr Box]</td>
<td>User-Defined Box</td>
</tr>
<tr>
<td>[Usr Opt]</td>
<td>User-Defined Box Options</td>
</tr>
<tr>
<td>[VLine]</td>
<td>Vertical Line</td>
</tr>
<tr>
<td>[Vry Large]</td>
<td>Very Large Print</td>
</tr>
<tr>
<td>[Wrd/Ltr Spacing]</td>
<td>Word and Letter Spacing</td>
</tr>
</tbody>
</table>
Appendix C: Environment Variables

An environment variable is a setting that affects the way a program runs on your system.

This appendix explains how to set an environment variable and the environment variables you can use with Corel WordPerfect.

Important: If you are also using WordPerfect Corporation’s WordPerfect 4.2 or 5.0, use WPTERM8 or WPLANG8 to avoid conflicts.

An environment variable is set from the system shell prompt, the .profile, .schrc, or .login file. You cannot set it from the Shell option in Corel WordPerfect.

The method for setting an environment variable depends on the type of system you are using. To set an environment variable on your system, follow the instructions below, under C Shell or Bourne Shell.

C Shell
To set an environment variable if you are using the C Shell,

1 Enter `setenv <VARIABLE> <parameter>` at the shell prompt.

The `<VARIABLE>` represents the environment variable (such as WPLANG or COLUMNS) you want to set, which must be entered in uppercase.

The `<parameter>` is a number or word that specifies the setting for the variable. For example, the parameter for the COLUMNS variable might be a number such as 132. The parameter for WPLANG might be a two-letter language code, such as ES (for Spanish).

Bourne Shell
To set an environment variable if you are using the Bourne shell,

1 Enter `<VARIABLE>=<parameter>` at the shell prompt.

The `<VARIABLE>` represents the environment variable (such as WPTERM) you want to set, which must be entered in uppercase.

The `<parameter>` is a number or word that specifies the setting for the variable.

2 Enter `export <VARIABLE>` at the shell prompt to complete the command sequence.

Notes

Environment Variables
When you add the setting for an environment variable to your .cshrc file, .profile file, or .login file, the variable will be in effect each time you use Corel WordPerfect.

For many of the Corel WordPerfect environment variables, there are corresponding options that can be used if you want the environment variable in effect for only one session of Corel WordPerfect.
**WPTERM**

The WPTERM variable determines what terminal you are using. Your system administrator should have set WPTERM during the Corel WordPerfect installation by adding it to your .cshrc file, .login file or .profile file. WPTERM is set to the parameter `<terminal name>`.

A list of supported terminals and their parameters is part of the trs.readme file in the shlib directory. If you do not have access to this file, ask your system administrator.

Using the startup option `-t`, you can set the terminal environment for only one session of Corel WordPerfect. The `-t` setting overrides any WPTERM setting for that session. It uses the same parameter `<terminal name>` to set WPTERM (see Appendix O: Startup Options).

**WPLANG**

The WPLANG variable starts a version of Corel WordPerfect in the language specified by the parameter. The international language versions of Corel WordPerfect provide menus, learning files, and the spelling dictionary in different languages. To use a specific language version of Corel WordPerfect, your system must have the language module for that language.

To find out what languages are available for your terminal, and what language modules have been purchased for your system, contact your system administrator.

WPLANG is set to a `<language code>` parameter. The language code is two letters that represent the desired language. For example, the code for Swedish is `sv`, and the code for Italian is `it` (see Language).

If you intend to regularly use a specific language version, we suggest you set WPLANG in your .cshrc file, .profile file, or .login file.

If you want to use a specific language for only one session of Corel WordPerfect, use the `-l` startup option when you start that session. The `-l` option uses the same parameter `<language code>` as WPLANG, and overrides any previous WPLANG setting for that session (see Appendix O: Startup Options).

**ROWS**

The ROWS environment variable sets the number of rows in the Corel WordPerfect window. This option is useful if you are using a windowing facility.

The default number of rows is created by the terminal definition, which will vary between terminals. The default is 24 rows on most terminals. You can set the number of rows to less than 24, but your screen will be sized to 24 lines.

To set the number of rows each time you use Corel WordPerfect, add the ROWS setting to the .cshrc file, .profile file, or .login file.

The startup option `-r` has the same effect as ROWS, but its effect is limited to the session of Corel WordPerfect you are starting (see Appendix O: Startup Options).
**LINES**
The LINES environment variable functions the same as the ROWS variable.

This option sets the number of lines (or rows) in the window to the number you specify in the parameter.

To set the number of lines each time you use Corel WordPerfect, add the LINES or ROWS setting to your .cshrc file, .profile file, or .login file. You can use the -r startup option to set the number of lines for only one session of Corel WordPerfect.

**COLUMNS**
The COLUMNS environment variable sets the number of columns in the Window.

This option is useful if you are using a windowing facility, or if you can change to a mode that uses a different number of columns (such as 132 column mode).

The default number of columns is created by the terminal definition, which will vary between terminals. The default on most terminals is 80 columns.

To set the number of columns each time you use Corel WordPerfect, add the COLUMNS setting to your .cshrc file, .profile file, or .login file.

The startup option -c has the same effect as COLUMNS, but its effect is limited to the session of Corel WordPerfect you are starting (see Appendix O: Startup Options).
Appendix D: Equation Palette

The following lists show the commands and symbols available from the Equation Palette in the Equation Editor. There are also other commands and symbols that are not listed on the Palette that are available for use in the Equation Editor. See Equations, Commands and Symbols for information on these unlisted items, and information on using those items listed below. See Equations, Commands Syntax for descriptions of the commands listed under the Commands menu.

The first column in each list below contains the command or symbol as it is listed on the Palette. Other columns contain other information displayed on the status line in the Equation Editor about the particular command or symbol.

In all of the lists except Arrows, there is a column labeled Keyword. When a keyword is available, you can type in the word or symbol from the keyboard or retrieve it from the Palette.

If no keyword is available, you must retrieve the word or symbol from the Palette. To retrieve a word or symbol from the Palette, press List to switch to the Palette, press Page Up or Page Down to select the appropriate menu, highlight the item, then press Return to insert the item into your equation.

In cases where there is both a symbol and a corresponding keyword (for example, Σ and SUM), pressing Enter will put the keyword (SUM) in your equation in the Editing window. If you prefer to have the symbol (Σ), press Hard Page. This only affects what is shown in the Editing window. In both cases, when you display or print the equation, the appropriate symbol (Σ) will be displayed or printed.

Many symbols are in the Corel WordPerfect character sets. You can retrieve any of these symbols using Compose.

**Arrows**

The Arrows menu contains a variety of arrows and several hollow and solid figures such as triangles, squares, and circles. There are no keywords for this menu, but each symbol can be entered using Compose.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>←</td>
<td>Left Arrow</td>
</tr>
<tr>
<td>→</td>
<td>Right Arrow</td>
</tr>
<tr>
<td>↑</td>
<td>Up Arrow</td>
</tr>
<tr>
<td>↓</td>
<td>Down Arrow</td>
</tr>
<tr>
<td>←→</td>
<td>Left &amp; Right Arrow</td>
</tr>
<tr>
<td>↑↓</td>
<td>Up &amp; Down Arrow</td>
</tr>
<tr>
<td>⇓</td>
<td>Two Left Arrows</td>
</tr>
<tr>
<td>→⇒</td>
<td>Two Right Arrows</td>
</tr>
<tr>
<td>⇓←</td>
<td>Left &amp; Right Arrows</td>
</tr>
<tr>
<td>⇓→</td>
<td>Right &amp; Left Arrows</td>
</tr>
<tr>
<td>←–</td>
<td>Double Left Arrow</td>
</tr>
<tr>
<td>⇒→</td>
<td>Double Right Arrow</td>
</tr>
<tr>
<td>⇑</td>
<td>Double Up Arrow</td>
</tr>
<tr>
<td>⇓→</td>
<td>Double Down Arrow</td>
</tr>
<tr>
<td>Symbol</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>------------------------------------</td>
</tr>
<tr>
<td>⇔</td>
<td>Double Left &amp; Right Arrow</td>
</tr>
<tr>
<td>⇐</td>
<td>Double Up &amp; Down Arrow</td>
</tr>
<tr>
<td>↗</td>
<td>North East Arrow</td>
</tr>
<tr>
<td>↘</td>
<td>South East Arrow</td>
</tr>
<tr>
<td>↘</td>
<td>South West Arrow</td>
</tr>
<tr>
<td>↗</td>
<td>North West Arrow</td>
</tr>
<tr>
<td>↘</td>
<td>Curly Right Arrow</td>
</tr>
<tr>
<td>←</td>
<td>Left Harpoon Up</td>
</tr>
<tr>
<td>←</td>
<td>Left Harpoon Down</td>
</tr>
<tr>
<td>→</td>
<td>Right Harpoon Up</td>
</tr>
<tr>
<td>→</td>
<td>Right Harpoon Down</td>
</tr>
<tr>
<td>⇆</td>
<td>Left &amp; Right Harpoons</td>
</tr>
<tr>
<td>↑</td>
<td>Right &amp; Left Harpoons</td>
</tr>
<tr>
<td>↑</td>
<td>Up Harpoon Left</td>
</tr>
<tr>
<td>↑</td>
<td>Up Harpoon Right</td>
</tr>
<tr>
<td>↓</td>
<td>Down Harpoon Left</td>
</tr>
<tr>
<td>↓</td>
<td>Down Harpoon Right</td>
</tr>
<tr>
<td>←</td>
<td>Hook Left Arrow</td>
</tr>
<tr>
<td>→</td>
<td>Hook Right Arrow</td>
</tr>
<tr>
<td>→</td>
<td>Maps To</td>
</tr>
<tr>
<td>▼</td>
<td>Triangle Left</td>
</tr>
<tr>
<td>▼</td>
<td>Triangle Right</td>
</tr>
<tr>
<td>▲</td>
<td>Triangle Up</td>
</tr>
<tr>
<td>▼</td>
<td>Triangle Down</td>
</tr>
<tr>
<td>▲</td>
<td>Small Triangle Left</td>
</tr>
<tr>
<td>▲</td>
<td>Small Triangle Right</td>
</tr>
<tr>
<td>▲</td>
<td>Big Triangle Up</td>
</tr>
<tr>
<td>▼</td>
<td>Big Triangle Down</td>
</tr>
<tr>
<td>*</td>
<td>Solid Triangle Left</td>
</tr>
<tr>
<td>*</td>
<td>Solid Triangle Right</td>
</tr>
<tr>
<td>▲</td>
<td>Solid Triangle Up</td>
</tr>
<tr>
<td>▼</td>
<td>Solid Triangle Down</td>
</tr>
<tr>
<td>▲</td>
<td>Defined As</td>
</tr>
<tr>
<td>≡</td>
<td>Corresponds To</td>
</tr>
<tr>
<td>≡</td>
<td>Bowtie</td>
</tr>
<tr>
<td>★</td>
<td>Solid Star</td>
</tr>
<tr>
<td>★</td>
<td>Big Solid Star</td>
</tr>
<tr>
<td>◇</td>
<td>Diamond</td>
</tr>
<tr>
<td>◇</td>
<td>Solid Diamond</td>
</tr>
<tr>
<td>◇</td>
<td>Hollow Diamond</td>
</tr>
<tr>
<td>◀</td>
<td>Big Circle</td>
</tr>
<tr>
<td>◀</td>
<td>Circle</td>
</tr>
<tr>
<td>◀</td>
<td>Small Circle</td>
</tr>
<tr>
<td>◀</td>
<td>Small Solid Circle</td>
</tr>
<tr>
<td>☐</td>
<td>Square</td>
</tr>
<tr>
<td>☐</td>
<td>Solid Square</td>
</tr>
</tbody>
</table>
**Commands**

The following are keywords that the Equation Editor recognizes as commands. Most require the use of a specific syntax when entering the command (see *Equations, Commands Syntax*). All have some formatting function, such as drawing a line in the equation or arranging variables in the equation. All commands can be typed from the keyboard and can be in either uppercase or lowercase.

<table>
<thead>
<tr>
<th>Keyword</th>
<th>Function</th>
<th>Syntax</th>
</tr>
</thead>
<tbody>
<tr>
<td>OVER</td>
<td>Fraction</td>
<td>x OVER y</td>
</tr>
<tr>
<td>SUP or ^</td>
<td>Superscript</td>
<td>x SUP y or x^y</td>
</tr>
<tr>
<td>SUB or _</td>
<td>Subscript</td>
<td>x SUB y or x_y</td>
</tr>
<tr>
<td>SQRT</td>
<td>Square root</td>
<td>SQRT x</td>
</tr>
<tr>
<td>NROOT</td>
<td>Nth root</td>
<td>NROOT n x</td>
</tr>
<tr>
<td>FROM</td>
<td>Limits</td>
<td>x FROM y TO z</td>
</tr>
<tr>
<td>TO</td>
<td>Limits</td>
<td>x FROM y TO z</td>
</tr>
<tr>
<td>LEFT</td>
<td>Left delimiter</td>
<td>LEFT char</td>
</tr>
<tr>
<td>RIGHT</td>
<td>Right delimiter</td>
<td>RIGHT char</td>
</tr>
<tr>
<td>SCALESYM</td>
<td>Scales symbols, numbers, or text</td>
<td>SCALESYM n symbol</td>
</tr>
<tr>
<td>STACK</td>
<td>Vertical Stack</td>
<td>STACK {x#y}</td>
</tr>
<tr>
<td>STACKALIGN</td>
<td>Vertical Stack with character alignment</td>
<td>STACKALIGN {x&amp;y # a&amp;b}</td>
</tr>
<tr>
<td>MATRIX</td>
<td>Matrix</td>
<td>MATRIX {x&amp;y # a&amp;b}</td>
</tr>
<tr>
<td>FUNC</td>
<td>User Function</td>
<td>FUNC name</td>
</tr>
<tr>
<td>UNDERLINE</td>
<td>Underline</td>
<td>UNDERLINE {x+y}</td>
</tr>
<tr>
<td>OVERLINE</td>
<td>Overline</td>
<td>OVERLINE {x+y}</td>
</tr>
<tr>
<td>{}</td>
<td>Start group</td>
<td>{x+2}</td>
</tr>
<tr>
<td>{}</td>
<td>End group</td>
<td>{x+2}</td>
</tr>
<tr>
<td>HORZ</td>
<td>Horizontal move</td>
<td>HORZ n</td>
</tr>
<tr>
<td>VERT</td>
<td>Vertical move</td>
<td>VERT n</td>
</tr>
<tr>
<td>`</td>
<td>Normal space</td>
<td>x˜y</td>
</tr>
<tr>
<td>`'</td>
<td>Thin space (¼ normal space)</td>
<td>x'y</td>
</tr>
<tr>
<td>BINOM</td>
<td>Binomial</td>
<td>BINOM x y</td>
</tr>
<tr>
<td>&amp;</td>
<td>Column separator</td>
<td>x &amp; y</td>
</tr>
<tr>
<td>#</td>
<td>Row separator</td>
<td>x # y</td>
</tr>
<tr>
<td>MATFORM</td>
<td>Matrix column format</td>
<td>MATFORM {ALIGNx &amp; ALIGNx &amp;...&amp; ALIGNx}</td>
</tr>
<tr>
<td>ALIGNL</td>
<td>Align left</td>
<td>ALIGNL x</td>
</tr>
<tr>
<td>ALIGNR</td>
<td>Align right</td>
<td>ALIGNR x</td>
</tr>
</tbody>
</table>
### Functions

The following commands are recognized as mathematical functions by the Equation Editor. These function names will be formatted in the base font (non-italic). All functions can be typed from the keyboard and retain the case in which they are entered.

<table>
<thead>
<tr>
<th>Keyword</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>cos</td>
<td>Cosine</td>
</tr>
<tr>
<td>sin</td>
<td>Sine</td>
</tr>
<tr>
<td>tan</td>
<td>Tangent</td>
</tr>
<tr>
<td>arccos</td>
<td>Arc cosine</td>
</tr>
<tr>
<td>arccsc</td>
<td>Arc cosecant</td>
</tr>
<tr>
<td>arctan</td>
<td>Arc tangent</td>
</tr>
<tr>
<td>cosh</td>
<td>Hyperbolic cosine</td>
</tr>
<tr>
<td>sinh</td>
<td>Hyperbolic sine</td>
</tr>
<tr>
<td>tanh</td>
<td>Hyperbolic tangent</td>
</tr>
<tr>
<td>cot</td>
<td>Cotangent</td>
</tr>
<tr>
<td>coth</td>
<td>Hyperbolic cotangent</td>
</tr>
<tr>
<td>sec</td>
<td>Secant</td>
</tr>
<tr>
<td>cosec</td>
<td>Cosecant</td>
</tr>
<tr>
<td>exp</td>
<td>Exponent</td>
</tr>
<tr>
<td>log</td>
<td>Logarithm</td>
</tr>
<tr>
<td>ln</td>
<td>Natural logarithm</td>
</tr>
<tr>
<td>lim</td>
<td>Limit</td>
</tr>
<tr>
<td>liminf</td>
<td>Limit inferior</td>
</tr>
<tr>
<td>limsup</td>
<td>Limit superior</td>
</tr>
<tr>
<td>min</td>
<td>Minimum</td>
</tr>
<tr>
<td>max</td>
<td>Maximum</td>
</tr>
<tr>
<td>gcd</td>
<td>Greatest common denominator</td>
</tr>
<tr>
<td>arc</td>
<td>Arc function</td>
</tr>
<tr>
<td>det</td>
<td>Determinant</td>
</tr>
<tr>
<td>mod</td>
<td>Modulo</td>
</tr>
</tbody>
</table>
Greek
All of the following Greek characters and variants are supported via keyword commands. Greek character keywords are case sensitive. If any letter in the keyword is uppercase, the Greek character is printed in uppercase; otherwise, it is printed in lowercase. All Greek characters available in the Corel WordPerfect character set are available if they are entered with Compose.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Keyword</th>
</tr>
</thead>
<tbody>
<tr>
<td>α</td>
<td>alpha</td>
</tr>
<tr>
<td>β</td>
<td>beta</td>
</tr>
<tr>
<td>γ</td>
<td>gamma</td>
</tr>
<tr>
<td>δ</td>
<td>delta</td>
</tr>
<tr>
<td>ε</td>
<td>epsilon</td>
</tr>
<tr>
<td>ϵ</td>
<td>varepsilon (variant)</td>
</tr>
<tr>
<td>ζ</td>
<td>zeta</td>
</tr>
<tr>
<td>η</td>
<td>eta</td>
</tr>
<tr>
<td>θ</td>
<td>theta</td>
</tr>
<tr>
<td>ϑ</td>
<td>vartheta (variant)</td>
</tr>
<tr>
<td>ι</td>
<td>iota</td>
</tr>
<tr>
<td>κ</td>
<td>kappa</td>
</tr>
<tr>
<td>λ</td>
<td>lambda</td>
</tr>
<tr>
<td>µ</td>
<td>mu</td>
</tr>
<tr>
<td>ν</td>
<td>nu</td>
</tr>
<tr>
<td>ξ</td>
<td>xi</td>
</tr>
<tr>
<td>ο</td>
<td>omicron</td>
</tr>
<tr>
<td>π</td>
<td>pi</td>
</tr>
<tr>
<td>ρ</td>
<td>rho</td>
</tr>
<tr>
<td>ρ</td>
<td>varrho (variant)</td>
</tr>
<tr>
<td>σ</td>
<td>sigma</td>
</tr>
<tr>
<td>ς</td>
<td>varsigma (variant)</td>
</tr>
<tr>
<td>τ</td>
<td>tau</td>
</tr>
<tr>
<td>υ</td>
<td>upsilon</td>
</tr>
<tr>
<td>φ</td>
<td>phi</td>
</tr>
<tr>
<td>ϕ</td>
<td>varphi (variant)</td>
</tr>
<tr>
<td>χ</td>
<td>chi</td>
</tr>
<tr>
<td>ψ</td>
<td>psi</td>
</tr>
<tr>
<td>ω</td>
<td>omega</td>
</tr>
<tr>
<td>Α</td>
<td>ALPHA</td>
</tr>
<tr>
<td>Β</td>
<td>BETA</td>
</tr>
<tr>
<td>Γ</td>
<td>GAMMA</td>
</tr>
<tr>
<td>Δ</td>
<td>DELTA</td>
</tr>
<tr>
<td>Ε</td>
<td>EPSILON</td>
</tr>
<tr>
<td>Ζ</td>
<td>ZETA</td>
</tr>
<tr>
<td>Η</td>
<td>ETA</td>
</tr>
<tr>
<td>Θ</td>
<td>THETA</td>
</tr>
<tr>
<td>Ι</td>
<td>IOTA</td>
</tr>
</tbody>
</table>
**Large**

The following commands insert an operator that takes on one of two sizes—small or large. The smaller size is typically used for Character Equation boxes; the larger size is typically used in other cases. These commands can be entered from the keyboard as either keywords or symbols, or with Compose. Keywords for large symbols are not case sensitive.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Keyword</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>$\sum$</td>
<td>SUM</td>
<td>Summation</td>
</tr>
<tr>
<td>$\Sigma$</td>
<td>SMALLSUM</td>
<td>Small Sum</td>
</tr>
<tr>
<td>$\int$</td>
<td>INT</td>
<td>Integral</td>
</tr>
<tr>
<td>$\oint$</td>
<td>SMALLINT</td>
<td>Small Integral</td>
</tr>
<tr>
<td>$\oint$</td>
<td>OINT</td>
<td>Contour Integral</td>
</tr>
<tr>
<td>$\prod$</td>
<td>PROD</td>
<td>Product</td>
</tr>
<tr>
<td>$\Pi$</td>
<td>SMALLPROD</td>
<td>Small Product</td>
</tr>
<tr>
<td>$\Pi$</td>
<td>COPROD</td>
<td>Coproduct</td>
</tr>
<tr>
<td>$\Pi$</td>
<td>SMALLCOPROD</td>
<td>Small Coproduct</td>
</tr>
<tr>
<td>$\cap$</td>
<td>CAP</td>
<td>Intersection</td>
</tr>
<tr>
<td>$\cap$</td>
<td>BIGCAP</td>
<td>Big Intersection</td>
</tr>
<tr>
<td>$\cup$</td>
<td>CUP</td>
<td>Union</td>
</tr>
<tr>
<td>$\cup$</td>
<td>BIGCUP</td>
<td>Big Union</td>
</tr>
<tr>
<td>$\cup$</td>
<td>UPLUS</td>
<td>Multiset Union (U Plus)</td>
</tr>
<tr>
<td>Symbol</td>
<td>Keyword</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>------------</td>
<td>----------------------</td>
</tr>
<tr>
<td>∪</td>
<td>BIGUPLUS</td>
<td>Big U Plus</td>
</tr>
<tr>
<td>□</td>
<td>SQCAP</td>
<td>Square Intersection</td>
</tr>
<tr>
<td>⊓</td>
<td>BIGSQCAP</td>
<td>Big Square Intersection</td>
</tr>
<tr>
<td>□</td>
<td>SQCUP</td>
<td>Square Union</td>
</tr>
<tr>
<td>⊔</td>
<td>BIGSQCUP</td>
<td>Big Square Union</td>
</tr>
<tr>
<td>∨</td>
<td>OR</td>
<td>Logical Or</td>
</tr>
<tr>
<td>∨</td>
<td>BIGVEE</td>
<td>Big Vee</td>
</tr>
<tr>
<td>∧</td>
<td>AND</td>
<td>Logical And</td>
</tr>
<tr>
<td>∧</td>
<td>BIGWEDGE</td>
<td>Big Wedge</td>
</tr>
<tr>
<td>⊕</td>
<td>OPLUS</td>
<td>Circle Plus</td>
</tr>
<tr>
<td>⊕</td>
<td>BIGOPLUS</td>
<td>Big Circle Plus</td>
</tr>
<tr>
<td>⊖</td>
<td>OMINUS</td>
<td>Circle Minus</td>
</tr>
<tr>
<td>⊖</td>
<td>BIGOMINUS</td>
<td>Big Circle Minus</td>
</tr>
<tr>
<td>⊗</td>
<td>OTIMES</td>
<td>Circle Multiply</td>
</tr>
<tr>
<td>⊗</td>
<td>BIGOTIMES</td>
<td>Big Circle Multiply</td>
</tr>
<tr>
<td>⊙</td>
<td>ODIV</td>
<td>Circle Divide</td>
</tr>
<tr>
<td>⊙</td>
<td>BIGODIV</td>
<td>Big Circle Divide</td>
</tr>
<tr>
<td>⊙</td>
<td>ODOT</td>
<td>Circle Dot</td>
</tr>
<tr>
<td>⊙</td>
<td>BIGODOT</td>
<td>Big Circle Dot</td>
</tr>
<tr>
<td>(</td>
<td>(</td>
<td>Left Parenthesis</td>
</tr>
<tr>
<td>)</td>
<td>)</td>
<td>Right Parenthesis</td>
</tr>
<tr>
<td>[</td>
<td>[</td>
<td>Left Bracket</td>
</tr>
<tr>
<td>]</td>
<td>]</td>
<td>Right Bracket</td>
</tr>
<tr>
<td>[</td>
<td>LDBRACK</td>
<td>Left Double Bracket</td>
</tr>
<tr>
<td>]</td>
<td>RDBRACK</td>
<td>Right Double Bracket</td>
</tr>
<tr>
<td>{</td>
<td>LBRACE</td>
<td>Left Brace</td>
</tr>
<tr>
<td>}</td>
<td>RBRACE</td>
<td>Right Brace</td>
</tr>
<tr>
<td></td>
<td></td>
<td>LFLOOR</td>
</tr>
<tr>
<td></td>
<td></td>
<td>RFLOOR</td>
</tr>
<tr>
<td></td>
<td></td>
<td>LCEIL</td>
</tr>
</tbody>
</table>
Symbol  Keyword  Description
|           RCEIL  Right Ceiling
\         LANGLE  Left Angle
/          RANGLE  Right Angle
|           LINE    Vertical Line
|           DLINE    Double Vertical Line

Other
The Other menu contains diacritical marks and different orientations of ellipses. Each item has a keyword and the keywords are not case sensitive.

Symbol  Keyword  Description
\       VEC     Vector Above; x VEC
|       BAR    Bar (Overline); x BAR
\       HAT    Hat (Above); x HAT
\       ACUTE   Acute Accent; x ACUTE
\       GRAVE   Grave Accent; x GRAVE
\       BREVE   Breve Accent; x BREVE
\       DOT     Dot Above; x DOT
\       DDOT    Double Dot Above; x DDOT
\       DDDOT   Triple Dot Above; x DDDOT
\       CIRCLE  Circle Above; x CIRCLE
\       TILDE   Tilde Above; x TILDE
\       DYAD    Dyad Above; x DYAD
\       DOTSAXIS Ellipses (centered)
\       DOTSLOW  Ellipses (on baseline)
\       DOTSVERT Ellipses (vertical)
\       DOTSdiag Ellipses (diagonal)
\       CHECK   Check Above; x CHECK

Sets
This menu contains set symbols, relational operators, and some commonly-used Fraktur and hollow letters. There are keywords for some of the set symbols. These commands are not case sensitive. All symbols are available with Compose.

Symbol  Keyword  Description
\      SETMINUS Set Minus (Figure Backslash)
\      SUBSET  Proper Subset
\      SUPSET  Proper Superset
\      REFLSUBSET Reflex Subset (Contained In)
\      REFLSUPSET Reflex Superset (Contains)
\      SUBSETBUNEQUAL Subset But Not Equal
\      SUPSETBUNEQUAL Superset But Not Equal
\      SQSUBSET Square Proper Subset
\      SQSUPSET Square Proper Superset
\      SQUARESET Square Reflex Subset
\      SQUARESUPSET Square Reflex Superset
<table>
<thead>
<tr>
<th>Symbol</th>
<th>Keyword</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>⊆</td>
<td>IN</td>
<td>Member (Element)</td>
</tr>
<tr>
<td>⊊</td>
<td>NOTIN</td>
<td>Not a Member</td>
</tr>
<tr>
<td>⊆</td>
<td>OWNS</td>
<td>Owns (Contains As A Member)</td>
</tr>
<tr>
<td>⊇</td>
<td>EMPTYSET</td>
<td>Empty Set</td>
</tr>
<tr>
<td>⊆</td>
<td>Double Union</td>
<td>Double Union</td>
</tr>
<tr>
<td>⊇</td>
<td>Double Intersection</td>
<td>Double Intersection</td>
</tr>
<tr>
<td>⊆</td>
<td>Double Subset</td>
<td>Double Subset</td>
</tr>
<tr>
<td>⊇</td>
<td>Double Superset</td>
<td>Double Superset</td>
</tr>
<tr>
<td>⊈</td>
<td>Not Subset</td>
<td>Not Subset</td>
</tr>
<tr>
<td>⊉</td>
<td>Not Superset</td>
<td>Not Superset</td>
</tr>
<tr>
<td>⊈</td>
<td>Not Reflex Subset</td>
<td>Not Reflex Subset</td>
</tr>
<tr>
<td>⊉</td>
<td>Not Reflex Superset</td>
<td>Not Reflex Superset</td>
</tr>
<tr>
<td>⊈</td>
<td>Square Not Subset</td>
<td>Square Not Subset</td>
</tr>
<tr>
<td>⊉</td>
<td>Square Not Superset</td>
<td>Square Not Superset</td>
</tr>
<tr>
<td>⊈</td>
<td>Square Not Reflex Subset</td>
<td>Square Not Reflex Subset</td>
</tr>
<tr>
<td>⊉</td>
<td>Square Not Reflex Superset</td>
<td>Square Not Reflex Superset</td>
</tr>
<tr>
<td>⊈</td>
<td>Not Less Than</td>
<td>Not Less Than</td>
</tr>
<tr>
<td>⊉</td>
<td>Not Less Than or Equal</td>
<td>Not Less Than or Equal</td>
</tr>
<tr>
<td>⊈</td>
<td>Not Greater Than</td>
<td>Not Greater Than</td>
</tr>
<tr>
<td>⊉</td>
<td>Not Greater Than or Equal</td>
<td>Not Greater Than or Equal</td>
</tr>
<tr>
<td>⊈</td>
<td>Not Similar</td>
<td>Not Similar</td>
</tr>
<tr>
<td>⊈</td>
<td>Not Similar or Equal</td>
<td>Not Similar or Equal</td>
</tr>
<tr>
<td>⊈</td>
<td>Not Congruent</td>
<td>Not Congruent</td>
</tr>
<tr>
<td>⊈</td>
<td>Not Approximately Equal</td>
<td>Not Approximately Equal</td>
</tr>
<tr>
<td>⊈</td>
<td>Does Not Precede</td>
<td>Does Not Precede</td>
</tr>
<tr>
<td>⊈</td>
<td>Neither Precedes nor Equals</td>
<td>Neither Precedes nor Equals</td>
</tr>
<tr>
<td>⊉</td>
<td>Does Not Follow</td>
<td>Does Not Follow</td>
</tr>
<tr>
<td>⊈</td>
<td>Neither Follows nor Equals</td>
<td>Neither Follows nor Equals</td>
</tr>
<tr>
<td>⊈</td>
<td>Not Parallel</td>
<td>Not Parallel</td>
</tr>
<tr>
<td>⊈</td>
<td>Does Not Divide</td>
<td>Does Not Divide</td>
</tr>
<tr>
<td>⊈</td>
<td>There Never Exists</td>
<td>There Never Exists</td>
</tr>
<tr>
<td>R</td>
<td>REAL</td>
<td>Real (R Fraktur)</td>
</tr>
<tr>
<td>C</td>
<td>IMAG</td>
<td>Imaginary (I Fraktur)</td>
</tr>
<tr>
<td>Z</td>
<td></td>
<td>Z Fraktur</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Weierstrass</td>
</tr>
<tr>
<td>h</td>
<td></td>
<td>Capital Weierstrass</td>
</tr>
<tr>
<td>L</td>
<td></td>
<td>Planck's Constant</td>
</tr>
<tr>
<td>F</td>
<td></td>
<td>Laplace Transform (Script L)</td>
</tr>
<tr>
<td>E</td>
<td></td>
<td>Script E</td>
</tr>
<tr>
<td>F</td>
<td></td>
<td>Fourier Transform (Script F)</td>
</tr>
<tr>
<td>C</td>
<td></td>
<td>Complex Number (Hollow C)</td>
</tr>
<tr>
<td>I</td>
<td></td>
<td>Integer (Hollow I)</td>
</tr>
<tr>
<td>N</td>
<td></td>
<td>Natural Number (Hollow N)</td>
</tr>
<tr>
<td>R</td>
<td></td>
<td>Real Number (Hollow R)</td>
</tr>
<tr>
<td>Symbol</td>
<td>Keyword</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-----------</td>
<td>---------------</td>
</tr>
<tr>
<td>Ω</td>
<td>MHO</td>
<td>Mho</td>
</tr>
<tr>
<td>Å</td>
<td>ANGSTROM</td>
<td>Angstrom</td>
</tr>
</tbody>
</table>

**Symbols**

Miscellaneous symbols are listed below. Keywords exist for each symbol. The keywords are not case sensitive. You can also use Compose to insert the symbol into your equation.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Keyword</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>′</td>
<td>Prime</td>
<td></td>
</tr>
<tr>
<td>″</td>
<td>Double Prime</td>
<td></td>
</tr>
<tr>
<td>‴</td>
<td>Triple Prime</td>
<td></td>
</tr>
<tr>
<td>∞</td>
<td>INFINITY</td>
<td>Infinity</td>
</tr>
<tr>
<td>∂</td>
<td>PARTIAL</td>
<td>Partial Derivative</td>
</tr>
<tr>
<td>∇</td>
<td>GRAD</td>
<td>Nabla (Gradient)</td>
</tr>
<tr>
<td>×</td>
<td>TIMES</td>
<td>Multiplication Sign (x)</td>
</tr>
<tr>
<td>÷</td>
<td>DIV</td>
<td>Division Sign</td>
</tr>
<tr>
<td>±</td>
<td>PLUSMINUS</td>
<td>Plus Or Minus</td>
</tr>
<tr>
<td>±</td>
<td>MINUSPLUS</td>
<td>Minus Or Plus</td>
</tr>
<tr>
<td>•</td>
<td>CDOT</td>
<td>Center Dot</td>
</tr>
<tr>
<td>⊕</td>
<td>XOR</td>
<td>Logical Exclusive Or</td>
</tr>
<tr>
<td>≦</td>
<td>Less Than Or Equal</td>
<td></td>
</tr>
<tr>
<td>≥</td>
<td>Greater Than Or Equal</td>
<td></td>
</tr>
<tr>
<td>≮</td>
<td>Much Less Than</td>
<td></td>
</tr>
<tr>
<td>≮</td>
<td>Much Greater Than</td>
<td></td>
</tr>
<tr>
<td>≪</td>
<td>Much Much Less</td>
<td></td>
</tr>
<tr>
<td>≫</td>
<td>Much Much Greater</td>
<td></td>
</tr>
<tr>
<td>≠</td>
<td>Not Equal</td>
<td></td>
</tr>
<tr>
<td>¬</td>
<td>NOT</td>
<td>Logical Not</td>
</tr>
<tr>
<td>≶</td>
<td>PRECEQ</td>
<td>Precedes Or Equals</td>
</tr>
<tr>
<td>≷</td>
<td>SUCEQ</td>
<td>Succeeds Or Equals</td>
</tr>
<tr>
<td>≡</td>
<td>Equivalent</td>
<td></td>
</tr>
<tr>
<td>≣</td>
<td>NEQUIV</td>
<td>Not Equivalent</td>
</tr>
<tr>
<td>≅</td>
<td>SIM</td>
<td>Similar</td>
</tr>
<tr>
<td>≈</td>
<td>SIMEQ</td>
<td>Similar Or Equal</td>
</tr>
<tr>
<td>∼</td>
<td>APPROX</td>
<td>Approximately Equal</td>
</tr>
<tr>
<td>≅</td>
<td>CONG</td>
<td>Congruent</td>
</tr>
<tr>
<td>∝</td>
<td>PROPTO</td>
<td>Proportional To</td>
</tr>
<tr>
<td>≍</td>
<td>DOTEQ</td>
<td>Equal by Definition</td>
</tr>
<tr>
<td>⊥</td>
<td>PERP</td>
<td>Perpendicular To</td>
</tr>
<tr>
<td>∀</td>
<td>FORALL</td>
<td>For All</td>
</tr>
<tr>
<td>∃</td>
<td>EXISTS</td>
<td>There Exists</td>
</tr>
<tr>
<td>∴</td>
<td>THEREFORE</td>
<td>Therefore</td>
</tr>
<tr>
<td>∵</td>
<td>BECAUSE</td>
<td>Because</td>
</tr>
<tr>
<td>Symbol</td>
<td>Keyword</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>---------</td>
<td>---------------------------</td>
</tr>
<tr>
<td>::=</td>
<td>IDENTICAL</td>
<td>Identical</td>
</tr>
<tr>
<td>+</td>
<td>DSUM</td>
<td>Direct Sum (Dot Plus)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>QEQUAL</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IMAGE</td>
</tr>
<tr>
<td></td>
<td></td>
<td>RIMAGE</td>
</tr>
<tr>
<td></td>
<td></td>
<td>ISO</td>
</tr>
<tr>
<td></td>
<td></td>
<td>NISO</td>
</tr>
<tr>
<td>&amp;</td>
<td>ASYMEQ</td>
<td>Asymptotically Equivalent</td>
</tr>
<tr>
<td>*</td>
<td>NASYMEQ</td>
<td>Not Asymptotically Equivalent</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SMILE</td>
</tr>
<tr>
<td></td>
<td></td>
<td>FROWN</td>
</tr>
<tr>
<td></td>
<td></td>
<td>BETWEEN</td>
</tr>
<tr>
<td>\</td>
<td>WREATH</td>
<td>Wreath Product</td>
</tr>
<tr>
<td></td>
<td></td>
<td>TOP</td>
</tr>
<tr>
<td></td>
<td></td>
<td>ASSERT</td>
</tr>
<tr>
<td></td>
<td></td>
<td>MASSERT</td>
</tr>
<tr>
<td></td>
<td></td>
<td>MODELS</td>
</tr>
<tr>
<td></td>
<td></td>
<td>ANGLE</td>
</tr>
<tr>
<td>\</td>
<td>MANGLE</td>
<td>Measured Angle</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SANGLE</td>
</tr>
<tr>
<td>\</td>
<td>RTANGLE</td>
<td>Right Angle</td>
</tr>
<tr>
<td>°</td>
<td>DEG</td>
<td>Degree</td>
</tr>
</tbody>
</table>
Appendix E: Error Messages

Common error messages associated with Corel WordPerfect are listed below.

If an error message is displayed,

1. Follow the solutions suggested below to solve the problem.
2. Consult the Help files, the Corel WordPerfect manuals, or other accompanying manuals that pertain to your software or system.
3. If you believe the problem is hardware-related, contact your system administrator.

Access Denied

**Cause:** A directory already exists by the name you specified.

**Solution:** Contact your system administrator.

**Cause:** You do not have permission to write in the current directory.

**Solution:** Contact your system administrator.

Can't Find wp.drs File

**Cause:** You are trying to enter View Document or Figure Editor, but Corel WordPerfect cannot locate the wp.drs file, which is required to use these features.

**Solution:** Copy the wp.drs file to the shlib directory.

Delete Without Saving for Undelete?

**Cause:** You are deleting a large block, and the disk where the undelete files are kept is full.

**Solution:** Type y if you want the block deleted (you will not be able to undelete it). Type n if you want the option to undelete it, in which case your deletion will be canceled.

Directory Not Empty

**Cause:** You are trying to delete a directory in List Files, but UNIX reports that the directory is not empty.

**Solution:** Make sure that the directory is empty, which means that there are no files or subdirectories in that directory.

Document Line is Too Complex to Print

**Cause:** An internal buffer in the printing process overflowed because a line in the document contained too many font changes, embedded printer commands, advances, or other printer codes.

**Solution:** Remove some font changes or printer commands, or insert hard returns between lines instead of vertical advances (where possible).
Document May Need to be Generated.

**Print?**

**Cause:** The document you are trying to print contains some codes that require generation. Some editing has been done since the last time it was generated.

**Solution:** Type n to answer No, then generate the document before printing (see Generate). If you are sure all the page numbers are correct, (or if you want to print the document even if they are not correct) type y to answer Yes and the document will be printed as is.

Document Needs to be Generated

**Cause:** The document you are trying to print has not been generated.

**Solution:** Generate the document (see Generate).

Document Not Formatted for Current Printer. Continue?

**Cause:** You have asked to print a document from disk, but the document was formatted for a printer other than the one you currently have selected.

**Solution:** To print the document on the printer for which it was formatted, you should retrieve the document, select the printer, then print from the screen or save the document. If you choose to print the document on the currently selected printer, fonts and other printer-specific items may not print as you expect.

[End Def] Code Does Not Have Matching [Def Mark]

**Cause:** The first time a table of contents, list, table of authorities, or index is generated, an [End Def] code is inserted at the end of the generated table or list. If [Def Mark] is deleted, or [End Def] is mistakenly moved or undeleted somewhere else in the document, the generate process will find [End Def] without a matching [Def Mark] preceding it.

**Solution:** Make sure each [End Def] immediately follows the generated text which has been placed after [Def Mark]. Remember that all text between [Def Mark] and [End Def] will be replaced during additional generations. These codes may be seen in Reveal Codes.

File Can't be Copied onto Itself

**Cause:** In List Files, you tried to copy a file, but you used the same name and directory (destination) as the original file.

**Solution:** Copy the file to a different directory or to a different name within the same directory.

File is Locked

**Cause:** You were trying to access a locked (password-protected) document, but did not enter the password correctly.

**Solution:** Retrieve the file again and enter the correct password when prompted. See Locked Documents for more information on passwords. If you do not know the password, you cannot retrieve the document.
**File Not Found**  
**Cause:** A file could not be found in the specified directory (or default directory if no directory was specified). Usually this message will be followed by the name of the file that can’t be found.  
**Solution:** Make sure you typed the filename and the path correctly. You can use List to verify the exact spelling and location of the file you need.

**Formula Must be Entered**  
**Cause:** In Math Definition, you specified a column as a calculation column, but did not enter a formula.  
**Solution:** Enter a formula for the column, or change the column type to something other than calculation.

**Generate Codes Found Between [Def Mark] and [End Def] Codes**  
**Cause:** Since you generated a document, you have added a Mark Text code in a generated section. The newly added codes will be lost because generation deletes previously generated text.  
**Solution:** Move the Mark Text codes outside the [Def Mark] and [End Def] codes. These codes can be seen in Reveal Codes. See Generate for more information.

**Graphics in Block Not Saved to Clipboard**  
**Cause:** The Office Clipboard formats for the Corel Shell program do not allow the mixture of text and graphics codes, so the graphics portion of the block you are saving to the Clipboard will not be included in the Clipboard.  
**Solution:** If you are interested in the graphics data, save the contents of each graphic figure from the Graphics Edit menu to the clipboard; the graphics data can then be retrieved into another figure by pressing the Shell key at the filename prompt in the Graphics: Edit screen. If you plan to retrieve text and graphics into Corel WordPerfect, use a named or unnamed block to move the text and graphics instead of the Clipboard.

**Illegal Character(s)**  
**Cause:** In Math Definition, invalid characters were found in a calculation formula.  
**Solution:** Remove the illegal characters. The only valid characters are spaces, digits, math operators (+ – / *), decimal points, parentheses, and column letters (A-X). Check for incorrect syntax as well.

**Incompatible File Format**  
**Cause:** The file in question is not in the correct format for the requested operation. For example, you are trying to print a WordPerfect Corporation’s WordPerfect 4.2 document from disk, or you are trying to retrieve a document created in another word processor.  
**Solution:** Convert the file to the correct format and then try again. See Convert Program, Document Conversion, and Text In/Out for more information.
Cause: You are trying to retrieve a graphics image into the normal editing screen.

Solution: Graphics images can only be retrieved into graphics boxes.

**Incompatible Supplementary Dictionary File Format**

**Cause:** The supplementary dictionary you specified is not a Corel WordPerfect 7 document.

**Solution:** If it is a WordPerfect Corporation’s WordPerfect 4.2 or 5.0 document, or a UNIX text file, retrieve it (using Text In if appropriate) and save it as a Corel WordPerfect 7 document. See also *Speller Utility*.

**Insert Paper—Press “G” to Continue**

**Cause:** “Prompt to Load” in Paper Size/Type is marked Yes for the form you are using to print.

**Solution:** Insert the paper (position it correctly), and press g to continue.

**Invalid Graphics Driver**

**Cause:** You are trying to view a document or edit a graphics box, but the graphics driver you selected in graphics screen type is invalid. The graphics driver is in an improper format, or you do not have the hardware that matches your selection.

**Solution:** Make sure the graphics screen type was correctly specified in Setup (see *Graphics Screen Type*).

**Invalid Graphics File Format**

**Cause:** When retrieving a graphic file into a graphic box, the file is not in a Corel WordPerfect-supported format, or that there is something in the file we do not support.

**Solution:** If the format of the graphics file is not supported by Corel WordPerfect, you must convert it to a supported format.

See *Graphics, Formats and Programs* and *Graphics, Conversion Program* for more information.

Many graphics packages save graphic images in several formats. Some formats supported by Corel WordPerfect have many variations in the industry, not all of which are currently supported by Corel WordPerfect.

**Invalid Printer Definition String**

**Cause:** A printer definition in the .prs file for the job being printed contained an unrecognized command. This can occur when converting a previous .prs file using the Printer Program (ptr), or because of corruption in the .prs file.

**Solution:** If you did not add information to the printer definition using ptr, rename the .prs file and reselect the printer. If you added information, check the commands you modified to see if any invalid commands are present.
Invalid Thesaurus File Format
Cause: The Thesaurus is not in a correct format.
Solution: Make sure the Thesaurus was installed correctly.

Job Not Found
Cause: You tried to cancel a job with a job number which is not currently in the list of jobs.
Solution: Enter the correct job number again.

Marked Files Must Be Copied to a Directory
Cause: In List Files, you marked one or more files and then requested that they be copied to a filename instead of a directory.
Solution: Specify a directory.

Maximum Records Exceeded
Cause: The input file for the sort contained more than 65,535 records.
Solution: Break up the file into smaller files, and sort them individually.

Maximum String Size Exceeded
Cause: The Select String in the Sort feature contains a constant of more than 16 digits.
Solution: Reduce the size of any constants in the Select String.

No Text Columns Defined
Cause: You tried to turn on columns before defining columns.
Solution: Define columns, then turn on columns again.

Printer Not Selected
Cause: You tried to print or view a document, but had not selected a printer.
Solution: Select a printer (make sure that an asterisk appears by it in the printer selection list), then try to print again (see Printer, Select).

Printer Port Not Selected
Cause: You are printing a document that has been set up with a different printer selected. Even though the printer is deleted, the .prs file still exists. The old .prs file is selected, but the port information is not available.
Solution: Add the port information to the printer selection Corel WordPerfect created, which makes the selection permanent.

Start/End Mismatch on:
Cause: While condensing a master document, there is a Subdocument End without a Subdocument Start, because of a specific request or as part of generation.
Solution: Check the document to make sure that Subdocument Start and Subdocument End codes are properly paired.
Subdoc Not Allowed Within This Function

**Cause:** You tried to insert a Subdocument code in a Footnote or Header/Footer, or similar editing substructure.

**Solution:** Insert Subdocument codes only at the main level of the document.

Too Many Characters in Constant

**Cause:** When defining your calculation column in the Math feature, you used more than 7 digits in each constant.

**Solution:** You cannot use more than 7 digits for each constant.

Too Much Text

**Cause:** You tried to exit a Header, Footer, Footnote, Endnote, Text Box, Caption, or Styles, but there was too much text. The limit for Footnotes and Endnotes is 64K (approximately 16,000 lines of text). For all other codes, the limit is one page.

**Solution:** Delete text until the text is within acceptable limits. If you forgot to exit the edit screen and continued with your document, use Move to move the text back to the document.

Unable to Process Secondary File Field Names

**Cause:** Missing tilde at the end of the {FIELD NAMES} definition.

**Solution:** Enter the tilde, save the secondary file, and perform the merge again.

Unmatched ( or )

**Cause:** A parenthesis is missing in the sort select string (see Sort, Select Records). All mathematical expressions require the same number of left and right parentheses, with the left parenthesis to the left of the matching right parenthesis.

**Solution:** Examine the string to find the missing parenthesis.
Appendix F: Graphics Images

The images listed below can be used with the Graphics feature. The filename is listed below the image. For more information on how to use the images, see Graphics, Define a Box.

**Important:** If you have problems inserting a graphics image into your document, or cannot find the graphics files in your directory, contact your system administrator.

ARROW-22
AUTO
BALLOONS
BANNER-3

BEACH-1
BICYCLE
BIKE
BIRTHDAY

BORD02
BORDER-8
BULB
BURST-1

CLOCK
CNTRCT-2
DESK-W
DEVICE-2
Appendix F: Graphics Images
Appendix G: Initial Settings

This section lists initial settings found in Setup and Format. For more information, see the Index for references to each option. Also, see Initial Codes.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Initial Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automatically Format and Rewrite</td>
<td>Yes</td>
</tr>
<tr>
<td>Backup Options</td>
<td></td>
</tr>
<tr>
<td>Minutes Between Timed Backups</td>
<td>30</td>
</tr>
<tr>
<td>Original Document Backup</td>
<td>No</td>
</tr>
<tr>
<td>Timed Document Backup</td>
<td>Yes</td>
</tr>
<tr>
<td>Baseline Placement for Typesetters</td>
<td>No</td>
</tr>
<tr>
<td>Beep Options</td>
<td></td>
</tr>
<tr>
<td>on Error</td>
<td>No</td>
</tr>
<tr>
<td>on Hyphenation</td>
<td>Yes</td>
</tr>
<tr>
<td>on Search Failure</td>
<td>No</td>
</tr>
<tr>
<td>Border Options</td>
<td></td>
</tr>
<tr>
<td>Single-Width</td>
<td>.013&quot;</td>
</tr>
<tr>
<td>Single-Shading</td>
<td>100%</td>
</tr>
<tr>
<td>Double-Width</td>
<td>.013&quot;</td>
</tr>
<tr>
<td>Double-Shading</td>
<td>100%</td>
</tr>
<tr>
<td>Double-Spacing Between</td>
<td>.013&quot;</td>
</tr>
<tr>
<td>Dashed-Width</td>
<td>.013&quot;</td>
</tr>
<tr>
<td>Dashed-Shading</td>
<td>100%</td>
</tr>
<tr>
<td>Dashed-Dash Spacing</td>
<td>.013&quot;</td>
</tr>
<tr>
<td>Dashed-Dash Length</td>
<td>.053&quot;</td>
</tr>
<tr>
<td>Dotted-Width</td>
<td>.013&quot;</td>
</tr>
<tr>
<td>Dotted-Shading</td>
<td>100%</td>
</tr>
<tr>
<td>Dotted-Dot Spacing</td>
<td>.013&quot;</td>
</tr>
<tr>
<td>Thick-Width</td>
<td>.062&quot;</td>
</tr>
<tr>
<td>Thick-Shading</td>
<td>100%</td>
</tr>
<tr>
<td>Extra Thick-Width</td>
<td>.125&quot;</td>
</tr>
<tr>
<td>Extra Thick-Shading</td>
<td>100%</td>
</tr>
<tr>
<td>Center Page (top to bottom)</td>
<td>No</td>
</tr>
<tr>
<td>Comments Display</td>
<td>Yes</td>
</tr>
<tr>
<td>Date Format</td>
<td>3 1,4 (May 1, 1991)</td>
</tr>
<tr>
<td>Decimal/Align Character</td>
<td>.</td>
</tr>
<tr>
<td>Default Document Type</td>
<td>none</td>
</tr>
<tr>
<td>Display Pitch</td>
<td></td>
</tr>
<tr>
<td>Automatic</td>
<td>Yes</td>
</tr>
<tr>
<td>Width</td>
<td>0.1&quot;</td>
</tr>
<tr>
<td>Document Summary</td>
<td></td>
</tr>
<tr>
<td>Create on Save/Exit</td>
<td>No</td>
</tr>
<tr>
<td>Subject Search Text</td>
<td>Re:</td>
</tr>
</tbody>
</table>
## Feature

<table>
<thead>
<tr>
<th>Feature</th>
<th>Initial Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Equation Options</td>
<td></td>
</tr>
<tr>
<td>Graphical Font Size</td>
<td>Default</td>
</tr>
<tr>
<td>Horizontal Alignment</td>
<td>Center</td>
</tr>
<tr>
<td>Keyboard</td>
<td>Original</td>
</tr>
<tr>
<td>Print as Graphics</td>
<td>Yes</td>
</tr>
<tr>
<td>Vertical Alignment</td>
<td>Center</td>
</tr>
<tr>
<td>Fast Save (unformatted)</td>
<td>Yes</td>
</tr>
<tr>
<td>Filename on the Status Line</td>
<td>Yes</td>
</tr>
<tr>
<td>Footers</td>
<td>None</td>
</tr>
<tr>
<td>Force Odd/Even Page</td>
<td>Off</td>
</tr>
<tr>
<td>Format Retrieved Documents for Default Printer</td>
<td>Yes</td>
</tr>
<tr>
<td>Graphics Screen Type</td>
<td>None Selected</td>
</tr>
<tr>
<td>Hard Return Display Character</td>
<td>Space</td>
</tr>
<tr>
<td>Headers</td>
<td>None</td>
</tr>
<tr>
<td>Hyphenation (feature)</td>
<td>No</td>
</tr>
<tr>
<td>Hyphenation Dictionary</td>
<td>External Dictionary/Rules</td>
</tr>
<tr>
<td>Hyphenation Prompt</td>
<td>When Required</td>
</tr>
<tr>
<td>Hyphenation Zone</td>
<td></td>
</tr>
<tr>
<td>Left</td>
<td>10%</td>
</tr>
<tr>
<td>Right</td>
<td>4%</td>
</tr>
<tr>
<td>Justification</td>
<td>Full</td>
</tr>
<tr>
<td>Kerning</td>
<td>No</td>
</tr>
<tr>
<td>Keyboard Layout</td>
<td>Original</td>
</tr>
<tr>
<td>Language</td>
<td>US</td>
</tr>
<tr>
<td>Leading Adjustment</td>
<td></td>
</tr>
<tr>
<td>Primary-[SRt]</td>
<td>0&quot;</td>
</tr>
<tr>
<td>Secondary-[HRt]</td>
<td>0&quot;</td>
</tr>
<tr>
<td>Letter Spacing</td>
<td>Optimal</td>
</tr>
<tr>
<td>Line Height</td>
<td>Auto</td>
</tr>
<tr>
<td>Line Numbering</td>
<td>No</td>
</tr>
<tr>
<td>Line Spacing</td>
<td>1</td>
</tr>
<tr>
<td>Location of Files</td>
<td>Set by Installation Program</td>
</tr>
<tr>
<td>Long Document Names</td>
<td>No</td>
</tr>
<tr>
<td>Feature</td>
<td>Initial Setting</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>----------------</td>
</tr>
<tr>
<td>Margins</td>
<td></td>
</tr>
<tr>
<td>Bottom</td>
<td>1&quot;</td>
</tr>
<tr>
<td>Left</td>
<td>1&quot;</td>
</tr>
<tr>
<td>Right</td>
<td>1&quot;</td>
</tr>
<tr>
<td>Top</td>
<td>1&quot;</td>
</tr>
<tr>
<td>Menu Bar</td>
<td></td>
</tr>
<tr>
<td>Letter Display</td>
<td>Redline</td>
</tr>
<tr>
<td>Remains Visible</td>
<td>No</td>
</tr>
<tr>
<td>Separator Line</td>
<td>No</td>
</tr>
<tr>
<td>Text</td>
<td>Shadow</td>
</tr>
<tr>
<td>Menu Letter Display</td>
<td>Bold</td>
</tr>
<tr>
<td>Merge</td>
<td></td>
</tr>
<tr>
<td>Field Delimiters</td>
<td>None</td>
</tr>
<tr>
<td>Begin</td>
<td></td>
</tr>
<tr>
<td>End</td>
<td>,</td>
</tr>
<tr>
<td>Record Delimiters</td>
<td>None</td>
</tr>
<tr>
<td>Begin</td>
<td>No Page Numbering</td>
</tr>
<tr>
<td>End</td>
<td>[CR]</td>
</tr>
<tr>
<td>Merge Codes Display</td>
<td>No</td>
</tr>
<tr>
<td>Page Number</td>
<td></td>
</tr>
<tr>
<td>New Page Number</td>
<td>1</td>
</tr>
<tr>
<td>Page Number Position</td>
<td>No Page Numbering</td>
</tr>
<tr>
<td>Page Number Style</td>
<td>^B</td>
</tr>
<tr>
<td>Paper Size</td>
<td>8.5&quot; x 11&quot;</td>
</tr>
<tr>
<td>Paper Type</td>
<td>Standard</td>
</tr>
<tr>
<td>Print Options</td>
<td></td>
</tr>
<tr>
<td>Binding Offset</td>
<td>0&quot;</td>
</tr>
<tr>
<td>Graphics Quality</td>
<td>Medium</td>
</tr>
<tr>
<td>Multiple Copies Generated By</td>
<td>WordPerfect</td>
</tr>
<tr>
<td>Number of Copies</td>
<td>1</td>
</tr>
<tr>
<td>Text Quality</td>
<td>High</td>
</tr>
<tr>
<td>Pull-Down Menu</td>
<td></td>
</tr>
<tr>
<td>Letter Display</td>
<td>Bold</td>
</tr>
<tr>
<td>Text</td>
<td>Normal</td>
</tr>
<tr>
<td>Redline Method</td>
<td>Printer Dependent</td>
</tr>
<tr>
<td>Repeat Value</td>
<td>8</td>
</tr>
<tr>
<td>Reveal Codes Window Size</td>
<td>10</td>
</tr>
<tr>
<td>Save with Original Privileges</td>
<td>No</td>
</tr>
<tr>
<td>Save/Retrieve with .wp Extension</td>
<td>No</td>
</tr>
<tr>
<td>Side-by-side Columns Display</td>
<td>Yes</td>
</tr>
<tr>
<td>Feature</td>
<td>Initial Setting</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>--------------------------------------</td>
</tr>
<tr>
<td>Size Attribute Ratios (% of Normal)</td>
<td></td>
</tr>
<tr>
<td>Fine</td>
<td>60%</td>
</tr>
<tr>
<td>Small</td>
<td>80%</td>
</tr>
<tr>
<td>Large</td>
<td>120%</td>
</tr>
<tr>
<td>Very Large</td>
<td>150%</td>
</tr>
<tr>
<td>Extra Large</td>
<td>200%</td>
</tr>
<tr>
<td>Super/Subscript</td>
<td>60%</td>
</tr>
<tr>
<td>Suppress All Page Numbering, Headers, and Footer</td>
<td>Off</td>
</tr>
<tr>
<td>Suppress Headers and Footers</td>
<td>Off</td>
</tr>
<tr>
<td>Print Page Number at Bottom Center</td>
<td>No</td>
</tr>
<tr>
<td>Suppress Page Numbering</td>
<td>No</td>
</tr>
<tr>
<td>Suppress Header A</td>
<td>No</td>
</tr>
<tr>
<td>Suppress Header B</td>
<td>No</td>
</tr>
<tr>
<td>Suppress Footer A</td>
<td>No</td>
</tr>
<tr>
<td>Suppress Footer B</td>
<td>No</td>
</tr>
<tr>
<td>Tab Set</td>
<td>Relative to Left Margin, every 0.5&quot;</td>
</tr>
<tr>
<td>Table of Authorities</td>
<td></td>
</tr>
<tr>
<td>Blank Line between Authorities</td>
<td>Yes</td>
</tr>
<tr>
<td>Dot Leaders</td>
<td>Yes</td>
</tr>
<tr>
<td>Underlining Allowed</td>
<td>No</td>
</tr>
<tr>
<td>Thousands’ Separator</td>
<td>,</td>
</tr>
<tr>
<td>Underline Spaces</td>
<td>Yes</td>
</tr>
<tr>
<td>Underline Tabs</td>
<td>No</td>
</tr>
<tr>
<td>Units of Measure</td>
<td></td>
</tr>
<tr>
<td>Display and Entry</td>
<td>Inches (”)</td>
</tr>
<tr>
<td>Status Line Display</td>
<td>Inches (”)</td>
</tr>
<tr>
<td>View Document Options</td>
<td></td>
</tr>
<tr>
<td>Bold Displayed with Color</td>
<td>No</td>
</tr>
<tr>
<td>Graphics in Black &amp; White</td>
<td>No</td>
</tr>
<tr>
<td>Text in Black &amp; White</td>
<td>No</td>
</tr>
<tr>
<td>Widow/Orphan Protection</td>
<td>No</td>
</tr>
<tr>
<td>Word Spacing</td>
<td>Optimal</td>
</tr>
<tr>
<td>Word Spacing Justification Limits</td>
<td></td>
</tr>
<tr>
<td>Compressed to</td>
<td>60%</td>
</tr>
<tr>
<td>Expanded to</td>
<td>400%</td>
</tr>
</tbody>
</table>
Appendix H: Keyboards

In addition to the original keyboard layout, you can use or edit six additional keyboard layouts: Alternate keyboard, Enhanced keyboard, Equation keyboard, Fast Keys keyboard, Macros keyboard, and Shortcut keyboard. The key assignments that differ from the key assignments on the original keyboard are listed below.

*For information on defining and selecting keyboard layouts, see Keyboard Layout. For information on editing a keyboard layout, see Keyboard Layout, Edit and Keyboard Layout, Map.*

**ALTERNATE (ALTERNAT)**
The Alternate Keyboard layout includes the following key assignments, which are built into Corel WordPerfect.

*This keyboard is only available by pressing Setup.*

<table>
<thead>
<tr>
<th>Key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cancel</td>
<td>Help</td>
</tr>
<tr>
<td>Help</td>
<td>Escape</td>
</tr>
<tr>
<td>Escape</td>
<td>Cancel</td>
</tr>
</tbody>
</table>

To select the Alternate Keyboard Layout,

1. Press **Setup**, then select Environment (2), to display the Environment menu.
2. Select Alternate Keyboard (8), and set Alternate Keyboard to Yes.
3. Press **Return** twice to return to the normal editing screen.

You can make the same assignments, but select another keyboard by using Alternate Keyboard option.

**ENHANCED**
The Enhanced keyboard layout is useful if you have a keyboard with two additional function keys. If your keyboard includes the F11 and F12 keys, this layout will appear as the following key assignments:

<table>
<thead>
<tr>
<th>Key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Home</td>
<td>Home, Home, Home, Left Arrow</td>
</tr>
<tr>
<td>Ctrl-Home</td>
<td>Home</td>
</tr>
<tr>
<td>Shift-F11</td>
<td>Italics</td>
</tr>
<tr>
<td>Ctrl-F11</td>
<td>Retrieve Block</td>
</tr>
<tr>
<td>Alt-F11</td>
<td>Large</td>
</tr>
<tr>
<td>Shift-F12</td>
<td>Move Block</td>
</tr>
<tr>
<td>Ctrl-F12</td>
<td>Very Large</td>
</tr>
<tr>
<td>Alt-F12</td>
<td>Copy Block</td>
</tr>
<tr>
<td>Ctrl-G</td>
<td>Go To</td>
</tr>
</tbody>
</table>
**EQUATION**

The Equation keyboard layout assigns mathematical and scientific characters to keys on your keyboard.

<table>
<thead>
<tr>
<th>Key</th>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alt-=</td>
<td>!=</td>
<td>(Not Equal to)</td>
</tr>
<tr>
<td>Alt-’</td>
<td>SIMEQ</td>
<td>(Similar or Equal to)</td>
</tr>
<tr>
<td>Alt--</td>
<td>CONG</td>
<td>(Congruent)</td>
</tr>
<tr>
<td>Alt-,</td>
<td>&lt;=</td>
<td>(Less Than or Equal to)</td>
</tr>
<tr>
<td>Alt-&gt;</td>
<td>&gt;=</td>
<td>(Greater Than or Equal to)</td>
</tr>
<tr>
<td>Alt-</td>
<td>LINE</td>
<td></td>
</tr>
<tr>
<td>Alt-a</td>
<td>α</td>
<td>alpha</td>
</tr>
<tr>
<td>Alt-b</td>
<td>β</td>
<td>beta</td>
</tr>
<tr>
<td>Alt-d</td>
<td>δ</td>
<td>delta</td>
</tr>
<tr>
<td>Alt-e</td>
<td>ε</td>
<td>epsilon</td>
</tr>
<tr>
<td>Alt-f</td>
<td>φ</td>
<td>phi</td>
</tr>
<tr>
<td>Alt-g</td>
<td>γ</td>
<td>gamma</td>
</tr>
<tr>
<td>Alt-i</td>
<td>∞</td>
<td>INF (infinity)</td>
</tr>
<tr>
<td>Alt-l</td>
<td>λ</td>
<td>lambda</td>
</tr>
<tr>
<td>Alt-m</td>
<td>μ</td>
<td>mu</td>
</tr>
<tr>
<td>Alt-n</td>
<td>η</td>
<td>eta</td>
</tr>
<tr>
<td>Alt-o</td>
<td>Ω</td>
<td>omega</td>
</tr>
<tr>
<td>Alt-p</td>
<td>π</td>
<td>pi</td>
</tr>
<tr>
<td>Alt-r</td>
<td>ρ</td>
<td>rho</td>
</tr>
<tr>
<td>Alt-s</td>
<td>σ</td>
<td>sigma</td>
</tr>
<tr>
<td>Alt-t</td>
<td>θ</td>
<td>theta</td>
</tr>
<tr>
<td>Alt-right</td>
<td>-</td>
<td>(Right Arrow)</td>
</tr>
<tr>
<td>Ctrl-a</td>
<td>SUP*</td>
<td>Sup (Superscript)</td>
</tr>
<tr>
<td>Ctrl-b</td>
<td>BAR*</td>
<td>Bar</td>
</tr>
<tr>
<td>Ctrl-d</td>
<td>Δ</td>
<td>DELTA (Uppercase)</td>
</tr>
<tr>
<td>Ctrl-e</td>
<td>ε</td>
<td>Member (Element)</td>
</tr>
<tr>
<td>Ctrl-f</td>
<td>FROM</td>
<td>FROM TO</td>
</tr>
<tr>
<td>Ctrl-g</td>
<td>ν</td>
<td>GRAD (Nabla, Gradient)</td>
</tr>
<tr>
<td>Ctrl-i</td>
<td>∫</td>
<td>(Integral)</td>
</tr>
<tr>
<td>Ctrl-l</td>
<td>OVERLINE*</td>
<td>OVERLINE</td>
</tr>
<tr>
<td>Ctrl-n</td>
<td>ν</td>
<td>GRAD (Nabla, Gradient)</td>
</tr>
<tr>
<td>Ctrl-o</td>
<td>OVER*</td>
<td>OVER</td>
</tr>
<tr>
<td>Ctrl-p</td>
<td>∂</td>
<td>PARTIAL</td>
</tr>
<tr>
<td>Ctrl-q</td>
<td>SQRT*</td>
<td>(Square Root)</td>
</tr>
<tr>
<td>Ctrl-s</td>
<td>SUM</td>
<td></td>
</tr>
<tr>
<td>Ctrl-z</td>
<td>SUB*</td>
<td>SUB (Subscript)</td>
</tr>
<tr>
<td>Ctrl-Left</td>
<td>-</td>
<td>(Left Arrow)</td>
</tr>
</tbody>
</table>

*Must be entered with parameters or arguments.

For information on how to use the Equation keyboard layout, see Equation Keyboard under Equations. You can use the Equation keyboard outside the Equation Editor by selecting it with Keyboard Layout. Some characters, however, may not display as expected because keywords specific to the Equation Editor represent certain characters.
**FAST KEYS**

Below is a list of the keys you can also display on-screen by selecting Fast Keys from the Help menu.

<table>
<thead>
<tr>
<th>Key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl-a</td>
<td>Paste Block</td>
</tr>
<tr>
<td>Ctrl-b</td>
<td>Bold</td>
</tr>
<tr>
<td>Ctrl-c</td>
<td>Center</td>
</tr>
<tr>
<td>Ctrl-d</td>
<td>Date Text</td>
</tr>
<tr>
<td>Ctrl-e</td>
<td>Endnote Create</td>
</tr>
<tr>
<td>Ctrl-f</td>
<td>Base Font</td>
</tr>
<tr>
<td>Ctrl-g</td>
<td>Graphics Create</td>
</tr>
<tr>
<td>Ctrl-i</td>
<td>Italics</td>
</tr>
<tr>
<td>Ctrl-k</td>
<td>Copy</td>
</tr>
<tr>
<td>Ctrl-m</td>
<td>Move (Cut)</td>
</tr>
<tr>
<td>Ctrl-n</td>
<td>Normal Text</td>
</tr>
<tr>
<td>Ctrl-p</td>
<td>Preview (View Document)</td>
</tr>
<tr>
<td>Ctrl-r</td>
<td>Reveal Codes</td>
</tr>
<tr>
<td>Ctrl-s</td>
<td>Spell</td>
</tr>
<tr>
<td>Ctrl-t</td>
<td>Thesaurus</td>
</tr>
<tr>
<td>Ctrl-u</td>
<td>Underline</td>
</tr>
<tr>
<td>Ctrl-v</td>
<td>Characters</td>
</tr>
</tbody>
</table>

**MACROS**

The Macros keyboard layout assigns useful macros to the Alt and Ctrl keys. It includes the following key assignments:

<table>
<thead>
<tr>
<th>Key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alt-b</td>
<td>Restores the previous block</td>
</tr>
<tr>
<td>Alt-c</td>
<td>Capitalizes the first letter of the word on which your cursor is located.</td>
</tr>
<tr>
<td>Alt-d</td>
<td>Deletes the line the cursor is on.</td>
</tr>
<tr>
<td>Alt-e</td>
<td>Returns you to the normal editing screen.</td>
</tr>
<tr>
<td>Alt-f</td>
<td>Finds a “bookmark” (&lt;&lt;Mark&gt;&gt;) in your document.</td>
</tr>
<tr>
<td>Alt-g</td>
<td>Gives the printer a “Go”</td>
</tr>
<tr>
<td>Alt-i</td>
<td>Inserts a blank line immediately preceding the line the cursor is on.</td>
</tr>
<tr>
<td>Alt-m</td>
<td>Inserts a “bookmark” (&lt;&lt;Mark&gt;&gt;) into your document.</td>
</tr>
<tr>
<td>Alt-n</td>
<td>Edits the next or previous footnote or endnote.</td>
</tr>
<tr>
<td>Alt-r</td>
<td>Replaces an attribute with another attribute. Place the cursor on the attribute before pressing the key.</td>
</tr>
<tr>
<td>Alt-t</td>
<td>Transposes two visible characters. Place the cursor on the attribute before pressing the key.</td>
</tr>
<tr>
<td>Key</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Ctrl-c</td>
<td>Displays a calculator you can use to perform mathematical calculations.</td>
</tr>
<tr>
<td>Ctrl-d</td>
<td>Helps you create a memo, letter, or itinerary.</td>
</tr>
<tr>
<td>Ctrl-e</td>
<td>Selects or defines an envelope paper size/type, then helps you type a name and address on the envelope.</td>
</tr>
<tr>
<td>Ctrl-g</td>
<td>Expands abbreviated words. Place the cursor to the immediate right of the abbreviation to be expanded before pressing the key. Edit this macro to add more words to the abbreviation “dictionary.”</td>
</tr>
<tr>
<td>Ctrl-p</td>
<td>Pointing mode when entering formulas.</td>
</tr>
<tr>
<td>Ctrl-r</td>
<td>Recalculates all math formulas in a table.</td>
</tr>
<tr>
<td>Ctrl-F8</td>
<td>Lets you temporarily change base fonts. Press the Right Arrow key to return to your regular font.</td>
</tr>
</tbody>
</table>

**SHORTCUT**

The Shortcut keyboard assigns some of the most common features to a macro, enabling quick access to these features with fewer keystrokes. The Shortcut keyboard includes the following key assignments:

<table>
<thead>
<tr>
<th>Key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alt-a</td>
<td>Adds an attribute to the text. Place your cursor on the attribute on code before selecting this option.</td>
</tr>
<tr>
<td>Alt-b</td>
<td>Subscript</td>
</tr>
<tr>
<td>Alt-d</td>
<td>Double Underline</td>
</tr>
<tr>
<td>Alt-e</td>
<td>Edit a Code (see Codes below)</td>
</tr>
<tr>
<td>Alt-f</td>
<td>Fine</td>
</tr>
<tr>
<td>Alt-g</td>
<td>Give printer a “Go”</td>
</tr>
<tr>
<td>Alt-i</td>
<td>Italics</td>
</tr>
<tr>
<td>Alt-l</td>
<td>Large</td>
</tr>
<tr>
<td>Alt-o</td>
<td>Outline</td>
</tr>
<tr>
<td>Alt-p</td>
<td>Superscript</td>
</tr>
<tr>
<td>Alt-r</td>
<td>Redline</td>
</tr>
<tr>
<td>Alt-s</td>
<td>Small</td>
</tr>
<tr>
<td>Alt-t</td>
<td>Strikeout</td>
</tr>
<tr>
<td>Alt-v</td>
<td>Very Large</td>
</tr>
<tr>
<td>Alt-w</td>
<td>Shadow</td>
</tr>
<tr>
<td>Alt-x</td>
<td>Extra Large</td>
</tr>
<tr>
<td>Ctrl-b</td>
<td>Base Font</td>
</tr>
<tr>
<td>Ctrl-c</td>
<td>Column Definition</td>
</tr>
</tbody>
</table>
### Key Description

<table>
<thead>
<tr>
<th>Key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl-d</td>
<td>Double Spacing (places a spacing code at the cursor position)</td>
</tr>
<tr>
<td>Ctrl-e</td>
<td>Create Endnote</td>
</tr>
<tr>
<td>Ctrl-f</td>
<td>Create Footnote</td>
</tr>
<tr>
<td>Ctrl-g</td>
<td>Create Figure Box</td>
</tr>
<tr>
<td>Ctrl-h</td>
<td>Create Header</td>
</tr>
<tr>
<td>Ctrl-i</td>
<td>Document Initial Codes</td>
</tr>
<tr>
<td>Ctrl-j</td>
<td>Justification</td>
</tr>
<tr>
<td>Ctrl-l</td>
<td>Margins, Left/Right</td>
</tr>
<tr>
<td>Ctrl-m</td>
<td>Margins, Top/Bottom</td>
</tr>
<tr>
<td>Ctrl-o</td>
<td>Create Footer A</td>
</tr>
<tr>
<td>Ctrl-p</td>
<td>Paper Size/Type</td>
</tr>
<tr>
<td>Ctrl-q</td>
<td>Create Equation</td>
</tr>
<tr>
<td>Ctrl-s</td>
<td>Single spacing (places a spacing code at the cursor position)</td>
</tr>
<tr>
<td>Ctrl-t</td>
<td>Tab Set</td>
</tr>
</tbody>
</table>

**Codes** • The Edit Code key on the Shortcut keyboard lets you edit a code for several features. To use the Edit Code key, position your cursor on the code, then press **Alt-e**. The following codes can be edited with **Alt-e**:

- Attribute On/Off
- Base Font
- Baseline Placement for Typesetters
- Center Page
- Column Definition
- Comment
- Conditional End of Page
- Cross-Reference
- Date
- Decimal/Align Character/Thousands' Separator
- Equation Options
- Footer
- Footnote/Endnote
- Force Odd/Even Page
- Graphics Boxes
- Graphics Lines
- Graphics Options
- Header
- Hyphenation Zone
- Justification
- Justification Limits
- Kerning
- Language
- Leading
- Line Height
- Line Numbering
- Line Spacing
- Margins, Left/Right
- Margins, Top/Bottom
- Math
- Outline Style
- Overstrike
- Page Number Insert
- Page Number Position
- Page Numbering, New
- Page Numbering Style
- Paper Size/Type
- Paragraph Numbering Definition
- Print Color
- Style
- Suppress
- Tab Set
- Table
- Target
- Underline Spaces and Tabs
- Widow Orphan On/Off
- Word and Letter Spacing
Appendix I: Macros and Merge, Comparison

Macros and Merge are both complex features that have many similarities, yet also important differences. Because these features can perform many of the same tasks, this section helps you better understand each feature and distinguish between them.

Before reading this section, we recommend that you familiarize yourself with Macros and Merge, as documented in the following sections:

- Macros
- Macros, Define
- Macros, Execute
- Macros, Macro Editor
- Macros, Message Display
- Merge
- Appendix J: Macros and Merge, Expressions
- Appendix K: Macros and Merge, Programming Commands
- Appendix M: Macros and Merge, Variables

### Similarities

**Commands**
Both Macros and Merge use a similar programming command language. Many of the major programming structures (IF structures, CASE structures, FOR and WHILE loops, global variables, subroutine branching structures) are identical, whether in a macro or merge file. See also Commands under Differences below.

**Macro-to-Merge Interface**
Either feature can initiate execution of the other, that is, a macro can execute a merge, and a merge can execute a macro (by nesting or chaining). This lets you take advantage of the abilities of both features to accomplish any given task.

**Overlap in Abilities**
Often the same task can be performed by either a macro or a merge. Depending on the nature of the task, one feature may be more efficient than the other in accomplishing the task.

**Repetition**
Both Macros and Merge control repetitive processes, and greatly enhance the flexibility of Corel WordPerfect and its ability to assist you in creating the documents you need.

### Differences

**Command Insertion**
Although you can define a macro at the normal editing screen when in macro define mode, macro programming commands must be inserted in the macro via the Macro Editor. In Merge, the codes are inserted in the document at the normal editing screen. There is no “Merge Editor.”

In Macros, when you select a command from the command access box, only the command itself is entered in the macro. You must then enter the arguments with their appropriate tildes (˜) yourself. In Merge, if you select a command that requires arguments, you are prompted for each argument, and the tildes are filled in.
Commands
Although there are many common programming commands between Macros and Merge, many are very different. Sometimes even the same command has important differences in function depending on whether it is in a macro or merge file.

For example, the User Interface commands \{CHAR\}, \{INPUT\}, \{PROMPT\}, \{TEXT\} in Macros allow cursor positioning codes to position the message of the command anywhere on the screen. In Merge, cursor positioning is not allowed. You must use a scrolling technique, or nest a macro to display large messages (see Message Display in Appendix K: Macros and Merge, Programming Commands).

In Merge, the \{LEN\} and \{MID\} commands can take full expressions (see Appendix J: Macros and Merge, Expressions and Command Syntax in Appendix K: Macros and Merge, Programming Commands) as arguments. In Macros, these commands can take only values as arguments. The differences between Macros and Merge for each command are outlined in Appendix K: Macros and Merge, Programming Commands.

In Macros, there are both programming commands and keystroke commands. Keystroke commands (such as \{Search\}, \{Left\}, \{Home\}, \{Mark Text\}, and so on) cannot be entered in a merge file. See Keystroke Commands in Variables in Appendix M: Macros and Merge, Variables for more information.

Execution
You execute a macro by using the Macro key. You execute a merge by using the Merge/Sort key.

In both Macros and Merge, you then enter the name of the file that will control the process. With Macros, you enter the name of a macro file. With Merge, you enter the name of a primary merge file.

In Macros, execution display defaults to off, but you can turn display on to see every keystroke as it is executed.

In Merge, execution is never displayed. You can use the \{REWRITE\} command to display on the screen the state of the merged document at that point, but this is only a checking device. You cannot display execution of a merge.

However, in both Macros and Merge, you can use the \{STEP ON\} command to check each step of execution.

File Format
Macro programming commands are stored in a file in a special format (.wpm format). All macro files must have the extension .wpm (added automatically when you define a macro).

Merge programming commands are stored in regular Corel WordPerfect documents. These documents may use any extension you can use for a Corel WordPerfect file.
**Formatting of Commands**
When editing a macro in the Macro Editor, pressing Tab or Return formats the commands, but does not place a code in the macro. The tabs and hard returns are completely ignored when the macro executes.

In Merge, because the non-command part of the file(s) is part of the resulting merged document, the formatting of the commands must be very carefully done. You can still use tabs and hard returns to make the commands more readable, but you must be careful to enclose them in a {COMMENT} command if you want to prevent them from appearing in the merged document (see the description of the [COMMENT] command in Appendix K: Macros and Merge, Programming Commands).

**General Process**
A macro is a recorded series of keystrokes. It is executed as if you were performing the same keystrokes at the console. The macro programming commands simply determine which keystrokes are executed in which order. Only the commands that are in the macro are performed.

A merge is the process of combining text from multiple sources into a single document. The merge programming commands give you control over the merge, affecting what text is merged in what order into the resultant document.

It is important, however, to know what parts of the merge Corel WordPerfect handles for you, without a specific command in the merge file. For example, Corel WordPerfect executes the primary file once for each record in a secondary file, unless you insert commands forcing it to do otherwise. Corel WordPerfect also automatically moves the record pointer (see Record Pointer at the end of Appendix K: Macros and Merge, Programming Commands) in the secondary file from one record to the next when an iteration of the primary file is complete. If you were not aware of how Corel WordPerfect handles the records, you might be tempted to put a [NEXT RECORD] command at the end of the primary file, causing the merge to skip every other record in the secondary file and insert a hard page between each iteration of the resulting document.

**Repetition**
Macros are most useful for repetitive keystroke activity. For example, you might create Quick Macro to save and print a document (see Macros, Define). The Quick Macro could replace the following keystrokes with a single keystroke: Save,Enter,y,Print,f.

Merge is most useful for repetitive text activity. For example, you might create a merge document that contains the text of a letter you frequently send to clients. The text of the letter would always be the same, but the client information would vary for each letter. When you perform the merge, the information for each client would then be substituted into each copy of the letter. If you had certain paragraphs that frequently but not always needed to be included in the letter, you could create a more complex merge document that would insert the paragraphs only when certain criteria were met.
Searching

The concept of searching is very different between Macros and Merge. Searching in Macros is very similar to searching in a document. You use the *Search or @Search key (represented by the {Search} and {Search Left} commands in a macro) to search forward or backward in a document for a string of text. Macro execution then depends on whether or not the text is found. You can use the {ON NOT FOUND} command to specify what should occur if the text is not found.

In Merge, searching is carried out in the context of fields and records. You can search a given field in all records of a secondary file, or you can check whether the contents of a given field in the current record are the same as the contents of a variable. But you cannot insert a {Search} or {ON NOT FOUND} command in a merge file to search for a specific string of text and branch accordingly, as with macros.

Records in a secondary file are searched in the order they occur in the secondary file, from top to bottom. You cannot search “backwards” through a secondary file. This order of procedure through records is governed by Corel WordPerfect and cannot be altered using programming commands, except by nesting, substituting, or chaining secondary files. (See Chaining, Nesting, and Substituting in Appendix K: Macros and Merge, Programming Commands for more information on the {CHAIN ...}, {NEST ...}, and {SUBST ...} commands available in merge. See also General Process above.)

Variables

Macros use only global variables. Merge can use the same global variables as Macros, but Merge can also use local variables. See Appendix L: Macros and Merge, Variables for more information on variables in Macros and Merge.

See Also: Macros; Macros, Define; Macros, Execute; Macros, Macro Editor; Macros, Message Display; Merge; Appendix J; Appendix K; Appendix M
Appendix J: Macros and Merge, Expressions

Expressions determine values in the {ASSIGN}, {CASE}, {CASE CALL}, {FOR}, {FOR EACH}, {IF}, {SHELL ASSIGN}, and {WHILE} commands in both Macros and Merge, and additionally in the {LEN}, {LOCAL}, {MID}, and {NTOC} commands in Merge (see Appendix K: Macros and Merge, Programming Commands). You can also use expressions to determine values for Alt-number variables. Expressions can perform operations on either numbers or strings of text.

An expression can contain up to 129 keystrokes. A keystroke can be a character, an extended character, a keystroke command (in Macros), or a programming command.

**Numeric Expressions**

Numeric expressions are listed below. The values must contain only integers (or variables which contain integers).

The highest positive number you should use is 2,147,483,647. Numbers higher than 2,147,483,647 are considered negative (Negative Numbers below). You can use signed numbers in expressions.

When performing multiplication or division, only one number can exceed ±65,535. For example, 65535*65536 is legal; 65536*65536 is not legal.

In the table, the terms n1 and n2 represent number 1 and number 2. Although only a single operator is illustrated in each example below, you can use several operators as well as parentheses in expressions. For definitions of the operations used in this table, see Expression Terms below.

<table>
<thead>
<tr>
<th>Expression</th>
<th>Operation</th>
</tr>
</thead>
<tbody>
<tr>
<td>!n1</td>
<td>Returns the logical NOT (bitwise) of the number n1 (see Expression Terms below). Example: !0 is –1.</td>
</tr>
<tr>
<td>–n1</td>
<td>Returns the negative of the number n1 (see Negative Numbers below). Example: If variable 1 holds 5, –{VARIABLE}1˜ is –5.</td>
</tr>
<tr>
<td>n1+n2</td>
<td>Returns the sum of n1 and n2. Example: 5+4 is 9.</td>
</tr>
<tr>
<td>n1–n2</td>
<td>Returns the difference of n1 and n2. Example: 10–1 is 9.</td>
</tr>
<tr>
<td>n1*n2</td>
<td>Returns the product of n1 and n2. Example: 6*5 is 30.</td>
</tr>
<tr>
<td>n1/n2</td>
<td>Returns the integer quotient of n1 and n2. Examples: 20/5 is 4. 5/2 is 2.</td>
</tr>
<tr>
<td>n1%n2</td>
<td>Returns the remainder of the quotient of n1 and n2. Examples: 20%5 is 0. 5%2 is 1.</td>
</tr>
<tr>
<td>n1&amp;n2</td>
<td>Returns the logical AND (bitwise) of n1 and n2 (see Expression Terms below). Examples: 7&amp;4 is 4. 3&amp;4 is 0.</td>
</tr>
<tr>
<td>n1</td>
<td>n2</td>
</tr>
<tr>
<td>Expression</td>
<td>Operation</td>
</tr>
<tr>
<td>------------</td>
<td>-----------</td>
</tr>
<tr>
<td>n1=n2</td>
<td>Returns a true value (–1) if n1 and n2 are equal; otherwise, returns a false value (0). Example: If variable 1 holds 5, then [\text{VARIABLE}1=5] is true and [\text{VARIABLE}1=3] is false.</td>
</tr>
<tr>
<td>n1!=n2</td>
<td>Returns a true value (–1) if n1 and n2 are not equal; otherwise, returns a false value (0). Example: If variable 1 holds 5, then [\text{VARIABLE}1!=3] is true and [\text{VARIABLE}1!=5] is false.</td>
</tr>
<tr>
<td>n1&gt;n2</td>
<td>Returns a true value (–1) if n1 is greater than n2; otherwise, returns a false value (0). Examples: 6&gt;4 is true. 4&gt;6 is false.</td>
</tr>
<tr>
<td>n1&lt;n2</td>
<td>Returns a true value (–1) if n1 is less than n2; otherwise, returns a false value (0). Examples: 2&lt;10 is true. 10&lt;2 is false.</td>
</tr>
</tbody>
</table>

If you try to use an invalid numeric expression (for example, incorrect use of operators, characters other than numbers and valid operators), the expression is simply treated as a text string.

### String Expressions

A string is a name for any sequence of one or more characters, including spaces. For example, “Apple”, “245”, “QB12”, “Z”, and “Personal Computer” are strings. Keyboard commands (for example, \{Enter\}, \{HPg\}) should be enclosed in string delimiters (‘ or ”) when they are part of an expression (see String Delimiters below).

String delimiters must also be used whenever you compare strings. If you are comparing the string contents of two variables, both variable commands must be enclosed in string delimiters. For example, \[\text{VARIABLE}x=\text{VARIABLE}y\].

The expressions outlined below compare strings. The terms s1 and s2 represent string 1 and string 2.

<table>
<thead>
<tr>
<th>Expression</th>
<th>Operation</th>
</tr>
</thead>
<tbody>
<tr>
<td>“s1”=”s2”</td>
<td>Returns a true value (–1) if string 1 is identical (including case) to string 2; otherwise, returns a false value (0). Examples: &quot;true&quot;=&quot;true&quot; is true. &quot;true&quot;=&quot;TRUE&quot; is false.</td>
</tr>
<tr>
<td>“s1”!=“s2”</td>
<td>Returns a true value (–1) if string 1 is not identical (including case) to string 2; otherwise, returns a false value (0). Examples: If variable 1 holds the string &quot;string&quot;, then &quot;[VARIABLE]1=&quot;rope&quot; is true. &quot;[VARIABLE]1=&quot;string&quot; is false.</td>
</tr>
<tr>
<td>“s1”&gt;“s2”</td>
<td>Returns a true value (–1) if string 1 is greater than string 2; otherwise, returns a false value (0). Examples: &quot;abcd&quot;&gt;&quot;aabcd&quot; is true. &quot;a&quot;&gt;&quot;A&quot; is true.</td>
</tr>
</tbody>
</table>
Expression Operation
"s1" < "s2" Returns a true value (–1) if string 1 is less than* string 2; otherwise, returns a false value (0). Examples:
"aab" < "abcd" is true. "A" < "a" is true.

*In a string comparison, the Corel WordPerfect character set values are compared. See Corel WordPerfect Character Set Values below for details.

If you do not use the delimiters correctly on s1, the expression is simply treated as a text string. If you do not use the delimiters correctly on s2, the expression evaluates as false.

Expression Evaluation
An expression must be written according to the rules in this appendix so it can be evaluated correctly. The following information will help you create and use expressions.

When an expression is encountered in a command, the expression is evaluated first, and the result of the expression completes the command. For example, in the statement {ASSIGN}1 *{VARIABLE}1 +1 , the expression is 
"{VARIABLE}1 +1 ." When the expression is evaluated, the contents of variable 1 are incremented by one. The assignment is then performed, replacing the old contents of variable 1 with the result of the expression.

In several of the expressions, the result of the operation is either true (–1) or false (0). A numeric value is assigned to true and false. These values were chosen because they are opposites (numeric complements) of each other (see NOT under Expression Terms below).

In the following example, the first assignment statement assigns false (0) to variable 1, the second assignment statement assigns true (–1), the complement of false, to variable 1, and the third assignment statement assigns true (–1) to variable 1.

{ASSIGN}1 =4
{ASSIGN}1 *{VARIABLE}1
{ASSIGN}1 =5*4

The order in which the various operators are applied in an expression is not simply the order in which they occur. The order of precedence determines which operators are used first, second, and so on. For example, in the expression 4+7*8, there is a different result depending on whether the addition is performed before or after the multiplication. Operator precedence is described below.

Operator Precedence
Corel WordPerfect supports expressions with several operators. Consequently, some order of evaluation must be followed. The operator precedence used by Corel WordPerfect is similar to the accepted precedence for mathematical operators in arithmetic. The following table shows the order that operators are applied:
1  – (unary minus), + (unary plus), ! (NOT)
2  * (multiply), / (divide), % (mod)
3  – (subtract), + (add)
4  < (less than), > (greater than), = (equal), != (not equal) (Relational operators also work on strings.)
5  & (AND), | (OR)

You can override the operator precedence by placing parentheses around those elements that you want to be evaluated first. Elements inside of parentheses are always evaluated before the elements outside. If parentheses are nested, the innermost parentheses are evaluated first.

In the expression 4+7*8, the multiplication (7*8) is performed first, followed by the addition. This is because multiplication has a higher precedence than addition. The result is 60. If you wanted the addition to be performed first, you would type (4+7)*8. In this case, the result is 88.

Notes

Expression Terms

The following technical terms are referenced above. An understanding of these terms is not an essential part of creating macros or performing merges. These definitions are provided for those who are somewhat familiar with programming.

AND (&) • A bitwise AND operation compares the bits of two numbers. When both numbers have a 1 bit in the same position (for example, there is a 1 bit in column 1 (right-most column) of the first number AND the second number), a 1 is placed in that position in the result. For example, the expression 21&47 is evaluated as follows:

<table>
<thead>
<tr>
<th>Value</th>
<th>Bits</th>
</tr>
</thead>
<tbody>
<tr>
<td>21</td>
<td>0000000000010101</td>
</tr>
<tr>
<td>47</td>
<td>0000000000010111</td>
</tr>
<tr>
<td>21&amp;47</td>
<td>0000000000000101</td>
</tr>
</tbody>
</table>

The resulting bits represent the number 5. So, 21&47=5.

Bitwise Operation • In the computer’s memory, numbers are represented as a series of sixteen 1s and 0s. Each of the 0s and 1s represents a bit. The pattern for each number is unique. The following table outlines some values and their corresponding bits:

<table>
<thead>
<tr>
<th>Value</th>
<th>Bits</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0000000000000000</td>
</tr>
<tr>
<td>–1</td>
<td>1111111111111111</td>
</tr>
<tr>
<td>–3</td>
<td>1111111111111111</td>
</tr>
<tr>
<td>–21</td>
<td>1111111111111111</td>
</tr>
<tr>
<td>3</td>
<td>0000000000000011</td>
</tr>
<tr>
<td>4</td>
<td>0000000000000010</td>
</tr>
<tr>
<td>7</td>
<td>0000000000000011</td>
</tr>
<tr>
<td>21</td>
<td>0000000000000101</td>
</tr>
</tbody>
</table>
A bitwise operation works on one column at a time, using a single bit from each number. The operation is done 16 times so each bit of each number is operated on.

**Evaluate the Expression** • Perform the operation(s) on the expression.

**NOT (!)** • A bitwise NOT operation takes the bits of the number and complements them. For example, if the expression is !0 (0 is 0000000000000000), the resulting value is –1 (–1 is 1111111111111111).

**OR (|)** • A bitwise OR operation compares the bits of both numbers. When either number has a 1 bit in the same position (for example, there is a 1 bit in column 1 (right-most column) of the first number OR the second number), a 1 is placed in that position in the result. For example, the expression 21|47 is evaluated as follows:

<table>
<thead>
<tr>
<th>Value</th>
<th>Bits</th>
</tr>
</thead>
<tbody>
<tr>
<td>21</td>
<td>0000000000010101</td>
</tr>
<tr>
<td>47</td>
<td>0000000000101111</td>
</tr>
<tr>
<td>21</td>
<td>47</td>
</tr>
</tbody>
</table>

The resulting bits represent the number 63. So, 21|47=63.

**Negative Numbers**
In Corel WordPerfect, negative numbers are represented as large positive numbers, from 2,147,483,648 to 4,294,967,295. 4,294,967,295 is –1, 4,294,967,294 is –2, and so on. To determine the number that represents any given negative number from –1 to –2,147,483,647, use the following formula:

\[ 4,294,967,296 - x \]

where \( x \) is the negative number whose equivalent you are trying to find. For example, to find the Corel WordPerfect equivalent of –3,

\[ 4,294,967,296 - 3 = 4,294,967,293 \]

To find the negative number represented by a given Corel WordPerfect equivalent, use this formula:

\[ x = 4,294,967,296 - \text{equivalent} \]

where \( x \) is the Corel WordPerfect equivalent. For example, to find the negative number represented by 4,294,967,293,

\[ 4,294,967,293 - 4,294,967,296 = -3 \]

You can assign variables to be negative numbers by using the minus (–) operator (see Numeric Expressions above), or by using the Corel WordPerfect equivalent. Do not use commas or other punctuation in the Corel WordPerfect equivalent. For example,

\{ASSIGN\}number˜–1˜
is the same as

{ASSIGN}number\textasciitilde4294967295\textasciitilde

**String Delimiters**
A string delimiter is a character which marks the beginning or end of a string. In string operations, the " and ' characters serve as string delimiters. Delimiters must be paired correctly. For example, the delimiters in "string" and 'string' are correctly paired, but in "string" they are not. However, one string can use the " character while the other uses the ' character (for example, "string" = 'string').

Whenever you compare any two items that are not numbers, you must use string delimiters around both strings.

**Corel WordPerfect Character Set Values**
Each character in each Corel WordPerfect character set is assigned a unique value (see the descriptions for the {KTON} and {NTOK} commands in Appendix K: Macros and Merge, Programming Commands). This is called the Corel WordPerfect character set value. In a string comparison, the character set values are compared.

For characters in the same character set, one character is considered “less than” another character if the first character comes before the second character. For example, in character set 0, “3” is less than “4” and “A” is less than “a.”

For characters in different character sets, the character from the character set with the lower numerical value is considered “less than” the character from the higher numerical character set. For example, any character from character set 2 is less than any character from character set 3.

**See Also:** Macros; Macros, Define; Macros, Execute; Macros, Macro Editor; Merge; Appendix I; Appendix K; Appendix M
Appendix K: Macros and Merge, Programming Commands

The Corel WordPerfect Programming Language commands let you control how macros and merges function. Those familiar with programming will recognize many commands as similar to those in other programming languages.

Some of the commands described in this section can be used only in macros, others only in merge files, and others can be used in both. The ♦ icon designates a command that is available in Macros; the ⊞ icon designates a command that is available in Merge. The presence of both icons indicates that the command is available in both features. When you see an icon in parentheses next to the command under the Programming Commands heading, it means that the command itself is not available in the feature, but there is an equivalent (or nearly equivalent) command or method in the feature that performs the same function as the command being described. Be sure to read further under the feature subheading for additional information.

Command Types

The programming commands can be categorized by the functions they perform. The categories are User Interface; Flow Control; Macro, Merge, or Subroutine Termination; External Condition Handling; Macro Execution; Variables; System Variables; Execution Control; Programming Aids; and Keystroke Commands.

User Interface • These commands communicate with the user. They display a prompt, allow input from the keyboard, or both. ([BELL] rings a bell.)

[BELL] [CHAR] [INPUT] [KEYBOARD] [LOOK] [ORIGINAL KEY] [PAUSE] [PAUSE KEY] [PROMPT] [STATUS PROMPT] [TEXT]

Flow Control • These commands can change the flow of macro or merge execution.

[BREAK] [CALL] [CASE] [CASE CALL] [CHAIN] [CHAIN MACRO] [CHAIN PRIMARY] [CHAIN SECONDARY] [ELSE] [END FOR] [END IF]
Macro, Merge, or Subroutine Termination • These commands will terminate a macro, merge, or subroutine.

**{BREAK]**
**{QUIT]**
**{RESTART]**
**{RETURN]**
**{RETURN CANCEL]**
**{RETURN ERROR]**
**{RETURN NOT FOUND]**
**{STOP]**

External Condition Handling • These commands determine how a condition outside of macro or merge execution is responded to (for example, when Cancel is pressed), or they create the condition.

†This is not a valid macro command in Corel WordPerfect for UNIX systems.
Macro Execution • These commands start a macro.

{CANCEL OFF}
{CANCEL ON}
{ON CANCEL}
{ON ERROR}
{ON NOT FOUND}
{RETURN CANCEL}
{RETURN ERROR}
{RETURN NOT FOUND}

Variables • These commands assign a value to a variable, determine the state of a variable, or execute (write out) a variable.

{ASSIGN}
{CHAR}
{IF EXISTS}
{LEN}
{LOCAL}
{LOOK}
{MID}
{NEXT}
{SYSTEM}
{TEXT}
{VAR n}
{VARIABLE}

System Variables • These commands determine the value of system variables.

{DATE}
{ORIGINAL KEY}
{STATE}
{SYSTEM}

Execution Control • These commands affect the speed or visibility of execution on the screen.

{DISPLAY OFF}
{DISPLAY ON}
Programming Aids • These commands can be used as programming aids.

• (; (Comment)
• {BELL}
• {COMMENT}
• {DISPLAY OFF}
• {DISPLAY ON}
• {SPEED}
• {STEP OFF}
• {STEP ON}

Keystroke Commands • These keys are mapped for the terminal you are using; however, you can change the key using the Keyboard Layout option in Setup (see Action under Keyboard Layout, Edit for information on mapping keys).

- [Block Append]
- [Block Copy]
- [Block Move]
- [Item Down]
- [Item Left]
- [Item Right]
- [Item Up]
- [Para Down]
- [Para Up]

Command Insertion
For information on how to insert Macro commands, see Macros, Macro Editor. For information on inserting Merge commands, see Inserting Merge Commands under Merge.

Command Syntax
Many of the commands use parameters or arguments which require a tilde (˜) at the end. If the tilde is missing, the macro or merge will not work correctly and may use subsequent commands as part of the arguments for the current command. If a macro or merge is not working properly, check to make sure all the comments and commands have their tilde marks correctly placed. (See also Troubleshooting under Notes at the end of this appendix.)

The syntax and arguments for each command are displayed in the command access box when you insert the command, and in each command heading below. In the arguments, var represents a variable. Expr represents a number, string, variable, command, or expression (or a combination). Additional argument types are described under each command.
The programming commands available in Macros and Merge are listed below.

The Macros Keyboard Definition (see Keyboard Layout) contains several macros. Studying these examples will help you see how some of the macro commands interrelate. The examples have numerous comments included, which help you follow the commands of the macro.

\{;\} comment ˜ ( ˜ )
The text you type between the comment command {;} and the tilde (˜) is ignored during macro execution. Comments are useful in helping to quickly recognize what each part of your macro does. You can also use comments to modify ("comment out") a section of your macro so it will not execute with the macro (see Commenting Out under Notes at the end of this appendix).

Macros • Comments can help you understand what is happening in the macro:

\{ASSIGN\}Phrase1 "One"
\{ASSIGN\}Phrase2 "Two"
\{ASSIGN\}Concatenation "One" + "Two"
\{;\}Assign\{VARIABLE\}Phrase1 "One"
\{;\}Assign\{VARIABLE\}Phrase2 "Two"
\{;\}Assign\{VARIABLE\}Concatenation "One" + "Two"
\{;\}Execute\{VARIABLE\}Concatenation (Type the string "One Two"

Note the centered dots (•) between many of the words. Spaces are represented this way in the Macro Editor. If the space were not between Phrase1 and Phrase2, the variable Concatenation would hold "OneTwo".

Merge • The \{COMMENT\} merge command is equivalent to the {;} macro command. See \{COMMENT\} below.

\{ASSIGN\}var " expr "
The \{ASSIGN\} command assigns to the global variable var the value returned by expr. Do not enclose the expression in quotes. Expressions are evaluated (see Appendix J: Macros and Merge, Expressions) and the result is assigned to the variable. Non-numeric characters and expressions that cannot be evaluated are treated as strings.

After a value has been assigned to a variable, the variable command (\{VARIABLE\} var ) can be placed anywhere you would normally place the variable contents. See Appendix M: Macros and Merge, Variables for more information on variables.

If you want to empty the variable of its contents, leave the expr argument empty (for example, \{ASSIGN\}Fred " ). It is a good idea to empty variables at the beginning of a macro or merge in which they are used (unless the macro or merge assigns new contents to them). When you empty a variable, it no longer "exists" (see {IF EXISTS} below).

Macros • In this example, variable Fred is first assigned a value, then an expression, then a string.
[ASSIGN]Fred \^3 \n
[;] Assign \# to variable Fred

[ASSIGN]Fred \{VARIABLE\}Fred \*2 \n
[;] Multiply old value of var Fred by 2, assign the result (6) as the new value of var Fred

[ASSIGN]Fred \{STRING\}Corel WordPerfect \n
[;] Assign \"Corel WordPerfect\" string to var Fred

See the Macro subheading under the following commands for additional examples: {;} (comment), {BREAK}, {ELSE}, {Item Down}, {Item Left}, {Item Right}, {Item Up}, {KTON}, {MID}, {STATE} (in text), {WHILE}.

**Merge** • To assign a local variable, see /LOCAL/ below.

In this example, variable Fred is first assigned a value, then an expression, then a string.

[ASSIGN]Fred \^3 \{COMMENT\}

Assign 3 to variable Fred

```
[ASSIGN]Fred \{VARIABLE\}Fred \*2 \{COMMENT\}
    Multiply old value of var Fred by 2, assign the result (6) as the new value of var Fred.
```

[ASSIGN]Fred \{STRING\}Corel WordPerfect \{COMMENT\}

Assign the string \"Corel WordPerfect\" to var Fred

See the Merge subheading under the following commands for additional examples: {CTON}, {IF}, {LEN}, {MID}, {NEST MACRO}, {PAGE ON}.

**BELL** \(\rightarrow\)

The {BELL} command causes your computer to sound a beep. This command is often useful in combination with the {CHAR}, {INPUT}, {KEYBOARD}, {PROMPT}, {STATUS PROMPT}, and {TEXT} commands which prompt the user to enter information. You can also use it to signal arrival at various points of the macro or merge, such as at the end of a lengthy process.

**Macros** • In this example, a bell will sound and the text \"Hello name.\" will be typed at the cursor position. The {BELL} command can also be placed inside the prompts for {CHAR}, {TEXT} and {PROMPT} commands (that is, {TEXT}1 \{BELL\}Please enter your name\).

```
{BELL}
{;}Sound a bell

{TEXT}Name \{PROMPT\}Please enter your name: \#

{;}Prompt for a name and place it in var Name

Hello {VARIABLE\}Name \#

{;}Type the message with the name that was entered
```

**Merge** • The following example checks the database.sf secondary file to see if the name entered by the user matches the Name field in one of the records in the file. If so, it asks for a password. If the name is not found in the secondary file, the user is notified that access is denied because he or she is not in the database.

The first {BELL} command in the example sounds a bell just before the name prompt. Within the IF structure, if the name is not found in the secondary file (the last record in the secondary file has \"End\" as the Name
field), a double bell sounds ([BELL][BELL]) at the error message “Access
denied.” If the name is found in the secondary file, another bell sounds at
the prompt to enter the password.

[BELL][TEXT]Name ‘Enter your name: ’ [COMMENT]
Sound a beep and prompt for a name. Place input in var Name
[NEST SECONDARY]database.sf’[COMMENT]
Begin using the database.sf secondary file. The record pointer is positioned at the first
record in the file.

[LABE]|CheckName’[COMMENT]
[IF]’[FIELD]Name ‘=’ [VARIABLE]Name ‘ ’ [COMMENT]
If the contents of the Name field and the var Name do not match
[IF]’[FIELD]Name ‘=’ [VARIABLE]Name ‘ ’ [COMMENT]
and if not at the end of the secondary file
[NEXT RECORD]’[COMMENT]
Move record pointer to the next record
[GO]’CheckName’[COMMENT]
Check the next record to find a match
[ELSE]’[COMMENT]
Otherwise (no match found in file)
[BELL][BELL][PROMPT]Access Denied–You are not entered in the database.
[WAIT]30’[COMMENT]
[STOP]’[COMMENT]
End the merge
[END IF]’[COMMENT]
[ELSE]’[COMMENT]
Otherwise (name found in file)
[BELL][TEXT]Password ‘Enter password: ’ [COMMENT]
[END IF]’[STOP]

{Block Append} ☺
{Block Append} is a keystroke command and works like the Append feature. It
appends a block of text to the end of a file that you designate. It is equivalent to
the keystrokes Move, Block (1), Append (4).

After this command executes, you are prompted for the name of the file to which
you wish to append. See Append for details.

Macros • Suppose, for example, that you wanted to compile a new
document from parts of one or more existing documents. Simply block each
section in the order that you want it to appear in the new document, then
execute the following macro after each block. Each block is appended to the
file listed as yourfile.wp.

{Block Append}
[;]Invoke•Block•Append ˜
yourfile.wp[Enter]
[;]Include•the•name•of•your•append•file ˜

The following two macros are equivalent:
{Block} {Word Right} {Block Append}
{Block} {Word Right} {Move} ba
Merge • This command is not available in Merge.

[Block Copy] ☞
[Block Copy] is a keystroke command and is a shortcut to copying a block in Macros. It is equivalent to the keystrokes Move, Block (1), Copy (2).

After this command executes, you are prompted to press Return at the point where you want to copy. You can cursor to this position or have your macro move to it.

Macros • For example, if you want to copy a block of text to the end of your document, first block the text, then run the following macro.

```
{Block Copy}
{;}Invoke•Block•Copy
{Home}{Home}{Down}
{;}Move•cursor•to•end•of•document
{Enter}
{;}Retrieve•block
```

The following two macros are equivalent:

- {Block}{Word Right}{Block Copy}
- {Block}{Word Right}{Move}bc

Merge • This command is not available in Merge.

[Block Move] ☞
[Block Move] is a keystroke command and is a shortcut to moving a block in Macros. It is equivalent to the keystrokes Move, Block (1), Move (1).

After this command executes, you are prompted to press Return at the point where you want to move to. You can cursor to this position or have your macro move to it.

Macros and Merge, Programming Commands • If Block is not on when the macro encounters [Block Move], the command will act like Delete Word and delete the word at the cursor.

Macros • For example, if you want to move a line of text to the beginning of your document, move the cursor to the line you want to move, then run the following macro.

```
{Home}{Home}{Left}
{;}Move•cursor•to•beginning•of•line
{Block}
{;}Turn•on•Block
{End}{Right}
{;}Move•cursor•past•the•HRt•or•SRt
{Block Move}
{;}Invoke•Block•Move
{Home}{Home}{Up}
{;}Move•cursor•to•beginning•of•document
{Enter}
{;}Insert•blocked•text
```
The following two macros are equivalent:

\{Block\}[Word Right][Block Move]

\{Block\}[Word Right][Move]bm

**Merge** • This command is not available in Merge.

**{BREAK}**

{BREAK} is useful when you want to skip some commands when a Cancel, Error, or Not Found condition occurs. Usually it is used to break out of a loop where several nested IF statements are used. The location of the command in the file determines its function.

The rules that govern how this command functions are listed below. Each of these rules assumes that the previous rules do not hold.

1. If a \{BREAK\} command is encountered within a FOR, FOR EACH, or WHILE structure, execution moves to the end of the structure (just after the \{END FOR\} or \{END WHILE\}). If these structures are nested, execution moves after the \{END FOR\} or \{END WHILE\} command of the current level.

2. If a \{BREAK\} command is encountered within an IF structure, execution moves to the end of the structure (just after the \{END IF\}). If the IF structure is nested within a \{FOR\}, \{FOR EACH\}, or a \{WHILE\} structure, the execution moved after the \{END FOR\} or the \{END WHILE\}. If the IF structures are nested, execution moves after the \{END IF\} command of the current IF structure.

3. If a \{BREAK\} command is encountered in a nested file, execution returns to the parent file.

4. If none of the above rules hold: In Macros, if a \{BREAK\} command is encountered, it is ignored. In Merge, if the \{BREAK\} command is encountered in a primary file, the primary file is ended and execution returns to the next iteration of the current primary file. If the \{BREAK\} command is encountered in a secondary file, the merge is terminated.

**Macros** • The following macro parses a full pathname entered by the user into path and filename portions. Notice that the \{BREAK\} command is within an IF structure, but is also within a FOR structure. The FOR structure takes precedence, so this \{BREAK\} command sends execution directly after the \{END FOR\} command (no more iterations of the FOR loop are performed), not after the \{END IF\} command (remaining iterations of the FOR loop would be performed).

```
{TEXT}String "Enter pathname:"
  [;] Ask \textit{to enter full pathname and assign it to var String} 
{ASSIGN}Length "[LEN]String" 
  [;] Assign \textit{length of full pathname} to var \textit{Length} 
{FOR}Pos \textit{[VARIABLE]}Length \textit{-1} \textit{-1} 
  [;] From \textit{last character to first...} 
{ASSIGN}Char "[MID]String \textit{[VARIABLE]}Pos \textit{-1}"
```
Assign the character to var Char.

IF "VAR Char = '/""
  Assign the character to var Pos + 1
  Assign the length of the path (not pathname) to var Pathlen
  Assign the path portion of var String to var Path
  Assign the length of the filename to var Filelen
  Assign the filename portion of var String to var File
  [BREAK]
  Break out of the FOR loop.
ENDIF END IF END FOR

[END IF]
[END FOR]

[CHAR] Foo Path: [VAR path] Filename: [VAR file] ...
...press Enter
Display the path and filename portions until user presses a key.

Merge • In the following example, the message “Counting...#” is displayed until it has counted up to 9. Then the message “I am no longer counting.” is displayed.

Assign Counter 0 [COMMENT]
Initialize var Counter
Assign Stop 9 [COMMENT]
Assign the stop value
[LABEL] Count [COMMENT]
[IF] VAR Counter = VAR Stop [COMMENT]
If var Counter has reached 9
  [BREAK][COMMENT]
  Break to the end of the IF statement
[ELSE][COMMENT]
Otherwise
  [ASSIGN] Counter [VAR Counter + 1][COMMENT]
  Increment var Counter
  [PROMPT] Counting... [VAR Counter][COMMENT]
  Send a message
  [WAIT] 5 [COMMENT]
  Wait .5 seconds
  [GO] Count [COMMENT]
  Repeat the loop
[END IF][COMMENT]
End of IF statement
[PROMPT] I am no longer counting.[COMMENT]
Send a message
[WAIT] 20 [COMMENT]
Display the message for 2 seconds
[QUIT][COMMENT]
End the merge

Appendix K: Macros and Merge, Programming Commands 601
The {CALL} command transfers execution to the subroutine label. When execution of the subroutine is completed (when a {RETURN} is encountered in the subroutine), execution returns to the command following {CALL}. (See Subroutines under Notes at the end of this appendix for more information about subroutines. See also Levels under Notes at the end of this appendix.)

**Macros** • In the following example, the macro searches for “test”. When it finds it, the macro deletes the entire line on which “test” was found. Then the macro inserts the bolded phrase “This line was deleted.”

```
{LABEL}SearchLoop
  •Begin•SearchLoop•subroutine  
  •Search•test{Search}
  •CALL•Delete
  •;Commence•Delete•subroutine  
  •[Bold][This•line•was•deleted][Bold][Enter]
  •;Place•the•bolded•message•in•the•document•after•line•is•deleted  
  •[GO]{SearchLoop
  •;Repeat•SearchLoop•subroutine  

{LABEL}Delete
  •;Subroutine•Delete  
  •[Home][Home][Left]
  •;Move•to•beginning•of•line  
  •[Del to EOL]
  •;Delete•the•line  
{RETURN}
```

**Merge** • In the following example, the merge checks the Name field in the current record of the secondary merge file. If the name is not blank, the salutation “Dear {FIELD}Name[{HRt}][HRt]” is written in the merged document. If the name is blank, a generic salutation “Dear Sir or Madam:[HRt]” is written.

```
{LABEL}Top
  •[COMMENT]
  •[IF BLANK]{Name} {COMMENT}
    •If the name field is blank
    •{CALL}{Generic} {COMMENT}
      •Call the subroutine “Generic”
    •[ELSE]{COMMENT}
      •Otherwise, write a name-specific salutation using the information in the Name field
      •“Dear {FIELD}Name” {COMMENT}
    •[END IF]{COMMENT}
      •End the IF statement
  •[RETURN]{COMMENT}
    •End of Top routine, return to point where Top was called.

  •[LABEL]{Generic} {COMMENT}
    •“Dear Sir or Madam:
  {RETURN}
```

602 Appendix K: Macros and Merge, Programming Commands
The {CANCEL OFF} command stops the Cancel key from performing its normal function. The default condition is for Cancel to be enabled ({CANCEL ON}).

Once you have turned off Cancel with this command, you must use the UNIX kill command to cancel the macro or merge during execution. Use caution when using the {CANCEL OFF} command.

Macros • In the following example, the macro pauses at the {INPUT} command to let the user edit the text of the document. The {CANCEL OFF} command lets the user press Cancel to undelete text while editing.

```
{CANCEL OFF}
{INPUT}Edit the desired text. Press Enter when done. {CANCEL OFF}
```

{CANCEL ON}

The {CANCEL OFF} command lets the user press Cancel to undelete text without terminating the {INPUT}.

{CANCEL ON} is also useful if you want to be able to get a Cancel key as input from the user in the {CHAR}, {LOOK}, or {PAUSE} commands.

Merge • In the following example, the merge pauses at the {INPUT} command to let the user edit the text of the document. The {CANCEL OFF} command lets the user press Cancel to undelete text while editing.

```
{CANCEL OFF}{COMMENT}
{INPUT}Type the text of the memo. Press End Field when done. {COMMENT}
```

{CANCEL ON}{COMMENT}

The {CANCEL OFF} command lets the user press Cancel to undelete text without terminating the {INPUT}.

{CANCEL ON} is also useful if you want to prevent a user from stopping a merge (by pressing Cancel) at a {CHAR}, or {LOOK} command.

The {CANCEL ON} command enables the Cancel key after it has been disabled with the {CANCEL OFF} command (see /CANCEL OFF/ above).

Macros • See the Macros subheading under /CANCEL OFF/ above for an example of how to use this command.

Merge • See the Merge subheading under /CANCEL OFF/ above for an example of how to use this command.

The {CASE} command allows execution to branch to different locations in the file (designated by label1, label2, and so on) (see also Subroutines under Notes at the end of this appendix), depending on what the value returned by expr is. The value returned by expr is compared to each case. When a match is found,
execution branches to the corresponding label. For example, your macro or merge might ask the user to answer Yes or No to a prompt. If the answer is Yes, one function will be performed. If the answer is No, another function will be performed. It is often helpful to format the {CASE} statement (place it on several lines) so it is more readable. Notice that there is an extra tilde (˜) required at the end of the {CASE} statement.

The variable contents must match a case exactly. For example, a case of “y” will match “y” but not “Y”. If no match is found in the {CASE} statement, execution continues after the {CASE} statement. You can use an {OTHERWISE} command as the last case in the command to handle all cases that do not match.

It is possible to use the {ELSE} command instead of the {OTHERWISE} command to handle cases that do not match. However, using {ELSE} will produce an error if the {CASE} command is within an IF statement. For this reason, we recommend that you use {OTHERWISE}. The {CASE} command does not require that program execution return after the routine is completed. In other words, it does not call the routine; rather, it goes to the routine. If you want program execution to return, use {CASE CALL} (see {CASE CALL} below).

**Macros**  
In this example, the Error subroutine is not executed unless a character other than n or y is pressed. If the {CASE} command is changed to {CASE CALL}, the subroutines are called, and execution returns to the {QUIT} command.

```plaintext
[CASE][VARIABLE]Answer ˜
    y ˜ Yes ˜
    Y ˜ Yes ˜
    n ˜ No ˜
    N ˜ No ˜
    {OTHERWISE} ˜Error ˜
```

See the Macros subheading under /CHAR/ for an additional example.

**Merge**  
In this example, the Error subroutine is not executed unless a character other than n or y is pressed. If the {CASE} command is changed to {CASE CALL}, the subroutines are called, and execution returns to the {STOP} command.

```plaintext
[CASE][VARIABLE]Answer ˜
    y ˜ Yes ˜
    Y ˜ Yes ˜
    n ˜ No ˜
    N ˜ No ˜
    {OTHERWISE} ˜Error ˜
```

604 Appendix K: Macros and Merge, Programming Commands
If var Answer contains y or Y, go to label Y es; if var Answer contains n or N, go to label No. Otherwise, go to label Error.

See the Merge subheading under Commentary for an example of how to use these commands.

**CASE CALL**

The **CASE CALL** command is similar to the **CASE** command in that it can branch to different subroutines. The difference is that **CASE CALL** requires that execution return after a subroutine has executed (see **CASE** above).

**Macros**

In the following example, the user is prompted to select an author. The **CASE CALL** command allows the user to select the author by number or letter (note the ^V)s which turn on and ^Q)s which turn off the mnemonic attribute (see Macros, Message Display). If a correct number or letter is not selected, the [OTHERWISE] case executes the routine again. Once the subroutine corresponding to the option selected is executed, execution returns to the [LABEL]GetType command.

```
{LABEL}GetType
{CHAR}Author
{^V}1•J•oe;•{^V}2•S•ue;•{^V}3•M•arco:

{CASE CALL} [VARIABLE] Author
1 ˜ J o e
j ˜ J o e
J ˜ J o e

2 ˜ S u e
s ˜ S u e
S ˜ S u e

3 ˜ M arco
m ˜ M arco
M ˜ M arco

[OTHERWISE] GetAuthor

{;} Notice the extra tilde to end the CASE statement

{LABEL}GetType
```

**Merge**

In the following example, the user is prompted to select an author. The **CASE CALL** command allows the user to select the author by number. If a correct number is not selected, the [OTHERWISE] case
executes the routine again. Once the subroutine corresponding to the option selected is executed, execution returns to the \{LABEL\}GetType\* command.

\{LABEL\}GetAuthor \*\{COMMENT\}
\{CHAR\}Author 1 Joe; 2 Sue; 3 Marco: \*\{COMMENT\}
  Prompt user for author
\{CASE CALL\}\{VARIABLE\}Author
  1  [Joe]
  2  [Sue]
  3  [Marco]
  \{OTHERWISE\} GetAuthor
  \*\{COMMENT\}
  If user enters 1, call subroutine Joe. If user enters 2, call subroutine Sue. If user enters 3, call subroutine Marco. Otherwise, send prompt again. Notice the extra tilde to end the CASE statement.
\{LABEL\}GetType

\{CHAIN\}macro

The \{CHAIN\} command stores the name of the indicated macro and executes it after the current macro is completed. You can enter a full pathname if you wish (the .wpm extension is not necessary).

You can chain one macro at each level of nesting (see \textit{Levels} under \textit{Notes} at the end of this appendix). If more than one macro is chained at the current nest level, only the last macro chained is executed when the current macro is completed.

See \textit{Chaining, Nesting, and Substituting} under \textit{Notes} at the end of this appendix for more information on chaining.

\textbf{Macros}\hspace{1em} The following macro executes a loop until the search text is not found. When the search fails, the loop is exited, completing the current macro. Execution is then transferred to the chained macro (notfound.wpm).

\{CHAIN\}NotFound
  \{;\} Execute the NOTFOUND macro when this macro is completed
  \{ON NOT FOUND\} \{RETURN\}
  \{;\} When the search fails, stop this macro, and start the chained macro
  \{LABEL\}Loop
  \{;\} Begin the repeating subroutine
  \{Search\} at \{Search\}
  \{;\} Search for "at"
  \{PAUSE\}
  \{;\} Pause (allow user to edit)
  \{GO\} Loop
  \{;\} Search was successful, repeat the search

\textit{The section of the macro between the \{LABEL\} and \{GO\} commands is repeatedly executed until the search fails. As soon as the search fails, the notfound macro begins.}
Notice the [ON NOT FOUND][RETURN] command. If a macro is not nested and has not been called with [CALL] or [CASE CALL], [RETURN] ends the macro (see [RETURN] below).

**Merge** • The [CHAIN] command in Macros is equivalent to the [CHAIN MACRO] command in Merge. See [CHAIN MACRO] below.

**{CHAIN MACRO}**

The [CHAIN MACRO] merge command starts the named macro at the end of the merge, if the merge terminates normally. You can enter a full pathname for the *macroname* if you wish. You need not enter the .wpm extension.

Only the last macro chained during the merge is executed.

See Chaining, Nesting, and Substituting under Notes at the end of this appendix for more information on chaining.

In previous versions of Corel WordPerfect, this merge command was represented as ^G +macroname ^G.

**Macros** • The [CHAIN] command in Macros is equivalent to the [CHAIN MACRO] command in Merge. See [CHAIN] above.

**Merge** • In the following example, the chained macro print.wpm prints the resulting merge file when the merge is complete.

```
{CHAIN MACRO}print " {COMMENT}
  Chain the macro print.wpm when the merge is complete
  {DATE}

Dear [FIELD]Name ,

  (rest of the letter)

Sincerely,

Chris Smith
```

**{CHAIN PRIMARY}**

This merge command continues the merge with the named primary file as soon as the current primary file is complete. You can enter a full pathname for the *filename*.

See Chaining, Nesting, and Substituting under Notes at the end of this appendix for more information on chaining.

**Macros** • This command is not available in Macros.

**Merge** • The [CHAIN PRIMARY]envelope command in the following example executes the envelope.pf primary file after the last iteration of the current primary file.

```
{CHAIN PRIMARY}envelope
  (rest of current primary file)
```
This merge command begins using records from the named secondary file when the end of the current secondary file is reached. This command is especially useful if you have broken a large secondary file into several smaller files. If you insert a `{CHAIN SECONDARY}` command in each smaller secondary file, they will act like one secondary file.

You can use a full pathname for `filename` if you wish.

See Chaining, Nesting, and Substituting under Notes at the end of this appendix for more information on chaining.

**Macros** • This command is not available in Macros.

**Merge** • The following example shows how a large secondary file has been broken into two smaller files. When a merge is executed using the first secondary file, the records of the second file will be used as soon as those in the first file are completed.

Large File:

```plaintext
{FIELD NAMES}
Name ˜
Status ˜
"[END RECORD]

Jose[END FIELD]
Staff[END FIELD]
[END RECORD]

• (additional records)

•

Barbara[END FIELD]
Professional[END FIELD]
[END RECORD]

Julie[END FIELD]
Part-time[END FIELD]
[END RECORD]

• (additional records)

•

Shoji[END FIELD]
Leave of Absence[END FIELD]
[END RECORD]
```

---

608 Appendix K: Macros and Merge, Programming Commands
First Small File:

{FIELD NAMES}
Name˜
Status˜
˜{COMMENT}
˜{PROCESS}{CHAIN SECONDARY}file2˜{PROCESS}{COMMENT}
The {PROCESS} commands ensure that the {CHAIN SECONDARY} command executes. The merge remembers the {CHAIN SECONDARY} command and filename so that it can execute it when the current secondary file has ended.

˜{END RECORD}

===========================================================
Jose{END FIELD}
Staff{END FIELD}
{END RECORD}

•
• (additional records)
•

=================================================================
Barbara{END FIELD}
Professional{END FIELD}
{END RECORD}

=================================================================
Second Small File (named file2, and in the default directory):

{FIELD NAMES}
Name˜
Status˜
˜{END RECORD}

=================================================================
Julie{END FIELD}
Part-time{END FIELD}
{END RECORD}

•
• (additional records)
•

=================================================================
Shoji{END FIELD}
Leave of Absence{END FIELD}
{END RECORD}

{CHAR}var “message”

This command is useful for creating menus and prompts. The {CHAR} command prompts the user with the message and waits until a single key is pressed. The key is then assigned to the indicated variable (see Appendix M: Macros and Merge, Variables). If Cancel is pressed, the macro or merge ends unless the {CANCEL OFF} or {ON CANCEL} commands have been previously executed. Once the key has been assigned to the variable, a {CASE},

Appendix K: Macros and Merge, Programming Commands 609
{CASE CALL}, or {IF} command can be used to perform different operations depending on the key pressed.

See Message Display under Notes at the end of this appendix, and Macros, Message Display for information on affecting the way messages are displayed. See also Prompting and User Input under Notes at the end of this appendix.

After the {CHAR} command executes, the contents of the status line just previous to the execution of the {CHAR} command are restored. Use {PROMPT}˜ or {STATUS PROMPT}˜ before the {CHAR} command to clear the status line.

**Macros •** The user can press any key as the input (including a feature key such as Search). In the following example, the user is prompted to select a type of document, after which a subroutine is executed based on what the user entered.

```plaintext
{CHAR}DocType ˜1•Memo;•2•Letter;•3•Itinerary:•• ˜
{CASE}{VARIABLE}DocType ˜
  1 •Memo ˜
  2 •Letter ˜
  3 •Itin ˜

{;}Check var DocType and branch to the appropriate subroutine ˜
```

See the Macros subheading under the following commands for additional examples: {BREAK}, {CASE}, {CASE CALL}, {KTON}, {RESTART}.

**Merge •** See the Merge subheading under the following commands for examples of how to use this command: {CASE}, {CASE CALL}, {CTON}.

**COMMENT**

Use this merge command to put comments in a primary or secondary merge file to make it easier to understand. You can also use this command to format the merge commands so that they are more readable, without inserting extra hard return or tab codes in the document.

**Macros •** The {COMMENT} command in Merge is equivalent to the {;} (comment) command in Macros (see {;} above).

**Merge •** The following shows how you can use the {COMMENT} command to format the primary document. This merge creates a list of employees and their salaries. The secondary file has three fields: Name, Type, and Salary. Any record in the secondary file that has 1, 2, or 7 in the Type field is not merged into the list.

```plaintext
{LABEL}List „{COMMENT} This comment prevents the insertion of a [HRt] between execution of the {LABEL} command and the {LOCAL} command.

„{LOCAL}Type „{FIELD}Type „„{COMMENT} This comment prevents the insertion of a [HRt] between execution of the {LOCAL} and {CASE CALL} commands.

„{CASE}{VARIABLE}Type „
  1 „Next „
```
Notice that there is no need for a {COMMENT} command between the cases. Since these are all part of the same command, no [HRt] will be inserted. The {COMMENT} command after the {CASE} command is necessary to prevent the insertion of [HRt] codes between the execution of the {CASE} command and the {LABEL}WriteIt command.

```
"[LABEL]WriteIt"[COMMENT]
This comment prevents the hard return between the [LABEL] command and [FIELD] command from appearing in the resulting document.
```

```
"[FIELD]Name"
[FIELD]Salary"[COMMENT]
```

No comment command was inserted between the [FIELD] commands so that in the document resulting from the merge, the Name and Salary field information will be separated by a [HRt]. Notice the position of this {COMMENT} command. This positioning will put two [HRt] codes between each Name-Salary pair in the resulting list.

```
"[LABEL]Next"[COMMENT]
"[NEXT RECORD]"[COMMENT]
"[GO]List"[COMMENT]
```

See the other Merge examples in this section to see more on how to use this command.

**{CTON}character**

The {CTON} merge command (Character TO Number) converts character (which may be any character in the Corel WordPerfect character sets) to a unique number, its Corel WordPerfect “key value.” {CTON} performs the inverse (opposite) function of the {NTOC} command (see **{NTOC}** below). You can use the key value to calculate the Corel WordPerfect character set value.

To calculate the character set value for a given character,

1. Use the {CTON} command to obtain the key value.
2. Divide the key value by 256.

The quotient is the number of the Corel WordPerfect character set (0-12). The remainder is the character number in the character set (0-255).

**Macros**

- This command is not available in Macros. However, the {KTON} macros command is very similar to the {CTON} merge command. See **{KTON}** below.

**Merge**

- This example calculates the character set value for a character:

```
{CHAR}Char "Type a character:"[COMMENT]
Assign input to var Char
"[ASSIGN]Set"[CTON][VARIABLE]Char "/256"[COMMENT]
Assign quotient to var Set
```
Assign remainder to var Num
“[VARIABLE]Set.”,[VARIABLE]Num “[COMMENT]
Write out character set value”

{DATE} ( فهي )
The {DATE} merge command inserts the current date and/or time in the
document, as formatted in Date Format.

*In previous versions of Corel WordPerfect, this merge command was represented as ^D.*

**Macros** • Although this command is not available in Macros, you can
program a macro to access the Date feature, such as in the following
example:

This document was printed::: [Date/Outline]c

{Date/Outline} may be inserted in the macro by pressing Date/Outline. When the macro is
executed, [Date/Outline]c will select Date Code from the Date/Outline menu.

**Merge** • You can use either this command, or the Date Code (see Date)
to insert the current date in merged documents. The first example below uses
the [DATE] command; the second example shows how to achieve the same
result using the Date Code.

Example 1:

{DATE}

{FIELD}Name—
{FIELD}Address—

Example 2:

See the Merge subheading under the following commands for additional
examples: [CHAIN MACRO], {KEYBOARD}, {PRINT}, {QUIT},
{REWRITE}.
The `DISPLAY OFF` macro command turns off the display of macro execution. If this command were not present, each action of the macro would be rapidly displayed on the screen as it was executed. In many cases, you may want to turn the display off because macro execution is faster when it does not display.

When you create a macro, the `DISPLAY OFF` command is inserted at the beginning of the macro. You can delete this command if you want the macro to display execution. (Exceptions: If you create a macro at the normal editing screen that ends at a menu or includes a `{PAUSE}` or `{PAUSE KEY}` command, the `DISPLAY OFF` command is not inserted.)

If you use this command to turn display off, the screen is not automatically cleared. Whatever is on the screen will remain on the screen (unless another command overwrites it) while the macro is executing.

If display is off when a `{PAUSE}` or `{PAUSE KEY}` (see `{PAUSE}` and `{PAUSE KEY}` below) is executed, the screen does not rewrite. The user will probably not know what to do at the pause. You should be sure to turn on display before using one of these commands.

Messages in the `{CHAR}`, `{INPUT}`, `{PROMPT}`, and `{TEXT}` commands always display on the screen, even when display is off.

**Macros** • In the following example, display is off until the file is ready to be printed. The `DISPLAY ON` command just before the `{Print}` command allows the Print menu to display.

```
{DISPLAY OFF}
{Home}{Home}{Up}
;;Move•to•beginning•of•file
{Replace}n[Search][Search]
;;Replace•"•with•"•w/o•confirm
{Home}{Home}{Up}
;;Move•the•cursor•to•the•top•of•the•file
{Replace}n[Search][Search]
;;Replace•"•with•"•w/o•confirm
{DISPLAY ON}
;;Turn•on•display•to•allow•menu•to•display
{Print}S
;;Display•printer•select•menu
```

**Merge** • This command is not available in Merge. Merges are always invisible unless you use the `{REWRITE}` command to rewrite the screen.

The `DISPLAY ON` macro command turns on the display of macro execution after it has been turned off by the `DISPLAY OFF` command (see `DISPLAY OFF` above). Display On is the default for macro execution. Macro execution is slower when display is on.
[DISPLAY ON] does not itself rewrite the screen. The screen is only rewritten when a command subsequent to the [DISPLAY ON] command performs an action that rewrites the screen.

**Macros** • See the **Macro** subheading under the following commands for examples of how to use this command: {DISPLAY OFF}, {MENU OFF}.

**Merge** • This command is not available in Merge. Merges are always invisible unless you use the [REWRITE] command to rewrite the screen.

**[DOCUMENT] filename**

The [DOCUMENT] merge command inserts the named document into the merged document at the point the command is encountered. The document is not processed, so any merge commands in the inserted document are ignored. This command is commonly used for inserting variable paragraphs in contracts and similar documents, often called *document assembly*, or to have the merge build a primary or secondary file.

**Macros** • This command is not available in Macros. However, you can perform a similar function with the following macro:

```
{Retrieve}document.wp{Enter}
```

These commands retrieve document.wp into the current document.

**Merge** • In the following example, the [DOCUMENT] command inserts the document called oneroom.mrg in the merged document if variable Rooms is equal to 1, or the document tworooms.mrg if variable Rooms is not equal to 1.

```
{IF} {VARIABLE} Rooms = 1 {COMMENT} 
   {DOCUMENT} oneroom.mrg {COMMENT} 
{ELSE} {DOCUMENT} tworooms.mrg {COMMENT} 
{END IF}
```

**[ELSE]**

The [ELSE] command is used in connection with the [IF], [IF BLANK], [IF EXISTS], [IF NOT BLANK], and [END IF] commands. It marks the beginning of the commands which execute should the IF value be zero (false) (see [IF] below).

The [ELSE] command is not a required part of an IF statement. It should be used when there are certain steps that need to be performed only when the IF value is zero (false). The commands below [END IF] execute whether or not the IF value is true.

It is possible to use the [ELSE] command instead of the [OTHERWISE] command to handle cases that do not match in a [CASE] or [CASE CALL] command. However, [ELSE] will not function correctly if the CASE statement is within an IF statement.

**Macros** • In the example below, if variable Number contains a negative number, add 2. If not, subtract 2.

```
{IF} {VARIABLE} Number < 0 {COMMENT}
   ; If var Number is less than 0
{END IF}
```
```plaintext
{ASSIGN}Number \{VARIABLE}Number \+2
{;}Add\+2\+to\+var\+Number
{ELSE}
{;}If\+not
{ASSIGN}Number \{VARIABLE}Number \-2
{;}subtract\-2\+from\+var\+Number
{END\+IF}
{;}End\+of\+{IF}\+statement
See\+the\+Macros\+subheading\+under\+the\+following\+commands\+for\+additional\+examples:\+{IF\+EXISTS},\+\{Item\+Down\},\+\{Item\+Left\},\+\{Item\+Right\},\+\{Item\+Up\},\+\{RESTART\},\+\{STATE\}.

See\+the\+Macros\+subheading\+under\+the\+following\+commands\+for\+additional\+examples:\+{IF\+EXISTS},\+\{Item\+Down\},\+\{Item\+Left\},\+\{Item\+Right\},\+\{Item\+Up\},\+\{RESTART\},\+\{STATE\}.

Merge\+•\+See\+the\+Merge\+subheading\+under\+the\+following\+commands\+for\+examples\+of\+how\+to\+use\+this\+command:\+\{DOCUMENT\},\+\{IF\},\+\{IF\+BLANK\},\+\{IF\+EXISTS\},\+\{LOOK\},\+\{NEST\+MACRO\},\+\{NEXT\+RECORD\},\+\{SUBST\+PRIMARY\}.

{END\+FIELD}\+•\+The\+\{END\+FIELD\}\+merge\+command\+signals\+the\+end\+of\+a\+field\+in\+a\+secondary\+file.\+\+A\+Hard\+Return\+\[HRt\]\+is\+automatically\+inserted\+with\+this\+command\+for\+better\+readability.

When\+you\+insert\+this\+command,\+a\+message\+appears\+at\+the\+bottom\+of\+the\+screen\+that\+lets\+you\+know\+the\+number\+of\+the\+field\+where\+the\+cursor\+is\+currently\+located.\+If\+you\+use\+the\+\{FIELD\+NAMES\}\+command,\+the\+name\+of\+the\+field\+appears\+instead\+of\+the\+number.\+Pressing\+Home,\+Home,\+Up\+Arrow\+will\+temporarily\+remove\+the\+message\+from\+the\+screen.\+However,\+as\+long\+as\+you\+have\+an\+\{END\+FIELD\},\+\{END\+RECORD\},\+or\+\{FIELD\+NAMES\}\+command\+in\+the\+file,\+the\+message\+will\+display\+when\+the\+cursor\+is\+after\+the\+command.\+If\+you\+delete\+all\+the\+\{END\+FIELD\},\+\{END\+RECORD\},\+and\+\{FIELD\+NAMES\}\+commands\+from\+the\+file,\+then\+press\+Home,\+Home,\+Up\+Arrow,\+the\+message\+will\+not\+reappear.

In\+previous\+versions\+of\+Corel\+WordPerfect,\+this\+merge\+command\+was\+represented\+by\+\(^\text{R}\).

Macros\+•\+This\+command\+is\+not\+available\+in\+Macros.

Merge\+•\+Records\+in\+the\+following\+secondary\+file\+have\+three\+fields:

International\+Exporting{END\+FIELD}
(801)\+555-4421{END\+FIELD}
George\+Wiley{END\+FIELD}
{END\+RECORD}
============================================================================
Tradewinds,\+Inc.{END\+FIELD}
(409)\+555-3567{END\+FIELD}
Susan\+Escher{END\+FIELD}
{END\+RECORD}
============================================================================

See\+the\+Merge\+subheading\+under\+the\+following\+commands\+for\+additional\+examples:\+\{CHAIN\+SECONDARY\},\+\{FIELD\+NAMES\}.
```
**{END FOR}**

This command signals the end of a {FOR} or {FOR EACH} loop (see {FOR} and {FOR EACH} below).

**Macros** • See the Macros subheading under the following commands for examples of how to use this command: {BREAK}, {FOR}, {FOR EACH}, {NEXT}.

**Merge** • See the Merge subheading under the following commands for examples of how to use this command: {FOR}, {MID}, {NEXT}.

**{END IF}**

The {END IF} command marks the end of an IF structure and is used with the {IF}, {IF BLANK}, {IF EXISTS}, {IF NOT BLANK}, and {ELSE} commands.

**Macros** • See the Macros subheading under the following commands for examples of how to use this command: {BREAK}, {ELSE}, {GO}, {IF}, {IF EXISTS}, {Item Down}, {Item Left}, {Item Right}, {Item Up}, {LEN}, {LOOK}, {NEXT}, {ORIGINAL KEY}, {RESTART}, {STATE} (in text).

**Merge** • See the Merge subheading under the following commands for examples of how to use this command: {BELL}, {CALL}, {DOCUMENT}, {GO}, {IF}, {IF BLANK}, {IF EXISTS}, {IF NOT BLANK}, {MID}, {NEST MACRO}, {NEST PRIMARY}, {NEST SECONDARY}, {NEXT}, {NEXT RECORD}, {SUBST PRIMARY}, {SUBST SECONDARY}.

**{END RECORD}**

This merge command signals the end of a record in a secondary file. A hard page break is inserted automatically with this code for better readability. When you insert this command, a message appears at the bottom of the screen that lets you know the number of the field where the cursor is currently located. If you use the {FIELD NAMES} command, the name of the field appears instead of the number. Pressing Home, Home, Up Arrow will temporarily remove the message from the screen. However, as long as you have an {END FIELD}, {END RECORD}, or {FIELD NAMES} command in the file, the message will display when the cursor is after the command. If you delete all the {END FIELD}, {END RECORD}, and {FIELD NAMES} commands from the file, then press Home, Home, Up Arrow, the message will not reappear.

In previous versions of Corel WordPerfect, this merge command was represented as ^E.

**Macros** • This command is not available in Macros.

**Merge** • See the Merge subheading under the following commands for examples of how to use this command: {CHAIN SECONDARY}, {END FIELD}, {FIELD NAMES}.

**{END WHILE}**

This command signals the end of a {WHILE} loop (see {WHILE} below).

**Macros** • See the Macros subheading under the following commands for examples of how to use this command: {SYSTEM}, {WHILE}.
**Merge** • See the Merge subheading under /WHILE/ for an example of how to use this command.

**[FIELD] field**
The [FIELD] merge command inserts the contents of the named (or numbered) field in the merged document or in another merge command.

*In previous versions of Corel WordPerfect, this merge command was represented as ^FName^ or ^F#.^

**Macros** • This command is not available in Macros.

**Merge** • In the following example, the contents of the Name and Address fields in the current record in the secondary merge file are inserted in the letter.

```
[FIELD]Name
[FIELD]Address

Dear [FIELD]Name:
```

See the Merge subheading under the following commands for additional examples: {BELL}, {CALL}, {CHAIN MACRO}, {COMMENT}, {DATE}, {GO}, {IF BLANK}, {IF NOT BLANK}, {MID}, {MRG CMND}, {NEST MACRO}, {NEST PRIMARY}, {NEST SECONDARY}, {NEXT RECORD}, {PAGE OFF}, {PAGE ON}, {PRINT}, {REWRITE}, {SUBST PRIMARY}.

**[FIELD NAMES] name1...nameN**
This merge command declares the names and order of the fields in a secondary file. Using this command in the secondary file allows you to reference the fields by name in a primary file. (Referencing fields by name in a primary file is usually much easier than remembering the order of the fields in the secondary file.)

The [FIELD NAMES] command must be the first command in the secondary file. If the records have more fields than those declared in this command, additional fields are numbered. The [FIELD NAMES] command must precede the records. When initially inserted, the command and field names are all on one line.

You may find it easier to read by formatting it on separate lines, as in the example below. An [END RECORD] command and its accompanying [HPg] code are inserted automatically when you insert this command. You are limited to 100 named fields, and field names are limited to 39 characters.

*After you insert this command, a message appears at the bottom of the screen that lets you know the name or number of the field where the cursor is currently located. Pressing Home, Home, Up Arrow will temporarily remove the message from the screen. However, as long as you have an [END FIELD], [END RECORD], or [FIELD NAMES] command in the file, the message will display when the cursor is after the command. If you delete all the [END FIELD],*
Macros • This command is not available in Macros.

Merge • In the following example, the first three fields of each record are named using the [FIELD NAMES] command. The additional fields are not named, and so are numbered Field 4, Field 5, and so on. The [FIELD NAMES] command shown in this example has been formatted on several lines so that it is easier to read.

[FIELD NAMES]
Company˜
Phone˜
Contact˜
˜[END RECORD]

====================================================================
International Exporting[END FIELD]
(801) 555-4421[END FIELD]
George Wiley[END FIELD]
Furniture[END FIELD]
45[END FIELD]
$1.5 million[END FIELD]
[END RECORD]
====================================================================
Tradewinds, Inc.[END FIELD]
(409) 555-3567[END FIELD]
Susan Escher[END FIELD]
Memorabilia[END FIELD]
200[END FIELD]
$2.0 million[END FIELD]
[END RECORD]
====================================================================

See the Merge subheading under [CHAIN SECONDARY] for an additional example.

{FOR}var˜start˜stop˜step˜{END FOR}
The {FOR} command is useful for executing a series of commands a certain number of times. The commands between the {FOR} and {END FOR} commands are executed once for each value of var between start and stop inclusive, as incremented by step.

The start, stop, and step values can be entered in the command as expressions, variables, or other commands. Each expression, variable, or command is evaluated to a value, then the value is assigned to the variable.

In any FOR loop, {END FOR} command determines the end of the series of commands included in the loop. The {END FOR} command sends execution to the top of loop for the next iteration. You can also use the {NEXT} command to send execution to the next iteration (see {NEXT} below), but you must still include an {END FOR} to mark the end of the loop.
The {FOR} command itself initializes the variable with the start value. You do not need to pre-assign the variable. Each subsequent time the {FOR} command is executed (at the top of the loop), the variable is incremented by the step value.

**Macros** The following example shows how you could use the {FOR} command to write out a line of 20 asterisks (*). (See **Merge** below for a more complicated example.)

```
{FOR}Counter ˜1 ˜20 ˜1 ˜
   {;}For every value of Counter from 1 to 20 (values incremented by 1 each time through the loop) ˜
   *
   {;}Write an asterisk (*) ˜
{END FOR}
   {;}End of {FOR} loop. Repeat the loop unless Counter=20 ˜
```

See the **Macros** subheading under the following commands for additional examples: {BREAK}, {NEXT}.

{FOR EACH}var ~expr1 "... exprN" ~

The {FOR EACH} macro command is similar to the {FOR} command. The difference is that instead of having a sequential step value, each value to be assigned to the variable is included as an argument in the command. (The values can still be included as expressions, variables, or commands. They are evaluated before being assigned to the variable.) See {FOR} above for more information.

Like the {FOR} command, the {FOR EACH} command itself initializes the variable with the start value. You do not need to pre-assign the variable. Each time the {FOR EACH} command is executed (at the top of the loop), the variable is assigned the next value.

Remember to end the loop with an {END FOR} command.

**Macros** In the following example, the macro will loop 5 times. Each time it loops, the variable “Count” will be equal to the specified value (that is, on
the first loop, Count=15, on the second loop, Count=10, on the third, Count=25, and so on).

{FOR EACH}Count ˜ 15 ˜ 10 ˜ 25 ˜ 95 ˜ 50 ˜
{;}V ar•Count•is•initialized•to•15•the•first•time•through•the•loop,•then
10,•then•25,•and•so•on
{VARIABLE}Count•
{;}Write•out•var•Count•followed•by•a•space
{END FOR}
{;}Perform•the•next•iteration•of•the•loop•unless•Count=50. • In•that•case,end•the
•loop.

When execution is complete, “15 10 25 95 50 ” will have been written out. Note the space (represented by “•”) after the {VARIABLE}Count command. This is the space after each number when they are written out.

**Merge** • This command is not available in Merge.

**{GO}** label ➔ ➔
The {GO} command transfers execution to the location in the macro or merge file indicated by label. It is used in conjunction with the {LABEL} command which marks the place to which execution is transferred.

The {GO} command is useful when you want to skip a part of your macro or merge, or to transfer control to another part based on a condition. Unlike the {CALL} command, {GO} does not require that execution return.

**Macros** • This macro checks to see if the Search command has been entered in variable Key. Notice that the steps between {END IF} and {LABEL} will be skipped if variable Key contains {Search}.

{IF}”{VARIABLE}Key =" {Search}”
{;}If var•Key•contains•{Search}
{GO}Search
{;}Go•to•the•Search•Label
{END IF}

• (middle section of macro)

{LABEL}Search
{;}Perform•the•search

• (Steps of the search)

{QUIT}
{;}Stop•macro•execution

The macro ends after the search has been completed.

See the **Macros** subheading under the following commands for additional examples: {CHAIN}, {Item Down}, {Item Left}, {Item Right}, {Item Up}, {LEN}, {LOOK}, {ON CANCEL}, {ON ERROR}, {RETURN CANCEL}, {RETURN ERROR}.
**Merge** • In the following example, suppose you have a secondary file where the last record has “End” as the contents of its Name field. You could use the following commands to stop the merge when it gets to that record.

```plaintext
{IF}"{FIELD}Name ˜"="End" {COMMENT}
   {GO}EndTheMerge {COMMENT}
   {END IF}
```

•

- (more of the primary file)

- 

```
{LABEL}EndTheMerge {COMMENT}
   {STOP}
```

See the **Merge** subheading under the following commands for additional examples: {BELL}, {COMMENT}, {IF}, {LOOK}, {ON CANCEL}, {ON ERROR}, {RETURN CANCEL}, {RETURN ERROR}.

**{IF} expr**

The {IF} command executes a set of commands only if a certain condition exists. If the condition exists (expr is evaluated to be true), the commands directly after the {IF} command are executed.

The expr argument is usually a logical expression. An expression is true if it is evaluated as a non-zero number. For example, when the expression 4=4 is evaluated, the result is –1 (which corresponds to true). The value is false if it results in a 0 or contains nothing at all. String values and commands must be enclosed in quotes to be evaluated correctly. See Appendix J: Macros and Merge, Expressions for more information on expression evaluation.

If the value is true, the commands directly after the {IF} execute. If the value is false (or there is no value at all), the commands after {IF} are skipped, and execution continues after the {END IF} command.

An {IF} statement always begins with {IF} and ends with {END IF}. If you want certain commands to execute only when the value is not true, use the {ELSE} command (see {ELSE} above).

It is possible to nest {IF} commands. See {STATE} below for an example of nested {IF} statements.

**Macros** • In the example below, the Setup menu is displayed only if the appropriate password is in variable Input.

```plaintext
{IF}"{VARIABLE}Input ˜"="{VARIABLE}Password" {COMMENT}
   {IF}var*Input*contains*the*password*as*stored*in*var*Password
      {Setup}
   {END IF}
   {END IF}
```

Notice that quotes are placed around both {VARIABLE}Input and {VARIABLE}Password because it is a string comparison.
See the *Macros* subheading under the following commands for additional examples: `{BREAK}`, `{ELSE}`, `{GO}`, `{Item Down}`, `{Item Left}`, `{Item Right}`, `{Item Up}`, `{LEN}`, `{LOOK}`, `{NEXT}`, `{ORIGINAL KEY}`, `{RESTART}`, `{SHELL MACRO}`, `{STATE}` (in text).

**Merge** • The following example writes “again” each time through the loop until variable Counter equals 0. Then it writes “Finished.” (Final output is “again again again Finished.”) Notice that the `{IF}` statement does not use a logical expression. Rather, it checks to see if the IF value is non-zero.

```
{ASSIGN}Counter ˜3 ˜{COMMENT}
Set var Counter to 3 (loop will execute 3 times before IF value is false (zero))
{LABEL}Loop ˜{COMMENT}
{IF}{VARIABLE}Counter ˜{COMMENT}
If var Counter is non-zero
  “again” ˜{COMMENT}
  Write “again ”
  {ASSIGN}Counter ˜{VARIABLE}Counter ˜-1 ˜{COMMENT}
  Subtract 1 from var Counter
  {GO}Loop ˜{COMMENT}
  Repeat the loop
{ELSE}{COMMENT}
“Finished.”{COMMENT}
Write “Finished.”
{END IF}{COMMENT}
End of IF statement
```

See the *Merge* subheading under the following commands for additional examples: `{BELL}`, `{DOCUMENT}`, `{GO}`, `{MID}`, `{NEST PRIMARY}`, `{NEST SECONDARY}`, `{NEXT}`, `{NEXT RECORD}`, `{SUBST PRIMARY}`.

**{IF BLANK}field** 
If the indicated field is blank, the commands after this command are executed. Be sure to end the set of commands to be executed with an `{END IF}` command. See also `{IF NOT BLANK}` below, and *If Blank, If Not Blank, and ?* under *Notes* at the end of this appendix.

**Macros** • This command is not available in Macros.

**Merge** • In the following example, the secondary merge file records have a Title field and a Name field. Corel WordPerfect checks to see if the Title field of the current record is blank. If so, it inserts just the Name in the merged document. Otherwise, it inserts the Title before the Name.

```
{IF BLANK}Title “”{COMMENT}
If the Title field is blank in this record
 “{FIELD}Name “{COMMENT}
Write out just the Name followed by a space
{ELSE}{COMMENT}
Otherwise
 “{FIELD}Title “{FIELD}Name “{COMMENT}
Write the Title before the Name
```

622  *Appendix K: Macros and Merge, Programming Commands*
See the *Merge* subheading under the following commands for additional examples: [CALL], [NEST MACRO], [SUBST SECONDARY].

**[IF EXISTS]** \( \var \) ~ \( \) ~

The **[IF EXISTS]** command checks to see if the indicated variable has been assigned. If it has, the commands following **[IF EXISTS]** are executed. Like other IF statements, the **[IF EXISTS]** command requires an **[END IF]** and can use an **[ELSE]** (see **[IF]** above).

Common uses for the **[IF EXISTS]** command include establishing a default response at a menu (see Macro example below). **[IF EXISTS]** is also useful when you want execution to wait until a key is pressed (see **[LOOK]** below).

**Macros** • The following example shows how you can use the **[IF EXISTS]** command to set up a default response to a user prompt:

```plaintext
[TEXT]Author 1 Joe; 2 Sue; 3 Marco: [Left]  
[;]User selects author  
[IF EXISTS]Author  
[ELSE]  
[;]If user pressed Enter at menu  
[ASSIGN]Author "1"  
[;]Use default of "1"  
[END IF]
```

**Merge** • The following example shows how you can use the **[IF EXISTS]** command to set up a default response to a user prompt:

```plaintext
[TEXT]Author 1 Joe; 2 Sue; 3 Marco: [COMMENT]  
User selects author  
"[IF EXISTS]Author [COMMENT]  
"[ELSE][COMMENT]  
If user pressed Enter at menu  
"[ASSIGN]Author "1" [COMMENT]  
Use default of "1"  
"[END IF]
```

**[IF NOT BLANK]** \( \text{field} \) ~

If the indicated field is not blank, the commands following this merge command are executed. Be sure to end the set of commands to be executed with an **[END IF]** command. See also **[IF BLANK]** above.

**Macros** • This command is not available in Macros.

**Merge** • In the following example, the secondary merge file records have a Title field and a Name field. Corel WordPerfect checks to see if the Title field of the current record is blank. If not, it inserts the Title before the Name. Otherwise, it inserts just the Name.

```plaintext
[IF NOT BLANK]Title [COMMENT]  
If the Title field is not blank in this record  
"[FIELD]Title [COMMENT]
```
Write out the title and a space
"[END IF][COMMENT]
End of [IF NOT BLANK] statement
"[FIELD][Name"

**INPUT** message

This command prompts the user with the message, then pauses, allowing the user to perform any keystroke operations. Once input is terminated (see Macros and Merge subheadings below), the message is removed from the screen and execution continues.

Using an **INPUT** command after a **STATUS PROMPT** command will remove the previous **STATUS PROMPT** message (see **STATUS PROMPT** below).

See also Prompting and User Input under Notes at the end of this appendix for alternative means of obtaining user input.

While an executing merge is paused at an **INPUT** (or **KEYBOARD**)) command, you can execute the [QUIT], [NEXT RECORD], or [STOP] commands from the keyboard. See Inserting Merge Commands During Execution under Notes at the end of this appendix.

In previous versions of Corel WordPerfect, this merge command was represented as ^O message ^C.

**Macros** • After the command below is executed, the user can do any editing. Execution continues when the user presses **Return**.

```
{INPUT}Edit the codes. • Press Enter when done.
```

See the Macros subheading under the following commands for additional examples: **CANCEL OFF**, **MENU OFF**, **Para Down**, **Para Up**.

**Merge** • After the command below is executed, the user can do any editing. Execution continues when the user presses **End Field**.

```
{INPUT}Type the memo text. Press End Field when done.
```

See the Merge subheading under **CANCEL OFF** for an additional example.

**Item Down**

The **Item Down** keystroke command is used in tables and paragraph numbering to move down one section or cell.

**Macros** • The following example moves down each cell in a column of a table and inserts the cell number in it.

```
ASSIGN PreviousCell '0'  
LABEL Number Cells 
IF ']' [VAR] PreviousCell ']' ] ']' [SYS] Cell ']' ']'  
[SYS] Cell ']'  
[ ] WRITE current cell number  
ASSIGN PreviousCell ']' [SYS] Cell ']' ']'  
ASSIGN current cell number to var PreviousCell ']'  
Item Down  
[ ] MOVE down to the next cell  
```

624 Appendix K: Macros and Merge, Programming Commands
Macros • The following example moves right to left to each cell in a table and inserts the cell number in it.

```plaintext
[ASSIGN]PreviousCell '0'
[LABEL]Number•Cells 
[IF]"[VARIABLE]PreviousCell"<"[SYSTEM]Cell"
[SYSTEM]Cell
    [;]Write•current•cell•number
    [ASSIGN]PreviousCell 'SYSTEM]Cell'
    [;]Assign•current•cell•number•to•var•PreviousCell 
    [Item Left]
    [;]Move•left•to•the•previous•cell
    [GO]Number•Cells
    [;]Repeat•the•loop
[ELSE]
    [QUIT]
[END IF]
[;]End•of•IF•statement
[RETURN]
```

Merge • This command is not available in Merge.

**Item Left** ♂ The [Item Left] keystroke command is used in tables and paragraph numbering to move left one section, column, or cell.

Macros • The following example moves right to left to each cell in a table and inserts the cell number in it.

```plaintext
[ASSIGN]PreviousCell '0'
[LABEL]Number•Cells
[IF]"[VARIABLE]PreviousCell"<"[SYSTEM]Cell"
[SYSTEM]Cell
    [;]Write•current•cell•number
    [ASSIGN]PreviousCell 'SYSTEM]Cell'
    [;]Assign•current•cell•number•to•var•PreviousCell
    [Item Left]
    [;]Move•left•to•the•previous•cell
    [GO]Number•Cells
    [;]Repeat•the•loop
[ELSE]
    [QUIT]
[END IF]
[;]End•of•IF•statement
[RETURN]
```

Merge • This command is not available in Merge.

**Item Right** ♂ The [Item Right] keystroke command is used in tables and paragraph numbering to move right one section, column, or cell.

Macros • The following example moves left to right to each cell in a table and inserts the cell number in it.

```plaintext
[ASSIGN]PreviousCell '0'
[LABEL]Number•Cells
[IF]"[VARIABLE]PreviousCell"<"[SYSTEM]Cell"
[SYSTEM]Cell
    [;]Write•current•cell•number
    [ASSIGN]PreviousCell 'SYSTEM]Cell'
    [;]Assign•current•cell•number•to•var•PreviousCell
    [Item Right]
    [;]Move•right•to•the•next•cell
    [GO]Number•Cells
    [;]Repeat•the•loop
[ELSE]
```
Merge • This command is not available in Merge.

(Item Up) ⊳
The {Item Up} keystroke command is used in tables and paragraph numbering to move up one section or cell.

Macros • The following example moves up each cell in a column of a table and inserts the cell number in it.

```plaintext
{ASSIGN}PreviousCell 0
{LABEL}NumberCells
{IF}"{VARIABLE}PreviousCell ""="{SYSTEM}Cell ""
{SYSTEM}Cell
{IF}"{VARIABLE}PreviousCell ""="{SYSTEM}Cell ""
{ASSIGN}PreviousCell {SYSTEM}Cell
{GO}NumberCells
{ELSE}
{QUIT}
{END IF}
{RETURN}
```

Merge • This command is not available in Merge.

(KEYBOARD ( ⊳ )) ⊳
The {KEYBOARD} merge command pauses an executing merge to rewrite the screen and then let the user enter information from the keyboard. This command is similar to the {PAUSE} and {PAUSE KEY} commands in Macros. When End Field is pressed, the merge continues. See also Prompting and User Input under Notes at the end of this appendix for additional methods of obtaining user input.

While an executing merge is paused at a {KEYBOARD} (or {INPUT}) command, you can execute the {QUIT}, {NEXT RECORD}, or {STOP} commands from the keyboard. See Inserting Merge Commands During Execution under Notes at the end of this appendix.

In previous versions of Corel WordPerfect, this merge command was represented as ^C.

Macros • This command is not available in Macros. Use {PAUSE}, {PAUSE KEY}, or {INPUT} instead.

Merge • In the following example, the {KEYBOARD} commands pause to let the user enter the “From:,” “To:,” and “Subject:” text as the merge is executed. The screen is rewritten at each {KEYBOARD} command which
displays the portion of the file merged so far, so that the user knows what information to enter.

MEMO

From:  {KEYBOARD}

To:    {KEYBOARD}

Date:  {DATE}

Subject:  {KEYBOARD}

See the Merge subheading under {STATUSPROMPT} for an example of how to use this command.

[KTON]key ~ ☳ ( //= )
The [KTON] macro command (Key TO Number) converts key (which may be any key on the keyboard) to a unique number, its Corel WordPerfect “key value.” [KTON] performs the inverse (opposite) function of the [NTOK] command (see /NTOK/ below).

If you take the [KTON] of a function key, an editing key, or a cursor key, the key value is the end result. This is the value you would use with the [NTOK] command.

If key is a character (characters are a subset of all keys), you can use the key value to calculate the Corel WordPerfect character set value. The character set value can be assigned to a variable, and a variable can input the character set value.

To calculate the character set value for a given key,

1 Use the [KTON] command to obtain the key value.

2 Divide the key value by 256.

The quotient is the number of the Corel WordPerfect character set (0-12). The remainder is the character number in the character set (0-255). For additional values returned by the [KTON] command, see Appendix L: Macros and Merge, Value Tables.

Macros • For example, if you want your macro to calculate the character set value for a character, you could use the following:

[CHAR]Key~Typeny*key ~  
[ASSIGN]Set _[KTON][VARIABLE]Key ~ "256 ~  
[ASSIGN]Num _[KTON][VARIABLE]Key ~ "%256 ~  
[ASSIGN]Set _[VARIABLE]Num ~  
[WRITE]outcharacter*set*value ~  

This macro prompts for a key, then calculates and writes out the character set value for that key.
**Merge** • This command is not available in Merge; however, the \{CTON\} merge command is very similar to it (see \{CTON\} above).

\{LABEL\}**label**

A \{LABEL\} command marks a place in the macro or merge file. Execution can be sent directly there from any place in the macro or merge file. The \{CALL\}, \{CASE\}, \{CASE CALL\}, and \{GO\} commands direct execution to the label. The \{LABEL\} command can also mark the beginning of a subroutine (see *Subroutines* under *Notes* at the end of this appendix).

The label name distinguishes each label from the others. Label names have no restrictions regarding length; however, only the first 15 characters determine uniqueness. (In other words, ABCDEFGHJKLMNO (15 characters) and ABCDEFGHJKLMNOP (16 characters) would be considered by Corel WordPerfect to be the same label name, but ABCDEFGHJKLMN (14 characters) and ABCDEFGHJKLMNO (15 characters) would be considered by Corel WordPerfect to be different label names. The only character you cannot use in the label name is a tilde (‘) because a tilde ends the label name. You can use spaces.

There can be many labels in the same macro or merge file as long as each one has a different name. If the name is duplicated, the first one is used. The other is ignored.

**Macros** • See the *Macros* subheading under the following commands for examples of how to use this command: \{CALL\}, \{CASE\}, \{CASE CALL\}, \{CHAIN\}, \{GO\}, \{Item Down\}, \{Item Left\}, \{Item Right\}, \{Item Up\}, \{LEN\}, \{LOOK\}, \{ON CANCEL\}, \{ON ERROR\}.

**Merge** • You may not use a label and local variable (see Appendix M: *Macros and Merge, Variables*) of the same name. If you do, when you execute the merge, you will receive an error message “Label is already defined.” Rename either the label or local variable.

See the *Merge* subheading under the following commands for examples of how to use this command: \{BELL\}, \{CALL\}, \{CASE CALL\}, \{COMMENT\}, \{GO\}, \{IF\}, \{LOOK\}, \{ON CANCEL\}, \{ON ERROR\}.

\{LEN\}**var** or \{LEN\}**expr**

This command determines the length of a variable or length of the value returned by an expression (see *Macros and Merge* subheadings below). This command is useful for validating or restricting the length of user input.

**Macros** • In Macros, you can only use a variable name for the *var* argument, not an expression.

In this example, if the user enters more than two letters at the \{TEXT\} prompt, the macro rejects it and the user is prompted again.

```
\{LABEL\}Get\*State ~
\{TEXT\}State “Enter a two-letter state abbreviation: ”
\{IF\}\{LEN\}State > 2 ~
\{GO\}Get\*State ~
\{END IF\}
```
See the Macros subheading under /BREAK/ for an additional example.

**Merge** • In Merge, you can use text, {FIELD}, {VARIABLE}, or complex expressions in argument **expr**.

In the following example, variable NameLength is assigned 7, which is the number of characters in the name “Sharron”:

```plaintext
[ASSIGN]Name ‘Sharron’
[ASSIGN]NameLength ‘[LEN]{VARIABLE}Name’
```

See the Merge subheading under /MID/ for an additional example.

**LOCAL** var ~ expr ~

The [LOCAL] merge command assigns the value returned by **expr** to the local variable **var**. Local variables are known only to the current file, and are deleted when the merge is finished or the file is exited. See also [ASSIGN] above, and Appendix M: Macros and Merge, Variables for more information.

You may not use a label and local variable of the same name. If you do, when you execute the merge, you will receive an error message “Label is already defined.” Rename either the label or local variable.

**Macros** • This command is not available in Macros.

**Merge** • See the Merge subheading under /COMMENT/ for an example of how to use this command.

**LOOK** var ~ ~

The [LOOK] command checks to see if a key has been pressed by the user. If a key has been pressed, it is assigned to the variable; it is not executed. If a key has not been pressed, the contents of the variable are deleted and execution is continued without stopping.

**Macros** • In the following example, [LOOK] simulates a Pause which does not terminate with the Enter key (see PAUSE below). (You could also do this with the [PAUSE KEY] command.)

```plaintext
[STATUS PROMPT]Press ‘Exit’ to Quit.
[;]Exit terminates the pause

[LABEL]Loop
[;]Top of the loop

[LOOK]Key
[;]Check to see if a key was pressed

[IF] {VARIABLE}Key = 'Exit'
[;]If Exit was pressed
[GO] Next
[;]Drop out of the loop

[END IF]
[;]End of IF structure

{VARIABLE}Key
[;]Perform the keystroke

[GO] Loop
[;]Go to the top of the loop
```

Appendix K: Macros and Merge, Programming Commands  629
See the *Macros* subheading under \*{ORIGINAL KEY}\* for an additional example.

**Merge** • The following merge sounds a beep until the user presses “s.” Then the message “You did it!” is written out.

\*{PROMPT}\*Press “s” to stop the beep\*{COMMENT}\*

Send the message to the user

\*{LABEL}\*Top \*{COMMENT}\*

\*{BELLOK}\*Key \*{COMMENT}\*

Sound the bell and check the last key pressed

\*{IF}\*\*{VARIABLE}\*Key \*“=s”\* \*{COMMENT}\*

If the user pressed “s”...

\*{GO}\*End \*{COMMENT}\*

Break out of the loop

\*{ELSE}\* \*{COMMENT}\*

Otherwise

\*{GO}\*Top \*{COMMENT}\*

Repeat the loop

\*{IF}|\* \*{COMMENT}\*

\*{LABEL}\*End \*{COMMENT}\*

“You did it!” \*{QUIT}\*

**{(MENU OFF)}**

Use the \*{MENU OFF}\* macro command to turn off display of menus (except pull-down menus).

When you define a macro from the normal editing screen using the pull-down menus, Corel WordPerfect automatically inserts a \*{MENU OFF}\* command before, and a \*{MENU ON}\* command after, the keystroke command that displays the menu (for example, \*{MENU OFF}\*{Font}\*{MENU ON}). Normally, in macro execution, the intervening menus to the final option chosen on the pull-down menu would display as regular menus. The \*{MENU OFF}\* command prevents the display of these intervening menus.

*If execution terminates while menus are off, Corel WordPerfect will automatically turn them on again.*

**Macros** • The macro in the following example displays a directory in List Files, allows the user to mark the files, then copies the files to the /tmp directory.

\*{TEXT}\*Directory “Enter the directory” \*{COMMENT}\*

\*{PROMPT}\*user to enter directory \*{COMMENT}\*

\*{DISPLAY ON}\* \*{COMMENT}\*

Turn display on so List Files will display. \*{COMMENT}\*

\*{MENU OFF}\* \*{COMMENT}\*

Turn off menus so that the menu at the bottom of the List Files screen will not display. \*{COMMENT}\*

\*{List}\*\*{VARIABLE}\*Directory \*{Enter}\* \*{COMMENT}\*

\*{List}\*the files in the directory entered by the user \*{COMMENT}\*

\*{INPUT}\*Mark files. \*Press Enter when done. \*{COMMENT}\*

\*{After sending an instructional message, pause for the user to mark the files. \*{COMMENT}\*
The {MENU ON} macro command turns on the display of menus after a {MENU OFF} command has been executed (see {MENU OFF} above).

**Macros** • See the Macros subheading under {MENU OFF} for an example of how to use this command.

**Merge** • This command is not available in Merge.

The {MENU ON} macro command turns on the display of menus after a {MENU OFF} command has been executed (see {MENU OFF} above).

**Macros** • See the Macros subheading under {MENU OFF} for an example of how to use this command.

**Merge** • This command is not available in Merge.

(MID) var \textasciitilde offset \textasciitilde count or (MID) expr \textasciitilde offset \textasciitilde count

Use this command to extract substrings. The substring returned is the set of characters from the string resulting from the evaluation of expr (see Merge subheading below) or the string in var (see Macros subheading below), starting at the offset character and continuing count characters. This command is often used with [LEN] to parse non-integer numbers.

**Macros** • In Macros, you can only use a variable name for the var argument.

In the following example, the [MID] command converts the adverb "quickly" to the adjective "quick" by extracting the first five characters of the adverb.

\[
\begin{align*}
\text{[ASSIGN]} & \text{Adverb} \textasciitilde \text{"quickly"} \\
& \text{[ASSIGN]} \text{string} \textasciitilde \text{"quickly"} \text{[FOR]} \text{Counter} \textasciitilde 0 \text{[LEN]} \text{var} \text{Adverb} \\
& \text{[MID]} \text{Adverb} \textasciitilde 0 \text{[IF]} \text{MID} \text{Adverb} \textasciitilde \text{\"\"} \text{[GO]} \text{End} \\
& \text{For a more complex example, see the Macros subheading under [BREAK].}
\end{align*}
\]

**Merge** • In Merge, you can use text, [FIELD], [VARIABLE], or complex expressions in argument expr.

In this example, the secondary file has a Name field where the names are stored in the format Last, First. The subroutine below uses the [MID] command to extract the first name from the field. (For a simple example of [MID], see the example under Macros above.)

\[
\begin{align*}
\text{[ASSIGN]} & \text{Name} \textasciitilde \text{[FIELD]} \text{Name} \textasciitilde \text{\"\"} \\
& \text{[FOR]} \text{Counter} \textasciitilde 0 \text{[LEN]} \text{VARIABLE} \text{Name} \textasciitilde 1 \text{[FOR]} \text{Counter} \textasciitilde 0 \text{[LEN]} \text{VARIABLE} \text{Name} \textasciitilde 1 \\
& \text{Check to see if the current character is a comma (\texttt{,}).} \\
& \text{If it is a comma, stop checking characters (break out of the loop)} \\
& \text{End of [IF] statement}
\end{align*}
\]
End of [FOR] statement

Assign to var ThisChar the position in the string of the first character of the first name

Assign to var FirstName the substring of characters in var Name starting at the first character of the first name ([VARIABLE]Counter) and continuing [LEN] of var Name characters (to the end of the name)

Write out the first name

This merge command lets you insert text, codes, and commands in the document being created by the merge. Any text, codes, or merge commands between the [MRG CMND] commands are sent directly to the merged document, without the commands being interpreted or executed.

In previous versions of Corel WordPerfect, this merge command was represented as ^Vcodes^V.

Macros • This command is not available in Macros.

Merge • In the following example, the merge command [FIELD]Name˜ is inserted in the resulting merged document.

Insert [FIELD]Name(tilde) in the resulting document

The [NEST] macro command transfers control to another macro. When the nested macro has finished, execution returns to the parent macro. It is somewhat like placing the contents of the specified macro where the [NEST] command is.

Macros • For example, suppose you often create macros that use cursor positioning to display large menus and messages on the screen (see Macros, Message Display). The messages will not display correctly if Reveal Codes is on. So, in each macro that uses cursor positioning, you need to first check whether Reveal Codes is on, and if so, turn it off. If you have already defined those keystrokes as a separate macro (say, codesoff.wpm), you can nest that macro in each macro that uses cursor positioning rather than re-entering the necessary commands. The macro that nests the codesoff.wpm macro would look something like this:

```
{NEST}codesoff ~

   {;|Nest the codesoff.wpm macro to be sure Reveal Codes is turned off before any messages are sent ~

   * (commands of the macro)

   {PROMPT}|^P|^A|^L|The macro is altering your file. Please Wait ~
```
Send the message, positioning it at position 1,23. This should display correctly because the codes off.wpm macro turned off Reveal Codes.

See the Macros subheading under [RESTART] for an additional example.

Merge • The [NEST MACRO] merge command is equivalent to the [NEST] macro command. See [NEST MACRO] below.

(NEST MACRO) macroname ( )

The named macro is executed when this merge command is encountered. When the macro is finished, the merge is continued with the code following the [NEST MACRO] command.

See also Chaining, Nesting, and Substituting under Notes at the end of this appendix for more information on nesting.

Macros • This command is not available in Macros. However, its function is identical to the [NEST] macro command. See [NEST] above for more information.

Merge • In the following example, the secondary file records each have an Address, City, State, and ZipCode field. During the merge, if a record is encountered with a blank ZipCode field, the merge nests a macro zipcode.wpm that calculates the ZIP Code based on the address and stores it in a global variable named ZipCode.

{IF BLANK}ZipCode {COMMENT}
If the ZipCode field is blank
{ASSIGN}Address {FIELD}Address {COMMENT}
{ASSIGN}City {FIELD}City {COMMENT}
{ASSIGN}State {FIELD}State {COMMENT}
Assign the contents of the Address, City, and State fields to global variables that the nested macro can access
{NEST MACRO}zipcode {COMMENT}
This macro calculates the zip code and stores it in the global var ZipCode
{VARIABLE}ZipCode {COMMENT}
Write out the calculated ZIP code
{ELSE}{COMMENT}
If the ZipCode field is not blank
{FIELD}ZipCode {COMMENT}
Write out the contents of the ZIPCode field
{END IF}{COMMENT}

Appendix K: Macros and Merge, Programming Commands 633
This merge command is similar to [NEST MACRO]. When this command is encountered, control of the merge is turned over to the named primary file. When the commands in the nested file have finished execution, control is returned to the original primary file, where execution is resumed after the [NEST PRIMARY] command. To change the secondary file, use the [NEST SECONDARY] command (see [NEST SECONDARY] below).

You can nest primary files up to 10 deep. However, using this command without specifying a filename ([NEST PRIMARY]˜) is the same as using the [SUBST PRIMARY] command with the current primary filename as the argument ([SUBST PRIMARY]CurrentPrimaryFilename˜) (see [SUBST PRIMARY] below). In this case, the [NEST PRIMARY] command does not use one of the 10 nest levels. See Levels under Notes at the end of this appendix for more information.

In previous versions of Corel WordPerfect, this merge command was represented as ^Pfilename^P. Using [NEST PRIMARY]˜ (without a filename) is equivalent to ^P^P in previous versions, which is equivalent to the [SUBST PRIMARY]currentprimaryfile˜ command.

Macro • This command is not available in Macros. Use the [NEST] command to nest a macro, or use the macro to begin a merge. For example,

```
[FIELD]Name ˜,

IF [FIELD]Balance < 0 [COMMENT]
  [NEST SECONDARY]transact.sf [COMMENT]
  [NEST PRIMARY]invoice.pf [COMMENT]
[END IF]
```

Sincerely,

See the Merge subheading under the following commands for additional examples: [ON ERROR], [PAGE ON].
The named secondary file is opened and used for the subsequent merge commands. Use of the parent secondary file can only be continued when the merge on the nested secondary file has been completed. (You can, however, re-nest the original secondary file from the primary file, which will open a second copy of the secondary file and begin at the first record.) You can nest secondary files up to 10 deep (see Levels under Notes at the end of this appendix).

Using this command without specifying a filename ([NEST SECONDARY]˜) returns an error.

**Macros** • This command is not available in Macros.

**Merge** • In this example, the original secondary file has a dummy record at the end of the file with “End” in the name field. The commands shown here nest the secondary file address2.sf when the last record of the secondary file is reached.

```
[IF][FIELD]Name “=” “End” [COMMENT]
  [NEST SECONDARY]address2.sf [COMMENT]
[END IF]
```

See the Merge subheading under the following commands for additional examples: [BELL], [NEST PRIMARY].

**NEXT**

Use this command to execute the next iteration of a [FOR], [FOR EACH], or [WHILE] loop. Usually, the [END FOR] or [END WHILE] command that ends the loop sends execution to the next iteration. However, the [NEXT] command can be used to send execution to the next iteration from other than the end of the loop. For example, you may use nested IF statements as part of the loop, where when a certain condition is true, you want to abandon the rest of the commands in the loop and go to the next iteration. In this case, you would use the [NEXT] command at the point where you want the next iteration to begin.

Even if you use the [NEXT] command in a loop, you must still use an [END FOR] or [END WHILE] command to mark the end of the loop.

**Macros** • The following macro writes out “***********@@@**”.

```
{FOR}1 1 15 1 ;Repeat the loop 15 times, starting at 1, ending at 15, in increments of 1
{IF}VARIABLE1 > 10; If var1 is > 10
  @; Write an @
{NEXT}; Skip to the next iteration of the loop
{END IF}
*; Write an asterisk
{END FOR}
```

**Merge** • The following merge writes out “***********@@@**”.

---

Appendix K: Macros and Merge, Programming Commands 635
Repeat the loop 15 times, starting at 1, ending at 15, in increments of 1

If var Fred is > 10,
  Write an @
Skip to the next iteration of the loop

Write an asterisk

The `[NEXT RECORD]` merge command moves the record pointer in the secondary file to the next record (see `Record Pointer` under `Notes` at the end of this appendix). If it does not find the next record, it ends the merge, or returns the merge to the next command in the primary file if the secondary file was nested, and un-nests the secondary file.

While an executing merge is paused at a `[KEYBOARD]` or `[INPUT]` command, you can execute the `[NEXT RECORD]` command from the keyboard. See `Inserting Merge Commands During Execution` under `Notes` at the end of this appendix.

In previous versions of Corel WordPerfect, this command was represented by ^N.

This command is not available in Macros.

In this example, the secondary file is searched until the variable `CompanyName` matches the field `Company` in the secondary file. When a match is found, the contents of the `Amount` field of that record in the secondary file are written to the merged document.

See the `Merge` subheading under the following commands for additional examples: `[BELL]`, `[COMMENT]`, `[SUBST PRIMARY].`

The `[NTOC]` merge command (Number TO Character) converts a Corel WordPerfect key value or character set number to its character equivalent. It performs the inverse (opposite) function of the `[CTON]` command (see `[CTON]` above). For example, the `[NTOC]` of 294 is “Ç”.

If you want to calculate the key value for a given character set value,
Multiply the character set number by 256, then add the number of the character.

For example, “Ç” is character number 38 in character set 1. Multiply 256 times 1 (256), then add 38 (294). The [NTOC] of 294 is “Ç”.

[NTOC] will return nothing if it is taken of a number that is not equivalent to a character.

**Macros** • This command is not available in Macros. However, the [NTOK] macro command is very similar to the [NTOC] merge command. See /NTOK/ below for more information.

**Merge** • The following example prompts for a number, then returns the character equivalent.

```
{TEXT}Num ˜Type a key value number: ˜{COMMENT}
˜{NTOC}{VARIABLE}Num ˜
```

The [NTOK] macro command (Number TO Key) converts a Corel WordPerfect key value to its character or function equivalent. It performs the inverse (opposite) function of the [KTON] command (see /KTON/ above). For example, if you take the [NTOK] of 32809 (Save), a Save is executed. If you take the [NTOK] of 1537, a “±” is written out.

You can also take the [NTOK] of a Corel WordPerfect character set value. For example, the character set value for “±” is 6,1. Type [NTOK]6,1 ˜ to obtain “±”.

If you want to calculate the key value for a given character set value,

1 Multiply the character set number by 256, then add the number of the character.

You can then use the [NTOK] command to obtain the character.

For example, “±” is character number 1 in character set 6. Multiply 256 times 6 (1536), then add 1 (1537). You can then take the [NTOK] of 1537 to obtain “±”. (For additional values see Appendix L: Macros and Merge, Value Tables.)

**Macros** • The following example prompts for a number, then returns the character or function equivalent.

```
{TEXT}Num ˜Type a key value number: ˜{COMMENT}
˜{NTOK}{VARIABLE}Num ˜
```

If the number returns a function, such as Save, and you do not want the function to execute, you can store it in a variable (for example, {ASSIGN}Key˜{NTOK}{VARIABLE}Num˜˜).

**Merge** • This command is not available in Merge; however, the [NTOC] merge command is very similar to it. See /NTOC/ above.
The \texttt{ON CANCEL} command tells Corel WordPerfect what to do if a user presses \texttt{Cancel} or if a \texttt{RETURN CANCEL} command has been returned by a subroutine or nested macro or merge. When a Cancel occurs, Corel WordPerfect will know what to do next only if it has already encountered the \texttt{ON CANCEL} command. For this reason, it is a good idea to place the command before a Cancel can occur, otherwise execution will terminate when Cancel is pressed.

The valid \textit{actions} available with this command in Macros are:

\begin{verbatim}
\{BREAK\} \{RETURN\}
\{CALL\} \{RETURN CANCEL\}
\{GO\} \{RETURN ERROR\}
\{QUIT\} \{RETURN NOT FOUND\}
\{RESTART\}
\end{verbatim}

The valid \textit{actions} available with this command in Merge are:

\begin{verbatim}
\{BREAK\} \{RETURN\}
\{CALL\} \{RETURN CANCEL\}
\{GO\} \{RETURN ERROR\}
\{QUIT\} \{STOP\}
\end{verbatim}

Since \texttt{GO} and \texttt{CALL} require a tilde (\texttt{\~}) after the label, there must be two tilde marks (\texttt{\~\~}) at the end (for example, \texttt{\{ON CANCEL\}\{GO\}label\texttt{\~\~}}).

In Macros, the default response to a Cancel (if no \texttt{ON CANCEL} command is encountered) is \texttt{RETURN CANCEL}. In Merge, the default response to a Cancel (if no \texttt{ON CANCEL} command is encountered) is \texttt{STOP}.

If no \textit{action} is specified in the command (that is, \texttt{ON CANCEL \~}), the cancel is ignored and execution continues as if there had been no cancel. In Macros, not only is the cancel condition ignored, but if the Cancel key was pressed, the key is thrown away. In other words, if either a \texttt{LOOK} or \texttt{ORIGINAL KEY} is used, they do not detect that the Cancel key was pressed. If you want the Cancel key to be used as input, use the \texttt{CANCEL OFF} command before the input is requested.

\textbf{Macros} • When Cancel is pressed (or a \texttt{RETURN CANCEL} is encountered), Corel WordPerfect executes the last \texttt{ON CANCEL} command encountered at the current level (see \textit{Levels} under \textit{Notes} at the end of this appendix). If no \texttt{ON CANCEL} command was encountered during execution of the current level, Corel WordPerfect looks to successively higher levels and executes the last one that was encountered. If none was encountered, the default (\texttt{RETURN CANCEL}) is executed.

If you chain or nest a macro, the \texttt{ON CANCEL} command is not passed from the parent file to the nested or chained file. Rather, the default (\texttt{RETURN CANCEL}) is in effect until another \texttt{ON CANCEL} command is encountered.
When execution returns from a lower level to a higher level, the last \{ON CANCEL\} command encountered at the higher level resumes effect. In the following example, if the user presses \textbf{Cancel} during the macro, the subroutine \texttt{End} is executed.

\begin{verbatim}
\{ON CANCEL\}\{GO\}End

\begin{verbatim}
\{LABEL\}End
  \{COMMENT\}
  If Cancel is pressed during the merge, execute the End subroutine
\end{verbatim}

\begin{verbatim}
\{LABEL\}End
  \{COMMENT\}
  Beginning of End subroutine
  \{PROMPT\}Merge cancelled prematurely.
  \{COMMENT\}
  Send notification message
\end{verbatim}

\{QUIT\}
\end{verbatim}

\begin{verbatim}
\{QUIT\}
\end{verbatim}

\end{verbatim}

See the \textit{Macros} subheading under \textit{RETURN CANCEL} for an additional example.

\textbf{Merge} • In Merge, when Cancel is pressed, the last \{ON CANCEL\} command encountered in the file is executed. If none was encountered, the default (\{ON CANCEL\}\{STOP\} ) is executed.

The \{ON CANCEL\} command is local to the file in which it is encountered. It cannot be seen from other files. For example, a secondary file cannot use the \{ON CANCEL\} command from a primary file.

In the following example, if the user presses \textbf{Cancel} during the merge, the subroutine \texttt{End} is executed.

\begin{verbatim}
\{ON CANCEL\}\{GO\}End

\begin{verbatim}
\{LABEL\}End
  \{COMMENT\}
  Beginning of End subroutine
  \{PROMPT\}Merge cancelled prematurely.
\end{verbatim}

\begin{verbatim}
\{QUIT\}
\end{verbatim}

\end{verbatim}

Appendix K: Macros and Merge, Programming Commands
"[WAIT]40 "[COMMENT]
   Display message for 4 seconds
"[STOP]"[COMMENT]
   Terminate execution"

See the Merge subheading under \{RETURN CANCEL\} for an additional example.

\{ON ERROR\} \{action\} \{GO\} \{LABEL\}

The \{ON ERROR\} command determines what to do if an error is detected in macro or merge execution, or returned by Corel WordPerfect or UNIX, or if a \{RETURN ERROR\} command has been returned by a subroutine or nested macro or merge. If you insert this command without an action (\{ON ERROR\} \{\}), the error is ignored and execution continues (when possible).

In Macros, any error that returns an error message to or from Corel WordPerfect can be trapped with this command. In Merge, the errors that can be trapped with this command are:

- File not found
- Print queue errors
- End of file condition returned by a \{NEXT RECORD\}

If you chain a file that does not exist or is not found, the error condition is not generated until Corel WordPerfect tries to execute the chained file (that is, at the end of the current macro or merge file). See Chaining, Nesting, and Substituting under Notes at the end of this appendix, and the descriptions for the \{CHAIN\}, \{CHAIN MACRO\}, \{CHAIN PRIMARY\}, and \{CHAIN SECONDARY\} commands in this section for more information.

In Macros, the default action (if no \{ON ERROR\} is encountered) is \{RETURN ERROR\}. In Merge, the default action is \{STOP\}. For a list of other possible actions, see \{ON CANCEL\} above.

\{Macros\} • The range of effect of the \{ON ERROR\} command is the same as the \{ON CANCEL\} command (see the Macros subheading under \{ON CANCEL\} above).

In the following example, the macro requests that the user enter the name of a file. The macro then tries to retrieve it. The \{ON ERROR\} command specifies that the Error subroutine be executed if the file is not found when the macro tries to retrieve it.

\{ON ERROR\}\{GO\}Error ""
   \{If\} an error is generated, \execute \{the\ \{Error\ \} subroutine \{\"
\{LABEL\}GetFile ""
\{LABEL\}GetFile ""
\{TEXT\}Filename \"File to be retrieved: \n   \{Prompt\} user for file ""
\{Retrieve\} \{VARIABLE\}Filename \{Enter\}
   \{\Ret\}rieve \{the\ \} file ""
•
• (more commands)
If the file was not found when the macro tried to retrieve it, execution moves here:

{CANCEL}

If the file was not retrieved:

{PROMPT}The file you entered is not in the default directory. Try again.

{TELL}the user what happened:

{WAIT}15

Display the message for 1.5 seconds:

{GO}GetFile

If an error is generated, execute the Error subroutine:

•
•

{NEST PRIMARY}invoice.pf

•
•

If the file was not found when the merge tried to nest it, execution moves here:

{PROMPT}File not found. Move invoice.pf to default directory and start merge again.

Send a message to the user:

{WAIT}15

Display the message for 1.5 seconds:

{STOP}

Terminate execution.

See the Macros subheading under \(\text{return error}\) for an additional example.

**Merge**

The range of effect of the \{on error\} command is the same as the \{on cancel\} command.

In the following example, a new primary file is nested. The \{on error\} command specifies that the Error subroutine be executed if the file is not found when the merge tries to nest it.

\begin{verbatim}
{ON ERROR}{GO}Error
{COMMENT}
If an error is generated, execute the Error subroutine
•
•
\end{verbatim}

\begin{verbatim}
{NEST PRIMARY}invoice.pf
•
•
\end{verbatim}

\begin{verbatim}
{LABEL}Error
{COMMENT}
If the file was not found when the merge tried to nest it, execution moves here
{PROMPT}File not found. Move invoice.pf to default directory and start merge again.
{COMMENT}
Send a message to the user
{WAIT}15
{COMMENT}
Display the message for 1.5 seconds
{STOP}
{COMMENT}
Terminate execution
\end{verbatim}

See the Merge subheading under \(\text{return error}\) for an additional example.

\begin{verbatim}
{ON NOT FOUND}action
\end{verbatim}

The \{on not found\} macro command determines what to do if a search fails (for example, Search, Word Search, or Name Search) or a \{return not found\} is returned by a nested macro or subroutine. If no \{on not found\} command is included before a Not Found condition occurs, the Not Found stops that level of macro execution (an \{on not found\} \{return not found\} is executed).
For a list of valid actions for this command, see Macros under {ON CANCEL} above. The range of effect of the {ON NOT FOUND} command is the same as the {ON CANCEL} command.

If you search for a nonexistent name with Name Search, the Not Found condition is returned at the first character that does not match. You should insert an {Enter} command somewhere in the macro after the Not Found is generated to terminate the name search.

If during a name search all characters before the {Enter} match, a Not Found is not generated, even though there may be additional characters in the name of the file at the cursor. To check whether the file is an exact match, use {HPg} to terminate the Name Search instead of {Enter}. When you use {HPg}, a Not Found is generated if the filename does not exactly match.

Macros • See the Macros subheading under the following commands for examples of how to use this command: [CHAIN], {RETURN NOT FOUND}.

Merge • This command is not available in Merge.

{ORIGINAL KEY} ⊃
The {ORIGINAL KEY} macro command evaluates the original (unmapped) action of the last key entered from the keyboard. The last key pressed could be either a key that was read before the macro started (which may be the key which invoked the macro) or a character input with a {CHAR}, {LOOK}, {TEXT}, {PAUSE}, or {PAUSE KEY} command.

Macros • This command is useful if your keyboard has been remapped with a keyboard definition (see Keyboard Layout). For example, you might want your macro to check if a user has typed a specific key, regardless of the keyboard definition. If you want to exit if Exit has been pressed, use the following macro:

{LOOK}Key
   [;]Check to see if a key has been pressed. Assign it to var Key
   [IF]"{ORIGINAL KEY}"="Exit" ;
      [;]If the unmapped key is Exit
      [Exit] ; Exit
   [END IF] ; End of IF statement

Merge • This command is not available in Merge.

{OTHERWISE}
Use this command as the last case in a {CASE} or {CASE CALL} command for cases other than the specified cases.

{PAGE OFF} ♫
The {PAGE OFF} merge command eliminates the hard page [HPg] between copies of the primary file in the merged document. Use {PAGE ON} to begin insertion of hard page codes again after you have used {PAGE OFF}. The
[PAGE ON] and [PAGE OFF] commands are global to the merge; they may be included in any primary or secondary file and are in effect for all the files in the merge until the opposite command is encountered.

These commands are useful for merging labels or for including multiple records in a document. You can also use [PAGE OFF] with the [PRINT] command to eliminate blank pages between copies of the merged document when merging to the printer. (In previous versions of Corel WordPerfect, this was accomplished with the ^N^P^P codes.)

**Macros** • This command is not available in Macros.

**Merge** • In the following example, the records in the secondary file have 2 fields: Name and Salary. When merged with the primary file below, a list is created of each name and salary. Because Page is off, no hard page break is inserted between each iteration of the primary file, thereby creating a single list.

```
{PAGE OFF}
{FIELD}Name~......{FIELD}Salary~
```

See the Merge example under the following commands for additional examples: [PAGE ON], [PRINT].

**[PAGE ON]** ➾

The [PAGE ON] merge command reinstates the use of hard page codes between copies of the primary file in the merged document. See [PAGE OFF] for more information.

**Macros** • This command is not available in Macros.

**Merge** • In the example below, the nested primary file list.pf creates a list of players on a given team—one team per page.

```
{ASSIGN}Team ~{FIELD}Team~ ˜{COMMENT}
Assign the current field to a global variable so that the nested primary file can use it
˜These people are on your team (Team {FIELD}Team~):
```

```
{PAGE OFF}{COMMENT}
This command prevents the insertion of a hard page between iterations of the nested primary file
```

```
˜{NEST PRIMARY}list.pf{COMMENT}
This primary file uses another secondary file to produce the list. (It writes the Name field of all records whose Team field matches the current Team variable.)
```

```
˜{PAGE ON}{COMMENT}
This command restores the use of page breaks to allow one team list per page
```

**[Para Down]** ⊳

The [Para Down] keystroke command moves the cursor to the beginning of the next paragraph (just beyond the next [HRt]).

**Macros** • The following macro swaps two paragraphs.

```
{INPUT}Position•cursor•on•paragraph•to•be•moved•down,•then•press•Enter. ˜
{;}Prompt•user•and•pause•for•user•to•position•cursor ˜
```

Appendix K: Macros and Merge, Programming Commands 643
The \{Para Up\} keystroke command moves the cursor to the beginning of the current paragraph (to the right of the previous [HRt]) or, if the cursor is already at the beginning, to the beginning of the previous paragraph.

**Macros** • The following macro swaps two paragraphs.

\[\text{INPUT}\]
\[
\text{Position}\text{cursor}\text{on}\text{paragraph}\text{to\text{be}\text{moved}\text{up}},\text{then}\text{press}\text{Enter} \]
\[\text{Move}pm\]
\[
\text{Move}\text{paragraph}\text{into}\text{buffer} \]
\[\text{Para Up}\]
\[
\text{Position}\text{cursor}\text{up}\text{one}\text{paragraph} \]
\[\text{Home}\text{Home}\text{Left}\]
\[
\text{Position}\text{cursor}\text{at}\text{beginning}\text{of}\text{the}\text{line} \]
\[\text{Enter}\]
\[
\text{Retrieve}\text{the}\text{paragraph} \]

**Merge** • This command is not available in Merge.

**[PAUSE]** ( \(\rightarrow\) )

The \{PAUSE\} macro command causes the macro to pause until Return is pressed. This command lets the user edit or type new text as if there were no macro running. Macro execution proceeds after Return is pressed. (If you want another key to end the pause, see \{PAUSE KEY\} below.)

\{PAUSE\} does not prompt the user. Because of this, the \{PROMPT\} and/or \{BELL\} commands are often used with \{PAUSE\}. See also Promting and User Input under Notes at the end of this appendix for other methods of obtaining user input.

**Macros** • In the following example, after the \{PROMPT\} command is executed, the user can do any editing. Execution continues when the user presses Enter.

\[\text{STATUS PROMPT}\]
\[
\text{Edit}\text{the}\text{codes}\text{.}\text{Press}\text{Enter}\text{when}\text{done} \]
\[\text{Send}\text{a}\text{prompt}\text{to}\text{the}\text{screen} \]
\[\text{PAUSE}\]
\[
\text{Pause}\text{for}\text{user}\text{to}\text{edit}\text{codes} \]
\[\text{STATUS PROMPT}\]
\[
\text{Clear}\text{status}\text{prompt}\text{message} \]

See the Macros subheading under \{CHAIN\} and \{RESTART\} for additional examples.
Merge • This command is not available in Merge. However, the
(KEYBOARD) merge command is very similar to the [PAUSE] macro
command. See /KEYBOARD/ above.

[PAUSE KEY]key " ( ≫ )
This command functions like the [PAUSE] command (see /PAUSE/ above),
except that you specify the key that terminates the pause.

Macros • If you wanted Exit to terminate the pause, you could use the
following:

[STATUS PROMPT]Edit*the*codes.*•*Press*Exit*when*done. * 
[+]Send*message*to*user. * " 
[PAUSE KEY][Exit] " 
[+]Stop*so*that*user*can*edit*codes.*•*Execution*continues*when*the*user*presses* 
Exit* " 
[STATUS PROMPT] " 
[+]Clear*prompt. * "

Merge • This command is not available in Merge. However, you may be
able to use the [KEYBOARD] merge command instead. See /KEYBOARD/ 
above.

(PRINT) ➔
The [PRINT] merge command sends all text that has been merged so far to the
printer. Once the text is sent to the printer, it is cleared from the edit buffer 
(that is, it is no longer in the “resulting document”). When you merge to the
printer using this command, the usual page break is still inserted between each
iteration of the primary file. To eliminate the extra page between each copy,
insert the [PAGE OFF] command before the [PRINT] command (see the
example under Merge below).

In previous versions of Corel WordPerfect, this command was represented as ^T.

Macros • This command is not available in Macros.

Merge • The secondary file to be used with the primary file in the following
example contains 1000 records. If you were to merge it to the screen, the
resulting document would have 1000 pages. So, this merge uses the
[PRINT] command to send each letter to the printer as soon as it is merged.

ABC Company
245 West Center Street
Long Beach, California 90807

[DATE]

|FIELD|Name |
|FIELD|Company |

Dear |FIELD|Salutation |

Appendix K: Macros and Merge, Programming Commands 645
Thank you for your inquiry regarding our new product.

Sincerely,

Amy Wilcox
Product Manager

This merge command is designed to be used in a secondary merge file. The text, codes, or commands enclosed in the {PROCESS} commands are executed when they are encountered, regardless of the current location in the secondary file. For example, if this command is encountered while the merge is scanning the secondary file for a record, the codes are processed, even if they are not in the record being searched for.

To prevent the codes from being executed, you can use a {GO} command to send control of the merge to another part of the file, thus skipping over the {PROCESS} command.

Macros • This command is not available in Macros.

Merge • See the Merge subheading under {CHAIN SECONDARY} for an example of how to use this command.

The {PROMPT} command displays the message on the status line. See Message Display under Notes at the end of this appendix for information on affecting the way messages are displayed on the screen. See also Prompting and User Input under Notes at the end of this appendix for other methods of prompting the user.

In previous versions of Corel WordPerfect, this merge command was represented as ^O.

Macros • See the Macros subheading under the following commands for examples of how to use this command: {NEST}, {ON CANCEL}, {ON ERROR}, {WHILE}.

Merge • See the Merge subheading under the following commands for examples of how to use this command: {BELL}, {ON CANCEL}, {ON ERROR}.

The {QUIT} command stops the execution of the macro or merge. If macros are nested or chained, it stops their execution at that point.

While an executing merge is paused at a {KEYBOARD} or {INPUT} command, you can execute the {QUIT} command from the keyboard. See Inserting Merge Commands During Execution under Notes at the end of this appendix.

In previous versions of Corel WordPerfect, this merge command was represented as ^Q.
Macros • See the Macros subheading under the following commands for examples of how to use this command: {CASE}, {GO}, {ON CANCEL}.

Merge • In a merge, the rest of the primary file after the {QUIT} command is written out to the resulting merged document before the merge terminates, but any commands after {QUIT} are not executed. Arguments in the commands following the {QUIT} command are included as text in the merged document. If you don’t want the rest of the primary file written out, use the {STOP} command instead of {QUIT} (see {STOP} below).

If {QUIT} is used in a secondary file, the secondary file is abandoned at that point. However, the rest of the primary file is written out (but not processed) just as if the command had been encountered in the primary file, and then the merge terminates.

The following example is a standard memo sent by a Personnel department to each employee before his or her six-month salary review. The merge ends just after the {DATE} command, but the rest of the memo is written out to the resulting merged document.

MEMO

To: {KEYBOARD}

From: Kim Charleston, Personnel

Date: {DATE}{QUIT}

Subject: Six-month Review Preparation

 ==============================================================

•

• (rest of memo)

•

(RESTART) ⊙
The {RESTART} macro command terminates all macro execution at the end of the current nested macro. This command can be used if you do not want a macro to return to the macro from which it was nested. The {RESTART} command can be inserted anywhere in the nested macro. The macro “remembers” the {RESTART} command and executes it after all other commands have been executed.

Macros • In the following example, the parent macro nests the macro continue.wpm which asks the user whether he or she wants to continue or stop. If the user elects to continue, execution returns to the parent file. If the user elects to stop, the {RESTART} command prevents execution from returning after the last command of the nested file.

Parent File:

•

•

Appendix K: Macros and Merge, Programming Commands  647
Nested File (continue.wpm):

[CHAR] Answer 1 * Continue; 2 * Stop; 1 [Left]

- Prompt user

[IF] [VARIABLE] Answer = 1

- If user selects to continue...
- [RETURN]
  - ...return execution to the parent file.

- [ELSE]
  - Otherwise...
  - [RESTART]
    - ...terminate execution at the end of this file.

- [END IF]
  - End of IF statement

- [PROMPT] You have elected to stop the macro. Press Enter to terminate execution.

- [PAUSE]
  - Wait for user to press Enter

- [Screen]
  - Clear the screen. Execution stops after this command.

**Merge** • This command is not available in Merge.

**RETURN**

The [RETURN] command marks the end of a subroutine and signals the macro or merge to return from a [CALL] or [CASE CALL] command.

**Macros** • If there is no [CALL] or [CASE CALL] to return to and the macro file containing this command is nested, [RETURN] signals the macro to return to the file from which it was nested. If the command is not in a nested file and there is no [CALL] or [CASE CALL] to return to, [RETURN] marks the end of a macro (see [CALL] above).

See the **Macros** subheading under the following commands for examples of how to use this command: [CALL], [CHAIN], [Item Down], [Item Left], [Item Right], [Item Up].

**Merge** • In Merge, the [RETURN] command must be paired with a [CALL] or [CASE CALL] command. If there is no [CALL] or [CASE CALL] to return to, an error message will be displayed.

See the **Merge** subheading under [CALL] for an example of how to use this command.

**RETURN CANCEL**

The [RETURN CANCEL] command causes execution to leave the current level and indicates a Cancel to the next higher level (see Levels under Notes at the end of this appendix).
Macros • Since {RETURN CANCEL} is the default action to Cancel when no {ON CANCEL} command is used (see {ON CANCEL} above), the {RETURN CANCEL} command is most often used to reset the {ON CANCEL} action back to the default after it has been changed.

In this example, the {RETURN CANCEL} is used to set the {ON CANCEL} action to {RETURN CANCEL}.

{ON CANCEL}{GO}Send•Message ˜
• (During this part of the macro, if the user presses Cancel, execution will be transferred to the Send Message label.)

{ON CANCEL}{RETURN CANCEL} ˜
• (During this part of the macro, if the user presses Cancel, a {RETURN CANCEL} is returned to the higher level.)

Merge • In this example, the {RETURN CANCEL} is used to set the {ON CANCEL} action to {RETURN CANCEL}.

{ON CANCEL}{GO}Send Message ˜
• (During this part of the merge, if the user presses Cancel, execution will be transferred to the Send Message label.)

{ON CANCEL}{RETURN CANCEL} ˜
• (During this part of the merge, if the user presses, a {RETURN CANCEL} is returned to the higher level.)

{RETURN ERROR} ☺

The {RETURN ERROR} command causes execution to leave the current level and indicate an error to the next higher level (see Levels under Notes at the end of this appendix) (see also {ON ERROR} above).

Macros • Since {RETURN ERROR} is the default action when an error occurs and no {ON ERROR} command is used (see {ON ERROR} above), the {RETURN ERROR} command is most often used to reset the {ON ERROR} action back to the default after it has been changed.

In this example, the {RETURN ERROR} is used to reset the {ON ERROR} action back to the default.

{ON ERROR}{GO}Send•Message ˜
• (During this part of the macro, if an error occurs, execution will be transferred to the Send Message label.)

{ON ERROR}{RETURN ERROR} ˜
• (During this part of the macro, if an error occurs, a {RETURN ERROR} is returned to the higher level.)
**Merge** • In this example, the [RETURN ERROR] is used to set the [ON ERROR] action to [RETURN ERROR].

\[\text{ON ERROR}}\text{GO}Send Message^\sim\text{ON ERROR}\]

• (During this part of the merge, if an error occurs, execution will be transferred to the Send Message label.)

• [RETURN ERROR]  

• (During this part of the merge, if an error occurs, a [RETURN ERROR] is returned to the higher level.)

**[RETURN NOT FOUND]**

The [RETURN NOT FOUND] macro command terminates macro execution on the current level and indicates a search Not Found condition to the next higher level (see \{ON NOT FOUND\} above). [RETURN NOT FOUND] can be used wherever you would use [RETURN] (see \{RETURN\} above).

Since [RETURN NOT FOUND] is the default action when a *Not Found* condition occurs and no \{ON NOT FOUND\} command is used (see \{ON NOT FOUND\} above), the [RETURN NOT FOUND] command is most often used to reset the [ON NOT FOUND] action back to the default after it has been changed.

**Macros** • In this example, the [RETURN NOT FOUND] is used to reset the [ON NOT FOUND] action back to the default.

\[\text{ON NOT FOUND}}\text{GO}Send Message^\sim\text{ON NOT FOUND}\]

• (During this part of the macro, if a search string is not found, execution will be transferred to the Send Message label.)

• [RETURN NOT FOUND]  

• (During this part of the macro, if a search string is not found, a [RETURN NOT FOUND] is returned to the higher level.)

**Merge** • This command is not available in Merge.

**[REWRITE]**

This merge command causes the screen to be rewritten. Since none of the merged document is written to the screen during a merge, you may want to use this command to display what has been merged at a certain point.

*In previous versions of Corel WordPerfect, this merge command was represented as ^U.*

**Macros** • This command is not available in Macros; however, you can use the following (inserted in the Macro Editor or while defining a macro at the normal editing screen by pressing **Screen** twice):

\[\text{Screen}}\text{Screen}\]
You can also use the {DISPLAY ON} command (see {DISPLAY ON} above).

**Merge** • In the following example, the {REWRITE} command is used so that the letter can be seen after it is merged.

ABC Company  
245 West Center Street  
Long Beach, California 90807

[DATE]

{FIELD}Name”  
{FIELD}Company”

Dear {FIELD}Salutation”:

Thank you for your inquiry regarding our new product.

•

• (rest of the letter)

•

Sincerely,

Amy Wilcox  
Product Manager

{COMMENT}“{REWRITE}

**{SHELL MACRO}macroname” ☞

This command does not have a function in Corel WordPerfect for UNIX systems. It is only available so that macros created in Corel WordPerfect 5.1 for DOS are compatible with those created in UNIX.

**{SPEED}100ths second” ☞

The {SPEED} macro command can slow down macro execution. It causes macro execution to wait the amount of time indicated by the 100ths second argument between each command.

The default speed is no delay between commands (that is, {SPEED}0”).

**Macros** • For example, if you want macro commands to execute every 1.5 seconds, insert the following into your macro:

{SPEED}150”

**Merge** • This command is not available in Merge.

**{STATE}” ☞

The {STATE} macro command returns a number representing the current operational state of Corel WordPerfect. This lets you create macros which are aware of the environment in which they are executing. The operational states and their corresponding code numbers are listed below.

<table>
<thead>
<tr>
<th>Number</th>
<th>Operational State</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>Current Document (1, 2, or 3)</td>
</tr>
<tr>
<td>4</td>
<td>Normal Editing Screen</td>
</tr>
<tr>
<td>8</td>
<td>Editing Structure Other than Normal Editing Screen</td>
</tr>
</tbody>
</table>
16 Macro Definition Active
32 Macro Execution Active (always set)
64 Merge Active
128 Block Active
256 Typeover Active
512 Reveal Codes Active
1024 Yes/No Question Active
2048 In a list (see also the List system variable description under \{SYSTEM\} below)
32768 Cannot go to Shell

†Document screens 4 through 9 return a zero (0) in the \{STATE\}&3 command. To get the current document number for all document screens, use the \{SYSTEM\}number˜ command. (See \{SYSTEM\} below.)

State 8 (Editing Structure Other than Normal Editing Screen) refers to a screen which is used for editing footnotes, headers, styles, and so on. Macro Execution (32) is labeled as "always set" because the \{STATE\} command is only used in a macro as it is executing.

You can determine what the state of Corel WordPerfect is by forming an AND (&) expression with a value called a mask (for example, \{STATE\}&3). The result of the operation indicates the current state of Corel WordPerfect.

To choose a mask, determine which state(s) you want to check for. Note the numbers associated with each state and add them together to calculate the mask value. For example, if you want to know what document you are currently in (1, 2, or 3), the mask value is 3. If you want to know if you are at the normal editing screen (4) and/or if Reveal Codes is active (512), the mask value is 516 (4+512=516).

After you have determined the appropriate mask, create an AND expression, then assign the result to a variable. For example,

\{ASSIGN\}DocNum \{=\} \{STATE\}&3
\{ASSIGN\}Active \{=\} \{STATE\}&516

In this example, the mask values are 3 and 516. Variable DocNum contains the current document number and variable Active contains a number which indicates whether the normal editing screen (4), Reveal Codes (512), both (516), or neither (0) are active.

If the result of the AND operation is 0, then the state you were checking for is not present. If the result is a non-zero number, then some (or all) of the states you checked for are present.

For example, if you want to check for both types of editing screens ((4) and (8)), the mask is 12. \{STATE\}&12 gives four types of information. If the result is 0, then neither the normal editing screen nor another editing screen is active (some type of menu is active). If the result is 4, the normal editing screen is on. If the
result is 8, a menu is active, but you are editing a style, footnote, and so on (for example, you pressed Format while editing a footnote). If the result is 12, you are in the normal editing screen, and you are editing a style, footnote, and so on.

Since the [IF] command interprets 0 as false, you can form [IF] statements that will perform functions when a certain condition exists. For example, the following macro returns you to the normal editing screen if Reveal Codes, Block, both, or neither is on.

```
{LABEL}Top
{IF}[STATE]&4
{IF}[STATE]&512
{IF}[STATE]&128
{ELSE}
{ELSE}
{END IF}
END IF
END IF
```

When [STATE] is executed by itself (not in an expression), it returns a number which represents the total state of Corel WordPerfect. All applicable numbers are added together. For example, if the cursor is in the normal editing screen (4) of document 1 (1) and if Block is on (128) and a macro is executing (32), then the executional state of Corel WordPerfect is 4+1+128+32=165.

See also /SYSTEM/ for information on accessing other system variables.

**Macros** • See the examples in the above description of this command.

**Merge** • This command is not available in Merge.

### [STATUS PROMPT]message

This command puts a message on the status line. Although you can use cursor positioning commands (see Message Display under Notes at the end of this appendix) to position the message elsewhere on the screen, the message may not redisplay correctly when the screen is rewritten if you do. Also, the [STATUS PROMPT] message only displays when the status line normally displays. So, for example, in Merge, the message would only display when a [KEYBOARD] command pauses the merge for input from the keyboard, and when the merge is finished. In Macros, the [STATUS PROMPT] message only
displays when display is on (see \{DISPLAY OFF\} and \{DISPLAY ON\} above) and when the macro has terminated.

If you position the message on the status line, only the first 48 characters will show.

When you use this command, the message is stored in memory, much like a variable. However, this spot in memory is shared with the \{INPUT\} command. If you use an \{INPUT\} command after a \{STATUS PROMPT\} command, the \{STATUS PROMPT\} message will be replaced in memory by the \{INPUT\} message. Since the \{INPUT\} command clears its own message from memory when execution continues after the command, the \{STATUS PROMPT\} message no longer exists after the \{INPUT\} command. This is one way to clear the \{STATUS PROMPT\} message from memory.

To clear a status prompt message without using \{INPUT\}, insert another \{STATUS PROMPT\} command with no message (\{STATUS PROMPT\} ). If you do not clear the message with an \{INPUT\} or \{STATUS PROMPT\} command, the message will be on the screen whenever the status line is displayed until you exit Corel WordPerfect.

For additional methods of prompting the user, see Prompting and User Input under Notes at the end of this appendix.

**Macros** • In the following example, the \{STATUS PROMPT\} is used to display the date the macro was created on the status line before the rest of the macro executes.

\begin{verbatim}
{DISPLAY ON}
  \{DISPLAY on to the subsequent \{STATUS PROMPT\} message will show \}
  \{STATUS PROMPT\} Macro created: 10/25/89 \}
  \{WAIT\} 15 \}
  \{DISPLAY OFF\}
\end{verbatim}

\begin{verbatim}
\{STATUS PROMPT\}
\end{verbatim}

See the Macros subheading under the following commands for additional examples: \{LOOK\}, \{PAUSE\}.

**Merge** • The first command puts the message “Press End Field when done.” on the status line. The second command erases the message.

\begin{verbatim}
\{STATUS PROMPT\} Press End Field when done. \{COMMENT\}
\{KEYBOARD\} \{COMMENT\}
\end{verbatim}

When the merge pauses at the \{KEYBOARD\} command, the message is displayed on the status line.

\begin{verbatim}
\{STATUS PROMPT\} \{COMMENT\}
\end{verbatim}

This clears the \{STATUS PROMPT\} message from memory.
The [STEP OFF] command turns off single step execution after it has been turned on (see [STEP ON] below).

**Macros** • See the example under [STEP ON] below.

**Merge** • See the example under [STEP ON] below.

The [STEP ON] command is useful for debugging macros and merges. It causes the macro or merge to execute one step at a time. Between each step, a message on the status line indicates what the next key or command is. The key or command executes when any key is pressed (see the Macros and Merge subheadings below).

During macro execution, press **Exit** to turn off the Step mode. Pressing **Cancel** terminates execution unless Cancel is turned off or is redefined (see [CANCEL OFF] and [ON CANCEL] above).

**Macros** • While step is on in macro execution, if the next step in the macro is a character (for example, A), that character will be displayed. If it is a command, a label followed by a number will be displayed. The four labels are as follows:

<table>
<thead>
<tr>
<th>Label</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quick Macro X</td>
<td>Quick Macro-letter Execution</td>
</tr>
<tr>
<td>KEY CMD n</td>
<td>Corel WordPerfect Command, Cursor Control, and so on</td>
</tr>
<tr>
<td>KEY MACRO n</td>
<td>Soft Keyboard Macro Execution</td>
</tr>
<tr>
<td>MACRO CMD n</td>
<td>Specific Macro Command</td>
</tr>
</tbody>
</table>

The X and n in the table above represent the letter or number that identifies the specific command of that type. Quick Macro-letter commands are identified by the letter to which they are assigned. Soft keyboard macro commands are identified by the number assigned to the macro by Keyboard Layout. Variables are identified by name. Keystroke commands and macro commands are identified by special code numbers that are listed below.

**Keystroke Command Codes (KEY CMD)**

<table>
<thead>
<tr>
<th>Keystroke Command Codes (KEY CMD)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 ^A – Delete to End of Page</td>
</tr>
<tr>
<td>2 ^B – Page Number</td>
</tr>
<tr>
<td>3 ^C – Merge from Console</td>
</tr>
<tr>
<td>4 ^D – Merge Date</td>
</tr>
<tr>
<td>5 ^E – Merge End Record</td>
</tr>
<tr>
<td>6 ^F – Merge Field</td>
</tr>
<tr>
<td>7 ^G – Merge Macro</td>
</tr>
<tr>
<td>8 ^H – Home</td>
</tr>
<tr>
<td>9 ^I – Tab</td>
</tr>
<tr>
<td>10 ^J – Enter</td>
</tr>
<tr>
<td>11 ^K – Delete to End of Line</td>
</tr>
<tr>
<td>12 ^L – Delete to End of Page</td>
</tr>
<tr>
<td>13 ^M – Search Value for [SRt]</td>
</tr>
<tr>
<td>14 ^N – Merge Next Record</td>
</tr>
<tr>
<td>15 ^O – Merge Output Prompt</td>
</tr>
<tr>
<td>16 ^P – Merge Primary Filename</td>
</tr>
<tr>
<td>17 ^Q – Merge Quit</td>
</tr>
<tr>
<td>18 ^R – Merge End Field</td>
</tr>
<tr>
<td>19 ^S – Merge Secondary Filename</td>
</tr>
<tr>
<td>20 ^T – Merge Text to Printer</td>
</tr>
<tr>
<td>21 ^U – Merge Update the Screen</td>
</tr>
</tbody>
</table>
22 ^V – Ignore Meaning of Following Code
23 ^W – Up
24 ^X – Right & Search Wildcard
   – Same as Typical “?”
25 ^Y – Left
26 ^Z – Down
27 ^[ – Escape
28 ^\n29 ^]
30 ^^ – Reset Keyboard Map
31 `_ – Cancel
32 Forward Search
33 Help
34 Indent
35 List
36 Bold
37 Exit
38 Underline
39 End Field
40 Save
41 Setup
42 Backwards Search
43 Switch
44 Left/Right Indent
45 Date/Outline
46 Center
47 Print
48 Format
49 Merge Codes
50 Retrieve
51 Thesaurus
52 Replace
53 Reveal Codes
54 Block
55 Mark Text
56 Flush Right
57 Columns/Table
58 Style
59 Graphics
60 Macro
61 Shell
62 Spell
63 Help
64 Indent
65 List
66 Bold
67 Underline
68 Exit
69 GoTo
70 Screen
71 Move
72 Text In/Out
73 Tab Align
74 Footnote
75 Merge/Sort
76 Macro Define
77 Backspace
78 Delete Right
79 Delete Word
80 Word Right
81 Word Left
82 Home,Home,Right (by pressing end key)
83 Home,Home,Left (by pressing begin key on the Victor computer)
84 GoTo
85 PgUp
86 PgDn
87 Screen Down (by pressing “+” on numeric keypad)
88 Screen Up (by pressing “-” on numeric keypad)
89 Typeover
90 Left Margin Release (reverse tab)
91 Hard Page
92 Soft Hyphen
93 Hyphen
94 Required (Hard) Space (Home,Space Bar)
95 Para Up
96 Para Down
97 Item Left
98 Item Right
99 Item Up
100 Item Down
101 Delete Row
102 Menu Bar
103 Block Append
104 Block Move
105 Block Copy
106 Block Append
107 Block Move
108 Block Copy
109 Block Copy
110 Block Copy
### Macro Command Codes (MACRO CMD)

<table>
<thead>
<tr>
<th></th>
<th>Command</th>
<th></th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>{ASSIGN}</td>
<td>31</td>
<td>{PROMPT}</td>
</tr>
<tr>
<td>2</td>
<td>{BELL}</td>
<td>32</td>
<td>{QUIT}</td>
</tr>
<tr>
<td>3</td>
<td>{BREAK}</td>
<td>33</td>
<td>{RESTART}</td>
</tr>
<tr>
<td>4</td>
<td>{CALL}</td>
<td>34</td>
<td>{RETURN}</td>
</tr>
<tr>
<td>5</td>
<td>{CANCEL OFF}</td>
<td>35</td>
<td>{RETURN CANCEL}</td>
</tr>
<tr>
<td>6</td>
<td>{CANCEL ON}</td>
<td>36</td>
<td>{RETURN ERROR}</td>
</tr>
<tr>
<td>7</td>
<td>{CASE}</td>
<td>37</td>
<td>{RETURN NOT FOUND}</td>
</tr>
<tr>
<td>8</td>
<td>{CASE CALL}</td>
<td>38</td>
<td>{SPEED}</td>
</tr>
<tr>
<td>9</td>
<td>{CHAIN}</td>
<td>39</td>
<td>{STEP ON}</td>
</tr>
<tr>
<td>10</td>
<td>{CHAR}</td>
<td>40</td>
<td>{TEXT}</td>
</tr>
<tr>
<td>11</td>
<td>{;} (comment)</td>
<td>41</td>
<td>{STATE}</td>
</tr>
<tr>
<td>12</td>
<td>{DISPLAY OFF}</td>
<td>42</td>
<td>{WAIT}</td>
</tr>
<tr>
<td>13</td>
<td>{DISPLAY ON}</td>
<td>43</td>
<td>{WHILE}</td>
</tr>
<tr>
<td>14</td>
<td>{ELSE}</td>
<td>44</td>
<td>{Macro Commands}</td>
</tr>
<tr>
<td>15</td>
<td>{END FOR}</td>
<td>45</td>
<td>{STEP OFF}</td>
</tr>
<tr>
<td>16</td>
<td>{END IF}</td>
<td>46</td>
<td>{ORIG KEY}</td>
</tr>
<tr>
<td>17</td>
<td>{END WHILE}</td>
<td>47</td>
<td>{IF EXISTS}</td>
</tr>
<tr>
<td>18</td>
<td>{FOR}</td>
<td>48</td>
<td>{MENU OFF}</td>
</tr>
<tr>
<td>19</td>
<td>{FOR EACH}</td>
<td>49</td>
<td>{MENU ON}</td>
</tr>
<tr>
<td>20</td>
<td>{GO}</td>
<td>50</td>
<td>{STATUS PROMPT}</td>
</tr>
<tr>
<td>21</td>
<td>{IF}</td>
<td>51</td>
<td>{INPUT}</td>
</tr>
<tr>
<td>22</td>
<td>{LABEL}</td>
<td>52</td>
<td>{VARIABLE}</td>
</tr>
<tr>
<td>23</td>
<td>{LOOK}</td>
<td>53</td>
<td>{SYSTEM}</td>
</tr>
<tr>
<td>24</td>
<td>{NEST}</td>
<td>54</td>
<td>{MID}</td>
</tr>
<tr>
<td>25</td>
<td>{NEXT}</td>
<td>55</td>
<td>{NTOK}</td>
</tr>
<tr>
<td>26</td>
<td>{SHEL MACRO}</td>
<td>56</td>
<td>{KTON}</td>
</tr>
<tr>
<td>27</td>
<td>{ON CANCEL}</td>
<td>57</td>
<td>{LEN}</td>
</tr>
<tr>
<td>28</td>
<td>{ON ERROR}</td>
<td>58</td>
<td>{˜} (hard tilde)</td>
</tr>
<tr>
<td>29</td>
<td>{ON NOT FOUND}</td>
<td>59</td>
<td>{PAUSE KEY}</td>
</tr>
<tr>
<td>30</td>
<td>{PAUSE}</td>
<td>60</td>
<td>{OTHERWISE}</td>
</tr>
</tbody>
</table>

In Macros, {STEP ON} is particularly useful when you want to track the contents of a variable. When a variable is encountered during macro execution with Step on, MACRO CMD 52 (for {VARIABLE}) is first displayed, then each letter of the name of the variable is displayed. Then its contents (if they exist) are displayed one character at a time. For example, if variable Num contains 14, the first message, MACRO CMD 52, is followed by an N, then a u, then an m, then a tilde (˜), which are then followed by a 1, then a 4.

If the execution command for a variable was entered as {VAR #}, VAR # is displayed instead of MACRO CMD 52. The contents are then displayed one character at a time as usual.

- (This section will execute normally.)
Merge  When step is on in Merge, if the next thing to be executed is a command (for example, [FIELD]), the command is displayed (there are no code lists as in Macros). Each character is displayed after it is written out to the resulting document.

You may find it more useful to step through merges with Reveal Codes on.

Macros  This command is not available in Macros; however, [QUIT] in Macros is equivalent to [STOP] in Merge (see [QUIT] above).

Merge  See the Merge subheading under the following commands for examples of how to use this command: [BELL], [CASE].

{SUBST PRIMARY}filename  This merge command is similar to the [NEST PRIMARY] and [CHAIN PRIMARY] commands, except with this command, the named primary file is used instead of the current primary file from the point of this command on. You are never returned to the original primary file; no commands following this one in the original primary file are executed. Local variables in a previous primary file are erased.

If you substitute a file that is not found, or no file ([SUBST PRIMARY]~), an error will be returned. You can use the [ON ERROR] command to determine what should happen if this error occurs (see [ON ERROR] above).
Macros • This command is not available in Macros.

Merge • In the following example, the secondary file has a field named DaysOverDue. The merge begins using the primary file invoice.pf, which substitutes a different primary file depending on the number in the DaysOverDue field. At the end of each substituted file, the record pointer is moved to the next record and invoice.pf is substituted so that it will execute again.

Primary file invoice.pf:

```
˜{IF}{FIELD}DaysOverDue˜<90˜{COMMENT}
  ˜{SUBST PRIMARY}60-89.pf˜{COMMENT}
  ˜{ELSE}{COMMENT}
  ˜{SUBST PRIMARY}over90.pf˜{COMMENT}
  ˜{END IF}{COMMENT}
˜{END IF}{COMMENT}
```

Structure of primary files 0-29.pf, 30-59.pf, 60-89.pf, and over90.pf:

•
• (body of file)
•
  [NEXT RECORD]{COMMENT}
  ˜{SUBST PRIMARY}invoice.pf˜

{SUBST SECONDARY}filename``
This merge command changes to the named secondary file and uses the first record in that file. If you substitute a file that is not found or no file ([SUBST PRIMARY]` ), an error will be returned. You can use the [ON ERROR] command to determine what should happen if this error occurs (see [ON ERROR] above).

In previous versions of Corel WordPerfect, this merge command was represented as ^Sfilename^S.

Macros • This command is not available in Macros.

Merge • In the following example, two secondary files are used, each sorted by ZIP Code in descending order so that any records where the Zip field is blank will be at the end of the file. The [SUBST SECONDARY] command in the primary file below causes the records with no ZIP Code to be skipped, and the next secondary file to be used.

```
[IF BLANK]Zip˜[SUBST SECONDARY]file2˜{COMMENT}
  If the Zip field is blank, substitute the secondary file
  ˜{END IF}
```

{SYSTEM}sysvar``
The [SYSTEM] command returns the value of the given system variable. These system variables allow the macro or merge to be aware of the current state of Corel WordPerfect. You can use mask values (see [STATE] above) to check for multiple system variables. Valid system variables are listed below.
Rather than use the name of the system variable in the \{SYSTEM\} command, you can use the number given in parentheses next to each system variable name below. Using the number instead of the name is especially useful when you want to use the same macro in different international versions of Corel WordPerfect. Since the system variable names are translated in international versions, running an English version of a macro would create an error at the \{SYSTEM\} command. The numbers, however, are the same across international versions.

Some of these system variables have restrictions when used in Merge. See the description of each variable for possible restrictions.

<table>
<thead>
<tr>
<th>Sysvar</th>
<th>Value(s) Returned</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attrib (1)</td>
<td>Current font attribute:</td>
</tr>
<tr>
<td>0</td>
<td>Normal</td>
</tr>
<tr>
<td>1</td>
<td>Extra Large</td>
</tr>
<tr>
<td>2</td>
<td>Very Large</td>
</tr>
<tr>
<td>4</td>
<td>Large</td>
</tr>
<tr>
<td>8</td>
<td>Small</td>
</tr>
<tr>
<td>16</td>
<td>Fine</td>
</tr>
<tr>
<td>32</td>
<td>Superscript</td>
</tr>
<tr>
<td>64</td>
<td>Subscript</td>
</tr>
<tr>
<td>128</td>
<td>Outline</td>
</tr>
<tr>
<td>256</td>
<td>Italics</td>
</tr>
<tr>
<td>512</td>
<td>Shadow</td>
</tr>
<tr>
<td>1024</td>
<td>Redline</td>
</tr>
<tr>
<td>2048</td>
<td>Double Underline</td>
</tr>
<tr>
<td>4096</td>
<td>Bold</td>
</tr>
<tr>
<td>8192</td>
<td>Strikeout</td>
</tr>
<tr>
<td>16384</td>
<td>Underline</td>
</tr>
<tr>
<td>32768</td>
<td>Small Caps</td>
</tr>
</tbody>
</table>

If two attributes are present, their respective numbers will be added together.

Cell (2) Current cell position in a table, such as A4 or E7. This system variable is undefined if the cursor is not in a table when the command is encountered.

CellAttr (23) Attributes of the current cell (see Attrib above for values). This system variable is undefined if the cursor is not in a table when the command is encountered.

CellState (24) State of a cell. Divide the value returned by 256 (value returned/256—see Appendix J: Macros and Merge, Expressions) to determine the following states:

0 Left justified.
Sysvar | Value(s) Returned
---|---
1 | Full justified.
2 | Center justified.
3 | Right justified.
4 | Decimal aligned.

Mod the value returned by 256 (\texttt{value returned} \bmod 256—see Appendix J: Macros and Merge, Expressions) to determine the following states:

1 | Justify is cell-specific.
2 | Attribute is cell-specific.
4 | Cell is bottom-aligned.
8 | Cell is center-aligned.
16 | Contents type is “text.”
32 | Contents is a formula.
64 | Cell is locked.

This system variable is undefined if the cursor is not in a table when the command is encountered.

Column (3) Current column number (numbered sequentially from left to right) in a table or in columns.

Document (4) Current modification status of the document on the screen:

1 | Document has been modified.
4 | Document has been modified since last generated.
256 | Document is blank. (Blank documents are those that appear in document screens when you first start Corel WordPerfect, and when you exit to a clear screen. A document from which you delete all text and codes is not “blank.”)
512 | Cursor is between \[Tbl Def\] and \[Tbl Off\] codes (in a table).
1024 | Cursor is between \[Math On\] and \[Math Off\] or the end of the file (Math is on).
2048 | Cursor is between \[Outline On\] and \[Outline Off\] or the end of the file (Outline is on).
4096 | Cursor is between \[Column On\] and \[Column Off\] or the end of the file (Column is on).
<table>
<thead>
<tr>
<th><strong>Sysvar</strong></th>
<th><strong>Value(s) Returned</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Endnote (5)</td>
<td>Number of the current endnote.</td>
</tr>
<tr>
<td>Entry (29)</td>
<td>When in a list, the string name of the currently highlighted entry. This system variable is not available when the cursor is not in a list (see List below) or in the following lists: Keyboard Edit, Macro Commands, Merge Commands, and Equation Palette.</td>
</tr>
</tbody>
</table>
| Equation (6) | Number of the current equation, according to the following formula:  
  \[
  \text{Return value/32=first level} \\
  \text{Return value\%32=second level}
  \]  
  For example, if the current equation is 1.2, \{SYSTEM\}Equation\^ will return 34 (that is, \(34/32=1\), \(34\%32=2\)). |
| Figure (7) | Number of the current figure, according to the formula described under system variable Equation above. |
| Footnote (8) | Number of the current footnote. |
| Left (9) | Item (character or code) immediately to the left of the cursor (see Appendix L: Macros and Merge, Value Tables). |
| Line (10) | Vertical position of the cursor in 1200ths of an inch. |
| List (11) | Number of items in the current list. (For purposes of this system variable, a list is any list in Corel WordPerfect where you can perform a name search.)  
  65535 The cursor is not in a list.  
  0 The list is empty.  
  Other The number of items in the list. In List Files, “Current” and “Parent” each count as an item on the list. Therefore, \{SYSTEM\}List\^ while in List Files returns 2 plus the number of files in the list (for example, if there are 3 files in the list, \{SYSTEM\}List\^ returns 5; if there are no files in the list, it returns 2). |
<p>| Menu (13) | Number of the menu currently active: (see Appendix L: Macros and Merge Value Tables). |
| Name (12) | Name of the current document (for example, jones.ltr.). Since there is no filename associated with the merged document while the merge is executing, this system variable is not available in Merge. |
| Number (26) | Current document number (1-9). |</p>
<table>
<thead>
<tr>
<th>Sysvar</th>
<th>Value(s) Returned</th>
</tr>
</thead>
<tbody>
<tr>
<td>Page (14)</td>
<td>Current page number.</td>
</tr>
<tr>
<td>Path (15)</td>
<td>Path to the current document (for example, /usr/home/). (Note the slash on the end of the path.) Since there is no path associated with the merged document during a merge, this system variable is not available in Merge.</td>
</tr>
<tr>
<td>Print (17)</td>
<td>Current print status:&lt;br&gt;8 Printer is waiting for a Go. All other values are undefined and not guaranteed to be 0.</td>
</tr>
<tr>
<td>Right (18)</td>
<td>Item on which the cursor is resting. In Merge, this command will return 0 if the cursor is resting on a Soft Return or Soft Page code (see Appendix L: Macros and Merge, Value Tables).</td>
</tr>
<tr>
<td>Row (22)</td>
<td>Current row number in a table (equals 0 if the cursor is not in a table when the command is encountered).</td>
</tr>
<tr>
<td>Row State (27)</td>
<td>Header status of current row.&lt;br&gt;0 Not in a table, or in a table but current row is not a header row.&lt;br&gt;1 In a table, and current row is a header row.</td>
</tr>
<tr>
<td>ShellVer (25)</td>
<td>Current Corel Shell version number. (Shell is an optional Corel program.) The formula for determining the version from the number returned is: &lt;br&gt;(Major Version# * 256) + Minor Version#</td>
</tr>
<tr>
<td>TableBox (19)</td>
<td>Number of the current Table box, according to the formula described under system variable Equation above.</td>
</tr>
<tr>
<td>TextBox (20)</td>
<td>Number of the current Text box, according to the formula described under system variable Equation above.</td>
</tr>
<tr>
<td>UserBox (21)</td>
<td>Number of the current User-Defined box, according to the formula described under system variable Equation above.</td>
</tr>
</tbody>
</table>

**Macros** *The following example ends the macro if the document screen is not blank.*
This example determines if "bill" or "bills" needs to be put in a letter by using the \{SYSTEM\}left command.

You have \{FIELD\}bills\{COMMENT\}Get the number of bills from the secondary file

\{IF\}\{SYSTEM\}left =~ 1\{COMMENT\}Was there only one bill?

  bill\{COMMENT\}Yes, put singular form

\{ELSE\}\{COMMENT\}Must be plural

  bills\{COMMENT\}Put the plural form

\{END IF\}

\{TEXT\}var message\{CHAR\}The \{TEXT\} command prompts the user by displaying a message on the status line. The input (up to 129 characters) from the user is then assigned to the variable (see \{CHAR\} above). See Message Display under Notes at the end of this appendix for information on affecting the way messages are displayed. See also Prompting and User Input under Notes at the end of this appendix for additional methods of obtaining user input.

After the \{TEXT\} command executes, the contents of the status line just previous to the execution of the \{TEXT\} command are restored, even if the contents are the message of a previously executed \{PROMPT\} or \{STATUS PROMPT\} message to reappear after the \{TEXT\} command. Use \{PROMPT\} before the \{TEXT\} command to clear the status line.

\{MACRO\} Macros • See the Macros subheading under the following commands for examples of how to use this command: \{BELL\}, \{BREAK\}, \{BREAK\}, \{IF EXISTS\}, \{LEN\}, \{MENU OFF\}, \{NTOK\}, \{ON ERROR\}.

\{MERGE\} Merge • See the Merge subheading under the following commands for examples of how to use this command: \{BELL\}, \{IF EXISTS\}, \{NTOC\}.

\{VARIABLE\}var This command accesses the contents of global and local (Merge) variables. If you have both a global and local variable by the same name, this command accesses the local variable. There is no way to access global variables while local variables of the same name exist. (For an explanation of global and local variables, see Appendix M: Macros and Merge, Variables.)

After a value has been assigned to a variable (see \{ASSIGN\} and \{LOCAL\} above), the \{VARIABLE\} var command can be placed anywhere you would normally place the variable contents. It can be placed within or as an argument for another command, or by itself.

A variable can hold no more than 129 keystrokes (characters).
Macros • See the Macros subheading under the following commands for examples of how to use this command: {;} (comment), {ASSIGN}, {BELL}, {BREAK}, {CASE}, {CASE CALL}, {CHAR}, {ELSE}, {FOR EACH}, {GO}, {IF}, {Item Down}, {Item Left}, {Item Right}, {Item Up}, {KTON}, {LOOK}, {MENU OFF}, {NEXT}, {NTOK}, {ON ERROR}, {RESTART}, {WHILE}.

Merge • See the Merge subheading under the following commands for examples of how to use this command: {ASSIGN}, {BELL}, {BREAK}, {CASE}, {CASE CALL}, {COMMENT}, {CTON}, {DOCUMENT}, {IF}, {LEN}, {LOOK}, {MID}, {NEST MACRO}, {NEXT}, {NEXT RECORD}, {NTOC}.

{WAIT} 10ths second
The {WAIT} command delays further execution of the macro or merge for the indicated time. This command is useful when you want a message to be displayed for a certain amount of time.

Macros • See the Macros subheading under the following commands for examples of how to use this command: {ON CANCEL}, {ON ERROR}, {STATUS PROMPT}.

Merge • See the Merge subheading under the following commands for examples of how to use this command: {BELL}, {ON CANCEL}, {ON ERROR}.

{WHILE} expr
While the expression expr is true, the commands between the {WHILE} and the {END WHILE} are repeatedly executed. This command is like the {FOR} command, except that it does not increment a value each time through the loop. In order to end the loop, use another command that will force the expression to be evaluated as false (see Loops under Notes at the end of this appendix).

Remember that if you use a variable in expr, the variable must already exist before the {WHILE} command is executed.

Macros • In this example, the message “Counting” will be displayed until variable “Count” reaches 50.

{ASSIGN}Count 0
{;}Initialize var Count.·(This command creates the variable, then assigns it “0”)·
{WHILE} [VARIABLE]Count < 50
{PROMPT} Counting
{;}Send the prompt “Counting”·
{ASSIGN}Count [VARIABLE] Count + 1
{;}Increment var Count each time through the loop
{END WHILE}

Merge • In the following example, {WHILE} skips all records that do not match a specific ZIP code.

{ASSIGN} zipcode = [FIELD] zipcode [COMMENT]
Initialize the variable to the first ZIP code.
While the ZIP code is not equal to the desired value...

...go to the next record.

Assign the ZIP code from the next record to var zipcode.

Notes

Chaining, Nesting, and Substituting

Chaining a macro or merge file causes the named file to take over control of execution as soon as execution of the current file is complete. A single file (whether a macro file, a primary merge file, or a secondary merge file) can only use one chain command. If you include more than one chain command, the last one encountered during the merge or macro will be the only one executed. The chained file only executes when the current macro or merge file is completely finished.

The commands that chain are as follows:

- [CHAIN]
- [CHAIN MACRO]
- [CHAIN PRIMARY]
- [CHAIN SECONDARY]

Nesting is the process of moving control of execution to another file (such as another macro file or primary file). Execution then returns to the parent file (directly after the nest command) when execution of the nested file terminates.

Nesting a macro is similar to calling a subroutine (see Subroutines below), except that the nested macro is not a part of the calling macro. It is a separate macro, referenced by giving the macro name or the full pathname if it is not in the Keyboard/Macro Files directory currently specified in Location of Files. You do not need to include the .wpm extension in the filename or pathname. Because execution is automatically returned when the nested macro has finished, you do not need to place a [RETURN] command at the end of a nested macro.

If there are certain procedures which you frequently use in your macros or merges, you can put them in smaller macros and nest them when they are needed.

You can nest macro and merge files several levels deep (see Levels below). The main file nests a second file; the second file nests a third. After the third file has finished, the rest of the second file is executed. After the second file has finished, the remaining part of the main file is executed.

The commands that nest are as follows:

- [NEST]
- [NEST MACRO]
- [NEST PRIMARY]
- [NEST SECONDARY]

Substituting is the process of permanently changing control of execution to another file. The substitution takes effect as soon as the command is
encountered, and control is never returned to the file that contained this command.

The commands that substitute are as follows:

{SUBST PRIMARY} ➤
{SUBST SECONDARY} ➤

**Commenting Out**

You can use the {;} or {COMMENT} commands to comment out sections of a macro or merge that you don’t want to execute. This practice is useful for testing and debugging your macros and merges.

Anything (including commands) between the {;} or {COMMENT} command and the next tilde is ignored in execution. It is easy to comment out commands such as {NEST}, {CHAIN}, and so on, where there is only one tilde associated with the command:

{;}{NEST}thefile˜

However, if the commands to be commented out have more than one tilde, you must insert a {;} or {COMMENT} to correspond to each one:

{COMMENT}{ASSIGN}Number˜{COMMENT}45˜

When multiple tildes are involved, you may find it easier to delete the additional tildes in the section to be commented out so that you only have to use one {;} or {COMMENT} command. The tildes would have to be re-inserted if you later decided to restore the section.

In Merge, a frequent use of {COMMENT} is to comment out Hard Return and Tab codes you use to format commands in the file. If you do not comment out these codes, they are included in the resulting merged document. See the Merge subheadings in this appendix for examples. The example under the {COMMENT} command may be especially useful.

**If Blank, If Not Blank, and ?**

In previous versions of Corel WordPerfect, a question mark (?) was used to avoid merging a field if it was blank (for example, ^F1?). This system had certain drawbacks, such as that anything in the primary file after the question mark but on the same line was also not printed if the field was blank. The {IF BLANK} and {IF NOT BLANK} commands in Corel WordPerfect 7 have eliminated this problem, plus added all the flexibility of a standard IF structure.

Although you can still use the ^F## construction, you will probably find it more convenient to use the {IF BLANK} and {IF NOT BLANK} commands.

**Inserting Merge Commands During Execution**

While an executing merge is paused at a {KEYBOARD} or {INPUT} command, you can execute the {QUIT}, {NEXT RECORD}, or {STOP} commands from the keyboard.

1. Press Merge Codes.
2. Select Quit (1), Next Record (2), or Stop (3).
Selecting the command from this menu functions as if the command had been encountered in the primary file. See the description of each of these commands in this appendix for more information on their functions.

**Levels**

In Macros, you can have up to 30 levels of execution. Each \{NEST\} command uses 2 levels (one for executing the macro and one for a possible CHAIN command). Each \{CALL\}, \{CASE CALL\}, nested \{IF\}, \{FOR\}, \{FOR EACH\}, or \{WHILE\} command uses 1 level.

In Merge, you can have up to 20 levels of execution per file. \{IF\} commands do not require a level (they can be nested indefinitely). Each \{CASE\}, \{CASE CALL\}, \{FOR\}, or \{WHILE\} uses 1 level.

Execution levels are maintained in stacks. In general, Macros and Merge use separate stacks to maintain levels. However, all expressions use the Macros stack. Generally, expressions use one level, but may use more if they are very complex. However, since expressions use the Macros stack, they effectively use no levels in Merge.

In Merge, the levels for the nesting commands (\{NEST MACRO\}, \{NEST PRIMARY\}, or \{NEST SECONDARY\}) are maintained in a separate stack. They do not require an execution level (because for each file nested you have 20 new execution levels), but they do require a nesting level. Files can be nested 10 deep.

The levels used by these commands are released when the command ends normally. For example, the level used by a \{CALL\} command is released when a \{RETURN\} command ends the subroutine. The level used by the \{IF\} command is released when the \{END IF\} is executed, and the level used by the \{FOR\} command is released at the \{END FOR\} after the last iteration of the FOR loop. If any of these level-using structures are exited abnormally, the level is not released. For example, if you use a \{GO\} or \{CASE\} in the subroutine executed by a \{CALL\} command, the level corresponding to the \{CALL\} is never released. If you "lose" 28 levels in this way, the macro will terminate.

**Loops**

Whenever the same commands repeat several times, that section of the macro or merge is called a loop. For example,

```
\{LABEL\} Top
\{;\} Top-of-the-loop
endless-loop
\{;\} Type "endless-loop"
\{GO\} Top
\{;\} Go-to-top
```

In this example, the words “endless loop” are written continuously to the screen. There is no way to stop execution without pressing Cancel or killing the Corel WordPerfect process. When you create a loop, it is very important to have a way for the loop to end.

In the following example, a count is kept of the number of times the text has been written to the screen. After the tenth time, the loop ends.
There are many types of loops you can create with Macros and Merge commands. You can use an IF structure as in the above examples, or you can use the \{FOR\}, \{FOR EACH\}, or \{WHILE\} commands (see each command above). You can also create loops by going to or calling subroutines (with the \{GO\} or \{CALL\} command). The structure you should use for any given loop will depend on the task you are trying to accomplish.

**Message Display**

The following commands send a message to the screen when executed:

- \{CHAR\}
- \{INPUT\}
- \{PROMPT\}
- \{STATUS PROMPT\}
- \{TEXT\}

In Macros, you can use control characters to both position the message on the screen, and affect the display attributes (such as Bold, Mnemonics, and so on) of the message. For information on using control characters and display attributes, see *Macros, Message Display*.

In Merge, neither control characters nor display attributes are available when sending messages to the screen. However, there are techniques for affecting the display of messages:

**Soft Wrapping** • If you include a message that is longer than you have room for on the status line, it will automatically wrap to the next line. The first line of the message will scroll up to the next line. The message will continue to scroll until the entire message is displayed. (You can also use this method in Macros.)

**Hard Wrapping** • If you want to determine where a message will wrap (rather than letting it soft wrap), insert a hard return \{HRt\} at each point in the message where you want it to wrap.
**Nesting a Macro**  • If you decide you need or want the positioning and attributes available for message display in Macros, you can put the command that sends the message in a nested macro (see `{NEST MACRO}` above).

See also *Prompting and User Input* below.

**Previous Merge Commands**

In previous versions of Corel WordPerfect, some of the Merge programming commands were available, although they were represented using a caret (^) and a letter as a control character, instead of a command made up of a word or words in braces, as they are in Corel WordPerfect 8. The following is a list of these command equivalents:

<table>
<thead>
<tr>
<th>Old Command</th>
<th>New Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>^C</td>
<td>{KEYBOARD}</td>
</tr>
<tr>
<td>^D</td>
<td>{DATE}</td>
</tr>
<tr>
<td>^E</td>
<td>{END RECORD}</td>
</tr>
<tr>
<td>^F&lt;name&gt; or ^F&lt;#&gt;</td>
<td>{FIELD}</td>
</tr>
<tr>
<td>^G&lt;macro&gt;</td>
<td>{CHAIN MACRO}</td>
</tr>
<tr>
<td>^N</td>
<td>{NEXT RECORD}</td>
</tr>
<tr>
<td>^O&lt;message&gt;</td>
<td>{PROMPT}</td>
</tr>
<tr>
<td>^P&lt;filename&gt;</td>
<td>{NEST PRIMARY}</td>
</tr>
<tr>
<td>^Q</td>
<td>{QUIT}</td>
</tr>
<tr>
<td>^R</td>
<td>{END FIELD}</td>
</tr>
<tr>
<td>^S&lt;filename&gt;</td>
<td>{SUBST SECONDARY}</td>
</tr>
<tr>
<td>^T</td>
<td>{PRINT}</td>
</tr>
<tr>
<td>^U</td>
<td>{REWRITE}</td>
</tr>
<tr>
<td>^V</td>
<td>{MRG CMND}</td>
</tr>
</tbody>
</table>

If you have files that use the old code format, see *Previous Versions* under Merge for information on whether or not they will have to be converted for use with Corel WordPerfect 8.

**Prompting and User Input**

The following commands can prompt the user of your macro or merge, and/or obtain input from the user:

- `{CHAR}`
- `{INPUT}`
- `{KEYBOARD}`
- `{LOOK}`
- `{PAUSE}`
- `{PAUSE KEY}`
- `{PROMPT}`
- `{STATUS PROMPT}`
- `{TEXT}`

These commands are similar to each other in some ways, yet different in others. The chart below shows some of these differences and similarities. Comparisons are based on the following features of each command:
• Whether or not a message is sent with the command or command combination.

• If a message is sent, whether the message remains on the screen until 1) the screen is rewritten or the message is overwritten with a new command, 2) input is terminated, or 3) you exit Corel WordPerfect or the message is overwritten with a new command.

• Whether or not execution stops at the command or command combination for user input.

• If execution stops for input, whether the input goes directly into the document or into a variable.

• If execution stops for input, the method of terminating input.

• Whether the command or command combination is available in Macros only, Merge only, or in both features.

<table>
<thead>
<tr>
<th>Commands</th>
<th>Sends Message?</th>
<th>Message Duration</th>
<th>Stops for user Input?</th>
<th>Input Goes To:</th>
<th>Input Termination method:</th>
<th>Available In:</th>
</tr>
</thead>
<tbody>
<tr>
<td>{CHAR}</td>
<td>Yes</td>
<td>R/O</td>
<td>Yes</td>
<td>Vnr.</td>
<td>1 Char.</td>
<td>Both</td>
</tr>
<tr>
<td>{INPUT}</td>
<td>Yes</td>
<td>T</td>
<td>Yes</td>
<td>Doc.</td>
<td>Enter (Macros)</td>
<td>Both</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>F9 (Merge)</td>
<td></td>
</tr>
<tr>
<td>{KEYBOARD}</td>
<td>No</td>
<td>n/a</td>
<td>Yes</td>
<td>Doc.</td>
<td>1 Char. or nothing</td>
<td>Both</td>
</tr>
<tr>
<td>{LOOK}</td>
<td>No</td>
<td>n/a</td>
<td>No</td>
<td>Vnr.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>{PAUSE}</td>
<td>No</td>
<td>n/a</td>
<td>Yes</td>
<td>Doc.</td>
<td>Enter</td>
<td>Macros</td>
</tr>
<tr>
<td>{PAUSE KEY}</td>
<td>No</td>
<td>n/a</td>
<td>Yes</td>
<td>Doc.</td>
<td>Specified key</td>
<td>Macros</td>
</tr>
<tr>
<td>{PROMPT}</td>
<td>Yes</td>
<td>R/O</td>
<td>No</td>
<td>n/a</td>
<td></td>
<td>Both</td>
</tr>
<tr>
<td>{STATUS PROMPT}</td>
<td>Yes</td>
<td>E/O</td>
<td>No</td>
<td>n/a</td>
<td></td>
<td>Both</td>
</tr>
<tr>
<td>{TEXT}</td>
<td>Yes</td>
<td>R/O</td>
<td>Yes</td>
<td>Vnr.</td>
<td>Enter</td>
<td>Both</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Command Combinations</th>
</tr>
</thead>
<tbody>
<tr>
<td>{PROMPT} with {KEYBOARD}</td>
</tr>
<tr>
<td>*{PROMPT} with {PAUSE}</td>
</tr>
<tr>
<td>*{PROMPT} with {PAUSE KEY}</td>
</tr>
<tr>
<td>{STATUS PROMPT} with {KEYBOARD}</td>
</tr>
<tr>
<td>{STATUS PROMPT} with {PAUSE}</td>
</tr>
<tr>
<td>Commands</td>
</tr>
<tr>
<td>----------</td>
</tr>
<tr>
<td>{STATUS PROMPT} with {PAUSE KEY}</td>
</tr>
</tbody>
</table>

**Legend**

- n/a: Not applicable
- T: Termination
- R/O: Rewrite Screen or Overwrite Message
- E/O: Exit Corel WordPerfect or Overwrite Message

*Although {PROMPT} messages normally appear only until the screen is rewritten or the message is overwritten, the message will reappear even after these normal terminations if the {PROMPT} command is followed by a {CHAR} or {TEXT} command. This occurs because the {CHAR} and {TEXT} commands take a "picture" of the status line, execute, and then redisplay the "picture."

**Record Pointer**

In a secondary merge file, there are several records. As a merge is executed, the primary file is repeated once for every record in the secondary file (unless you use commands to alter this procedure). The **record pointer** is the internal device that Corel WordPerfect uses to keep track of which record it is currently using from the secondary file. (You cannot see the record pointer.)

At the start of a merge, the record pointer points to the first record in the secondary file. As the merge progresses, the pointer automatically moves to each subsequent record as the primary file is repeated. You can force the record pointer to move to the next record by using the {NEXT RECORD} command (see {NEXT RECORD} above). This is useful when you want to change to the next record without repeating the primary file.

**Subroutines**

A subroutine is a set of commands you may want to execute several times in a macro or merge. Instead of repeating the commands each time you need them, you can include them only once, then send execution to that spot each time you want the commands performed. Inserting a call to a subroutine functions as if its commands were placed at each point of the call. There is no limit to the number of subroutines you can have in a macro or merge file.

A subroutine is identified by two commands. The first command, {LABEL}, marks the beginning of a subroutine. The second command, {RETURN}, marks the end.

Some subroutines do not need a {RETURN} at the end, if the commands in the subroutine guarantee correct branching or returning.

The commands you can use to send execution to a subroutine are as follows:

- {CALL}  
- {CASE}  
- {CASE CALL}  
- {GO}

---

672  Appendix K: Macros and Merge, Programming Commands
Since there may be more than one subroutine in a macro, the name associated with each one must be unique. The label name must be entered as an argument in the command that sends execution to the subroutine, and must match the name following the {LABEL} command identifying the beginning of the subroutine.

If you use local variables in Merge, you cannot use the same name for both a subroutine and a local variable.

Troubleshooting
If you have trouble getting your macros or merges to work, check to see that you have not made one of the following errors:

- Incorrect number or placement of tildes. (See the descriptions of the commands you are using.)
- Using a variable name instead of the {VARIABLE} var command, or vice versa. (See the description of the commands you are using, and Appendix L: Macros and Merge, Variables.)
- Other syntax errors. (See the descriptions of the commands you are using.)
- Infinite loops. (See Loops above.)
- Trying to reference a global variable while a local variable of the same name is accessible. (See Appendix L: Macros and Merge, Variables.)
- Using a local variable and label of the same name. (See {LOCAL} and {LABEL} above.)
- In a merge, accessing a global variable that contains keystrokes. (See Keystroke Commands in Variables in Appendix L: Macros and Merge, Variables.)
- Missing a {RETURN} at the end of a subroutine. (See Subroutines above.)
- Misspelled variable or label names.
- Going to or calling non-existent labels, or accessing non-existent variables.
- In a merge, incorrect placement of {COMMENT} command and its tilde, or lack of use of the {COMMENT} command. (See {COMMENT} and Commenting Out above.)
- Nesting files too many deep or using too many levels. (See Levels above.)
- Performing a numeric operation on a string. This usually happens when you use an invalid character (such as a space, period, or comma) in an expression which is assigned to a variable. (See Appendix J: Macros and Merge, Expressions.)
- Missing loop terminators (see {END FOR}, {END IF}, {END WHILE}).
• Missing or improper nested files, or improper termination of nested files (see \{NEST\} \{NEST MACRO\}, \{NEST PRIMARY\}, \{NEST SECONDARY\}, and Chaining, Nesting, and Substituting above).

• In a merge, using an open code (such as a Tab Set or Margin Set) in a primary file that is not reset at the beginning of the file. (Any open code encountered during the merge will be in effect in the resulting merged document until another open code of the same type is found to counteract it.)

See Also: Macros; Macros, Define; Macros, Execute; Macros, Macro Editor; Macros, Message Display; Merge; Appendix I; Appendix J; Appendix L
Appendix L: Macros and Merge, Value Tables

This appendix lists the values returned by various macro and merge programming commands.

(KTON) and (NTOK) The following table shows the Corel WordPerfect key values used with the [KTON] and [NTOK] programming commands. For more information on using these commands, see Appendix K: Macros and Merge, Programming Commands.

<table>
<thead>
<tr>
<th>Value</th>
<th>Key Name</th>
<th>Macro Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>32768</td>
<td>Compose</td>
<td>{Compose}(^1)</td>
</tr>
<tr>
<td>32769</td>
<td>^A</td>
<td>^(\text{A})</td>
</tr>
<tr>
<td>32770</td>
<td>^B</td>
<td>^(\text{B})</td>
</tr>
<tr>
<td>32771</td>
<td>^C</td>
<td>^(\text{C})</td>
</tr>
<tr>
<td>32772</td>
<td>^D</td>
<td>^(\text{D})</td>
</tr>
<tr>
<td>32773</td>
<td>^E</td>
<td>^(\text{E})</td>
</tr>
<tr>
<td>32774</td>
<td>^F</td>
<td>^(\text{F})</td>
</tr>
<tr>
<td>32775</td>
<td>^G</td>
<td>^(\text{G})</td>
</tr>
<tr>
<td>32776</td>
<td>Home or ^H</td>
<td>(Home)</td>
</tr>
<tr>
<td>32777</td>
<td>Tab or ^I</td>
<td>(Tab)</td>
</tr>
<tr>
<td>32778</td>
<td>Enter or ^J</td>
<td>(Enter)</td>
</tr>
<tr>
<td>32779</td>
<td>Delete to End of Line or ^K</td>
<td>(Del EOL)</td>
</tr>
<tr>
<td>32780</td>
<td>Delete to End of Page or ^L</td>
<td>(Del EOP)</td>
</tr>
<tr>
<td>32781</td>
<td>^M</td>
<td>^(\text{M})</td>
</tr>
<tr>
<td>32782</td>
<td>^N</td>
<td>^(\text{N})</td>
</tr>
<tr>
<td>32783</td>
<td>^O</td>
<td>^(\text{O})</td>
</tr>
<tr>
<td>32784</td>
<td>^P</td>
<td>^(\text{P})</td>
</tr>
<tr>
<td>32785</td>
<td>^Q</td>
<td>^(\text{Q})</td>
</tr>
<tr>
<td>32786</td>
<td>^R</td>
<td>^(\text{R})</td>
</tr>
<tr>
<td>32787</td>
<td>^S</td>
<td>^(\text{S})</td>
</tr>
<tr>
<td>32788</td>
<td>^T</td>
<td>^(\text{T})</td>
</tr>
<tr>
<td>32789</td>
<td>^U</td>
<td>^(\text{U})</td>
</tr>
<tr>
<td>32790</td>
<td>^V</td>
<td>^(\text{V})</td>
</tr>
<tr>
<td>32791</td>
<td>Up Arrow or ^W</td>
<td>(Up)</td>
</tr>
<tr>
<td>32792</td>
<td>Right Arrow or ^X</td>
<td>(Right)</td>
</tr>
<tr>
<td>32793</td>
<td>Left Arrow or ^Y</td>
<td>(Left)</td>
</tr>
<tr>
<td>32794</td>
<td>Down Arrow or ^Z</td>
<td>(Down)</td>
</tr>
<tr>
<td>32795</td>
<td>Escape or ^[</td>
<td>(Esc)</td>
</tr>
<tr>
<td>32796</td>
<td>(\backslash)</td>
<td>(\backslash)</td>
</tr>
<tr>
<td>32797</td>
<td>(\text{\textbackslash})</td>
<td>(\text{\textbackslash})</td>
</tr>
<tr>
<td>32798</td>
<td>^(\text{^})</td>
<td>^(\text{^})</td>
</tr>
<tr>
<td>32799</td>
<td>^_</td>
<td>^(\text{_})</td>
</tr>
<tr>
<td>32800</td>
<td>Cancel</td>
<td>(Cancel)</td>
</tr>
<tr>
<td>32801</td>
<td>#Search</td>
<td>(Search)</td>
</tr>
<tr>
<td>32802</td>
<td>Help</td>
<td>(Help)</td>
</tr>
<tr>
<td>32803</td>
<td>Indent</td>
<td>(Indent)</td>
</tr>
<tr>
<td>32804</td>
<td>List</td>
<td>(List)</td>
</tr>
<tr>
<td>32805</td>
<td>Bold</td>
<td>(Bold)</td>
</tr>
<tr>
<td>32806</td>
<td>Exit</td>
<td>(Exit)</td>
</tr>
<tr>
<td>32807</td>
<td>Underline</td>
<td>(Underline)</td>
</tr>
<tr>
<td>32808</td>
<td>End Field(^2)</td>
<td>(End Field)</td>
</tr>
<tr>
<td>32809</td>
<td>Save</td>
<td>(Save)</td>
</tr>
<tr>
<td>32812</td>
<td>Setup</td>
<td>(Setup)</td>
</tr>
<tr>
<td>Value</td>
<td>Key Name</td>
<td>Macro Command</td>
</tr>
<tr>
<td>-------</td>
<td>-----------------------</td>
<td>---------------------</td>
</tr>
<tr>
<td>32813</td>
<td>♦Search</td>
<td>(Search Left)</td>
</tr>
<tr>
<td>32814</td>
<td>Switch</td>
<td>(Switch)</td>
</tr>
<tr>
<td>32815</td>
<td>♦Indent♦</td>
<td>(L/R Indent)</td>
</tr>
<tr>
<td>32816</td>
<td>Date/Outline</td>
<td>(Date/Outline)</td>
</tr>
<tr>
<td>32817</td>
<td>Center</td>
<td>(Center)</td>
</tr>
<tr>
<td>32818</td>
<td>Print</td>
<td>(Print)</td>
</tr>
<tr>
<td>32819</td>
<td>Format</td>
<td>(Format)</td>
</tr>
<tr>
<td>32820</td>
<td>Merge Codes</td>
<td>(Merge Codes)</td>
</tr>
<tr>
<td>32821</td>
<td>Retrieve</td>
<td>(Retrieve)</td>
</tr>
<tr>
<td>32824</td>
<td>Thesaurus</td>
<td>(Thesaurus)</td>
</tr>
<tr>
<td>32825</td>
<td>Replace</td>
<td>(Replace)</td>
</tr>
<tr>
<td>32826</td>
<td>Reveal Codes</td>
<td>(Reveal Codes)</td>
</tr>
<tr>
<td>32827</td>
<td>Block</td>
<td>(Block)</td>
</tr>
<tr>
<td>32828</td>
<td>Mark Text</td>
<td>(Mark Text)</td>
</tr>
<tr>
<td>32829</td>
<td>Flush Right</td>
<td>(Flush Right)</td>
</tr>
<tr>
<td>32830</td>
<td>Columns/Table</td>
<td>(Columns/Tables)</td>
</tr>
<tr>
<td>32831</td>
<td>Style</td>
<td>(Style)</td>
</tr>
<tr>
<td>32832</td>
<td>Graphics</td>
<td>(Graphics)</td>
</tr>
<tr>
<td>32833</td>
<td>Macro</td>
<td>(Macro)</td>
</tr>
<tr>
<td>32836</td>
<td>Shell</td>
<td>(Shell)</td>
</tr>
<tr>
<td>32837</td>
<td>Spell</td>
<td>(Spell)</td>
</tr>
<tr>
<td>32838</td>
<td>Screen</td>
<td>(Screen)</td>
</tr>
<tr>
<td>32839</td>
<td>Move</td>
<td>(Move)</td>
</tr>
<tr>
<td>32840</td>
<td>Text In/Out</td>
<td>(Text In/Out)</td>
</tr>
<tr>
<td>32841</td>
<td>Tab Align</td>
<td>(Tab Align)</td>
</tr>
<tr>
<td>32842</td>
<td>Footnote</td>
<td>(Footnote)</td>
</tr>
<tr>
<td>32843</td>
<td>Font</td>
<td>(Font)</td>
</tr>
<tr>
<td>32844</td>
<td>Merge/Sort</td>
<td>(Merge/Sort)</td>
</tr>
<tr>
<td>32845</td>
<td>Macro Define</td>
<td>(Macro Define)</td>
</tr>
<tr>
<td>32848</td>
<td>Backspace</td>
<td>(Backspace)</td>
</tr>
<tr>
<td>32849</td>
<td>Delete</td>
<td>(Del)</td>
</tr>
<tr>
<td>32850</td>
<td>Delete Word</td>
<td>(Del Word)</td>
</tr>
<tr>
<td>32851</td>
<td>Word Right</td>
<td>(Word Right)</td>
</tr>
<tr>
<td>32852</td>
<td>Word Left</td>
<td>(Word Left)</td>
</tr>
<tr>
<td>32853</td>
<td>End of Line</td>
<td>(End)</td>
</tr>
<tr>
<td>32854</td>
<td>Beginning of Line³</td>
<td>(Invalid)</td>
</tr>
<tr>
<td>32855</td>
<td>Go To</td>
<td>(Goto)</td>
</tr>
<tr>
<td>32856</td>
<td>Page Up</td>
<td>(Page Up)</td>
</tr>
<tr>
<td>32858</td>
<td>Page Down</td>
<td>(Page Down)</td>
</tr>
<tr>
<td>32859</td>
<td>Screen Down</td>
<td>(Screen Down)</td>
</tr>
<tr>
<td>32860</td>
<td>Screen Up</td>
<td>(Screen Up)</td>
</tr>
<tr>
<td>32861</td>
<td>Typeover</td>
<td>(Typeover)</td>
</tr>
<tr>
<td>32862</td>
<td>Margin Release</td>
<td>(Left Mar Rel)</td>
</tr>
<tr>
<td>32863</td>
<td>Hard Page</td>
<td>(HPg)</td>
</tr>
<tr>
<td>32864</td>
<td>Soft Hyphen</td>
<td>(SHy)</td>
</tr>
<tr>
<td>32865</td>
<td>Hyphen Character</td>
<td>(-)</td>
</tr>
<tr>
<td>32866</td>
<td>Hard Space</td>
<td>{ }</td>
</tr>
<tr>
<td>32867</td>
<td>Paragraph Up</td>
<td>(Para Up)</td>
</tr>
<tr>
<td>32868</td>
<td>Paragraph Down</td>
<td>(Para Down)</td>
</tr>
<tr>
<td>32869</td>
<td>Item Left</td>
<td>(Item Left)</td>
</tr>
<tr>
<td>32870</td>
<td>Item Right</td>
<td>(Item Right)</td>
</tr>
<tr>
<td>32871</td>
<td>Item Up</td>
<td>(Item Up)</td>
</tr>
<tr>
<td>32872</td>
<td>Item Down</td>
<td>(Item Down)</td>
</tr>
</tbody>
</table>

---

676  Appendix L: Macros and Merge, Value Tables
<table>
<thead>
<tr>
<th>Value</th>
<th>Key Name</th>
<th>Macro Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>32874</td>
<td>Delete Row</td>
<td>{Block Move}</td>
</tr>
<tr>
<td>32875</td>
<td>Menu Bar</td>
<td>{Menu Bar}</td>
</tr>
<tr>
<td>32876</td>
<td>Block Append</td>
<td>{Block Append}</td>
</tr>
<tr>
<td>32877</td>
<td>Block Move</td>
<td>{Block Move}</td>
</tr>
<tr>
<td>32878</td>
<td>Block Copy</td>
<td>{Block Copy}</td>
</tr>
<tr>
<td>64513</td>
<td>{ASSIGN}</td>
<td></td>
</tr>
<tr>
<td>64514</td>
<td>{BELL}</td>
<td></td>
</tr>
<tr>
<td>64515</td>
<td>{BREAK}</td>
<td></td>
</tr>
<tr>
<td>64516</td>
<td>{CALL}</td>
<td></td>
</tr>
<tr>
<td>64517</td>
<td>{CANCEL OFF}</td>
<td></td>
</tr>
<tr>
<td>64518</td>
<td>{CANCEL ON}</td>
<td></td>
</tr>
<tr>
<td>64519</td>
<td>{CASE}</td>
<td></td>
</tr>
<tr>
<td>64520</td>
<td>{CASE CALL}</td>
<td></td>
</tr>
<tr>
<td>64521</td>
<td>{CHAIN}</td>
<td></td>
</tr>
<tr>
<td>64522</td>
<td>{CHAR}</td>
<td></td>
</tr>
<tr>
<td>64523</td>
<td>(;)</td>
<td></td>
</tr>
<tr>
<td>64524</td>
<td>{DISPLAY OFF}</td>
<td></td>
</tr>
<tr>
<td>64525</td>
<td>{DISPLAY ON}</td>
<td></td>
</tr>
<tr>
<td>64526</td>
<td>{ELSE}</td>
<td></td>
</tr>
<tr>
<td>64527</td>
<td>{END FOR}</td>
<td></td>
</tr>
<tr>
<td>64528</td>
<td>{END IF}</td>
<td></td>
</tr>
<tr>
<td>64529</td>
<td>{END WHILE}</td>
<td></td>
</tr>
<tr>
<td>64530</td>
<td>{FOR}</td>
<td></td>
</tr>
<tr>
<td>64531</td>
<td>{FOR EACH}</td>
<td></td>
</tr>
<tr>
<td>64532</td>
<td>{GO}</td>
<td></td>
</tr>
<tr>
<td>64533</td>
<td>{IF}</td>
<td></td>
</tr>
<tr>
<td>64534</td>
<td>{LABEL}</td>
<td></td>
</tr>
<tr>
<td>64535</td>
<td>{LOOK}</td>
<td></td>
</tr>
<tr>
<td>64536</td>
<td>{NEST}</td>
<td></td>
</tr>
<tr>
<td>64537</td>
<td>{NEXT}</td>
<td></td>
</tr>
<tr>
<td>64538</td>
<td>{SHELL MACRO}</td>
<td></td>
</tr>
<tr>
<td>64539</td>
<td>{ON CANCEL}</td>
<td></td>
</tr>
<tr>
<td>64540</td>
<td>{ON ERROR}</td>
<td></td>
</tr>
<tr>
<td>64541</td>
<td>{ON NOT FOUND}</td>
<td></td>
</tr>
<tr>
<td>64542</td>
<td>{PAUSE}</td>
<td></td>
</tr>
<tr>
<td>64543</td>
<td>{PROMPT}</td>
<td></td>
</tr>
<tr>
<td>64544</td>
<td>{QUIT}</td>
<td></td>
</tr>
<tr>
<td>64545</td>
<td>{RESTART}</td>
<td></td>
</tr>
<tr>
<td>64546</td>
<td>{RETURN}</td>
<td></td>
</tr>
<tr>
<td>64547</td>
<td>{RETURN CANCEL}</td>
<td></td>
</tr>
<tr>
<td>64548</td>
<td>{RETURN ERROR}</td>
<td></td>
</tr>
<tr>
<td>64549</td>
<td>{RETURN NOT FOUND}</td>
<td></td>
</tr>
<tr>
<td>64550</td>
<td>{SPEED}</td>
<td></td>
</tr>
<tr>
<td>64551</td>
<td>{STEP ON}</td>
<td></td>
</tr>
<tr>
<td>64552</td>
<td>{TEXT}</td>
<td></td>
</tr>
<tr>
<td>64553</td>
<td>{STATE}</td>
<td></td>
</tr>
<tr>
<td>64554</td>
<td>{WAIT}</td>
<td></td>
</tr>
<tr>
<td>64555</td>
<td>{WHILE}</td>
<td></td>
</tr>
<tr>
<td>64556</td>
<td>Macro Commands</td>
<td>{Macro Commands}</td>
</tr>
<tr>
<td>64557</td>
<td>{STEP OFF}</td>
<td></td>
</tr>
<tr>
<td>64558</td>
<td>{ORIGINAL KEY}</td>
<td></td>
</tr>
<tr>
<td>64559</td>
<td>{IF EXISTS}</td>
<td></td>
</tr>
<tr>
<td>64560</td>
<td>{MENU OFF}</td>
<td></td>
</tr>
<tr>
<td>64561</td>
<td>{MENU ON}</td>
<td></td>
</tr>
</tbody>
</table>
To insert this command in a macro, you must define a macro containing \{NTOK\}x', where x is the value listed on the table. Then map this macro to a key using Keyboard Layout (see Keyboard Layout). With the keyboard containing the mapping selected, enter the Macro Editor. Press the key to which the macro is mapped to insert the command.

Pressing **End Field** inserts [Mrg:End Field][HRt] into the document.

Although it is impossible to take the \{KTON\} of multiple keys, you can produce (execute) this keystroke sequence by taking the \{NTOK\} of its key value.

The following table shows the values returned by the \{SYSTEM\}Right' and \{SYSTEM\}Left' commands when the item to the right or left of the cursor is a Corel WordPerfect code. In most cases, a five-digit number is returned. For some codes, however, the keystroke corresponding to the code is returned instead of a number. These codes are listed at the end of the table.

For some codes, the value returned differs depending on whether it was returned by the \{SYSTEM\}Right' or \{SYSTEM\}Left' command. These values are marked with (R) and (L), respectively, in the table below.

For more information on using these commands, see Appendix K: Macros and Merge, Programming Commands.

<table>
<thead>
<tr>
<th>Value</th>
<th>Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>33024</td>
<td>Just On</td>
</tr>
<tr>
<td>33280</td>
<td>Just Off</td>
</tr>
<tr>
<td>34304</td>
<td>Center Pg</td>
</tr>
<tr>
<td>34560</td>
<td>Col On</td>
</tr>
<tr>
<td>35328</td>
<td>W/O On</td>
</tr>
<tr>
<td>35584</td>
<td>W/O Off</td>
</tr>
<tr>
<td>35840</td>
<td>HRt-SPg</td>
</tr>
<tr>
<td>36096</td>
<td>Note Num</td>
</tr>
<tr>
<td>36352</td>
<td>Box Num</td>
</tr>
<tr>
<td>36864</td>
<td>DSRt</td>
</tr>
<tr>
<td>37376</td>
<td>[SPg] (not a space or [HRt])</td>
</tr>
<tr>
<td>37632</td>
<td>ISRt</td>
</tr>
<tr>
<td>Value</td>
<td>Code</td>
</tr>
<tr>
<td>-----------</td>
<td>------------------</td>
</tr>
<tr>
<td>38656 (R), 38400 (L)</td>
<td>[Block]</td>
</tr>
<tr>
<td>39168</td>
<td>[Dorm HRt]</td>
</tr>
<tr>
<td>39424</td>
<td>[/] (Cancel Hyphenation)</td>
</tr>
<tr>
<td>39680</td>
<td>[End Def]</td>
</tr>
<tr>
<td>40448</td>
<td>[Hyph Off]</td>
</tr>
<tr>
<td>40704</td>
<td>[Hyph On]</td>
</tr>
<tr>
<td>40960</td>
<td>[ ] (Hard Space)</td>
</tr>
<tr>
<td>41216</td>
<td>[+ ]</td>
</tr>
<tr>
<td>41472</td>
<td>[t ]</td>
</tr>
<tr>
<td>41728</td>
<td>[= ]</td>
</tr>
<tr>
<td>41984</td>
<td>[T ]</td>
</tr>
<tr>
<td>42240</td>
<td>[+]</td>
</tr>
<tr>
<td>42496</td>
<td>[!]</td>
</tr>
<tr>
<td>42752</td>
<td>[Math On]</td>
</tr>
<tr>
<td>43008</td>
<td>[Math Off]</td>
</tr>
<tr>
<td>43264</td>
<td>[- ] (Hyphen Character)</td>
</tr>
<tr>
<td>44032</td>
<td>[- ] (Soft Hyphen)</td>
</tr>
<tr>
<td>44800</td>
<td>[Col Off]</td>
</tr>
<tr>
<td>45312</td>
<td>[N]</td>
</tr>
<tr>
<td>45568</td>
<td>[Outline Off]</td>
</tr>
<tr>
<td>49408</td>
<td>[TAB]</td>
</tr>
<tr>
<td>49410</td>
<td>[Tab]</td>
</tr>
<tr>
<td>49424</td>
<td>[TAB] (with dot leader)</td>
</tr>
<tr>
<td>49426</td>
<td>[Tab] (with dot leader)</td>
</tr>
<tr>
<td>49474</td>
<td>[Dec Tab]</td>
</tr>
<tr>
<td>49480</td>
<td>[RGT TAB]</td>
</tr>
<tr>
<td>49482</td>
<td>[Rgt Tab]</td>
</tr>
<tr>
<td>49490</td>
<td>[Dec Tab] (with dot leader)</td>
</tr>
<tr>
<td>49496</td>
<td>[RGT TAB] (with dot leader)</td>
</tr>
<tr>
<td>49498</td>
<td>[Rgt Tab] (with dot leader)</td>
</tr>
<tr>
<td>49504</td>
<td>[Flsh Rgt]</td>
</tr>
<tr>
<td>49520</td>
<td>[Flsh Rgt] (with dot leader)</td>
</tr>
<tr>
<td>49536</td>
<td>[Mar Rel]</td>
</tr>
<tr>
<td>49608</td>
<td>[CNTR TAB]</td>
</tr>
<tr>
<td>49610</td>
<td>[Cntr Tab]</td>
</tr>
<tr>
<td>49624</td>
<td>[CNTR TAB] (with dot leader)</td>
</tr>
<tr>
<td>49626</td>
<td>[Cntr Tab] (with dot leader)</td>
</tr>
<tr>
<td>49632</td>
<td>[Center]</td>
</tr>
<tr>
<td>49648</td>
<td>[Center] (with dot leader)</td>
</tr>
<tr>
<td>Value</td>
<td>Code</td>
</tr>
<tr>
<td>-------</td>
<td>---------------</td>
</tr>
<tr>
<td>49664</td>
<td>[-Indent]</td>
</tr>
<tr>
<td>49665</td>
<td>[-Indent-]</td>
</tr>
<tr>
<td>49920</td>
<td>[EXT LARGE]</td>
</tr>
<tr>
<td>49921</td>
<td>[VRY LARGE]</td>
</tr>
<tr>
<td>49922</td>
<td>[LARGE]</td>
</tr>
<tr>
<td>49923</td>
<td>[SMALL]</td>
</tr>
<tr>
<td>49924</td>
<td>[FINE]</td>
</tr>
<tr>
<td>49925</td>
<td>[SUPRSCPT]</td>
</tr>
<tr>
<td>49926</td>
<td>[SUBSCPT]</td>
</tr>
<tr>
<td>49927</td>
<td>[OUTLN]</td>
</tr>
<tr>
<td>49928</td>
<td>[ITALC]</td>
</tr>
<tr>
<td>49929</td>
<td>[SHADW]</td>
</tr>
<tr>
<td>49930</td>
<td>[REDLN]</td>
</tr>
<tr>
<td>49931</td>
<td>[DBL UND]</td>
</tr>
<tr>
<td>49932</td>
<td>[BOLD]</td>
</tr>
<tr>
<td>49933</td>
<td>[STKOUT]</td>
</tr>
<tr>
<td>49934</td>
<td>[UND]</td>
</tr>
<tr>
<td>49935</td>
<td>[SM CAP]</td>
</tr>
<tr>
<td>50176</td>
<td>[ext large]</td>
</tr>
<tr>
<td>50177</td>
<td>[vry large]</td>
</tr>
<tr>
<td>50178</td>
<td>[large]</td>
</tr>
<tr>
<td>50179</td>
<td>[small]</td>
</tr>
<tr>
<td>50180</td>
<td>[fine]</td>
</tr>
<tr>
<td>50181</td>
<td>[suprscpt]</td>
</tr>
<tr>
<td>50182</td>
<td>[subscpt]</td>
</tr>
<tr>
<td>50183</td>
<td>[outln]</td>
</tr>
<tr>
<td>50184</td>
<td>[italc]</td>
</tr>
<tr>
<td>50185</td>
<td>[shadw]</td>
</tr>
<tr>
<td>50186</td>
<td>[redln]</td>
</tr>
<tr>
<td>50187</td>
<td>[dbl und]</td>
</tr>
<tr>
<td>50188</td>
<td>[bold]</td>
</tr>
<tr>
<td>50189</td>
<td>[stkout]</td>
</tr>
<tr>
<td>50190</td>
<td>[und]</td>
</tr>
<tr>
<td>50191</td>
<td>[sm cap]</td>
</tr>
<tr>
<td>50432</td>
<td>[Block Pro:On]</td>
</tr>
<tr>
<td>50433</td>
<td>[Block Pro:Off]</td>
</tr>
<tr>
<td>53248</td>
<td>[Ln Height]</td>
</tr>
<tr>
<td>53249</td>
<td>[L/R Mar]</td>
</tr>
<tr>
<td>53250</td>
<td>[Ln Spacing]</td>
</tr>
<tr>
<td>53251</td>
<td>[HZone]</td>
</tr>
<tr>
<td>Value</td>
<td>Code</td>
</tr>
<tr>
<td>-------</td>
<td>-----------------------</td>
</tr>
<tr>
<td>53252</td>
<td>[Tab Set]</td>
</tr>
<tr>
<td>53253</td>
<td>[T/B Mar]</td>
</tr>
<tr>
<td>53254</td>
<td>[Just]</td>
</tr>
<tr>
<td>53255</td>
<td>[Suppress]</td>
</tr>
<tr>
<td>53256</td>
<td>[Pg Numbering]</td>
</tr>
<tr>
<td>53259</td>
<td>[Paper Sz/Typ]</td>
</tr>
<tr>
<td>53504</td>
<td>[Color]</td>
</tr>
<tr>
<td>53505</td>
<td>[Font]</td>
</tr>
<tr>
<td>53760</td>
<td>[Math Def]</td>
</tr>
<tr>
<td>53761</td>
<td>[Col Def]</td>
</tr>
<tr>
<td>53762</td>
<td>[Par Num Def]</td>
</tr>
<tr>
<td>53763</td>
<td>[Ftn Opt]</td>
</tr>
<tr>
<td>53764</td>
<td>[End Opt]</td>
</tr>
<tr>
<td>53765</td>
<td>[Fig Opt]</td>
</tr>
<tr>
<td>53767</td>
<td>[Txt Opt]</td>
</tr>
<tr>
<td>53768</td>
<td>[Usr Opt]</td>
</tr>
<tr>
<td>53769</td>
<td>[Equ Opt]</td>
</tr>
<tr>
<td>53771</td>
<td>[Tbl Def]</td>
</tr>
<tr>
<td>53773</td>
<td>[Link]</td>
</tr>
<tr>
<td>53774</td>
<td>[Link End]</td>
</tr>
<tr>
<td>53776</td>
<td>[Tbl Opt]</td>
</tr>
<tr>
<td>53777</td>
<td>[Brdr Opt]</td>
</tr>
<tr>
<td>54016</td>
<td>[Decml/Algn Char]</td>
</tr>
<tr>
<td>54017</td>
<td>[Undrln]</td>
</tr>
<tr>
<td>54018</td>
<td>[New Ftn Num]</td>
</tr>
<tr>
<td>54019</td>
<td>[New End Num]</td>
</tr>
<tr>
<td>54020</td>
<td>[Pg Num]</td>
</tr>
<tr>
<td>54021</td>
<td>[Ln Num]</td>
</tr>
<tr>
<td>54022</td>
<td>[Adv]</td>
</tr>
<tr>
<td>54023</td>
<td>[Force]</td>
</tr>
<tr>
<td>54024</td>
<td>[BLine]</td>
</tr>
<tr>
<td>54026</td>
<td>[Wrd/Ltr Spacing]</td>
</tr>
<tr>
<td>54027</td>
<td>[Just Lim]</td>
</tr>
<tr>
<td>54028</td>
<td>[New Fig Num]</td>
</tr>
<tr>
<td>54029</td>
<td>[New Tbl Num]</td>
</tr>
<tr>
<td>54030</td>
<td>[New Txt Num]</td>
</tr>
<tr>
<td>54031</td>
<td>[New Usr Num]</td>
</tr>
<tr>
<td>54032</td>
<td>[New Equ Num]</td>
</tr>
<tr>
<td>54033</td>
<td>[Lang]</td>
</tr>
<tr>
<td>54034</td>
<td>[Pg Num Style]</td>
</tr>
<tr>
<td>Value</td>
<td>Code</td>
</tr>
<tr>
<td>-------</td>
<td>-----------------------</td>
</tr>
<tr>
<td>54528</td>
<td>[Header A]</td>
</tr>
<tr>
<td>54529</td>
<td>[Header B]</td>
</tr>
<tr>
<td>54530</td>
<td>[Footer A]</td>
</tr>
<tr>
<td>54531</td>
<td>[Footer B]</td>
</tr>
<tr>
<td>54784</td>
<td>[Footnote]</td>
</tr>
<tr>
<td>54785</td>
<td>[Endnote]</td>
</tr>
<tr>
<td>55040</td>
<td>[Mark]</td>
</tr>
<tr>
<td>55041</td>
<td>[End Mark]</td>
</tr>
<tr>
<td>55042</td>
<td>[Def Mark]</td>
</tr>
<tr>
<td>55043</td>
<td>[Index]</td>
</tr>
<tr>
<td>55044</td>
<td>[ToA]</td>
</tr>
<tr>
<td>55045</td>
<td>[Endnote Placement]</td>
</tr>
<tr>
<td>55047</td>
<td>[Ref]</td>
</tr>
<tr>
<td>55048</td>
<td>[Target]</td>
</tr>
<tr>
<td>55049</td>
<td>[Subdoc]</td>
</tr>
<tr>
<td>55050</td>
<td>[Subdoc Start]</td>
</tr>
<tr>
<td>55051</td>
<td>[Subdoc End]</td>
</tr>
<tr>
<td>55296</td>
<td>[Date]</td>
</tr>
<tr>
<td>55297</td>
<td>[Par Num]</td>
</tr>
<tr>
<td>55298</td>
<td>[Ovrstk]</td>
</tr>
<tr>
<td>55299</td>
<td>[Insert Pg Num]</td>
</tr>
<tr>
<td>55552</td>
<td>[Ptr Cmd]</td>
</tr>
<tr>
<td>55553</td>
<td>[Cndl EOP]</td>
</tr>
<tr>
<td>55554</td>
<td>[Comment]</td>
</tr>
<tr>
<td>55555</td>
<td>[Kern]</td>
</tr>
<tr>
<td>55556</td>
<td>[Outline On]</td>
</tr>
<tr>
<td>55557</td>
<td>[Leading Adj]</td>
</tr>
<tr>
<td>55808</td>
<td>[Fig Box]</td>
</tr>
<tr>
<td>55809</td>
<td>[Tbl Box]</td>
</tr>
<tr>
<td>55810</td>
<td>[Text Box]</td>
</tr>
<tr>
<td>55811</td>
<td>[Usr Box]</td>
</tr>
<tr>
<td>55812</td>
<td>[Equ Box]</td>
</tr>
<tr>
<td>55813</td>
<td>[HLine]</td>
</tr>
<tr>
<td>55814</td>
<td>[VLine]</td>
</tr>
<tr>
<td>56064</td>
<td>[Style:On] or [Outline Lvl # Style On]</td>
</tr>
<tr>
<td>56067</td>
<td>(R)</td>
</tr>
<tr>
<td>56067</td>
<td>(L)</td>
</tr>
<tr>
<td>56065</td>
<td>[Style:Off] or [Outline Lvl # Style Off]</td>
</tr>
<tr>
<td>56067</td>
<td>(R)</td>
</tr>
<tr>
<td>56067</td>
<td>(L)</td>
</tr>
<tr>
<td>56066</td>
<td>[Open Style] or [Outline Lvl # Open Style]</td>
</tr>
<tr>
<td>56067</td>
<td>(R)</td>
</tr>
<tr>
<td>56067</td>
<td>(L)</td>
</tr>
<tr>
<td>56320</td>
<td>[Cell]</td>
</tr>
</tbody>
</table>

682 Appendix L: Macros and Merge, Value Tables
<table>
<thead>
<tr>
<th>Value</th>
<th>Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>56321</td>
<td>[Row]</td>
</tr>
<tr>
<td>56322</td>
<td>[Tbl Off]</td>
</tr>
<tr>
<td>56579</td>
<td>[Hrd Row]</td>
</tr>
<tr>
<td>56864</td>
<td>[Mrg:ASSIGN]</td>
</tr>
<tr>
<td>56865</td>
<td>[Mrg:BELL]</td>
</tr>
<tr>
<td>56866</td>
<td>[Mrg:BREAK]</td>
</tr>
<tr>
<td>56867</td>
<td>[Mrg:CALL]</td>
</tr>
<tr>
<td>56868</td>
<td>[Mrg:CANCEL OFF]</td>
</tr>
<tr>
<td>56869</td>
<td>[Mrg:CANCEL ON]</td>
</tr>
<tr>
<td>56870</td>
<td>[Mrg:CASE]</td>
</tr>
<tr>
<td>56871</td>
<td>[Mrg:CASE CALL]</td>
</tr>
<tr>
<td>56872</td>
<td>[Mrg:CHAIN MACRO]</td>
</tr>
<tr>
<td>56873</td>
<td>[Mrg:CHAIN PRIMARY]</td>
</tr>
<tr>
<td>56874</td>
<td>[Mrg:CHAIN SECONDARY]</td>
</tr>
<tr>
<td>56875</td>
<td>[Mrg:CHAR]</td>
</tr>
<tr>
<td>56876</td>
<td>[Mrg:COMMENT]</td>
</tr>
<tr>
<td>56877</td>
<td>[Mrg:CTON]</td>
</tr>
<tr>
<td>56878</td>
<td>[Mrg:DATE]</td>
</tr>
<tr>
<td>56879</td>
<td>[Mrg:DOCUMENT]</td>
</tr>
<tr>
<td>56880</td>
<td>[Mrg:ELSE]</td>
</tr>
<tr>
<td>56881</td>
<td>[Mrg:END FIELD]</td>
</tr>
<tr>
<td>56882</td>
<td>[Mrg:END FOR]</td>
</tr>
<tr>
<td>56883</td>
<td>[Mrg:END IF]</td>
</tr>
<tr>
<td>56884</td>
<td>[Mrg:END RECORD]</td>
</tr>
<tr>
<td>56885</td>
<td>[Mrg:END WHILE]</td>
</tr>
<tr>
<td>56886</td>
<td>[Mrg:FIELD]</td>
</tr>
<tr>
<td>56887</td>
<td>[Mrg:FOR]</td>
</tr>
<tr>
<td>56888</td>
<td>[Mrg:GO]</td>
</tr>
<tr>
<td>56889</td>
<td>[Mrg:IF]</td>
</tr>
<tr>
<td>56890</td>
<td>[Mrg:IF BLANK]</td>
</tr>
<tr>
<td>56891</td>
<td>[Mrg:IF EXISTS]</td>
</tr>
<tr>
<td>56892</td>
<td>[Mrg:IF NOT BLANK]</td>
</tr>
<tr>
<td>56893</td>
<td>[Mrg:KEYBOARD]</td>
</tr>
<tr>
<td>56894</td>
<td>[Mrg:LABEL]</td>
</tr>
<tr>
<td>56895</td>
<td>[Mrg:LOCAL]</td>
</tr>
<tr>
<td>56896</td>
<td>[Mrg:LOOK]</td>
</tr>
<tr>
<td>56897</td>
<td>[Mrg:MID]</td>
</tr>
<tr>
<td>56898</td>
<td>[Mrg:MRG CMND]</td>
</tr>
<tr>
<td>56899</td>
<td>[Mrg:NEST MACRO]</td>
</tr>
<tr>
<td>56900</td>
<td>[Mrg:NEST PRIMARY]</td>
</tr>
<tr>
<td>Value</td>
<td>Code</td>
</tr>
<tr>
<td>--------</td>
<td>----------------------------------</td>
</tr>
<tr>
<td>56902</td>
<td>[Mrg:NEST SECONDARY]</td>
</tr>
<tr>
<td>56903</td>
<td>[Mrg:NEXT]</td>
</tr>
<tr>
<td>56904</td>
<td>[Mrg:NEXT RECORD]</td>
</tr>
<tr>
<td>56905</td>
<td>[Mrg:NTOC]</td>
</tr>
<tr>
<td>56906</td>
<td>[Mrg:PROCESS]</td>
</tr>
<tr>
<td>56907</td>
<td>[Mrg:ON CANCEL.]</td>
</tr>
<tr>
<td>56908</td>
<td>[Mrg:ON ERROR]</td>
</tr>
<tr>
<td>56909</td>
<td>[Mrg:PAGE OFF]</td>
</tr>
<tr>
<td>56910</td>
<td>[Mrg:PAGE ON]</td>
</tr>
<tr>
<td>56911</td>
<td>[Mrg:PRINT]</td>
</tr>
<tr>
<td>56912</td>
<td>[Mrg:PROMPT]</td>
</tr>
<tr>
<td>56913</td>
<td>[Mrg:QUIT]</td>
</tr>
<tr>
<td>56914</td>
<td>[Mrg:RETURN]</td>
</tr>
<tr>
<td>56915</td>
<td>[Mrg:RETURN CANCEL]</td>
</tr>
<tr>
<td>56916</td>
<td>[Mrg:RETURN ERROR]</td>
</tr>
<tr>
<td>56917</td>
<td>[Mrg:REWRITE]</td>
</tr>
<tr>
<td>56918</td>
<td>[Mrg:STEP OFF]</td>
</tr>
<tr>
<td>56919</td>
<td>[Mrg:STEP ON]</td>
</tr>
<tr>
<td>56920</td>
<td>[Mrg:SUBST PRIMARY]</td>
</tr>
<tr>
<td>56921</td>
<td>[Mrg:SUBST SECONDARY]</td>
</tr>
<tr>
<td>56922</td>
<td>[Mrg:SYSTEM]</td>
</tr>
<tr>
<td>56923</td>
<td>[Mrg:TEXT]</td>
</tr>
<tr>
<td>56924</td>
<td>[Mrg:VARIABLE]</td>
</tr>
<tr>
<td>56925</td>
<td>[Mrg:WAIT]</td>
</tr>
<tr>
<td>56926</td>
<td>[Mrg:WHILE]</td>
</tr>
<tr>
<td>56927</td>
<td>[Mrg:STATUS PROMPT]</td>
</tr>
<tr>
<td>56928</td>
<td>[Mrg:INPUT]</td>
</tr>
<tr>
<td>56929</td>
<td>[Mrg:LEN]</td>
</tr>
<tr>
<td>56930</td>
<td>[Mrg:FIELD NAME]</td>
</tr>
<tr>
<td>56931</td>
<td>[Mrg:STOP]</td>
</tr>
<tr>
<td>{^A}</td>
<td>^A</td>
</tr>
<tr>
<td>{^B}</td>
<td>^B</td>
</tr>
<tr>
<td>{^C}</td>
<td>^C</td>
</tr>
<tr>
<td>{^D}</td>
<td>^D</td>
</tr>
<tr>
<td>{^E}</td>
<td>^E</td>
</tr>
<tr>
<td>{^F}</td>
<td>^F</td>
</tr>
<tr>
<td>{^G}</td>
<td>^G</td>
</tr>
<tr>
<td>{Home}</td>
<td>^H</td>
</tr>
<tr>
<td>{Enter}</td>
<td>[HRt]</td>
</tr>
<tr>
<td>{^N}</td>
<td>^N</td>
</tr>
</tbody>
</table>
The tables below list the values returned by the \{SYSTEM\}Menu˜ command. The first table lists the values by menu, the second by number. The Keystrokes column of both tables lists the keystrokes required to produce the menu. Bracketed keystrokes indicate that any one of the given keys may be pressed at that point in the keystroke series to produce the menu. Other conditions required to produce the menu appear in the Conditions column. Block is assumed to be off unless otherwise specified.

For more information on using the \{SYSTEM\}Menu˜ command, see Appendix K: Macros and Merge, Programming Commands.

By Menu
This table lists the menus by general menu name and then by the keystrokes required to produce the menu. Use this table when you know the menu but not the value that will be returned at that menu.

<table>
<thead>
<tr>
<th>Value</th>
<th>Keystrokes</th>
<th>Conditions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cancel Menu</td>
<td>49</td>
<td>Cancel</td>
</tr>
<tr>
<td>Setup Menu</td>
<td>177</td>
<td>Setup</td>
</tr>
<tr>
<td></td>
<td>221</td>
<td>Setup, 1</td>
</tr>
<tr>
<td></td>
<td>221</td>
<td>Setup, 1, 1</td>
</tr>
<tr>
<td></td>
<td>221</td>
<td>Setup, 1, 2</td>
</tr>
<tr>
<td></td>
<td>410</td>
<td>Setup, 1, 3</td>
</tr>
</tbody>
</table>

The tables below list the values returned by the \{SYSTEM\}Menu˜ command. The first table lists the values by menu, the second by number. The Keystrokes column of both tables lists the keystrokes required to produce the menu. Bracketed keystrokes indicate that any one of the given keys may be pressed at that point in the keystroke series to produce the menu. Other conditions required to produce the menu appear in the Conditions column. Block is assumed to be off unless otherwise specified.

For more information on using the \{SYSTEM\}Menu˜ command, see Appendix K: Macros and Merge, Programming Commands.

By Menu
This table lists the menus by general menu name and then by the keystrokes required to produce the menu. Use this table when you know the menu but not the value that will be returned at that menu.

<table>
<thead>
<tr>
<th>Value</th>
<th>Keystrokes</th>
<th>Conditions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cancel Menu</td>
<td>49</td>
<td>Cancel</td>
</tr>
<tr>
<td>Setup Menu</td>
<td>177</td>
<td>Setup</td>
</tr>
<tr>
<td></td>
<td>221</td>
<td>Setup, 1</td>
</tr>
<tr>
<td></td>
<td>221</td>
<td>Setup, 1, 1</td>
</tr>
<tr>
<td></td>
<td>221</td>
<td>Setup, 1, 2</td>
</tr>
<tr>
<td></td>
<td>410</td>
<td>Setup, 1, 3</td>
</tr>
<tr>
<td>Value</td>
<td>Keystrokes</td>
<td>Conditions</td>
</tr>
<tr>
<td>-------</td>
<td>----------------------------</td>
<td>---------------------</td>
</tr>
<tr>
<td>341</td>
<td>Setup,1,4</td>
<td></td>
</tr>
<tr>
<td>341</td>
<td>Setup,1,4,[1,2,3,5,6],[1,2]</td>
<td></td>
</tr>
<tr>
<td>342</td>
<td>Setup,1,5</td>
<td></td>
</tr>
<tr>
<td>343</td>
<td>Setup,1,6</td>
<td></td>
</tr>
<tr>
<td>347</td>
<td>Setup,2</td>
<td></td>
</tr>
<tr>
<td>68</td>
<td>Setup,2,1</td>
<td></td>
</tr>
<tr>
<td>44</td>
<td>Setup,2,2</td>
<td></td>
</tr>
<tr>
<td>348</td>
<td>Setup,2,3</td>
<td></td>
</tr>
<tr>
<td>349</td>
<td>Setup,2,5</td>
<td></td>
</tr>
<tr>
<td>101</td>
<td>Setup,2,6</td>
<td></td>
</tr>
<tr>
<td>55</td>
<td>Setup,2,7</td>
<td></td>
</tr>
<tr>
<td>413</td>
<td>Setup,2,9</td>
<td></td>
</tr>
<tr>
<td>45</td>
<td>Setup,3</td>
<td></td>
</tr>
<tr>
<td>344</td>
<td>Setup,3,1</td>
<td></td>
</tr>
<tr>
<td>45</td>
<td>Setup,3,2</td>
<td></td>
</tr>
<tr>
<td>345</td>
<td>Setup,3,3</td>
<td></td>
</tr>
<tr>
<td>400</td>
<td>Setup,3,3,2</td>
<td></td>
</tr>
<tr>
<td>400</td>
<td>Setup,3,3,2,2</td>
<td></td>
</tr>
<tr>
<td>379</td>
<td>Setup,3,3,3</td>
<td></td>
</tr>
<tr>
<td>380</td>
<td>Setup,3,3,4</td>
<td></td>
</tr>
<tr>
<td>220</td>
<td>Setup,3,7</td>
<td></td>
</tr>
<tr>
<td>105</td>
<td>Setup,3,8</td>
<td></td>
</tr>
<tr>
<td>252</td>
<td>Setup,3,8,2,Return</td>
<td></td>
</tr>
<tr>
<td>202</td>
<td>Setup,3,8,3</td>
<td></td>
</tr>
<tr>
<td>199</td>
<td>Setup,3,8,4</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>Setup,3,8,5</td>
<td></td>
</tr>
<tr>
<td>409</td>
<td>Setup,3,8,6</td>
<td></td>
</tr>
<tr>
<td>69</td>
<td>Setup,3,8,7</td>
<td></td>
</tr>
<tr>
<td>208</td>
<td>Setup,4</td>
<td></td>
</tr>
<tr>
<td>209</td>
<td>Setup,4</td>
<td></td>
</tr>
<tr>
<td>235</td>
<td>Setup,4,7</td>
<td></td>
</tr>
<tr>
<td>303</td>
<td>Setup,4,8</td>
<td></td>
</tr>
<tr>
<td>235</td>
<td>Setup,4,8,2</td>
<td></td>
</tr>
<tr>
<td>56</td>
<td>Setup,5</td>
<td></td>
</tr>
</tbody>
</table>

**Thesaurus Menu**

<table>
<thead>
<tr>
<th>Value</th>
<th>Keystrokes</th>
<th>Conditions</th>
</tr>
</thead>
<tbody>
<tr>
<td>32824</td>
<td>Thesaurus</td>
<td>word not found</td>
</tr>
<tr>
<td>110</td>
<td>Thesaurus</td>
<td>word found</td>
</tr>
</tbody>
</table>

686  Appendix L: Macros and Merge, Value Tables
<table>
<thead>
<tr>
<th>Value</th>
<th>Keystrokes</th>
<th>Conditions</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Corel Shell Menu</td>
<td></td>
</tr>
<tr>
<td>103</td>
<td>Corel Shell</td>
<td>not under Corel Shell</td>
</tr>
<tr>
<td>102</td>
<td>Corel Shell</td>
<td>under Corel Shell</td>
</tr>
<tr>
<td></td>
<td>Search Menus</td>
<td></td>
</tr>
<tr>
<td>32801</td>
<td>⋆Search 1</td>
<td></td>
</tr>
<tr>
<td>32813</td>
<td>⋆Search 1</td>
<td></td>
</tr>
<tr>
<td>32776</td>
<td>Home, ⋆Search</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Replace Menu</td>
<td></td>
</tr>
<tr>
<td>32825</td>
<td>Replace</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Spell Menu</td>
<td></td>
</tr>
<tr>
<td>17</td>
<td>Speller</td>
<td></td>
</tr>
<tr>
<td>64</td>
<td>Speller,{1,2,3}</td>
<td>word not found</td>
</tr>
<tr>
<td></td>
<td>Help Menu</td>
<td></td>
</tr>
<tr>
<td>32802</td>
<td>Help</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Switch Menu</td>
<td></td>
</tr>
<tr>
<td>31</td>
<td>Switch</td>
<td>Block on</td>
</tr>
<tr>
<td></td>
<td>Screen</td>
<td></td>
</tr>
<tr>
<td>38</td>
<td>Screen</td>
<td></td>
</tr>
<tr>
<td>362</td>
<td>Screen,2</td>
<td></td>
</tr>
<tr>
<td>365</td>
<td>Screen,2,4</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Move</td>
<td></td>
</tr>
<tr>
<td>30</td>
<td>Move</td>
<td></td>
</tr>
<tr>
<td>23</td>
<td>Move</td>
<td>Block on</td>
</tr>
<tr>
<td>32</td>
<td>Move,{1,2,3}</td>
<td>Block on or off</td>
</tr>
<tr>
<td>112</td>
<td>Move,4</td>
<td></td>
</tr>
<tr>
<td></td>
<td>List Files</td>
<td></td>
</tr>
<tr>
<td>389</td>
<td>List Files</td>
<td></td>
</tr>
<tr>
<td>305</td>
<td>List Files,directory,Return</td>
<td></td>
</tr>
<tr>
<td>401</td>
<td>List Files,directory,Return,5</td>
<td></td>
</tr>
<tr>
<td>114</td>
<td>List Files,directory,Return,L</td>
<td>no document summary</td>
</tr>
<tr>
<td>334</td>
<td>List Files,directory,Return,L</td>
<td>document summary</td>
</tr>
<tr>
<td>335</td>
<td>List Files,directory,Return,L,3</td>
<td></td>
</tr>
<tr>
<td>232</td>
<td>List Files,directory,Return,9</td>
<td></td>
</tr>
<tr>
<td>241</td>
<td>List Files,directory,Return,9,5</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Date/Outline</td>
<td></td>
</tr>
<tr>
<td>24</td>
<td>Date/Outline</td>
<td></td>
</tr>
<tr>
<td>57</td>
<td>Date/Outline,3</td>
<td></td>
</tr>
<tr>
<td>350</td>
<td>Date/Outline,4</td>
<td></td>
</tr>
<tr>
<td>Value</td>
<td>Keystrokes</td>
<td>Conditions</td>
</tr>
<tr>
<td>-------</td>
<td>-----------------------</td>
<td>------------</td>
</tr>
<tr>
<td>79</td>
<td>Date/Outline,6</td>
<td></td>
</tr>
<tr>
<td>256</td>
<td>Date/Outline,6,9</td>
<td></td>
</tr>
<tr>
<td>263</td>
<td>Date/Outline,6,9,2</td>
<td></td>
</tr>
<tr>
<td>339</td>
<td>Date/Outline,6,9,2,3</td>
<td></td>
</tr>
<tr>
<td>201</td>
<td>Date/Outline,6,9,2,4</td>
<td></td>
</tr>
<tr>
<td>263</td>
<td>Date/Outline,6,9,3</td>
<td></td>
</tr>
<tr>
<td>339</td>
<td>Date/Outline,6,9,3,3</td>
<td></td>
</tr>
<tr>
<td>201</td>
<td>Date/Outline,6,9,3,4</td>
<td></td>
</tr>
<tr>
<td>370</td>
<td>Date/Outline,6,9,4</td>
<td></td>
</tr>
<tr>
<td>390</td>
<td>Date/Outline,6,9,6</td>
<td></td>
</tr>
</tbody>
</table>

**Mark Text**

<table>
<thead>
<tr>
<th>Value</th>
<th>Keystrokes</th>
<th>Conditions</th>
</tr>
</thead>
<tbody>
<tr>
<td>78</td>
<td>Mark Text</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Mark Text</td>
<td>Block on</td>
</tr>
<tr>
<td>159</td>
<td>Mark Text,1</td>
<td></td>
</tr>
<tr>
<td>154</td>
<td>Mark Text,1,[1,3]</td>
<td></td>
</tr>
<tr>
<td>244</td>
<td>Mark Text,1,[1,3],5</td>
<td></td>
</tr>
<tr>
<td>32806</td>
<td>Mark Text,4,Return</td>
<td>Block on</td>
</tr>
<tr>
<td>121</td>
<td>Mark Text,5</td>
<td></td>
</tr>
<tr>
<td>88</td>
<td>Mark Text,5,1</td>
<td></td>
</tr>
<tr>
<td>89</td>
<td>Mark Text,5,1,3</td>
<td></td>
</tr>
<tr>
<td>85</td>
<td>Mark Text,5,2,[1,3]</td>
<td></td>
</tr>
<tr>
<td>36</td>
<td>Mark Text,5,4,1</td>
<td></td>
</tr>
<tr>
<td>176</td>
<td>Mark Text,6</td>
<td></td>
</tr>
</tbody>
</table>

**Text In/Out**

<table>
<thead>
<tr>
<th>Value</th>
<th>Keystrokes</th>
<th>Conditions</th>
</tr>
</thead>
<tbody>
<tr>
<td>60</td>
<td>Text In/Out</td>
<td></td>
</tr>
<tr>
<td>32840</td>
<td>Text In/Out</td>
<td>Block on</td>
</tr>
<tr>
<td>70</td>
<td>Text In/Out,1</td>
<td></td>
</tr>
<tr>
<td>249</td>
<td>Text In/Out,2</td>
<td></td>
</tr>
<tr>
<td>388</td>
<td>Text In/Out,3</td>
<td></td>
</tr>
<tr>
<td>250</td>
<td>Text In/Out,4</td>
<td></td>
</tr>
<tr>
<td>259</td>
<td>Text In/Out,5</td>
<td></td>
</tr>
<tr>
<td>260</td>
<td>Text In/Out,5,[1,2,3]</td>
<td></td>
</tr>
<tr>
<td>390</td>
<td>Text In/Out,5,[1,2,3],1</td>
<td></td>
</tr>
<tr>
<td>261</td>
<td>Text In/Out,5,[1,2,3],3</td>
<td></td>
</tr>
<tr>
<td>314</td>
<td>Text In/Out,5,4</td>
<td></td>
</tr>
</tbody>
</table>

**Center**

<table>
<thead>
<tr>
<th>Value</th>
<th>Keystrokes</th>
<th>Conditions</th>
</tr>
</thead>
<tbody>
<tr>
<td>32817</td>
<td>Center</td>
<td>Block on</td>
</tr>
<tr>
<td>Value</td>
<td>Keystrokes</td>
<td>Conditions</td>
</tr>
<tr>
<td>---------------</td>
<td>---------------------</td>
<td>------------------------------------------------</td>
</tr>
<tr>
<td>Flush Right</td>
<td></td>
<td></td>
</tr>
<tr>
<td>32829</td>
<td>Flush Right</td>
<td>Block on</td>
</tr>
<tr>
<td>Exit</td>
<td></td>
<td></td>
</tr>
<tr>
<td>32806</td>
<td>Exit,y</td>
<td>Long Document Name=No</td>
</tr>
<tr>
<td>65027</td>
<td>Exit,y</td>
<td>Long Document Name=Yes</td>
</tr>
<tr>
<td>Print</td>
<td></td>
<td></td>
</tr>
<tr>
<td>74</td>
<td>Print</td>
<td>Block on</td>
</tr>
<tr>
<td>32818</td>
<td>Print</td>
<td>Block on</td>
</tr>
<tr>
<td>74</td>
<td>Print,[4,8]</td>
<td>Block on</td>
</tr>
<tr>
<td>153</td>
<td>Print;6</td>
<td>Block on</td>
</tr>
<tr>
<td>133</td>
<td>Print;s</td>
<td>Block on</td>
</tr>
<tr>
<td>76</td>
<td>Print;s,2</td>
<td>Block on</td>
</tr>
<tr>
<td>76</td>
<td>Print;s,2,3</td>
<td>Block on</td>
</tr>
<tr>
<td>47</td>
<td>Print;s,2,4</td>
<td>Block on</td>
</tr>
<tr>
<td>134</td>
<td>Print;s,3</td>
<td>Block on</td>
</tr>
<tr>
<td>46</td>
<td>Print;s,3,2</td>
<td>Block on</td>
</tr>
<tr>
<td>75</td>
<td>Print;s,3,3</td>
<td>Block on</td>
</tr>
<tr>
<td>42</td>
<td>Print;s,3,4</td>
<td>Block on</td>
</tr>
<tr>
<td>182</td>
<td>Print;s,3,4,1</td>
<td>cursor on Soft Fonts; soft fonts available</td>
</tr>
<tr>
<td>132</td>
<td>Print;s,3,5</td>
<td>Block on</td>
</tr>
<tr>
<td>412</td>
<td>Print,u</td>
<td>Block on</td>
</tr>
<tr>
<td>202</td>
<td>Print,g</td>
<td>Block on</td>
</tr>
<tr>
<td>69</td>
<td>Print;j</td>
<td>Block on</td>
</tr>
<tr>
<td>199</td>
<td>Print,t</td>
<td>Block on</td>
</tr>
<tr>
<td>Columns/Table</td>
<td></td>
<td></td>
</tr>
<tr>
<td>353</td>
<td>Columns/Tables</td>
<td>cursor not in a table</td>
</tr>
<tr>
<td>298</td>
<td>Columns/Tables</td>
<td>cursor not in a table</td>
</tr>
<tr>
<td>301</td>
<td>Columns/Tables,Ins</td>
<td>cursor not in a table</td>
</tr>
<tr>
<td>309</td>
<td>Columns/Tables,Del</td>
<td>cursor not in a table</td>
</tr>
<tr>
<td>318</td>
<td>Columns/Tables,Move</td>
<td>cursor not in a table</td>
</tr>
<tr>
<td>324</td>
<td>Columns/Tables,Move,[1,2,3]</td>
<td>cursor not in a table</td>
</tr>
<tr>
<td>16</td>
<td>Columns/Tables,1</td>
<td>cursor not in a table</td>
</tr>
<tr>
<td>325</td>
<td>Columns/Tables,1</td>
<td>cursor not in a table</td>
</tr>
<tr>
<td>33</td>
<td>Columns/Tables,1,3</td>
<td>cursor not in a table</td>
</tr>
<tr>
<td>255</td>
<td>Columns/Tables,1,3,1</td>
<td>cursor not in a table</td>
</tr>
<tr>
<td>296</td>
<td>Columns/Tables,2</td>
<td>cursor not in a table</td>
</tr>
<tr>
<td>311</td>
<td>Columns/Tables,2</td>
<td>cursor not in a table</td>
</tr>
</tbody>
</table>

Appendix L: Macros and Merge, Value Tables 689
<table>
<thead>
<tr>
<th>Value</th>
<th>Keystrokes</th>
<th>Conditions</th>
</tr>
</thead>
<tbody>
<tr>
<td>296</td>
<td>Columns/Tables,2,1</td>
<td>cursor not in a table</td>
</tr>
<tr>
<td>306</td>
<td>Columns/Tables,2,1</td>
<td>cursor in a table</td>
</tr>
<tr>
<td>323</td>
<td>Columns/Tables,2,1,1</td>
<td>cursor in a table</td>
</tr>
<tr>
<td>351</td>
<td>Columns/Tables,2,1,2</td>
<td>cursor in a table</td>
</tr>
<tr>
<td>148</td>
<td>Columns/Tables,2,1,2,1</td>
<td>cursor in a table</td>
</tr>
<tr>
<td>149</td>
<td>Columns/Tables,2,1,2,2</td>
<td>cursor in a table</td>
</tr>
<tr>
<td>352</td>
<td>Columns/Tables,2,1,3</td>
<td>cursor in a table</td>
</tr>
<tr>
<td>308</td>
<td>Columns/Tables,2,1,4</td>
<td>cursor in a table</td>
</tr>
<tr>
<td>367</td>
<td>Columns/Tables,2,1,5</td>
<td>cursor in a table</td>
</tr>
<tr>
<td>298</td>
<td>Columns/Tables,2,2</td>
<td>cursor not in a table; a table exists in document</td>
</tr>
<tr>
<td>307</td>
<td>Columns/Tables,2,2</td>
<td>cursor in a table</td>
</tr>
<tr>
<td>301</td>
<td>Columns/Tables,2,2,Ins</td>
<td>cursor not in a table; a table exists in document</td>
</tr>
<tr>
<td>309</td>
<td>Columns/Tables,2,2,Del</td>
<td>cursor not in a table; a table exists in document</td>
</tr>
<tr>
<td>318</td>
<td>Columns/Tables,2,2,Move</td>
<td>cursor not in a table; a table exists in document</td>
</tr>
<tr>
<td>324</td>
<td>Columns/Tables,2,2,Move,[1,2,3]</td>
<td>cursor not in a table; a table exists in document</td>
</tr>
<tr>
<td>325</td>
<td>Columns/Tables,2,2,1</td>
<td>cursor not in a table; a table exists in document</td>
</tr>
<tr>
<td>307</td>
<td>Columns/Tables,2,2,1</td>
<td>cursor in a table</td>
</tr>
<tr>
<td>311</td>
<td>Columns/Tables,2,2,2</td>
<td>cursor not in a table; a table exists in document</td>
</tr>
<tr>
<td>231</td>
<td>Columns/Tables,2,2,2</td>
<td>cursor in a table</td>
</tr>
<tr>
<td>306</td>
<td>Columns/Tables,2,2,2,1</td>
<td>cursor not in a table; a table exists in document</td>
</tr>
<tr>
<td>148</td>
<td>Columns/Tables,2,2,2,1</td>
<td>cursor in a table</td>
</tr>
<tr>
<td>323</td>
<td>Columns/Tables,2,2,2,1,1</td>
<td>cursor not in a table; a table exists in document</td>
</tr>
<tr>
<td>351</td>
<td>Columns/Tables,2,2,2,1,2</td>
<td>cursor not in a table; a table exists in document</td>
</tr>
<tr>
<td>148</td>
<td>Columns/Tables,2,2,2,1,2,1</td>
<td>cursor not in a table; a table exists in document</td>
</tr>
<tr>
<td>149</td>
<td>Columns/Tables,2,2,2,1,2,2</td>
<td>cursor not in a table; a table exists in document</td>
</tr>
<tr>
<td>352</td>
<td>Columns/Tables,2,2,2,1,3</td>
<td>cursor not in a table; a table exists in document</td>
</tr>
<tr>
<td>308</td>
<td>Columns/Tables,2,2,2,1,4</td>
<td>cursor not in a table; a table exists in document</td>
</tr>
<tr>
<td>367</td>
<td>Columns/Tables,2,2,2,1,5</td>
<td>cursor not in a table; a table exists in document</td>
</tr>
<tr>
<td>Value</td>
<td>Keystrokes</td>
<td>Conditions</td>
</tr>
<tr>
<td>-------</td>
<td>---------------------</td>
<td>----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>307</td>
<td>Columns/Tables,2,2,2,2</td>
<td>cursor not in a table; a table exists in document</td>
</tr>
<tr>
<td>149</td>
<td>Columns/Tables,2,2,2,2</td>
<td>cursor in a table</td>
</tr>
<tr>
<td>307</td>
<td>Columns/Tables,2,2,2,2,1</td>
<td>cursor not in a table; a table exists in document</td>
</tr>
<tr>
<td>231</td>
<td>Columns/Tables,2,2,2,2,1</td>
<td>cursor not in a table; a table exists in document</td>
</tr>
<tr>
<td>148</td>
<td>Columns/Tables,2,2,2,2,1</td>
<td>cursor not in a table; a table exists in document</td>
</tr>
<tr>
<td>149</td>
<td>Columns/Tables,2,2,2,2,2,2</td>
<td>cursor not in a table; a table exists in document</td>
</tr>
<tr>
<td>317</td>
<td>Columns/Tables,2,2,2,2,3</td>
<td>cursor not in a table; a table exists in document</td>
</tr>
<tr>
<td>312</td>
<td>Columns/Tables,2,2,2,3</td>
<td>cursor not in a table; a table exists in document</td>
</tr>
<tr>
<td>299</td>
<td>Columns/Tables,2,2,3</td>
<td>cursor not in a table; a table exists in document</td>
</tr>
<tr>
<td>317</td>
<td>Columns/Tables,2,2,3</td>
<td>cursor in a table</td>
</tr>
<tr>
<td>145</td>
<td>Columns/Tables,2,2,3,[1,2,3,4,5,6,7]</td>
<td>cursor not in a table; a table exists in document</td>
</tr>
<tr>
<td>300</td>
<td>Columns/Tables,2,2,3,8</td>
<td>cursor not in a table; a table exists in document</td>
</tr>
<tr>
<td>298</td>
<td>Columns/Tables,2,2,4</td>
<td>cursor not in a table; a table exists in document</td>
</tr>
<tr>
<td>297</td>
<td>Columns/Tables,2,2,5</td>
<td>cursor not in a table; a table exists in document</td>
</tr>
<tr>
<td>366</td>
<td>Columns/Tables,2,2,5,3</td>
<td>cursor not in a table; a table exists in document; formula exists in cell</td>
</tr>
<tr>
<td>313</td>
<td>Columns/Tables,2,2,6</td>
<td>cursor not in a table; a table exists in document</td>
</tr>
<tr>
<td>333</td>
<td>Columns/Tables,2,2,6,3</td>
<td>cursor not in a table; a table exists in document</td>
</tr>
<tr>
<td>298</td>
<td>Columns/Tables,2,2,7</td>
<td>cursor not in a table; a table exists in document</td>
</tr>
<tr>
<td>302</td>
<td>Columns/Tables,2,2,8</td>
<td>cursor not in a table; a table exists in document</td>
</tr>
<tr>
<td>312</td>
<td>Columns/Tables,2,3</td>
<td>cursor in a table</td>
</tr>
<tr>
<td>28</td>
<td>Columns/Tables,3</td>
<td>cursor not in a table</td>
</tr>
<tr>
<td>299</td>
<td>Columns/Tables,3</td>
<td>cursor in a table</td>
</tr>
<tr>
<td>145</td>
<td>Columns/Tables,3,[1,2,3,4,5,6,7]</td>
<td>cursor in a table</td>
</tr>
<tr>
<td>300</td>
<td>Columns/Tables,3,8</td>
<td>cursor in a table</td>
</tr>
<tr>
<td>298</td>
<td>Columns/Tables,4</td>
<td>cursor in a table</td>
</tr>
<tr>
<td>Value</td>
<td>Keystrokes</td>
<td>Conditions</td>
</tr>
<tr>
<td>-------</td>
<td>--------------------</td>
<td>-------------------------------------</td>
</tr>
<tr>
<td>297</td>
<td>Columns/Tables,5</td>
<td>cursor in a table</td>
</tr>
<tr>
<td>366</td>
<td>Columns/Tables,5,3</td>
<td>cursor in a table; formula exists in cell</td>
</tr>
<tr>
<td>313</td>
<td>Columns/Tables,6</td>
<td>cursor in a table</td>
</tr>
<tr>
<td>333</td>
<td>Columns/Tables,6,3</td>
<td>cursor in a table</td>
</tr>
<tr>
<td>298</td>
<td>Columns/Tables,7</td>
<td>cursor in a table</td>
</tr>
<tr>
<td>302</td>
<td>Columns/Tables,8</td>
<td>cursor in a table</td>
</tr>
</tbody>
</table>

**Footnote**

<table>
<thead>
<tr>
<th>Value</th>
<th>Keystrokes</th>
<th>Conditions</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>Footnote</td>
<td></td>
</tr>
<tr>
<td>137</td>
<td>Footnote,1</td>
<td></td>
</tr>
<tr>
<td>67</td>
<td>Footnote,1,4</td>
<td></td>
</tr>
<tr>
<td>92</td>
<td>Footnote,1,4,5</td>
<td></td>
</tr>
<tr>
<td>223</td>
<td>Footnote,1,4,7</td>
<td></td>
</tr>
<tr>
<td>392</td>
<td>Footnote,2</td>
<td></td>
</tr>
<tr>
<td>135</td>
<td>Footnote,2,4</td>
<td></td>
</tr>
<tr>
<td>92</td>
<td>Footnote,2,4,5</td>
<td></td>
</tr>
</tbody>
</table>

**Format**

<table>
<thead>
<tr>
<th>Value</th>
<th>Keystrokes</th>
<th>Conditions</th>
</tr>
</thead>
<tbody>
<tr>
<td>32819</td>
<td>Format</td>
<td>Block on</td>
</tr>
<tr>
<td>155</td>
<td>Format</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Format,1</td>
<td></td>
</tr>
<tr>
<td>331</td>
<td>Format,1,3</td>
<td></td>
</tr>
<tr>
<td>20</td>
<td>Format,1,4</td>
<td></td>
</tr>
<tr>
<td>122</td>
<td>Format,1,5,y</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>Format,1,8</td>
<td></td>
</tr>
<tr>
<td>358</td>
<td>Format,1,8,t</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Format,2</td>
<td></td>
</tr>
<tr>
<td>156</td>
<td>Format,2,2</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Format,2,3</td>
<td></td>
</tr>
<tr>
<td>240</td>
<td>Format,2,3,[1,2]</td>
<td></td>
</tr>
<tr>
<td>117</td>
<td>Format,2,4</td>
<td></td>
</tr>
<tr>
<td>240</td>
<td>Format,2,4,[1,2]</td>
<td></td>
</tr>
<tr>
<td>368</td>
<td>Format,2,6</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Format,2,6,4</td>
<td></td>
</tr>
<tr>
<td>328</td>
<td>Format,2,7</td>
<td></td>
</tr>
<tr>
<td>229</td>
<td>Format,2,7,2</td>
<td></td>
</tr>
<tr>
<td>230</td>
<td>Format,2,7,2,Return,1</td>
<td></td>
</tr>
<tr>
<td>229</td>
<td>Format,2,7,2,Return,2</td>
<td></td>
</tr>
<tr>
<td>330</td>
<td>Format,2,7,2,Return,3</td>
<td></td>
</tr>
<tr>
<td>Value</td>
<td>Keystrokes</td>
<td>Conditions</td>
</tr>
<tr>
<td>-------</td>
<td>------------------</td>
<td>-----------------------------------</td>
</tr>
<tr>
<td>234</td>
<td>Format,2,7,2,Return,5</td>
<td></td>
</tr>
<tr>
<td>359</td>
<td>Format,2,7,2,Return,7</td>
<td></td>
</tr>
<tr>
<td>356</td>
<td>Format,2,7,2,Return,8,y</td>
<td></td>
</tr>
<tr>
<td>329</td>
<td>Format,2,7,2,Return,9</td>
<td></td>
</tr>
<tr>
<td>327</td>
<td>Format,2,7,5</td>
<td>form is not [ALL OTHERS]</td>
</tr>
<tr>
<td>230</td>
<td>Format,2,7,5,1</td>
<td>form is not [ALL OTHERS]</td>
</tr>
<tr>
<td>229</td>
<td>Format,2,7,5,2</td>
<td>form is not [ALL OTHERS]</td>
</tr>
<tr>
<td>330</td>
<td>Format,2,7,5,3</td>
<td>form is not [ALL OTHERS]</td>
</tr>
<tr>
<td>234</td>
<td>Format,2,7,5,5</td>
<td>form is not [ALL OTHERS]</td>
</tr>
<tr>
<td>359</td>
<td>Format,2,7,5,7</td>
<td>form is not [ALL OTHERS]</td>
</tr>
<tr>
<td>356</td>
<td>Format,2,7,5,8,y</td>
<td>form is not [ALL OTHERS]</td>
</tr>
<tr>
<td>329</td>
<td>Format,2,7,5,9</td>
<td>form is not [ALL OTHERS]</td>
</tr>
<tr>
<td>326</td>
<td>Format,2,7,5</td>
<td>form is [ALL OTHERS]</td>
</tr>
<tr>
<td>234</td>
<td>Format,2,7,5,3</td>
<td>form is [ALL OTHERS]</td>
</tr>
<tr>
<td>329</td>
<td>Format,2,7,5,4</td>
<td>form is [ALL OTHERS]</td>
</tr>
<tr>
<td>10</td>
<td>Format,2,8</td>
<td></td>
</tr>
<tr>
<td>169</td>
<td>Format,3</td>
<td></td>
</tr>
<tr>
<td>132</td>
<td>Format,3,3</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>Format,3,4</td>
<td></td>
</tr>
<tr>
<td>125</td>
<td>Format,3,5</td>
<td></td>
</tr>
<tr>
<td>25</td>
<td>Format,4</td>
<td></td>
</tr>
<tr>
<td>150</td>
<td>Format,4,1</td>
<td></td>
</tr>
<tr>
<td>164</td>
<td>Format,4,5</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Format,4,6</td>
<td></td>
</tr>
<tr>
<td>84</td>
<td>Format,4,6,2</td>
<td></td>
</tr>
<tr>
<td>93</td>
<td>Format,4,6,3</td>
<td></td>
</tr>
<tr>
<td>151</td>
<td>Format,4,6,3,Return</td>
<td></td>
</tr>
<tr>
<td>403</td>
<td>Format,4,8</td>
<td></td>
</tr>
</tbody>
</table>

**Style**

<table>
<thead>
<tr>
<th>Value</th>
<th>Keystrokes</th>
<th>Conditions</th>
</tr>
</thead>
<tbody>
<tr>
<td>59</td>
<td>Style</td>
<td></td>
</tr>
<tr>
<td>387</td>
<td>Style,3</td>
<td></td>
</tr>
<tr>
<td>174</td>
<td>Style,3,2</td>
<td></td>
</tr>
<tr>
<td>201</td>
<td>Style,3,5</td>
<td>paired styles only</td>
</tr>
<tr>
<td>387</td>
<td>Style,4</td>
<td>not outline style</td>
</tr>
<tr>
<td>263</td>
<td>Style,4</td>
<td>outline style</td>
</tr>
<tr>
<td>174</td>
<td>Style,4,2</td>
<td>not outline style</td>
</tr>
<tr>
<td>339</td>
<td>Style,4,3</td>
<td>outline style</td>
</tr>
<tr>
<td>201</td>
<td>Style,4,4</td>
<td>outline style</td>
</tr>
<tr>
<td>Value</td>
<td>Keystrokes</td>
<td>Conditions</td>
</tr>
<tr>
<td>-------</td>
<td>-----------</td>
<td>------------</td>
</tr>
<tr>
<td>201</td>
<td>Style,4,5</td>
<td>not outline style; paired styles only</td>
</tr>
<tr>
<td>370</td>
<td>Style,5</td>
<td></td>
</tr>
</tbody>
</table>

**Font**

<table>
<thead>
<tr>
<th>Value</th>
<th>Keystrokes</th>
<th>Conditions</th>
</tr>
</thead>
<tbody>
<tr>
<td>147</td>
<td>Font</td>
<td></td>
</tr>
<tr>
<td>63</td>
<td>Font</td>
<td>Block on</td>
</tr>
<tr>
<td>148</td>
<td>Font,1</td>
<td>Block on or off</td>
</tr>
<tr>
<td>149</td>
<td>Font,2</td>
<td>Block on or off</td>
</tr>
<tr>
<td>132</td>
<td>Font,4</td>
<td></td>
</tr>
<tr>
<td>146</td>
<td>Font,5</td>
<td></td>
</tr>
</tbody>
</table>

**Merge Codes**

<table>
<thead>
<tr>
<th>Value</th>
<th>Keystrokes</th>
<th>Conditions</th>
</tr>
</thead>
<tbody>
<tr>
<td>340</td>
<td>Merge Code</td>
<td></td>
</tr>
<tr>
<td>340</td>
<td>Merge Codes,6</td>
<td></td>
</tr>
</tbody>
</table>

**Graphics**

<table>
<thead>
<tr>
<th>Value</th>
<th>Keystrokes</th>
<th>Conditions</th>
</tr>
</thead>
<tbody>
<tr>
<td>136</td>
<td>Graphics</td>
<td></td>
</tr>
<tr>
<td>393</td>
<td>Graphics,1</td>
<td></td>
</tr>
<tr>
<td>138</td>
<td>Graphics,1,1</td>
<td></td>
</tr>
<tr>
<td>257</td>
<td>Graphics,1,1,2</td>
<td></td>
</tr>
<tr>
<td>139</td>
<td>Graphics,1,1,4</td>
<td></td>
</tr>
<tr>
<td>140</td>
<td>Graphics,1,1,5</td>
<td></td>
</tr>
<tr>
<td>152</td>
<td>Graphics,1,1,5</td>
<td></td>
</tr>
<tr>
<td>142</td>
<td>Graphics,1,1,6</td>
<td></td>
</tr>
<tr>
<td>141</td>
<td>Graphics,1,1,6</td>
<td></td>
</tr>
<tr>
<td>142</td>
<td>Graphics,1,1,6,1</td>
<td></td>
</tr>
<tr>
<td>142</td>
<td>Graphics,1,1,6,2</td>
<td></td>
</tr>
<tr>
<td>210</td>
<td>Graphics,1,1,7</td>
<td></td>
</tr>
<tr>
<td>373</td>
<td>Graphics,1,1,9</td>
<td></td>
</tr>
<tr>
<td>225</td>
<td>Graphics,1,1,9,Graphics</td>
<td>Contents=Text</td>
</tr>
<tr>
<td>399</td>
<td>Graphics,1,1,9,List Files</td>
<td>Contents=Equation</td>
</tr>
<tr>
<td>399</td>
<td>Graphics,1,1,9,Switch</td>
<td>Contents=Equation; equation palette active</td>
</tr>
<tr>
<td>374</td>
<td>Graphics,1,1,9,Switch</td>
<td>Contents=Equation; editing window active</td>
</tr>
<tr>
<td>375</td>
<td>Graphics,1,1,9,Switch</td>
<td>Contents=Equation; display window active</td>
</tr>
<tr>
<td>381</td>
<td>Graphics,1,1,9,Setup</td>
<td>Contents=Equation</td>
</tr>
<tr>
<td>400</td>
<td>Graphics,1,1,9,Setup,2</td>
<td>Contents=Equation</td>
</tr>
<tr>
<td>379</td>
<td>Graphics,1,1,9,Setup,3</td>
<td>Contents=Equation</td>
</tr>
<tr>
<td>380</td>
<td>Graphics,1,1,9,Setup,4</td>
<td>Contents=Equation</td>
</tr>
<tr>
<td>Value</td>
<td>Keystrokes</td>
<td>Conditions</td>
</tr>
<tr>
<td>-------</td>
<td>---------------------------</td>
<td>----------------</td>
</tr>
<tr>
<td>144</td>
<td>Graphics,1,4</td>
<td></td>
</tr>
<tr>
<td>145</td>
<td>Graphics,1,4,1</td>
<td></td>
</tr>
<tr>
<td>239</td>
<td>Graphics,1,4,[4,5]</td>
<td></td>
</tr>
<tr>
<td>183</td>
<td>Graphics,1,4,7</td>
<td>Contents=Equation</td>
</tr>
<tr>
<td>143</td>
<td>Graphics,1,4,7</td>
<td>Contents #Equation</td>
</tr>
<tr>
<td>115</td>
<td>Graphics,1,4,7,[1,2]</td>
<td>Contents #Equation</td>
</tr>
<tr>
<td>394</td>
<td>Graphics,2</td>
<td></td>
</tr>
<tr>
<td>138</td>
<td>Graphics,2,1</td>
<td></td>
</tr>
<tr>
<td>144</td>
<td>Graphics,2,4</td>
<td></td>
</tr>
<tr>
<td>395</td>
<td>Graphics,3</td>
<td></td>
</tr>
<tr>
<td>138</td>
<td>Graphics,3,1</td>
<td></td>
</tr>
<tr>
<td>144</td>
<td>Graphics,3,4</td>
<td></td>
</tr>
<tr>
<td>396</td>
<td>Graphics,4</td>
<td></td>
</tr>
<tr>
<td>138</td>
<td>Graphics,4,1</td>
<td></td>
</tr>
<tr>
<td>144</td>
<td>Graphics,4,4</td>
<td></td>
</tr>
<tr>
<td>227</td>
<td>Graphics,5</td>
<td></td>
</tr>
<tr>
<td>224</td>
<td>Graphics,5,1</td>
<td></td>
</tr>
<tr>
<td>243</td>
<td>Graphics,5,1,1</td>
<td></td>
</tr>
<tr>
<td>361</td>
<td>Graphics,5,1,2</td>
<td></td>
</tr>
<tr>
<td>226</td>
<td>Graphics,5,1,2,2</td>
<td></td>
</tr>
<tr>
<td>226</td>
<td>Graphics,5,2</td>
<td></td>
</tr>
<tr>
<td>242</td>
<td>Graphics,5,2,1</td>
<td></td>
</tr>
<tr>
<td>140</td>
<td>Graphics,5,2,2</td>
<td></td>
</tr>
<tr>
<td>226</td>
<td>Graphics,5,2,2,5</td>
<td></td>
</tr>
<tr>
<td>224</td>
<td>Graphics,5,3</td>
<td></td>
</tr>
<tr>
<td>226</td>
<td>Graphics,5,4</td>
<td></td>
</tr>
<tr>
<td>397</td>
<td>Graphics,6</td>
<td></td>
</tr>
<tr>
<td>138</td>
<td>Graphics,6,1</td>
<td></td>
</tr>
<tr>
<td>144</td>
<td>Graphics,6,4</td>
<td></td>
</tr>
<tr>
<td><strong>Merge/Sort</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>62</td>
<td>Merge/Sort</td>
<td></td>
</tr>
<tr>
<td>390</td>
<td>Merge/Sort,1</td>
<td></td>
</tr>
<tr>
<td>52</td>
<td>Merge/Sort,2,file,Return,file,Return</td>
<td></td>
</tr>
<tr>
<td>61</td>
<td>Merge/Sort,2,file,Return,file,Return,3</td>
<td></td>
</tr>
<tr>
<td>109</td>
<td>Merge/Sort,2,file,Return,file,Return,5</td>
<td>Select active</td>
</tr>
<tr>
<td>108</td>
<td>Merge/Sort,2,file,Return,file,Return,6</td>
<td></td>
</tr>
<tr>
<td>107</td>
<td>Merge/Sort,2,file,Return,file,Return,7</td>
<td></td>
</tr>
<tr>
<td>Value</td>
<td>Keystrokes</td>
<td>Conditions</td>
</tr>
<tr>
<td>---------</td>
<td>---------------------</td>
<td>---------------------------------</td>
</tr>
<tr>
<td>Save</td>
<td>Save</td>
<td>Long Document Name=Yes</td>
</tr>
<tr>
<td>65027</td>
<td>Save</td>
<td>Long Document Name=No</td>
</tr>
<tr>
<td>32809</td>
<td>Save</td>
<td></td>
</tr>
<tr>
<td>Retrieve</td>
<td>Retrieve</td>
<td></td>
</tr>
<tr>
<td>32821</td>
<td>Retrieve</td>
<td></td>
</tr>
<tr>
<td>Macro</td>
<td>Macro</td>
<td></td>
</tr>
<tr>
<td>32833</td>
<td>Macro</td>
<td></td>
</tr>
<tr>
<td>Macro Define</td>
<td>Macro Define</td>
<td>macro already defined</td>
</tr>
<tr>
<td>32845</td>
<td>Macro Define</td>
<td></td>
</tr>
<tr>
<td>222</td>
<td>Macro Define,2</td>
<td>macro already defined</td>
</tr>
<tr>
<td>236</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Other Keys</td>
<td>Esc</td>
<td>repeat value</td>
</tr>
<tr>
<td>32795</td>
<td>Esc</td>
<td></td>
</tr>
<tr>
<td>32848</td>
<td>Backspace</td>
<td>deleting code and Reveal Codes</td>
</tr>
<tr>
<td>32776</td>
<td>Home</td>
<td>off</td>
</tr>
<tr>
<td>32856</td>
<td>Go To</td>
<td></td>
</tr>
<tr>
<td>32849</td>
<td>Del</td>
<td>deleting code and Reveal Codes</td>
</tr>
<tr>
<td>32780</td>
<td>Delete to End of Page</td>
<td>off</td>
</tr>
<tr>
<td>253</td>
<td>Macro Commands</td>
<td>macro definition or execution</td>
</tr>
<tr>
<td>32790</td>
<td>Compose</td>
<td>active</td>
</tr>
<tr>
<td>Pull-Down Menus</td>
<td>Menu Bar</td>
<td></td>
</tr>
<tr>
<td>264</td>
<td>File</td>
<td></td>
</tr>
<tr>
<td>265</td>
<td>File,Text In</td>
<td></td>
</tr>
<tr>
<td>273</td>
<td>File,Text In,Spreadsheet</td>
<td></td>
</tr>
<tr>
<td>321</td>
<td>File,Text In,Spreadsheet</td>
<td></td>
</tr>
<tr>
<td>272</td>
<td>File,Text Out</td>
<td></td>
</tr>
<tr>
<td>293</td>
<td>File,Password</td>
<td></td>
</tr>
<tr>
<td>377</td>
<td>File,Setup</td>
<td></td>
</tr>
<tr>
<td>266</td>
<td>Edit</td>
<td></td>
</tr>
<tr>
<td>270</td>
<td>Edit,Append</td>
<td>Block on</td>
</tr>
<tr>
<td>274</td>
<td>Edit,Select</td>
<td></td>
</tr>
<tr>
<td>322</td>
<td>Edit,Comment</td>
<td></td>
</tr>
<tr>
<td>275</td>
<td>Edit,Convert Case</td>
<td></td>
</tr>
<tr>
<td>287</td>
<td>Search</td>
<td></td>
</tr>
<tr>
<td>277</td>
<td>Search,Extended</td>
<td></td>
</tr>
<tr>
<td>268</td>
<td>Layout</td>
<td></td>
</tr>
<tr>
<td>Value</td>
<td>Keystrokes</td>
<td>Conditions</td>
</tr>
<tr>
<td>-------</td>
<td>------------</td>
<td>------------</td>
</tr>
<tr>
<td>276</td>
<td>Layout, Columns</td>
<td></td>
</tr>
<tr>
<td>378</td>
<td>Layout, Tables</td>
<td></td>
</tr>
<tr>
<td>286</td>
<td>Layout, Math</td>
<td></td>
</tr>
<tr>
<td>279</td>
<td>Layout, Footnote</td>
<td></td>
</tr>
<tr>
<td>280</td>
<td>Layout, Endnote</td>
<td></td>
</tr>
<tr>
<td>283</td>
<td>Layout, Justify</td>
<td></td>
</tr>
<tr>
<td>290</td>
<td>Layout, Align</td>
<td></td>
</tr>
<tr>
<td>376</td>
<td>Mark</td>
<td></td>
</tr>
<tr>
<td>288</td>
<td>Mark, Cross-Reference</td>
<td></td>
</tr>
<tr>
<td>289</td>
<td>Mark, Table of Authorities</td>
<td></td>
</tr>
<tr>
<td>285</td>
<td>Mark, Define</td>
<td></td>
</tr>
<tr>
<td>295</td>
<td>Mark, Master Documents</td>
<td></td>
</tr>
<tr>
<td>294</td>
<td>Mark, Document Compare</td>
<td></td>
</tr>
<tr>
<td>271</td>
<td>Tools</td>
<td></td>
</tr>
<tr>
<td>281</td>
<td>Tools, Macro</td>
<td></td>
</tr>
<tr>
<td>284</td>
<td>Tools, Outline</td>
<td></td>
</tr>
<tr>
<td>282</td>
<td>Tools, Merge Codes</td>
<td></td>
</tr>
<tr>
<td>269</td>
<td>Font</td>
<td></td>
</tr>
<tr>
<td>278</td>
<td>Font, Appearance</td>
<td></td>
</tr>
<tr>
<td>267</td>
<td>Graphics</td>
<td></td>
</tr>
<tr>
<td>279</td>
<td>Graphics,[Figure,Table,Text Box,User Box,Equation]</td>
<td></td>
</tr>
<tr>
<td>291</td>
<td>Graphics,Line</td>
<td></td>
</tr>
<tr>
<td>292</td>
<td>Help</td>
<td></td>
</tr>
</tbody>
</table>

\(^1\) The value returned corresponds to the original key pressed, not to the direction of the search. For example, if you press \(\text{Search}\), then press Down Arrow to change the search to a forward search, \{SYSTEM\}Menu \(\wedge\) still returns 32813.

### By Number

This table lists the menus by menu number (value returned by \{SYSTEM\}Menu \(\wedge\)). Use this table when you know the value but not the menu(s) at which that value is returned.

<table>
<thead>
<tr>
<th>Value</th>
<th>Keystrokes</th>
<th>Conditions</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Format,2</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Mark Text</td>
<td>Block on</td>
</tr>
<tr>
<td>3</td>
<td>Footnote</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Format,1</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Format,2,3</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Format,4,6</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Format,2,6,4</td>
<td></td>
</tr>
<tr>
<td>Value</td>
<td>Keystrokes</td>
<td>Conditions</td>
</tr>
<tr>
<td>-------</td>
<td>-----------------------------</td>
<td>---------------------------------</td>
</tr>
<tr>
<td>10</td>
<td>Format,2,8</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>Setup,3,8,5</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Format,3,4</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>Format,1,8</td>
<td></td>
</tr>
<tr>
<td>16</td>
<td>Columns/Tables,1</td>
<td>cursor not in a table</td>
</tr>
<tr>
<td>17</td>
<td>Speller</td>
<td></td>
</tr>
<tr>
<td>20</td>
<td>Format,1,4</td>
<td></td>
</tr>
<tr>
<td>23</td>
<td>Move</td>
<td>Block on</td>
</tr>
<tr>
<td>24</td>
<td>Date/Outline</td>
<td></td>
</tr>
<tr>
<td>25</td>
<td>Format,4</td>
<td></td>
</tr>
<tr>
<td>28</td>
<td>Columns/Tables,3</td>
<td>cursor not in a table</td>
</tr>
<tr>
<td>30</td>
<td>Move</td>
<td></td>
</tr>
<tr>
<td>31</td>
<td>Switch</td>
<td>Block on</td>
</tr>
<tr>
<td>32</td>
<td>Move,[1,2,3]</td>
<td>Block on or off</td>
</tr>
<tr>
<td>33</td>
<td>Columns/Tables,1,3</td>
<td>cursor not in a table</td>
</tr>
<tr>
<td>36</td>
<td>Mark Text,5,4,1</td>
<td></td>
</tr>
<tr>
<td>38</td>
<td>Speller</td>
<td></td>
</tr>
<tr>
<td>42</td>
<td>Print,s,3,4</td>
<td></td>
</tr>
<tr>
<td>44</td>
<td>Setup,2,2</td>
<td></td>
</tr>
<tr>
<td>45</td>
<td>Setup,3</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Setup,3,2</td>
<td></td>
</tr>
<tr>
<td>47</td>
<td>Print,s,2,2</td>
<td></td>
</tr>
<tr>
<td>49</td>
<td>F1</td>
<td></td>
</tr>
<tr>
<td>52</td>
<td>Merge/Sort,2,file,Return,file,Return</td>
<td></td>
</tr>
<tr>
<td>55</td>
<td>Setup,2,8</td>
<td></td>
</tr>
<tr>
<td>56</td>
<td>Setup,5</td>
<td></td>
</tr>
<tr>
<td>57</td>
<td>Date/Outline,3</td>
<td></td>
</tr>
<tr>
<td>59</td>
<td>Style</td>
<td></td>
</tr>
<tr>
<td>60</td>
<td>Text In/Out</td>
<td></td>
</tr>
<tr>
<td>61</td>
<td>Merge/Sort,2,file,Return,file,Return,3</td>
<td></td>
</tr>
<tr>
<td>62</td>
<td>Merge/Sort</td>
<td></td>
</tr>
<tr>
<td>63</td>
<td>Font</td>
<td>Block on</td>
</tr>
<tr>
<td>64</td>
<td>Speller,[1,2,3]</td>
<td>word not found</td>
</tr>
<tr>
<td>67</td>
<td>Footnote,1,4</td>
<td></td>
</tr>
<tr>
<td>68</td>
<td>Setup,2,1</td>
<td></td>
</tr>
<tr>
<td>69</td>
<td>Setup,3,8,7</td>
<td></td>
</tr>
<tr>
<td>70</td>
<td>Text In/Out,1</td>
<td></td>
</tr>
<tr>
<td>Value</td>
<td>Keystrokes</td>
<td>Conditions</td>
</tr>
<tr>
<td>-------</td>
<td>------------</td>
<td>------------</td>
</tr>
<tr>
<td>74</td>
<td>Print</td>
<td></td>
</tr>
<tr>
<td>75</td>
<td>Print,s,3,3</td>
<td></td>
</tr>
<tr>
<td>76</td>
<td>Print,s</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Print,s,2</td>
<td></td>
</tr>
<tr>
<td>78</td>
<td>Mark Text</td>
<td></td>
</tr>
<tr>
<td>79</td>
<td>Date/Outline,6</td>
<td></td>
</tr>
<tr>
<td>84</td>
<td>Format,4,6,2</td>
<td></td>
</tr>
<tr>
<td>85</td>
<td>Mark Text,5,2,[1,3]</td>
<td></td>
</tr>
<tr>
<td>88</td>
<td>Mark Text,5,1</td>
<td></td>
</tr>
<tr>
<td>89</td>
<td>Mark Text,5,1,3</td>
<td></td>
</tr>
<tr>
<td>92</td>
<td>Footnote,1,2,4,5</td>
<td></td>
</tr>
<tr>
<td>93</td>
<td>Format,4,6,3</td>
<td></td>
</tr>
<tr>
<td>101</td>
<td>Setup,2,7</td>
<td></td>
</tr>
<tr>
<td>102</td>
<td>Shell</td>
<td>under Shell</td>
</tr>
<tr>
<td>103</td>
<td>Shell</td>
<td>not under Shell</td>
</tr>
<tr>
<td>105</td>
<td>Setup,3,8</td>
<td></td>
</tr>
<tr>
<td>107</td>
<td>Merge/Sort,2,File,Return,File,Return,7</td>
<td></td>
</tr>
<tr>
<td>108</td>
<td>Merge/Sort,2,File,Return,File,Return,6</td>
<td></td>
</tr>
<tr>
<td>109</td>
<td>Merge/Sort,2,File,Return,File,Return,5</td>
<td>Select active</td>
</tr>
<tr>
<td>110</td>
<td>Thesaurus</td>
<td>word found</td>
</tr>
<tr>
<td>112</td>
<td>Move,4</td>
<td></td>
</tr>
<tr>
<td>114</td>
<td>List Files,Directory,Return,L</td>
<td>no document summary</td>
</tr>
<tr>
<td>115</td>
<td>Graphics,1,4,7,[1,2]</td>
<td>Contents, Equation</td>
</tr>
<tr>
<td>117</td>
<td>Format,2,4</td>
<td></td>
</tr>
<tr>
<td>121</td>
<td>Mark Text,5</td>
<td></td>
</tr>
<tr>
<td>122</td>
<td>Format,1,5,y</td>
<td></td>
</tr>
<tr>
<td>125</td>
<td>Format,3,5</td>
<td></td>
</tr>
<tr>
<td>132</td>
<td>Font,4</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Print,s,3,5</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Format,3,3</td>
<td></td>
</tr>
<tr>
<td>133</td>
<td>Print,s,2,3</td>
<td></td>
</tr>
<tr>
<td>134</td>
<td>Print,s,3</td>
<td></td>
</tr>
<tr>
<td>135</td>
<td>Footnote,2,4</td>
<td></td>
</tr>
<tr>
<td>136</td>
<td>Graphics</td>
<td></td>
</tr>
<tr>
<td>137</td>
<td>Footnote,1</td>
<td></td>
</tr>
<tr>
<td>138</td>
<td>Graphics,1,2,3,4,6,1</td>
<td></td>
</tr>
<tr>
<td>139</td>
<td>Graphics,1,1,4</td>
<td></td>
</tr>
<tr>
<td>140</td>
<td>Graphics,1,1,5</td>
<td>anchor type=Page</td>
</tr>
<tr>
<td>Value</td>
<td>Keystrokes</td>
<td>Conditions</td>
</tr>
<tr>
<td>-------</td>
<td>------------</td>
<td>------------</td>
</tr>
<tr>
<td>141</td>
<td>Graphics,1,1,6</td>
<td>anchor type=Paragraph</td>
</tr>
<tr>
<td>142</td>
<td>Graphics,1,1,6</td>
<td>anchor type=Paragraph</td>
</tr>
<tr>
<td>143</td>
<td>Graphics,1,4,7</td>
<td>Contents=Equation</td>
</tr>
<tr>
<td>144</td>
<td>Graphics,1,2,3,4,6,4</td>
<td></td>
</tr>
<tr>
<td>145</td>
<td>Columns/Tables,2,2,3,[1,2,3,4,5,6,7]</td>
<td>cursor not in a table; a table exists in document</td>
</tr>
<tr>
<td></td>
<td>Columns/Tables,3,[1,2,3,4,5,6,7]</td>
<td>cursor in a table</td>
</tr>
<tr>
<td>146</td>
<td>Font,5</td>
<td>Block on or off</td>
</tr>
<tr>
<td>147</td>
<td>Font</td>
<td>Block on or off</td>
</tr>
<tr>
<td>148</td>
<td>Columns/Tables,2,[1,2],2,1</td>
<td>cursor in a table</td>
</tr>
<tr>
<td></td>
<td>Columns/Tables,2,2,2,[1,2],2,1</td>
<td>cursor not in a table; a table exists in document</td>
</tr>
<tr>
<td></td>
<td>Font,1</td>
<td>Block on or off</td>
</tr>
<tr>
<td>149</td>
<td>Columns/Tables,2,[1,2],2,2</td>
<td>cursor in a table</td>
</tr>
<tr>
<td></td>
<td>Columns/Tables,2,2,2,[1,2],2,2</td>
<td>cursor not in a table; a table exists in document</td>
</tr>
<tr>
<td></td>
<td>Font,2</td>
<td>Block on or off</td>
</tr>
<tr>
<td>150</td>
<td>Format,4,1</td>
<td></td>
</tr>
<tr>
<td>151</td>
<td>Format,4,6,3,Return</td>
<td></td>
</tr>
<tr>
<td>152</td>
<td>Graphics,1,1,5</td>
<td>anchor type=Character</td>
</tr>
<tr>
<td>153</td>
<td>Print,6</td>
<td></td>
</tr>
<tr>
<td>154</td>
<td>Mark Text,1,[1,3]</td>
<td></td>
</tr>
<tr>
<td>155</td>
<td>Format</td>
<td></td>
</tr>
<tr>
<td>156</td>
<td>Format,2,2</td>
<td></td>
</tr>
<tr>
<td>159</td>
<td>Mark Text,1</td>
<td></td>
</tr>
<tr>
<td>164</td>
<td>Format,4,5</td>
<td></td>
</tr>
<tr>
<td>169</td>
<td>Format,3</td>
<td></td>
</tr>
<tr>
<td>174</td>
<td>Style,3,2</td>
<td>not outline style</td>
</tr>
<tr>
<td></td>
<td>Style,4,2</td>
<td></td>
</tr>
<tr>
<td>176</td>
<td>Mark Text,6</td>
<td></td>
</tr>
<tr>
<td>177</td>
<td>Setup</td>
<td></td>
</tr>
<tr>
<td>181</td>
<td>Setup,2,3</td>
<td></td>
</tr>
<tr>
<td>182</td>
<td>Print,s,3,4,1</td>
<td>cursor on Soft Fonts; soft fonts available</td>
</tr>
<tr>
<td>Value</td>
<td>Keystrokes</td>
<td>Conditions</td>
</tr>
<tr>
<td>-------</td>
<td>-------------------------------------</td>
<td>------------------------------------------------------</td>
</tr>
<tr>
<td>183</td>
<td>Graphics,1,4,7</td>
<td>Contents=Equation</td>
</tr>
<tr>
<td>199</td>
<td>Setup,3,8,4</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Print,t</td>
<td></td>
</tr>
<tr>
<td>201</td>
<td>Style,3,5 t</td>
<td>paired styles only</td>
</tr>
<tr>
<td></td>
<td>Style,4,4</td>
<td>outline style</td>
</tr>
<tr>
<td></td>
<td>Style,4,5</td>
<td>not outline style; paired styles only</td>
</tr>
<tr>
<td></td>
<td>Date/Outline,6,9,[2,3],4</td>
<td></td>
</tr>
<tr>
<td>202</td>
<td>Setup,3,8,3</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Print,g</td>
<td></td>
</tr>
<tr>
<td>208</td>
<td>Setup,4</td>
<td></td>
</tr>
<tr>
<td>209</td>
<td>Setup,4,7</td>
<td></td>
</tr>
<tr>
<td>210</td>
<td>Graphics,1,1,7</td>
<td></td>
</tr>
<tr>
<td>217</td>
<td>Print,4</td>
<td></td>
</tr>
<tr>
<td>220</td>
<td>Setup,3,7</td>
<td></td>
</tr>
<tr>
<td>221</td>
<td>Setup,1</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Setup,1,[1,2]</td>
<td></td>
</tr>
<tr>
<td>222</td>
<td>Macro Define</td>
<td>macro already defined</td>
</tr>
<tr>
<td>223</td>
<td>Footnote,1,4,7</td>
<td></td>
</tr>
<tr>
<td>224</td>
<td>Graphics,5,1</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Graphics,5,3</td>
<td></td>
</tr>
<tr>
<td>225</td>
<td>Graphics,1,1,9,Graphics</td>
<td>Contents=Text</td>
</tr>
<tr>
<td>226</td>
<td>Graphics,5,1,2,2</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Graphics,5,[2,4]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Graphics,5,2,2,5</td>
<td></td>
</tr>
<tr>
<td>227</td>
<td>Graphics,5</td>
<td></td>
</tr>
<tr>
<td>229</td>
<td>Format,2,7,2</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Format,2,7,2,Return,2</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Format,2,7,5,2</td>
<td>form is not [ALL OTHERS]</td>
</tr>
<tr>
<td>230</td>
<td>Format,2,7,2,Return,1</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Format,2,7,5,1</td>
<td>form is not [ALL OTHERS]</td>
</tr>
<tr>
<td>231</td>
<td>Columns/Tables,2,2,2</td>
<td>cursor in a table</td>
</tr>
<tr>
<td></td>
<td>Columns/Tables,2,2,2,2</td>
<td>cursor not in a table; a table exists in document</td>
</tr>
<tr>
<td>232</td>
<td>List Files, directory,Return,9</td>
<td></td>
</tr>
<tr>
<td>234</td>
<td>Format,2,7,2,Return,5</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Format,2,7,5,3</td>
<td>form is [ALL OTHERS]</td>
</tr>
<tr>
<td></td>
<td>Format,2,7,5,5</td>
<td>form is not [ALL OTHERS]</td>
</tr>
<tr>
<td>235</td>
<td>Setup,4,7,1</td>
<td></td>
</tr>
<tr>
<td>Value</td>
<td>Keystrokes</td>
<td>Conditions</td>
</tr>
<tr>
<td>-------</td>
<td>------------</td>
<td>------------</td>
</tr>
<tr>
<td>236</td>
<td>Macro Define,2</td>
<td>macro already defined</td>
</tr>
<tr>
<td>239</td>
<td>Graphics,1,4,[4,5]</td>
<td></td>
</tr>
<tr>
<td>240</td>
<td>Format,2,[3,4],[1,2]</td>
<td></td>
</tr>
<tr>
<td>241</td>
<td>List Files, directory, Return, 9.5</td>
<td></td>
</tr>
<tr>
<td>242</td>
<td>Graphics,5,2,1</td>
<td></td>
</tr>
<tr>
<td>243</td>
<td>Graphics,5,1,1</td>
<td></td>
</tr>
<tr>
<td>244</td>
<td>Mark Text,1,[1,3],5</td>
<td></td>
</tr>
<tr>
<td>249</td>
<td>Text In/Out,2</td>
<td></td>
</tr>
<tr>
<td>250</td>
<td>Text In/Out,4</td>
<td></td>
</tr>
<tr>
<td>252</td>
<td>Setup,3,8,2, Return Print,u</td>
<td></td>
</tr>
<tr>
<td>253</td>
<td>Macro Commands macro definition or execution active</td>
<td></td>
</tr>
<tr>
<td>255</td>
<td>Columns/Tables,1,3,1 cursor not in a table</td>
<td></td>
</tr>
<tr>
<td>256</td>
<td>Date/Outline,6,9</td>
<td></td>
</tr>
<tr>
<td>257</td>
<td>Graphics,1,1,2</td>
<td></td>
</tr>
<tr>
<td>259</td>
<td>Text In/Out,5</td>
<td></td>
</tr>
<tr>
<td>260</td>
<td>Text In/Out,5,[1,2,3]</td>
<td></td>
</tr>
<tr>
<td>261</td>
<td>Text In/Out,5,[1,2,3],3</td>
<td></td>
</tr>
<tr>
<td>263</td>
<td>Style,4 outline style</td>
<td></td>
</tr>
<tr>
<td>263</td>
<td>Date/Outline,6,9,[2,3]</td>
<td></td>
</tr>
<tr>
<td>264</td>
<td>(pull-down) Menu Bar</td>
<td></td>
</tr>
<tr>
<td>265</td>
<td>(pull-down) File</td>
<td></td>
</tr>
<tr>
<td>266</td>
<td>(pull-down) Edit</td>
<td></td>
</tr>
<tr>
<td>267</td>
<td>(pull-down) Graphics</td>
<td></td>
</tr>
<tr>
<td>268</td>
<td>(pull-down) Layout</td>
<td></td>
</tr>
<tr>
<td>269</td>
<td>(pull-down) Font</td>
<td></td>
</tr>
<tr>
<td>270</td>
<td>(pull-down) Edit, Append Block on</td>
<td></td>
</tr>
<tr>
<td>271</td>
<td>(pull-down) Tools</td>
<td></td>
</tr>
<tr>
<td>272</td>
<td>(pull-down) File, Text Out</td>
<td></td>
</tr>
<tr>
<td>273</td>
<td>(pull-down) File, Text In</td>
<td></td>
</tr>
<tr>
<td>274</td>
<td>(pull-down) Edit, Select</td>
<td></td>
</tr>
<tr>
<td>275</td>
<td>(pull-down) Edit, Convert Case</td>
<td></td>
</tr>
<tr>
<td>276</td>
<td>(pull-down) Layout, Columns</td>
<td></td>
</tr>
<tr>
<td>277</td>
<td>(pull-down) Search, Extended</td>
<td></td>
</tr>
<tr>
<td>278</td>
<td>(pull-down) Font, Appearance</td>
<td></td>
</tr>
<tr>
<td>279</td>
<td>(pull-down) Graphics, Equation, Figure,</td>
<td></td>
</tr>
</tbody>
</table>

702 Appendix L: Macros and Merge, Value Tables
<table>
<thead>
<tr>
<th>Value</th>
<th>Keystrokes</th>
<th>Conditions</th>
</tr>
</thead>
<tbody>
<tr>
<td>279</td>
<td>(pull-down) <strong>Table,</strong> <strong>Text Box,</strong> <strong>User Box</strong></td>
<td></td>
</tr>
<tr>
<td>280</td>
<td>(pull-down) <strong>Layout,</strong> <strong>Footnote</strong></td>
<td></td>
</tr>
<tr>
<td>281</td>
<td>(pull-down) <strong>Tools,</strong> <strong>Macro</strong></td>
<td></td>
</tr>
<tr>
<td>282</td>
<td>(pull-down) <strong>Tools,</strong> <strong>Merge Codes</strong></td>
<td></td>
</tr>
<tr>
<td>283</td>
<td>(pull-down) <strong>Layout,</strong> <strong>Justify</strong></td>
<td></td>
</tr>
<tr>
<td>284</td>
<td>(pull-down) <strong>Tools,</strong> <strong>Outline</strong></td>
<td></td>
</tr>
<tr>
<td>285</td>
<td>(pull-down) <strong>Mark,</strong> <strong>Define</strong></td>
<td></td>
</tr>
<tr>
<td>286</td>
<td>(pull-down) <strong>Layout,</strong> <strong>Math</strong></td>
<td></td>
</tr>
<tr>
<td>287</td>
<td>(pull-down) <strong>Search</strong></td>
<td></td>
</tr>
<tr>
<td>288</td>
<td>(pull-down) <strong>Mark,</strong> <strong>Cross-Reference</strong></td>
<td></td>
</tr>
<tr>
<td>289</td>
<td>(pull-down) <strong>Mark,</strong> <strong>Table of Authorities</strong></td>
<td></td>
</tr>
<tr>
<td>290</td>
<td>(pull-down) <strong>Layout,</strong> <strong>Align</strong></td>
<td></td>
</tr>
<tr>
<td>291</td>
<td>(pull-down) <strong>Graphics,</strong> <strong>Line</strong></td>
<td></td>
</tr>
<tr>
<td>292</td>
<td>(pull-down) <strong>Help</strong></td>
<td></td>
</tr>
<tr>
<td>293</td>
<td>(pull-down) <strong>File,</strong> <strong>PassWord</strong></td>
<td></td>
</tr>
<tr>
<td>294</td>
<td>(pull-down) <strong>Mark,</strong> <strong>Document Compare</strong></td>
<td></td>
</tr>
<tr>
<td>295</td>
<td>(pull-down) <strong>Mark,</strong> <strong>Master Documents</strong></td>
<td></td>
</tr>
<tr>
<td>296</td>
<td><strong>Columns/Tables,</strong> <strong>2</strong></td>
<td>cursor not in a table</td>
</tr>
<tr>
<td>296</td>
<td><strong>Columns/Tables,</strong> <strong>2,</strong> <strong>1</strong></td>
<td>cursor not in a table</td>
</tr>
<tr>
<td>297</td>
<td><strong>Columns/Tables,</strong> <strong>2,</strong> <strong>2,</strong> <strong>5</strong></td>
<td>cursor not in a table; a table exists in document</td>
</tr>
<tr>
<td></td>
<td><strong>Columns/Tables,</strong> <strong>5</strong></td>
<td>cursor in a table</td>
</tr>
<tr>
<td>298</td>
<td><strong>Columns/Tables</strong></td>
<td>cursor in a table</td>
</tr>
<tr>
<td></td>
<td><strong>Columns/Tables,</strong> <strong>2,</strong> <strong>2</strong></td>
<td>cursor not in a table; a table exists in document</td>
</tr>
<tr>
<td></td>
<td><strong>Columns/Tables,</strong> <strong>2,</strong> <strong>2,</strong> <strong>[4,7]</strong></td>
<td>cursor not in a table; a table exists in document</td>
</tr>
<tr>
<td></td>
<td><strong>Columns/Tables,</strong> <strong>[4,7]</strong></td>
<td>cursor in a table</td>
</tr>
<tr>
<td>299</td>
<td><strong>Columns/Tables,</strong> <strong>2,</strong> <strong>2,</strong> <strong>3</strong></td>
<td>cursor not in a table; a table exists in document</td>
</tr>
<tr>
<td></td>
<td><strong>Columns/Tables,</strong> <strong>3</strong></td>
<td>cursor in a table</td>
</tr>
<tr>
<td>300</td>
<td><strong>Columns/Tables,</strong> <strong>2,</strong> <strong>2,</strong> <strong>3,</strong> <strong>8</strong></td>
<td>cursor not in a table; a table exists in document</td>
</tr>
<tr>
<td></td>
<td><strong>Columns/Tables,</strong> <strong>3,</strong> <strong>8</strong></td>
<td>cursor in a table</td>
</tr>
<tr>
<td>301</td>
<td><strong>Columns/Tables,</strong> <strong>2,</strong> <strong>2,</strong> <strong>Ins</strong></td>
<td>cursor not in a table; a table exists in document</td>
</tr>
<tr>
<td></td>
<td><strong>Columns/Tables,</strong> <strong>Ins</strong></td>
<td>cursor in a table</td>
</tr>
<tr>
<td>302</td>
<td><strong>Columns/Tables,</strong> <strong>2,</strong> <strong>2,</strong> <strong>8</strong></td>
<td>cursor not in a table; a table exists in document</td>
</tr>
<tr>
<td>Value</td>
<td>Keystrokes</td>
<td>Conditions</td>
</tr>
<tr>
<td>-------</td>
<td>---------------------------------------------------------------------------</td>
<td>-------------------------------------------------</td>
</tr>
<tr>
<td>303</td>
<td>Setup,4,8</td>
<td>cursor in a table</td>
</tr>
<tr>
<td>305</td>
<td>List Files, directory, Return</td>
<td></td>
</tr>
<tr>
<td>306</td>
<td>Columns/Tables,2,1</td>
<td>cursor in a table</td>
</tr>
<tr>
<td></td>
<td>Columns/Tables,2,2,2,1</td>
<td>cursor not in a table; a table exists in document</td>
</tr>
<tr>
<td>307</td>
<td>Columns/Tables,2,2</td>
<td>cursor in a table</td>
</tr>
<tr>
<td></td>
<td>Columns/Tables,2,2,1</td>
<td>cursor in a table</td>
</tr>
<tr>
<td></td>
<td>Columns/Tables,2,2,2,2</td>
<td>cursor not in a table; a table exists in document</td>
</tr>
<tr>
<td></td>
<td>Columns/Tables,2,2,2,2,1</td>
<td>cursor not in a table; a table exists in document</td>
</tr>
<tr>
<td>308</td>
<td>Columns/Tables,2,1,4</td>
<td>cursor in a table</td>
</tr>
<tr>
<td></td>
<td>Columns/Tables,2,2,2,1,4</td>
<td>cursor not in a table; a table exists in document</td>
</tr>
<tr>
<td>309</td>
<td>Columns/Tables,2,2,Del</td>
<td>cursor not in a table; a table exists in document</td>
</tr>
<tr>
<td></td>
<td>Columns/Tables,Del</td>
<td>cursor in a table</td>
</tr>
<tr>
<td>311</td>
<td>Columns/Tables,2</td>
<td>cursor in a table</td>
</tr>
<tr>
<td></td>
<td>Columns/Tables,2,2,2</td>
<td>cursor not in a table; a table exists in document</td>
</tr>
<tr>
<td>312</td>
<td>Columns/Tables,2,2,2,3</td>
<td>cursor not in a table; a table exists in document</td>
</tr>
<tr>
<td></td>
<td>Columns/Tables,2,3</td>
<td>cursor in a table</td>
</tr>
<tr>
<td>313</td>
<td>Columns/Tables,2,2,6</td>
<td>cursor not in a table; a table exists in document</td>
</tr>
<tr>
<td></td>
<td>Columns/Tables,6</td>
<td>cursor in a table</td>
</tr>
<tr>
<td>314</td>
<td>Text In/Out,5,4</td>
<td></td>
</tr>
<tr>
<td>317</td>
<td>Columns/Tables,2,2,2,2,3</td>
<td>cursor not in a table; a table exists in document</td>
</tr>
<tr>
<td></td>
<td>Columns/Tables,2,2,3</td>
<td>cursor in a table</td>
</tr>
<tr>
<td>318</td>
<td>Columns/Tables,2,2,Move</td>
<td>cursor not in a table; a table exists in document</td>
</tr>
<tr>
<td></td>
<td>Columns/Tables,Move</td>
<td>cursor in a table</td>
</tr>
<tr>
<td>321</td>
<td>(pull-down) File, Text In, Spreadsheet</td>
<td></td>
</tr>
<tr>
<td>322</td>
<td>(pull-down) Edit,Comment</td>
<td></td>
</tr>
<tr>
<td>323</td>
<td>Columns/Tables,2,1,1</td>
<td>cursor in a table</td>
</tr>
<tr>
<td></td>
<td>Columns/Tables,2,2,2,1,1</td>
<td>cursor not in a table; a table exists in document</td>
</tr>
<tr>
<td>324</td>
<td>Columns/Tables,2,2,Move,[1,2,3]</td>
<td>cursor not in a table; a table exists in document</td>
</tr>
<tr>
<td></td>
<td>Columns/Tables,Move,[1,2,3]</td>
<td>cursor in a table</td>
</tr>
<tr>
<td>Value</td>
<td>Keystrokes</td>
<td>Conditions</td>
</tr>
<tr>
<td>-------</td>
<td>-----------------------------</td>
<td>-------------------------------------------</td>
</tr>
<tr>
<td>325</td>
<td>Columns/Tables,1</td>
<td>cursor in a table</td>
</tr>
<tr>
<td></td>
<td>Columns/Tables,2,2,1</td>
<td>cursor not in a table; a table exists in document</td>
</tr>
<tr>
<td>326</td>
<td>Format,2,7,5</td>
<td>form is [ALL OTHERS]</td>
</tr>
<tr>
<td>327</td>
<td>Format,2,7,5</td>
<td>form is not [ALL OTHERS]</td>
</tr>
<tr>
<td>328</td>
<td>Format,2,7</td>
<td></td>
</tr>
<tr>
<td>329</td>
<td>Format,2,7,2,Return,9</td>
<td>form is [ALL OTHERS]</td>
</tr>
<tr>
<td></td>
<td>Format,2,7,5,4</td>
<td>form is not [ALL OTHERS]</td>
</tr>
<tr>
<td></td>
<td>Format,2,7,5,9</td>
<td></td>
</tr>
<tr>
<td>330</td>
<td>Format,2,7,2,Return,3</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Format,2,7,5,3</td>
<td>form is not [ALL OTHERS]</td>
</tr>
<tr>
<td>331</td>
<td>Format,1,3</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Columns/Tables,2,2,6,3</td>
<td>cursor not in a table; a table exists in document</td>
</tr>
<tr>
<td></td>
<td>Columns/Tables,6,3</td>
<td>cursor in a table</td>
</tr>
<tr>
<td>333</td>
<td>List Files,directory,Return,L</td>
<td>document summary</td>
</tr>
<tr>
<td>334</td>
<td>List Files,directory,Return,L,3</td>
<td></td>
</tr>
<tr>
<td>339</td>
<td>Style,4,3</td>
<td>outline style</td>
</tr>
<tr>
<td></td>
<td>Date/Outline,6,9,[2,3],3</td>
<td></td>
</tr>
<tr>
<td>340</td>
<td>Shift-F9</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Shift-F9,6</td>
<td></td>
</tr>
<tr>
<td>341</td>
<td>Setup,1,4</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Setup,1,4,[1,2,3,5,6],[1,2]</td>
<td></td>
</tr>
<tr>
<td>342</td>
<td>Setup,1,5</td>
<td></td>
</tr>
<tr>
<td>343</td>
<td>Setup,1,6</td>
<td></td>
</tr>
<tr>
<td>344</td>
<td>Setup,3,1</td>
<td></td>
</tr>
<tr>
<td>345</td>
<td>Setup,3,3</td>
<td></td>
</tr>
<tr>
<td>347</td>
<td>Setup,2</td>
<td></td>
</tr>
<tr>
<td>348</td>
<td>Setup,2,4</td>
<td></td>
</tr>
<tr>
<td>349</td>
<td>Setup,2,6</td>
<td></td>
</tr>
<tr>
<td>350</td>
<td>Date/Outline,4</td>
<td></td>
</tr>
<tr>
<td>351</td>
<td>Columns/Tables,2,1,2</td>
<td>cursor in a table</td>
</tr>
<tr>
<td></td>
<td>Columns/Tables,2,2,2,1,2</td>
<td>cursor not in a table; a table exists in document</td>
</tr>
<tr>
<td>352</td>
<td>Columns/Tables,2,1,3</td>
<td>cursor in a table</td>
</tr>
<tr>
<td></td>
<td>Columns/Tables,2,2,2,1,3</td>
<td>cursor not in a table; a table exists in document</td>
</tr>
<tr>
<td>353</td>
<td>Columns/Tables</td>
<td>cursor not in a table</td>
</tr>
<tr>
<td>356</td>
<td>Format,2,7,2,Return,8,y</td>
<td></td>
</tr>
</tbody>
</table>

Appendix L: Macros and Merge, Value Tables
<table>
<thead>
<tr>
<th>Value</th>
<th>Keystrokes</th>
<th>Conditions</th>
</tr>
</thead>
<tbody>
<tr>
<td>358</td>
<td>Format,2,7,5,8,y</td>
<td>form is not [ALL OTHERS]</td>
</tr>
<tr>
<td>359</td>
<td>Format,1,8,t</td>
<td></td>
</tr>
<tr>
<td>360</td>
<td>Format,2,7,2,Return,7</td>
<td></td>
</tr>
<tr>
<td>361</td>
<td>Format,2,7,5,7</td>
<td>form is not [ALL OTHERS]</td>
</tr>
<tr>
<td>362</td>
<td>Graphics,5,1,2</td>
<td></td>
</tr>
<tr>
<td>363</td>
<td>Speller,2</td>
<td></td>
</tr>
<tr>
<td>364</td>
<td>Speller,2,4</td>
<td></td>
</tr>
<tr>
<td>365</td>
<td>Columns/Tables,2,2,5,3</td>
<td>cursor not in a table; a table exists in document; formula exists in cell</td>
</tr>
<tr>
<td>366</td>
<td>Columns/Tables,5,3</td>
<td>cursor in a table; formula exists in cell</td>
</tr>
<tr>
<td>367</td>
<td>Columns/Tables,2,1,5</td>
<td>cursor in a table</td>
</tr>
<tr>
<td>368</td>
<td>Columns/Tables,2,2,2,1,5</td>
<td>cursor not in a table; a table exists in document</td>
</tr>
<tr>
<td>369</td>
<td>Format,2,6</td>
<td></td>
</tr>
<tr>
<td>370</td>
<td>Style,5</td>
<td></td>
</tr>
<tr>
<td>371</td>
<td>Date/Outline,6,9,4</td>
<td></td>
</tr>
<tr>
<td>372</td>
<td>Graphics,1,1,9</td>
<td></td>
</tr>
<tr>
<td>373</td>
<td>Graphics,1,1,9,Switch</td>
<td>Contents=Equation; editing window active</td>
</tr>
<tr>
<td>374</td>
<td>Graphics,1,1,9,Switch</td>
<td>Contents=Equation; display window active</td>
</tr>
<tr>
<td>375</td>
<td>(pull-down) Mark</td>
<td></td>
</tr>
<tr>
<td>376</td>
<td>(pull-down) File,Setup</td>
<td></td>
</tr>
<tr>
<td>377</td>
<td>(pull-down) Layout,Tables</td>
<td></td>
</tr>
<tr>
<td>378</td>
<td>(pull-down) Graphics,1,1,9,Setup,3</td>
<td>Contents=Equation</td>
</tr>
<tr>
<td>379</td>
<td>(pull-down) Setup,3,3,3</td>
<td></td>
</tr>
<tr>
<td>380</td>
<td>Graphics,1,1,9,Setup,4</td>
<td>Contents=Equation</td>
</tr>
<tr>
<td>381</td>
<td>Graphics,1,1,9,Setup</td>
<td>Contents=Equation</td>
</tr>
<tr>
<td>382</td>
<td>Style,3</td>
<td></td>
</tr>
<tr>
<td>383</td>
<td>Style,4</td>
<td>not outline style</td>
</tr>
<tr>
<td>384</td>
<td>Text In/Out,3</td>
<td></td>
</tr>
<tr>
<td>385</td>
<td>List Files</td>
<td></td>
</tr>
<tr>
<td>386</td>
<td>Text In/Out,5,[1,2,3],1</td>
<td></td>
</tr>
<tr>
<td>387</td>
<td>Merge/Sort,1</td>
<td></td>
</tr>
<tr>
<td>388</td>
<td>Date/Outline,6,9,6</td>
<td></td>
</tr>
<tr>
<td>389</td>
<td>Footnote,2</td>
<td></td>
</tr>
<tr>
<td>390</td>
<td>Graphics,1</td>
<td></td>
</tr>
<tr>
<td>Value</td>
<td>Keystrokes</td>
<td>Conditions</td>
</tr>
<tr>
<td>-------</td>
<td>------------</td>
<td>------------</td>
</tr>
<tr>
<td>394</td>
<td>Graphics,2</td>
<td></td>
</tr>
<tr>
<td>395</td>
<td>Graphics,3</td>
<td></td>
</tr>
<tr>
<td>396</td>
<td>Graphics,4</td>
<td></td>
</tr>
<tr>
<td>397</td>
<td>Graphics,6</td>
<td></td>
</tr>
<tr>
<td>399</td>
<td>Graphics,1,1,9,List Files</td>
<td>Contents=Equation</td>
</tr>
<tr>
<td></td>
<td>Graphics,1,1,9,Switch</td>
<td>Contents=Equation; equation palette active</td>
</tr>
<tr>
<td>400</td>
<td>Graphics,1,1,9,Setup,2</td>
<td>Contents=Equation</td>
</tr>
<tr>
<td></td>
<td>Setup,3,3,2</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Setup,3,3,2,2</td>
<td></td>
</tr>
<tr>
<td>401</td>
<td>List Files,directory,Return,5</td>
<td></td>
</tr>
<tr>
<td>409</td>
<td>Setup,3,8,6</td>
<td></td>
</tr>
<tr>
<td>410</td>
<td>Setup,1,3</td>
<td></td>
</tr>
<tr>
<td>413</td>
<td>Setup,2,9</td>
<td></td>
</tr>
<tr>
<td>403</td>
<td>Format,4,8</td>
<td></td>
</tr>
<tr>
<td>32776</td>
<td>Home</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Home,F2</td>
<td></td>
</tr>
<tr>
<td>32780</td>
<td>Delete to End of Page</td>
<td></td>
</tr>
<tr>
<td>32790</td>
<td>Compose</td>
<td></td>
</tr>
<tr>
<td>32795</td>
<td>Esc</td>
<td>repeat value</td>
</tr>
<tr>
<td>32801</td>
<td>Search₁</td>
<td></td>
</tr>
<tr>
<td>32802</td>
<td>Help</td>
<td></td>
</tr>
<tr>
<td>32806</td>
<td>Mark Text,4,Return</td>
<td>Block on Exit,y Long Document Name=No</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>32809</td>
<td>Save</td>
<td>Long Document Name=No</td>
</tr>
<tr>
<td>32813</td>
<td>Search₁</td>
<td></td>
</tr>
<tr>
<td>32817</td>
<td>Center</td>
<td>Block on</td>
</tr>
<tr>
<td>32818</td>
<td>Print</td>
<td>Block on</td>
</tr>
<tr>
<td>32819</td>
<td>Format</td>
<td>Block on</td>
</tr>
<tr>
<td>32821</td>
<td>Retrieve</td>
<td></td>
</tr>
<tr>
<td>32824</td>
<td>Thesaurus</td>
<td>word not found</td>
</tr>
<tr>
<td>32825</td>
<td>Replace</td>
<td></td>
</tr>
<tr>
<td>32829</td>
<td>Columns/Tables</td>
<td>Block on</td>
</tr>
<tr>
<td>32833</td>
<td>Macro</td>
<td></td>
</tr>
<tr>
<td>32840</td>
<td>Text In/Out</td>
<td>Block on</td>
</tr>
<tr>
<td>32845</td>
<td>Macro Define</td>
<td></td>
</tr>
<tr>
<td>32848</td>
<td>Backspace</td>
<td>deleting code and Reveal Codes off</td>
</tr>
</tbody>
</table>

*Appendix I: Macros and Merge, Value Tables* 707
<table>
<thead>
<tr>
<th>Value</th>
<th>Keystrokes</th>
<th>Conditions</th>
</tr>
</thead>
<tbody>
<tr>
<td>32849</td>
<td>Del</td>
<td>deleting code and Reveal Codes off</td>
</tr>
<tr>
<td>32856</td>
<td>Go To</td>
<td></td>
</tr>
<tr>
<td>65027</td>
<td>Save</td>
<td>Long Document Name=Yes</td>
</tr>
<tr>
<td>65027</td>
<td>Exit,y</td>
<td>Long Document Name=Yes</td>
</tr>
</tbody>
</table>

1 The value returned corresponds to the original key pressed, not to the direction of the search. For example, if you press ♦Search, then press Down Arrow to change the search to a forward search, [SYSTEM]Menu” still returns 32813.
Appendix M: Macros and Merge, Variables

A variable represents a place in memory where data is stored. As its name indicates, the data in a variable is changeable. You might want to use variables to calculate and keep track of values and text which change during execution.

**System Variables vs. User-Defined Variables**

There are two major types of variables in Corel WordPerfect: system variables and user-defined variables. System variables are variables that Corel WordPerfect creates and maintains, and that contain information about the current state of Corel WordPerfect. You cannot change the names or contents of these variables, but you can find out and use their contents at any given time. The names and possible contents of system variables are listed in Appendix K: Macros and Merge, Programming Commands under the description of the [SYSTEM] command.

User-defined variables are variables that you create and name, and whose contents you determine. You can perform operations on these variables to change their contents. There are two sub-categories of user-defined variables: global variables and local variables.

**Global vs. Local Variables**

Global variables are accessible from anywhere inside a macro or merge.

Local variables are available only in Merge, and are stored in a separate place in memory from global variables. They are only accessible from the file in which they are created. For example, if you create a local variable named Number in a primary file, the secondary files or other primary files cannot access the information stored in it. When you nest merge files, the local variables in the parent file are not visible to the nested file. When you return to the parent file, the local variables in the nested file no longer exist, but the local variables in the parent file are once again accessible.

Local variables take precedence over global variables. For example, suppose you have both a global and local variable named Number. If you try to access the global variable Number from inside a file where the local variable Number is accessible, you will get the contents of the local variable. The global variable Number still exists, but is inaccessible until execution moves to where the local variable Number is no longer accessible (out of the merge file).

**Naming Variables**

Variables, whether local or global, must have a unique name. The name may consist of any combination of the characters in the Corel WordPerfect character sets. However, in Macros, only the first 7 letters determine uniqueness. So, in Macros, ABCDEFG and ABCDEFGH are considered by Corel WordPerfect to refer to the same variable. In Merge, however, 15 characters determine uniqueness. In Merge, ABCDEFG (7 characters long) and ABCDEFGH (8 characters long) would be considered two separate, unique variables, but ABCDEFGHJJKLMNO (15 characters long) and ABCDEFGHIJKLMNOP (16 characters long) would be considered the same variable.

Variable names are not case sensitive. Abc, AbC, ABC, and abc are all considered the same variable.
Variables receive their names when they are assigned. See Assigning Variables below for more information.

**Variable Contents**
All user-defined variables can contain text or numbers. In addition to text and numbers, global variables can also contain keystrokes. The method you use to assign variables may affect the kinds of codes, commands, and keystrokes that can be assigned to a variable (see Assigning Variables and Keystroke Commands in Variables below). A user-defined variable can only hold 129 keystrokes. A keystroke can be a character, an extended character, a keystroke command (in Macros), or a programming command.

**Assigning Variables**
You assign a global variable with the {ASSIGN} command, and a local variable with the {LOCAL} command. For example, the following two statements assign two different variables, one global, and one local:

```
{ASSIGN}Number "45"
{LOCAL}Number "36"
```

The {ASSIGN} command creates a global variable named Number and puts in “45” as its contents. The {LOCAL} command creates a separate, local variable named Number and puts in “36” as its contents. (See the description of the {ASSIGN} and {LOCAL} commands in Appendix K: Macros and Merge, Programming Commands.)

In a macro, the {ASSIGN} command can only be entered from within the Macro Editor (see Inserting Commands under Macros, Macro Editor). In a merge file, the {ASSIGN} and {LOCAL} commands are inserted from the normal editing screen by pressing Merge Codes (Shift-F9) twice, then selecting the command from the command access box (see Inserting Merge Commands under Merge).

In addition to using the {ASSIGN} and {LOCAL} commands, the following commands also assign variables:

```
{CHAR}
{FOR}
{FOR EACH}
{LOOK}
{TEXT}
```

See Appendix K: Macros and Merge, Programming Commands for a description of each of these commands.
The following rules determine whether the variable assigned by the \{CHAR\}, \{LOOK\}, and \{TEXT\} commands are local or global in a merge:

- If a local variable by the name used in the command exists, the command will assign to the local variable.
- If no local variable by the name used in the command exists, but a global variable by that name does exist, the command will assign to the global variable.
- If no variable exists by the name used in the command, a global variable of that name is created and assigned by the command.

The \{FOR\} command in Merge assigns by the same rules as above, except that if no variable exists by the name used in the command (the third rule), a local variable is created and assigned by the command. This feature allows recursion using the \{FOR\} command in Merge.

You can also assign global variables without using a command from the normal editing screen or while in macro definition mode (see Macros, Define for an explanation of macro definition mode). To assign the variable,

1. Press Macro Commands.
2. If you are in macro definition mode, a menu appears. Select Assign (3). Otherwise, skip to the next step.
3. Enter the variable name.
   You are prompted for the value.
4. Enter the variable contents.

Using this method, you can only assign characters and numbers to the variable. You can enter up to 79 characters. If the characters you enter form a valid expression (see Appendix J: Macros and Merge, Expressions), the expression is evaluated and the result is assigned to the variable.

To assign a block of existing text to the variable (from the normal editing screen or while in macro definition mode),

1. Block the text.
2. Press Macro Commands.
3. If you are in macro definition mode, a menu appears. Select Assign (3). Otherwise, skip to the next step.
4. Enter the variable name.

The first 128 characters are assigned to the variable.

When codes are encountered in the block, they are converted (if possible) to the keystroke command that would normally insert that code. For example, if the block includes a \[Tab\] code, it is converted to the keystroke command \{Tab\}.
The codes that can be converted are:

<table>
<thead>
<tr>
<th>Code</th>
<th>Converted To</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Indent]</td>
<td>Indent</td>
</tr>
<tr>
<td>![Indent•]</td>
<td>Indent</td>
</tr>
<tr>
<td>[Tab]</td>
<td>Tab</td>
</tr>
<tr>
<td>[Center]</td>
<td>Tab</td>
</tr>
<tr>
<td>[Flsh Rgt]</td>
<td>Tab</td>
</tr>
<tr>
<td>[Mar Rel]</td>
<td>Tab</td>
</tr>
<tr>
<td>[–] (Hyphen character)</td>
<td>– (dash)</td>
</tr>
<tr>
<td>– (Hard Hyphen)</td>
<td>– (dash)</td>
</tr>
<tr>
<td>[HRt]</td>
<td>Enter</td>
</tr>
<tr>
<td>[Hrt–Spgl]</td>
<td>Enter</td>
</tr>
<tr>
<td>[Dorm HRt]</td>
<td>Enter</td>
</tr>
<tr>
<td>[SRt]</td>
<td>space</td>
</tr>
<tr>
<td>[Spg]</td>
<td>space</td>
</tr>
<tr>
<td>[HPg]</td>
<td>{HPg}</td>
</tr>
</tbody>
</table>

See Keystroke Commands in Variables below for information on limitations to using variables that contain keystroke commands.

If a variable already exists, assigning new contents to it replaces the previous contents without warning.

**Executing Variables**

You can execute or write out a variable anywhere you would want its contents. For example, by executing a variable you can do the following:

- Use the contents of the variable as a subroutine.
- Insert the contents as text in a document, or in the message strings of programming commands.
- Provide variable arguments in other programming commands.

To execute a variable, you use the `{VARIABLE}` command. For example, the statement `{VARIABLE}Number˜` would execute the variable named Number.

If a global variable is named with a single-digit number (1, 2, 3, 4, 5, 6, 7, 8, 9, or 0) (see Naming Variables above), the Macro Editor allows a short-cut method of inserting the command to execute the variable in the macro. You can press Compose Quick Macro-#, where # is the number of the variable, or if you have pressed Macro Define to turn on command insert mode, just press Quick Macro-#. The command that is inserted looks like this: `{VAR #}`. This command is equivalent to `{VARIABLE}#˜`. Remember, however, that this shortcut is only available in the Macro Editor.

Another advantage of naming global variables with a single digit is that you can execute them at the normal editing screen. For example, if you are at the normal editing screen and want to know the current contents of variable 5, press Quick Macro-5. The contents are executed/written out. You cannot use this method to execute variables of other names at the normal editing screen.
Variable Duration
Local variables exist only in the file in which they are created. Once the file that created the variables is exited or the merge ends, the local variables are erased (and the memory assigned to them is released). However, the contents of global variables remain in memory until you exit Corel WordPerfect. To conserve memory, use local variables instead of global variables whenever possible.

If you want to erase a variable before Corel WordPerfect does it for you, assign the variable "nothing" by using the following commands: \{ASSIGN\} var \= \nothing or \{LOCAL\} var \= \nothing. These commands not only empty the variable of its contents, but also release the memory used by the variable. After this command, the variable no longer exists. It is a good idea to empty variables at the beginning of a macro or merge in which they are used (unless the macro or merge assigns new contents to them).

Operations on Variables
All variables can be compared to each other, and user-defined variables can have other operations performed on them. Operations are performed using various programming commands (see Appendix K: Macros and Merge, Programming Commands and Appendix J: Macros and Merge, Expressions).

Keystroke Commands in Variables
In Macros, variables are executed as keystrokes. Therefore, if in a macro you assign keystroke commands (such as \{Search\}, \{Tab\}, \{Enter\}, \{Home\}) to a variable, then execute the variable, the keystrokes will be performed.

Keystroke commands do not exist in Merge, so it is impossible to assign keystroke commands to a variable in a merge.* (You also cannot enter keystroke commands in the merge files themselves.)

However, since all variables assigned in macros are global, it is possible to execute within a merge a global variable that was assigned keystroke commands by a macro. If you do so, the keystrokes will not be executed as they would be in a macro. Instead, the character equivalents of the keystroke commands will be written out to the document.* If you are combining macros and merges and find unexpected control characters (such as ^I, ^F, ^H) or extended characters in the merged document, see that you have assigned your variables properly.

*There is one exception to this rule. When you use a \{CHAR\} command in a merge, the user can press Return at the prompt to assign the variable the keystroke command \{Enter\}. If you then execute the variable, a \{HRt\} is inserted in the resulting document. See \{CHAR\} in Appendix K: Macros and Merge, Programming Commands for more information on using the \{CHAR\} command.

See Also: Macros; Macros, Define; Macros, Execute; Macros, Macro Editor; Macros, Message Display; Merge; Appendix I; Appendix J; Appendix K
Appendix N: Pull-Down Menus

This section contains a list of the pull-down menus. Information about using the pull-down menus can be found in Pull-Down Menus.

Menu Bar

File Edit Search Layout Mark Tools Font Graphics Help

File Menu
Retrieve
Save
Text In ▶
UNIX Text (CR/LF to HRt)
UNIX Text (CR/LF to SRt)
Spreadsheet ▶
Import
Create Link
Edit Link
Link Options
Text Out ▶
UNIX Text
Generic
WP5.0
WP4.2
Password ▶
Add/Change
Remove
-----
List Files
Summary
-----
Print
-----
Setup ▶
Display
Environment
Initial Settings
Keyboard Layout
Location
-----
Go to UNIX
Exit

Edit Menu
Move (Cut)
Copy
Paste
Append ▶
To File
To Clipboard
-----
Delete
Undelete
-----
Block
Select ▶
Sentence
Paragraph
Page
-----
Tabular Column
Rectangle
Comment ▶
Create
Edit
Convert to Text
Convert Case ▶
To Upper
To Lower
Protect Block
-----
Switch Document
Window
-----
Reveal Codes
Search Menu
Forward
Backward
Next
Previous
-----
Replace
-----
Extended ▶
Forward
Backward
Next
Previous
-----
Replace
-----
Go to

Layout Menu
Line
Page
Document
Other
-----
Columns ▶
On
Off
-----
Define
Tables ▶
Create
Edit
Math ▶
On
Off
-----
Define
Calculate
-----
Footnote ▶
Create
Edit
New Number
Options
Endnote ▶
Create
Edit
New Number
Options
Placement
-----
Justify ▶
Left
Center
Right
Full
Align ▶
Indent ->
Indent -><-
Margin Rel <->
-----
Center
Flush Right
Tab Align
-----
Hard Page
-----
Styles
Mark Menu
Index
Table of Contents
List
Cross-Reference ▶
  Reference
  Target
  Both
Table of Authorities ▶
  Mark Short
  Mark Full
  Edit Full
 Define ▶
Index
Table of Contents
List
Table of Authorities
Generate
Master Documents ▶
  Expand
  Condense
Subdocument
Document Compare ▶
  Add Markings
  Remov Markings

Tools Menu
Spell
Thesaurus
 Macro ▶
  Define
  Execute
Date Text
Date Code
Date Format
Outline ▶
  On
  Off
Move Family
Copy Family
Delete Family
Paragraph Number
  Define
Merge Codes ▶
  Field
  End Record
  Input
  Page Off
  Next Record
  More
  Merge
Sort
Line Draw
Font Menu
Base Font
-----
Normal
Appearance ▶
  Bold
  Underline
  Double Underline
  Italics
  Outline
  Shadow
  Small Cap
  Redline
  Strikeout
  Superscript
  Subscript
  Fine
  Small
  Large
  Very Large
  Extra Large
-----
Print Color
-----
Characters

Graphics Menu
Figure ▶
  Create
  Edit
  New Number
  Options
Table Box ▶
  Create
  Edit
  New Number
  Options
Text Box ▶
  Create
  Edit
  New Number
  Options
User Box ▶
  Create
  Edit
  New Number
  Options
Equation ▶
  Create
  Edit
  New Number
  Options
-----
Line ▶
  Create Horizontal
  Create Vertical
-----
  Edit Horizontal
  Edit Vertical

Help Menu
Help
Index
Template
Appendix O: Startup Options

When starting from UNIX, you can enter Corel WordPerfect with any of these options:

```
wp -A
wp -a <filename>
wp -b
wp -c <number of columns>
wp -D <directory pathname>
wp -d <directory pathname>
wp -g <group name>
wp -i
wp -l <language code>
wp -m <macro name>
wp -r <number of rows>
wp -s <directory pathname>
wp -t <terminal name>
wp -u <username>
wp -x
wp <filename> <filename> ... (up to nine)
```

Any of the options can be combined.

**Combining Options**

You can combine any options in one command. The options, except the filenames, can be combined in any order. The filenames must come last in the command string. For example, you could enter the following: `wp -d <directory pathname> -m <macro name> <filename>`.

If an option requires a parameter, this option must be entered with a space and a hyphen (-) preceding it. It cannot be combined with other options behind one hyphen (as in `-dmp`). However, options without parameters can be strung together behind one hyphen.

**Notes**

- **-A**
  Makes the Auto Code Placement brackets visible. If this option is used, the Auto Code Placement brackets (`[Auto Placement]>][<<Auto Placement]`) are visible around the Paragraph and Page codes when viewed in the Reveal Codes screen.

- **-a <filename>**
  Turns on the Accounting utility to keep track of statistics such as keystrokes, CPU time used, and pages printed during the current session. A file is automatically created to hold these statistics, using the pathname specified in the parameter.

  The `<pathname>` parameter should include both the directory path and the filename. This parameter is required and has no default value. If you do not specify a full pathname with `-a`, you will not be able to enter Corel WordPerfect.

- **-b**
  Turns off backup for the current session. Both Original and Automatic Backup are turned off if this option is used.
Sets the number of columns in the window for the current session. Has the same effect as the COLUMNS environment variable, but on a temporary basis. For information on COLUMNS, see Appendix C: Environment Variables.

Sets the shared data directory pathname (shlib).

Sets the unshared data directory pathname (wpplib).

Lets you specify a name under which an editing session will be logged when the Accounting utility is running. For example, if you were tracking the hours spent on documents for law firms 1 and 2, then lawfirm1 and lawfirm2 could be group names. The group name is a name you choose to categorize records, and is not related to UNIX system groups. However, the default for -g is the UNIX group name.

Ignores, but does not delete, any settings you have established using Setup. Changes to the Setup options can be made for the current session, but will not be saved in the settings file.

Starts a version of Corel WordPerfect for the language specified, including menus, learning files, and the spelling dictionary in that language. To use a particular language, your system must have the language module (the international language files) for that language.

Though Corel WordPerfect for UNIX systems may be available in several language versions, not all versions will be available for all machines. To find out what languages are available for your machine, contact your system administrator.

The <language code> parameter is a two-letter code for the desired language. For example, the code for Swedish is sv and the code for Spanish is es.

The two-letter language codes are the same as those that set the WPLANG environment variable, which has the same effect as using -l (see Appendix C: Environment Variables for more information about WPLANG). In many cases, WPLANG may have already been set for you by your system administrator, and you would therefore not need to use -l. However, using -l will override any WPLANG setting during that session. If your WPLANG variable was sv, you could still run a Spanish session by entering wp -l es at the shell prompt.

If -l is not used, or if no parameter is given, the default is the current language setting.

Starts the specified macro as you enter Corel WordPerfect.

Sets the number of rows in the window for the current session. Has the same effect as the LINES and ROWS environment variables, but on a temporary
basis. (For information on LINES and ROWS, see Appendix C: Environment Variables.)

The default number of rows is established by the terminal definition, and varies from terminal to terminal. On most terminals the default is 24 rows.

-s <directory pathname>
Sets the setup file (wp8c.set) directory. The wp8c.set file contains startup parameters. This option lets you use a different wp8c.set file for various options (for example, default margins, timed backup, or supplementary Speller dictionaries) by creating different settings files in different directories. By default, this file is placed in your home directory.

-t <terminal name>
Starts Corel WordPerfect for the specified terminal environment.

This option has the same effect as the WPTERM8 environment variable, which is similar to the TERM environment variable used by UNIX. WPTERM8 should have been set for you by your system administrator. Using -t, however, overrides any previous WPTERM8 setting during the current session. (For more information on WPTERM8, see Appendix C: Environment Variables.)

The <terminal name> parameter is the same used to set the WPTERM8 variable. It is usually similar to the actual brand name of the terminal. For example, the terminal name (or WPTERM8 variable) for a DEC VT 220 terminal is vt220. For a complete list of supported terminal types and corresponding terminal names, see the README.trs file in the wpbin directory. (If you do not have access to the README.trs file, ask your system administrator.)

The -t option is especially useful if your terminal has the capability of emulating another terminal. For example, you may be running a vt220 in vt100 mode. However, when you run Corel WordPerfect, you may want to use the terminal in vt220 mode. You would then enter wp -t vt220 from the shell prompt.

-u <user name>
Lets you specify the user name that the Accounting utility will use in its records. If you do not use -u, the UNIX user name is the default.

-x
Deletes the settings you have established using the Setup key, and restores the original system defaults.

If your system administrator runs wp -x, the system settings file will be deleted.

<filename> <filename 2> . . . <filename 9>
Starts Corel WordPerfect and retrieves the named file(s) immediately. There must be a space between wp and the filenames in the command (you can include as many as 9 documents on the command line).
Appendix P: Corel WordPerfect Characters

More than 1500 characters are available with Corel WordPerfect. Depending on your printer, you can print some, or all, of these characters. The ability to view these characters on the normal editing screen and the View Document screen, the ability to print, and the print quality depend upon several factors described below.

If your printer can print graphics, you can print all of the characters in the character sets below. If your printer cannot print graphics, you must have a font that contains the character. Each font has a unique typeface and type weight (for example, Times Roman, or Helvetica Narrow Bold). If you don’t have a font that contains the character and your printer cannot print graphics, your printer will not print the character.

Character Entry
You insert a character in a document with Compose. Press Compose which displays a “Key =” prompt at the bottom of your screen. Type the number of the character set, a comma, and the number of the character and press Enter. For example, to enter an Ä, press Compose, then 1,30 and press Enter. You must use Ctrl-2 in the Equation and Macro Editors, search strings, and filename entry. With Ctrl-2, the “Key =” prompt is not displayed. See Compose in Reference for more information on Compose.

The Corel WordPerfect Keyboard Layout feature allows you to remap a single key or a key combination to function as a Corel WordPerfect character. You can remap the uppercase “A” to “Ä” or you can map Ctrl-a to “Ä.” See Keyboard Layout, Map in Reference for more information.

Screen Display
Not all characters can appear in the normal editing screen. When a character can’t appear in the normal editing screen, it is represented by a tilde “~” on the screen. All printable characters will appear in the View Document screen.

Printing Characters
Each table below contains the character set value (location) and a representation of how the character should appear. The Corel WordPerfect characters in this appendix were printed using the wp.drs file that ships with Corel WordPerfect.

This appendix was printed in Times Roman 10pt on a Linotronic 330 Laser Imagesetter at 1270 dots per inch (dpi). The typical laser printer achieves a maximum of 300 dpi. The print quality you experience depends on the capabilities of your printer, and on the font and point size you select. The print quality also depends on the Graphics and Text Quality settings used in Print.

When printing characters, Corel WordPerfect first uses built-in printer fonts or soft fonts to print text characters. If these fonts are unavailable, Corel WordPerfect prints the graphics characters from the wp.drs file. The Print Quality Settings are important in determining the visual appearance of graphically printed characters. The wp.drs characters print at the current...
Graphics Quality setting (Draft, Medium, or High). However, if Text Quality is set to High, the wp.drs characters print as if at the High Graphics Quality setting. When either Quality is set to Do Not Print, the wp.drs characters will not print. The Medium and Draft settings use less printer memory and print faster, but they do not look as sharp as the High setting.

A document with many wp.drs characters can take a long time to print. If the print job does not finish printing, your printer may not have enough memory for the number of wp.drs characters you are printing. The Corel WordPerfect wp.drs file may not have the exact fonts you used in your document. If you have selected different fonts, Corel WordPerfect automatically chooses the fonts most like the ones you have chosen. If you make frequent use of these wp.drs characters, you should buy some printer soft fonts. This will speed up printing at a higher quality.

You can determine which characters will print with a particular font. To do this, retrieve the charmap.tst document to the screen, select your printer, change the Document Initial Base Font to the font you want to use, then view or print the document.

Important: charmap.tst installs with the Corel WordPerfect Learn files. If you did not install the Learn files, you must do so before you can use charmap.tst. (Check with your system administrator.)

Character Sets

The character sets are shown below. Character set 12 is a user-defined set. If your printer can print characters other than the ones listed in character sets 0 through 11, you can include those characters in character set 12. To do so, you must use the Printer Program to edit the character map for a font.

For more information about the strings that send additional characters to the printer, consult your printer or soft font documentation or ask your printer or soft font manufacturer.
### Character Set 4 (Typographic Symbols)

<table>
<thead>
<tr>
<th>0</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
<th>9</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>·</td>
<td>¶</td>
<td>§</td>
<td>¡</td>
<td>¿</td>
<td>«</td>
<td>»</td>
<td>£</td>
<td>¥</td>
</tr>
<tr>
<td>1</td>
<td>¢</td>
<td>ª</td>
<td>º</td>
<td>½</td>
<td>¼</td>
<td>™</td>
<td>℠</td>
<td>™</td>
<td>℠</td>
</tr>
<tr>
<td>2</td>
<td>30</td>
<td>“</td>
<td>”</td>
<td>“</td>
<td>—</td>
<td>‹</td>
<td>›</td>
<td>†</td>
<td>‡</td>
</tr>
<tr>
<td>60</td>
<td>£</td>
<td>,</td>
<td>%</td>
<td>%</td>
<td>%</td>
<td>%</td>
<td>$</td>
<td>©</td>
<td>©</td>
</tr>
</tbody>
</table>

### Character Set 5 (Iconic Symbols)

<table>
<thead>
<tr>
<th>0</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
<th>9</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>♦</td>
<td>♠</td>
<td>♦</td>
<td>♣</td>
<td>♦</td>
<td>♦</td>
<td>♦</td>
<td>♦</td>
<td>♦</td>
</tr>
<tr>
<td>1</td>
<td>♦</td>
<td>♠</td>
<td>♦</td>
<td>♣</td>
<td>♦</td>
<td>♦</td>
<td>♦</td>
<td>♦</td>
<td>♦</td>
</tr>
<tr>
<td>2</td>
<td>30</td>
<td>©</td>
<td>©</td>
<td>©</td>
<td>©</td>
<td>©</td>
<td>©</td>
<td>©</td>
<td>©</td>
</tr>
</tbody>
</table>

### Character Set 6 (Math/Scientific)

<table>
<thead>
<tr>
<th>0</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
<th>9</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>±</td>
<td>±</td>
<td>±</td>
<td>±</td>
<td>±</td>
<td>±</td>
<td>±</td>
<td>±</td>
<td>±</td>
</tr>
<tr>
<td>1</td>
<td>÷</td>
<td>÷</td>
<td>÷</td>
<td>÷</td>
<td>÷</td>
<td>÷</td>
<td>÷</td>
<td>÷</td>
<td>÷</td>
</tr>
<tr>
<td>2</td>
<td>30</td>
<td>°</td>
<td>µ</td>
<td>×</td>
<td>×</td>
<td>×</td>
<td>×</td>
<td>×</td>
<td>×</td>
</tr>
<tr>
<td>60</td>
<td>™</td>
<td>™</td>
<td>™</td>
<td>™</td>
<td>™</td>
<td>™</td>
<td>™</td>
<td>™</td>
<td>™</td>
</tr>
<tr>
<td>90</td>
<td>™</td>
<td>™</td>
<td>™</td>
<td>™</td>
<td>™</td>
<td>™</td>
<td>™</td>
<td>™</td>
<td>™</td>
</tr>
<tr>
<td>120</td>
<td>™</td>
<td>™</td>
<td>™</td>
<td>™</td>
<td>™</td>
<td>™</td>
<td>™</td>
<td>™</td>
<td>™</td>
</tr>
<tr>
<td>150</td>
<td>™</td>
<td>™</td>
<td>™</td>
<td>™</td>
<td>™</td>
<td>™</td>
<td>™</td>
<td>™</td>
<td>™</td>
</tr>
<tr>
<td>180</td>
<td>™</td>
<td>™</td>
<td>™</td>
<td>™</td>
<td>™</td>
<td>™</td>
<td>™</td>
<td>™</td>
<td>™</td>
</tr>
<tr>
<td>210</td>
<td>™</td>
<td>™</td>
<td>™</td>
<td>™</td>
<td>™</td>
<td>™</td>
<td>™</td>
<td>™</td>
<td>™</td>
</tr>
<tr>
<td>Character Set 7 (Math/Scientific Extension)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>------------------------------------------</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
<td>5</td>
<td>6</td>
<td>7</td>
<td>8</td>
<td>9</td>
</tr>
<tr>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
<td>5</td>
<td>6</td>
<td>7</td>
<td>8</td>
<td>9</td>
<td>0</td>
</tr>
<tr>
<td>10</td>
<td>20</td>
<td>30</td>
<td>40</td>
<td>50</td>
<td>60</td>
<td>70</td>
<td>80</td>
<td>90</td>
<td>100</td>
</tr>
<tr>
<td>110</td>
<td>120</td>
<td>130</td>
<td>140</td>
<td>150</td>
<td>160</td>
<td>170</td>
<td>180</td>
<td>190</td>
<td>200</td>
</tr>
<tr>
<td>210</td>
<td>220</td>
<td>230</td>
<td>240</td>
<td>250</td>
<td>260</td>
<td>270</td>
<td>280</td>
<td>290</td>
<td>300</td>
</tr>
</tbody>
</table>

Appendix P: Corel WordPerfect Characters 725
Important: Most printers and soft fonts support only a part of the Greek character set. Those printed characters may not match the appearance of the Greek fonts from the wp.drs file. If you are printing Greek text, it is likely that your printouts will use a combination of printer fonts and wp.drs fonts.

Character Set 9 (Hebrew)

Character Set 10 (Cyrillic)
### Character Set 11 (Hiragana and Katakana)

<table>
<thead>
<tr>
<th>0</th>
<th>0</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
<th>9</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 あいえうえおえうえおえうえおえうえ</td>
<td>0 ひ へ ほ ほ ほ ほ ほ ほ ほ</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>30 せ せ せ せ せ せ せ せ せ せ</td>
<td>30 の ほ ほ ほ ほ ほ ほ ほ ほ ほ</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>60 べ べ べ べ べ べ べ べ べ べ</td>
<td>60 ん わ わ わ わ わ わ わ わ わ</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>90 ん わ わ わ わ わ わ わ わ わ</td>
<td>90 ン わ わ わ わ わ わ わ わ わ</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>120 ん わ わ わ わ わ わ わ わ わ</td>
<td>120 ン わ わ わ わ わ わ わ わ わ</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>150 ん わ わ わ わ わ わ わ わ わ</td>
<td>150 ン わ わ わ わ わ わ わ わ わ</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>180 ん わ わ わ わ わ わ わ わ わ</td>
<td>180 ン わ わ わ わ わ わ わ わ わ</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Character Set 12

Character Set 12 is a user-defined character set.
Appendix Q: NROFF/TROFF Convert Program

The NROFF/TROFF Convert program converts files formatted in NROFF or TROFF format to Corel WordPerfect format. As much of the text format as possible is preserved during conversion.

To use the convert program,

1. Change to the directory that contains the files you are converting. The Corel WordPerfect executable files directory (wpbin) must be in your path.

2. Enter `cvtroff -h <input filename> <output filename> <format #>` at the shell prompt. (See Notes below for a description of each option.)

All NROFF/TROFF conversions allow number and string register declarations and references, macro definitions, and references with the source document. As much as possible, standard read-only registers are also maintained. However, because of differences in file formats, some features may be lost during the conversion process.

Notes

- **-h Startup Option**
  When you use the -h startup option, cvtroff displays a help screen describing the command syntax and file format types.

- **Input Filename**
  Name of the file to be converted. This must be an NROFF/TROFF file and must be located in the current directory.

- **Output Filename**
  Name of the converted file. This file will be in Corel WordPerfect format and will be placed in the current directory.

- **Format #**
  Number representing the input file format. Use the following table to determine the correct number.

<table>
<thead>
<tr>
<th>Format #</th>
<th>Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>TROFF Primitives Only</td>
</tr>
<tr>
<td>2</td>
<td>NROFF/TROFF with MS Macros</td>
</tr>
<tr>
<td>3</td>
<td>NROFF/TROFF with ME Macros</td>
</tr>
</tbody>
</table>

**Primitives Only** • TROFF Primitives Only interprets the formatting codes in the source document as TROFF "primitives" while ignoring all macro calls to macros not defined in the source document.

**NROFF/TROFF with MS Macros** • NROFF/TROFF with MS Macros allows you to convert an NROFF/TROFF document that includes embedded -MS macro calls.

**NROFF/TROFF with ME Macros** • NROFF/TROFF with ME Macros allows you to convert an NROFF/TROFF document that includes embedded -ME macro calls.

See Also: Convert Program
Glossary / Index
ASCII
American Standard Code for Information Interchange is one of the standard formats for representing characters. It is useful when files are shared between programs. A text file is in ASCII format.

Baud
The rate of speed (referred to as baud rate) at which information is sent between two computer devices. It sends files to serial printers or across modems.

Bit
A binary digit is the smallest storage unit for data in a computer.

Buffer
A temporary data storage area used by computers and some printers.

Byte
The amount of space needed to store a single character (number, letter, or code). A byte generally represents eight binary digits (bits). For example, if a character requires one byte of storage space, that one byte is translated to eight bits when processed in the computer. 1024 bytes equals one kilobyte (K).

Default Directory
The directory where files are saved to or retrieved from when you enter a filename (no pathname). It can be viewed by pressing List, then Return.

Defaults
The startup settings for Corel WordPerfect. The defaults can be changed temporarily, but are reset each time the program is started. To change defaults permanently, use Setup.

Delimiter
Most commonly refers to a character or code that marks the beginning or end of an item such as a sentence, paragraph, page, record, or field. Also used in "dynamic delimiter" to refer to a character that expands to enclose part of an equation.

Diacritic
A mark added to a letter to indicate a specific phonetic value.

Digraph
Two letters written, and usually sounded, as a single character. A ligature.

Driver
A set of commands that run peripheral devices. For example, Corel WordPerfect’s .prs files are drivers that run the printer.

Fixed-Pitch Fonts
Fonts can be separated into two categories: fixed-pitch fonts (mono-spaced) and proportionally spaced fonts. Fixed-pitch fonts allocate the same amount of space to each character in the font (the i takes up as much horizontal space as the w).
Font
A specific typeface, point size, and weight (for example, 10pt Helvetica Bold).

Kilobyte (K)
1024 bytes of information or storage space.

Megabyte (M)
1024 kilobytes (1,048,576 bytes) of information or storage space.

Memory
A computer's temporary data storage area.

Mono-Spaced Fonts
See Fixed-Pitch Fonts above.

Output
The information produced by the computer.

Parallel Interface
An interface in which several bits of information (usually 1 byte) are transmitted at the same time.

Parallel Printer
A printer that accepts information by way of a parallel interface.

Pathname
A full pathname includes the root, subdirectory names, and the filename (if applicable). Each name is separated by a slash (/). For example, /wp51 refers to the wp51 directory, while /wp51/test refers to the test subdirectory (or file) in the wp51 directory.

Point Size
Points are the unit of measure used to measure font sizes. Corel WordPerfect uses the standard point size (72 points per inch).

Port
A connection device between a computer and another component such as a printer or modem. For example, a printer cable is plugged into the parallel printer port on the computer so information can be sent to the printer.

Proportionally-Spaced Fonts
Proportionally-spaced fonts vary the amount of space given to characters in the font (the letter i usually gets less space than w).

Scrolling
Moving through a document that is longer or wider than your screen.

Serial Interface
An interface in which information is transmitted one bit at a time.

Serial Printer
A printer that accepts information from the computer by way of a serial interface.
Soft Font
A font file located on media or in a directory. When the printer is switched on, soft font files must be copied (downloaded) from the external media, or from a directory, to the printer’s memory.

String
A sequence of characters. For example, you enter a string of characters or codes when using Search.

Syntax
The way certain elements are organized in an operation. For example, equation and macro commands require a specific syntax or organization to function properly.

System Administrator
A person in charge of maintaining your terminal, system printers, and the programs running on it.

Toggle
A feature or key that is turned on or off with the same keystroke. If the feature or key is on, pressing the keystroke turns off the feature or key. If the feature or key is off, pressing the keystroke turns on the feature or key.

Typeface
A style of type, such as Courier.

Unary
An operator that applies to a single element, as opposed to a binary operator.

Weight
The appearance of a character in a typeface (for example, bold).
Index

| (Comment) 595
~ (tilde) 127
• 512

A

.ALL file 224, 269, 382, 384, 390, 403, 432
convert 391
print 394
retrieve 390
[ALT letters] 594
[ASSIGN] 291, 586, 588, 594, 596, 710
Absolute tabs 482
Account, document 100
Action
keyboard layout 229
sort 433, 435
Add
column to end of table 501
paper size/type 359, 364
printer definition 383, 384
row to end of table 501
table column 492, 501
table row 486, 492
text to end of file 24
word 441, 446
words to hyphenation dictionary 453
Added text
mark 93, 414
redline 93
Addition 509
macros 586
math 307, 312, 314, 509
merge 586
Additional, printers 383
Address, file 318
Advance 21, 334
and graphics images 22
and kerning 21
and line height 21
cursor 21
paper in printer 376, 409
AFC 400
Algorithmic, dictionary 453
Align
equation 111
equation variable 128
existing text 221
multiple lines of text 221
table 500
table cell 504, 505
text 144
text vertically 476, 478
text with left and right margins 222
text with left margin 222
text with right margin 222
Alignment
character 334, 478
equation 215
Alphabeticize
block 433
document 432
lines 432-436
paragraphs 432, 434, 436
table of authorities 160, 512
text 432
Alt key, and keyboard layout 227
Alt-macros 279, 280, 282, 283
Amount of note to keep together 154
Anchor type, graphics box 170
AND
macros 586, 589
merge 586, 589
Antonyms 525
Append
and Move 24
block 24
graphics box 25
page 24, 327
paragraph 24, 327
rectangle 24, 25, 311
sentence 24, 327
tabular columns 24, 25, 333
text 24, 327
to clipboard 163, 272
to file 24
to locked file 24
Arabic, page numbers 356
Arrow
down 78
equation 119
left 77
line draw 250
right 77
up 77
ASCII
convert from WordPerfect 5.1 69, 521-523
save 521-523
Assign
attributes 400, 401
characters to keys 225
feature to key 225, 228, 232
font to attribute 54, 148, 217, 400, 401
to landscape orientation 400, 402
to portrait orientation 400, 402
font to WordPerfect characters 398, 402
function key 229, 235
key 67, 225, 228, 232
macro to key 231
variables 275, 281
WordPerfect characters to key 229, 234
Asterisk, wildcard character 141
Attribute 25
add to existing text 27
and base font 26
and block 39
and printing 26, 27
appearance 25, 26
assign font 54, 148, 217, 401
display 54
in macro prompts 291
in table 486, 503, 504
modify 400, 401
not printing 27
printer program 400, 401
table column 504
test 148
Attributes, assign font 400
Author, document 97, 99
Auto
format 425
height/width 176
rewrite 425
Automatic
display pitch 88
font changes 394, 400
indexing 207
line height 254
outline 335
Automatically
adjust to current level, paragraph number 342
format and rewrite 425
Auxiliary files 267
Available slots, cartridges 45
Average, math 313

B
[BELL] 592, 595, 597
[Block Append] 595, 598
[Block Copy] 595, 599
[Block Move] 595, 599
[BREAK] 592, 593, 600
Background, printing 403
Backspace 86
Backslash 86
Backup
directory 268
document 32, 104, 268, 426
file 32, 104, 268, 426
location of file 31, 32
original 104
retrieve 31, 32
timed 32, 104
Banner, print 377
Bar code 33
Base font 45, 96, 146
and attributes 26
document 146
initial 96
labels 243
landscape 148
Name Search 148
portrait 148
printer 146
spreadsheet 459
test 148
Baseline 253
and line height 387
placement for typesetters 254, 387
Beep
on error 36, 105
on hyphenation 36, 105
on search failure 36, 105
Beep options 35, 105
Begin
field 322
record 322
string 591
Bin number 358, 362, 432
Bin paper 359, 362, 431
Binding 36, 377
duplex 361
left 361
reset 38
top 38, 361
Binomial, equation 128
Bitmap images 180
Bitwise operation 589
BK! file 30
Black and white, graphics 166, 179
Blank line
at top of page 421
count 256
Block
alphabetize 433
and attributes 39
and bold 39
and justification 222
append 24, 329
cancel 39, 42
copy 329
cursor movement in 39
cut 329
delete 39, 84, 329
move 39, 329, 498
paste 329
print 373
protect 40
redefine 40
retrieve 40, 420
save as file 40
save to clipboard 163
search 429
short cut keystrokes 331
sort 432, 433
spell-check 441, 442
spreadsheet 457, 462
text 17, 38
Block protect
and conditional end of page 41, 69
codes 41
parallel columns with 62, 64
Bold 27, 129
table 503
Border
draw 250
graphics box 168, 191
Border options 191, 334, 545
Border space, graphics box 192
Border style, graphics box 191
Bottom, margin 299
Box
anchor type 170
and columns 175
and lists 168
and margins 175
border style 191
bump 170, 171, 177
caption 171
caption number style 191
caption position 193
change definition 172
change type 168
character type 171
comments 90
contents 172
default settings 170
define 168, 170
delete contents 174
distance from top of paragraph 193
draw 250, 427edit 168, 172, 178
equation 168
figure 168
fixed position 170
graphics 166, 170
gray shading 192
height 176
horizontal position 174
initial settings 192
inside border space 192
level numbering methods 192
minimum offset from paragraph 177, 193
move 170, 171
number 168, 169, 171
options 168, 190
overlap 171, 178
page type 170
paragraph type 170
retrieve equation 174
set height 176
set width 176
shading 192, 375
size 175
skip pages 170
superimpose text 178
table 168
three-dimensional 191
type 168
user 168
vertical position 176
width 176
Box contents
equation 173
graphic 173
graphic on disk 173
text 174
Brackets, pull-down menus 412
Break
line 420
pages 352
Buffer
printer 219, 376, 409
storing text in 328
table move 499
temporary 328
Built-in
fonts 45
safety features 136
bulk mailings 33
Bullet format
outline 343
paragraph numbers 343
Bump, graphics box 170, 171, 177

C

[CALL] 592, 602, 672
[CANCEL OFF] 594, 603
[CANCEL ON] 594, 603
[CASE CALL] 586, 592, 605, 672
[CASE] 586, 592, 603, 672
[CHAIN MACRO] 592, 594, 607, 666, 670
[CHAIN PRIMARY] 592, 607, 666
[CHAIN SECONDARY] 592, 608, 666
[CHAIN] 592, 594, 606, 666
macros 606
[CHAR] 289, 291-294, 592, 594, 609, 669, 670
[COMMENT] 595, 610
[CTON] 611
Calculate
math 307, 508
math formulas 307, 508
Calculation columns, math 306, 309-311
Calculation order, math 312
Can be loaded/unloaded during print job
font 44, 47
print wheel 44, 47
Cancel 13, 42
and help 42
and Reveal Codes 42
block 39, 42
changes to keyboard layout 230, 233
error message 42
graphics changes 179
hyphenation 201
macro 42, 284
macro editing 286
merge 322
print job 218, 375, 409
search 42, 142
spell-checking 442
Cannot rotate fonts, printer 408
Capital letters, spell-check 441, 443
Capitalization 43, 475
and replace 416
and search 428
errors 441, 443
Caps lock 43
Caption
and replace 418
graphics box 171, 191
Caption number style, graphics box 191, 193
Cartridge
mark 45, 46
present when print job begins 44, 48
quantity 48
Cartridges, available slots 45
Cartridges and fonts 44, 381
Case checking, disable 444
Case conversion 43, 475
Cell
alignment 504, 505
attributes 503
format 502-504, 506
join 496
justification 503
numeric 504
shading 497, 499
split 501
table 484, 487
text 504
unlock 504
width 505
Center
and dot leaders 52
existing text 52
justification 50, 51, 222
line 50
remove 52
several lines of text 51
Center page 49, 354
and endnotes 50
and footnotes 50
and hard returns 50
Center text 50
and center page 50
at a specific position 51
between margins 222
horizontally 50
in columns 52
on labels 238
on page 354
over tab stop 52
vertically on page 49
Chain, macros 279, 666
Change
comment to text 92
default directory 86, 258, 262
directory 86
line draw character 250
line spacing 257
Character
.DRS 379, 380, 403, 405
alignment 334, 478
assign to keys 225
combine 350
create 65
decimal 334
delete 85, 416
display 65
extended 65
graphic 379, 405
graphics box 171
Greek 120
hard return 102
hyphenation 201
international 351
line draw 250
mapping 67, 393
overstrike 350
per line 88
print 67
printable 405
repeat 217, 414
screen 65
sets 65
symbols 118
thousands' separator 334
view 65
width 87
wildcard 141, 450
WordPerfect 121, 379, 398, 402, 405
Character box
horizontal position 174
outside border space 171, 193
vertical position 176
Character(s), sets 721
Characters, WordPerfect 721
CHARMAP TST 400, 722
Clean
screen 13
screen program 423
Clip art 569
Clipboard
and Merge 318, 326
append to 163, 272
retrieve from 163
retrieve graphics from 181
save graphics to 181
save to 163, 272
Close
document 135
file 135
menu 136
WordPerfect 135
Code 15
and cursor movement 77
default 212, 216, 419, 426
delete 82, 84, 416
initial 212, 216, 426
invisible 157
language 203, 244
link 460
printer command 385
replace 82, 416
search for 82, 428
Code page 718
Codes 545
Color
assign to attribute 54
create 374
display 54edit 374
graphics 403
intensity 374
on-screen 375
printer dependent 374
printing 374
reset 375
screen 54
text 374
Colors/Fonts/Attributes 54
Column
and comments 91
and page type box 175
append tabular columns 24, 25, 333
calculation 306, 310, 311
center text in 52
continuous 57, 64
copy tabular columns 331
cursor movement in 56
cut tabular column 331
define 58
display 56, 87, 89
display side-by-side 103
format and rewrite 56
labels 237
margins 59, 63
math 306, 310
movement 59
newspaper 57
newspaper vs. parallel 59, 64
number of 59
numeric 306, 310, 314
off code 62
on code 60
on-screen display 56
parallel 61
parallel with block protect 62, 64
printing 57
script 61
side-by-side 56
size 63
snaking 57
spreadsheet 458
text 306, 310, 314
titles 308, 310, 314
off code 62
on code 60
on-screen display 56
parallel 61
parallel with block protect 62, 64
printing 57
script 61
size 63
snaking 57
spreadsheet 458
text 306, 310, 314
titles 305, 307, 314
Type 58
Column types, math 306, 308, 310
Combine
attributes 55
characters 350
dictionaries 453
documents 300, 318
files 300, 318
text 24
Comma operator 141
Command
equations 110, 117, 119, 126
macro 287
merge 326
printer 385, 389
Command insert mode 288
Command(s)
macro 592
merge 592
Comment
and columns 91
and cursor movement 91
and newspaper columns 91
and parallel columns 91
and text 91, 92
box 90
change to text 92
display 90, 92, 102
document 90edit 91
hide 92
in macros 281
print 92
Comment(s) in macros 610
Compare
documents 92, 414
phrases 94
screen and disk documents 92
undo 94
Complementary color, graphics 180
Compose 65, 119, 234, 721
and keyboard layout 229
and overstrike 351
Compress
dictionary 453
master document 302
Concordance 208, 209
create 209
mark text 210
sort 210
Condense, master document 302
Conditional end of page 67, 334
and block protect 41, 69
and line spacing 69
Conditions
find 98, 140, 142
reset 143
search 142
Contents
delete from graphics box 174
equation box 168
graphics box 172
Context-sensitive help 199
Continue, print job 409
Continued message 155
language 245, 247
Continuous, paper size/type 362
Control, printer 218, 406
Control printer 409
Convert
ALL files 391
.PRS files 391
codes 82, 84, 417
directory 83, 86
document 83, 258, 261
diagrams 83, 86
endnotes 83, 258, 261
equation 112
file 258, 261
footnotes 150
graphics box contents 174
hard return 421
keyboard layout 226
line 85, 415
line draw 251
link 461
marked files 261, 263
multiple documents 261, 263
multiple files 83
newspaper columns 59
outline family 339
page 85, 327
paper size/type 358, 361, 364
paragraph 327
paragraph numbers 366
parallel columns 64
printer definition 382, 384
rectangle 331
redline 414
sentence 327
strikeout 414
style 469
style library 469
thesaurus/spell/hyphenation 270
Dictionary
add words 452
algorithmic 453
compress 453
correct 4.2 to 5.1 454
delete words 454
directory 270
edit 451
edit words 447
external 202
full 442
hyphenation 106, 202, 447
international 448
language 448
main 270
non-US 448
not found 442
optimize 455
personal 449
speller 441, 442, 444, 446, 449,
452
supplementary 270, 442, 449, 452,
453
Digraphs 65, 66
Directory 85, 258, 419
backup files 268
change 86, 258, 262
create 85
current 258, 263
default 85, 268, 410
delete 83, 86
dictionary 270
display files 272, 273
document 268
graphics 173, 174, 268
hyphenation 270
keyboard/macros 225, 269
look 272
macro 269, 279, 282, 283
organize 85
other 262
parent 258
printer files 269
root 86
search 139, 142
speller 270
style 270
style library 270
Disk
print to 410
space 260
Disk and screen documents, compare 139, 142
Display
attributes 54
characters 65, 721
codes 82, 424
colors 54
columns 56, 87, 89
columns side-by-side 103
comments 90, 92
document 258, 261
document comments 102
equation 110
filename on status line 102
files 86, 258, 261, 272, 273
font 54
indent 87
long document names 105
macro 281
macro messages 289
macro prompts 289
menu 430
merge codes 102, 325
negative numbers 499, 511
pull-down menus 411, 412
setup 89
submenus 413
tab settings 479
window in equation editor 108, 110
WordPerfect characters 65
Display card 54
Display pitch 87, 96
automatic 88
manual 88
Division 312, 509
macros 586
math 312
merge 586
Document
account 100
alphabetize 432

740  Index
appearance 157
assembly 318
author 97, 99
backup 32, 104, 268, 426
base font 146
combine 300, 318, 320
comments 90
compare 92, 414
conversion 69, 95
copy 258, 261
create 16
delete 258, 261
description 99
differences 92
directory 268
display 258, 261
document 146
erase 136
exit 135
fast save 139
filename 102
find 97, 140
format 96, 157, 405
information 97
keep 426
keywords 100
landscape 359, 361, 363, 406
load 418
locate 270
long name 100, 105
look 258, 261, 272
mark 261-263
master 300
merge 318, 320
move 261
multiple 427
name 426
name search 262
not formatted for current printer 
371
options 96
organize 258
portability 359
preview 405
print 18, 258, 262, 370, 373
rename 258, 261
replace 136, 426
retrieve 258, 262, 418
revision date 99, 260
save 18, 105, 136, 139, 426
search 100, 143, 261, 264
size 260
sort 432
spell-check 441
store 258, 426
subject 100
switch 474
two-sided 36
type 100, 105, 260, 264
typist 99
unmark 263
Document 1 474
attributes 55
exit 137, 475
Document 2 474
attributes 55
exit 137, 475
Document screen appearance 102
options 102
Document summary 97, 99, 105
automatic subject 105
create 98
create on save/exit 105
delete 98
document type 105
edit 98
find 139, 143
look at text 273
next document 274
previous document 274
print 100, 262, 274, 370
save 100
search 143
subject search text 105
view 273
Document summary summary, save to file
274
Dormant
hard return 421
tab codes 477
DOS
and WordPerfect 163
file 410
print 410
temporarily exit to 163
DOS text 318, 322
DOS text file 262, 264, 521
export 521, 522
field delimiters 216, 322
import 521, 523
merge 318, 322
merge delimiters 216
record delimiters 216, 322
retrieve 521, 523
save 521-523
Dot leader
and center 52
and flush right 145
and tabs 481
table of authorities 514
Double
 sided printing 361, 406
spacing 252, 257, 423
underline 26
Double word 441, 443
Double-high, font 380
Down arrow 78
Downloadable fonts 44, 45, 219
location 381
path 381
Draft, quality 380
Draw
borders 250, 427
box 250, 427
graph 250
lines 250, 427
DrawPerfect 181
Driver, resource file 379, 405
Duplex
binding 361
printing 361, 406
E
{ELSE} 592, 614
{END FIELD} 615, 670
{END FOR} 592, 616
{END IF} 592, 616
{END RECORD} 319, 324, 616, 670
{END WHILE} 593, 616
Edit
comments 91
date/time format 79, 247, 249
document 16
document summary 98
document type 105
endnote 150
equation 108, 179
figure 179
foot 197
footnote 150
footnotes 174, 178
graphics 168, 178
graphics box 168, 178
graphics box definition 172
graphics lines 188
header 197
hyphenation dictionary 453
index 160, 208
initial base font 381
keyboard layout 226, 228, 235
language resource file 246
link 461
lists 160, 265, 267
macros 280, 285, 286
menu 714
multiple documents 474
newspaper columns 58
overstrike 350
paper size/type 358, 360, 361, 364
paragraph numbers 366
parallel columns 62
print color 374
printer definition 382, 384
search string 417
speller dictionary 451
style 465, 470
style codes 471
table of authorities 160, 519, 521
table structure 491
words in dictionary 447
[ALL OTHERS] 360

Edit-screen
appearance 102
options 102

Editing window, equation editor 108, 109

Editor
equation 108, 116, 119, 172, 179
graphics 172, 173, 179
text 172, 174

End
field 322
line 420
link 460
record 322
string 591
subdoc 304

Endnote
and center page 50
and graphics box 153
and master documents 303
and replace 418
appearance 153
create 149
cross-reference 76
delete 150
edit 150
generate 152, 159, 160
location 152
note numbering method 155
numbering 150
options 153
placement 152, 159, 160
regenerate 160
renumber 153
spacing within and between 156
style for number in note 156
style for number in text 156
Endnote placement, generate 159, 160
Enhanced BIOS, and keyboard 576
ENHANCED.WPK 576
Enter
in style 470
macro editor 286
outline style 348
printer commands 385
Envelopes 358
bar codes 33
Environment
menu 430
setup 104
Equal
macro comparison 587
merge comparison 587
Equation 107
. (period) 126, 130
\ (backward accent) 127
\ (left brace) 127
^ (right brace) 127
^ (SUP) 135
# (pound sign) 126, 132, 134
& (ampersand) 126, 131
\ (backslash) 127
accents 121
align 111
align matrix 131
ALIGNC 128
ALIGNL 128
alignment 215
ALIGNR 128
and hard returns 109, 124
appearance 110-114
arrows 119
bar above 132
bar below 132
BINOM 120, 122, 128
binomial 128
BOLD 129
box 168
circle characters 119
commands 110, 117
commands structure 126
commands syntax 126
delete 112
delimiters 120
diacritics 121
display 110
DOTSAXIS 122
DOTSAXIS 122
DOTSDIAG 122
DOTSLOW 122
DOTSVERT 122
dynamic operators 120
edit 108
editor 107, 126
e llipises 121
enlarge 111, 113
font 112, 113
format 110-114
fractions 132
fraktur letters 124
FROM 122, 129
FUNC 125, 129
functions 120
graphic characters 113, 114
graphics box 107, 168, 173
Greek characters 120
grouping 121, 127
hollow characters 119
HORIZ 124, 129
incorrect format 110
initial settings 215
intersection symbols 125
ITAL 130
italicize 130
keyboard 112
keyword 117
large characters 121
LEFT 120, 130, 132
left align 130, 132
limits 129, 134
literal character 127
MATHFORM 131
mathematical 116, 126
MATRX 132
menu 117, 126
NROOT 120, 132
Nth root 132
numbers 119
operators 120
options 215
order 122, 126
other characters 121
OVER 120, 122, 126, 128, 132
OVERLINE 132
OVERSM 133
palette 117, 126
PHANTOM 133
placeholder 133
position 111, 114, 215
precedence 122
primes 123
print 112-114
print as graphics 113, 114, 215
print characters 113, 114
reduce 111, 113
renumber 107
retrieve 115
retrieve in graphics box 174
RIGHT 120, 130, 132
right align 130, 132
roots 122
save 116
set characters 124
size 110, 113
small fractions 133
solid characters 119
space 109, 118, 124, 127
SQRT 120, 133
square characters 119
STACK 130, 133
STACK command 109
STACKALIGN 134
structure 116, 126
SUB 122
subgroup 126
subscripts 113, 122
SUP 122, 135
superscripts 113, 122, 135
switch window 110
symbols 110, 118, 125
syntax 116, 126
text 116
TO 122, 129
triangle characters 119
UNDERLINE 135
union symbols 125
user-defined functions 125, 129
variables 113, 118, 126
VERT 124, 129, 135
view 110
Equation editor 108, 116, 126, 172, 173, 179
display window 108, 110
editing window 108, 109
equation palette 108, 110
Equation palette, equation editor 108, 110
EQUATION.WPK 577
Equation(s), keyboard 577
Erase

codes 82
file 83
line draw 251
text 84
Error

beep 36, 105
messages 36
Escape 78
Excel

import 456
link 460
retrieve 458
Execute

macros 275, 283
variable 713
Exit

and create document summary 105
and save 427
document 135
file 135
reveal codes 425
WordPerfect 15, 18, 135
Expand, master document 303
Export

DOS text file 521-523
spreadsheet 460
Expression evaluation

macros 588
merge 588
Expression(s)

macro 586
merge 586
negative numbers 590
order of precedence 588
parentheses in 589
terms 589
Extended

characters 65
replace 418
External hyphenation dictionary 106, 202

F

[FIELD NAMES] 617
[FIELD] 324, 617, 670
[FOR EACH] 586, 593, 619

[FOR] 586, 593, 618
Family

copy 339
delete 339
move 339
Fast save 105, 139, 371
Feature

assign to key 225, 228, 232
help 199
mnemonic selection 15, 317
repeat 217, 415
Field

begin 322
delimiter 216, 322
delimiter 216, 322
sort 434, 436, 437
Figure 166
edit 178
graphics box 168
Figure boxes, and lists 265, 266
File

address 318
append to 24
backup 32, 104, 268, 426
combine 300, 318, 320
convert 69
copy 31, 32, 258, 261
create 261, 426
delete 83, 258, 261
directory 85
display 86, 258, 261
DOS text 262, 264
driver resource 379, 405
exit 135
find 139, 142, 261, 263
font 44, 45, 381
graphics image 173
keyboard 269
language resource 245
list 86, 258, 259, 263, 371
load 418
locate 139, 142, 267
locked 260, 263, 270
look 258, 261, 272
macro 269, 275, 279, 282
mark 83, 261-263
mark and delete 83
move 261
name search 262
nest 300
organize 85, 258, 267
overwrite 426
primary 318, 320
appearance 146
assign attribute 54, 148, 217, 400, 401
base 96, 146
bold 26
built-in 45
can be loaded/unloaded during print job 44, 47
cartridges 44, 381
categories 44, 46
default 146
display 54
document base font 146
download 45, 404
equation 112, 113
file 44, 45, 381
graphics 192
groups 44, 46
header 197
initial 96, 146
landscape 148, 361, 362, 402, 404, 408
line draw 250
load 47
mark 44, 46
maximum number 47
menu 717
mono-spaced 250, 255
normal 146
orientation 402, 407
outline 26
point size 146
portrait 148, 362, 381, 402, 408
present when print job begins 44, 48
printer base font 146
programs 49
proportionally-spaced 250, 255
quantity 47, 48
redline 26
rotate 360-362, 404, 408
screen 54
size attribute ratios 217
soft 44, 219, 376
style 26
swap 48
text 148
type 361, 362
typeface 146
underline 26
unload 47, 376
Font libraries, copy 391
Footer 196, 354
and margins 300
and page numbers 198, 357
create 196
discontinue 198
disposition 197
even pages 198
every page 198
exit 197
font 197
location 197
number allowed 198
odd pages 198
placement on page 197
print 198
suppress 197, 199
Footnote
amount of note to keep together 154
and center page 50
and graphics boxes 153
and margins 300
and master document 303
and replace 418
appearance 153
continued message 155, 245, 247
create 149
delete 150
edit 150
line separating text and footnotes 154
location 153, 154
new number 153
note numbering method 155
numbering 150, 153
options 153
placement 153
print continued message 155
renumber 153
spacing within and between 156
start footnote numbers each page 153
style for number in note 156
style for number in text 156
Force, odd/even page numbering 156, 354
Format
auto 425
date 79, 215
default 212
document 96, 158, 405
equation 110-114
graphics 185
index 212
G

[GO] 593, 620, 672
Generate
  cross-references 73, 159
  endnote 152
  endnote placement 159
  index 159
  lists 159
  master document 303
  table of authorities 159, 161
  table of contents 159
Global
  replace 418
  select 440
  variables 709
Go (start printer) 218, 409
Go to 78, 161
  columns 161
  graphics editor 179
  previous position 162
  shell 162
Go to DOS 163
Grand total function 315, 511
GRAPHCNV.EXE 164
Graphic on disk 173
  graphics box contents 173
Graphic(s) images 569
Graphical font size, equation 113
Graphics
  % change 180
  advance 22
  and merge 323
  and suppressing page numbers 473
  bitmap images 180
  black and white 166, 179
  box 166, 170
  cancel changes 179
  color 403
  conversion 164
  create 166
  directory 173, 174, 268
  display complementary color 180
  edit 174, 178
  end of file 165
  enlarge image 181
  equation box 107
  file on disk 173
  filename 168, 174
  files 182, 268
  font 192
  formats 164, 185
  image on disk 173
  invert on/off 180
  line drawings 180
  menu 717
  mirror image 181
  move image 180
  options 190, 375
  print 167, 192, 378-380, 403
  programs 182
  quality 378, 379, 405, 406
  reduce image 181
  reposition image 180
  retrieve from clipboard 181
  rotate image 180
  save 181
  save to clipboard 181
  scale image 181
  screens 193
  styles 173, 465
  supported programs 182
  text 182
  vector images 180
  WordPerfect graphics format 164, 181
Graphics box 166, 268
  anchor type 170
  append 25
  attach to paragraph 170
  auto height/width 176
  border style 191
  borders 168, 191
  bump 170, 171, 177
  caption 171
  caption number style 191
  caption position 193
  captions and replace 418
  change definition 172
  change type 168
  character type 171
  columns 175
  contents 172
  contents, equation 173
  contents, graphic 173
  contents, graphic on disk 173
  contents, text 174
  define 168, 170
  delete contents 174
  distance from top of paragraph 177, 193
  edit 168, 178
  endnotes 153
  equation 168
  figure 168
  fixed position 170

Index 745
gray shading 192
height 176
horizontal position 174
initial settings 192
inside border space 192
level numbering methods 192
lists 168, 265-267
location 170
margins 175
minimum offset from paragraph 177, 193
move 170
new number 169
number 171
numbering 168, 169, 192
overlap 171, 178
page type 170
paragraph type 170, 193
position 170
retrieve equation 174
set height 176
set width 176
settings 192
shading 192
size 175
skip pages 170
spreadsheet 460
superimpose 178
table 168
three-dimensional 191
type 168
user 168
vertical position 176
width 176
wrap text around box 177
Graphics card 54
Graphics characters 379, 405, 721
equation 113, 114
Graphics conversion program 164
startup options 166
Graphics editor 172, 173, 179
Graphics lines 187, 251
edit 188
gray shade 188, 189
horizontal 187, 188
horizontal position 188, 189
length 189, 190
line height 189
margins 188, 189
shade 188, 189
vertical 187, 189
vertical position 189, 190
width 189, 190
Graphics screen type 193
Gray shading
graphics box 192, 375
horizontal graphics lines 188
table 497, 499
vertical graphics lines 189
Greater than
macro comparison 587
merge comparison 587
Greek
characters 120
equation 120
Group
files 85
font 44, 46
Grouping equations 121, 127

H
Hard decimal align tab 478, 483
Hard hyphen 201
Hard left tab 483
Hard page break 352
Hard return 258, 420
and equations 109, 124
display character 102
dormant 421
leading 388
spacing 422
Hard right tab 145, 483
Hard space, and hyphenation 196
Hard tab 483
Header 196
and replace 418
create 196
discontinue 198
edit existing 197
even pages 198
every page 198
exit 197
font 197
location 197
long display 260
margins 300
number allowed 198
odd pages 198
page numbers 198, 357
print 198
row 496
suppress 197, 199
Height
graphics box 176
label 237
line 253
paper 363
Help 11, 13, 16, 199
and cancel 42
cancel-sensitive 199
file 200
on-line 199
on-screen 199
printer 383, 384
printer program 392
Hide, comments 92
Highlight, text 17, 38
Home key 17, 77
Horizontal lines 187, 188
and margins 189
gray shade 188
horizontal position 188
length 189
line height 189
vertical position 189
width 189
Horizontal measurements 476
Horizontal position
color type box 174
graphics box 174
horizontal lines 188
page type box 175
paragraph type box 175
vertical lines 189
Hyphen
hard 201
location 205
position 205
soft 202
Hyphen (-) 201
Hyphenation 106, 201, 252, 270
alternatives 201
and justification 205, 222
assistance 203
beep 36, 105
cancel 201
color 201
character 201
internal rules 106
keep words together 196
manual 203
non-US 334, 448
off 204
prompt 106, 202
region 204
rules 106, 202
zone 204
Hyphenation dictionary 106, 202

746  Index
Index

b

add words 452
edit 453
external 202
Hyphenation directory 270
Hyphenation zone 203, 204

[IF BLANK] 593, 622
[IF EXISTS] 593, 594, 623
[IF NOT BLANK] 593, 623
[IF] 593, 621
[INPUT] 325, 592, 624, 669, 670
[Item Down] 595, 624
[Item Left] 595, 625
[Item Right] 595, 625
[Item Up] 595
Illustrations 569
Import, DOS text file 521, 523
Incorrect
date 81
time 81
Incorrect format, equations 110
Indent 206
and tab stops 207
and tabs 477
display 87
from margins 206
left and right margins 206
left margin 206
right margin 206
text 206
Index
alphabetize 210
and master document 208, 211, 303
concordance 208, 209
create 159, 207
define 207, 211
deadend 160, 208
format 212
generate 159
headings 208, 210
location 159, 207, 211
mark text 208, 210
number type 212
numbering options 212
page numbers 355
regenerate 159, 207
subdocuments 211
subheadings 207, 210
Initial base font 96, 146
eat 381
printer 146
Initial codes 212, 216, 426
after retrieving document 419
document 96, 213
existing documents 214
labels 214
merge 214, 323
retrieve 419
setup 96
Initial settings 13, 212, 214, 426, 430, 572
date format 215
equation 215
graphics box 192
left and right margins 299
menu 431
print options 216
redline method 216
repeat value 217
Table of Authorities 217
Initialize, printer 45, 219, 376, 403
Input file, sort 432, 433, 436
Inside border space, graphics box 192
Install 12
Interrupt, printing 409
Invalid
drive/path specification 269
numeric expression 587
string expression 588
Invert on/off 180
Invisible, soft return 202
Irregular case
replace 444
skip 444
speller 443
ISRt 202
Italize, equations 130
Italics 26
Job number 376
Join
lines 67
table cells 496
words 196
Justification 221, 252
block 222
center 222
full 222
hyphenation 205, 222
left 222
multiple lines of text 221
right 145, 222
search 223
tables 223, 503, 505
tabs 476, 483
word spacing 223, 389

K

[KEY MACRO n] 594
[KEYBOARD] 325, 592, 626, 670
[KTON] 627
values returned 675
KERN.TST 224
Kerning 224, 388
advance 21
printers 224
table 224, 393
test file 224
Key
assign 228, 232
function 14
macro 230, 235
map 228, 231
retrieve macro 231
save assignment as macro 232
sort 435, 437
Key assignment 67, 225
Key: action screen 229, 235
Keyboard
definitions 228, 576
directory 269, 279, 282
enhanced 576
equation 112, 577
files 269
macro 578
merge 325
shortcut 579
Keyboard layout 225
action 229
Alt-macros 227
cancel changes 230, 233
compose 229, 234
copy 225
create 225
delete 226
description 230
edit 226, 228, 235
macro editor 229, 235
macros 226, 227, 275
map 67, 227, 231, 232, 721
menu 431
name search 227, 236
original 227, 236
rename 227
Keyboard mapping 225
and macros 275
Keyboard/macro, directory 225
Keyboard/Macro directory 269
KeyG 440
Keystrokes 13, 199
Keyword
document 100
equations 117

L
.LRS file
and date 259
and list files 259
[LABEL] 593, 628
[LEN] 594, 628
[LOCAL] 594, 629, 710
[LOOK] 592, 594, 629, 670
Labels 236, 362
bar codes 33
center text 238
change base font 243
distance between 238
height 237
information needs to be updated for page size 239
initial codes 214
logical page 240
margins 238
merge 236, 240, 318
number 237
number of lines 243
paper size/type 236
physical page 240
print 241
size 237
top left corner 237
tractor-fed 242
type text 243
width 237
will not fit on paper size 239
LABELS.WPM 239
Language
Landscape
document 359, 361, 363, 406
font 148, 361, 362, 402, 404, 408
printing 359, 362, 363, 404, 406
spreadsheet 459
Language 334
code 203, 244
date 81
date format 245, 247
dictionary 448
footnote continued message 245, 247
foreign 243
macro 287
non-US 243
package 248
programming 592
sort by 245
WordPerfect 244
Language resource file 245
edit 247
Large 28
equation 121
Laser printer
margins 299
sheet feeder 382, 431
Laser printers, margins 300
Layout
keyboard 225
menu 715
Leading
adjustment 254, 388, 422
hard return 388
primary 388
second 388
soft return 388
Learning, about WordPerfect 199
Left
binding 361
hyphenation zone 204
justification 222
Left and right margins 298
indent 206
initial settings 299
Left arrow 77
Left margin 37, 253, 298
align text 222
indent 206
ragged 222
Left tab 483
hard 483
Legal format
outline 343
paragraph numbers 343
Length
horizontal lines 189
vertical lines 190
Less than
macro comparison 587, 588
merge comparison 587, 588
Letter pairs 224
spacing 388
Letter spacing 224
Letterhead, paper 358
Letters
lowercase 475
uppercase 475
Level
of paragraph number 338, 366
table of contents 518-520
Level numbering methods, graphics box 192
Library
clipboard 163, 272
shell 162, 318, 326
Library style 270, 467
Line
alphabetize 432, 434, 435, 437
appearance 252
between paragraphs 422
breaks 422
center 50
count 256
count blank lines 256
delete 85
double spacing 258
fixed height 253
format 158, 252
graphics 251
horizontal position 188, 189
indent 206
join 67
leading 254
length 189, 190
line height 189
margins 188, 189
restart numbering 257
separating pull-down menu bar from text 317
shade 188, 189
single spacing 258
sort 432, 434, 435, 437
start numbering 257
table 497
typeover 527
vertical position 189, 190
width 189, 190
Line draw 250, 427
arrows 250
characters 250
delete 251
erase 251
font 250
mono-spaced font 250
<table>
<thead>
<tr>
<th>programming language</th>
<th>229, 236, 275, 280</th>
</tr>
</thead>
<tbody>
<tr>
<td>pull-down menu</td>
<td>412</td>
</tr>
<tr>
<td>repeat</td>
<td>283</td>
</tr>
<tr>
<td>replace</td>
<td>279, 286</td>
</tr>
<tr>
<td>size</td>
<td>289</td>
</tr>
<tr>
<td>spaces in</td>
<td>287</td>
</tr>
<tr>
<td>stop</td>
<td>279</td>
</tr>
<tr>
<td>style</td>
<td>467</td>
</tr>
<tr>
<td>variables</td>
<td>275, 281</td>
</tr>
<tr>
<td>Macro commands key</td>
<td>281, 287</td>
</tr>
<tr>
<td>Macro editor</td>
<td>285</td>
</tr>
<tr>
<td>keyboard layout</td>
<td>229, 235</td>
</tr>
<tr>
<td>rapid entry</td>
<td>285</td>
</tr>
<tr>
<td>Macro expressions</td>
<td>586</td>
</tr>
<tr>
<td>Macro messages</td>
<td>and [DISPLAY OFF] 295</td>
</tr>
<tr>
<td></td>
<td>and Reveal Codes 297</td>
</tr>
<tr>
<td>Macro programming commands</td>
<td>287</td>
</tr>
<tr>
<td>name search</td>
<td>288</td>
</tr>
<tr>
<td>MACRO.WPK</td>
<td>578</td>
</tr>
<tr>
<td>Macro(s)</td>
<td>addition 586</td>
</tr>
<tr>
<td></td>
<td>and merge 582</td>
</tr>
<tr>
<td></td>
<td>assign variables 664, 710</td>
</tr>
<tr>
<td></td>
<td>differences with merge 582</td>
</tr>
<tr>
<td></td>
<td>division 586</td>
</tr>
<tr>
<td></td>
<td>expression evaluation 588</td>
</tr>
<tr>
<td></td>
<td>global variable 709</td>
</tr>
<tr>
<td></td>
<td>keyboard 578</td>
</tr>
<tr>
<td></td>
<td>multiplication 586</td>
</tr>
<tr>
<td></td>
<td>negative value 586, 590</td>
</tr>
<tr>
<td></td>
<td>similarities with merge 582</td>
</tr>
<tr>
<td></td>
<td>subtraction 586</td>
</tr>
<tr>
<td></td>
<td>system variable 709</td>
</tr>
<tr>
<td></td>
<td>text expressions 587</td>
</tr>
<tr>
<td></td>
<td>user-defined variable 709</td>
</tr>
<tr>
<td></td>
<td>variables 664, 709</td>
</tr>
<tr>
<td>Macro/Keyboard directory</td>
<td>269, 279, 282, 283</td>
</tr>
<tr>
<td>MACROCNV.EXE</td>
<td>276</td>
</tr>
<tr>
<td>mailing labels</td>
<td>33, 236, 323, 358, 362</td>
</tr>
<tr>
<td>mailings, mass</td>
<td>35</td>
</tr>
<tr>
<td>Manual</td>
<td>hyphenation 203</td>
</tr>
<tr>
<td></td>
<td>paper size/type 362</td>
</tr>
<tr>
<td>Manual printing</td>
<td>358</td>
</tr>
<tr>
<td>Map</td>
<td>227, 231, 232</td>
</tr>
<tr>
<td>characters</td>
<td>67</td>
</tr>
<tr>
<td>function key</td>
<td>229</td>
</tr>
<tr>
<td>keyboard</td>
<td>67, 225</td>
</tr>
<tr>
<td>keys</td>
<td>228, 232</td>
</tr>
<tr>
<td>Margin</td>
<td>baseline placement 300</td>
</tr>
<tr>
<td></td>
<td>bottom 299</td>
</tr>
<tr>
<td></td>
<td>center text between 50, 222</td>
</tr>
<tr>
<td></td>
<td>columns 59, 63</td>
</tr>
<tr>
<td></td>
<td>footers 300</td>
</tr>
<tr>
<td></td>
<td>footnotes 300</td>
</tr>
<tr>
<td></td>
<td>headers 300</td>
</tr>
<tr>
<td></td>
<td>horizontal lines 189</td>
</tr>
<tr>
<td></td>
<td>indent 206</td>
</tr>
<tr>
<td></td>
<td>labels 238</td>
</tr>
<tr>
<td></td>
<td>left 253, 298</td>
</tr>
<tr>
<td></td>
<td>left and right 298</td>
</tr>
<tr>
<td></td>
<td>measurement 299</td>
</tr>
<tr>
<td></td>
<td>page type box 175</td>
</tr>
<tr>
<td></td>
<td>parallel columns 63</td>
</tr>
<tr>
<td></td>
<td>ragged left 222</td>
</tr>
<tr>
<td></td>
<td>ragged right 222</td>
</tr>
<tr>
<td></td>
<td>right 253, 298</td>
</tr>
<tr>
<td></td>
<td>right and left 298</td>
</tr>
<tr>
<td></td>
<td>set tabs relative to 482</td>
</tr>
<tr>
<td></td>
<td>settings in Reveal Codes 298</td>
</tr>
<tr>
<td></td>
<td>spreadsheet 459</td>
</tr>
<tr>
<td></td>
<td>temporary 206</td>
</tr>
<tr>
<td></td>
<td>text not printed in 300</td>
</tr>
<tr>
<td></td>
<td>top 299</td>
</tr>
<tr>
<td></td>
<td>top and bottom 299</td>
</tr>
<tr>
<td></td>
<td>vertical lines 189</td>
</tr>
<tr>
<td>Margin release</td>
<td>485</td>
</tr>
<tr>
<td></td>
<td>outline 336, 339, 342, 344, 350, 546</td>
</tr>
<tr>
<td></td>
<td>paragraph numbering 342, 366</td>
</tr>
<tr>
<td>Margins, left and right</td>
<td>37</td>
</tr>
<tr>
<td>Mark</td>
<td>added phrases 93</td>
</tr>
<tr>
<td></td>
<td>added text 414</td>
</tr>
<tr>
<td></td>
<td>both reference and target 72</td>
</tr>
<tr>
<td></td>
<td>cartridge 44, 46</td>
</tr>
<tr>
<td></td>
<td>delete files 83, 84</td>
</tr>
<tr>
<td></td>
<td>deleted phrases 93</td>
</tr>
<tr>
<td></td>
<td>deleted text 414</td>
</tr>
<tr>
<td></td>
<td>documents 261-263</td>
</tr>
<tr>
<td></td>
<td>files 83, 261-263</td>
</tr>
<tr>
<td></td>
<td>font 44, 46</td>
</tr>
<tr>
<td></td>
<td>moved phrases 93</td>
</tr>
<tr>
<td></td>
<td>moved text 93</td>
</tr>
<tr>
<td></td>
<td>print wheel 44, 46</td>
</tr>
<tr>
<td></td>
<td>reference only 73</td>
</tr>
<tr>
<td></td>
<td>target only 74</td>
</tr>
<tr>
<td></td>
<td>text 414</td>
</tr>
<tr>
<td>Mark entries, concordance</td>
<td>210</td>
</tr>
<tr>
<td>Mark text</td>
<td>generate 159</td>
</tr>
<tr>
<td></td>
<td>index 208, 210</td>
</tr>
<tr>
<td>lists</td>
<td>264, 266</td>
</tr>
<tr>
<td></td>
<td>table of authorities 512, 515</td>
</tr>
<tr>
<td></td>
<td>table of contents 518, 520</td>
</tr>
<tr>
<td>Marked files</td>
<td>copy 261, 263</td>
</tr>
<tr>
<td></td>
<td>delete 261, 263</td>
</tr>
<tr>
<td></td>
<td>move 261, 263</td>
</tr>
<tr>
<td></td>
<td>print 262, 263</td>
</tr>
<tr>
<td>mass mailings</td>
<td>33</td>
</tr>
<tr>
<td>Master document</td>
<td>74, 300</td>
</tr>
<tr>
<td></td>
<td>compress 302</td>
</tr>
<tr>
<td></td>
<td>cross-reference 303</td>
</tr>
<tr>
<td></td>
<td>endnote 303</td>
</tr>
<tr>
<td></td>
<td>expand 303</td>
</tr>
<tr>
<td></td>
<td>footnote 303</td>
</tr>
<tr>
<td></td>
<td>generate 303</td>
</tr>
<tr>
<td></td>
<td>index 208, 211, 303</td>
</tr>
<tr>
<td></td>
<td>list 265, 303</td>
</tr>
<tr>
<td></td>
<td>numbering 302, 303</td>
</tr>
<tr>
<td></td>
<td>page numbering 302, 303</td>
</tr>
<tr>
<td></td>
<td>save 304</td>
</tr>
<tr>
<td></td>
<td>style 467</td>
</tr>
<tr>
<td></td>
<td>table of authorities 303, 513</td>
</tr>
<tr>
<td></td>
<td>table of contents 303, 518</td>
</tr>
<tr>
<td>Math</td>
<td>304, 334, 507</td>
</tr>
<tr>
<td></td>
<td>addition 307, 312, 314, 509</td>
</tr>
<tr>
<td></td>
<td>average 313</td>
</tr>
<tr>
<td></td>
<td>calculate 307, 508</td>
</tr>
<tr>
<td></td>
<td>calculation columns 306, 309, 311</td>
</tr>
<tr>
<td></td>
<td>calculation formulas 309-311</td>
</tr>
<tr>
<td></td>
<td>calculation order 312</td>
</tr>
<tr>
<td></td>
<td>column types 306, 310</td>
</tr>
<tr>
<td></td>
<td>columns 305, 306, 310</td>
</tr>
<tr>
<td></td>
<td>decimal character 306, 307, 309, 310, 316, 503, 504</td>
</tr>
<tr>
<td></td>
<td>decimal numbers 306, 307, 309, 310, 316, 503, 504</td>
</tr>
<tr>
<td></td>
<td>decimal places 307, 310, 503, 504</td>
</tr>
<tr>
<td></td>
<td>define columns 306, 308</td>
</tr>
<tr>
<td></td>
<td>definition menu 306, 309, 311</td>
</tr>
<tr>
<td></td>
<td>division 312, 509</td>
</tr>
<tr>
<td></td>
<td>edit formula 313</td>
</tr>
<tr>
<td></td>
<td>extra subtotal 316</td>
</tr>
<tr>
<td></td>
<td>extra total 316</td>
</tr>
<tr>
<td></td>
<td>formulas 311, 509</td>
</tr>
<tr>
<td></td>
<td>fractions 313</td>
</tr>
<tr>
<td></td>
<td>functions 307, 314, 510</td>
</tr>
<tr>
<td></td>
<td>grand total 315, 511</td>
</tr>
<tr>
<td></td>
<td>in tables 304, 489, 507</td>
</tr>
<tr>
<td></td>
<td>multiplication 312, 509</td>
</tr>
<tr>
<td></td>
<td>negative numbers 316, 511</td>
</tr>
<tr>
<td></td>
<td>numbers 307, 310, 314, 316</td>
</tr>
<tr>
<td></td>
<td>numeric columns 306, 310, 313</td>
</tr>
</tbody>
</table>
off 305, 308
on 305, 306
operators 312
order of operation 312
row titles 306, 307, 314, 316
subtotal 305-307, 310, 314, 510
subtraction 312, 509
syntax 307, 312, 314, 509
tab align 305, 306, 309, 503
tab stops 305
text columns 306, 310, 314
thousands separator 309
titles 305, 307, 314, 316
total 305-307, 311, 315, 511
total columns 306, 311, 314
Mathematical
equations 107, 116, 126, 168
functions 120
Maximum width, [ALL OTHERS] 360
Memory, available for font 45, 47
Menu
appearance 316
back out of 42
cancel 42
equation 117, 126
icon 413
letter display 317
look 274
mnemonics 317
mouse 411
options 15, 316, 412
printer program 393
pull-down 14, 411
sort 433, 435, 439
tab set 479
user-defined 275, 289
Menu bar 412
letter display 317
pull-down menus 317
remains visible 317
separator line 317
text appearance 317
Merge 318, 320
addition 586
and macros 582
cancel 322
clipboard 318, 326
contracts 318
convert 326
delimiters 216
differences with macros 582
display 326
dividers 216
division 586
expression evaluation 588
from keyboard 325
global variable 709
graphics 323
initial codes 214, 323
labels 236, 240, 318
letters 318
local variable 709
mail 318
memos 318
multiplication 586
negative value 586, 590
phone lists 318
POSTNET bar codes 323
programming commands 326, 592
similarities with macros 582
subtraction 586
system variable 709
text expressions 588
user-defined variable 709
Merge codes 592
display 102
Merge commands 326, 592
Merge comparison
equal 587
greater than 587
lesser than 587, 588
not equal 587
Merge expressions 587
Message
cancel 42
error 36
hyphenation 36
not found 36
Method, redline 97, 216
Microsoft Excel
link 460
retrieve 458
Microsoft Word 4.0
convert to WordPerfect 5.1 69
Minimum offset from paragraph,
graphics box 177, 193
Minus sign, math 310
Mirror image, graphics 181
Misspelled word 441, 445
Mnemonics
menus 317
pull-down menu bar 317
pull-down menus 317
Monitor 54
Mono-spaced fonts 254
line draw 250
Month 80
Month/Day names 80
Mouse
interface 411
menus 411
pull-down menus 411
Move
append 24
block 329
cursor 16, 77, 161
document 261
file 261
from column to column 161
graphics box 170, 171
graphics image 180
key assignment 231
marked files 261, 263
multiple documents 261, 263
options 328
outline family 339
page 327, 329
paragraph 328
rectangle 330
sentence 328
table 489, 498
table column 331, 498
table row 498
text 327, 363
text by using block 329
text without using block 328
to previous position 162
Move buffer, for table 499
Multiple copies
generated by network 378
generated by printer 378
generated by WordPerfect 378
print 378
Multiple documents 427
copy 261, 263
delete 261, 263
duplicate 378
exit 475
move 261, 263
print 262, 263
Multiple lines of text, flush right 145
Multiple pages, print 371, 373
Multiplication 509
macros 586
math 312
merge 586
Multiply, numbers 312
N
[NEST MACRO] 593, 594, 666
[NEST PRIMARY] 593, 634, 666, 670
[NEST SECONDARY] 593, 635, 666
[NEST] 593, 594, 635
[NEXT] 593, 594, 635
[NEXT RECORD] 319, 324, 636, 670
[NEXT] 593, 594, 635
[NTOC] 636
[NTOK] 637
values returned 675

Name
base font 148
descriptive 259, 262
directory 85
document 419, 426
drive 86
file 136, 419, 426
long document 100, 105, 137
macros 279, 282, 283
outline style 347
printer 381
style 468
target 76

Name search
base font 148
document 262
file 262
keyboard layout 227, 236
macro programming commands 288
printer 383
style 465

negative numbers
display 310, 511
display in table 499
expressions 590
minus sign 310
parentheses 310

Negative value
macros 586, 590
merge 586, 590

Nest
documents 300
files 300
macros 280, 282
outline styles 348
style 465

New number
footnote 153

graphics box 169
New page number 356
New supplementary dictionary 444
Newspaper columns 57
and comments 91
and table 486
cursor movement in 59
define 58
deleting 59
distance between 58
document summary 274
document appearance 356
document appearance 274
look 272, 274
Non-US
dictionary 448
language 243
Normal editing screen
appearance 102
options 102
Normal font 146

Number
add text to page number 357
and header 357
Arabic 356
bin 432
cross-reference 76, 355
equation 107, 119
graphics box 171
ignore 446
in table columns 504
index 355
insert page number 356
lines 252, 256
math 307, 310, 314, 316
new page number 356
of columns 59, 64
of copies 377, 378
of labels 237
of lines to keep together 68
of parallel columns 64
of words 450
page 354, 355
page number and footer 357
page number position 356
page number style 357
page number type 356
paragraph 364, 367
print job 376
repeat 415
restart line numbering 257
Roman numerals as page numbers 356
sort 436, 438
start line numbering 257
suppress page numbering 357
table 486
table of authorities 355
table of contents 355
turn off page numbers 357
turn on page numbers 357

Numbering
and master document 302, 303
boxes 168, 169
endnotes 150, 152, 153
footnotes 150, 153
graphics boxes 168, 169, 192
lines 256
Numbering formats
outline 343
paragraph numbering 343
Numbering levels, paragraph 338
Numbering style
index 212
lists 266
table of authorities 515
table of contents 520

Numeric
math columns 306, 310, 314
sort 438
table cell 504

Numeric comparison
macro 586
merge 586
Numeric expression, invalid 587
Numeric values
macros 586
merge 586

O
[ON CANCEL] 593, 594, 638, 673
[ON ERROR] 593, 594, 640, 673
[ON NOT FOUND] 593, 594, 641, 673
[ORIGINAL KEY] 592, 594, 642
[OTHERWISE] 593
Office, shell 162
Open
existing files 418
outline style 348
second editing screen 474
style 464, 468, 469, 471
Operators
and find 141
dynamic 120, 126
equation 120
math 312, 509
Optimize dictionary 455
Option 15
document 96
equation 141
endnotes 153
equation 215
find 142
footnotes 153
graphics 190, 194
menu 316, 412
move 328
printer 216
pull-down menus 412
select 15
table 499
Options
beep 35
graphics box 168
print 377
Order of operation, math 312, 310
Organize
directories 85
documents 258
files 85, 258, 267
secondary records 319
Orientation
font 402, 408
paper type 364
Original
backup 104
keyboard layout 227, 236
Orphan 253
Other
equation 118
format 158, 334
Other characters
equation 121
line draw 250
Other directory 262
Other disk, printer files 383
Outline
and paragraph numbering 340, 367
and tabs 477
appearance 341, 346
attach previous level 342
attribute 26
automatically adjust to current level
bullet format 343
center lines 343
define 341
Enter inserts paragraph number 343
format 341, 346
generic format 343
lowercase Roman/digits format 343
margin release to previous level 336, 339, 342
numbering format 343
off 340
on 340
renumber 344
Roman numerals 343
tab to next level 339, 341, 342
type text 341
uppercase Roman/digits format 343
user-defined format 343
Outline family
copy 339
delete 339
move 339
Outline number, cross-reference 76
Outline style 270, 346, 466, 468, 471
and styles 346, 349
change to style 346
codes 348
creat 347
Enter key 348
name 347
nest 348
open 348
paired 348
retrieve 348
save 349
type 348
Output file, sort 433, 436
Outside border space, character box 171, 193
Overlap, graphics box 171, 178
Overlapping, text 52
overstrike 335, 350
and compose 351
edit 350
Overwrite file 426

P

[PAGE OFF] 642
[PAGE ON] 643
[Para Down] 595, 643
[Para Up] 595, 644
[PAUSE KEY] 592, 645, 670
[PAUSE] 592, 644, 670
[PRINT] 645, 670
[PROCESS] 593, 646
[PROMPT] 592, 646, 669, 670
Package, language 248
Page
appearance 353
append 24, 327
center 49
cut 327
delete 85, 327
delimiter 25, 328
divide 352
even numbers 354
footer 196
force odd/even 156
format 158, 353
graphics box 170
hard 352
header 196
limit 329
move 327, 329
number 354, 355
odd numbers 354
paste 327, 329
print 370-373, 403
renumber 356
retrieve 328
separate 352
soft 352
spell check 441
start line numbering on 257
start new page 352
suppress format 354
Page box
and columns 175
and margins 175
horizontal position 174
vertical position 176
Page break
and tab 490
delete 353
hard 352
protect text 40
soft 352
Page format
suppress 472
turn off 354

Page number
adding text to 357
and cross-references 355
and footers 198, 357
and headers 198, 357
and indexes 355
and lists 355
and master document 302, 303
and print 371
and table of authorities 355
and table of contents 355
Arabic 356
cross-reference 76
even 156, 354
insert 356
new 356
odd 156, 354
position on page 356
Roman numerals 356
suppress 357
type 356
with text 357

Page numbering
and force odd/even page numbering 156
start 356
turn off 357
turn on 357

Pages to skip, graphics box 170
Paired outline style 348
Paired style 464, 465, 470, 471
Pairs of letters 224
Palette
equation 116, 126
equation editor 108, 110
Paper
advance in printer 376, 409
bins 359, 362, 431
height 362
sheet-fed 362, 431
size 354, 358, 359, 361, 362, 364
tray 359, 362
type 354, 358, 359, 363, 364
width 362
Paper definition, prompt to load 218
Paper size/type 358, 405
add 359, 364
code 359, 408
continuous 362
copy 361
define 358, 359
delete 358, 361, 364
edit 358, 360, 361, 364
insertion edge 359, 363, 408
labels 236
landscape 359
location 359, 360, 362
manual 362
prompt to load 360, 363
select 358, 361, 364
sheet-fed 431
text adjustment 363
tractor-fed 362
[ALL OTHERS] 359, 364
Paper type, orientation 364

Paragraph
alphabetize 432, 434, 436
append 24, 327
copy 327
cut 327
delete 327
delimiter 25, 328
graphics box 170
move 327, 328
paste 327, 328
retrieve 328
sort 434

Paragraph box
horizontal position 175
vertical position 176

Paragraph number 337, 340
and outline 340, 347
appearance 341, 346, 365
attach previous level 342
automatically adjust to current level 342
bullet format 343
cross-reference 76
define 341
definition menu 340
delete 366
edit 366
format 341, 343, 346
legal format 343
levels 338, 364
lowercase Roman/digits format 343
margin release to previous level 342, 366
number 364, 367
renumber 344
Roman numerals 343
tab to next level 342, 366
uppercase Roman/digits format 343
user-defined format 343

Password
protect 270
remove 271

Path
downloadable fonts 381
printer command file 386
printer commands 381
soft fonts 381
Pathname 86, 381
and retrieve 419

Pattern
cursor movement 78
filename 260, 273
find 141
search 141
words 446, 450
Pause, macros 281

Percentages, print color 374
Perform
search with find 143
spreadsheet import 457
spreadsheet link 461
Perform action, sort 433, 435
Personal, dictionary 449
Phonetic, look up 441, 446, 456
Phrase
compare 94
present when print job begins 44, 48
quantity 48
unload 48
Printer
.ALL file 382, 390, 394, 403
.PRS file 382, 390, 394, 403
additional 383
and font 44, 146, 149
and kerning 224
buffer 219, 376
built-in fonts 45
can rotate fonts 408
cannot rotate fonts 408
cartridges 44
commands 385, 389
control 218, 406, 409
definition list 383edit 380
file 27, 28, 224, 382, 384, 403
filename 384
format 379
functions 335, 385, 386
help 383, 384
information 403
initial base font 146
initialize 45, 219, 376, 403
list files 269
name 381
name search 383
not found 384
port 382, 410, 411
print multiple copies 378
print wheels 44
reset 386
resource file 403
restart 218
select 377, 378, 382, 384, 403, 432
troubleshooting 406, 410
Printer command
codes 385
erase 385
file 385
insert 385
location 381
path 381, 386
text 386
Printer definition
add 383, 384
copy 382, 384
delete 382, 384
edit 382, 384
program 390
restore 383, 384
update 382, 384
Printer drivers 269
Printer file 269
copy 391
directory 269
error 391
list 383
not found 44, 432
other disk 383
Printer format 262
Printer name, edit 381
Printer program 390
attributes 400, 401
automatic font changes 394
character maps 393
cartridge 391
drop 392
kerning tables 393
list files 393
proportional spacing tables 393
sheet feeders 393
startup options 394
substitute fonts 395, 398
typefaces 393
Printer resource file 382, 384, 394, 403, 432
Printer settings, edit 380
PRINTER.TST 27, 148
Printing 403
and attributes 26
background 403
cancel 375
columns 57
double-sided 361, 406
duplex 361, 406
from DOS 410
interrupt 409
landscape 359, 362, 363, 404, 406
portrait 404, 406
quit 375
stop 219, 375, 409
two-sided 406
Printing to disk 410
Program
covers 242
help 199
soft font 49
Programming, language 229, 236
Programming commands
macro 287, 592
merge 326, 592
Prompt
for hyphenation 106
hyphenation 202
user-defined 275
Prompt for hyphenation
always 202
never 203
when required 203
Prompt to load
paper definition 218
paper size/type 360, 363
Proportional spacing
and tabs 476
tables 393
Proportionally-spaced font 255
and line draw 250
Protect
block 40
file 270
text 40, 67
widow/orphan 253
PRS.ERR 390
PTR Program 390
PTR.EXE 390
Pull-down menu 14, 411, 714
and macros 412
brackets 412
display 411
icon 413
letter display 317
mnemonics 317
options 412
select 412
submenu 413
text appearance 317
Pull-down menu bar
letter display 317
mnemonics 317
remains visible 317, 412
separator line 317
text appearance 317
Q
{QUIT} 593, 646, 670
Quality
graphics 378, 379, 405, 406
print 379, 405
settings 380
text 379, 380, 405, 406
Quantity
cartridge 48
font 47, 48
Index 757
file 258, 262, 418
from clipboard 163
from list files 419
into existing document 419
locked file 271, 420
Lotus 1-2-3 458
macro to key 231
non-WordPerfect file 420
outline style 348
page 328
paragraph 328
PlanPerfect 458
Quattro 458
Quattro Pro 458
read-only 420
sentence 328
style 466
style library 467
table column 498
table row 498
text from temporary buffer 328

Return
hard 258, 420
invisible soft return 202
soft 258, 420

Reveal codes
and delete 84
and macro messages 297
cancel 42
editing in 425
exiting 425
screen 424
screen size 103
window size 103

Reversed, text 375

Revision date
document 260
file 260
find 143
search 143

Rewrite
auto 425
columns 56
screen 102, 425, 427
text 425

Right
hyphenation zone 204
margin 37, 253, 298
move word 77
tab 483
Right align
tabs 483
text 144, 221, 483
Right and left margins 298
initial settings 299
overlapping 299
Right arrow 77
Right justification 145, 222
Right margin 37
align text 222
hyphenate 201
indent 206
ragged 222
Roman numerals
as page numbers 356
outline 343
paragraph number 343
Root directory 86
Roots 122
Rotate
font 360-362, 404, 407
graphics image 180
Row height
multi-line 506
single line 506

S
[SHELL MACRO] 593, 594, 651
[SPEED] 595, 651
[STATE] 594, 651
[STATUS PROMPT] 592, 653, 669, 670
[STEP OFF] 595, 655
[STEP ON] 595
[STOP] 593, 658
[SUBST PRIMARY] 593, 658, 667
[SUBST SECONDARY] 593, 659, 667, 670
[SYSTEM] 594, 659
values returned 678

Save
and create document summary 105
document 18, 105, 136, 139, 426
document summary 100
DOS text file 521-523
equation 116
existing file 426
file 105, 136, 139, 426
graphics image 181
key assignment as macro 232
master document 304
outline style 349
subdocuments 302-304
to clipboard 163, 272
vs. exit 136, 427

Scale, graphics image 181
Scientific, equations 107
Screen 427
characters 65
clean 13, 423
colors 54
divide 427
empty 13
equation editor 108
font 54
format 102, 425, 427
long display 105
print from 373
print multiple pages 373
reveal codes 424
rewrite 102, 425, 427
text 524

Screen and disk documents, compare 92
Screen attributes 54
Screen positioning, and ASCII characters 541
Screen size, reveal codes 103
Script, columns 61
Scroll, sort 435
Search 428
and capitalization 428
and replace 416
backward 429
base font name 148
beep 36
beep on failure 36, 105
block 429
cancel 42, 142
codes 82, 428
conditions 140, 142
creation date 143
directory 142
document 100, 143, 261, 264
document name 143
document summary 140, 143
document type 143
file 139, 261, 262, 264
filename 140
first page of document 140
forward 429
justification 223
keyboard layout 227
limit 140, 142
locked file 271
look screen 274
macro programming commands 288
menu 715
pattern 141
perform 143
phrase 428
printer 383
reset conditions 143
revision date 143
string 417, 428
undo 142
Search and replace, text 416
Search string 417, 428
edit 417
Search text, edit 417
Secondary, leading 388
Secondary file 318, 320
delimiters 216
Secondary records, organize 319
Sections, print 371
Select
and sort 436, 439
cartridges and fonts 381
criteria 439
file 139
global 440
logical symbols 439
options 15
paper size/type 358, 361, 364
printer 377, 378, 382, 384, 403, 432
pull-down menu 412
sheet feeder 382, 431
statement order 440
[ALL OTHERS] 359
Select feature, mnemonics 317
Select only 440
Selected pages, print 370, 371, 403
Selected records, sort 439
Semicolon (:) operator 141
Sentence
append 24, 327
copy 327
cut 327
delimiter 25, 328
limit 328
move 327, 328
paste 327, 328
retrieve 328
Set
characters 118
equation 118, 124
multiple tabs 482
short tabs 482
tabs 253, 479
Set height, graphics box 176
Set width, graphics box 176
Set(s), characters 721
Setting
default 13, 212, 214
graphics box 190
save 213
Setting(s), default 572
Settings
default 426, 430
print 377
quality 380
Setup
beep options 35
display 89
display menu 430
environment 104
environment menu 430
initial codes 96, 212
initial settings menu 431
keyboard layout menu 431
location of files menu 431
WordPerfect 430
Several files, delete 83
Shade
graphics box 192, 375
horizontal lines 188
redline 414
text 414
vertical lines 189
Shadow, attribute 26
Sheet feeder 382, 431
select 382, 431
Sheet-fed paper 362, 431
size/type 432
Shell 318, 326
go to 162
Shift 43
Shift key assignments 233
Short, filename 259, 260
Short cut block keystrokes 331
find 142
Short cut(s), keyboard 579
Short display 260, 263
Short form, table of authorities 515, 517
Short/Long display 259, 263, 264
SHORTCUT.WPK 579
Show
document 258
files 86, 258
link codes 463
Side, binding 361
Side-by-side columns 56
Side-by-side columns 103
Sidebars 168
Single spacing 252, 257, 423
line 257
Single tab, set 482
Size
attributes 28
columns 59, 63
cursor 77
document 260
equation 110, 113
file 260
graphics box 175
labels 237
macros 289
paper 354, 358, 359, 361, 362, 364
reveal codes screen 103
table 501, 506
text 28
Size attribute
assign font 148
font 148
Size attribute ratio 148
font 217
Skip
double word 443
irregular case 444
Skip pages, graphics box 170
Skip word 443, 444, 446
Slots, available for cartridges 45
Small
text 37, 38
font 28
fractions 133
Small caps 26, 43
font 402
SmartQuotes 413
Snaking, columns 57
Soft
hyphen 202
page 352
page break 352
return 258, 420
Soft font 44, 219, 376
downloadable 44, 45
load 47
path 381

programs 49
swap 48
unload 47, 376
Soft fonts, downloading 403
Soft return
leading 388
leading adjustments for 422
spacing 422
Solid, characters 119
Sort
action 433, 435
alphanumeric 432, 438
and select 436, 439
ascending order 436
block 432, 433
by language 245
criteria 435, 439
descending order 436
document 432
fields 434, 436, 437
input file 432, 433, 436
keys 435, 437
lines 432, 434, 435, 437
logical symbols 439
menu 433, 435, 439
numbers 436, 438
numeric 438
order 436, 437
output file 432, 433, 436
paragraphs 434
perform action 433, 435
records 434, 436, 437, 439
selected records 439
table 436, 490
text 432
view 435
words 435
Sort order
generate 160
index 160
lists 160, 264
table of authorities 160, 512
table of contents 160, 518
Space 196
between letters 224, 386, 389
between words 386, 389
equation 109, 118, 124, 127, 129
hard 196
in macros 287
in replacement string 418
on disk 260
operator 141
repeat 415
underline 335
vs. tabs 476
Spacing
between letter pairs 224, 388
between words 223
double 252, 257, 423
equation 124
hard return 422
line 252, 255, 257, 423
of tab settings 477
single 252, 257, 423
soft return 422
table of authorities 514
tables 393
within and between notes 156
Speed
column display 56
saving files 139
SPELL.EXE 451
Spell-check 441
block 441, 442
cancel 442
capital letters 441, 443
document 441
page 441
Speller 441
add word 441, 446
count words 441, 445
cancel dictionary 453
delete double word 443
dictionary 441, 442, 444, 446, 449, 452
dictionary full 442
dictionary not found 442
directory 270
disable case checking 444
double word 441, 443
edit word 446
irregular case 443
look up words 441, 446, 449
non-US 334
replace irregular case 444
replace word 444, 445
skip double word 443
skip irregular case 444
skip word 443
supplementary dictionary 442, 444, 452
word count 450
word not found 445
Speller dictionary
add words 452
delete words 454
edit 451
Speller utility 451
change dictionary 453
look up word 456
phonetic look up 456
Split, table cell 501
Split screen 427
Spreadsheet
and graphics boxes 460
appearance 458
base font 459
block 457, 462
columns 458
delete link 461
document 461
export 460
filename 457
format 458
import type 462
landscape 459
link 462
link options 462
link type 462
margins 458
perform import 457
perform link 457, 461
document 460ange 457, 462
retrieve 458
rows 458
show link codes 463
table 457, 462, 491
type 462
update link 461, 463
update link on retrieve 463
Square root, equation 133
Start
line numbering 256
WordPerfect 12
Start footnote numbers each page 155
Starting paragraph number 344
Startup, option 718
Startup option 718
GRAPHCNV.EXE 166
printer program 394
Statement order, select 440
Status
current print job 218
print job 406
Status line 13
and table 491
messages 35
Stop
macros 284
hard decimal 478
hard decimal align 483
hard left 483
hard right 145, 483
intervals 479
left 483
measured from left edge of page 482
measured from margins 482
multiple 482
relative to left margin 482
right 483
ruler 477
set 253
single 482
types of measurements 482
underline 335
vs. spaces 476
Tab align 334, 478
and decimal tabs 478
math 305, 309
Tab ruler 482
Tab set menu, and cursor movement 480
Tab settings 477
default 477, 479
delete 481
on-screen display 477
types 482
Tab stop, in math 305
Tab to next level
outline 336, 339, 341
paragraph number 342, 366
Table 168, 251, 484
add column 492, 501
add column to end 501
add row 486, 492, 501
add row to end 501
addition 509
alignment 499
and cross-reference 486
and cursor movement 486
and graphics boxes 489
and justification 223
and newspaper columns 486
and page breaks 490
and parallel column 486, 490
and spreadsheet 462, 491
and status line 491
and style 491
bold 503
calculate math formulas 508
copy math formulas 508
create 484
create from existing text 488
create from parallel columns 488
create from tabular data 488
cursor movement 494
decimal align 504, 505
delete 487, 491
delete column 495, 501
delete row 487, 495, 501
display 87, 89
display digits 504
division 509
divide menu 492
divide structure 491
divide text 485
format cell 502-504, 506
format column 502, 504-506
grand total 511
graphics box 168
graphics box align 489
group 496
group cells 496
grouping 224
grouping digits 497
lock cell 504
math 304, 507
math functions 509
move 489, 498
move block 498
move buffer 499
move column 498
move row 498
multi-line row height 507
multiplication 509
negative numbers 499, 511
number 486
numeric cell 504
options 499
positioning 499
print 490
restore column 500
restore row 500
retrieve block 498
retrieve row 498
shade cell 497, 499
single line row height 507
size 501, 506
sort 436, 490
split cell 501
sub-rows 493
subtotal 510
subtraction 509
text cell 504
total 511
underline 503
unlock cell 504
white space 500
Table boxes, and lists 265-267
Table math 489, 507
addition 509
division 509
formula 509
functions 510
grand total 511
multiplication 509
negative numbers 499
subtotal 510
subtraction 509
total 511
Table of authorities
alphabetize 512
and master document 303, 512
and page numbers 355
appearance 217
create 159, 512
define 512, 513
dot leaders 514
dot leaders 160, 512, 516
dot leaders 492
dot leaders 492, 516
dot leaders full 516
dot leaders full 515, 516
generate 159, 161
initial settings 217
location 159, 514
mark text 512, 515
new page number 514, 515
number type 514
numbering options 514
regenerate 159, 512
sections 512, 513
short form 515, 517
sort order 160, 512
spacing 514
subdocuments 512
underline 514
update 159, 512
Table of contents
and master document 303, 518
and page numbers 355
create 159, 518, 519
define 519
dot leaders 518, 521
dot leaders 518, 521
levels 518-520
location 159, 518, 520
mark text 519, 520
new page number 519, 520
number type 520

762 Index
numbering 520
numbering options 520
numbering style 520
regenerate 159, 518
sort order 160, 518
subdocuments 518
update 159, 518
Tabular column
append 24, 25, 333
copy 333
cut 333
definition 331
delete using block 333
move 333
paste 333
Tabular data 484
change to table 488
Target name 76
Template 12
filename 140
on-screen 199, 200
Temporary
buffer 328
margins 206
Terminal help 427
Text
attributes 148
fonts 148
kerning 224
substitute fonts 400
Text
appearance 25, 157, 463
editor 172, 174, 179, 182
quality 379, 380, 405
was not modified 136
Text adjustment, paper size/type 363
Text and codes, delete 84
Text boxes
and lists 265-267
and replace 418
Text columns, math 306, 310, 314
Text display 524
Text editor 174, 179, 182
Text expressions
macros 587
merge 587
Text file 521, 523
merge 318, 322
Text in/out 264, 521
Text screens 524
Thesaurus 270, 525
clear columns 525
cursor movement 526
directory 270
exit 525
headword 526
look up word 526
menu 526
non-US 334
references 526
replace word 527
subgroups 526
view document 527
Thesaurus/Spell/Hyphenation
directory 270
Thousands separator 334
math 309
Three-dimensional boxes 191
Time, current 81
Time format 80
edit 247, 249
Timed, backup 32, 104
Title
in math 305, 307, 314, 316
math columns 316
math row 305, 307, 314, 316
Titles and text, keep together 67
Tools, menu 716
Top, binding 361
Top and bottom margin 299
Top margin, and baseline 387
Total function 511
Total lines on page 255
Totals
extra 315
math 305-307, 311, 315
math columns 306, 311, 314
Tractor-fed
labels 242
paper size/type 362
Troubleshooting 11, 16
printer 406, 410
Two-sided
copies 361, 377, 406
printing 361, 406
Typeface 146
printer program 393
Typeover 251
and line draw 527
and tabs 477
text 16, 527
Typesetters, baseline placement for 254
Typist, document 99
Undelete 85
codes 82
in table 500
text 42
Underline 26
double 26
existing text 39
spaces 335
tab 335
table 503
table of authorities 514
text 17
Undo 42
compare 94
document compare 94
find 142
search 142
Units of measure 107
Unload
font 47
print wheel 48
Unlock
file 271
table cell 504
Unprintable, region 299, 300
Up arrow 77
Update
printer definition 382, 384
style library 467
Update link 461, 463
on retrieve 463
Uppercase, text 43
User-defined
characters 722
functions 125, 129
graphics box 168
menus 275, 289
prompts 275, 289
variable 709
User-defined boxes, and lists 265-267
User-defined format
outline 343
paragraph numbers 343
Utility
graphics conversion 183
speller 451
V
{VAR n} 594
{VARIABLE} 594, 664
Value, repeat 217, 414
WP{WP}US.TH5  270, 525
WPG format  164
WPHELP.FIL  200
Wrap, words  420
Wrap text around box  177

Z
ZIP codes  33
Zone
  hyphenation  204
  unprintable  299, 300